Software Manual

ZEISS ZEN 3.3 (blue edition)

ZEISS ZEN 3.3 (blue edition)
Original Manual
Carl Zeiss Microscopy GmbH
Carl-Zeiss-Promenade 10
07745 Jena
Germany
microscopy@zeiss.com
www.zeiss.com/microscopy

Carl Zeiss Microscopy GmbH
ZEISS Group
Kistlerhofstr. 75
81379 München

Document Name: ZEISS ZEN 3.3 (blue edition) Software Manual
Revision: 1
Language: en-US
Effective from: 10/2020

© 2020 Without the prior written consent of ZEISS, this document or any part of it must neither be translated nor reproduced or
transmitted in any form or by any means - including electronic or mechanic methods, by photocopying, recording or by any information or filing system. The right to make backup-copies for archiving purposes shall remain unaffected thereby. Any violations may be prosecuted as copyright infringements.
The use of general descriptive names, registered names, trademarks, etc. in this document does not imply that such names are
exempt from the relevant intellectual property laws and regulations and therefore free for general use. This shall also apply if
this is not specifically referred to. Software programs shall entirely remain the property of ZEISS. No program or subsequent upgrade thereof may be disclosed to any third party, copied or reproduced in any other form without the prior written consent of
ZEISS, even if these copies or reproductions are destined for internal use at the customer's only, the only exception being one
single back-up copy for archiving purposes.
ZEISS reserves the right to make modifications to this document without notice.

 Content

ZEISS

Content
1 Welcome ....................................................................................... 12
2 General Information ...................................................................... 13
2.1

Using the ZEISS Help Viewer....................................................................... 13

2.2

Safety Notes and Safety Labels ................................................................... 14

2.3

Text Conventions........................................................................................ 14

2.4

Legal Notes ................................................................................................ 15

3 First Steps ..................................................................................... 17
3.1

Starting the Software ................................................................................. 17

3.2

User Interface............................................................................................. 18
3.2.1
3.2.2
3.2.3
3.2.4
3.2.5
3.2.6
3.2.7
3.2.8
3.2.9

Title bar......................................................................................
Workspace Configuration ...........................................................
Menu bar ...................................................................................
Tool bar......................................................................................
Left Tool Area.............................................................................
Center Screen Area.....................................................................
Right Tool Area ..........................................................................
Document bar ............................................................................
Status bar ...................................................................................

18
19
19
19
20
21
22
22
22

3.3

Setting the User Language ......................................................................... 24

3.4

Acitvating the Show All Mode .................................................................... 25

3.5

Configuring Microscope Components......................................................... 26

3.6

Acquiring a First Camera Image.................................................................. 28

3.7

Adding Annotations to an Image................................................................ 29

3.8

Adjusting Live Image Settings..................................................................... 30

3.9

Creating a Manual Scaling.......................................................................... 30

3.10 Closing the Software .................................................................................. 31
3.11 Displaying and adapting a grid in the image area ....................................... 32

4 Basic Concepts .............................................................................. 34
4.1

Image Acquisition....................................................................................... 34

4.2

Image Processing ....................................................................................... 34

4.3

Image Analysis ........................................................................................... 34

4.4

File Format ................................................................................................. 34

4.5

Extensions .................................................................................................. 35

5 User Management ......................................................................... 36
5.1

Creating a new user ................................................................................... 37

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

3

 Content

ZEISS

5.2

Adding users to a group............................................................................. 38

5.3

Managing access rights for user groups...................................................... 40

5.4

Managing group privileges ......................................................................... 41

5.5

Options ...................................................................................................... 41

6 Image Acquisition (General)........................................................... 43
6.1

Acquiring Multi-Channel Images with Cameras........................................... 43
6.1.1
6.1.2
6.1.3

6.2

Set up a new experiment............................................................ 44
Variant 1: Smart Setup ............................................................... 44
Variant 2: Channels Tool............................................................. 46

Acquiring Z-Stack Images ........................................................................... 46
6.2.1
6.2.2
6.2.3

Configuring a Z-Stack automatically............................................ 47
Configuring a Z-Stack manually (First/Last Mode)........................ 48
Configuring a Z-Stack manually (Center Mode) ........................... 48

6.3

Acquiring Time Series Images ..................................................................... 49

6.4

Acquiring a Panorama Image Automatically ............................................... 49

6.5

Acquiring EDF Images Manually (ZEN lite)................................................... 51
6.5.1
6.5.2
6.5.3
6.5.4

6.6

51
51
52
53

Cryo Acquisition in ZEN .............................................................................. 54
6.6.1
6.6.2

6.7

Prerequisites ...............................................................................
Acquiring EDF image with Timer mode .......................................
Acquiring EDF image with F12 Key mode ...................................
Compare Images using Split Display............................................

Exporting temperature data........................................................ 54
Adding temperature annotations to an image ............................ 54

Using the Dye Editor................................................................................... 55
6.7.1
6.7.2
6.7.3

Dye Editor Dialog........................................................................ 55
Creating a Custom Dye............................................................... 57
Adding a New Dye to the Data Set ............................................. 59

6.8

Setting an experiment as startup default .................................................... 60

6.9

Creating default experiments as templates automatically............................ 60

6.10 Applying an experiment template............................................................... 61
6.11 Adding Annotations to Images or Movies................................................... 61
6.12 Editing Annotations in Images or Movies.................................................... 62

7 Confocal Image Acquisition (LSM) ................................................. 63
7.1

Acquiring Confocal Images......................................................................... 63

7.2

Using Smart Setup with Airyscan LSM 980 and LSM 900............................ 68

7.3

Using the Sample Navigator with LSM 980 and LSM 900 ........................... 69

7.4

Acquiring LSM 900 images with Airyscan 2 multiplex modes...................... 76

7.5

Acquiring LSM 980 images with Airyscan 2 multiplex modes...................... 79

8 Working with Focus Strategies...................................................... 86

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

4

 Content

ZEISS

8.1

Introduction ............................................................................................... 86

8.2

Using Software Autofocus.......................................................................... 86

8.3

Using Definite Focus in Time Series Experiments ......................................... 87

8.4

Using Local or Global Focus Surfaces.......................................................... 88

9 Image Processing .......................................................................... 90
9.1

Image Processing Workflow ....................................................................... 90

9.2

General Settings ......................................................................................... 90

9.3

Performing Deconvolution Using Default Values......................................... 91

9.4

Performing Configurable Deconvolution ..................................................... 93
9.4.1
9.4.2
9.4.3
9.4.4

Step 1: Load input image for deconvolution ...............................
Step 2: Set parameters for deconvolution ...................................
Step 3: Perform deconvolution ...................................................
Step 4: Info View and re-using Deconvolution parameters from a
processed image.........................................................................

94
95
96
98

9.5

Measuring the PSF using subresolution beads............................................. 99

9.6

Extracting Individual Fluorescence Images of a Multichannel Image............101

9.7

Applying Batch Processing..........................................................................102

9.8

Cropping a ROI...........................................................................................103

9.9

Creating an EDF Image ...............................................................................105

9.10 Creating image subset and split dimensions ...............................................107
9.11 Using Analyze to Label Image.....................................................................108
9.12 Image Processing Functions........................................................................109
9.12.1
9.12.2
9.12.3
9.12.4
9.12.5
9.12.6
9.12.7
9.12.8
9.12.9
9.12.10
9.12.11
9.12.12
9.12.13
9.12.14
9.12.15
9.12.16
9.12.17

EM Processing ............................................................................ 109
Deconvolution ............................................................................ 123
Adjust......................................................................................... 136
Edges ......................................................................................... 141
Geometric .................................................................................. 143
Morphology ............................................................................... 156
Sharpen...................................................................................... 157
Smooth ...................................................................................... 160
Time Series ................................................................................. 163
Arithmetics ................................................................................. 166
Segmentation ............................................................................. 170
Binary ......................................................................................... 174
Utilities ....................................................................................... 177
Export/Import ............................................................................. 195
Image Analysis............................................................................ 212
Lightsheet .................................................................................. 218
Batch Processing Functions......................................................... 229

10 Importing/ Exporting Images ........................................................ 233
10.1 Workflow Export/Import.............................................................................233
10.2 Exporting Images .......................................................................................233
10.3 Exporting Movies........................................................................................233

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

5

 Content

ZEISS

10.4 Exporting Multichannel Images ..................................................................234
10.5 Exporting Multiscene Images......................................................................234
10.6 Importing Z-Stack Images...........................................................................236

11 Customizing the Application.......................................................... 237
11.1 Selecting a Screen Design...........................................................................237
11.2 Customizing Toolbar ..................................................................................237
11.3 Adjusting the Workspace Zoom..................................................................237
11.4 Showing/Hiding Workspace Areas ..............................................................238
11.5 Undocking/Docking Tool Windows.............................................................238

12 Software Modules & Extensions .................................................... 239
12.1 Advanced Processing..................................................................................239
12.1.1
12.1.2

Experiment Feedback.................................................................. 239
Workflow Experiment Feedback ................................................. 240

12.2 APEER (on-site) ...........................................................................................244
12.2.1
12.2.2
12.2.3
12.2.4
12.2.5
12.2.6
12.2.7
12.2.8
12.2.9

System Requirements ................................................................. 244
Preliminary Work / Prerequisites.................................................. 244
Creating and entering an API key................................................ 245
Setting up the remote module execution .................................... 245
Create a path mapping............................................................... 246
Downloading an APEER module ................................................. 246
Executing APEER modules in ZEN................................................ 247
Example for APEER on-site.......................................................... 247
Functions & Reference ................................................................ 249

12.3 APEER Workflows (online) ..........................................................................252
12.3.1
12.3.2
12.3.3

Starting Workflows..................................................................... 252
Uploading Files ........................................................................... 252
Functions & Reference ................................................................ 253

12.4 Automated Photomanipulation ..................................................................253
12.4.1
12.4.2
12.4.3

Using Automated Photomanipulation settings ............................ 253
Performing an Automated Photomanipulation experiment ......... 254
Functions & Reference ................................................................ 255

12.5 Confocal Topography .................................................................................257
12.5.1
12.5.2
12.5.3

Acquiring Topography Images .................................................... 258
Measuring Layer Thickness ......................................................... 261
Functions & Reference ................................................................ 265

12.6 Correlative Array Tomography (CAT)...........................................................273
12.6.1
12.6.2
12.6.3
12.6.4
12.6.5
12.6.6

Basics of Array Tomography ....................................................... 273
Sample Preparation .................................................................... 273
Pre-Settings (Light Microscope)................................................... 274
Experiment Settings.................................................................... 274
The CAT Workflow ..................................................................... 275
Functions & Reference ................................................................ 303

12.7 Deconvolution............................................................................................322

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

6

 Content

ZEISS

12.7.1
12.7.2
12.7.3
12.7.4
12.7.5
12.7.6
12.7.7
12.7.8

Basics of Deconvolution.............................................................. 322
Deconvolution (defaults)............................................................. 323
Deconvolution (adjustable) ......................................................... 323
Creating a PSF - With Wizard and Without ................................. 334
Image types suitable for deconvolution ...................................... 335
Deconvolution Methods in ZEN .................................................. 337
Table of Default Parameter for Deconvolution ............................ 341
Creating Deconvolution Settings................................................. 342

12.8 Direct Processing........................................................................................343
12.8.1
12.8.2
12.8.3
12.8.4
12.8.5
12.8.6
12.8.7
12.8.8
12.8.9

Direct Processing ........................................................................ 343
Connecting the acquisition computer with the processing computer .......................................................................................... 344
Setting up your PC as discovery proxy......................................... 346
Defining settings in the Auto Save tool ....................................... 346
Using Direct Processing .............................................................. 346
Using Direct Processing with Airyscan......................................... 347
Using Direct Processing with Deconvolution ............................... 349
Using Direct Processing with advanced deconvolution settings ... 350
Functions & Reference ................................................................ 351

12.9 EM Processing Toolbox...............................................................................355
12.9.1
12.9.2
12.9.3
12.9.4
12.9.5
12.9.6
12.9.7

Licensing of EM Processing......................................................... 356
Workflow Overview.................................................................... 356
Aligning z-planes manually ......................................................... 357
Aligning z-planes automatically (based on a ROI) ........................ 358
Replacing z-slices in a z-stack...................................................... 358
Cutting out a volume from a z-stack ........................................... 359
Importing SmartFIB Tiffs ............................................................. 360

12.10 Guided Acquisition .....................................................................................361
12.10.1
12.10.2
12.10.3
12.10.4
12.10.5

Licensing of Guided Acquisition .................................................. 362
Preliminary work to Guided Acquisition ...................................... 362
Performing a Guided Acquisition ................................................ 363
Using Guided Acquisition settings............................................... 365
Functions & Reference ................................................................ 366

12.11 Image Analysis ...........................................................................................369
12.11.1
12.11.2
12.11.3
12.11.4
12.11.5
12.11.6
12.11.7
12.11.8
12.11.9
12.11.10

Creating a new image analysis setting ........................................ 369
Creating an image analysis setting from an analyzed image........ 370
Measuring Fluorescence Intensity in a Multichannel Image ......... 371
Counting Number of Fluorescence Signals per Nuclei ................. 375
Measuring Mean Fluorescence Intensity on a Ring around the
Primary Object............................................................................ 382
Counting the number of Objects in a Ring around the Nucleus ... 389
Performing an interactive analysis............................................... 392
Creating a measurement data table ............................................ 393
Charts and Tables of the Analysis View....................................... 393
Measurement Features ............................................................... 397

12.12 ImageJ .......................................................................................................411
12.12.1
12.12.2
12.12.3
12.12.4

Preparations ............................................................................... 411
Activate ImageJ Extension .......................................................... 411
Sending and retrieving images.................................................... 412
Use ImageJ Methods .................................................................. 412

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

7

 Content

ZEISS

12.12.5 Image Type Send/Retrieve Conventions ...................................... 413
12.13 Intellesis .....................................................................................................415
12.13.1
12.13.2
12.13.3
12.13.4
12.13.5
12.13.6
12.13.7
12.13.8
12.13.9
12.13.10
12.13.11
12.13.12
12.13.13
12.13.14
12.13.15

Fact Sheet .................................................................................. 417
FAQ/Terminology........................................................................ 417
Operating Concept ..................................................................... 419
Workflow Overview.................................................................... 420
User Interface - Training ............................................................. 421
Intellesis Models ......................................................................... 425
Editing Classes............................................................................ 432
Importing Labels from Binary Mask............................................. 432
Converting segmentations to labels ............................................ 433
Using neural networks for Intellesis ............................................ 433
Using a Trained Model for Image Processing .............................. 434
Using a Trained Model for Image Analysis .................................. 435
Using Intellesis within OAD......................................................... 436
Remarks and Additional Information........................................... 437
Functions & Reference ................................................................ 438

12.14 Macro Environment....................................................................................444
12.14.1 Running an existing macro ......................................................... 445
12.14.2 Recording a macro ..................................................................... 445
12.15 Panorama...................................................................................................445
12.15.1
12.15.2
12.15.3
12.15.4
12.15.5
12.15.6

Prerequisites ............................................................................... 446
Acquiring a Reference Image ...................................................... 447
Settings for the Panorama Experiment........................................ 448
Acquiring the Panorama Image .................................................. 449
Processing the Panorama Image ................................................. 451
Functions & Reference ................................................................ 456

12.16 Physiology (Dynamics) ................................................................................458
12.16.1 Workflow MeanROI View (offline) .............................................. 458
12.16.2 Workflow Physiology (Dynamics) Experiments ............................ 465
12.16.3 Sample Experiment Fura-2 with DG4/5 ....................................... 469
12.17 Shuttle & Find.............................................................................................472
12.17.1
12.17.2
12.17.3
12.17.4
12.17.5
12.17.6

Settings and Image Acquisition with the Light Microscope ......... 473
Shuttle & Find Sample Positions at the Electron Microscope........ 480
Correlating Two Loaded Images ................................................. 484
Correlation of Live Image and Loaded Image ............................. 485
Shuttle & Find with an EVO 10 ................................................... 485
Functions & Reference ................................................................ 487

12.18 Software Autofocus ...................................................................................500
12.18.1
12.18.2
12.18.3
12.18.4
12.18.5

Terminology & Abbreviations...................................................... 500
When is focus the "right" focus?................................................. 504
Software Autofocus in ZEN......................................................... 504
FAQ............................................................................................ 505
Functions & Reference ................................................................ 507

12.19 Tiles & Positions .........................................................................................511
12.19.1 General Preparations .................................................................. 512
12.19.2 Calibrating the stage and selecting the channel .......................... 512
12.19.3 Setting up a simple tiles experiment without the Tiles & Positions
module....................................................................................... 513
Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

8

 Content

ZEISS

12.19.4 Setting up a simple positions experiment without the Tiles & Positions module ............................................................................ 514
12.19.5 Tiles & Positions with Advanced Setup........................................ 515
12.19.6 Copying a Tile Region or Position................................................ 520
12.19.7 Adjusting Z-Values...................................................................... 520
12.19.8 Local and Global Focus Surfaces ................................................. 522
12.19.9 Assigning Categories to Tile Regions and Positions ..................... 526
12.19.10 Re-positioning Sample Carrier after Incubation ........................... 527
12.19.11 Using Sample Carriers................................................................. 529
12.19.12 Importing Images into the Advanced Setup ................................ 530
12.19.13 Exporting Tile Images ................................................................. 531
12.19.14 Functions & Reference ................................................................ 531
12.20 ZEN Connect ..............................................................................................562
12.20.1
12.20.2
12.20.3
12.20.4
12.20.5
12.20.6
12.20.7
12.20.8
12.20.9
12.20.10
12.20.11

Licensing of ZEN Connect ........................................................... 562
Introduction to the User Interface............................................... 563
ZEN Connect 3D View ................................................................ 564
Opening the Correlative Workspace............................................ 564
Opening images in ZEN Connect 3D view ................................... 565
Non Image Data ......................................................................... 565
Project and Image Management................................................. 565
Import and Export ...................................................................... 572
Handling of images and data...................................................... 576
ZEN Data Storage ....................................................................... 591
Functions & Reference ................................................................ 594

13 Software Functions & Reference ................................................... 613
13.1 Menus........................................................................................................613
13.1.1
13.1.2
13.1.3
13.1.4
13.1.5
13.1.6
13.1.7
13.1.8
13.1.9

File Menu ................................................................................... 613
Edit Menu................................................................................... 617
View Menu................................................................................. 618
Acquisition Menu ....................................................................... 619
Graphics Menu ........................................................................... 620
Macro Menu .............................................................................. 622
Tools Menu ................................................................................ 626
Window Menu ........................................................................... 646
Help Menu ................................................................................. 647

13.2 Main Tabs ..................................................................................................648
13.2.1
13.2.2
13.2.3
13.2.4
13.2.5
13.2.6

Locate Tab.................................................................................. 648
Acquisition Tab........................................................................... 652
Processing Tab ........................................................................... 664
Analysis Tab ............................................................................... 665
Applications Tab......................................................................... 665
Extensions Tab............................................................................ 666

13.3 Tools ..........................................................................................................666
13.3.1
13.3.2
13.3.3
13.3.4
13.3.5
13.3.6

Tools on Locate Tab ................................................................... 666
Tools on Acquisition Tab............................................................. 684
Tools on Processing Tab ............................................................. 769
Tools on Analysis Tab ................................................................. 770
Tools on Applications Tab........................................................... 797
Tools in Right Tool Area.............................................................. 797

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

9

 Content

ZEISS

13.4 Dialogs.......................................................................................................808
13.4.1
13.4.2
13.4.3
13.4.4

Stage/Focus not calibrated Dialog............................................... 808
ApoTome Dialog ........................................................................ 808
ApoTome Settings Dialog ........................................................... 809
Add Dye or Contrasting Method Dialog ...................................... 809

13.5 Image views ...............................................................................................810
13.5.1
13.5.2
13.5.3

General image views .................................................................. 810
Specific image views................................................................... 831
General View Options................................................................. 887

13.6 View Modes ...............................................................................................908
13.6.1
13.6.2
13.6.3

Full Screen mode ........................................................................ 908
Exposé mode.............................................................................. 909
Splitter mode.............................................................................. 909

13.7 File Browser ...............................................................................................911
13.7.1

Tools Tab.................................................................................... 911

14 Systems, Applications & Components............................................ 912
14.1 LSM 980 ....................................................................................................912
14.1.1
14.1.2
14.1.3
14.1.4

Polarization Imaging................................................................... 912
FCS (Fluorescence Correlation Spectroscopy) .............................. 917
Imaging Setup ............................................................................ 963
System Maintenance .................................................................. 975

14.2 ApoTome.2 ................................................................................................985
14.2.1
14.2.2
14.2.3
14.2.4
14.2.5
14.2.6
14.2.7
14.2.8
14.2.9
14.2.10
14.2.11

Introduction ............................................................................... 985
Principle of imaging using fringe projection ................................ 985
Optimum acquisition conditions ................................................. 991
List of recommended objectives.................................................. 991
Preparation: Phase calibration..................................................... 995
Step 1: Define channels using Smart Setup ................................. 995
Step 2: Grid focus calibration...................................................... 997
Step 3: Perform ApoTome experiment ........................................1000
Step 4: Process the resulting image ............................................1002
Step 5: Perform Z-stack acquisition.............................................1004
Step 6: Perform ApoTome deconvolution ...................................1006

14.3 Celldiscoverer 7 ..........................................................................................
1010
14.3.1
14.3.2
14.3.3
14.3.4
14.3.5
14.3.6
14.3.7
14.3.8
14.3.9
14.3.10
14.3.11
14.3.12
14.3.13

Introduction ...............................................................................1010
Sample Tab (Interactive mode)....................................................1012
Using customized sample carriers ...............................................1015
Sample Tab (Automation mode) .................................................1017
Magazine View...........................................................................1021
Navigation View .........................................................................1024
Navigation tab............................................................................1025
Celldiscoverer Tool .....................................................................1026
Dispensing Tool ..........................................................................1027
Perfusion ....................................................................................1028
Celldiscoverer Options ................................................................1029
Performing a Celldiscoverer calibration .......................................1031
Mixed Mode Settings..................................................................1033

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

10

 Content

ZEISS

14.3.14
14.3.15
14.3.16
14.3.17
14.3.18

Calculating the disparity map for mixed mode acquisition...........1037
Airyscan HS ................................................................................1042
Airyscan MPLX HS ......................................................................1043
Smart Setup................................................................................1044
Auto Immersion for Celldiscoverer ..............................................1045

15 Service / Maintenance ...................................................................1049
15.1 Creating a Service Report ...........................................................................
1049

16 FAQ ...............................................................................................1050
16.1 What can I do If my image is too dark? ......................................................
1050
16.2 How can I balance my images color? ..........................................................
1050
16.3 How can it be that my image has dust or a shadow, although my specimen is clean?..............................................................................................
1051
16.4 Why my image seems to look that something have burned in? (i.e. a
1051
shadow of a previous specimen?) ...............................................................
16.5 How can I fix a color gradient cast? ............................................................
1051
16.6 What can I do if my live image is of a low quality and looks pixelated?.......
1051
16.7 What can I do if my live image is slow? ......................................................
1052
16.8 What can I do if my live image is mostly red/blue?......................................
1052
16.9 What can I do if my live image is still black or white after setting the expo1052
sure? ..........................................................................................................
16.10 Why my live image shows extreme colors in comparison to what I see in
the eyepieces? ............................................................................................
1052
16.11 Why is my image resolution lower than the given camera specification?.....
1052
16.12 What can I do if I do not see a focused live image? ....................................
1053
16.13 Why is my image color not the same that I see through the eye pieces? .....
1053

Glossary.........................................................................................1054
Index .............................................................................................1064

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

11

1 Welcome
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1 Welcome
ZEN (blue edition) is a modular image acquisition, processing and analysis software for digital microscopy. The abbreviation ZEN stands for ZEISS Efficient Navigation and points out that the software can be used to control microscopes and imaging systems by ZEISS.
In addition to basic functionality for image acquisition, elementary image processing and annotations and image analysis a lot of optional modules for specific microscopy tasks are available.
With ZEN lite the basic version of the software is available for free. Starting from a basic functionality for image acquisition, simple image processing, image analysis and documentation a lot of
optional modules are available for ZEN lite as well. More detailed information is available in the
product brochure.
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2 General Information
2.1 Using the ZEISS Help Viewer
Opening the ZEISS Help Viewer
If you need help on a specific area, tool, or section within the software, simply press the [F1] key
to open the related help topic.
As it is difficult sometimes for the software to know on which topic you want help for when
pressing the [F1] key, you can use the Question Mark symbol alternatively. Simply click on the
question mark symbol ? in the Title bar. The courser then appears as a question mark symbol.
Click on an area in the software for which you want to get help. If there is a related help topic
available it will open directly.
ZEISS Help Viewer User Interface
The following screenshot indicates the main elements of the user interface:
4

5

3
2
1

1

Index
List of keywords to help you find topics and content quickly

2

Topics
Contains the structure tree with a list of all the topics.
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Search
Search through the entire text
It supports partial strings but not wildcards.

4

Structure tree
Enables you to navigate through topics sequentially. A > indicates a topic has subtopics.

5

Content panel

2.2 Safety Notes and Safety Labels
The display of safety notes in the documentation and software follows a system of risk levels, that
are defined as follows:

CAUTION
Risk of personal injury
CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor
or moderate personal injury.

NOTICE
Risk of property damage
NOTICE indicates a property damage message. In addition, NOTICE is used for data loss or corrupt data as well.
The safety icons / labels on the device or in the documentation refer to potential dangers or information that are defined as follows:

Icon / Label

Name

Description

Crushing
Fingers

This icon warns you of a potential risk of crushing fingers.

2.3 Text Conventions
The following text conventions are used in this documentation:

Format

Description

Format "bold"

The format "Bold" within text is used for
§ Clickable user interface elements, e.g. buttons and icons
Example: Click on Save.
§ Hardware buttons on the microscope
Example: On/Off button
§ Non-clickable user interface elements, e.g. name of a dialog
Example: Image dialog
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Format

Description

Format "italic"

Italics highlights the following:
§ text to be entered by the operator

Format for keyboard
text

Text in bold + brackets is used for keyboard commands. E.g.
Example:
Press [F1] to open the online help.

Format for a path in
the software

Description of a path within the software.
Example:
Go to Tools > Options > Acquisition

Format for programming code

Used for programming code, e.g. macro code as well as for anything
that you would type literally when programming, including keywords,
data types, constants, method names, variables, class names, and interface names.
Example: Integer

Format for links (internal or web links)

Links to further information internally or in the web.

Format for procedural instructions

A numbered procedural instruction is used for actions which are performed by the user. The steps must be performed in the given order.
Optionally there are pre-requisites which have to be fulfilled in advance. At the end of the instruction normally the result of the procedure is presented.

Example: Link

Example:
1. Action step which has to be actively performed by the user
à Intermediate result
2. Another step within the procedure.
Additional information is indicated as follows:

Info
Helpful additional information, e.g. about necessary additional actions.

2.4 Legal Notes
ZEISS draws the User's attention to the fact that the information and references contained in
these documentation may be subject to technical modifications, in particular due to the continuous further development of ZEISS products. The documentation enclosed does not contain any
warranty by ZEISS with regard to the technical processes described in the documentation or to
certain reproduced product characteristics. Furthermore, ZEISS shall not be held liable for any possible printing errors or other inaccuracies in this documentation, unless proof can be furnished
that any such errors or inaccuracies are already known by ZEISS or that these are not known to
ZEISS due to gross negligence and that furthermore ZEISS has for these reasons refrained from
eliminating these errors or inaccuracies appropriately. ZEISS hereby explicitly draws the User's attention to the fact that this documentation only contains a general description of the technical
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processes and information, the implementation of which in any individual case may not be appropriate in the form described here. In cases of doubt, we recommend the User to consult ZEISS service and support.
This documentation is protected by copyright. ZEISS has reserved all rights to this documentation.
It is prohibited to make copies, partial copies, or to translate this documentation into any other
language, except for personal use.
ZEISS explicitly draws attention to the fact that the information contained in this documentation
will be updated regularly in compliance with the technical modifications and supplements carried
out in the products and furthermore that this documentation only reflects the technical status of
ZEISS products at the time of printing.
Safety
Refer to the safety notes and instructions in the documentation of all necessary devices (e.g. microscope peripherals, cameras, computers, computer accessories, etc.) before installing and using
the software.
Disclaimer
The author is not responsible for any contents linked or referred to from his pages - unless he has
full knowledge of illegal contents and would be able to prevent the visitors of his site from viewing those pages. If any damage occurs by the use of information presented there, only the author
of the respective pages might be liable, not the one who has linked to these pages. Furthermore
the author is not liable for any postings or messages published by users of discussion boards,
guest books or mailing lists provided on his page.
Please note that this software contains an extension that enables you to connect it with the third
party software ImageJ. ImageJ is not a ZEISS product. Therefore ZEISS undertakes no warranty
concerning ImageJ, makes no representation that ImageJ or derivatives such as Fiji or related
macros will work on your hardware and will not be liable for any damages caused by the use of
this extension. By using the extension you agree to this disclaimer.
Notice of the Producer
This software product was designed, realized, verified, validated and released in a certificated
process environment. The quality management system is certified following the rule of DIN EN ISO
13485.
The fields of application of the Software are common tasks and applications in microscopy respectively imaging (so called “Off-The-Shelf Software”). Though the user acknowledges that in any
kind of use the end user of the software is responsible for the validation of the Software for the
end user’s dedicated intend of use considering all requirements of law and standards (e.g. FDA/21
CFR part 11, IvDD, etc.). If necessary the end user has to establish, to document, to implement
and to maintain a special process to fulfill all the requirements to be conform with the validate
rules of law and standards. It is pointed out that displayed measure values (e.g. length measurement) may not be used directly as analytical values for diagnostic results.
CARL ZEISS DOES NOT WARRANT THAT THIS SOFTWARE IS USABLE FOR SPECIAL PURPOSES
OTHER THAN IN THE FIELDS OF APPLICATION DEFINED ABOVE.
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3 First Steps
3.1 Starting the Software
Prerequisite ü You have installed ZEN (blue edition) on your computer.
1. Double click on the program icon on your desktop.

2. Alternatively click on Start > All Programs > Carl Zeiss Microscopy > ZEN > ZEN (blue
edition) entry (blue icon).
à The software starts. After a while you see the login screen.

3. Click on the button of the application you want to work with. The available applications depend on your licenses and system (e.g. if you work with an LSM, only ZEN system and Image Processing is available). Make sure that the hardware components you use are
switched on and are ready for operation.
à The software starts. During the program start the hardware settings will be initialized.
You successfully started the software.

Info
For using pre-recorded images when starting the software, in the menu Tools > Options >
Startup, the Reload Last Used Documents checkbox must be activated.
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3.2 User Interface
The software user interface is divided into three main areas.

2

1

3

Fig. 1: User interface

1

Left Tool Area
With the tabs you can access all the main tools for microscope control (Locate Tab
[} 648]), acquisition (Acquisition Tab [} 652]), image processing (Processing Tab [} 664]),
image analysis (Analysis Tab [} 665]), and applications (Applications Tab [} 665]).

2

Center Screen Area
This area is used to display your images with several image views available. For more information, see Center Screen Area [} 21].

3

Right Tool Area
Here you find the Images and Documents Tool [} 797], the Objective Selection and the
Stage and Focus controls. Additionally system specific tools can be available here (e.g.
Definite Focus and ZEN Connect controls).

3.2.1 Title bar
Parameter

Description

Help icon

Activates the "drag & drop“ help function. A question mark appears beside the mouse pointer. Move the mouse pointer to a
place in the software where you need help. Left-click on the desired location. The online help opens.

Minimize

Minimizes the program window.
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Parameter

Description

Maximize Over 2
Screens

Maximizes the program window across 2 screens if available.
This option is only possible if you are working with 2 screens
with the same resolution.

Maximize

Maximizes the program window to the main screen.

Restore Down

Reduces the program window to any selected size.

Close

Closes the program window.

3.2.2 Workspace Configuration

Fig. 2: Workspace Configuration
Here you find settings to adjust your workspace. Select Light/Dark Design of the user interface
or enlarge the screen with Workspace Zoom slider. You can also save and reload all personal
settings in a workspace configuration. With the Dock all tool windows button
right corner you can easily dock all undocked tools by one click.

in the top

3.2.3 Menu bar

Fig. 3: Menu bar
The menu bar contains all the menus you need for managing, editing, and viewing your projects.

See also
2 File Menu [} 613]
2 Edit Menu [} 617]
2 View Menu [} 618]
2 Acquisition Menu [} 619]
2 Graphics Menu [} 620]
2 Macro Menu [} 622]
2 Tools Menu [} 626]
2 Window Menu [} 646]
2 Help Menu [} 647]

3.2.4 Tool bar

Fig. 4: Tool Bar
Here you gain quick access to important functions, e.g. saving or opening files. Further right you
find more workspace settings, e.g. Design and Workspace selection. Read how to customize the
Tool bar in chapter Customizing Toolbar [} 237].
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3.2.5 Left Tool Area
This area contains the main tabs for microscope and camera settings (Locate tab), image acquisition (Acquisition tab), image processing (Processing tab), and image analysis (Analysis tab). The
main tabs are organized in an order which follows the typical workflow of experiments in bioscience or material science.

Fig. 5: Left Tool Area

See also
2 Locate Tab [} 648]
2 Acquisition Tab [} 652]
2 Processing Tab [} 664]
2 Analysis Tab [} 665]
2 Extensions Tab [} 666]
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3.2.6 Center Screen Area
The Center Screen Area is structured in 4 areas.

1

2

3

4

Fig. 6: Center Screen Area

1

Document bar
Here you can switch between all your opened documents. For more information, see
Document bar [} 22].

2

Image Views
Area where you can switch between different image views by selecting the corresponding tab in the list. For more information, see also Image views [} 810].

3

View Options
Area for general and specific view options. For more information, see also General View
Options [} 887].

4

Image Area
Area where images, reports, and tables are displayed.
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3.2.7 Right Tool Area
This area contains mainly the tools for image and file handling (e.g. Image Gallery) and hardware
control (e.g. Stage / Focus tool). Depending on your system configuration, other tools can be
available. The tools are described in the corresponding chapters of the online help.

See also
2 ZEN Connect Tool [} 601]
2 Stage Tool [} 798]
2 Focus Tool [} 800]
2 Incubation Tool [} 803]
2 Microscope Tool [} 798]
2 Images and Documents Tool [} 797]
2 Macro Tool [} 804]

3.2.8 Document bar
Here you see tabs of all open documents. Click on a tab to view the image/document. On the
right end of document bar you find buttons to switch view mode from Exposé to Splitter mode
and further view options (View menu).

Info
A asterisk (*) next to an image/document title indicates that unsaved changes have been
made to this document. Save your pictures/documents from time to time in order to avoid data
loss.

Parameter

Description
Opens the exposé view mode. For more information, see Exposé
mode [} 909].

Exposé Mode
Opens the splitter view mode. For more information, see Splitter
mode [} 909].
Splitter Mode

Options

Displays the options of the view menu. For more information about
the individual options, see View Menu [} 618].

3.2.9 Status bar
The status bar shows important information on the system status:

Parameter

Description

Scaling

Displays which lateral scaling is currently being used. If you click on
the arrow, the Scaling dialog [} 629] will be opened. There you have
access to advanced scaling settings and the scaling wizard.

System Information

Always shows the latest, currently active process that the system is
performing.
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Parameter

Description

Progress bar

Displays the progress of the currently active process. Each new
process added supersedes older still active processes. If you click on
the arrow button, a window opens with a list of all processes in
chronological order. You can stop a process that is running using the
Stop button.

Performance indicators

In this group you will see an overview of the performance of individual computer components:
§ Free RAM indicates how much physical memory is still available.
§ Free HD indicates how much space is still available on the hard
drive onto which the next image is to be acquired (see Tools > Options > Saving).
§ CPU indicates the usage of the Central Processing Unit.
§ The small status bar provides an overall assessment of the system
usage.
§ GPU indicates the usage of the Graphics Processing Unit by ZEN
and ZEN related services. It is also visualized by a small status bar
on its right.
Note: This GPU indicator is only visible if you your computer has
Microsoft Windows 10 version 1709 or higher.
Info: Double-clicking in the Performance Indicators area opens the
Windows Task Manager.

Frame Rate

Indicates the current frame rate in frames per second (fps) used by the
active camera for producing new images. Please note in most cases
that at speeds greater than 100 frames per second, this value cannot
always be accurately determined.

Pixel Value

Displays the gray value to the image at the current position of the
mouse pointer. In the case of multichannel images the gray value/
channel is displayed for up to 4 channels.

Position

Displays the X/Y position (in pixel coordinates) of the mouse pointer in
the image.

Information (i)

If you click on the icon, a window opens with a System Messages
[} 24].

Storage Folder

Displays the location where new images are automatically saved. This
path can be changed in the menu Tools > Options > Saving.

Status: Airyscan
Detector Alignment

If you click on the arrow the Alignment Tool window opens. See
Airyscan Detector Adjustment [} 980].

User

Shows the Windows user name of the logged in user.

Time

Shows the current Windows system time.
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3.2.9.1 System Messages
If you right click on a system message the Copy button will appear. Left click on Copy button to
copy the message to clipboard. Then paste it into a text file or an E-Mail. The idea behind is that
you can easily send error messages to your support team for example. This copy/paste function
works for all upcoming system messages or error messages within the application as well.

Parameter

Information

Warnings

Errors

Description
System information that arises during normal operation. This system
information does not lead to an interruption of the workflow. The information window is not displayed automatically.
Information that requires input from the user, e.g. a prompt to
change a manual microscope component. This information leads to
the information window being shown briefly. However, it closes again
after a few seconds.
Error messages indicate a malfunction by the system. In this case the
information window opens and remains open. The system requires input from the user in order to continue.

Info
Hundreds of messages can accumulate in the course of a session. A maximum of 300 messages are displayed. To display messages for a certain category, activate or deactivate the corresponding checkboxes.

3.3 Setting the User Language
Prerequisite ü You have successfully started the application.
1. Click on menu Tools> Options.
à The Options dialog opens. The General entry in the Software group is selected.
2. Deactivate the Select Automatically checkbox if you want to set the language manually.
3. Select user language from the Fixed Language dropdown list.
à A message appears to restart the application.
à Note, that the availability of additional languages can differ between software versions.
4. Click on OK.
à The Options dialog closes.
5. Exit and restart software.
You have successfully set the user language.
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3.4 Acitvating the Show All Mode
1. With the Show All mode deactivated (default setting), only the basic functions of tool windows or view options are shown.

2. To show the advanced settings or expert functions of tool windows or view options, click
on the Show All button.
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3.5 Configuring Microscope Components
This chapter refers to the manual configuration of the microscope components in ZEN lite. All microscope components definitions will be stored in the meta data of the acquired image.
Prerequisite ü You have selected the Camera tab.

1. Click to the Microscope Components tool.
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à The tool will open. Consider that the button Show all is activated.

2. For Objective select that objective you will use for your acquisitions.
3. Select all other microscope components you eventually will use (i.e. Optovar, Reflector,
etc.).
You have successfully configured your microscope components.

Info
If you have activated the Select automatically button in the status bar under Scaling (standard settings), the scaling will be calculated on the basis of your definitions. If you want to perform a manual scaling, read the chapter Creating a Manual Scaling [} 30].

See also
2 Creating a Manual Scaling [} 30]
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3.6 Acquiring a First Camera Image
This topic guides you through acquiring your first camera image with the software.
Prerequisite ü You have connected and configured a microscope camera (i.e. Axiocam 305 color/mono) to
your system.
ü You have started the software.
ü You have configured the microscope components (e.g. objective, camera adapter) und you
are using the automatic or manual scaling.
ü You are on the Camera (ZEN light only) or Locate tab.
ü You see your microscope camera available in the Active Camera section. If not, select the
camera from the list.

1. Position your sample on the microscope and adjust the microscope to see a focused image
through the eyepieces.
2. Adjust the tube slider of the microscope to divert the image to the camera (e.g. 50% camera and 50% eyepieces).
3. Click on Live button.
à The Live Mode will be activated. In the Center Screen Area you will see the camera
live image. By default the live image shows a cross hair helping to navigate on the specimen. In the chapter Adjusting Live Image Settings [} 30] you will learn how to optimize
live image display.
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4. Click on Set Exposure button.
à The exposure time will be automatically determined and set.
5. Click on Snap button.
You successfully acquired your first image. Save the image in the file system via the File menu |
Save as.

Info
If you do not see a focused image please refocus the specimen on the microscope. You may
activate the focus bar as an additional aid. Right click in the Center Screen Area to open the
context menu. Select the entry Focus Bar. The focus bar will be shown.

See also
2 Document bar [} 22]

3.7 Adding Annotations to an Image
Annotations are the generic term for all the graphics (e.g. rectangle, arrow, scale), measurements,
texts or other metadata (e.g. recording time) that you can add to your image.
Prerequisite ü You have acquired or loaded an image.
1. In the Center Screen Area select the Graphics tab.

2. Click on the
Scale Bar button.
à The scale bar will appear directly in the image.
à To edit an annotation (e.g. color, line width) you can right click on the annotation in the
image and select Format Graphical Elements from the context menu.
3. Click on the
Draw Arrow button.
à Now you may draw an arrow into your image.
You added the annotations Scale Bar and Arrow from the toolbar to your image.

See also
2 Adding Annotations to Images or Movies [} 61]
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3.8 Adjusting Live Image Settings
Prerequisite ü You have started the Live mode via the Live button and see the camera’s live image in the
Center Screen Area.
ü Under the image area you see the general view options on Dimensions tab, Graphics tab
and Display tab.
1. In the Dimensions tab activate the Range Indicator checkbox. This will mark overexposed
(too bright) areas in the live image in red and underexposed (too dark) areas in blue.
2. On the Display tab click the 0.45 button. The display curve will be adapted to a gamma
value of 0.45. This will set the optimum color presentation. If you do not see this button,
activate the Show all mode.
3. Move the controls under the display curve left and right in order to directly adjust the values for Contrast (Black) (1), Gamma (2), and Brightness (White) (3) in the live image.
1

2

3

Info
With the settings above the display of the live image will be adapted. These settings will also
be transferred to your acquired image. This will not change the camera settings.

3.9 Creating a Manual Scaling
Prerequisite ü You have an object micrometer oriented horizontally on the microscope stage.
ü You have selected all definitions for your microscope correctly in the Microscope Components tool (ZEN lite only). In our example we use an objective with a 10x magnification.
1. Acquire an image (see Acquiring a First Camera Image [} 28]) of the scale in your object
micrometer using the objective to be scaled manually.
2. In the bottom status bar click on the arrow in the Scaling area. In the Scaling dialog deactivate the Select Automatically checkbox.
3. In the Create new scaling section, click on the Interactive Calibration... button.
à The calibration wizard will appear in the image area.
4. Click on single Reference Line button (selected as default) and activate the Automatic
Line Detection button (activated as default).
5. Draw in the reference line along the scale.
6. Enter the true distance between both scale lines in the calibration wizard. In our example
this is 500 micrometer.
7. Enter a name for the scaling (i.e. Obj 10x) and click the Save Scaling button.
You performed a manual scaling for your objective. Repeat this sequence for all objectives you will
need a manual scaling for. Always ensure that you did select the correct objective in the tool Microscope Components and for this performed and selected the matching scaling in the status
bar.
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Info
§

The function Automatic Line Detection calculates the theoretical maximum of the reference line‘s both end points to the closest scale lines in the image. Thus the distance will be
calculated with sub-pixel accuracy.

§

If you defined manual scalings for your available objectives, and you click in the status bar
in the Scaling area to open the Scaling dialog and to activate the checkbox Select Automatically again, the system will use the measured scalings instead of the theoretic ones.
You will recognize this via the label "Measured" instead of "Theoretic" beside the pixel
size.

3.10 Closing the Software
1. Click on File | Exit. Alternatively you can use the short cut ALT+F4 or click on the Close
icon in the program bar.

Info
If you haven’t saved your files the Save Documents dialog will open before the program
closes. Select files you want to save or unselect files you don’t want to save.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

31

3 First Steps | 3.11 Displaying and adapting a grid in the image area

ZEISS

3.11 Displaying and adapting a grid in the image area
In this section you will find out how to display a grid in your images and how to adapt it.

Info
A grid can only be displayed in an acquired image or in a live image in Continuous mode.

Prerequisite ü You have opened an image in which you want to display a grid.
1. Click on the Grid entry on the Graphics menu.
à The grid is displayed in the image.

2. Right-click precisely on a grid line.
à The shortcut menu opens.
3. Click on the Format Graphical Elements entry in the shortcut menu.
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à The Format Grid dialog is displayed.

4. Activate the Synchronize checkbox. This function means that any changes made, e.g. to
the number of columns, are adopted simultaneously for the number of rows. The grid
therefore remains square.
5. Set a higher number of columns using the Columns slider. Alternatively, you can enter a
value in the input field.
à The changes are displayed directly in the image.
6. Click on the
Save button to save the grid settings.
à The Windows dialog for saving settings is opened.
7. Enter a name and click on Save.
8. Close the Format Grid dialog.
You have inserted a grid into your image, edited the grid and saved your grid settings.
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4 Basic Concepts
4.1 Image Acquisition
The software completes all microscopes, microscope systems like LSM, and cameras from ZEISS to
efficient and tailor-made imaging systems. With little training you will interactively control the entire workflow from image acquisition, processing and analysis.
Depending on the system you can capture single images, multi-channel fluorescence images or
video sequences with up to 16-bit per channel image information. The software contains the so
called 'Smart Setup' which automatically delivers several proposals for the optimal dye and wavelength combinations for an experiment.
A wide range of different cameras can be used, starting from simple consumer cameras through
to high-resolution and high-sensitivity microscope cameras. The seamless integration of cameras
into the software allows you to acquire complex images and image sequences by one mouse
click. For best results we recommend to use ZEISS Axiocam microscope cameras.

4.2 Image Processing
After acquiring an image it is immediately displayed on your screen. It can then be optimized using a wide range of techniques:
§

Contrast, brightness and color adjustment

§

Noise suppression, smoothing and contour enhancement

§

Sharpness enhancement/emphasizing of details

§

Correction of illumination influences and white balance

The software can also be used to add any annotations that you may require to the images. All elements, from scale bars and colored markings through to text and graphics, have been integrated
into the program.

4.3 Image Analysis
Even with ZEN lite you are able to perform simple interactive measurements. The measured values (e.g. lengths, areas and perimeters) are made available in a data table, and can be processed
further using spreadsheet programs.
With the optional modules Image Analysis and Measurement you can perform professional
analysis tasks like generating automatic measurement procedures or measuring microscopic structures interactively.

4.4 File Format
For the ZEN software we developed a special file format called *.czi (Carl Zeiss Image). Besides the
image data itself, the image format saves a lot of additional data, for example the date of acquisition, microscope settings, exposure values, size and scale details, contrast procedures which were
used. Also all annotations and measured values are saved with the file.
To learn more about the ZEISS image file format we recommend to visit the ZEISS Microscopy
Community forum in the internet (http://forums.zeiss.com/microscopy/community/forum.php).
There you can join interesting discussions or download the detailed documentation of the file format.
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Fig. 7: CZI file format

4.5 Extensions
The extensions concept allows you to extend ZEN dynamically in its functionality. From a technical
point of view the concept is comparable with plug-in`s or add-on`s. For the extensions we reserved a special area (Extensions tab [} 666]) within the software so that you can find all loaded
extensions at a glance.
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5 User Management
The software can be used with or without user management.
Without user management
User management is disabled by default. This means that every user has the same rights. No username or password is required and there are no user roles within the software (i.e. the user can
perform any action).
With user management
If user management is enabled, each user has an account which is used to log into the software.
Each user account is assigned to one or more user groups.
User groups define the privileges (actions the user can perform in the software) for the users assigned to the group. Groups typically correspond to the roles in the software (e.g. Administrator,
User). However, you can also create new user groups if required.
Typically, one user is assigned to one group, but can be assigned to multiple user groups if required. Users have the sum of all permissions of the groups to which they are assigned.
When you start ZEN with user management, you have to enter your username and password on
the login screen. Additional to the general login, the last three logged in users on this machine are
displayed on the login screen.
ZEN Data Storage
If you use the ZEN Data Storage and user management, the users are the data storage specific
ones.
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5.1 Creating a new user
1. Click on Tools > Users and Groups... to open the User and Group Management dialog.

2. Activate Enable User Management checkbox.
à As the user management is enabled now all settings will be effective with the next start
of the software. Make sure that you remember password, username, etc.
3. In the Users tab, click on the Add button
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à The New User dialog opens.

4. Enter a user name.
Optional: Enter a description and/or enter and confirm a password.
5. Click on OK.
You have successfully created a new user. Now you can now add the user to a specific user
group.

5.2 Adding users to a group
Prerequisite ü You are in the User And Group Management dialog (Tools > Users and Groups...) .
ü Enable User Management is activated.
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1. Click on the Groups tab.

à By default you will find 4 groups (Admin, Expert, PowerUser, User) with each group
having the same rights. Learn how you can manage access rights for user groups under
Managing access rights for user groups [} 40].
2. Select the group you want to add a user to, e.g. User.
3. In the list, click on the Group Properties button
.
à The Group Properties dialog opens. Under Data > Members you see the members list.
4. Click on Add Member
.
à The Select User dialog opens.
5. Select the user you want to add to the group and click on OK.
You have successfully added a user to a user group.
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5.3 Managing access rights for user groups
You can restrict the access for user groups to certain functionalities of the software. If you use
ZEN Data Storage, you can also assign privileges to user groups. For more information on that,
see Managing group privileges [} 41].
Prerequisite ü You are in the User And Group Management dialog (Tools > Users and Groups...) .
1. Click on the Groups tab.
à By default you will find 4 groups with each group having the same rights.
2. Select the group you want to manage access rights for.
3. Click on the Group Properties button
.
à The Group Properties dialog opens.
4. Under Access Rights click on the Left Tool Area tab.
à You see a list with elements of the Left Tool Area.
5. Click on the Check mark button in front of the entry Processing.
à The button changes to an Minus icon. The access to the Processing tab is now restricted for all members of this group.

6. Click on OK to close the dialog.
7. Restart the software for the changes to be effective.
You have successfully changed access rights within a user group.
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5.4 Managing group privileges
If you use ZEN with ZEN Data Storage, privileges are assigned to user groups. They specify what
actions members of the group can perform in the software.
The software contains various pre-defined roles, each with different sets of privileges. Typically,
the software contains one user group for each role. However, you can create any number of user
groups with arbitrary privileges.
Prerequisite ü You are logged in as an administrator.
ü Enable User Management is activated.
1. Got to Tools > Users and Groups. .
2. Click on Groups.
3. Select the desired user group and click on
.
4. Click on Privileges.
à The privileges for the ZEN Data Storage groups are displayed. Each privilege is displayed
with its Name, a Description, and the Application Name. Here you can see which
privilege is designated for groups in ZEN, ZEN core, or the ZEN Storage Processing
Server. If the field Application Name is empty, the respective privilege is generally
available.
5. Select the privileges for the user group.
à You can click on one of the pre-defined Privilege sets or activate individual checkboxes
to create a custom set of privileges.
6. Click on OK.
You have now set/changed the privileges for this group.

5.5 Options
The options apply to all users, regardless of the user groups to which the user is assigned. If you
are using ZEN Data Storage, not all parameters are displayed.

Parameter

Description

Check the following rules for a
password

Here you can specify certain rules or criteria for a password that is
created. If the checkbox is activated, the rules must be fulfilled when
a new password is created.
The following rules can be adjusted:
§ Minimal number of lower case characters (e.g. when you set "2",
the password must contain at least two lower case characters e.g.
"e" and "f")
§ Minimal number of upper case characters (e.g. when you set "2",
the password must contain at least two upper case characters e.g.
"C" and "G")
§ Minimal number of digit characters ( e.g. when you set "3", the
password must contain at least 3 digits (from 0 - 9), e.g. "5", "6",
"7")
§ Minimal number of special characters (e.g. when you set "1", the
password must contain at least one special character, e.g. "&")
§ Minimum length (e.g. when you enter "9", the password must consist of at least 9 characters (any from above).
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Parameter

Description

Do not allow Windows or ZEN user
name as password

If activated, it is not allowed to use an existing user name from Windows or ZEN installation as password for the software.

Disable the reuse
of last used passwords

If activated, you can enter a certain number of passwords which can`t
be reused after each other. E.g. if you enter the number '3' you have
to assign 3 different passwords one after another before you can use
(reuse) an old password.

Disable the use of
common passwords

If activated, you can create and edit a list which contains passwords
which you can lock for usage. E.g. if you add the entry
'123456789Password' this password can not be assigned from a user.

Force users to
change password
after period of
time

Activated: The user must change his password after the specified period of time elapses.

–

Days before expiry

Deactivated: The password never expires.
Specifies the period of time after which the password expires.

Lock user after
wrong password
entries

If activated, you can determine the number of attempts the user has if
he enters a wrong password. E.g. if you enter '3' , the user can enter
a wrong password for 3 times before his user account is locked.

Lock screen after
certain time span

Activated: After a period of inactivity the screen is locked and the
user must enter his/her password to continue working.
Deactivated: The password never expires.

–

Minutes until
screen lock

Enable Auto-Login

Specifies the time span after which the screen is locked.
§ Activated: No password is required
The user is logged in automatically based on the Windows username.
Create a user group in the software that is based on Windows Active Directory (Type = AD) and ensure that all relevant Windows
users are present in the group and that the group has sufficient
privileges in the software.
§ Deactivated: Each user has to log in with their own password.

Export/Import user
database

Enables you to export or import the user database, including all user
groups and privilege sets, for example to exchange it with another
system.

–

Export...

Specify the location on the file system where the database should be
exported

–

Import...

Select the database location on the file system
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6 Image Acquisition (General)
6.1 Acquiring Multi-Channel Images with Cameras
In the following chapters you will learn how to set-up and run multi-channel experiments quick
and easy.

Info
Make sure that you work with a fully motorized microscope system. In advance all microscope
components (e.g. objectives, filters, etc.) must be configured correctly in the MicroToolBox
(MTB) software.
In principle there are two variants for setting up multi-channel experiments. The first variant uses
Smart Setup, while the second variant uses the Channels tool. Both variants have similarities
and differences, which are presented in the following overview:
Commonalities
§

Fluorescent dyes and transmitted light techniques can be selected from a database.

§

Hardware settings for motorized microscopes, which take the properties of the selected dye
and the available microscope hardware into account, can be created automatically.

§

Bases for experiments can be created using both variants and experienced users can optimize
settings further.

Differences

Smart Setup

Channels tool

A maximum of 4 camera channels, 8 confocal
channels and 1 transmitted light channel are
available

No restriction on the number and type of
channels

Offers up to 3 proposals of variants of the experiment (depending on the selected combination of dyes and available hardware)

-

Offers more optimization of experiment settings by using the Motif buttons

-

Graphic overview of the expected signal
strength for the selected dyes

-

Graphic overview of the expected spectral
crosstalk with the selected dye combinations

-

Display of the excitation and emission spectra
of the selected dyes

-

-

Channels can be configured for dyes that are
not supported (or not supported sufficiently
well) by the available hardware
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6.1.1 Set up a new experiment
Prerequisite ü You have switched on and configured your microscope system and all components.
ü You have successfully started the software.
1. In the Left Tool Area click on the Acquisition tab.
2. In the Experiment Manager click on the
Options button.
à The Options dropdown list opens.
3. To create a new, "empty" experiment, click on the New entry.
4. Enter a name for the experiment, e.g. "3-channel_NEW".

5. To create the experiment, click on the

Save button.

You have created a new, blank experiment. All other settings are now stored in this experiment. If
you make changes to the experiment, an asterisk (*) after the file name appears. This means that
the experiment was modified and not saved. Save your experiments from time to time to ensure
that your settings are not lost.
Note that with a very high number of experiments saved in the Experiment Manager (more than
500) moving from the Locate to the Acquisition tab takes a considerably long time. Delete redundant or no longer used experiments to avoid this lag time.

6.1.2 Variant 1: Smart Setup
1. Click on the Smart Setup button on the Acquisition tab.
à The Smart Setup dialog opens.
2. Select the WF button on top of the dialog.
3. To add a channel, click on the
Add button in the Configure your Experiment section.
à The Add Dye or Contrasting Method dialog opens.
4. Select the desired dye or contrast method.
5. Click on the Add button. Alternatively you can double-click on the entry in the dye database. The dye is then adopted directly into the experiment.
à You have added a channel to your experiment. To add further channels, repeat the last 2
steps.
6. To return to Smart Setup, click on the Close button.
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à You will now see a graphic overview in the Proposals section. This displays the spectra
of the dyes, the expected signal strengths per dye and the spectral crosstalk schematically.

7. To select a proposal (if there’s more than one), for all active configured channels, activate
the proposal.
8. To optimize experiment settings additionally, click on a Motif button.
The Automatic button is set as default.
9. To optimize experiment settings, adopt the suggestion and leave Smart Setup, click on the
OK button.
à The added channels are adopted automatically into the Channels tool.
10. Click on the Set Exposure button in the Action buttons bar on top of the Acquisition
tab.
à The exposure time is now measured for all three channels one after the other. This is
adopted into the settings for the channels. Following the measurement of the exposure
time, the multi-channel image is acquired automatically and displayed in the Center
Screen Area.
11. To save the experiment together with all the settings, click in the Experiment Manager on
the
Options button .
12. In the Experiment Manager click on the Save entry in the dropdown list.
You have set up the multichannel experiment using Smart Setup, executed it and then saved the
configuration. This means that you can repeat the experiment as often as you like using the same
settings.
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6.1.3 Variant 2: Channels Tool

Info
This workflow does not work with LSM systems.
1. Open the Channels tool in the Acquisition Parameter group.

2. From the drop down list, select the channel.
à The Add Dye or Contrast Method dialog opens.
3. Select the desired dye or contrast method. You can search for a dye by entering its name
(or starting letter) in the Search input field.
4. Click on the Add button at the bottom of the dialog or simply double click on an entry.
à The channel will be added to your experiment. To add more channels, repeat the last 2
steps.
5. Click on the Close button.
à You will see the added channels in the Channels tool.
6. Click on the Set Exposure button in the main buttons bar on top of the Acquisition tab.
à The exposure time is now measured for all active configured channels one after the
other. It will be also adopted into the settings for the channels. To set the exposure time
channel specific, use the Set Exposure button in the channel settings of the channels
tool.
7. To save the experiment together with all the settings, click in the Experiment Manager on
the
Options button.
8. Click on the Save entry in the dropdown list.
You have set up the multichannel experiment using the Channels tool, executed it and then
saved the configuration. This means that you can repeat the experiment as often as you like using
the same settings.

6.2 Acquiring Z-Stack Images
Prerequisite ü You have licensed ZEN celldiscoverer, ZEN slidescan, ZEN system, or ZEN pro and additionally licensed the Z-Stack module.
For LSM systems, the Z-Stack module is part of the system license.
ü You have switched on and configured your microscope system including all components.
ü You have set up a new experiment [} 44], at least defined one channel and adjusted focus
and exposure time correctly.
ü You are on the Acquisition tab.
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1. In the Acquisition dimensions section activate the Z-Stack checkbox.

à The All Tracks per Slice selection box appears below the check boxes.
à The Z-Stack tool appears in the Multidimensional Acquisition tool group.
2. Use the All Tracks per Slice option or select the Full Z-Stack per Track option in the selection box.
3. Simply click on the blue bar to open the Z-Stack tool.
You have successfully completed the general preparations. You can now set up Z-Stack experiments automatically or manually.

6.2.1 Configuring a Z-Stack automatically

Info
Note that the automatic Z-Stack configuration will only work, if no LSM tracks are added in the
Channels tool.
1. Make sure that you have placed a sample in the visual field of the camera and that the
sample is roughly in focus. Set the exposure time of the camera fair enough for receiving a
good signal.
2. On the Acquisition tab, in the Z-Stack tool, click on Start Auto Configuration.
3. Confirm the system message by clicking on OK.
à The automatic configuration starts.
à The auto configuration sets the focus position for the first, last and center slice of the ZStack, the number of slices and the interval automatically. The Z-Stack experiment is set
up successfully now.
4. Click on the Start Experiment button to start the experiment.
You have successfully set up and performed an z-stack experiment.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

47

6 Image Acquisition (General) | 6.2 Acquiring Z-Stack Images

ZEISS

Info
§

The auto configuration can last for a few seconds up to half a minute depending on the
acquisition settings. You can check the configuration status on Progress bar in the Status
bar.

§

You can change the area of the sample (Z direction in %) covered by the Z-Stack auto configuration under Tools > Options > Acquisition > Z-Stack section. Smaller values will enlarge the Z-Stack. Bigger values will make the Z-Stacks smaller.

6.2.2 Configuring a Z-Stack manually (First/Last Mode)
Using this mode you set the first and the last plane of the Z-Stack. This mode is suitable if you
don’t know the thickness of your sample exactly.
Prerequisite ü You are in the Z-Stack tool.
1. Activate the First /Last mode by clicking on the First /Last button. This button is selected
by default.
2. In the Live mode adjust the Z-drive until you have reached the upper plane of the Z-Stack.
The blue plane in the illustration shows the actual focus plane.
3. Click on Set First button to set the adjusted Z-Position as first position of the Z-Stack.
4. In the Live mode adjust the Z-drive until you have reached the lower plane of the Z-Stack.
5. Click on Set Last button to set the adjusted Z-Position as last position of the Z-Stack.
à You have set the upper and lower boundaries of the Z-Stack.
6. Click on the Optimal button. This will adjust the number of slices and the best interval according to the Nyquist criteria. Alternatively you can set the desired interval and number of
slices in the input fields manually.
7. Click on Start Experiment button to start the experiment.
You have successfully set up and performed an Z-Stack experiment using First/Last mode.

6.2.3 Configuring a Z-Stack manually (Center Mode)
Using this mode you set the center plane of the Z-Stack. This mode is suitable if you know the
thickness of your sample. It will be the fastest method to set up a Z-Stack in this case.
Prerequisite ü You are in the Z-Stack tool.
1. Activate the Center mode by clicking on the Center button on the top of the tool.
2. In the Live mode adjust the Z-drive until you have focused the center of the sample exactly.
The blue plane in the illustration shows the actual focus plane.
3. Click on the Center button under the settings section to set the actual focus position as
center of the Z-Stack.
4. Click on the Optimal button. This will adjust the number of slices and the best interval according to the Nyquist criteria. Alternatively you can set the desired interval and number of
slices in the input fields manually.
à Depending on which option is selected in the Keep section either the Interval or the
Slices will be held constant.
5. Click on Start Experiment button to start the experiment.
You have successfully set up and performed a Z-Stack experiment using the Center mode.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

48

6 Image Acquisition (General) | 6.3 Acquiring Time Series Images

ZEISS

6.3 Acquiring Time Series Images
Prerequisite ü To set up Time Series experiments you need to license the Time Series module.
For LSM systems, the Time Series module is part of the system license.
ü You have set up a new experiment [} 44], at least defined one channel [} 43] and adjusted
focus and exposure time correctly.
ü You are on Acquisition tab.
1. Activate the Time Series tool by activating the Time Series checkbox in the Acquisition
Dimensions section.
à The Time Series tool appears in the Left Tool Area.
2. Open the Time Series tool.
3. Set length of your time series by the Duration slider. You are able to select an interval
(days, hours, minutes, seconds, milliseconds) or the cycles (1-n) e.g. 10 cycles.
4. Set interval of your time series by the Interval slider, e.g. 5 s.
5. Click on Start Experiment button.
The time series experiment will be started. You`ve successfully learned the basics of how to set up
time series experiments. In our example in 10 cycles after each 5 seconds an image is acquired.
The Time Series image also contains 10 single images.

Info
You can display the individual images via the Time slider on the Dimensions tab.

6.4 Acquiring a Panorama Image Automatically
The field of view of your microscope might be too small for the sample area you wish to acquire.
You can automatically visualize panorama images from a sample area which is larger than the
camera sensor can cover by means of a single snap.
With the Live Panorama tool, you can move the stage while the software automatically acquires
individual images, stitches them together and creates a panorama image.
Note that Live Panorama works for uncoded and un-motorized stages as well as motorized
stages.
Prerequisite ü You have set-up and configured your microscope system correctly.
ü You work with brightfield or widefield illumination.
ü Your image has sufficient contrast. Lower magnificantion objectives typically give better results.
ü A sample is on the stage and stays in focus. Note that you can adjust the focus during the
Live panorama.
ü You have started the software and selected the Locate tab. If you work with an LSM, activate
camera mode.
1. On the Locate Tab, click the Live button to get a live image from the microscope camera.
Adjust the camera and microscope settings to see a well illuminated and sharp live image.
2. Navigate to a specific area on your sample you want to image.
à Move the stage gently and not too fast!
3. Select the Live Panorama tool, and click the Start Live Panorama button.
à After a short moment, the camera rectangle changes to green and you can move the
stage. The panorama acquisition starts. You see the live image of the sensor area.
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à Note that the color of the rectangle changes to orange or red, when the software loses
the stitching algorithm. This might happen if the stage is moved too quickly. Then you
have to manually go back to the last known or successfully synchronized position. If you
wish to image a continous area of the sample without any gaps, we recommend using a
zig-zag pattern to move over your sample to slowly build up the image.

4. Move the stage slowly in the desired direction.
à During the stage movement the software automatically acquires the panorama image.
5. To finish the acquisition, click Live Panorama tool | Stop button.
à A message is displayed, prompting you to decide if you want to generate an image pyramid to optimize the later display of your image.
6. Click Yes.
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The panorama image is added to the Documents tab | Images and Documents tool.
Stitching artifacts can be corrected by making sure the camera rotation has be corrected. You can
make use of the stitching image processing function to correct them.
You can save the image to your file system.
For more information, see Live Panorama tool [} 683].

6.5 Acquiring EDF Images Manually (ZEN lite)
The module Manual Extended Focus for ZEN lite allows to create one single image, out of several acquisitions with different focus positions. The sharp areas of all acquisitions are combined to
one consistently sharp image, the so called EDF image (EDF = Extended Depth of Focus).
Preconditions
To work with the module Manual Extended Depth of Focus, the following conditions must be
fulfilled.
§

You have licensed your module and ensured that in the menu Tools > Modules Manager
the function Manual Extended Focus is activated via the checkbox.

§

The tool Manual Extended Depth of Focus is now shown on the Locate tab.

6.5.1 Prerequisites
Prerequisite ü You are on the Locate tab.
1. Click on the Live button to open the live image.
à The Live button changes to a Stop button during a live image.
2. For the extended focus acquisition look for a suitable position on the sample.
3. Click on the Stop button to switch off the live image.
You have made all necessary arrangements. For EDF image acquisition you have now three modes
available. These will be revealed in the following chapters.

6.5.2 Acquiring EDF image with Timer mode
In this mode, after a freely selectable interval, a new picture will be automatically added. In the
period between the acquisitions you can set a different focus position. After each recording a new
image with an extended depth of focus is immediately calculated. When you finish the acquisition
you will get the image which was calculated last.
Prerequisite ü You are in the tool Manual Extended Depth of Focus.
1. To acquire Z-Stacks, activate Z-Stack.
2. Select the Timer mode.
3. Adjust the length of your interval by the Interval slider. Set the interval long enough, to
move the specimen comfortably to a new focus position. After lapse of time, an image of
your actual position will be automatically acquired.
4. Click on the Start button to start the acquisition. The Start button will only be active when
the live image is closed.
à The Central Screen Area will be split into two parts. Right you will always see the current live image, left you will see after each new acquisition the actual calculated extended focus image.
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5. Set a new focus position after each acquisition. Repeat this procedure until you are satisfied
with the result.
6. To finish your acquisition, click on the Stop button. If you click on the Pause button you
are able to pause the acquisition.
You have successfully acquired an image, showing the extended depth of focus, with the Timer
mode.

6.5.3 Acquiring EDF image with F12 Key mode
In this mode you can achieve different time intervals between the individual focus steps. By pressing the F12 key on your keyboard, you can manually record a new image. Between the acquisitions, you can change the focus position.
Prerequisite ü You are in the tool Extended Depth of Focus.
1. To acquire Z-Stacks, activate Z-Stack.
2. For Mode, click on F12 Key.
3. Click on the Start button. The Start button will only be active when the live image is
closed.
4. Press the F12 key on your keyboard to initiate manually, each acquisition with a different
time step.
5. Select manually a new focus position.
à Repeat the last two steps until you have sharp images from all desired areas of your sample.
6. To finish the acquisition, click on the Stop button.
You have successfully acquired an image, showing the extended focus, with the F12 key mode.
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6.5.4 Compare Images using Split Display
Prerequisite ü You have already acquired images with extended depth of focus which you want compare to
each other.
1. To compare images click on the Create new multiple image button
.
2. In the view options on the Split Display tab define an arrangement of 2x2 images to be
shown aside .
3. Move the images via Drag & Drop from the Image and Documents gallery in the right
tool area, to the Center Screen Area. If necessary, click the show/hide button to show
the Image and Documents gallery.

The comparison of all 4 methods used (via Timer, F12-key, Z-stack without shift, Z-stack with
shift) shows identical resulting images.

Fig. 8: Image comparison with multi image
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6.6 Cryo Acquisition in ZEN
To be able to acquire cryo images in ZEN, several prerequisites have to be fulfilled:
§

The Linkam Cryo stage has to be set in the MTB configuration.

§

You have licensed the Linkam Cryo module.

§

In Tools > Modules Manager > Optional Hardware, the Linkam Cryo module has to be
activated.

§

To be able to control the hardware, you need the software version ZEN Pro or ZEN Systems. All other versions of ZEN can only read the temperatures from image metadata.

6.6.1 Exporting temperature data
You can export the temperature data which are logged during the acquisition of cryo images in
ZEN. The export depends on the software version you have started.
Export with ZEN Pro or ZEN System
This export is only possible with ZEN Pro or ZEN System.
Prerequisite ü You have opened the image where you want to export the temperature data.
1. In the Cryo Temperature tool, click on Export Temperature Data.
à The temperature data is displayed as table in ZEN.
2. In the Export tab, click on Export Table.
3. In the file browser, select the storage location and click on Save.
You have exported the image temperature data.
Export without ZEN Pro and ZEN System
This export is possible in all ZEN versions (also in ZEN Pro or ZEN System).
Prerequisite ü You have opened the image where you want to export the temperature data.
1. Click on the Measure view.
2. In the Measurement tab, click on Export Temperature Data.
à The temperature data is displayed as table in ZEN.
3. In the Export tab, click on Export Table.
4. In the file browser, select the storage location and click on Save.
You have exported the image temperature data.

6.6.2 Adding temperature annotations to an image
Temperature data of images is saved in the metadata. To display the information directly in the
image you need to create an annotation which can be displayed in the image.
1. Open your image in ZEN.
2. In the view options below the image, click on the Custom Graphics tab.
3. Click on Customize.
à The Customize Tools dialog opens.
4. Under Frequent Annotations, select Other and click on
.
à The annotation is now visible in the User Toolbar list on the top of the dialog.
5. In the User Toolbar list, right click on Other... and select Format Custom Graphics.
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à The Format new custom graphic tool dialog opens.
In the Annotation dropdown list, select ....
à The Select Metadata dialog opens.
In the list, select your metadata (Cryo Stage Bridge Temperature, Cryo Stage Dewar Temperature, Cryo Stage Chamber Temperatur).
Click on OK to close the Select Metadata dialog.
If necessary, change other parameters of the graphic.
Click on OK.
Click on Close to exit the Customize Tools dialog.

Your custom graphic is now available on the Custom Graphics tab. You can add it to your image
and see the temperature information displayed directly in the image.

6.7 Using the Dye Editor
The ZEN software is delivered with a large number of preset dyes. Dyes and its parameter are
stored in the dye database. In case you have created a custom made filter cube, you may need
additional dyes.
You can create new dyes and a custom dye database with the Dye Editor in the Tools menu.

6.7.1 Dye Editor Dialog
1

2

3

4

Fig. 9: Dye Editor Dialog

1

Menu
Here you can create new data sets and import available dye databases. A detailed description can be found under Dye Editor Menus [} 56].
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2

Dye search & database
In this list you see the dyes that are available in the open database. You can search for
dyes and see which dyes you edited last.

3

Dye information area
Here you see all the additional information about a selected dye.

4

Dye spectra
Here you see the available dye spectra. Click on the relevant tabs to display the emission, excitation, or extinction spectra. On the Overview tab you can see all spectra at
a glance.

See also
2 Creating a Custom Dye [} 57]
6.7.1.1 Dye Editor Menus
File menu

Menu item

Description

Short cut

New

Creates a new ExEml file in which you can create dye
data sets.

Open file...

Opens a single ExEml file.

Open folder...

Opens several ExEml files that have been saved together in the same folder.

Import file...

Imports an ExEml file.

Save...

Saves the open ExEml file.

Save As...

Saves the open ExEml file under a new name.

Save As Folder...

Saves all open ExEml files in a folder.

Close

Closes the Dye Editor.

Ctrl+F4

Menu item

Description

Short cut

Add new...

Creates a new, empty data set.

Copy

Copies the selected data set to the clipboard.

Ctrl+C, Ctrl
+Ins

Cut

Cuts the selected data set and copies it to the clipboard.

Ctrl+X,
Shift+Del

Delete

Deletes the selected data set.

Paste

Pastes a data set from the clipboard.

Paste Part

Pastes a range of a data set from the clipboard.

Ctrl+S

Dataset menu
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Tools menu

Menu item

Description

Generate short
names...

Creates abbreviations for names of dyes. This helps to avoid duplication.

Update max.
wavelength ermitter properties

Calculates the main emission wavelength of the selected dye from
spectral data that has either been copied or entered manually.

6.7.2 Creating a Custom Dye
If non of the preset dyes matches your requirements, you can create a new custom dye.
1. Open the Dye Editor via Tools > Dye Editor....
à The Dye Editor dialog [} 55] opens.
2. In the File menu, click the Save As Folder... entry.
3. In the Windows dialog, create a new folder to save your custom dye database,
e.g. C:/User/Documents/Carl Zeiss/ZEN/Documents/New Folder.
Name the new folder, e.g. New Dyes.
à You have created a custom dye database to which all new dyes are stored.
4. Click on the New Dye entry in the Exeml Collection list.
à The properties section opens.

5. In the Names section, click in the Name input field to change the name of the custom dye.
à The name enables you to find your custom dye in the Smart Setup or Channels tool.
6. Fill in other known parameters in the following sections, e.g. Providers, Properties, References.
7. Change to the Emission tab.
8. To fill in Wavelength (nm) and Spectrum value to the table on the right, you have 3 options:
§

Type in data manually. [} 58]

§

Copy and paste data from e.g. an Excel sheet. [} 58]

§

Copy and paste data from a preset dye. [} 58]
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6.7.2.1 Type in Data Manually
Prerequisite ü You have created a new dye in the Dye Editor dialog.
ü Your are on the Emission tab.
1. In the Wavelenth (nm) | Spectrum value table, click on the Plus icon.
Add 10 rows, by pressing Shift and the Plus icon.
Add 100 rows, by pressing Alt+Shift and the Plus icon.
2. Type in the corresponding Spectrum Value in the input fields.
à The emission graph is displayed next to table.
3. Save the dye via File | Save....
You have saved a new dye in your custom database.
You can use the new dye in the Smart Setup or in the Channels tool.
6.7.2.2 Copy Data from an Other Source
If you have recorded Wavelength (nm) and Spectrum value of your custom dye in an other
source e.g. an Excel sheet, you can copy the data and paste it directly into the Dye Editor dialog.
Prerequisite ü You have created a new dye in the Dye Editor dialog.
ü You have opened your source, e.g. an Excel sheet with the emission data.
1. Arrange the data in two columns like on the Emission tab.
2. Mark the data and copy it via Ctrl+C. Alternatively, right-click on the marked area to open
the shortcut menu and select Copy.
3. Change to the Dye Editor dialog.
4. On the Emission tab, click in the first row of the Wavelength (nm) | Spectrum value table an press Ctrl+V. Alternatively, right-click in the first row to open the shortcut menu and
select Paste.
à The emission data is inserted in the table and the emission graph is displayed next to the
table.
5. Save the dye via File | Save....
You have saved a new dye in your custom database.
You can use the new dye in the Smart Setup or in the Channels tool.
6.7.2.3 Copy Data from a Preset Dye
If the data of a preset dye, e.g. the emission data of the DAPI dye resembles your custom dye, you
can copy the data from the preset dye into a new custom dye.

NOTICE
Do not edit preset dyes
Editing preset dyes leads to irreversible data loss.
Note that you should therefore only copy the data set of a preset dye.
Prerequisite ü You have created a new dye in the Dye Editor dialog.
1. Open a second Dye Editor dialog via Tools | Dye Editor....

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

58

6 Image Acquisition (General) | 6.7 Using the Dye Editor

ZEISS

2. Confirm the occurring dialog with Yes.
Perform the following steps to open the ZEN Dye Database in the second Dye Editor dialog:
3. In the File menu, click on the Open folder... entry.
4. In the Windows dialog, open the DyeDataBase with all preset dyes by following the file
path:
C:/Program Files/Carl Zeiss/ZEN/ZEN 2 (blue edition)/ZEN/Resources/DyeDataBase
à All preset dyes are displayed in the second Dye Editor dialog.
5. Use the Search input field, to quickly find a preset dye with similar values, e.g. DAPI.
6. Select the desired dye.
7. Click on the Copy the current dataset as XML button.

8.
9.
10.
11.

Alternatively, click Dataset | Copy.
à The emission data is copied to the clipboard.
Change to the first Dye Editor dialog, to edit your custom dye.
In the Dataset menu select Paste Part | Spectra | Emission | Data.
à The emission data from the preset dye is copied into your custom dye.
Edit the custom dye emission data, until it matches your requirements.
à The emission graph is displayed next to the table.
Save the dye via File | Save....

You have saved a new dye in your custom database.
You can use the new dye in the Smart Setup or in the Channels tool.

Info
You can paste other properties of preset dyes just as the emission data, e.g. All Spectra data
or Emitter Properties.

6.7.3 Adding a New Dye to the Data Set
Prerequisite ü You have successfully created a first custom dye and a custom dye database, see Creating a
Custom Dye [} 57].
ü You have opened the Dye Editor dialog.
1. In the Dataset menu select New....
à The Create new dataset dialog opens.
2. Enter an ID for your new dye, e.g. DyeC2 and confirm with OK.
à The entry Unnamed other dye appears in the Exeml Collection list.
3. Add a name for the new dye by clicking on the Plus icon in the Names section.
4. Enter a name in the Name input field.
5. Edit the properties of the new dye, see
Type in Data Manually [} 58] or
Copy Data from an Other Source [} 58] or
Copy Data from a Preset Dye [} 58].
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6.8 Setting an experiment as startup default
Any experiment can be set as a startup default indicated by a

symbol.

If you want to set an experiment as startup default, the following steps are necessary.
1.
2.
3.
4.

In the menu bar click on Tools > Options....
Click on Startup/Shutdown.
In the Experiment section, select Load Default Experiment from the drop down list.
Click on OK.
à The Options dialog closes.
5. Configure your experiment for startup default or select an existing experiment.
6. Click on the options button

and select Set As Start up Default.

The actice experiment is set as startup default now and marked with the

symbol.

This experiment is loaded when starting the ZEN software.

6.9 Creating default experiments as templates automatically
It is possible to generate an experiment template. This cannot be modified but used as a starting
point for your acquisition.
If you want to generate an experiment template, the following steps are necessary.
1. Create an experiment.
2. In the menu bar, click on Help > About ZEN...
à The About ZEN dialog appears.
3. Click on Show ZEN Information.
à The Application Information dialog appears.
4. Open the Folders tab, scroll to the Experiment Templates entry, and double click on it.
à The folder Experiment Setups will open.
5. Export the experiment generated before into the Carl Zeiss\ZEN\Templates\Experiment
Setups folder.
6. Create a descriptive name for the experiment template.
You have successfully created an experiment template.
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It is possible to generate and save multiple templates.
To apply an experiment template, see chapter Applying an experiment template [} 61].

6.10 Applying an experiment template
If you want to apply an experiment template as a starting point for your acquisition, the following
steps are necessary.
Prerequisite ü The experiment template to be used has been created before, see chapter Creating default
experiments as templates automatically [} 60].
1. On the acquisition tab, click on the options button
and select New from Template.
à The available experiment templates will be shown on the right side.
2. Click on the name of the appropriate template.
The selected experiment template will be loaded as starting point for the acquisition.

6.11 Adding Annotations to Images or Movies
You can add annotations to visualize a specific region or to add metadata or specific measurement information to images and movies.
You can use the annotations within several workflows and functionalities:
§

For your own information, you can display metadata to images and movies.

§

When working with mean ROI, you use the annotation functions to draw regions into the image.

§

When analysing images manually, you can record your measurement results in the image.

§

When exporting images or movies, you can add annotations that are visible in the export format of your images and movies.

You can use the annotation functions on the Graphics tab as well as in the Graphics menu. For
information on the Graphics menu, see Graphics Menu [} 620].
Prerequisite ü You have acquired or loaded an image or a movie.
1. In the Center Screen Area select the Graphics tab.

2. Click on one of the icons to add an annotation or a measurement.
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Remove Annotations
1. Select the annotation in the Image view or in the Selection table, and press the Del key.
Alternatively, right-click the annotation and select Delete.
Additionally, the annotations can be edited, rearranged, and formatted. For more information,
see Editing Annotations in Images or Movies [} 62].

See also
2 Graphics Tab [} 894]
2 Custom Graphics Tab [} 901]

6.12 Editing Annotations in Images or Movies
You can edit, rearrange and format annotations in an image or movie.
Edit Annotations
You can change the annotations type or the unit of the time or of the measurement.
1. To edit text in a textbox, double-click the textbox and change the text.
2. In the image, select the annotation and right-click to open the context menu. Select Format Graphical Elements.
à The Format graphical elements dialog opens.
3. Edit the annotation and click Close to save.
Rearrange Annotations
1. Select the annotation with the left mouse button and drag and drop the annotation to another position.
Format Annotations
1. In the image, select the annotation and right-click to open the context menu. Select Format Graphical Elements.
à The Format graphical elements dialog opens.
2. Format the annotation and click Close to save.

See also
2 Format Graphical Elements Dialog [} 898]
2 Adding Annotations to Images or Movies [} 61]
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7 Confocal Image Acquisition (LSM)
7.1 Acquiring Confocal Images
To acquire confocal images you first have to setup the acquisition parameters and configure your
experiment. Therefore we recommend to use Smart Setup as this will automatically give you certain suggestions for the experiment configuration, e.g. Airyscan acquisition or camera based acquisition. In the following guide you will learn how to use Smart Setup and acquire a first confocal
image. Because there`s a huge variety of samples (and suitable experiment configurations) this
guide shows the necessary basics only.
Prerequisite ü You are on the Acquisition tab.
1. Click on Smart Setup.
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Add.

à The Add Dye dialog opens.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

64

7 Confocal Image Acquisition (LSM) | 7.1 Acquiring Confocal Images

ZEISS

3. Select the dyes used in your experiment. Double click on a dye entry to add it to the list.

4. Click on Ok to close Smart Setup.
5. Make sure that the cover glass of you sample points towards the objective.
Use the appropriate immersion medium for the objective.
6. Click on Live to start a live scan.

à You will see the image of your sample in the center screen area.
7. Search the desired sample area and focus with the joystick. Alternatively use the mouse
wheel while pressing the Ctrl key.
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8. Click on Stop to stop the live scan.

9. Click on Set Exposure to automatically adopt the sensitivity of the detector to the sample
brightness.
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10. Optional: If you work with weakly stained samples you can try to increase the laser power
under Channels | Lasers. Then repeat the last step by clicking on Set Exposure.

à The sample is adjusted correctly.
11. Click on Snap to acquire a single confocal image.

You have successfully acquired a confocal image. Save the image in the Images and Documents
tool or under File | Save.
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7.2 Using Smart Setup with Airyscan LSM 980 and LSM 900
After selecting samples and overall preference for speed (single track, more crosstalk) or signal
(multi track, less crosstalk), you can choose LSM confocal or Airyscan 2 detection modes in Smart
Setup.

LSM confocal acquisition
Prerequisite ü Smart Setup is open.
1. Select LSM at the detection selection on the right.
2. Click on OK to activate the acquisition settings.

Airyscan 2 detection mode
Prerequisite ü Smart Setup is open.
1. Select Airyscan at the detection selection on the right.
2. Click into the triangle depending on your preference for resolution, speed and SNR/sensitivity.
3. Click in one of the areas in the lower left corner to activate available modes with super resolution image quality.
Depending on how close the selected area is to Speed, the amount of parallelization in
pixel acquisition will increase.
4. Click in one of the areas on the line at the right between SNR/Sensitivity and Speed to
activate modes with at least confocal image quality. Depending on how close the selected
area is to Speed, the amount of parallelization in pixel acquisition will increase.
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7.3 Using the Sample Navigator with LSM 980 and LSM 900
The Sample Navigator wizard is a tool to find the focus plane and quickly acquire an overview
scan of your sample. You can also simplify the search for a region of interest for the actual imaging experiment. Together with Smart Setup, it allows to set all basic settings for a new sample
without extensive search of the sample by the eyepieces.
1. In the Acquisition tab, click on the Sample Navigator button.
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à A wizard shows up which guides you through the required steps. On the left you find
general settings, in the middle temporary information and steps to do.

2. Put a sample on the stage and center the sample with some structure over the center of
the objective.
The preferred objective to use is a 2.5x overview objective. Alternatively, 5x and 10x objectives can be used if a Axiocam is available on your system. If no Axiocam is present, the
LSM T-PMT will be used for detection.
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3. Select a checkbox with the wavelength that matches the label of your sample.

à You are asked whether this sample was already focused, or if a new sample was put on
the microscope. With a new sample, you are asked to focus the objective a bit closer
than the putative focus plane. This is because the autofocus will move away from the
sample when searching for the focus plane.
4. Click on Objective is now close to the sample to confirm.
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5. Click on Next at the bottom of the wizard.
à This guides you to Step 2, which selects the sample carrier
6. Select a matching sample carrier type from the selection list in the middle.
The coverage degree can be selected with the three buttons Small, Middle and Full. Full
means full coverage of the Cover slip area.

à The selected coverage is displayed by a red area on the sample carrier drawing.

7. Click on Next at the bottom of the wizard .

à This guides you to Step 3, which selects the Kondensor Filter in case the T-PMT was selected as detector.
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8. Since Sample Navigator uses transmitted fluorescence with the T-PMT, a laser blocking
filter needs to be inserted. This filter is located in one of the DIC positions of the condenser,
and labelled T-FL. Also, correct Köhler adjustment is needed. Setups with Sample Navigator have a line marking at the condenser carrier, which helps to find the right position.

9. Click on Next at the bottom of the wizard .

à This guides you to Step 4, which is the autofocus step.
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10. Click on Focus Detection to start the autofocus, and observe the image in the middle.
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11. If the image is over- or underexposed, the light intensity needs to be adjusted with the
slider Light Source Intensity.

12. In case the autofocus result is not suffient, correct it by manually focussing the sample with
the focus drives or CTRL+mouse wheel.
13. Click on Finish to start the automatic overview tile scan.

The wizard is closed and a new image container opens.
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The overview image can be used to navigate to ROIs, by a double klick on an interesting structure.
This will re-center the stage. Proceed with normal image acquisition by setting up acquisition parameters for a higher magnification objective.

7.4 Acquiring LSM 900 images with Airyscan 2 multiplex modes
Multiplex modes allow a faster image acquisition with Airyscan 2 detectors. The acquisition is parallelized in the Y-direction, which allows to process full SR or confocal resolution though not every
line in Y was scanned during acquisition. The Airyscan 2 detector has nonetheless acquired data
for all lines in the image.
1. On the Acquisition tab, in Imaging Setup select Airyscan MPLX in the drop down list.

à The respective Airyscan mode menu will be displayed in the Acquisition Mode tool.
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2. Click on SR-2Y to activate a parallelization of 2 lines in the Y-direction. Alternatively, if no
super resolution is required, click on CO-2Y.
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3. If 2x parallelization is not fast enough, click on SR-4Y to activate a parallelization of 4 lines
in the Y-direction. This mode always delivers super resolution results. For confocal resolution, click on CO-2Y.
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7.5 Acquiring LSM 980 images with Airyscan 2 multiplex modes
Multiplex modes allow a faster image acquisition with Airyscan 2 detectors. The acquisition is parallelized in the Y-direction, which allows to process full SR or confocal resolution though not every
line in Y was scanned during acquisition. The Airyscan 2 detector has nonetheless acquired data
for all lines in the image.
1. On the Acquisition tab, in Imaging Setup select Airyscan MPLX in the drop down list.

à The respective Airyscan mode menu will be displayed in the Acquisition Mode tool.
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2. Click on SR-4Y to activate a parallelization of 4 lines in the Y-direction.
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3. If 4x parallelization is not fast enough, click on SR-8Y to activate a parallelization of 8 lines
in the Y-direction. This mode always delivers super resolution results.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

81

7 Confocal Image Acquisition (LSM) | 7.5 Acquiring LSM 980 images with Airyscan 2 multiplex modes

ZEISS

4. If no superresolution is required, click on CO-8Y. The highest speed can be selected in
CO-8Y mode, with confocal resolution results.
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5. The slider between these buttons allows to select any sampling between these sampling
points.
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6. It is also possible to select a desired image format, e.g. 1024x1024 pixels. The slider will
then display the sampling factor deriving from the selected zoom or crop area.
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Additional information for using Z-stacks:
The Z stepping is not automatically adjusted to the sampling mode, but is set to secure maximum
resolution. The button Optimal and the checkbox Optimize Sectioning and Step in the ZStack menu set the acquisition for optimal oversampling in Airyscan SR resolution.
Faster volume speed can be achieved by intentionally selecting a wider Z stepping e.g. for CO-8Y
mode. The recommendation for a fast CO-8Y stack would be 1.5x – 2x the calculated optimal interval. Deselect the check box Optimize Sectioning and Step to choose your interval manually.
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8 Working with Focus Strategies
8.1 Introduction
If you want to work with focus strategies you have to use the Focus Strategy tool. There you
can select the suitable strategy and adjust the corresponding settings, e.g. defining Z-positions
manually or automatically and update these during the experiment. Note that the availability of
certain focus strategies depends on your system and available components (e.g. Definite Focus.2).
General Preparations
Prerequisite ü To use focus strategies, you will need a motorized focus drive/Z-drive.
ü You are in the Left Tool Area on the Acquisition tab.
ü You have created a new experiment [} 44], defined at least one channel [} 43] and adjusted
the focus and exposure time.
1. Activate the acquisition dimensions (e. g. Tiles, Time Series) that you want to use for your
experiment.
2. Open the Focus Strategy tool.
à The available focus strategies are displayed in the dropdown list.
à The number of focus strategies available depends on the activated acquisition dimensions
(e.g. tiles, time series), the available hardware devices (e.g. definite focus) present, and
software license (e.g. Software Autofocus and Tiles module allow additional focus
strategies).
3. Decide which strategy is best suited to your experiment. In case of a Tiles experiment the
software will automatically select the most appropriate focus strategy if you have not previous selected one. For a detailed description of all strategies, read the chapter Focus Strategy Tool [} 711].
You have successfully completed the general preparations. Now follow one of the following sets
of instructions for specific focus strategies.

8.2 Using Software Autofocus
Select this focus strategy to automate the focusing of your specimen before and during acquisition with the help of the Software Autofocus. This is particularly useful for Time Series or Tiles
experiments.
Prerequisite ü To use the Software Autofocus focus strategy, you will need the module.
For LSM systems, the Autofocus module is part of the system license.
ü You have completed the general preparations [} 86] for using focus strategies (experiment
created, at least one channel defined, acquisition dimensions activated).
ü You are on the Acquisition tab in the Focus Strategy tool.
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1. Select the Software Autofocus entry from the dropdown list. Note that the Z values defined by Tiles Setup are ignored.

2. In the Reference Channel section select the channel that you want to use for the focus
action from the list. Expand the section if you don`t see it in full. Note that the reference
channel does not necessarily have to be a acquisition channel. Not all acquisition modes
can be used as reference. For LSM 980 LSM Lambda tracks and Online Fingerprinting cannot be selected as reference channels. Also, Airyscan SR and MPLX tracks might fail when
using such tracks as reference for reflex autofocus function.
3. Click on the Set as Reference Channel button.
4. In the Time Series Loop and/or Tiles Loop sections of the Focus Strategy tool you can
define when focus actions should be performed during the course of the experiment.
5. Open the Software Autofocus tool.
6. Adjust the autofocus settings (e.g. Quality, Sampling, etc.) to your experiment conditions
or use the default settings first.
7. Set up your tile and/or time series experiment.
8. To start the experiment, click on the Start Experiment button.
You have successfully used the Software Autofocus to bring images into focus automatically during the experiment.

8.3 Using Definite Focus in Time Series Experiments
Select this focus strategy to use the definite focus device to stabilize the focus in the event of temperature fluctuations during your Time Series experiments.
Prerequisite ü To use the Definite Focus focus strategy, you will need the Definite Focus hardware device.
ü You have completed the general preparations [} 86] for using focus strategies.
ü You are on the Acquisition tab in the Focus Strategy tool.
1. Select Definite Focus as focus strategy from the dropdown list. Note that Z values defined
by Tiles Setup are ignored.
2. In the Stabilization Event Repetitions and Frequency section select Standard mode.
This mode will use our recommend default settings for stabilization. When selecting the Expert mode you can adjust all settings according to your needs.
3. Set up a Time Series experiment, see Acquiring Time Series Images [} 49].
4. Use the Live mode to set the focus position using the focus drive.
5. To start the experiment, click on Start Experiment.
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à Definite Focus is initialized at the start of the experiment at the current focus position.
The focus is then stabilized in accordance with your settings during the time series experiment. You will be reminded to set the focus accordingly prior to the experiment starting.
You can do this by navigating to a suitable location (position or Tile region) and starting
live or continuous. You can then continue with the experiment or cancel it.
You have successfully used the Definite Focus to stabilize the focus during a Time Series experiment.

8.4 Using Local or Global Focus Surfaces
For Local or Global Focus Surfaces you need to select the focus strategy Use Z Values/ Focus
Surface defined in Tiles Setup. This strategy is selected by default, if you have licensed the
Tiles module. Then you can acquire tiles images along local or global focus surfaces (tile region
specific/position specific) and use the focus strategy for optimal image results.
A local/global focus surface ensures that all tiles are in focus on tilted or irregular specimens. Local
focus surfaces for tile regions are interpolated on the basis of the focus positions of support
points. Positions automatically have a horizontal focus area with the Z-value of the position.
The following guide explains how to use the focus strategy for local focus surfaces.
Prerequisite ü To use the Use Z Values/ Focus Surface defined in Tiles Setup focus strategy, you need a
licence for the Tiles module.
ü You have read Introduction [} 86] for using focus strategies (experiment created, at least one
channel defined, acquisition dimensions activated).
ü You are on the Acquisition tab in the Focus Strategy tool.
1. Select the Use Z Values/ Focus Surface defined in Tiles Setup entry from the dropdown
list (if not selected by default).
2. If you want to set up the entire focus strategy, you can click on Optimize this focus strategy
to use the Focus Strategy Wizard [} 716].
3. In the Z Values/ Focus Surface section select Local (per Region/Position).
4. Under Initial Definition for Z-Values/ Focus Surface select the By Tiles Setup entry
from the dropdown list.

à
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5. Set up a Tiles experiment. For more information, see also the chapter Tiles & Positions with
Advanced Setup [} 515].
6. Create a local focus surface for the tile regions, see Creating a Local Focus Surface
[} 522].
7. To start the experiment, click on the Start Experiment button.
The tiles of tile regions and positions are acquired using the local focus surfaces.
If you are performing a Time Series experiment we recommend to use the Adapt Z Values/ Focus Surface functions, see Focus Strategy Tool [} 711]. By these you can correct the focus for
small drifts that occur in long multidimensional time series experiments with living cells, for example.
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9 Image Processing
9.1 Image Processing Workflow
On the Processing tab you can apply image processing functions (IP functions) to acquired or
loaded images. The basic workflow is quite simple:
§

Acquire or open an image that you want to process.

§

Open the Processing tab.
When you open the tab, the last active image (e.g from Acquisition tab) will be used as the input
image for the processing function.
If you want to select an other input load the new image under Image Parameters | Input.
Note that the image must be opened in ZEN before.

§

Select the desired processing mode (Single / Batch). Per default, single processing mode is
selected. Batch processing allows to apply a specific processing function automatically to a
batch of images.

§

Select the desired processing function under Method, e.g. Color Balance.
You can search for processing functions in the Search field. Therefore just enter the initials of
the functions you want to search.

§

Set the parameters of the function under Parameters.
If you need help for a specific function and its parameters press the F1 key. You will find detailed descriptions for each functions in the online help.

§

To see how the functions works you can click on the Preview button under Image Parameters | Output.

§

Click on the Apply button to apply the processing functions to the image.
This will create a new image in a new image container. The original image will not be
changed.

See also
2 Processing Tab [} 664]

9.2 General Settings
Save/Load Settings
In the Settings section at the top of a function's Parameters tool you are able to save and
reload the adjusted settings. If you have adjusted the parameters for a function, simply click on
Options > New to save your setting under a new name.

Fig. 10: Settings section
Adjust Settings per Channel
If your input image is a multichannel image, all settings can be adjusted individually for each
channel. Therefore the checkbox Adjust per Channel must be activated.
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Third Dimension Settings
If there are more dimensions in the input image and/or the Show all mode is activated the Third
Dimension dropdown list becomes visible. There you can select to which dimension you want to
apply the function additionally. Several choices are available, depending on your input image:

Parameter

Description

Third Dimension

Only visible, if there is a third dimension in the input image and/or
Show all mode is activated.
Here you can select how you want the function to work in the case of
multidimensional images.

-

2D Slices

The function is used in a 2-dimensional fashion only for multidimensional images such as time lapse or z-stacks.

-

Z, T or C

Here you can select to which additional dimension the functions
should be applied to. If you select the C (channel) dimension, the Adjust per Channel checkbox is not available.

Adjust per Channel

Only available for images with multiple channels and if C is not selected as Third Dimension.
Activated: Opens a list with the channels to allow an individual adjustment of each channel. For every channel you have the following
options:

–

Process Channel

Processes this channel according to the input.

–

Skip Channel

Skips this channel when processing. This channel will not be in the
output image.

–

Copy Channel

This channel is copied into the output image without a reduction of
noise.

Reset Settings to Default
You can reset the settings for a function to default by clicking on the Defaults button.

9.3 Performing Deconvolution Using Default Values
Successful deconvolution depends mainly on good image quality, knowledge about the optical
parameters of the sample and detailed knowledge about the type of instrument used for image
acquisition. While information about the used instrument type can be easily extracted from the
image metadata, optical parameters of the sample might not be known and the image quality can
vary widely. Many parameters are available for deconvolution which allow you to make corrections to the image quality and adjust the algorithms to match the various optical condiditions
such as coverslip type or the medium, in which the sample is embedded. This wide range of parameters can be overwhelming.
With the Deconvolution (defaults) method, good initial result are achieved by using a carefully
preselected set of default parameters. The parameters are automatically adapted to the following
instrument types: widefield, confocal, lightsheet and ApoTome.
While these parameters usually give nice results, there are cases, where further parameter
changes will be necessary, e.g., activating and using spherical aberration correction. In such cases,
you should use the Deconvolution (adjustable) method.
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Prerequisite ü You are on the Processing tab.
ü You have acquired or opened a fluorescence image on which you wish to perform deconvolution.
ü All tools are in Show All mode.
1. Under Method Selection, open the Method tool.
2. Click on the Deconvolution group.
à You will see the methods Deconvolution (defaults) and Deconvolution (adjustable).
3. Click on Deconvolution (defaults)..
4. Under Method Parameters, open the Parameters tool.

5.
6.

7.
8.

à Here you will see 4 different algorithms for deconvolution (Nearest Neighbor, Inverse
Filter, Fast Iterative, Iterative), which you can apply to your image automatically.
To select an algorithm, click on the relevant entry.
Under Image Parameters, open the Input tool.
à You will see the Input tool. If the Set Input Automatically checkbox is checked, the
currently active image has been loaded as input image automatically. If the checkbox is
unchecked, the container for the input image is empty. In this case continue with step 7.
Click on the empty image container.
à A list opens with preview images of all currently open images.
Click on the image to which you want to apply deconvolution.

à The image can now be found in the image container and will be used as the input image
for processing.
9. Click on the Apply button on the top to perform deconvolution, .
Deconvolution is performed. A new image file is generated and is opened automatically in the
center screen area after processing. If you are satisfied with the result, save the processed image.
Repeat deconvolution using the other default values to obtain different results. If you have expert
knowledge, you can configure all the deconvolution settings yourself using the Deconvolution
(adjustable) method.
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9.4 Performing Configurable Deconvolution
These instructions explain how to deconvolve a Z-stack image correctly step by step.
We will use the best method Constrained Iterative and a theoretical PSF.
Preparation
To follow these instructions you will need a Z-stack image of your sample. You have opened the
software and no images are loaded.
Overview
The following steps are described in these instructions.
Prerequisites
§

You are on the Processing tab.

§

You have acquired or opened a fluorescence image on which you wish to perform deconvolution.

§

All tools are in Show All mode.

Steps
§

Step 1: Load input image
In this section you will find out how to load an input image in Deconvolution (Configurable).

§

Step 2: Set parameters

§

In this section you will find out how to set the parameters.

§

Step 3: Process image
In this section you will find out how to process the image and compare it with the input image.
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9.4.1 Step 1: Load input image for deconvolution
In this step you will select the image to be processed and load it as an input image for deconvolution.
1. On the Processing tab > Method tool in the Deconvolution group select the Deconvolution (adjustable) method.
2. In the Input tool, select the image that you want to deconvolve. If the Set Input Automatically checkbox is checked, the currently active image has been loaded as input image
automatically. Since this means, that the output image is then also automatically selected
as input, it is recommended to uncheck this checkbox. Select the desired input image.

Info
If a warning appears at this point, it is likely that parameters required for deconvolution are
missing from the image. You can subsequently enter or change these values in the Parameters tool > PSF settings tab > Microscope parameters.
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9.4.2 Step 2: Set parameters for deconvolution
In this step you will choose the desired algorithm and the associated method parameters. Then
you will perform deconvolution and save the result.
Prerequisite ü On the Processing tab, in the Method Parameters group, you have opened the Parameters tool in the Show All mode. You can usually leave these parameters alone as they are automatically set to give you a good result.
1. On the Deconvolution tab first set the desired algorithm. In our example we are using the
Constrained Iterative algorithm, which is the most complex algorithm, but normally the best
one to use.
à You will now see a number of additional parameters for the Constrained Iterative
method appear on the tab (Show All mode).
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9.4.3 Step 3: Perform deconvolution
In the last step you will perform deconvolution. The resulting image will be compared with the input image and details relating to the processing procedure will be observed.
1. Go to the Deconvolution tab in the Parameters tool to keep the Diagnosis section in the
foreground.
2. Click on the Apply button.
à You can monitor the progress in the Convergence History graph, in which the gradual
improvement is plotted against the number of iterations.

3. Save the resulting image under a meaningful name.
4. Click on the Splitter Mode button
(split image).
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5. The currently active image is loaded automatically into the multi image. Now drag the input
image from the document gallery in the Right Tool Area into the split document.

6. On the Display tab, change and adjust the display as desired, e.g. Best Fit with 0.01 and
for black and white value with a Gamma of 0.8.
à Both images are adjusted simultaneously.
7. If on the Split Display tab the Synchronize Dimensions checkbox is activated, you can
now zoom synchronously into the images (mouse wheel) and, with the mouse wheel held
down, move the image content as desired to focus on the regions of interest.
8. To create an image of the desired view click on New Image from > Current View > Create.
à This creates a new output image document with both images shown side by side.

You have successfully performed deconvolution, observed the processing procedure and created
an output image to compare the deconvolved with the input image.
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9.4.4 Step 4: Info View and re-using Deconvolution parameters from a processed
image
The Info View contains a section Deconvolution Information, which shows a summary of the
parameters used for deconvolution of the image. It also contains the Convergence History
graph displaying the time it took to get this image processed.
If you like to use the same settings in order to process another image, the following steps show
how to do this:
1. Select the processed image from the previous steps.
2. Select the Info View and scroll down to the Deconvolution Information group:

3. Click on the Clipboard button.
à All deconvolution parameters are copied to the clipboard.
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4. Open the new image you want to deconvolve and select it as input in the Deconvolution
(adjustable) function. Right-click and select Copy and then right-click and select Paste to
copy the parameters into Deconvolution.

5. Click on the Apply button to run Deconvolution with the identical function parameters as
used for the previous image.

9.5 Measuring the PSF using subresolution beads
When measuring the PSF (point spread function) you perform the following process. Note the prerequisite preparation and hints.
Preparation
1. The surface of coverslips is hydrophobic which means, liquid droplets do not spread out
easily and beads tend to aggregate at the edges. For PSF measurements you want individually spread out beads.
2. Bath the coverslips for 10 minutes in 100% ethanol.
3. Use forceps to remove the coverslip. Shake off excess liquid and run through bunsen burner
flame.
à This makes the surface slightly hydrophilic which means, the droplets and beads spread
out easier.
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4. Break up agglomerates by sonicating stock suspension in a waterbath for 20 minutes.
Stocks suspensions are way too dense, so dilute 1:100 with 70% ethanol.
5. Create further dilutions of 1:1.000 and 1:10.000 by adding 100 µl to 900µl 70% ethanol.
Mix well using a Vortex mixer.
6. Put one 5 µl drop for each dilution on a cover slip using a 20 µl Eppendorf pipette
7. Let dry. This should take less than 5 minutes. You can speed it up by putting the cover slip
on a warm surface.
8. Put 10-20 µl mounting medium on the coverslip. For aqueous mounting media seal edges
of coverslip with valap (1:1:1 mixture of vaseline, lanolin, paraffin), nailpolish or paraffin.
In the next step, you acquire an image.
Imaging
1. Locate the beads on the microscope (e.g. use a 20 x lens first, then move to 63x oil). Start
at the 1:100 spot which should have tons of beads and be easy to find.
2. When found, move to a sparser spot and try to find an area with a couple of single beads
in the FOV. This can be tricky, but usually you will be able to find good areas if you keep
looking around.
3. Acquire a Z-stack of a suitable area, observing the following rules.
à No saturation. This can be tricky with LSM’s. Use 12-bit mode at least.
à Only fill the dynamic range in the histogram to about 80%.
à Make sure to focus up and down when setting up the exposure times to measure the exposure suitable for the bright bead center to avoid the risk of saturation.
4. Set up the z-stack as follows: in the Z-stack tool, click on the Optimal button.
à This sets the distance according to Nyquist. For bead measurments further reduce the
slice distance to about half of what Optimal suggests.
5. Also, define the top and bottom of the stack in such a way that the airy disc of the beads
cannot be distinguished any longer.
6. When ready, save and name the image properly.
Look at the result in OrthoView: Do you see spherical aberrations? Are the beads symmetrical?
Are there enough individual beads in the stack? Is the background low enough?
Processing in ZEN Blue
1. Use the PSF wizard (Processing/Deconvolution) to extract the PSF from the bead-z-stack.
For more information, see Creating a PSF - With Wizard and Without [} 135].
The PSF wizard guides you step by step through the necessary procedure.
The result of the wizard is a PSF file which you use in deconvolution for images acquired under
the same conditions.
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9.6 Extracting Individual Fluorescence Images of a Multichannel Image
In this topic we will show you how to extract individual fluorescence channel images of a multichannel image.
Prerequisite ü You have acquired or opened a multichannel image.

1. Select the Processing tab. Open the Method tool and select under Utilities the entry Create Image Subset.
2. In the section Image Parameters open the Input tool and select the multichannel image
as Input image.
3. In the section Method Parameters open the Parameter tool and the select the entry
Channels. Deactivate the channels you do not want in the extracted image (e.g. the red
and the blue fluorescence channel).

4. Click on the Apply button.
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In the example image, you have extracted the green fluorescence channel image of the multichannel image. Activate the corresponding channel and deactivate the other channels to extract
further individual fluorescence images. You can now save the extracted sub images as separate
files.

9.7 Applying Batch Processing
In this topic we will show you how to export all images of a folder as batch. For each image you
can use identical or different export settings.
Prerequisite ü You have a folder with several CZI-images to be exported in a new image type (ie. TIFF, BMP,
JPEG). For example two 2channel-Timelapse images, one 2channel-Z-stack image, one 3Channel image on the product DVD Example Image Databases\CaRationSeries.czi, kaede5lsm.czi,
ratbrainstack.czi, zf_psa.czi).
1. Select the Processing tab. Click on the Batch button.
2. Open the Method tool and select the entry Image Export.
3. In the Method Parameters section, open the Parameters tool.
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4. In the Batch Processing tool, click on the Add button. Select the folder, mark all images
to be exported, and click on Open.

5.
6.

7.
8.
9.

à The list of images is displayed in the Batch Processing.
Activate the checkbox Use Input Folder as Output Folder to save the exported images in
the folder of the original images.
Click on one image in the list and do the export settings in the Parameters tool. In the example the TIFF format will be used for all time points and channels. This setting is only valid
for the selected image, but can be copied to further images in the list with identical dimensions (i.e. 2channel Time-Series image).
Click on the Copy Parameters button. Select the image with identical dimensions in the
list and click on the Paste Parameters button.
Continue with the other images of the list. Use Copy Parameters and Paste Parameters
or define the export settings for each image individually in the Parameters tool.
Click on the Check All button. All images in the list will be tagged with a green marker, if
they have the correct setting.

10. Click on the Apply button.
All exported images in the list will be checked and are exported in separate folders in the Input
folder.

9.8 Cropping a ROI
In this topic we will show you how to crop a region of interest (ROI) of a image.
Prerequisite ü You have acquired or opened a multichannel image.
1. On the Processing tab, open the Method tool and under Utilities select the entry Create
Image Subset.
2. In the Image Parameters section, open the Input tool and select the image.
3. In the Method Parameters section open the Parameters tool.
4. Open the Z-position dimension setting and select Extract Range of the dropdown list. Set
the start position and the end position using the slider or the input field.
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5. Open the Region setting and select Rectangular Region of the dropdown list.
6. Click in the image on the start position of the ROI and draw a rectangular region.

à You have marked the ROI which should be cropped.
7. Click on the Apply button.
The marked ROI with the defined dimensions is extracted of the image. You can now save or
process this image.
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Fig. 11: Cropped ROI with the dimensions All channels and the Z-Postion 11-20.

9.9 Creating an EDF Image
In this topic we will show you how to create an extended depth of focus (EDF) image of a Z-Stack
image. The focus planes of all the z-positions will be calculated to one EDF image.
Prerequisite ü You have acquired or opened a z-stack image.
1. On the Processing tab, open the Method tool and select under Sharpen the entry Extended Depth of Focus.
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2. In the Image Parameters section open the Input tool and select the Z-Stack image as input image.

3.
4.
5.
6.

In the Method Parameters section open the Parameters tool.
Select Waveletsof the Method dropdown list.
Select High of the Z-Stack Alignment dropdown list.
Click on the Apply button.

All focus planes of the Z-Stack image are now calculated to one EDF image.
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9.10 Creating image subset and split dimensions
Depending on your loaded image, you can split certain dimensions, e.g., channels or timepoints,
and save them to separate images. First, you select the method, and in the Parameters tools,
you specify the dimension. Each of the dimensions is only visible if the corresponding dimension is
present in the input image.
Create Image Subset and Split opens the resulting images in the ZEN document area. Therefore, for this image processing function, Split Dimension is limited to a maximum of 20, e.g. timepoints, tiles, or slices. To split images along a dimension with more than 20 elements, use Create
Image Subset and Split (Write files), which creates image files in the specified folder.
Prerequisite ü You have loaded an image with more than one channel and not more than 20 timepoints.
1. Select Processing tab | Method tool, and select under Utilities the entry Create Image
Subset and Split or Create Image Subset and Split (Write files). When using the first
option, you can specify the output in the Output tool.
2. To create a subset from the available dimensions, make your settings in the sections Channels and Time.
3. In the Parameters tool, in the Split Dimension section, select the dimension along which
you want to split the image, e.g., Channel or Time.
In the Channels list, all channels of the loaded image are listed. Unselect channels you
want to exclude.
In the Time section, select the subset of timepoints which you want to include. If you have
an image with more than 20 timepoints, and you limit the range to below 20 elements,
Time will appear in Split Dimension allowing you to split the dataset along this dimension
(for Create Image Subset and Split).
In the Region section, select the region which you want to extract from the image, e.g.,
Full or Rectangle Region.
Select Rectangle Region and draw a rectangle in the 2D view to specify the region you
want to extract.
When you use Create Image subset and Split (Wirte files), you also need to specify the
output folder for the images.
4. In the Input tool, specify whether you want to set the input automatically and which image
you want to display after processing. Check the according options.
5. In the Output tool, specify how to proceed with the new image. Select if you want to overwrite an existing image with the same name or if you want to create a new output. The
output tool is only available, if you selected the Create Image Subset and Split method.
6. Click the Apply button.
The new images are created according to your specifications.
For more information, see Create Image Subset and Split [} 186] or Create Image Subset and Split
(Write files) [} 187].
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9.11 Using Analyze to Label Image
The image processing functions Analyze to Label Image and Analyze to Label Image Batch
label images based on an existing image analysis setting and the parameters which you select
from the function. For general information about the image processing, see Image Processing
Workflow [} 90]. For a description of all the parameters of Analyze to Label Image see Analyze
to Label Image [} 214] and for Analyze to Label Image Batch see Analyze to Label Image
Batch [} 215].
The image analysis with this functions offers a wide variety of parameter options and the outcome
completely depends on the combination of them. Therefore, this chapter can only give an example to illustrate the use and outcome of the function. In general, the labeling is possible as regions, contours, and double contours. For all three the same options are given in Label Mode.
As an example, the following two channel image and image analysis setting with three classes are
used to illustrate the functions:

Example: Applying One channel and One channel per class
With these options, you can initialize your output image either as an image with one labeled
channel or as an image where the labels for each class have a separate channel.
Labeling regions with the maximum pixel type as a 8 bit black and white image generates the following output for the first class:

Labelling the other two classes with the option One channel per class additionally creates the
output for the other two classes:
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If you want the regions to have the same color as defined in the image analysis setting, you can,
for example, choose the option Region - Region Class Color and 24 Bit RGB as Pixel Type:

As stated before, you can choose the same options (labeling with pixel type maximum and region
class color) for contours or double contours as well.

9.12 Image Processing Functions
9.12.1 EM Processing
This group lists image processing functions that are designed for processing FIB-SEM images.
Some of the functions can also be found in other groups of image processing functions. This
group is only visible if you have the license for EM Processing Toolbox.

See also
2 EM Processing Toolbox [} 355]
9.12.1.1 Change Pixel Type
This method allows you to change the pixel type of an image. This can be useful if you want to
compare or combine images that have different pixel types.
Parameters

Parameter

Description

Pixel Format

Select the desired pixel format from the dropdown list.

-

8 Bit B/W

The output image is a monochrome image, the whole-number gray
values of which can lie in the range from 0 to 255.

-

16 Bit B/W

The output image is a monochrome image, the whole-number gray
values of which can lie in the range from 0 to 65535.
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Description

-

32 Bit B/W Float

The output image is a monochrome image with real numbers as pixel
values.

-

2x32 Bit Complex

The output image is a monochrome image with complex numbers
(real part and imaginary part) as pixel values. Such images are generally created by means of transformation into the Fourier space.

-

24 Bit RGB

The output image is a color image, the whole-number color values of
which in the red, green and blue channels can lie in the range from 0
to 255.

-

48 Bit RGB

The output image is a color image, the whole-number color values of
which in the red, green and blue channels can lie in the range from 0
to 65535.

-

2x32 Bit RGB
Float

The output image is a color image with real numbers as color values
in the red, green and blue channels.

-

3x64 Bit RGB
Complex

The output image is a color image with complex numbers (real part
and imaginary part) in the red, green and blue channels. Such images
are generally created by means of transformation into the Fourier
space.

9.12.1.2 Coarse Z-Stack Alignment
This function enables you to align planes of z-stacks manually.

Parameter

Description

Z-Alignment Setup

The Setup button opens the Coarse Z-Stack Alignment setup to
manually align your z-stack.

Shift List

Displays a list with all the shifts that have been made in the Coarse ZStack Alignment setup.

See also
2 Aligning z-planes manually [} 357]

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

110

9 Image Processing | 9.12 Image Processing Functions

ZEISS

9.12.1.2.1 Coarse Z-Stack Alignment Setup
With this setup you can manually align the planes of a z-stack. If you have imported your z-stack
and there are bigger shifts between individual planes of the stack, this setup helps you to make a
coarse alignment of your z-stack before an automated alignment, e.g. via Z-Stack Alignment
with ROI.

1

2

3

1

Alignment Controls Section
Here you have your controls to align the z-planes in the stack manually. For more information, see Alignment Controls Section [} 111].

2

Image View
Displays your selected z-plane and the following plane with different colors. The current
plane is displayed in cyan and the following z-plane is displayed in red.

3

View Options
Here you have your standard view options (Dimensions Tab [} 887] and Display Tab
[} 902]).

See also
2 Aligning z-planes manually [} 357]
9.12.1.2.1.1 Alignment Controls Section
This section of the Coarse Z-Stack Alignment setup contains the main controls to align the zplanes of your stack manually.

Parameter

Description

Speed

Selects the speed/ number of pixels by which the z-planes are shifted
per click.
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Parameter

Description

–

Shifts the z-planes by 1 pixel per click.

–

Shifts the z-planes by 10 pixels per click.

–

Shifts the z-planes by 100 pixels per click.

–

Shifts the z-planes by 1000 pixels per click.

Arrow Buttons

Shifts the next and all following z-planes in the corresponding direction.

Visibility Weight
slider

Changes the color intensity of the current plane and the following zplanes in the Image View. In extreme slider positions, only the current z-plane or only the following z-planes are displayed.

Channels

Only available for images with multiple channels.
Selects the channel that is displayed in the Image View. The same
shift is applied to all channels of the image.

Shift List

Displays a list with all the shifts in x and y direction that you defined in
the setup.

9.12.1.3 Create Image Subset
This method allows you to extract parts from one image and use these to create a new image.
You can select these parts freely from the individual dimensions of the image.

Info
Each of the sections described below is only visible if the corresponding dimension is present in
the input image.

Parameter

Description

Channels

Here you can select which channels of the input image you want to
be used. All channels are selected by default. To deselect a channel,
click on the respective channel button.

Z-Position, Time,
Block, Scene

Here you can select which parts of the input image you want to use
for the resulting image.

-

Extract All

If selected, all parts of the corresponding image are extracted.

-

Extract Single

If selected, you can select a single image to be extracted.

-

Extract Range

If selected, you can select a certain range of images to be extracted.
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-

Extract Multiple
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Description
If selected, you can select several continuous ranges and individual
sections.
Enter one or more sections that you want to select in the input field.
To do this, enter the first section, followed by a minus sign, and then
the last section. If you want to define an interval, after the last section
enter a colon and then the interval. The entry "2-10:2" means that every second section is selected from section 2 to section 10.
Enter a comma after the first section if you want to define another
section. You can also select individual sections separated by commas.
By entering "2-10:2,14-18,20,23", you select every second section
from section 2 to section 10, followed by sections 14 to 18, as well as
sections 20 and 23.

-

Get current position

Adopts the position from the current display in the image area.

-

Interval

Activated: Interval mode is active. The Interval spin box/input field
appears.
Enter the desired interval here. E.g. if you enter the value 2 only every
2nd value from the range is considered.

Region

Here you can select if you want to use the entire image or just a region (ROI) of the input image.

-

Full

Select this option to use the full image for the new image.

-

Rectangle region (ROI)

Select this option to draw in a rectangle region of interest which will
be used for creating a new image.
If a rectangle region was drawn in you can see and change its coordinates by editing the X/Y/W/H input fields.

-

Keep tiles

Has only an effect, if a region (ROI) is defined.
Activated: Extracts the drawn in region including the complete tiles.
This setting is recommend when you want to apply DCV processing
functions on the resulting image.

9.12.1.4 Cut Out Regions
This function allows you to define a region of interest in your z-stack and cut it out of the stack as
a separate volume.

Parameter

Description

Define Regions

Opens the Define Regions setup [} 114] to define the region of interest to be cut out of your z-stack.

See also
2 Cutting out a volume from a z-stack [} 359]
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9.12.1.4.1 Define Regions setup

1

2

3

1

Region Edit Section
Here you have the controls to draw and edit the support regions. For detailed information see Region Edit section [} 114].

2

Image View
Here you can draw your support regions into the current z-plane and edit them if
needed.

3

View Options
Here you have some standard view options as well as the Support Regions tab [} 115].

See also
2 Cutting out a volume from a z-stack [} 359]
9.12.1.4.1.1 Region Edit section
With this tools you can draw regions into your image and edit them.

Parameter

Description

Draw

Draws a new region into the image.

Erase

Using this button you can erase parts of a region. Holding down the
left mouse button, outline the parts of the region that you want to
erase. Right-click to erase the parts.

Merge

Use this button to connect regions. Holding down the left mouse button to extend the outline of an existing region or draw a connection
between the regions that you want to merge. Right-click to merge
them.
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Parameter

Description

Fill

Fills a hole. To fill a hole, left-click on the hole.

Remove

Removes a region by clicking on it.

Remove All

Removes all regions on the current z-slice.

ZEISS

Enables you to add a rectangular region.
Rectangle
Enables you to add a circular region.
Circle
Enables you to add a polygonal region.
Contour
Enables you to add a polygonal spline region.
Contour (Spline)

–

Define Single
Region

In this mode you should only define a single region on each support
slice of the image. For the interpolation, the support regions on the
different slices do not necessarily have to overlap with one another.

–

Define Multiple
Regions

In this mode you can define multiple regions on each support slice of
the image. Interpolation here is only possible, if the support regions
on each slice have some overlap with the respective regions on the
previous/next support slice.

Interpolate

Interpolates regions in the slices between the drawn support regions
and displays the interpolated regions in the image.

Clear All

Removes all regions (drawn support regions and interpolated ones) in
the entire stack.

Undo

Undoes the last change made on the current slice.

Redo

Restores the last undone change on the current slice.

See also
2 Cutting out a volume from a z-stack [} 359]
9.12.1.4.1.2 Support Regions tab

Parameter

Description

Show Objects

Activated: Displays the regions in the Image View.
Deactivated: Hides the regions in the Image View.

Fill

Activated: The region is filled with color.
Deactivated: Displays only the outlines of the regions.

Opacity

Sets the opacity for the regions.

Refresh Support
Slice List

Updates the list below with the drawn support regions.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

115

9 Image Processing | 9.12 Image Processing Functions

ZEISS

Parameter

Description

Support Slice List

Displays a list with information on the Position(s) where support regions have been drawn and the number of regions and holes on the
respective slice.
This list is only updated when you click on Refresh Support Slice
List.

9.12.1.5 Denoise
This method removes noise from images using a real or a complex wavelet transformations. The
process of denoising an image can be broken down into the following three parts:
§

Calculate the wavelet transform of the noisy image.
The wavelet transformation can be calculated by the method Real Wavelets and Complex
Wavelets.

§

Modify the noisy wavelet coefficients.
This is done by using bivariate shrinkage with local variance estimation (thresholding). [Bivariate Shrinkage with Local Variance Estimator, Levent Sendur and Ivan W. Selesnick, IEEE Signal
Processing Letters, Vol. 9, No. 12, December 2002]

§

Compute the inverse transform using the thresholded coefficients.

Parameter

Description

Method

-

Complex wavelets

The Dual Tree Complex Wavelet transform provides better results due
to the fact that it is nearly direction invariant and makes more directional sub bands available. The results will be less prone to block-artefacts. However, this method is computationally more intense and
therefore takes longer.

-

Real wavelets

The real wavelet transform only considers three sides (XYZ) and is
therefore faster. However, the result can show block artefacts.

Strength

Here you adjust the strength with which the function is applied.

See also
2 Using Direct Processing [} 346]
9.12.1.6 Enhance Local Contrast
With this function you can improve the contrast of your image.

Parameter

Description

Clip Limit (%)

Defines the value at which the histogram is clipped. It is used to avoid
oversaturation of the image in homogeneous areas. It is determined
by the normalized histogram of the local region. The higher the value
is set, the higher the contrast will be.

Region Size (%)

Defines the size of every single region or tile where the local histogram is calculated as percentage of the image size. For example, a
region size of 50% has the size of half the image.
A small region size will increase the contrast but will take more calculation time.
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Parameter

Description

Bins

Defines the number of histogram bins that is used to create the contrast enhancing transformation. A higher number of bins will cover a
greater dynamic range but will increase calculation time.

Process Tiles Separately

Only visible for tile images.
Activated: Processes each tile region separately.

NOTICE
Difference between Result and Preview
The actual result of the function and the preview you see in the preview window can be different. This is caused by the parameter Region Size (%) and the different size of the preview
and original image. The function splits the image into small regions and processes them individually based on the histogram of every single region. The histogram is usually related to the
absolute region size. For the preview only the visible part of the image in the view is processed.

9.12.1.7 Gauss
This method allows you to reduce noise in an image. Each pixel is replaced by a weighted average
of its neighbors. The neighboring pixels are weighted in accordance with a two-dimensional
Gauss bell curve.

Parameter

Description

Sigma

Here you can adjust the sigma value. If the Show All mode is activated you can adjust the values in each dimension individually.

9.12.1.8 Highpass
This method performs high-pass filtering. The high pass filter is defined as the difference between
the original image and the low-pass filtered original.

Parameter

Description

Normalization

Depending on the image processing function you have selected not
all choices are available in the list.

-

Clip

Gray levels that exceed or fall below the specified gray value range
are automatically set to the lowest/highest gray value (black or white).
The effect corresponds to underexposure or overexposure. This means
that in some cases information is lost.

-

Automatic

Automatic normalization of gray values to the available gray value
range.

-

Wrap

If the result is greater than the maximum gray value of the image, the
value maximum gray value +1 is subtracted from it.

-

Shift

Normalizes the output to the value gray value + max. gray value/2.

-

Absolute

Values are used positive only.
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Parameter

Description

Count

Here you set the number of repetitions. I.e. the number of times the
function is applied sequentially to the respective result of the filtering.
The effect is increased correspondingly.

Kernel Size

You can set the filter size in the x-, y-and z-direction, symmetrically
around the subject pixel. This should be the size of the transition region between objects and background match.

9.12.1.9 Import SmartFIB TIFFs
This function allows you to import SmartFIB stacks of Crossbeam microscopes into ZEN.

Parameter

Description

Select Files

Opens a file browser to select the images for import.

Z-Spacing

Sets the slice distance in z. Per default, Auto is activated and the distance is calculated automatically with information from the image
metadata of the first and last selected image.
Deactivate Auto to enter a value manually.

XY-Scaling

Sets the scaling in x and y. Per default, Auto is activated and the scaling is automatically taken from the image metadata of the first selected image.
Deactivate Auto to enter a value manually, e.g. if you import images
without scaling information in the metadata.

Sample Angle

Sets the angle of the sample. Per default, Auto is activated and the
sample angle is automatically calculated from the image metadata or
set to the default of 54 degree and the image is rendered with a 90
degree tilt (if no information is available in the metadata). In this case
the SmartFIB stack will be displayed perpendicular to the images acquired on a light microscope.
Deactivate Auto to enter a value manually, e.g. if you know the original sample angle as set in the SmartFIB software and import images
without using the information in the metadata.

Read XY Offsets

Activated: Reads the xy offset of the individual slices from the metadata. Note that this can lead to a slanted z-stack depending on the
sample orientation during imaging and the metadata.

9.12.1.10 Median
This method allows you to reduce noise in an image. Each pixel is replaced by the median of its
neighbors. The size of the area of the neighboring pixels considered is defined by a quadratic filter
matrix. The modified pixel is the central pixel of the filter matrix. The median is the middle value
of the gray values of the pixel and its neighbors sorted in ascending order.

Parameter

Description

Kernel Size

Here you can adjust the size of the filter matrix. If the Show All mode
is activated you can adjust the values in X ,Y and Z direction individually.
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9.12.1.11 Not
This function performs a binary "not" operation on all bits of the binary representation of an input
pixel's gray value. A 0-bit in the input pixel results in an 1-bit in the corresponding output pixel an
1-bit in the input gets a 0-bit in the output. For integral image types the resulting output gray
value is the difference of the maximum possible gray value minus the input gray value, but for
float image type the results are strange due to the inhomogeneous float format.
9.12.1.12 Remove Stripes
This function allows you to remove stripe artifacts from your image. It is recommended to use the
output preview to determine the suitable values for your parameters. You can display the output
preview window by clicking on Preview in the Output tool [} 769].

Parameter

Description

Method

Selects the method you want to use for the removing the striping artifacts in your image.

–

GPU VSNR

Only available if you have a NVIDIA GPU in your machine.
Uses a special GPU-based VSNR algorithm.

–

GPU

Only available if you have a NVIDIA GPU in your machine.
Uses a GPU optimized algorithm to remove the stripe artifacts from
the image. This calculation produces the same results as the CPU version when using the same parameter values.

–

CPU

Uses a CPU optimized algorithm to remove artifacts from the image.

Iterations

Sets the number of iterations after which the calculation is ended.

First Filter

Displays the settings of the first filter to remove vertical or horizontal
stripes in your image.

–

Noise Level

Sets the intensity level of the stripes in your image.

–

Width

The calculation for the removal of stripes in the image is based on a
Gaussian curve. This parameter sets the width of the curve.

–

Height

The calculation for the removal of stripes in the image is based on a
Gaussian curve. This parameter sets the elongation of the curve.

–

Angle

Sets the angle for stripes in your image. An angle of 0 corresponds to
vertical stripes. An angle of 90 (or -90) corresponds to horizontal
stripes.

Second Filter

To remove a second set of stripes (e.g. if you have both vertical and
horizontal stripes in your image), you can activate a second filter. For
information about the parameters, see the descriptions above.

–

Enabled

Activated: Displays the settings for a second filter to remove striping
artifacts in the image.
Deactivated: Hides the settings for a second filter and only the first
filter is applied.
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9.12.1.13 Shading Correction
This method allows you to improve images in which the quality has been impaired by uneven illumination or vignetting.
If you want to perform shading correction before an experiment (recommended) you have to use
the shading correction function in the Camera tool in the Post-Processing section [} 673].

Parameter

Description

Shading Mode

-

Camera shading

Applies the Shading correction to each tile of a tile image.

-

Global shading

Applies the Shading correction to the whole tile image. Requires a
shading reference image with the same size as the tile image.

Automatic

Activated: The function automatically calculates the reference image
for shading correction from the input image.

Shading Reference

Only available in Batch mode and if Global shading is selected or
Camera shading is selected and Automatic is deactivated.
Selects a reference image for the shading correction.

Display Mode

-

Additive

In this mode the normalized reference image is subtracted from each
camera frame. This influences the brightness of the image.

-

Multiplicative

In this mode each camera frame is divided by the normalized reference image. This influences the contrast of the image. This is the default setting.
The simulated/auto reference image is created by averaging up to 20
camera frames in the input image and running a lowpass filter on
them.

Offset

Adjust the gray value that will be added on to the newly calculated
gray values using the slider or input field. If this results in negative values, these are set to 0. Values that exceed the maximum gray value
are set to the maximum gray value.

9.12.1.14 Slices Replacement
With this function you can replace one or more z-slices of a stack with the respective previous or
following slice.

Parameter

Description

Replace with Next

Replaces the currently selected z-slice with the following one.

Replace with previous

Replaces the currently selected z-slice with the previous one.

Undo

Reverses the last replacement(s).

Redo

Restores the last undone change(s) for the replacement.
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Parameter

Description

Replacement Table

Only visible if at least one replacement has been set.

ZEISS

Displays information about the slice replacement and which Z is replaced.

–

Z

Displays the index of the z-slice that gets replaced.

–

Source

Displays the index of the z-slice which replaces Z.

–

Replacement
Type

Displays the type of replacement (Next or Previous).

See also
2 Replacing z-slices in a z-stack [} 358]
9.12.1.15 Sort SmartFIB Tiffs
This function allows you to select a folder with FIB-SEM tiffs and sort these files in separate subfolders according to channel name, number of pixels, image size, and spacing of the images, corresponding to slice thickness. The files are sorted into subfolders of the output folder according to
their metadata. This means that each time one of the above mentioned metadata changes from
one image to the subsequent image, a new sub folder is created. Thus subfolders with homogeneous metadata with respect to xyz-scaling and image size are created.
Note that this function only works if the tiff files have their default names assigned by the microscope (e.g. channel0_slice_0001.tiff or slice_0001.tiff)! All tiff files with other names are ignored
by the function.

Parameter

Description

Input Folder

Selects the folder where the tiff files which should be sorted are
saved. Click on
to open a file browser and navigate to the respective folder. Note that this function does not include images from subfolders, all images that you want to be sorted have to be in this input
folder!

Output Folder

Selects the folder where the subfolders with the sorted tiff files are
placed. Click on
to open a file browser and navigate to the respective folder. The function automatically creates subfolders in this
folder.

File Operation

–

Copy

Copies the images into the output folder. Your data is duplicated and
remains unchanged in the input folder.

–

Move

Moves the images from your input folder into the output directory.

–

Hard Link

Creates links in the output folder to each image file in the input
folder, i.e. the space occupied by the images on the hard disk remains
unchanged.
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9.12.1.16 Z-Stack Alignment with ROI
This function allows you to automatically align the individual planes of a z-stack image if they are
not positioned precisely above each other.

Parameter

Description

Quality

Selects the quality level that you want the function to work with. The
calculation of the alignment is based on a so-called image pyramid.
The higher the selected quality, the more levels of the image pyramid
are used to calculate the alignment and the more precise the alignment will be. However, the higher the selected quality is, the slower
the calculation of the alignment will get.

–

Low

This is the most imprecise but also the fastest calculation of the alignment. It uses a low number of levels (2) of the image pyramid for the
alignment calculation.

–

Medium

This is a more precise but also a slower calculation of the alignment
than the one before. It uses a medium number of levels (3) of the image pyramid for the alignment calculation.

–

High

This is a more precise but also a slower calculation of the alignment
than the two before. It uses a high number of levels (4) of the image
pyramid for the alignment calculation.

–

Highest

This is the most precise but also the slowest calculation of the alignment. It uses the highest number of levels of the image pyramid for
the alignment calculation.

Registration
Method

Selects the method which is used to align the images.

–

Translation

The neighboring sections of the z-stack are shifted in relation to each
other in the X and Y direction.

–

Rotation

The neighboring sections of the z-stack are rotated in relation to each
other.

–

Translation +
Rotation

The neighboring sections of the z-stack are translated and rotated in
relation to each other.

Interpolation

Selects how the interpolation is performed if a pixel is calculated from
several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial
function of the input pixels closest to it.

Region

-

Full

Selects which parts of the image should be considered for the calculation of the transformation matrix.
Considers the entire image for alignment.
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Rectangle Region
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Description
Allows you to draw a region of interest into the image. Only the image information of this region is then considered for the calculation of
the transformation matrix for alignment. The resulting transformation
matrix will be applied to the full image.
After you have drawn a rectangle region into the image, you can see
and change its coordinates with the X/Y/W/H input fields.

Crop output

Activated: The output image will have the same size as the input image. The image will be cropped in the case that pixels are shifted out
of the area defined by the input image.
Deactivated: The output image does not keep the size of the input
image but incorporates also pixels that lie outside of the area defined
by the original image.

Single Component

Activated: Displays the image channels. Selects one of the image
channels which will be used to calculate the alignment transformation
matrix, which then is also applied to the other channel(s).
Deactivated: Calculates an alignment transformation matrix for each
individual channel.

See also
2 Aligning z-planes automatically (based on a ROI) [} 358]
9.12.1.17 Z-Stack Equalization
This function equalizes the gray values throughout an entire image stack. It scales the intensities
of all slices to a common mean intensity value and standard deviation. The goal is a harmonization of the gray value distribution within a z-stack. With this process, brighter image slices will get
darker and darker slices will get brighter.

9.12.2 Deconvolution
9.12.2.1 Deconvolution (defaults)
This method allows you to use 4 different algorithms for deconvolution, without any further settings.
The following algorithms are provided in the Parameter tool:

Parameter

Description

Simple, very fast
(Nearest Neighbor)

Executes the fast Nearest Neighbor method using default parameters.

Better, fast
(Regularized Inverse
Filter)

Executes the Regularized Inverse Filter algorithm for image enhancement.

Good, medium speed
(Fast Iterative)

Executes the Fast Iterative restoration method.

Excellent, slow
(Constrained Iterative)

Executes the Constrained Iterative quantitative restoration
method.
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9.12.2.2 Deconvolution (adjustable)
Deconvolution can be done either by using the computers CPU or by using a graphics card. Using
a graphics card can speed up deconvolution processing quite dramatically. A NVIDIA graphics
card is required which supports the CUDA processing library. Contact your sales representative for
further details about supported graphic card models.
For a detailed overview of all deconvolution methods (and its combinations) see Deconvolution
Methods in ZEN [} 337]. This method allows you to use and individually configure 4 different algorithms for deconvolution (short DCV). Under Parameters two tabs are available for detailed
configuration:
§

On the Deconvolution tab, you can select the desired algorithm and define the precise settings for it, see Deconvolution tab [} 124].

§

On the PSF Settings tab, you can see and change all key parameters for either generating a
theoretically calculated PSF, or selecting an experimentally measured PSF, see PSF Settings tab
[} 130].

9.12.2.2.1 Deconvolution tab

Info
Expert knowledge is required for some of the settings. If you are in doubt, leave the settings
unchanged.
Algorithm dropdown list
Here you can select the algorithm that is used. The following algorithms are available:
§

Nearest Neighbor

§

Regularized Inverse Filter

§

Fast Iterative

§

Constrained Iterative

Enable Channel Selection
Activated: Applies the settings on a channel-specific basis. This allows you to set parameters for
each channel individually. You will see a separate, colored tab for each of the channels.
Deactivated: Applies the same settings to all channels of a multichannel image.
9.12.2.2.1.1 Normalization section
Here you can specify how the data of the resulting image are handled:

Parameter

Description

Clip

Sets negative values to 0 (black).
If the values exceed the maximum possible gray value of 65636 when
the calculation is performed, they are limited to 65636 (pixel is 100%
white).
Results from different input images can be quantitatively compared
with each other.
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Parameter

Description

Automatic

Normalizes the output image automatically.
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In this case the lowest value is 0 and the highest value is the maximum possible gray value in the image (gray value of 65636). The maximum available gray value range is always utilized fully in the resulting
image.
Results from different input images cannot directly be compared
quantitatively with each other.
9.12.2.2.1.2 Set Strength Manually section
If you have selected the Nearest Neighbor algorithm, the checkbox is always activated.

Info
If you have selected the Fast Iterative algorithm, the checkbox is also always activated. Using
the slider you can then enter the number of iterations used directly, as, in contrast to the other
methods, no regularization is performed.
Activated: Enter the desired degree of restoration using the slider.
To achieve strong restoration and best contrast, move the slider towards Strong.
To achieve lower restoration but smoother results, move the slider towards Weak.
If the setting is too strong, image noise may be intensified and other artifacts, such as "ringing",
may appear.
Deactivated: Determines the restoration strength for optimum image quality automatically. This
is recommended for widefield and confocal images and is therefore deactivated by default.
The restoration strength is inversely proportional to the strength of so-called regularization. This
is determined automatically with the help of Generalized Cross Validation (GCV).
9.12.2.2.1.3 Convergence History
Only visible if the Show All mode is activated.
This section is only visible if you have selected the Fast Iterative or Constrained Iterative algorithm.
The progress of the calculation is displayed here as line graph. Several quality parameters are
measured for each iteration and once either an optimum or the maximum allowed number of iterations is reached, the processing is stopped. This display allows you to observe directly how the iterative method affects the available data. It also shows how many iterations have been used and
how much time is being used per iterations.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

125

9 Image Processing | 9.12 Image Processing Functions

ZEISS

9.12.2.2.1.4 Corrections section
To show the section in full, click on the arrow button

.

Parameter

Description

Lamp Flicker

Activated: Analyzes the total brightness of each Z-plane. In the event
of non-constant deviations in the total brightness between neighboring planes, a compensation factor is taken into account.
Activate this function if you have acquired your images using an old
fluorescent lamp that exhibits strong fluctuations/flickering in brightness.

Fluorescent Decay

Activated: Corrects bleaching of the sample during acquisition of the
Z-stack.
This function should only be activated for widefield images. Use it if
your sample undergoes strong bleaching during acquisition.

Background

Activated: Analyzes the background component in the image and removes it before the DCV calculation.
This can prevent background noise being intensified during DCV.

Bad Pixel Correction

Activated: Employs a fully automatic detection and removal of spurious or hot pixels (also known as stuck pixels) in an image stack which
might interfere with the deconvolution result.
It is based on the analysis of the gray level variance in the neighborhood of each pixel in the image. It is recommended to use this parameter only, if stuck pixels are observed in the input image.

9.12.2.2.1.5 Advanced Settings section
Only visible if the Show All mode is activated.
This section is only visible if you have selected the Inverse Filter, Iterative (Fast) or Iterative algorithm.
To show the section in full, click on the arrow button

.

Depending on which algorithm you have selected, different advanced setting options are available. The relevant settings are described in the following chapters for each algorithm:
9.12.2.2.1.6 Advanced settings (Regularized Inverse Filter)
Regularization
Here you can select which frequencies in the image are taken into account during regularization:

Parameter

Description

Regularization

-

Zero Order

Regularization based on G-difference, modeled on Tikhonov, but accelerated.

-

First Order

Regularization based on Good's roughness. Under certain circumstances, more details are extracted from noisy data. May be better
suited to the processing of confocal data sets.
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Parameter

Description

GPU Acceleration

Only available, when having installed a suitable (NVIDIA, CUDA based)
graphics card. The checkbox is then activated by default. If
unchecked, CPU processing is being used instead.

9.12.2.2.1.7 Advanced settings (Fast Iterative)

Parameter

Description

Likelihood

Here you can decide which likelihood calculation you want to work
with:

-

Poisson (Meinel)

The calculation according to Meinel works with one convolution per
iteration and converges very fast, normally in 4-5 iterations. This
method can also produce artifacts, however.

-

Poisson
(RichardsonLucy)

The calculation according to Richardson-Lucy, on the other hand, normally requires hundreds of iterations and therefore takes considerably
longer. This method is, however, somewhat more robust producing
less artifacts. Precondition is however, that the PSF is known very
well.

Regularization

For the Poisson (Meinel) calculation it is also possible to perform
zero order (G-difference) regularization here as an option. This
means, however, that the calculation will take considerably longer
and the main advantage of the greater speed of Meinel is lost.

-

None

No regularization is performed.

-

Zero Order

Regularization based on G-difference, modeled on Tikhonov, but accelerated.

-

Total Variation

Total Variation regularization denoises the input data but protects the
edges of structures. This can improve results for noisy data but increases the computation time quite significantly.

Optimization

-

Numerical Gradient

If selected, an attempt is made to determine the trend of the iterations in advance and extrapolate this to the entire calculation. This
can significantly speed up the calculation.

First Estimate

-

Input Image

The input image is used as the first estimate of the target structure
(default).

-

Last Output Image

The result of the last calculation is used to estimate the next calculation. This can speed up a calculation that is repeated using slightly different parameters.

-

Mean of Input
Image

No estimate is made, the mean gray level of the input image is being
used. This is the most rigid application of deconvolution. It should be
chosen for confocal images, where the data sampling can be quite
sparse. The computation time will increase, but missing information
can be recovered from the PSF.
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Parameter

Description

Maximum Iterations

Here you can indicate the maximum permitted number of iterations
that you want. In the case of Richardson-Lucy, you should allow significantly more iterations here.

Quality Threshold

Defines the quality level at which you want the calculation to be
stopped. The percentage describes the difference in enhancement between the last and next-to-last iteration compared with the greatest
difference since the start of the calculation. 1% is the default value.
Lowering this can bring about small improvements in quality.

GPU Acceleration

Only available, when having installed a suitable (NVIDIA, CUDA based)
graphics card. The checkbox is then activated by default. If
unchecked, CPU processing is being used instead.

GPU Tiling

Only available for very large images which exceed the available
graphic card memory.
With this function the image is split up in smaller portions which fit
into the memory of the graphic card. The function automatically determines into how many tiles the image must be split to allow maximum usage of the graphics card. The resulting tiles will automatically
be stitched together for the final output result.
If deactivated, tiling will not be done, however, in this case only certain sub-functions of deconvolution can run on the graphics card and
the speed increase compared to CPU processing will be lower. The
image quality might be higher than with tiling because there is no
need for stitching.

9.12.2.2.1.8 Advanced settings (Constrained Iterative)

Parameter

Description

Likelihood

Here you can decide which likelihood calculation you want to work
with:

-

Poisson

Calculation according to Poisson, this is normally the correct noise
model for microscopic images.

-

Gauss

Calculation according to Gauss. If detector noise is dominant over
sample noise, using a Gaussian noise model can be advantageous,
however, this is rarely the case with modern microscopy systems.

Regularization

Here you can enter which frequencies in the image are taken into account during regularization:

-

Zero Order

Regularization based on G-difference, modeled on Tikhonov, but accelerated.

-

First Order

Regularization based on Good's roughness. Under certain circumstances, more details are extracted from noisy data. This regularization can sometimes produce better results for the processing of confocal data sets.

-

Second Order

Regularization according to Tikhonov-Miller. Here higher frequencies
are penalized more than in the case of Good's roughness. Results
have a tendency to become overly smoothed.
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Description

Optimization

-

Analytical
(Newton Raphson)

Here an attempt is made to optimize the iterations analytically. This
option is usually faster but may also be somewhat less precise.

-

Line Search

Searches rigorously and comprehensively for the minimum. It is therefore more robust, but the calculation takes longer. Line search is recommended for confocal data sets especially, if they are noisy as this
can enforce convergence even for noisy and sparsely sampled data.

First Estimate

-

Input Image

The input image is used for the first estimate of the target structure
(default).

-

Last Output Image

The result of the last calculation is used to estimate the next calculation. This can speed up a calculation that is repeated using slightly different parameters.

-

Mean of Input
Image

No estimate is made for the next iteration. This is the most rigid application of deconvolution. It should be chosen for confocal images,
where the data sampling can be quite sparse. The computation time
increases increase, but missing information can be recovered from the
PSF.

Maximum Iterations

Here you can indicate the maximum permitted number of iterations
that you want.

Quality Threshold

Defines the quality level at which you want the calculation to be
stopped. The percentage describes the difference in enhancement between the last and next-to-last iteration compared with the greatest
difference since the start of the calculation. Lowering this can bring
about small improvements in quality.

GPU Acceleration

Only available, when having installed a suitable (NVIDIA, CUDA based)
graphics card. The checkbox is then activated by default. If
unchecked, CPU processing is being used instead.

GPU Tiling

Only available for very large images which exceed the available
graphic card memory.
With this function the image is split up in smaller portions which fit
into the memory of the graphic card. The function automatically determines into how many tiles the image must be split to allow maximum usage of the graphics card. The resulting tiles will automatically
be stitched together for the final output result.
If deactivated, tiling will not be done, however, in this case only certain sub-functions of deconvolution can run on the graphics card and
the speed increase compared to CPU processing will be lower. The
image quality might be higher than with tiling because there is no
need for stitching.
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9.12.2.2.2 PSF Settings tab
All key parameters for generating a theoretically calculated Point Spread Function ("PSF") are
displayed here.

Info
Ordinarily, images that have been acquired using ZEN (of the *.czi type) automatically contain
all microscope parameters, meaning that you do not have to configure any settings on this
page. Most parameters are therefore grayed out in the display. It is possible, however, that as
a result of an incorrect microscope configuration values may not be present or may be incorrect. You can change these here. The correction of spherical aberration can also be set here.

9.12.2.2.2.1 Microscope parameters section
The most important microscope parameters for PSF generation that are not channel-specific are
displayed in this section.

Info
If you enter incorrect values, this can lead to incorrect calculations. If the values here are obviously wrong or values are missing, check the configuration of your microscope system.

Parameter

Description

Microscope dropdown list

Displays which type of microscope has been used. There are two main
options: conventional microscope (also known as a widefield microscope) and confocal microscope, for which the additional pinhole diameter parameter applies.

NA Objective

Displays the numerical aperture of the objective.

Immersion

Displays the refractive index of the immersion medium. Please note
that this can never be smaller than the numerical aperture of the objective. You can make a selection from typical immersion media in the
dropdown list next to the input field.

Scale lateral

Displays the geometric scaling in the X/Y direction.

Scale axial

Displays the geometric scaling in the Z direction.

Override button

To change the input fields that are normally grayed out, click on the
button. The input fields and dropdown lists are now active.
The text on the button then changes to Reset. To restore the original
values saved in the image, click on the Reset button.

Master Reset

Resets the metadata to the values which were originally stored in the
image at time of acquisition. It reverts any changes made by pressing
the Override button.
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9.12.2.2.2.2 Advanced section
Only visible if the Show All mode is activated.
To show the section in full, click on the arrow button

.

Phase Ring dropdown list
If you have acquired a fluorescence image using a phase contrast objective, the phase ring
present in the objective is entered here. This setting has significant effects on the theoretical Point
Spread Function ("PSF").
PSF generation dropdown list
There are two models for calculating the PSF:

Parameter

Description

Scalar Theory

The wave vectors of the light are interpreted as electrical field = intensity and simply added. This method is fast and is sufficient in most
cases (default setting).

Vectorial Theory

The wave vectors are added geometrically. However, the calculation
takes considerably longer.

Z-Stack
This field can only be changed if it was not possible to define this parameter during acquisition,
e.g. because the microscope type was unknown. It describes the direction in which the Z-stack
was acquired. Note that this setting is only relevant, if your are using the spherical aberration correction.

Parameter

Description

Descending

The Z-Stack descends away from the objective.

Ascending

The Z-Stack ascends towards the objective.

9.12.2.2.2.3 Aberration correction section
Only visible if the Show All mode is activated.
Here you can select whether you want spherical aberration to be taken into account and corrected during the calculation of the PSF. As with the other PSF parameters, most values are extracted automatically from the information about the microscope that is saved with the image
during acquisition. The input option is therefore inactive.

Parameter

Description

Enable Correction

Activated: Uses the correction function. All options are active and
can be edited.

Embedding
medium

Here you can select the embedding medium used from the list.

Refractive index

Displays the refractive index of the selected embedding medium. Enter the appropriate refractive index if you are using a different embedding medium.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

131

9 Image Processing | 9.12 Image Processing Functions

ZEISS

Parameter

Description

Manufacturer

Displays the manufacturer, if known.

Depth variance

When Aberration correction is activated, it is also possible to enable
the creation of depth variant PSF’s. This method allows for dramatic
improvements in image restoration of thicker samples by creating axially variant theoretical PSF’s as a function of the distance to the coverslip and the refractive index of the mounting medium.
To use depth variant aberration correction activate the checkbox. In
the spin box edit field you can define how many PSF’s should be generated. The more PSF’s you create, the better the results, but choosing many PSF’s will increase the processing time. You should choose
at least 3 PSF’s.
From the dropdown list you can choose between the PCA method
(Primary Component Analysis, M. Arigovindan et al., 2005, IEEE Transactions on Image Processing 14. nr. 4 p.450ff) which is best suited for
constrained iterative and fast iterative method and the Strata method
(Myneni and Preza, Frontiers in Optics 2009, Optical Society of America, paper CThC4.), which is best for regularized inverse filter and
Richardson Lucy iterative deconvolution.

Distance to cover
slip

Displays the distance of the acquired structure from the side of the
cover slip facing the embedding medium. Half the height of the Zstack is assumed as the initial value for the distance from the cover
slip. The value can be corrected if this distance is known. If possible,
this distance should be measured.
Note: Use Ortho View and the Distance Measurement option to
define the distance of the sample to the coverslip. It is also important
to estimate the position of the glass/embedding medium interface as
precise as possible. If the z-stack extends into the coverslip, the determined range of the stack which reaches into the glass should be entered as a negative value. Example: Z-stack is 26 µm thick, glass/
medium interface is positioned at 9 µm distance from the first plane
of the stack. Resulting value for Distance to cover slip: - 9.0 µm.
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Parameter

Description

Cover slip type
(Thickness and type)

Commercially available cover slips are divided into different groups
depending on their thickness (0, 1, 1.5 and 2), which you can select
from the dropdown list. Cover slips of the 1.5 type have an average
thickness of 170 µm. In some cases, however, the actual values can
vary greatly depending on the manufacturer. For best results the use
of cover slips with a guaranteed thickness of 170 µm is recommended. Values that deviate from this can be entered directly in the
input field.

Cover slip ref. index

Select the material that the cover slip is made of from the dropdown
list. The corresponding refractive index is displayed in the input field
next to it.

Working distance

Displays the working distance of the objective (i.e. the distance between the front lens and the side of the cover slip facing the objective). The working distance of the objective is determined automatically from the objective information, provided that the objective was
selected correctly in the MTB 2011 Configuration program. You can,
however, also enter the value manually.

Override

Only active if the Enable correction checkbox is activated.
To reset the values, click on the Reset button.

9.12.2.2.2.4 Channel specific section
In this section you will find all settings that are channel-specific. This means that they may be configured differently for each channel.

Parameter

Description

Use external PSF
checkbox

Activated: Uses an external measured PSF. You'll find an additional
input window under Image Parameters | Input where you can
choose the external PSF file. The software will check if the PSFs microscope parameters match with the input image. Deviations (10nm deviation in wavelength will be accepted) will make the software use a
theoretical PSF.

Attach to input
button

If an external PSF was selected you can attach the file to the input image. The saved input image will then contain the correct measured
PSF. Usage of a theoretical PSF is possible as well for such an image.
Just deactivate the Use external PSF checkbox.

Illumination display
field

Displays the excitation wavelength for the channel dye [in nm] by using the peak value of the emission spectrum. The color field corresponds to the wavelength (as far as possible).

Detection display
field

Displays the peak value of the emission wavelength for the channel
dye. The color corresponds to the wavelength (as far as possible).
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Parameter

Description

Sampling lateral
display field

Depends on the geometric pixel scaling in the X/Y direction and displays the extent of the oversampling according to the Nyquist criterion. The value should be close to 2 or greater in order to achieve
good results during DCV. As, in the case of widefield microscopes,
this value is generally determined by the objective, the camera
adapter used and the camera itself, it can only be influenced by the
use of an Optovar. With confocal systems, the zoom can be set to
match this criterion.

Sampling axial display field

Depends on the geometric pixel scaling in the Z direction and displays
the extent of the oversampling according to the Nyquist criterion.
The value should be at least 2 or greater in order to achieve good results during DCV. This value is determined by the increment of the focus drive during acquisition of Z-stacks and can therefore be changed
easily.

Pinhole display field

Only available if a confocal microscope has been entered under the
microscope parameters.
Displays the size of the confocal pinhole in Airy units (AU).

NA Cond. display
field

Only visible if the microscope is a Conventional Microscope and
Transmitted Light has been selected as the illumination type.
Displays the numerical aperture of the condenser with which transmitted-light acquisition was performed.

9.12.2.2.2.4.1 Microscope info section
Displays advanced microscope information that influences the form of the PSF in a channel-dependent way:

Parameter

Description

Illumination dropdown list

Here you can select the illumination method with which the data set
has been acquired. In the event that a Conventional Microscope
has been entered under the microscope parameters, the following options are available here: Epifluorescence, Multiphoton Excitation
and Transmitted Light. In the case of confocal microscopes, Epifluorescence is the only option.

Image Formation

Displays whether the imaging was incoherent (Conventional Microscope) or coherent (Laser Scanning Microscope).

Lateral Resolution

Displays the lateral resolution of the calculated PSF.

Axial FWHM

Displays the FWHM (Full Width Half Maximum) as a measure of the
axial resolution of the PSF.
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9.12.2.2.2.4.2 PSF view section
This tool shows you the PSF that is calculated for a channel based on the current settings. If you
select the Auto Update checkbox, all changes made to the PSF parameters are applied immediately to the PSF view. This makes it possible to check quickly whether the settings made meet
your expectations.
1. To extract the PSF from the image, right click and select PSF snapshot.
The result is a new PSF document opened in the center screen area.
9.12.2.3 Creating a PSF - With Wizard and Without
The PSF Wizard combines two steps which are necessary for extracting experimental point spread
functions (PSF) from Z-Stacks of subresolution fluorescent beads:
§

A bead averaging step finds individual beads, presents them for inspection, allows you to select the ones you like and then creates an averaged combination of all selected beads. This
stack shows a single bead which is, as a consequence of the averaging function, fairly free of
noise.

§

The averaged bead stack is then run through the Create PSF function which removes background and residual noise, correctly scales the PSF and also converts the stack into a 32-bit
floating point format which is better suitable for the mathematical procedures used in deconvolution.

Prerequisite ü You have acquired a Z-Stack image. For more information, see Measuring the PSF using subresolution beads [} 99].
ü The use of the PSF wizard is activated.
1. Select the path to open the Parameters dialog box.
à The functions Use wizard and Bad Pixel Correction are activated by default.
2. On the Processing tab, press the Apply button.
à The PSF wizard opens and guides you throught the creation of the PSF.
à If the Use wizard checkbox is not activated, the function shows the parameters for
Bead averaging. Note that these parameters are only available in Show all mode. We
recommend using the PSF wizard. The result of the wizard is a PSF file which you use in
deconvolution for images acquired under the same conditions.
This method determines the position of fluorescent beads in a Z-stack image. If these beads are
too close to one another they are excluded from the calculation. Beads which are far enough
apart from one another are combined into a single bead, from which it is then possible to calculate a PSF using the Create PSF function (Processing / Utilities).
Description of the algorithm
This function consists of a series of steps before and after processing. The aim is to find beads
that are far enough apart from one another. The processing steps are as follows:
§

Select input image

§

Image smoothing

§

Segmentation

§

Alignment of the center of the found beads

§

Averaging of the beads
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Parameters
§

Bead proximity: Defines the distance between two neighboring beads in μm. A bead is excluded from the averaging if the distance to a neighboring bead is greater than the minimum
distance set. A smaller value leads to the detection off fewer beads, albeit ones that are further apart, while a larger value leads to the detection of more beads, but with the risk that
beads will partially overlap. Range between 2.1 and 20 µm.

§

Detection sensitivity: determines the sensitivity with which beads are being detected. Range
is between -5 to 5. Smaller Values lower the sensitivity excluding beads with weaker staining
and lower signal to noise ratio, higher values include also beads with weaker staining.

§

Average Beads: If activated, an image of an individual, averaged bead is produced. If deactivated, an image is produced in which each found bead is centered, but saved in the R dimension. A slider for Rotation (R dimension) appears on the Dimensions tab.

Bad Pixel Correction
This parameter employs a fully automatic detection and removal of spurious or hot pixels (also
known as stuck pixels) in an image stack which might interfere with the PSF extraction procedure.
It is based on the analysis of the gray level variance in the neighborhood of each pixel in the image. It is usually recommended to leave this parameter active.

9.12.3 Adjust
9.12.3.1 Background Subtraction
With this function you remove smooth background or correct uneven illumination. The implementation is adapted from the corresponding function in ImageJ and based on the “rolling ball” algorithm (S. Sternberg, “Biomedical Image Processing”, IEEE Computer, January 1983).
Parameters

Parameter

Description

Radius

Here you adjust the radius of the rolling ball in pixels. This value
should be at least as large as the radius of the largest object in the image that is not part of the background. Larger values will also work
unless the background of the image is too uneven.

Create Background
only

If activated, an image which contains the detected background only is
created. Use this image to subsequently perform manual corrections
of the image background, e.g. using the image calculator function.

Do smoothing beforehand

If activated, a 3x3 pixel averaging is performed before analyzing the
background. Use this option to ensure that the image data after subtraction will not be below the background.

Light Background

Use this option if your image contains bright background and dark
objects.
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9.12.3.2 Brightness/Contrast/Gamma
This method allows you to adjust the brightness, contrast and gamma value of an image.

Info
Unlike the adjustments that can be made on the Display tab, here the pixel values of the image are changed.
Parameters

Parameter

Description

Brightness

Adjust the desired brightness using the slider or input field.
Changing the brightness means that each gray or color value is increased or decreased by the same value. The difference between the
biggest and smallest gray or color value in the image remains the
same, however.

Contrast

Adjust the desired contrast using the slider or input field.
Changing the contrast means that the gray or color values are multiplied by a factor. The difference between the biggest and smallest
gray or color value changes.

Gamma

Adjust the desired gamma value using the slider or input field.
Changing the gamma value means that the gray or color values are
multiplied by individual factors.

9.12.3.3 Color Balance
This method allows you to adjust the weighting of the individual color channels of a true color image.
Parameters

Parameter

Description

Range to Adjust

Here you can select the adjustment range for the color balance. There
are 3 ranges available:

-

Shadows

The settings relate to tones in the dark color range.

-

Midtones

The settings relate to tones in the mid color range.

-

Lights

The settings relate to tones in the light color range.

Cyan - Red

Adjust the desired color balance using the slider or input field.

Yellow - Blue

Adjust the desired color balance using the slider or input field.

Magenta - Green

Adjust the desired color balance using the slider or input field.

9.12.3.4 Color Temperature
This method allows you to adjust the color temperature of a true color image. Therefore use the
Temperature Delta slider. A description of the slider can be found under White Balance [} 141].
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9.12.3.5 Histogram Equalization
This function enhances the contrast by linearizing the histogram of the image to equal area fractions in the histogram. The areas (pixel count multiplied by gray value range) of all gray values in
the histogram of the result image are the same.

Parameter

Description

All Z

If activated, the function is applied to all Z planes.

All T

If activated, the function is applied to all time points.

High Threshold

The fraction of pixels that will be mapped to the highest gray value of
the output image.

Lower Threshold

The fraction of pixels that will be mapped to gray value 0.

9.12.3.6 Hue/Saturation/Lightness
This method allows you to adjust the hue, saturation and brightness of a true color image.
Parameters

Parameter

Description

Hue

The value of the shift represents an angle on the color wheel. The values -180 and +180 therefore have an identical effect. Negative angles
shift the color tone towards blue and positive ones shift it towards
red.
Adjust the desired shift in the color tone using the slider or input field.

Saturation

Saturation describes how intense the color of a pixel is. "Chromatic" is
the maximum saturation, while "achromatic" describes colors that do
not leave a color impression.
Adjust the desired saturation using the slider or input field.

Lightness

Lightness describes how light or dark a pixel appears. The greatest
difference is between black and white or between violet and yellow.
Adjust the desired brightness using the slider or input field.

9.12.3.7 Shading Correction
This method allows you to improve images in which the quality has been impaired by uneven illumination or vignetting.
If you want to perform shading correction before an experiment (recommended) you have to use
the shading correction function in the Camera tool in the Post-Processing section [} 673].

Parameter

Description

Shading Mode

-

Camera shading

Applies the Shading correction to each tile of a tile image.

-

Global shading

Applies the Shading correction to the whole tile image. Requires a
shading reference image with the same size as the tile image.
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Parameter

Description

Automatic

Activated: The function automatically calculates the reference image
for shading correction from the input image.

Shading Reference

Only available in Batch mode and if Global shading is selected or
Camera shading is selected and Automatic is deactivated.
Selects a reference image for the shading correction.

Display Mode

-

Additive

In this mode the normalized reference image is subtracted from each
camera frame. This influences the brightness of the image.

-

Multiplicative

In this mode each camera frame is divided by the normalized reference image. This influences the contrast of the image. This is the default setting.
The simulated/auto reference image is created by averaging up to 20
camera frames in the input image and running a lowpass filter on
them.

Offset

Adjust the gray value that will be added on to the newly calculated
gray values using the slider or input field. If this results in negative values, these are set to 0. Values that exceed the maximum gray value
are set to the maximum gray value.

9.12.3.8 Shading Reference from Tile Image
With this method you can create shading reference images for multi-channel tile images.
Note: Z-stack and time series images cannot be processed with this function! The best results are
achieved with tiles larger than 200 images.

Parameters

Description

All Scenes

Only available for multi-scene images.
Selects all scenes for processing.

Selected Scenes

Only available for multi-scene images and if All Scenes is deactivated.
Selects the scene for processing.

Merge Channels

Creates a single multi-channel-reference-image (with the same channel order) in one step.

Adjust per Channel

Only available for images with multiple channels.
Activated: You can adjust the settings for every channel separately.
To use a channel select Process Channel or select Skip Channel if
you do not want a channel to be processed.
The settings Save directly as Shading Reference and Channel-specific are applied separately for each channel. If you want to use the
same settings for all channels deactivate the checkbox.
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Parameters

Description

Save directly as
Shading Reference

Activated: The software creates the shading reference image and
stores it directly to the Calibration Manager (Shading Reference).
The software provides no possibility to check the image before they
will be saved, thus it is recommended to deactivate the checkbox and
execute this function. The system will create the reference images and
present it to you. If the images have a good quality, you can activate
the checkbox and run the function again.
Note that, if you activate this option it is important that you check afterwards the system messages (the "i" in the lower part of the
screen). If e.g. the resulting shading reference image is too dim the
system will not use it as valid shading reference image, this will be
shown under the system messages. Also if the import of the reference
database were successful this will be shown!

Channel-specific

Activated: The software performs channel-specific shading correction. In this case the fluorescence filter block used is saved with the
shading file. The following components will be considered:
Contrasting method and condenser, fluorescence filter, magnification:
Objective and Optovar; camera bit depth and RGB/BW mode, camera
type and port position.
Deactivated: The system creates an All Channel calibration and perform an objective specific shading correction. The following components will be considered:
Magnification (Objective and Optovar); Camera bit depth and RGB/
BW mode, and camera type and port position.

Multiply Factor

Here you can apply a multiply factor, thus the software will multiply
the pixel intensity for each pixel of the shading reference image by
this value.
If you use an own sample it is mostly the case that the images are
very dim and the intensity does not reach the value needed to be
used within the shading reference calibration manager, thus it will be
rejected.

Auto Adjust Intensity

Activated: Automatically calculates the multiply factor based on the
gray values of the image and the needed gray values for using it in
the shading reference calibration manager.
If activated, the setting for Multiply Factor has no influence anymore
on the image generation.

Apply Gaussian Filter

Activated: A Gaussian filter is applied after the averaging of the field
of views from a tiled image is done. This enables to smooth the shading reference image. The Sigma factor defines the strength of the
smoothing.
Use this filter and the Sigma factor very carefully as it could remove
also features which are real shading structures. This feature could be
recommend if the number of tiles in the scanned image is low and
cannot be increased for certain reasons.
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9.12.3.9 Stack Correction
This method allows you to improve the quality of Z-Stack images that have been affected by
bleaching effects during acquisition.
Parameters
Under Correction you can select the desired correction mode or a combination of the modes.

Parameter

Description

Decay

This mode compensates the bleaching effect.

Flicker

This mode compensates the flicker of the lamp voltage.

Background

This mode reduces background noise.

9.12.3.10 White Balance
This method allows you to adjust the white balance of an image.
Parameters

Parameter

Description

Automatic

Activated: The white spot is calculated automatically from the image
data.

White Spot

Only visible if the Automatic checkbox is deactivated.
Define the white spot by clicking on the
Pick.. button. The
mouse pointer then changes to a pipette symbol. Use it to click on a
white region of your input image. The coordinates and color values of
the selected white spot are displayed next to the button.

Temperature Delta

Adjust the delta that will be added on to the newly calculated color
values. Negative values reduce the color temperature, while positive
values increase it. A value of 1 corresponds to 10 Kelvin.

9.12.4 Edges
9.12.4.1 Gradient Max
This method performs a gradient filtering. Based on the sum of a 2x2 matrix in the X-and Y-direction, a gradient image is calculated and using the larger of the two components. The edges are
darker than that of the method Gradient Sum.
9.12.4.2 Gradient Sum
This method performs a gradient filtering. Based on the sum of a 2x2 matrix in the X-and Y-direction, a gradient image is calculated. The edges are brighter than that of the method Gradient
Max.
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9.12.4.3 Highpass
This method performs high-pass filtering. The high pass filter is defined as the difference between
the original image and the low-pass filtered original.

Parameter

Description

Normalization

Depending on the image processing function you have selected not
all choices are available in the list.

-

Clip

Gray levels that exceed or fall below the specified gray value range
are automatically set to the lowest/highest gray value (black or white).
The effect corresponds to underexposure or overexposure. This means
that in some cases information is lost.

-

Automatic

Automatic normalization of gray values to the available gray value
range.

-

Wrap

If the result is greater than the maximum gray value of the image, the
value maximum gray value +1 is subtracted from it.

-

Shift

Normalizes the output to the value gray value + max. gray value/2.

-

Absolute

Values are used positive only.

Count

Here you set the number of repetitions. I.e. the number of times the
function is applied sequentially to the respective result of the filtering.
The effect is increased correspondingly.

Kernel Size

You can set the filter size in the x-, y-and z-direction, symmetrically
around the subject pixel. This should be the size of the transition region between objects and background match.

9.12.4.4 Laplace
This function performs a Laplace highpass filter on an image.
The calculation is based on a 3x3x3 Laplace operator in all directions. The function does not show
smooth gray value changes very well.
9.12.4.5 Local variance
This method is an edge filter, which calculates the variance of each pixel with its neighboring pixels by the lateral filter size.
Parameter
Kernel Size in X/Y
Here you set the matrix size in X / Y symmetrically around the pixel. This determines the degree of
smoothing effect in the X / Y direction.
9.12.4.6 Roberts
This method calculates a gradient image using the Roberts filter matrix. Large gray value differences between neighbors are shown as light gray values. No changes are indicated by a value of 0
(black). Edges are thinner than with the Sobel method.
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9.12.4.7 Sobel
Sobel calculates a gradient image using a Sobel filter.
This method indicates gray value changes in the image. Large differences between neighbors are
displayed as bright gray values, no changes are indicated by a value of 0 (zero). The pixels in the
output image are calculated with the Sobel differential operator on the basis of a 3x3x3 fold of
the input image.

9.12.5 Geometric
9.12.5.1 Change Orientation
With this function you can easily change the image orientation.
Parameters

Parameter

Description

Orientation

-

Flip Horizontally

Flips the image horizontally.

-

Flip Vertically

Flips the image vertically .

-

Rotate 90 CW

Rotates the image by 45 degrees clockwise (CW).

-

Rotate 90 CCW

Rotates the image by 45 degrees counter clockwise (CCW).

-

Rotate 180

Rotates the image by 180 degrees.

-

Mirror at +45
Diagonal

Mirrors the image at +45 degrees diagonal.

-

MIrror at -45
Diagonal

Mirrors the image at -45 degrees diagonal.

9.12.5.2 Channel Alignment
Using this method it is possible to automatically align the individual channels of a multi-channel
image correctly to one another.
Parameters

Parameter

Description

Registration Method

Here you can select the method (or a combination of these) to
be used to align the images.

-

Translation

The neighboring sections of the Z-stack image are shifted in relation to each other in the X and Y direction.

-

Rotation

The neighboring sections of the Z-stack image are rotated in relation to each other.

-

Iso Scaling

The magnification is adjusted from section to section.
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Description

-

Skew Scaling

The neighboring sections of the Z-stack image are corrected for
skewness / shearing.

-

Affine

The neighboring sections of the Z-stack image are shifted in the
X and Y direction, rotated and the magnification is adjusted from
section to section.

The following parameters are only visible if the Show All mode is activated:

Parameter

Description

Quality

Here you can select the quality level that you want the function
to work with.

-

Low

Highest speed with low image quality.

-

Medium

High speed with medium image quality.

-

High

Low speed with high image quality.

-

Highest

Lowest speed with highest image quality.

Interpolation

Here you can select how you want interpolation to be performed
if a pixel is calculated from several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is
closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear
combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial function of the input pixels closest to it.

9.12.5.3 Channel Alignment (Extended)
Using this method it is possible to automatically align the individual channels of a multi-channel
image correctly to one another.
Parameters

Parameter

Description

Load transformation

If activated, the result of a previous transformation can be
loaded. Click on

to select an according *.xml file.

Save transformation

If activated, the result of the transformation process is saved in
an *.xml file for later use.

Parameter

Description

Registration Method

Here you can select the method (or a combination of these) to
be used to align the images.

-

Translation

The neighboring sections of the Z-stack image are shifted in relation to each other in the X and Y direction.
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Description

-

Rotation

The neighboring sections of the Z-stack image are rotated in relation to each other.

-

Iso Scaling

The magnification is adjusted from section to section.

-

Skew Scaling

The neighboring sections of the Z-stack image are corrected for
skewness / shearing.

-

Affine

The neighboring sections of the Z-stack image are shifted in the
X and Y direction, rotated and the magnification is adjusted from
section to section.

The following parameters are only visible if the Show All mode is activated:

Parameter

Description

Quality

Here you can select the quality level that you want the function
to work with.

-

Low

Highest speed with low image quality.

-

Medium

High speed with medium image quality.

-

High

Low speed with high image quality.

-

Highest

Lowest speed with highest image quality.

Interpolation

Here you can select how you want interpolation to be performed
if a pixel is calculated from several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is
closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear
combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial function of the input pixels closest to it.

9.12.5.4 Color-coded Projection
The Color-coded projection function generates a maximum intensity projection image along the
z-, or time-dimension of a multidimensional data set. Instead of using the colors assigned to the
channels, it displays the position in z or in time with a color gradient.
Parameters

Parameter

Description

Palette

Sets the color-pattern for the projection.

ROI

Specifies the range of the dimension (chosen below) which will be
used for the projection.

Dimension

Selects whether to perform the projection along the time (T) or along
the z-axis (Z). Only dimensions which are available in your data set are
shown.
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Parameter

Description

Quantitative

Activated: Uses a quantitative method which first creates a maximum intensity projection and then determines at which plane a pixel
was located. After that it attributes a color of the LUT to the pixel.
This method can sometimes produce abrupt transitions, but the pixel
color representing depth or time corresponds correctly to the colors in
the annotation.
Deactivated: This method attributes a color of the LUT to each plane
and then separates the result into RGB channels. Subsequently it creates a maximum intensity projection of each RGB channel and then
combines the results into one image. Note that while this might result
in a more pleasantly looking image, the method can produce colors
which do not correspond to colors in the annotation!

9.12.5.5 Image Overlay
With this function you can align (or overlay) two images that are displaced in relation to each
other. It is also possible to make the individual planes of a z-stack image congruent, in the event
that they are not lying exactly on top of one another.
You can define 3 related points (Input Pixel) in both the input image and in the reference image
(Reference Pixel) that is displaced in relation to it. Therefore click interactively on conspicuous
points, which are present in both images. If you click Apply the function calculates the Output
image, in which the new fitting points have the same coordinates as in the Input image.
Parameters

Parameter

Description

Input Pixel 1 - 3

If you click on the corresponding buttons you can define the 3 input
pixel points.
The selected point is shown in the graphics plane. This serves as an
aid to orientation when you are clicking on the reference points.

Reference Pixel 1 3

If you click on the corresponding buttons you can define the 3 reference pixel points.

Interpolation

Here you can specify how the rotation influences the neighboring pixels.

-

Linear

The rotated pixel is given the gray value calculated from the linear
combination of the gray values of the pixel closest to it and this pixel’s
nearest neighbor.

-

Cubic

The rotated pixel is given the gray value resulting from a polynomial
function of the pixel that is closest to it.
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9.12.5.6 Mirror
This method allows you to flip an image horizontally or vertically. In the case of multidimensional
images, such as Z-stack or time lapse images, you can also use the mirror method to reverse the
sequence of the relevant dimension.
Parameters

Parameter

Description

Display Mode

-

Horizontal

Flips the image horizontal

-

Vertical

Flips the image vertical

-

T/ Z

Only visible if input image is a multichannel image.
Reverses sequence of the sections (Z) or time points (T)

9.12.5.7 Orthogonal Projection
With this method you can extract specific parts of the image of three-dimensional images. This is
accomplished with three alternative projection planes, frontal in the XY direction, sagittal in YZ direction or transverse in XZ direction as seen from the observer of the image. You can choose between different projection methods, all have in common is that the pixels are analyzed by the observer along an imaginary projection beam. You can also determine the thickness of the projection planes, and thus the projection depth.
Parameters

Parameter

Description

Projection Plane

Here you choose the type of the projection plane (Frontal X/Y, Transverse (X/Z), Sagittal (Y/Z).

Method

-

Maximum

Uses the brightest pixel along the projection beam.

-

Minimum

Uses the darkest pixel along the projection beam.

-

Average

Calculates the average of all pixel along the projection beam.

-

Weighted average

This method is related to the calculation of the extended depth of focus. It prefers structures with more lateral sharpness along the projection beam. The output image contains more significant details.

-

Standard deviation

Calculates the standard deviation of pixel grey values along the projection beam.

Start position

Here you adjust the starting position of the project plane (in pixel
units or z-stack positions depending on the chosen projection plane).
The maximum range results automatically of the size of the input image.

Thickness

Here you adjust the thickness of the cutting plane (in pixel or z-stacks
depending on the chosen projection plane). The maximum range results automatically of the size of the input image.
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9.12.5.8 Resample
This method allows you to change the size of an image in every dimension. You can either enlarge
or reduce the image size.
Parameters

Parameter

Description

Third Dimension

Only visible, if there is a third dimension in the input image and/or
Show all mode is activated.
Here you can select how you want the function to work in the case of
multidimensional images.

-

2D Slices

The function is used in a 2-dimensional fashion only for multidimensional images such as time lapse or z-stacks.

-

Z, T or C

Here you can select to which additional dimension the functions
should be applied to.

Adapt sizes

Activated: The size of the output image is adjusted in accordance
with the settings for the scaling.
Deactivated: The output image has the same size as the input image.
Depending on the image size and rotation angle, partial areas of the
input image may not be visible in the output image.

Adjust per Channel

Only visible if your input image is a multi-channel image.
Activated: You can adjust the parameters for each channel individually.

Interpolation

Here you can select how you want interpolation to be performed if a
pixel is calculated from several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial
function of the input pixels closest to it.

Controls

Parameter

Description

Scaling in X

Adjust the desired scaling for X using the slider or input field.

Scaling in Y

Adjust the desired scaling for Y using the slider or input field.

Scaling in Z

Adjust the desired scaling for Z using the slider or input field.

The following parameters are only visible if the Adapt sizes checkbox is deactivated:
Shift in X

Enter the shift in the X direction using the slider or input field.

Shift in Y

Enter the shift in the Y direction using the slider or input field.

Shift in Z

Enter the shift in the Z direction using the slider or input field.
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9.12.5.9 Rotate
With this method you can rotate images by defined angles. This function was especially developed for rotating complex (multi-dimensional) images in the available image dimensions. Therefore the function can be a little bit slower but offers more settings for the rotation. For simple, 2dimensional rotations we recommend to use the Rotate 2D function which is usually lots of
faster.
Parameter

Parameter

Description

Third Dimension

Only visible, if there is a third dimension in the input image and/or
Show all mode is activated.
Here you can select how you want the function to work in the case of
multidimensional images.

-

2D Slices

The function is used in a 2-dimensional fashion only for multidimensional images such as time lapse or z-stacks.

-

Z, T or C

Here you can select to which additional dimension the functions
should be applied to.

Adapt sizes

Activated: The size of the output image is adjusted in accordance
with the settings for the scaling.
Deactivated: The output image has the same size as the input image.
Depending on the image size and rotation angle, partial areas of the
input image may not be visible in the output image.

Adjust per Channel

Only visible if your input image is a multi-channel image.
Activated: You can adjust the parameters for each channel individually.

Interpolation

Here you can select how you want interpolation to be performed if a
pixel is calculated from several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial
function of the input pixels closest to it.

Parameter

Description

Angle

Enter the angle by which you want the input image to be rotated
around using the slider or input field. Positive angles rotate the images clockwise.

Angle X

Enter the angle by which you want the input image to be rotated on
the X axis using the slider or input field.

Angle Y

Enter the angle by which you want the input image to be rotated on
the Y axis using the slider or input field.
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Parameter

Description

Angle Z

Enter the angle by which you want the input image to be rotated on
the Z axis using the slider or input field.

The following parameters are only visible if the Adapt sizes checkbox is deactivated:
Center X

Enter the X coordinate of the center of the rotation using the slider or
spin box/input field.
The value 0 means that the image is rotated around its center point.
Negative values mean that the center of the rotation in the image is
shifted to the left in relation to the image's center point. Positive values shift the center to the right.

Center Y

Enter the Y coordinate of the center of the rotation using the slider or
spin box/input field.
The value 0 means that the image is rotated around its center point.
Negative values mean that the center of the rotation in the image is
shifted downwards in relation to the image's center point. Positive
values shift the center upwards.

Center Z

Enter the Z coordinate of the center of the rotation using the slider or
spin box/input field.
The value 0 means that the image is rotated around its center point.
Negative values mean that the center of the rotation in the image is
shifted forwards in relation to the image's center point. Positive values shift the center backwards.

9.12.5.10 Rotate 2D
With this method you can easily rotate an image clockwise around its center axis. Simply set the
desired angle with the slider. Of course you can enter the angle value in the input field directly. To
perform the rotation click on the Apply button on top of the Processing tab.

Parameter

Description

Angle

Enter the angle by which you want the input image to be rotated
around using the slider or input field. Positive angles rotate the images clockwise.

Interpolation

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial
function of the input pixels closest to it.

Edge Smoothing

Activated: Performs edge smoothing.

PaveWholePlane

Activated: Paves the whole resulting plane with tiles; there might be
empty tiles.
Inactivated: Creates only tiles which contain also parts of the image.
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Description

ProcessMask

Activated: Rotates also the mask of valid/invalid pixels.

ZEISS

Inactivated: Ignores the mask of valid/unvalid pixels. Pixels previously
marked as invalid will have an intensity of zero after rotation but are
not marked as invalid.
IncludeGraphic Elements

Activated: Rotates also the graphical elements together with the image.
Inactivated: Rotates only the image, but not the graphical elements.

9.12.5.11 Sample Down
With this function you can reduce the size of an image in a flexible way. The reduction is performed along with an averaging of the respective dimension. If the parameters are set to 1, the
corresponding dimension is not modified.
Parameters

Parameter

Description

Average Pixels X

Here you adjust how many pixels are averaged in the lateral X dimension to calculate the output image. The size of the output will be
smaller by this factor.

Average Pixels Y

Here you adjust how many pixels are averaged in the lateral Y dimension to calculate the output image. The size of the output will be
smaller by this factor.

Third Dimension

If your input image has a third dimension you can select it here for resampling.
§ Z (sections of a Z-Stack)
§ T (time points of a time series)
§ C (Channels) or
§ H (Phases).
§ If 2D Slices is chosen, the third dimension will not be re-sampled.

9.12.5.12 Shift
This method allows you to shift the content of an image in the direction of the 3 axes X, Y and Z.
To adjust the shift use the respective sliders or input fields under Parameters.

Parameter

Description

Third Dimension

Only available if Show All is activated an if the acquired image is
three dimensional.
Selects the third dimensional shift.

–

2D Slices

The third dimension is shifted by 0 which means the image is only
shifted in X / Y direction.

–

Z

The shift is in Z direction.
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Description
Shifts the channel.
If you have a 32 channel image, the first 30 channels are copied/ interpolated into the last ones (for an 32 channel lambda image this
would result in a shift to the red spectrum).
When selected, the checkbox Adjust per channel is not available.

Adjust per Channel

Only available for images with multiple channels.
Opens a list with the channels to allow an individual adjustment of
each channel.

–

Process Channel

Shifts this channel according to the input.

–

Skip Channel

Skips this channel when processing. This channel will not be in the
output image.

–

Copy Channel

This channel is copied into the output image without a shift.

Shift in X

Selects the shift of the content in X direction.

Shift in Y

Selects the shift of the content in Y direction.

Shift in Z

Selects the shift of the content in Z direction.

9.12.5.13 Stage Alignment
The images are registered by using the stage calibration points from the meta data.

Parameter

Description

Interpolation

Here you can select how you want interpolation to be performed.

-

Nearest Neighbor

The output pixel is given the value of the input pixel that is closest to
it.

-

Linear

The output pixel is given the value resulting from the linear combination of the input pixels closest to it.

-

Cubic

The output pixel is given the value resulting from a polynomial function of the input pixels closest to it.
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9.12.5.14 Stitching
This method allows you to align the individual tiles of a tile image with one another automatically
and correctly.
Parameters

Parameter

Description

Inplace

The stitching is applied to the original image.

New Output

A new image is generated as a result of the stitching process. The
original image is not modified.

Fuse Tiles

Only visible when the button New Output is selected.
Activated: All individual tile images are fused together after alignment.
Deactivated: The individual tile images are aligned but not fused.

Correct shading

Only visible when the button New Output is selected.
Activated: Applies a shading correction (Multiplicative mode, see
Shading Correction [} 138]) to each image of prior to stitching.
Select from the dropdown list which reference should be used for
shading correction:

-

Automatic

The function automatically calculates a reference image from the input image.

-

Reference

The function uses an existing reference image. This must be selected
in addition to the input image in the input tool of the image parameters section. In Batch mode, a reference image must be defined beneath.

Select Reference
Image

Only visible in Batch mode and if Reference is selected as shading
correction.
Selects a reference image for the shading correction.

Select dimension references for stitching
Only visible for multidimensional input images.
Select here a reference dimension (one channel, one z-position, one time point) from your multidimensional data set. This reference dimension is either stitched exclusively (no other planes of the
dimensions are stitched) or serves as reference when stitching all planes of the dimensions.

Parameter

Description

Get all dimensions
from 2d view

Reads the current planes of the dimensions from the 2D view.

Z-Position

Selects a z-position for the 2D image.

Time

Selects a time point for the 2D image.

Channels

Selects a channel for the 2D image.

Illumination

Only visible for dual side illuminated images.
Selects an illumination side for the 2D image.
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Description

View

Only visible for Multiview images.
Selects a view for the 2D image.
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Stitch multiple dimensions section
Only visible for multidimensional input images. Under the respective dimension you can select
which planes of the dimensions should be considered for stitching.

Parameter

Description

All by reference

Only the reference plane (2D image) for this dimension is taken into
consideration for calculating the stitch. All other planes are stitched
accordingly and appear in the output image.

Reference only

Only the selected reference plane (2D image) of this dimension is
stitched. No other planes appear in the output image.

All individually

All planes of this dimension are stitched and appear in the output image. The stitch is calculated individually for each plane.

Parameters

Parameter

Description

Edge Detector

-

Yes

An edge detector is applied to localize image edges. This may improve
the stitching result.

-

No

No edge detector is applied.

Minimal Overlap

Sets the extent of the area of minimal overlap (in %) of the individual
tiles

Max Shift

Sets the maximal extent of the shift (in %) of the individual tiles to
one another.

Comparer

Here you can select how the conformance of the tiles in the overlapping regions is evaluated.

-

Basic

Basic comparison (faster).

-

Best

Elaborate comparison (slower).

-

Optimized

Optimized comparison.

Global Optimizer

Select here which tile overlaps are evaluated.

-

Basic

Only one overlap per tile is evaluated.

-

Best

All overlaps of a tile are evaluated.

9.12.5.15 Z-Stack Alignment
This method allows you to bring the individual planes of a Z-stack image into line if these are not
positioned precisely one above the other. This is the case, for example, when you acquire Z-stacks
at an oblique angle using a stereo microscope.
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Parameters

Parameter

Description

Registration Method

Here you can select the method (or a combination of these) to
be used to align the images.

-

Translation

The neighboring sections of the Z-stack image are shifted in relation to each other in the X and Y direction.

-

Rotation

The neighboring sections of the Z-stack image are rotated in relation to each other.

-

Iso Scaling

The magnification is adjusted from section to section.

-

Skew Scaling

The neighboring sections of the Z-stack image are corrected for
skewness / shearing.

-

Affine

The neighboring sections of the Z-stack image are shifted in the
X and Y direction, rotated and the magnification is adjusted from
section to section.

The following parameters are only visible if the Show All mode is activated:

Parameter

Description

Quality

Selects the quality level that you want the function to work with.
The calculation of the alignment is based on a so-called image
pyramid. The higher the selected quality, the more levels of the
image pyramid are used to calculate the alignment and the more
precise the alignment will be. However, the higher the selected
quality is, the slower the calculation of the alignment will get.

–

Low

This is the most imprecise but also the fastest calculation of the
alignment. It uses a low number of levels (2) of the image pyramid for the alignment calculation.

–

Medium

This is a more precise but also a slower calculation of the alignment than the one before. It uses a medium number of levels (3)
of the image pyramid for the alignment calculation.

–

High

This is a more precise but also a slower calculation of the alignment than the two before. It uses a high number of levels (4) of
the image pyramid for the alignment calculation.

–

Highest

This is the most precise but also the slowest calculation of the
alignment. It uses the highest number of levels of the image
pyramid for the alignment calculation.

Interpolation

Here you can select how you want interpolation to be performed
if a pixel is calculated from several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is
closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear
combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial function of the input pixels closest to it.
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9.12.6 Morphology
Morphology functions apply structure elements to images. A structure element is like a stencil
with holes. When the stencil is placed on an image then only some pixels are visible through the
holes. The gray values of these pixels are collected and their external gray value (minimum or
maximum) is computed.
This external gray value is assigned to that pixel of the resulting image which corresponds to the
place of the origin of the stencil on the input image. When the stencil is placed at all positions of
the input image, all pixels of the resulting image are thus assigned. When bigger structure elements are required than those which are provided, these can be achieved by iterating the small elements using the Count parameter.
The following functions are available:

Function

Description

Erode

Shrinks bright structures on a darker background in the input image.
Thin connections between structures and small structures itself will
disappear.

Dilate

Expands bright structures on a darker background in the input image.
Small gaps between structures are filled and those structures become
connected.

Open

First erodes (Erode class) the bright structures on a darker background
in the input image, then it dilates (Dilate class) the result by the same
number of steps. Thus it separates bright structures on a darker background, but approximately keeps the size of the structures.

Close

First dilates (Dilate class) the bright structures on a darker background
in the input image, then it erodes (Erode class) the result by the same
number of steps. Thus it connects bright structures on a darker background, but approximately keeps the size of the structures.

Top Hat (White)

Computes the difference between the original image and the image
produced by an open operation (Open class). Bright structures which
were flattened by the opening are strengthened in the result. This is
like putting a top hat with the size of the open operation upon the
structure and keep only the part inside the hat.

Top Hat (Black)

Computes the difference between the original image and the image
produced by a close operation (Close class). Dark structures which
were flattened by the closing are strengthened in the result. This is
like lifting a top hat with the size of the close operation beneath the
structure from the dark side and keep only the part inside the hat.

Gradient

Computes the difference between the dilated image and the eroded
image (Dilate and Erode class). Since a point in the dilated image has
the maximum gray value and the corresponding point in the eroded
image has the minimum gray value within the structure element the
difference is zero for regions of constant gray values and gets bigger
for steeper gray value ramps or edges.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

156

9 Image Processing | 9.12 Image Processing Functions

ZEISS

Function

Description

Watersheds

Computes the barriers between catchment basins of local minima in
the gray valued input image. A local minimum is a connected plateau
of points from which it is impossible to reach a point of lower gray
value without first climbing up to higher gray values. A catchment
basin of a local minimum is a connected component which contains
that minimum and all downstream points to it. A downstream is a
path of points along which gray values are monotonically descending.
Thus all catchment basins of local minima are expanded until they collide with another catchment basins. At those point barriers (watersheds) are built up. The output image is binary and contains all watersheds. If the 'Basins' flag is set, the catchment basins themselves are
in the output image as uniquely labeled connected components without any border lines.

Grey Reconstruction

Works mainly as an iterated dilation (Dilate class) of the image, but
with a constraint image as a second input image. After every dilation
step the pixel wise minimum of the dilated image and the constraint
image is computed and gives the next image to be dilated. The computation stops automatically when all the just dilated pixels are bigger
than the corresponding ones in the constraint image.

Parameters

Parameter

Description

Structure Element

Here you select the desired structure element. Following elements are
available: Horizontal, Diagonal 45°, Vertical, Diagonal 135°, Cross,
Square, Octagon

Count

Here you can adjust the number of repetitions to define the size of
the structure element.

Binary

Only available for Erode, Dilate, Open and Close function.
Activated: Creates a binary image. The calculation will be faster.

9.12.7 Sharpen
9.12.7.1 Delineate
This method enhances the edges of individual regions in an image. It corrects the halo effect and
only affects edges.
Parameters

Parameter

Description

Threshold

Enter the threshold value for edge detection using the slider or spin
box/input field. The threshold value should correspond roughly to the
gray value difference between objects and the background.

Size

Enter the size of the edge detection filter using the slider or spin box/
input field. The value should correspond to the size of the transition
area between objects and the background.
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9.12.7.2 Enhance Contour
This method allows you to enhance contours in an image and emphasize regions in which gray
values change. The function is suitable for visually emphasizing fine structures in an image.
Parameters

Parameter

Description

Strength

Here you can adjust the factor for increasing edge enhancement.

Normalization

Here you can select how the gray/color values that exceed or fall
short of the value range should be dealt with.

-

Clip

Automatically sets the gray levels that exceed or fall short of the predefined gray value range to the lowest or highest gray value (black or
white). The effect corresponds to underexposure or overexposure. In
certain circumstances some information may therefore be lost.

-

Automatic

Normalizes the gray values automatically to the available gray value
range.

-

Wrap

If the result is larger than the maximum gray value of the image, the
maximum gray value + 1 is deducted from this value.

-

Shift

Normalizes the output to the value "gray value + maximum gray
value/2".

-

Absolute

Converts negative gray levels into positive values.

9.12.7.3 Extended Depth of Focus
Using this method you can combine the sharp regions from the individual sections of a Z-stack image to form a single image. This enables you to display a considerably larger depth of field than is
possible on a microscope.
Parameters

Parameter

Description

Method

-

Wavelets

A wavelet transform is used to detect the sharpest areas in the images.

-

Contrast

For the this method the value is the difference between the brightest
and the darkest pixel value within the “Kernel”.

-

Maximum Projection

Images with the brightest and darkest pixels are generated first. Of
these images the image with the higher variance is used as the resulting image.

-

Variance

For this method the variance of the pixel values is calculated within
the “Kernel”.
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Parameter

Description

Z-Stack Alignment

Here you can select whether you want the Z-stack image to be
aligned before the calculation and with what quality level. If you want
to acquire images with a stereo microscope, the images are displaced
against each other. This displacement can be corrected. The higher
the quality of alignment is selected, the longer is the calculation. Select No Alignment, if you want to acquire images with a compound
microscope.

-

No Alignment

The Z-stack image is not aligned before the calculation. You should
select this setting if the Z-stack image has not been acquired using a
stereo microscope.

-

Normal

High speed with normal image quality.

-

High

Low speed with high image quality.

-

Highest

Lowest speed with best image quality.

9.12.7.4 Unsharp Mask (Sigma)
Using this method you can increase the impression of sharpness in an image and consequently
obtain an image display that is richer in detail. The function allows contrasts at small structures
and edges to be enhanced in a targeted way.

Parameter

Description

Strength

Enter the strength of the Unsharp Masking using the slider or spin
box/input field. The higher the value selected, the greater the extent
to which small structures are enhanced.

Sigma

Adjusts the sigma value derived from Gauss [} 161]. Reduces noise in
an image. Each pixel is replaced by a weighted average of its neighbors. The neighboring pixels are weighted in accordance with a twodimensional Gauss bell curve.

Color Mode

Select the desired color mode from the dropdown list.

-

RGB

Calculates the sharpness for each color channel individually. The color
saturation and the color of structures may be changed and color noise
may occur.

-

Luminance

Only calculates the sharpness on the basis of the brightness signal detected. This mode does not show any color noise and changes the
color saturation accordingly.

Threshold Mode

Here you can select a setting from the dropdown list for calculating
the boundary between the sharpened image regions.
It is only effective if the value for the Lower Threshold Value parameter is not equal to 0 or the value for the Upper Threshold
Value parameter is not equal to 100.

-

None

No adjustment takes place.

-

Binary

The transition follows the threshold values.

-

Linear

Calculates a linear course.
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Parameter

Description

Threshold Low

Enter the lower threshold value using the slider or spin box/input field.
This determines the lower limit from which existing contrast structures
are changed.

Threshold High

Enter the upper threshold value using the slider or spin box/input
field. This prevents the existing strong contrasts in the image from being increased further unnecessarily.

Clip To Valid Bits

Activated: The value range of the gray/color values of the output image is adjusted to the value range of the input image.

See also
2 Using Direct Processing [} 346]

9.12.8 Smooth
9.12.8.1 Binomial Filter
This method allows you to reduce noise in an image. Each pixel is replaced by a weighted average
of its neighbors. The weighting factors are calculated from the binomial coefficients in accordance
with the filter size. The binomial filter is very similar to a Gaussian filter in its effect.
Parameter

Parameter

Description

Kernel Size

Her you can adjust the size of the filter matrix. If the Show All mode
is activated you can adjust the values in X ,Y and Z direction individually.

9.12.8.2 Denoise
This method removes noise from images using a real or a complex wavelet transformations. The
process of denoising an image can be broken down into the following three parts:
§

Calculate the wavelet transform of the noisy image.
The wavelet transformation can be calculated by the method Real Wavelets and Complex
Wavelets.

§

Modify the noisy wavelet coefficients.
This is done by using bivariate shrinkage with local variance estimation (thresholding). [Bivariate Shrinkage with Local Variance Estimator, Levent Sendur and Ivan W. Selesnick, IEEE Signal
Processing Letters, Vol. 9, No. 12, December 2002]

§

Compute the inverse transform using the thresholded coefficients.

Parameter

Description

Method

-

Complex wavelets

The Dual Tree Complex Wavelet transform provides better results due
to the fact that it is nearly direction invariant and makes more directional sub bands available. The results will be less prone to block-artefacts. However, this method is computationally more intense and
therefore takes longer.
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ZEISS

Description
The real wavelet transform only considers three sides (XYZ) and is
therefore faster. However, the result can show block artefacts.
Here you adjust the strength with which the function is applied.

See also
2 Using Direct Processing [} 346]
9.12.8.3 Gauss
This method allows you to reduce noise in an image. Each pixel is replaced by a weighted average
of its neighbors. The neighboring pixels are weighted in accordance with a two-dimensional
Gauss bell curve.

Parameter

Description

Sigma

Here you can adjust the sigma value. If the Show All mode is activated you can adjust the values in each dimension individually.

9.12.8.4 Lowpass
This method allows you to reduce noise in an image. Each pixel is replaced by the average of its
neighbors. The size of the area of the neighboring pixels considered is defined by a quadratic filter
matrix. The modified pixel is the central pixel of the filter matrix.
Parameter

Parameter

Description

Count

Enter the number of repetitions using the slider or input field. The
function can be applied several times in succession to the result of the
filtering. This intensifies the effect accordingly.

Parameter

Description

Kernel Size

Her you can adjust the size of the filter matrix. If the Show All mode
is activated you can adjust the values in X ,Y and Z direction individually.

9.12.8.5 Median
This method allows you to reduce noise in an image. Each pixel is replaced by the median of its
neighbors. The size of the area of the neighboring pixels considered is defined by a quadratic filter
matrix. The modified pixel is the central pixel of the filter matrix. The median is the middle value
of the gray values of the pixel and its neighbors sorted in ascending order.

Parameter

Description

Kernel Size

Here you can adjust the size of the filter matrix. If the Show All mode
is activated you can adjust the values in X ,Y and Z direction individually.
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9.12.8.6 Rank
This method performs a rank order filtering. The gray levels of the resulting image is determined
by calculating the ranking within the matrix of the filter size in the X and Y directions. Even numbers are automatically set to the next odd number. A low value for the rank value enlarges dark
areas, a higher value will increase bright areas of the image.
9.12.8.7 Sigma
This method allows you to reduce noise in an image. Each pixel is replaced by the average of its
neighbors. The size of the area of the neighboring pixels considered is defined by a quadratic filter
matrix. The modified pixel is the central pixel of the filter matrix. To calculate the average, only
the gray values that lie within a defined range (+/- sigma) around the gray value of the central
pixel are taken into consideration. As a result, fine object structures are not blurred; only the gray
levels in image regions that belong together are adjusted.
Parameter

Parameter

Description

Sigma

Enter the sigma value using the slider or input field.

Parameter

Description

Kernel Size

Her you can adjust the size of the filter matrix. If the Show All mode
is activated you can adjust the values in X ,Y and Z direction individually.

9.12.8.8 Single Pixel Filter
With this function you can remove single pixel phenomena, such as those that occur in the case
of clocking induced charge with EMCCDs and as radio telegraph signal noise with CMOS sensors.
It is a filter which analyzes the input image and removes pixels, whose intensity value diverges
strongly from the median intensity of its neighboring pixels.
The filter analyzes the input image and removes pixels that are "much" larger than the median of
their neighbors. The algorithm works as follows:
1. Sort all 9 pixel in a 3x3 neighborhood.
2. Determine the median intensity value of the sorted pixels.
3. Multiply the median by the threshold factor to get the limit.
4. If the center pixel intensity is larger than the limit, replace the pixel with the median.
Larger values of the threshold factor increase the value of the intensity limit and decrease the
number of pixels that are replaced. The default value of 1.5 is arbitrary, but seems to remove
charge induced noise from images acquired using cameras with EM gain capabilities. This filter
can also be used to remove hot pixels from images.
Parameter

Parameter

Description

Threshold

Here you adjust the threshold value.
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9.12.9 Time Series
9.12.9.1 Gliding Average
With this function a smoothing effect can be achieved due to averaging out noise. It therefore
calculates the gliding average of a time series image, taking into account the defined number of
time points according to the following schematic:
Input Image: SizeT = 6
Averaging Length: AvL = 3
Output image: SizeT(output) = SizeT – AvL + 1 = 6 -3 +1 = 4

Parameter

Parameter

Description

Average Length

Specifies the number of images used to determine the mean value.
The maximum value correlates with the number of time points.

Scaling Factor

The preset value is 1. Values > 1 can be applied for images with low
intensity. In this case all pixel values are multiplied by the specified
factor.

9.12.9.2 Kymograph
This method creates a Kymograph. The input image has to be a time series image containing a
graphical element (e.g. a line, arrow, curve or polygon) which is not locked.
Parameter

Parameter

Description

Graphic tool

Here you see all graphic tools which can be used. Choose the desired
graphic tool from the list. Note that the tool must be selected in the
image as well.

Width

Here you adjust the graphic tools width (in pixel). This determines
which pixels are used to calculate the average gray value along the
width.
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9.12.9.3 Time Alignment
Using this function you can automatically align individual time points in order to compensate for
shifts between time points.

Info
For the alignment function to work the presence of immobile and clearly distinguishable object
structures in the time series is required. Also, when aligning z-stacks over time, you should always use the z dimension from the Third Dimension drop down list. Otherwise each z-plane
would be aligned over time potentially leading to z-stack artefacts.
Parameter

Parameter

Description

Registration Method

Here you can select the method (or a combination of these) to
be used to align the images.

-

Translation

The neighboring sections of the Z-stack image are shifted in relation to each other in the X and Y direction.

-

Rotation

The neighboring sections of the Z-stack image are rotated in relation to each other.

-

Iso Scaling

The magnification is adjusted from section to section.

-

Skew Scaling

The neighboring sections of the Z-stack image are corrected for
skewness / shearing.

-

Affine

The neighboring sections of the Z-stack image are shifted in the
X and Y direction, rotated and the magnification is adjusted from
section to section.

The following parameters are only visible if the Show All mode is activated:

Parameter

Description

Quality

Here you can select the quality level that you want the function
to work with.

-

Low

Highest speed with low image quality.

-

Medium

High speed with medium image quality.

-

High

Low speed with high image quality.

-

Highest

Lowest speed with highest image quality.

Interpolation

Here you can select how you want interpolation to be performed
if a pixel is calculated from several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is
closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear
combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial function of the input pixels closest to it.
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9.12.9.4 Time Concatenation
This function joins two images to form a new time series image. Select the desired images in the
Input tool and click Apply.

Info
Images with varying dimensions will be put into different blocks by this function. The resulting
image document shows a Block slider in the Dimensions view block.

9.12.9.5 Time Differential
This function calculates the first and second order differential of a time lapse image according to
the following formula and schematic:
First Order Differential:
Output[t] = Input[t+1] – Input[t-1]
-> the difference between consecutive pixels is not calculated so that the output is not directional.
The first order differential represents the Speed.
Second Order Differential:
Output[t] = Input[t-1] + Input[t+1] – 2 x Input[t]
->Second order differential is also known as the "Laplacian" and represents the Acceleration. It
enhances the fine details in the image (including noise). The smoothing kernel helps reduce this
noise.

Parameter

Parameter

Description

Derivative

Here you can select whether to calculate the first (speed) or second
(acceleration) order differential.

Smoothing

Indicates the iterative, binominal smoothing filter. This reduces noise
in the differential images, whilst retaining maximums and minimums.
Value range: 0 – 50

Normalization

Defines what to do with negative values resulting from the calculation.
§ Clip: negative values are set to 0.
§ Absolute: negative values are used positively.
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9.12.9.6 Time Stitching
This function stitches heterogeneous CZI images together to create a new, single homogeneous
time series containing all dimensions and time points in their proper order. This differs from the
Time Concatenate function, which simply pastes one time lapse series to the end of another
without regard for the proper time order or channel content.
Missing images can either be filled with copies of the previous valid image in the series or filled
with black images.
When combining Z-stack time series with non-Z-stack time series a choice can be made between
either using only the center plane of the Z-stack or creating an extended focus projection of the Zstack before stitching the images together.
Parameter

Parameter

Description

Fill Missing with

-

Previous

Fills a missing dimension index with a copy of the last existing image
from that index.

-

Black

Fills a missing dimension index with a black image.

Z-Stacks

-

Collapse (EDF)

Reduces a z-stack with an extended focus function to a single plane
image which is then added to the output.

-

Collapse (Center
Plane)

Only uses the center plane from a z-stack for the output image.

-

Expand

Copies the z-stack to the output unchanged, fills the missing indices
according to the setting in the Fill Missing with dropdown list.

9.12.10 Arithmetics
9.12.10.1 Add
This function adds the two images Input1 and Input2 pixel by pixel and generates the Output
image. Note that a resulting gray value may be greater than the maximum gray value of the image.
Parameter

Parameter

Description

Normalization

Depending on the IP function you have selected not all choices are
available in the list.

-

Automatic

Automatic normalization of gray values to the available gray value
range.

-

Clip

Automatically sets the gray levels that exceed or fall below the specified gray value range to the lowest/highest gray value (black or
white). The effect corresponds to underexposure or overexposure.
This means that in some cases information is lost.
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Description

-

Shift

Normalizes the output to the value gray value + max. gray value/2.

-

Wrap

If the result is greater than the maximum gray value of the image, the
value maximum gray value +1 is subtracted from it.

9.12.10.2 Add Constant
This function adds the factor Addend to each pixel of the Input image and generates the Output
image.
To work useful with this function, the pixel values of the input image must be in float format. If
images of type 8 bit, 16 bit, 24 bit and 48 bit are used as input image, the output images are of
the same type, i.e. the output value will be clipped to an integer value. Negative values are set to
0, values higher than the maximum gray value are set to the maximum possible gray value of the
image.
Parameter

Parameter

Description

Addend

Here you adjust the addend.

9.12.10.3 Average
The function calculates the average of the two images Input1 and Input2 pixel by pixel and generates the Output image.
9.12.10.4 Combine
This function calculates the linear combination of two images on a pixel basis.
Both Input images are first multiplied by the specified factor and then added together. The
brightness of the Output image can then be adjusted. The combination of two images can be
used to reduce noise, for example. This is achieved by acquiring several images of the same scene
and subsequently combining them.
Parameters

Parameter

Description

Factor 1

Weighting factor for input image 1.
Value range: -1,00 ... +1,00

Factor 2

Weighting factor for input image 2.
Value range: -1,00 ... +1,00

Offset

Offset between input images 1 and 2.
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9.12.10.5 Divide
This function divides the images Input1 by Input2 pixel by pixel and generates the Output image.
Parameter

Parameter

Description

Factor

Here you adjust the scaling factor by which the result of the division is
multiplied. Using this factor it is possible to keep the gray values of
the output image within the range of 0 to the maximum gray value.
Values that are greater than the maximum gray value are in any case
limited to the maximum gray value. Negative values are set to 0.
Value range: -20.000 ... +20.000

9.12.10.6 Exponential
This function calculates the exponential function of the Input image pixel by pixel and generates
the Output image.
To work useful with this function, the pixel values of the input image must be in float format. If
images of type 8 bit, 16 bit, 24 bit and 48 bit are used as input image, the output images are of
the same type, i.e. the output value will be clipped to an integer value. Negative values are set to
0, values higher than the maximum gray value are set to the maximum possible gray value of the
image.
9.12.10.7 Invert
This function additively inverts the gray values of the input image into the output image. Bright
pixels will become darker and vice versa. To adjust the output range the parameter Operand is
used. The actual mathematical operation is then: output-gray value = constant - input-gray value.
Negative results are clipped to 0 and overflow results are clipped to the maximum possible gray
value.
9.12.10.8 Logarithm
This function calculates the logarithm of the Input image pixel by pixel and generates the Output
image.
To work useful with this function, the pixel values of the input image must be in float format. If
images of type 8 bit, 16 bit, 24 bit and 48 bit are used as input image, the output images are of
the same type, i.e. the output value will be clipped to an integer value. Negative values are set to
0, values higher than the maximum gray value are set to the maximum possible gray value of the
image.
9.12.10.9 Maximum
The function calculates the minimum values of the two images Input1 and Input2 pixel by pixel.
9.12.10.10 Minimum
The function calculates the maximum value of the two images Input1 and Input2 pixel by pixel.
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9.12.10.11 Multiply
This function multiplies the two images Input1 and Input2 pixel by pixel and generates the Output image.
Parameter

Parameter

Description

Factor

Here you adjust the scaling factor by which the result of the multiplication is divided. Using this factor it is possible to keep the gray values
of the Output image within the range of 0 to the maximum gray
value. Values that are greater than the maximum gray value are in any
case limited to the maximum gray value. Negative values are set to 0.
Value range: -20,000 ... +20,000

9.12.10.12 Multiply Constant
This function multiplies each pixel of the Input image with a adjustable Factor and generates the
Output image.
To work useful with this function, the pixel values of the input image must be in float format. If
images of type 8 bit, 16 bit, 24 bit and 48 bit are used as input image, the output images are of
the same type, i.e. the output value will be clipped to an integer value. Negative values are set to
0, values higher than the maximum gray value are set to the maximum possible gray value of the
image.
Parameter

Parameter

Description

Factor

Here you adjust the factor to be multiplied.

9.12.10.13 Reciprocal
This function computes the reciprocals of the gray values in the input image into the output image. Bright pixels will become darker and vice versa. To adjust the output range the parameter
"factor" is used. The actual mathematical operation is then: output-gray value = factor / inputgray value. Negative results are clipped to 0 and overflow results are clipped to the maximum possible gray value.
9.12.10.14 Square
This function calculates the square of the Input image pixel by pixel and generates the Output
image.
To work useful with this function, the pixel values of the input image must be in float format. If
images of type 8 bit, 16 bit, 24 bit and 48 bit are used as input image, the output images are of
the same type, i.e. the output value will be clipped to an integer value. Negative values are set to
0, values higher than the maximum gray value are set to the maximum possible gray value of the
image.
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9.12.10.15 Square Root
This function calculates the square root of the Input image pixel by pixel and generates the Output image.
To work useful with this function, the pixel values of the input image must be in float format. If
images of type 8 bit, 16 bit, 24 bit and 48 bit are used as input image, the output images are of
the same type, i.e. the output value will be clipped to an integer value. Negative values are set to
0, values higher than the maximum gray value are set to the maximum possible gray value of the
image.
9.12.10.16 Subtract
This function subtracts the two images Input1 and Input2 pixel by pixel and generates the Output image. Note that a resulting gray value may be less than 0.
Parameter

Parameter

Description

Normalization

Depending on the IP function you have selected not all choices are
available in the list.

-

Automatic

Automatic normalization of gray values to the available gray value
range.

-

Clip

Automatically sets the gray levels that exceed or fall below the specified gray value range to the lowest/highest gray value (black or
white). The effect corresponds to underexposure or overexposure.
This means that in some cases information is lost.

-

Shift

Normalizes the output to the value gray value + max. gray value/2.

-

Wrap

If the result is greater than the maximum gray value of the image, the
value maximum gray value +1 is subtracted from it.

9.12.11 Segmentation
9.12.11.1 Canny
Canny detects edges in an image. This function detects relatively thick contours at the edge of
bright regions.
Parameter

Parameter

Description

Sigma

Degree of smoothing of input image before detection of edges. A
Gauss filter is used as a smoothing function. The smoothing factor
can be used to influence the sensitivity of recognition. If a low value is
set, lots of edges are detected. Fewer edges are detected with a high
value. If the value 0 is set, no smoothing is performed.
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Parameter

Description

Threshold

Steepness of the edges to be detected. Low values mean "flat" edges
with a wide transition area between two regions. In this case lots of
edges are detected. If high values are used, fewer edges are detected,
as only steep transition areas are interpreted as edges.

9.12.11.2 Marr
This mehtod detects edges or regions in an image. In contrast to Valleys and Canny, here a
Laplace filter is calculated, followed by smoothing using a Gauss filter, and the edges (Display
Mode | Edges) or regions (Display Mode | Regions) are detected.
Parameter

Parameter

Description

Sigma

Degree of smoothing of input image before detection of edges or regions. A Gauss filter is used as a smoothing function. The smoothing
factor can be used to influence the sensitivity of recognition. If a low
value is set, lots of edges are detected. Fewer edges are detected with
a high value. If the value 0 is set, no smoothing is performed.

Display Mode

-

Edges

Region edges are detected.

-

Regions

The regions, not just their edges, are detected.

9.12.11.3 Threshold
This function performs a segmentation based on the definition of a brightness range (separated
according to color channels (red, green, blue)) for the regions to be segmented. All pixels whose
color values lie within the defined color range are marked as region pixels in the resulting image.
All the pixels whose color values lie outside the defined color range are marked as background
pixels (black).
In the resulting image, the color values of the region pixels can either be set permanently to white
or adopted unchanged. If you set the region pixels permanently to white, the result is a binary image, which can then be used as a mask image for a subsequent automatic measurement.
Parameters

Parameter

Description

Level Low

Determines the lower brightness threshold for the regions to be segmented. All the pixels whose gray values lie below this threshold value
are marked as background pixels (black).

Level High

Determines the upper brightness threshold for the regions to be segmented. All the pixels whose gray values lie above this threshold value
are marked as background pixels (black).

The following parameters are only visible if the Show All mode is activated:
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Parameter

Description

Create binary

Activated: The resulting image is a binary image. Pixels within the
calculated gray level range are set to the maximum gray value (white),
whilst pixels outside it are set to the gray value 0.
Deactivated: The resulting image is of the same type as the input image. Pixels within the calculated gray level range are set to the original gray value. Pixels outside it are set to 0.

Invert result

Activated: Inverts the effect of the function. The segmented regions
will be given the value 0, and all other pixels the gray value white or
the gray value/color of the input image.

9.12.11.4 Threshold (auto)
This method performs an automatic gray value segmentation. The function calculates the two
minimums in the individual channels in the gray value histogram of the input image (Input) and
uses these for the segmentation.
The following parameters are only visible if the Show All mode is activated:

Parameter

Description

Method

-

Otsu

For all possible threshold values, the Otsu method calculates the variance of intiensities on each side of the respective threshold. It minimizes the sum of the variances for the background and the foreground.

-

Maximum Peak

Separates background and foreground pixels at the maximum value
of the histogram.

-

Iso Data

The threshold value lies in the middle between two maximums in the
histogram.

-

Triangle Threshold

The threshold value is calculated from the sum of the average and
three times the sigma value of the histogram distribution.

-

Three Sigma
Threshold

Parameters

Parameter

Description

Create binary

Activated: The resulting image is a binary image. Pixels within the
calculated gray level range are set to the maximum gray value (white),
whilst pixels outside it are set to the gray value 0.
Deactivated: The resulting image is of the same type as the input image. Pixels within the calculated gray level range are set to the original gray value. Pixels outside it are set to 0.

Invert result

Activated: Inverts the effect of the function. The segmented regions
will be given the value 0, and all other pixels the gray value white or
the gray value/color of the input image.
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9.12.11.5 Threshold (dynamic)
This method performs an adaptive gray value segmentation. This procedure is particularly well
suited to the segmentation of small structures against a varying background.
The function initially applies a low pass filter and then subtracts this low-pass-filtered image from
the input image. The effect of this function mainly depends on the size of the filter matrix: Select
a low value for Size to segment small regions or regions with low gray value contrast from the
background. Select a higher value for Size to segment larger regions from the background.
Parameters

Parameter

Description

Kernel Size

Matrix size of the low pass filter in x- and y-direction symmetrically
around the pixel in question. Determines the extent of the smoothing
effect. As the affected pixel is at the center, the edge length of the filter matrix is always an odd number. If an even number is entered via
the keyboard, the value is always set to the next highest odd number.

Threshold

This value defines the gray value difference between the regions to be
detected and the background. Segmented pixels are set to the maximum gray value (white), whilst other pixels are set to the gray value 0.

The following parameters are only visible if the Show All mode is activated:

Parameter

Description

Create binary

Activated: The resulting image is a binary image. Pixels within the
calculated gray level range are set to the maximum gray value (white),
whilst pixels outside it are set to the gray value 0.
Deactivated: The resulting image is of the same type as the input image. Pixels within the calculated gray level range are set to the original gray value. Pixels outside it are set to 0.

Invert result

Activated: Inverts the effect of the function. The segmented regions
will be given the value 0, and all other pixels the gray value white or
the gray value/color of the input image.

9.12.11.6 Valleys
This method detects dark lines (gray value valleys) on a bright background and contours between
bright regions.
Parameter

Parameter

Description

Sigma

Degree of smoothing of input image before detection of valleys. The
smoothing factor can be used to influence the sensitivity of recognition. If a low value is set, lots of valleys are detected. Fewer valleys are
detected with a high value.

Threshold

Curvature at the valley bottom high/low. Depending on the setting
made, weakly pronounced valleys are also detected, or only ones that
are strongly pronounced.
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9.12.12 Binary
9.12.12.1 And
This method performs a bit-by-bit AND calculation for the input images (Input1 and Input2). This
function is particularly useful for the masking of images. All the pixels that are white in input image 1 AND input image 2 are set to white in the resulting image. Pixels that are white in only one
of the two input images become black.
9.12.12.2 Apply Mask
This tool enables you to isolate features in an image and to suppress image areas not of interest
using a mask image.

Parameter

Description

Input

The input image from which you wish to isolate features or suppress
areas not of interest

Mask

The mask image that is applied to the input image
The mask is laid on top of the input image. Image regions of the input
image in1 where the mask is white remain unchanged, image regions
where the mask is black are blacked out and suppressed.
Both images are aligned at the upper left corner. If the mask image is
smaller than the input image in1, the mask is applied only to part of
the input image, beginning at the upper left corner. The rest of the input image remains unchanged.

9.12.12.3 Distance
This method creates a distance-transformed image (distance map, distance image) from a binary
image. The Euclidean distance to the next background pixel (gray value 0) is calculated for each
pixel within the white regions of the binary image (input image), and coded as a gray value. Bright
pixels (high gray values) indicate a long distance to the background.
9.12.12.4 Exoskeleton
This method generates an image with the skeleton of the influence zone of regions. The background in the Input image is analyzed, and the skeleton of the influence zones of the objects is
determined. This is then saved as a binary image in the Output image.
9.12.12.5 Fill Holes
This method fills holes in regions. Holes are structures that have the gray scale value 0, and is
completely surrounded by pixels with a gray value equal to 0. Of regions outside of the image, it
is assumed that they are black. Black areas that touch the edge of the image are preserved, therefore, even if they are surrounded by a contour.
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9.12.12.6 Label Image
Assigns a gray value to each object in a binary image.
Parameters

Parameter

Description

Label Background

Activated: Assigns gray values to the background objects with connectivity 4.
Deactivated: Assigns gray values to the background objects with
Connectivity 8.

9.12.12.7 Mark Regions
This function marks binary regions of the input image. For each region in the input image, a check
is performed to establish whether a pixel has been set in the marker image.
Parameters

Parameter

Description

Select Marked

Activated: Copies the marked region into the output image.
Deactivated: Copies the unmarked region into the output image.

9.12.12.8 Not
This function performs a binary "not" operation on all bits of the binary representation of an input
pixel's gray value. A 0-bit in the input pixel results in an 1-bit in the corresponding output pixel an
1-bit in the input gets a 0-bit in the output. For integral image types the resulting output gray
value is the difference of the maximum possible gray value minus the input gray value, but for
float image type the results are strange due to the inhomogeneous float format.
9.12.12.9 Or
This method performs a bit-by-bit OR calculation for the Input1 and Input2 images. This function
can be used to combine binary masks or regions. All the pixels that are white in input image 1 OR
input image 2 are set to white in the resulting image. This means that all the white pixels in the
two input images are white in the resulting image.
9.12.12.10 Scrap
This method removes regions within a certain area.
Parameters

Parameter

Description

Minimum Area

Here you adjust the minimum area in Px.

Maximum Area

Here you adjust the maximum area in Px.

Select in Range
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9.12.12.11 Separation
Using this function you can attempt to separate objects that are touching (and that you have
been unable to separate using segmentation) automatically.
Parameters

Parameter

Description

Separation Mode

-

Morphology

This method separates objects by first reducing and then enlarging
them, making sure that once objects have been separated they do not
merge together again.

-

Watersheds

With this method you can separate objects that are roughly the same
shape. This method may however result in the splitting of elongated
objects.

Count

Enter how often the method is applied successively to the result at the
location of the separation, using the slider or input field.

9.12.12.12 Thinning
This method thins objects to a line of single pixel thickness.
Parameters

Parameter

Description

Thinning Element

Select the desired thinning method here.

-

Arcelli

Applies thinning in accordance with the Arcelli method.

-

Levialdi

Applies thinning in accordance with the Levialdi method.

Count

Sets the number of repetitions.
This means that the function is applied a number of times in succession to the filtering result. This increases the effect accordingly. The
value range is from 1...256.

Prune

Cuts off the ends of the thinned lines.

Converge

If activated, the function is automatically repeated until all regions will
be deleted by the next erosion step.

AxioVision Compatibility

Performs the function exactly like in AxioVision to achieve identical results.

9.12.12.13 Ultimate Erode
This function works in the same way as normal erosion. Structures in the input image are reduced. Thin connections between regions are separated. The difference between this function
and normal erosion is that structures are eroded until they would be deleted by the next erosion
step. With erosion, the pixel in question is set to the gray value 0 (black) in the resulting image.
For regions (pixels) at the image edge, the assumption is that the pixels outside the image are
white.
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Parameters

Parameter

Description

Structure Element

Here you select the preferred direction of morphological change (e.g.
Cross, Diagonal).

Count

Here you set the number of repetitions. This means that the function
is applied a number of times in succession to the filtering result. This
increases the effect accordingly.

Converge

If activated, the function is automatically repeated until all regions will
be deleted by the next erosion step.

9.12.12.14 Xor
This method performs a bit-by-bit Xor calculation for the Input1 and Input2 images. This function can be used to combine binary masks or regions. All the pixels that are white in input image
1 or input image 2 are set to white in the resulting image. Pixels that are white in both input images are set to black.

9.12.13 Utilities
9.12.13.1 Add Channels
This method allows you to combine two input images that have different channels but otherwise
have the same dimension (Z-stack, time series, tile, scene). An image is produced that contains all
the channels of the input images.
If the two input images differ from one another in the dimensions Z-stack, time series, tiles or
scene, input image 1 and input image 2 are copied into the output image as two separate blocks.
9.12.13.2 Airyscan Processing
With this function you can access the superresolution data in images acquired with Airyscan.

Info
Please note that starting with ZEN 2.5 blue edition, the black border of the processed image is
automatically removed. Hence the resulting image will be smaller by 24 pixels in X and Y dimension.
Parameters

Parameter

Description

3D Processing

This option is only available for images with 5 or more z-positions.
If activated, this option improves the resolution in axial and lateral direction. The data set needs to have at least 5 z-sections acquired with
an optimal step size. 3D Processing is slower than 2D Processing. For
3D Processing, the whole z-stack (single channel and time point)
needs to fit into the physical memory.
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Parameter

Description

2D SR Processing

This function is available for 2D images only. It enhances the 2D resolution.
Note this only results in increased superresolution when images are
acquired with optimal settings and sufficient signal.

Auto Filter

If activated, a suitable Super Resolution parameter for the Airyscan
processing is automatically determined for the selected data set.
To manually adjust the Super Resolution parameter, deactivate the
checkbox. Then determine suitable values by using the corresponding
function in the Airyscan viewer in the Airyscan view. Note that the
preview is only suitable for 2D Airyscan processing. A preview for 3D
Airyscan processing is not available. For adjusting 3D processing parameters, you should first process your data set once using the Auto
Filter and then check the value that was actually applied by the
Airyscan processing function. This value is stored in the metadata of
the processed image and can be accessed using the Info view.
Note: High strength might look attractive at some images, Z planes
or color channels, but other filtering artefacts might occur which appear like small rings in the image. Also the results will become very
sharp, but grainy. So carefully check your image data in order to avoid
such artefacts.

Adjust per Channel

Only visible, when the Auto Filter is deactivated.
Only available for images with two or more Airyscan channels.
If activated, you can manually set channel-specific Airyscan processing
parameters.

Strength

Use this option for an increased (high) or decreased (low) strength of
the automatically assigned filter value. This is especially useful for 3D
processing, as the 2D preview of the processing filter value in the
Airyscan viewer does not allow to conclude the result after a 3D data
processing.
The increment of this parameter is ± 0.4 compared to the standard
auto Airyscan processing. This setting is not available when manual
processing strength is selected.

9.12.13.3 ApoTome deconvolution
This method accepts ApoTome raw data only.
It was derived from the Deconvolution modul and is available in every licensed version of the
software. It contains settings and parameters which make sense for an Apotome deconvolution
only.
Parameter
Find the description of the parameters under: Deconvolution (adjustable) parameters . This
method is available for batch processing as well.
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9.12.13.4 ApoTome RAW Convert
This method accepts ApoTome raw data only. The settings are similar to the ones on the ApoTome tab (view option for ApoTome images). The function is also available for batch processing,
which makes it easy to convert a series of ApoTome RAW data images into deconvolved images.

Parameter

Description

Display Mode

ApoTome images are acquired as raw data. The Display Mode sets
how the image is calculated and displayed.

–

Optical sectioning

The displayed output image is calculated/rendered by eliminating the
excitation and emission light that originates in regions outside of the
focal plane.

–

Conventional
fluorescence

The displayed output image is calculated/rendered like a conventional
fluorescence image.

–

Raw data

Displays the raw data as output image and disables all other parameters of the function.

Correction

Applies stripe artifact correction to the resulting image. It attempts to
remove stripe artifacts which may be caused by bleaching of the
sample during acquisition or by slight deviations in the grid phase position.

–

No correction

No correction is applied to the image.

–

Local Bleaching

Corrects the bleaching for each pixel individually (default setting). This
is usually the best method.

–

Global Bleaching

Corrects bleaching by means of global bleaching correction, which is
applied equally to the entire image.

–

Phase Errors

Corrects phase errors in the image without additional bleaching correction.

–

Phase Errors
and Global
Bleaching

Corrects phase errors in the image with additional global bleaching.

–

Phase Errors
and Local
Bleaching

Corrects phase errors in the image with additional local bleaching.

Fourier Filter

The Fourier filter attempts to remove residual stripes.

–

Off

Uses no Fourier filter to remove stripes.

–

Weak

Uses a weak Fourier filter to remove stripes.

–

Medium

Uses a medium Fourier filter to remove stripes.

–

Strong

Uses a strong Fourier filter to remove stripes.

Normalization

Here you can select how the gray/color values that exceed or fall
short of the value range should be dealt with. If you use this method
with Direct Processing, only the Clip method is available and preselected.
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Description

–

Clip

Automatically sets the gray levels that exceed or fall short of the predefined gray value range to the lowest or highest gray value (black or
white). The effect corresponds to underexposure or overexposure. In
certain circumstances some information may therefore be lost.

–

Automatic

Normalizes the gray values automatically to the available gray value
range.

See also
2 Using Direct Processing [} 346]
2 ApoTome tab [} 905]
9.12.13.5 Attach PSF (Point Spread Function)
This method is only available for batch processing.
This method attaches a previously created PSF to the image file.

Parameter

Description

Channel

Selects the channel where the PSF should be attached.

PSF File

Selects the PSF-file created by the image processing function Create PSF.

9.12.13.6 Calculate Histogram
This method calculates a histogram distribution for selected measurement parameters of a measurement data table.
Parameters

Parameter

Description

Columns

Define the measurement parameters for classification by entering the
column numbers freely, e.g. 1,3,5, or 1-6 or 1,3-7,8.
Clicking on the
button to open the Select columns dialog. Here
the column names of the data can be activated or deactivated by
clicking on the relevant checkbox.

Class Boundaries

Select here, how you want the class boundaries of the calculated histogram to be determined.

-

>=,…,<

A numerical value falls into the histogram class if it is greater than or
equal to the lower class boundary and less than the upper class
boundary.

-

>,…,=<

A numerical value falls into the histogram class if it is greater than the
lower class boundary and less than or equal to the upper class boundary.

Automatic Classification

Activated: The class boundaries are calculated automatically from the
data. The value range from the lowest to the highest data value is divided into as many classes of equal width as you have set in the Class
Number input field.
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Description
Example:
Minimum value is 0
Maximum value is 10000
Range is 10000 units
Class Count is 4
Then the class boundaries are as follows:
Class 1: 0 .. 2500
Class 2: 2501 .. 5000
Class 3 : 5001 .. 7500
Class 4: 7501 .. 10000

Logarithmic

Only active, if the Automatic Classification checkbox is activated.
Activated: The class boundaries are scaled logarithmic.
Example:
Minimum value is 0
Maximum value is 10000
Range is 10000 units
Number of classes is 4
Then the class boundaries are as follows:
Class 1: 0 .. 10
Class 2: 11 .. 100
Class 3: 101 .. 1000
Class 4: 1001 .. 10000

Class Count

Specifies the number of classes that shall be created.

Display Mode

Select here, how you want the values of the histogram to be calculated.

-

Count

The histogram indicates how many data sets fall into the relevant
class, it contains the frequency of the values in the class concerned.

-

Count Cumulative

The histogram cumulates the counts of values in each class. Class 1
contains the number of values for class 1, class 2 contains the sum of
the values from class 1 and class 2, class 3 contains the sum of the
values from class 2 and class 3, etc.

-

Percentage

The histogram indicates what percentage of the data sets fall into the
relevant class, it therefore contains the percentage share of the values
in the class concerned.

-

Percentage Cumulative

The histogram cumulates the percentage of the count of values in
each class. Class 1 contains the percentage for class 1, class 2 contains the sum of the percentages from class 1 and class 2, class 3 contains the sum of the percentages from class 2 and class 3, etc.
The last class therefore contains 100%.

-

Sum

The histogram contains the sum of the numerical values of the data
sets that fall into the relevant class, the values of the data sets that fall
into the class concerned are therefore added together.
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Description

-

Sum Cumulative

The histogram cumulates the sums of the values in each class. Class 1
contains the sum of the numerical values from class 1, class 2 contains the sum of the numerical values from class 1 and class 2, class 3
contains the sum of the numerical values from class 2 and class 3, etc.
The last class therefore contains the sum of all individual values.

-

Percentage Sum

The histogram indicates the percentage share of the total numerical
values in the relevant class.

-

Percentage Sum
Cumulative

The histogram cumulates the percentage of the sums of values of all
data points which belong to the class. Class 1 contains the percentage
of the total numerical values from class 1, class 2 contains the sum of
the percentages of the total numerical values from class 1 and class 2,
class 3 contains the sum of the percentages of the total numerical values from class 2 and class 3, etc.
The last class therefore contains 100%.

9.12.13.7 Change Pixel Type
This method allows you to change the pixel type of an image. This can be useful if you want to
compare or combine images that have different pixel types.
Parameters

Parameter

Description

Pixel Format

Select the desired pixel format from the dropdown list.

-

8 Bit B/W

The output image is a monochrome image, the whole-number gray
values of which can lie in the range from 0 to 255.

-

16 Bit B/W

The output image is a monochrome image, the whole-number gray
values of which can lie in the range from 0 to 65535.

-

32 Bit B/W Float

The output image is a monochrome image with real numbers as pixel
values.

-

2x32 Bit Complex

The output image is a monochrome image with complex numbers
(real part and imaginary part) as pixel values. Such images are generally created by means of transformation into the Fourier space.

-

24 Bit RGB

The output image is a color image, the whole-number color values of
which in the red, green and blue channels can lie in the range from 0
to 255.

-

48 Bit RGB

The output image is a color image, the whole-number color values of
which in the red, green and blue channels can lie in the range from 0
to 65535.

-

2x32 Bit RGB
Float

The output image is a color image with real numbers as color values
in the red, green and blue channels.

-

3x64 Bit RGB
Complex

The output image is a color image with complex numbers (real part
and imaginary part) in the red, green and blue channels. Such images
are generally created by means of transformation into the Fourier
space.
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9.12.13.8 Combine HLS
With this method a HLS image can be generated of the single color extractions H, L, S.
9.12.13.9 Combine RGB
With this method a color image can be generated out of three input images of the single color extractions Red, Green and Blue.
Parameters

Parameter

Description

Output Pixel type

Here you choose the desired output image format, e.g. 24 Bit RGB.

9.12.13.10 Convert To Lambda
With this function you can convert Lambda stacks which were acquired with LSM 800 into a file
with the same appearance as inside the Lambda view. In contrast to the generic raw data format
of the Lambda stacks, these files can be opened and analyzed normally in ZEN (black edition).
9.12.13.11 Copy Annotations
This method copies the annotations of one image into another image.
9.12.13.12 Copy Image
This method creates a copy of an image.
9.12.13.13 Correct Stage Jitter
This method automatically corrects the jitter of the stage which can occur during the acquisition
of a Z-stack image.

9.12.13.14 Correlation
With this function you can, in conjunction with confocal data sets, display the spatial or temporal
correlation of an image or image stack. You can select which kind of correlation you want to perform by activating the corresponding checkboxes.
Parameters

Parameter

Description

Cross Correlation

If activated, you can to correlate two images with each other. Note
that the second input image needs to have the same dimensionality
and size.

X, Y

Correlates the signal in the X or Y direction.

Z

Correlates the signal in Z. Only available for data sets containing Zsections.
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Parameter

Description

Time

Correlates the signal in time. Only available for time series data sets.

9.12.13.15 Create Gray Scale Image
This method allows you to create a gray scale image.
Parameters

Parameter

Description

Pattern

Select the desired pattern for the gray scale image here.

-

Uniform

All pixels have an identical gray/color value.

-

2D Gray Scale
Vertical

The gray scale runs from top to bottom, starting with the gray value
selected in parameter Min. Gray Value.

-

2D Gray Scale
Horizontal

The gray scale runs from left to right, starting with the gray value selected in parameter Min. Gray Value.

Width

Set the desired width of the output image in pixels using the slider or
the input field.

Height

Set the desired height of the output image in pixels using the slider or
the input field.

Min. Gray Value

Set the minimum gray value of the gray scale using the slider or input
field.

Max. Gray Value

Set the maximum gray value of the gray scale using the slider or input
field.

Pixel Type

Select the desired pixel type here.

-

8 Bit B/W

The output image is a monochrome image whose integer gray values
can be in the range of 0 to 255.

-

16 Bit B/W

The output image is a monochrome image whose integer gray values
can be in the range of 0 to 65535.

-

24 Bit RGB

The output image is a color image whose integer color values in the
channels Red, Green, Blue can be in the range of 0 to 255.

-

48 Bit RGB

The output image is a color image, with integer color values in the
color channels Red, Green, Blue can be in the range of 0 to 65535.

9.12.13.16 Create Image Subset
This method allows you to extract parts from one image and use these to create a new image.
You can select these parts freely from the individual dimensions of the image.

Info
Each of the sections described below is only visible if the corresponding dimension is present in
the input image.
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Parameter

Description

Channels

Here you can select which channels of the input image you want to
be used. All channels are selected by default. To deselect a channel,
click on the respective channel button.

Z-Position, Time,
Block, Scene

Here you can select which parts of the input image you want to use
for the resulting image.

-

Extract All

If selected, all parts of the corresponding image are extracted.

-

Extract Single

If selected, you can select a single image to be extracted.

-

Extract Range

If selected, you can select a certain range of images to be extracted.

-

Extract Multiple

If selected, you can select several continuous ranges and individual
sections.
Enter one or more sections that you want to select in the input field.
To do this, enter the first section, followed by a minus sign, and then
the last section. If you want to define an interval, after the last section
enter a colon and then the interval. The entry "2-10:2" means that every second section is selected from section 2 to section 10.
Enter a comma after the first section if you want to define another
section. You can also select individual sections separated by commas.
By entering "2-10:2,14-18,20,23", you select every second section
from section 2 to section 10, followed by sections 14 to 18, as well as
sections 20 and 23.

-

Get current position

Adopts the position from the current display in the image area.

-

Interval

Activated: Interval mode is active. The Interval spin box/input field
appears.
Enter the desired interval here. E.g. if you enter the value 2 only every
2nd value from the range is considered.

Region

Here you can select if you want to use the entire image or just a region (ROI) of the input image.

-

Full

Select this option to use the full image for the new image.

-

Rectangle region (ROI)

Select this option to draw in a rectangle region of interest which will
be used for creating a new image.
If a rectangle region was drawn in you can see and change its coordinates by editing the X/Y/W/H input fields.

-

Keep tiles

Has only an effect, if a region (ROI) is defined.
Activated: Extracts the drawn in region including the complete tiles.
This setting is recommend when you want to apply DCV processing
functions on the resulting image.
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9.12.13.17 Create Image Subset and Split
This method allows you to extract certain dimensions, e.g. channels, regions or time series from
one image and use these to create a new image.

Info
Each of the dimensions described below is only visible if the corresponding dimension is
present in the input image.
Method Parameters

Parameter

Description

Split Dimension

Depends on the loaded image.

-

None

The image is not split by any dimension. Only the ranges of the different dimensions defined below will be extracted for the new image.

-

Channels (or:
Time, Scenes
etc.)

Here you can select the dimension for splitting the dataset. A new image document opens in ZEN for each element of the selected dimension. The available options depend on the selected image. If your input image contains two channels, split dimension creates two output
images, for each channel one.

Channels

Here you can select which channels of the input image you want to
be used. All channels are selected by default. To deselect a channel,
click on the respective channel button.

Time (or: Z-Position, Rotation,
Scene, Illumination, Acquisition
block, Mosaic tile,
Phase, View)

-

Extract All

Activated: All elements of the corresponding dimension are extracted.

-

Extract Single

Activated: You can select a single element to be extracted.

-

Extract Range

Activated: You can select a certain range of elements to be extracted.

-

Extract Multiple

Activated: You can select several continuous ranges and individual
sections.
Enter one or more sections that you want to select in the input field.
To do this, enter the first section, followed by a minus sign, and then
the last section. If you want to define an interval, after the last section
enter a colon and then the interval. The entry "2-10:2" means that every second section is selected from section 2 to section 10.
Enter a comma after the first section if you want to define another
section. You can also select individual sections separated by commas.
By entering "2-10:2,14-18,20,23", you select every second section
from section 2 to section10, followed by sections 14 to 18, as well as
sections 20 and 23.
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Description

Region

-

Full

Takes the full region into account.

-

Rectangle Region

Takes the rectangle into account that you can draw in the 2D view.
After drawing you can modify X, Y coordinates as well as width (W)
and height (H) manually.

Keep tiles

Has only an effect, if a region (ROI) is defined.
Activated: Extracts the drawn in region including the complete tiles.
This setting is recommend when you want to apply DCV processing
functions on the resulting image.
Deactivated: Drawn ROI will cut through mosaic tiles.

Propagate ROI

Has only an effect, if a region (ROI) is defined in multi-scene images.
Activated: Applies the defined region (ROI) to all scenes.

For more information, see Creating image subset and split dimensions [} 107]
9.12.13.18 Create Image Subset and Split (Write files)
This method allows you to extract certain dimensions, e.g. channels, regions or time series from
one image and use these extracted dimensions to create a new image. The result file is saved in
your target folder.

Info
Each of the dimensions described below is only visible if the corresponding dimension is
present in the input image.
Method Parameters

Parameter

Description

Split Dimension

Depends on the loaded image.

-

None

The image is not split by any dimension. Only the ranges of the different dimensions defined below will be extracted for the new image.

-

Channels (or:
Time, Scenes
etc.)

Here you can select the dimension for splitting the dataset. A new file
will be created in the target folder for each element of the selected dimension. The available options depend on the selected image. If your
input image contains two channels, split dimension creates two output images for each channel.

Channels

Here you can select which channels of the input image you want to
be used. All channels are selected by default. To deselect a channel,
click on the respective channel button.

Time (or: Z-Position, Rotation,
Scene, Illumination, Acquisition
block, Mosaic tile,
Phase, View)
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Description

-

Extract All

Activated: All elements of the corresponding dimension are extracted.

-

Extract Single

Activated: You can select a single element to be extracted.

-

Extract Range

Activated: You can select a certain range of elements to be extracted.

-

Extract Multiple

Activated: You can select several continuous ranges and individual
sections.
Enter one or more sections that you want to select in the input field.
To do this, enter the first section, followed by a minus sign, and then
the last section. If you want to define an interval, after the last section
enter a colon and then the interval. The entry "2-10:2" means that every second section is selected from section 2 to section 10.
Enter a comma after the first section if you want to define another
section. You can also select individual sections separated by commas.
By entering "2-10:2,14-18,20,23", you select every second section
from section 2 to section10, followed by sections 14 to 18, as well as
sections 20 and 23.

Region

-

Full

Takes the full region into account.

-

Rectangle Region

Takes the rectangle into account that you can draw in the 2D view.
After drawing you can modify X, Y coordinates as well as width (W)
and height (H) manually.

Keep tiles

Has only an effect, if a region (ROI) is defined.
Activated: Extracts the drawn in region including the complete tiles.
This setting is recommend when you want to apply DCV processing
functions on the resulting image.
Deactivated: Drawn ROI will cut through mosaic tiles.

Propagate ROI

Has only an effect, if a region (ROI) is defined in multi-scene images.
Activated: Applies the defined region (ROI) to all scenes.

Target Folder

Selects the folder on the disk where the images are to be saved.

Overwrite existing
files

Overwrites image files.

Compression

-

Original

The output image has the same compression as the original image.

-

Compression

JPEG XR compession is applied to the output images.

Defaults

Sets the values back to default, if they have been changed.

For more information, see Creating image subset and split dimensions [} 107]
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9.12.13.19 Create PSF
For creating experimental point spread functions from a Z-stack of subresolution fluorescent
beads please use the function PSF Wizard which is available together with the Deconvolution
module and offers a guided procedure starting with a stack of many beads and includes the Create PSF functionality.
Prerequisite for the Create PSF function here is, that bead averaging has already been done. It is
available only for legacy reasons.
This function creates a PSF (Point Spread Function) image from a Z-stack image of a bead acquired for PSF measurement. Please observe the instructions for optimal acquisition here: Using
beads for PSF measurement.
The result is a so-called PSF image. For advanced settings and options, please use the specific control elements on the PSF Display [} 904] tab.
Parameters

Parameter

Description

Z-Stack Correction

Activated: Performs background correction of the Z-stack before the
processing.

Circular Average

Activated:Forces a PSF with lateral symmetry. This option should not
usually be activated as lateral asymmetries correspond better to the
real situation. Circular averaging is only recommended when a measured PSF is used with the Fast Iterative method.

Threshold Cropping

Activated: The PSF is restricted to gray value ranges up to 0.25% of
the brightest voxel present. If the value is reduced or the option is deactivated, the PSF may be larger. This increases the calculation time.
However, it is also possible to achieve slightly better results in this
case. This option is deactivated by default.

Threshold

Using this slider and input field you can set the percentage from
which the PSF is clipped if the Volume Clipping option has been selected.

Iterative Restoration

Activated: If Z-stack images of beads with diameters greater than the
microscope's resolution limit are used to generate the PSF, this option
must be selected. The bead diameter used can be entered using the
slider and input field.

9.12.13.20 Fuse Image Subset
This method allows you to insert an image subset back into the original image. Its contents are replaced by the contents of the image subset. Using this method you can process a previously created image subset using image processing functions and copy the result back into the original image.
Parameters

Parameter

Description

In Place
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Parameter

Description

Subset

Contains the description of how the input image was created as a
subset.

ZEISS

Shows which areas have been selected in generating the subset image for each dimension (channels, Z-stack, time series), as well as for
the defined image section.
Example:
The entry "Z (1-8: 2) | T (2-7)" means that the sub-image consists of
sections 1,3,5,7 at the intervals of 2 to 7 of the input image.
9.12.13.21 Generate Image Pyramid
This method allows you to calculate a resolution pyramid for an image. Using the resolution pyramid you can navigate extremely efficiently even in very large tile images and display individual regions in the image window.
Parameters

Option

Description

Background

This option will influence how the background of the image pyramid
will look like.

–

Auto

The region outside the scenes keeps the grey value of the image, i.e.
white for brightfield images and black for fluorescence images.

–

Black

The region outside the scenes will be displayed black.

–

White

The region outside the scenes will be displayed white.

9.12.13.22 Image Calculator
This method allows you to apply arithmetic operations to images in the form of a calculator.
You can process a single image or combine two images.
All operations are performed pixel by pixel.
Parameters

Parameter

Description

Channel Input 1

Here you can select whether you want to use an individual channel or
all channels of the first input image for the calculation.

Channel Input 2

Here you can select whether you want to use an individual channel or
all channels of the second input image for the calculation.

First Images

Activated: For the second input image uses only the first time points
of a time lapse image for the calculation. This allows you, for example, to normalize a time lapse image to the intensity values of the first
time points.
Enter the number of images that you want to be used for the calculation using the input field.
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Parameter

Description

Formula

Enter the calculation formula here using the keyboard and numeric
keypad. Use "S1" as a placeholder for the first input image and "S2"
for the second input image.

Input 1

Inserts the placeholder for the first input image into the Formula input field at the current cursor position.

Input 2

Inserts the placeholder for the second input image into the Formula
input field at the current cursor position.

Absolute Intensities

Activate this radio button if input image 1 and input image 2 have the
same pixel type.

Normalize Intensities 0..1

Activate this radio button if input image 1 and input image 2 have different pixel types. To allow such images to be combined, the intensity
values of the two images are normalized to the value range from 0 to
1 before the calculation.

Operators...

Opens a list of all available operators. Here you can select the operator that you want. If you double-click on a list entry, it is inserted into
the Formula input field at the current cursor position.

Delete

Deletes the contents of the Formula input field.

Undo

Undoes the last entry in the Formula input field.

9.12.13.23 Image Generator
This function creates a synthetic image where the dimensions can be defined.

Parameter

Description

Width

Width in x of the image

Height

Height in y of the image

Z Slices

Number of z slices of the image. If the value is > 1, it will become a Zstack image.

Channels

number of channels of the image, if value is > 1, it will become a
multi channel image

Time Slices

Number of time slices, if value is > 1, it will become a time series image.

Min. Gray Value

Minimum Gray Value for generation.

Max Gray Value

Maximum Gray Value for generation.

Pixel Type

Specifies the pixel type of the image.

Pattern

-

Uniform

all pixels of the image have identical Min. Gray Value

-

2D Gray Scale
Vertical

the image shows a gray scale with values between Min. Gray Value
and Max. Gray Value from top to bottom.

-

2D Gray Scale
Horizontal

the image shows a gray scale with values between Min. Gray Value
and Max. Gray Value from left to right.
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Description

-

Ramp

the image shows a ramp with values between Min. Gray Value and
Max. Gray Value starting from each corner of the image to the center.

-

Gaussian

the image shows a Gaussian shaped grayscale with values between
Min. Gray Value and Max. Gray Value starting from the borders of
the image to the center.

-

Checkerboard

the image shows a checkerboard where the “dark” fields have Min.
Gray Value and the “bright” fields have Max. Gray Value.

-

Cosine Checkerboard

the image shows a checkerboard where the “dark” fields have Min.
Gray Value and the “bright” fields have Max. Gray Value overlaid
with a cosine modulation.

-

Chirp Cosine

the image shows a cosine pattern where the “dark” fields have Min.
Gray Value and the “bright” fields have Max. Gray Value overlaid
with a chirp modulation.

-

Chirp Checker

the image shows a checkerboard where the “dark” fields have Min.
Gray Value and the “bright” fields have Max. Gray Value overlaid
with a chirp modulation.

-

Random
Spheres

a 3D (Z stack) image is created which contains Number of Spheres
spheres with Sphere Diameter diameter which are randomly distributed in the image.

-

Sphere Array

a 3D (Z stack) image is created which contains Number of Spheres
spheres with Sphere Diameter diameter which are equally distributed in the image.

-

Single Sphere

a 3D (Z stack) image is created which contains a single sphere with
Sphere Diameter diameter which is positioned in the center of the
image.

Sphere Diameter

Diameter of the created spheres.

Number of
Spheres

Number of spheres which are generated in the 3D image.

9.12.13.24 Impose Noise
This function imposes an image with a defined noise for testing purposes.

Parameter

Description

Signal to Noise Ratio

Adjusts the signal to noise ratio.
Range 0.10 - 100.00.

Distribution

-

Poisson

Imposes a Poisson distributed noise.

-

Gauss

Imposes a Gauss distributed noise.
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9.12.13.25 Linear Unmixing
With this function you can extract the emission of single fluorescence dyes (e.g. GFP only, YFP
only etc.) from strongly overlapping multi-fluorescence data acquired in multi-channel images or
Lambda stacks (only available in LSM imaging mode).
With the knowledge of the spectral characteristic of individual components within a multi-component sample, even heavily overlapping individual spectral characteristics can be mathematically extracted from an experimental multi-channel data set. This method is a strictly pixel-by-pixel image
analysis procedure. Experimentally, fluorescence spectra of mono-labeled samples are acquired
and stored in the Spectra Database as an external reference. Then a multi-channel image or
Lambda stack from the multi-labeled sample is acquired. The individual components are mathematically extracted using the information from the reference spectra. Up to ten different reference
signals can be used in the least-square-fit based algorithm to produce a 10-channel output image
without any partial overlap between the channels.
Avoid saturation of fluorescence signal in the data set to be unmixed. Saturation will generate a
high signal in the residual channel.
If mono-labeled samples are not available, the references can be obtained by the following methods:
§

Interactively by user-selection of regions in the image where only one fluorescence dye is
present (only available in the Unmixing view).

§

Automatically by software analyses of what the individual spectral signatures are. This processing function is called Automatic Component Extraction (ACE).

Note that in some cases, spectrally acquired images are not appropriate for ACE and linear unmixing can lead to wrong results.
Parameters

Parameter

Description

Components

Adjust the number of spectrally distinguishable fluorescent components within the imaged sample. The number of extractable components cannot be higher than the number of acquired channels. The
maximum possible value is 10 components.

Import Reference
Spectra

For the unmixing process previously generated emission spectra of
ideally pure dyes can be loaded and used for unmixing. This function
is mutually exclusive to the Automatic Component Extraction function.

Automatic Component Extraction

Use this function if no reference spectra are available. Indicate the
number of components the system should be looking for in the image. The number of components cannot be higher than the number
of channels. It will only work, if each of the emission signals is present
in an area of the image without overlap of another emission signal.
Otherwise ACE cannot produce a reliable result.

Weighted Unmixing

When this option is checked, spectral channels with high noise contribute less to the unmixing result. This option includes a statistical
analysis of the signal-related (Poisson-) noise and weighs the respective contribution for the fitting with the combination of reference
spectra to the experimental data.
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Description
Note: This option involves a more sophisticated unmixing algorithm
and therefore takes longer than the basic unmixing analysis.
Weighted unmixing generates improved unmixing results when acquisition channels are not so well balanced but still have a good signalto-noise ratio.

Autoscale

Balances the intensity of the unmixed channels to equal levels.

Calculate Residuals

Generates an additional channel in which the intensity values represent the difference between the acquired spectral data and the fitted
linear combination of the reference spectra. In essence, the residual
value is the biggest remaining "residual" from the least square fit routine. The residuals are a general measure for how good the fit of the
algorithm has performed. The higher the intensity in this additional
channel, the worse is the fit of the spectra to the data set.

9.12.13.26 Split into HLS
This method generates the individual color extractions for a HLS input image. The resulting images
for hue, lightness and saturation take the form of gray images.
9.12.13.27 Split into RGB
This method generates the individual color extractions for red, green and blue from the RGB input
image. The resulting images for red, green and blue take the form of gray images.
Parameters

Parameter

Description

Output Pixel type

Here you choose the desired output image format, e.g. 8 Bit B/W.

9.12.13.28 Split Multiblock Image
This method saves the single blocks/dimensions (Tiles or Positions) of a multiblock image (i.e. image of an inhomogeneous experiment) in a folder in .CZI format.
Parameter

Parameter

Description

Split Mode

Choose the mode how to split the multiblock image.

-

Homogeneous
groups

Splits the multiblock image into the single dimensions. The blocks will
remain.

-

Single blocks

Splits the multiblock image into single blocks.

Display field

The path of the destination folder is displayed automatically in the display field. To change the folder, click on the
of the display field.
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9.12.13.29 Split Scenes
This method separates scenes from a tiles or positions image. The individual images are displayed
in the Center Screen Area. Note that the images in this method, in contrast to the method Split
Scenes (write files), are not automatically stored in a folder.
9.12.13.30 Split Scenes (Write files)
This method saves the single scenes (tiles or positions) of a multiscene image (i.e. image of a multiwell plate) as single images in a folder in CZI format.
Parameter

Parameter

Description

Display field

The path of the destination folder is displayed automatically in the display field. To change the folder, click on the
of the display field.

button to the right

Include Scene Information in Generated File Name

Activated: Includes the scene information in the file name of the separate image.

Overwrite existing
files

Activated: All files in the target folder will be deleted, if the function
is applied again.

Compression

Choose the type of compression here, eg. Original (no compression)
or Compression (JPEG XR).

9.12.13.31 VivaTome RAW Convert

9.12.14 Export/Import
9.12.14.1 Movie Export
Using this function you can export multidimensional images (e.g. Time Series or Z-Stack images)
into various file types in the form of film sequences so that you can continue to use them in other
programs.

Info
If you want to export MOV files (H264 or MPEG4 codec) successfully, download the application FFmpeg Version 4.0.2, Windows 64-bit, Static (e.g. on http://www.ffmpeg.org/ or
https://ffmpeg.zeranoe.com/builds/). Copy ffmpeg.exe in to the same folder where ZEN.exe
is located (for example C:\Program Files\Carl Zeiss\ZEN 2\ZEN 2 (blue edition)).

See also
2 Exporting Movies [} 233]
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9.12.14.1.1 File Type section

Info
AVI (MS-Video1) mode is available for 32-bit Windows operating systems only.

Parameter

Description

Format

Select the desired mode here. The following formats are available for
the movie export.
§ AVI (M-JPEG compression)
§ AVI (uncompressed)
§ AVI (DV)
§ WMF (WindowsMedia)
§ MOV (H.264)
§ MOV (MPEG4)
§ AVI (MS-Video1)

Size/Rate

-

Original Size

Select the desired format here.
Not available for the file types AVI (DV) and AVI (MS-Video1).
Uses the height and width of the input image and sets the frame rate
to 5 frames per second.

-

User-Defined

Not available for the file types AVI (DV) and AVI (MS-Video1).
Enter the values in the Width, Height and Frame Rate input fields.

-

720x576/25fps
(PAL 576p/25)

Uses the PAL (Phase Alternating Line) video resolution with 25 frames
per second.

-

720x480/29.97f
ps (NTSC)

Uses the NTSC (National Television Systems Committee) video resolution with 29.97 frames per second.

-

1280x720/50fp
s (HD 720p/50)

Not available for the file types AVI (DV) and AVI (MS-Video1).

1920x1080/25f
ps (HD
1080p/25)

Not available for the file types AVI (DV) and AVI (MS-Video1).

1920x1080/29.
97fps (HD
1080p/29.97)

Not available for the file types AVI (DV) and AVI (MS-Video1).

-

-

Width

Uses the HD (High Definition 720) video resolution with 25 frames per
second.

Uses the HD (High Definition 1080) video resolution with 25 frames
per second.

Uses the HD (High Definition 1080) video resolution with 29.97
frames per second.
Only active if you have selected User-Defined in the Format dropdown list.
Here you can enter the width of the image in pixels (px).

Height

Only active if you have selected User-Defined in the Format dropdown list.
Here you can enter the height of the image in pixels (px).
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Parameter

Description

Frame Rate

Only active if you have selected User Defined in the Format dropdown list.
Here you can enter the frame rate in frames per second (fps).

Quality

Only visible if you have selected AVI (M-JPEG compression) or MOV
in the Mode dropdown list.
Here you can set the image quality using the slider or spin box/input
field. This influences the size of the file. Although low values result in
very small files, image quality may be considerably reduced.

9.12.14.1.2 Image Data section
The following functions are only visible if the Show All mode is activated:

Parameter

Description

Apply Display Settings and Channel
Color

–

Burn-in Graphics

Activated: Burns the graphic elements into the image. The pixels under the graphic element (e.g. scale bars) are overwritten. The burnt-in
graphic elements cannot be subsequently modified.

–

Zoom

Only available if Burn-in Graphics is activated.
Sets the zoom of graphic elements for export.
The default is 100%, which means that the graphical elements are
rendered as they would if the viewer zoom was 100%. When the
zoom increases, the graphical elements are rendered larger (e.g. with
zoom 200, graphical elements are rendered twice as large, but it corresponds to the size they would have if the viewer zoom was 50%).

–

–

–

Get Zoom
from Viewer

Only available if Burn-in Graphics is activated.

Merged Channels Image

Only visible for multichannel images.

Individual
Channels Image

Only visible for multichannel images.

Use channel names

Gets the current zoom factor of the graphical elements in the 2D
view.

Activated: Exports the pseudo color image of all selected channels.

Activated: Exports the individual colored image of all selected channels.
Only visible for multi-channel images.
Activated: Integrates the channel name in the name of the exported
image.

Use Full Set of Dimensions

Activated: Includes all dimensions of the original file.

Define Subset

Activated: Creates a subset of the data, depends on the dimensions
available in the image, e.g. Channels, Region, Tiles.
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At least one of the three checkboxes must be activated. If the Merged Channels Image and Individual Channel Image checkboxes are activated, you can export the individual colored images
and the pseudo color images in a single step.
9.12.14.1.3 Fitting section
The following functions are only visible if the Show All mode is activated:

Parameter

Description

Fitting

Select the desired type of fitting here.

-

Fit All (Uniform)

Fits the image to the selected resolution. The original aspect ratio is
retained.

-

Fit and Crop
(Uniform to Fill)

Fits the image to the selected resolution and clips it. The original aspect ratio is not retained.

-

Fit and Stretch
(Fill)

Stretches the image to the selected resolution. The original aspect ratio is not retained.

-

Crop (None)

Crops the image to the selected resolution. The original aspect ratio is
retained.

9.12.14.1.4 Sequence section
The following functions are only visible if the Show All mode is activated:
Change the sequence of the dimensions in which you want the movie to be created.
button
Shifts the selected dimension up a line.
button
Shifts the selected dimension down a line.
9.12.14.1.5 Mapping section

Parameter

Description

Mapping

Select how you want the images to be assigned.

-

Fixed Duration

Enter the time per image in seconds using the spin box/input field.
The total length is displayed in the Final Movie Length display field.

-

1 Frame per Image

Assigns one frame per image.

Image count

Indicates the number of images in the input image.

Final Movie Length

Indicates the total length of the resulting movie, depending on the selected image sequence and the time.
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9.12.14.1.6 Dimensions section
The following functions are only visible if the Show All mode is activated:

Parameter

Description

Use Full Set of Dimensions

Select this option if you want to export all dimensions without changing them.

Define Subset

Select this option if you only want to export individual dimensions or
subsets of individual dimensions.

Info
Each of the sections described below is only visible if the corresponding dimension is present in
the input image.

Parameter

Description

Channels

Here you can select which channels of the input image you want to
be used. All channels are selected by default. To deselect a channel,
click on the relevant channel button.

Z-Position, Time,
Block, Scene

Here you can select which parts of the input image you want to use
for the resulting image.

-

Extract All

If selected, all parts of the corresponding image are extracted.

-

Extract Single

If selected, you can select a single image to be extracted.

-

Extract Range

If selected, you can select a certain range of images to be extracted.

-

Extract Multiple

If selected, you can select several continuous ranges and individual
sections.
Enter one or more sections that you want to select in the input field.
To do this, enter the first section, followed by a minus sign, and then
the last section. If you want to define an interval, after the last section
enter a colon and then the interval. The entry "2-10:2" means that every second section is selected from section 2 to section 10.
Enter a comma after the first section if you want to define another
section. You can also select individual sections separated by commas.
By entering "2-10:2,14-18,20,23", you select every second section
from section 2 to section 10, followed by sections 14 to 18, as well as
sections 20 and 23.

-

Get current position

Adopts the position from the current display in the image area.

-

Interval

Activated: Interval mode is active. The Interval spin box/input field
appears.
Enter the desired interval here. E.g. if you enter the value 2 only every
2nd value from the range is considered.

Region

-

Full

Here you can select if you want to use the entire image or just a region (ROI) of the input image.
If selected this option, the full image is used for the new image.
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Parameter
-

Rectangle region (ROI)

ZEISS

Description
If selected this option, you can draw in a rectangle region of interest
which will be used for creating a new image.
If a rectangle region was drawn in you can see and change its coordinates by editing the X/Y/W/H input fields.

-

Keep tiles

Has only an effect, if a region (ROI) is defined.
Activated: Extracts the drawn in region including the complete tiles.
This setting is recommend when you want to apply DCV processing
functions on the resulting image.

Tiles

-

Existing Tiles

Exports the tiles according to the original image.

-

Re-Tile

Creates new tiles according to your entries in the fields Colums/Rows
and Overlap.

-

Colums /Rows

Only active if Re-Tile is activated.
Defines, with how many rows and colums the re-tiling is performed.

-

Overlap

Only active if Re-Tile is activated.
Defines the overlap of the re-tiled tiles in %.

9.12.14.1.7 Export to section

Parameter

Description

Export to

The path of the export folder is displayed automatically in the display
field.
To change the file path, click on the
display field.

button to the right of the

Parameter

Description

Prefix

Here you can edit the prefix specified or enter a new name. The name
of the original image is specified by default.

9.12.14.2 OME TIFF Export
Using the OME TIFF Export function you can export your images into OME (Open Microscopy
Environment) TIFF format so that you can continue to use them in other programs. The images
are then available as a multipage TIFF file.
9.12.14.2.1 Image Format section

Parameter

Description

Resize

Adjust the image size in percent using the slider or spin box/input
field.
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Parameter

ZEISS

Description

The following parameters are only visible, if Show All is activated.
BigTIFF

Activated: Creates a BigTIFF image that can be bigger than 4 gigabytes and uses 64-bit offset format.

Compress

Activated: Performs internal tif compression.

Use Tiles

Activated: Performs an internal tiling.
Note that this option is recommend for large images as some tif readers do not support large images.

Shift Pixel

Activated: Shifts the grey value of a 10-bit or 12-bit image to 16-bit.

Merge All Scenes

Activated: Generates one image including all scenes. Single scene images will be generated, if the checkbox is deactivated.

9.12.14.2.2 Image Data section
The following functions are only visible if the Show All mode is activated:

Parameter

Description

Original Data

Activated: Exports the image with the original channel colors and the
original display characteristic curve.

Apply Display
Curve and Channel
Color

Activated: Exports the image with the changed channel color and
display characteristic curve settings. These settings are applied to the
pixel values of the exported images. They are particularly important if
you want to use dark images with a dynamic range of more than 8
bits in other programs.

Burn In Graphics

Activated: Burns the graphic elements into the image. The pixels under the graphic element (e.g. scale bars) are overwritten. The burnt-in
graphic elements cannot be subsequently modified.

9.12.14.2.3 Dimensions section
The following functions are only visible if the Show All mode is activated:

Parameter

Description

Use Full Set of Dimensions

Select this option if you want to export all dimensions without changing them.

Define Subset

Select this option if you only want to export individual dimensions or
subsets of individual dimensions.

Info
Each of the sections described below is only visible if the corresponding dimension is present in
the input image.
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Parameter

Description

Channels

Here you can select which channels of the input image you want to
be used. All channels are selected by default. To deselect a channel,
click on the relevant channel button.

Z-Position, Time,
Block, Scene

Here you can select which parts of the input image you want to use
for the resulting image.

-

Extract All

If selected, all parts of the corresponding image are extracted.

-

Extract Single

If selected, you can select a single image to be extracted.

-

Extract Range

If selected, you can select a certain range of images to be extracted.

-

Extract Multiple

If selected, you can select several continuous ranges and individual
sections.
Enter one or more sections that you want to select in the input field.
To do this, enter the first section, followed by a minus sign, and then
the last section. If you want to define an interval, after the last section
enter a colon and then the interval. The entry "2-10:2" means that every second section is selected from section 2 to section 10.
Enter a comma after the first section if you want to define another
section. You can also select individual sections separated by commas.
By entering "2-10:2,14-18,20,23", you select every second section
from section 2 to section 10, followed by sections 14 to 18, as well as
sections 20 and 23.

-

Get current position

Adopts the position from the current display in the image area.

-

Interval

Activated: Interval mode is active. The Interval spin box/input field
appears.
Enter the desired interval here. E.g. if you enter the value 2 only every
2nd value from the range is considered.

Region

Here you can select if you want to use the entire image or just a region (ROI) of the input image.

-

Full

If selected this option, the full image is used for the new image.

-

Rectangle region (ROI)

If selected this option, you can draw in a rectangle region of interest
which will be used for creating a new image.
If a rectangle region was drawn in you can see and change its coordinates by editing the X/Y/W/H input fields.

-

Keep tiles

Has only an effect, if a region (ROI) is defined.
Activated: Extracts the drawn in region including the complete tiles.
This setting is recommend when you want to apply DCV processing
functions on the resulting image.

Tiles

-

Existing Tiles

Exports the tiles according to the original image.

-

Re-Tile

Creates new tiles according to your entries in the fields Colums/Rows
and Overlap.
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Parameter
-

Colums /Rows
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Description
Only active if Re-Tile is activated.
Defines, with how many rows and colums the re-tiling is performed.

-

Overlap

Only active if Re-Tile is activated.
Defines the overlap of the re-tiled tiles in %.

9.12.14.2.4 Export to section

Parameter

Description

Export to

The path of the export folder is displayed automatically in the display
field.
To change the file path, click on the
display field.

button to the right of the

Parameter

Description

Prefix

Here you can edit the prefix specified or enter a new name. The name
of the original image is specified by default.

9.12.14.3 ZVI Export
Using the ZVI Export function you can export your images into ZVI format so that you can continue to use them in AxioVision.
9.12.14.3.1 Export to section

Parameter

Description

Export to

The path of the export folder is displayed automatically in the display
field.
To change the file path, click on the
display field.

button to the right of the

Parameter

Description

Prefix

Here you can edit the prefix specified or enter a new name. The name
of the original image is specified by default.
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9.12.14.4 Image Import
Using the Image Import function you can create a multidimensional image (multichannel, Zstack, time lapse, tile, position image) from individual images. The individual images may be in any
of the external formats supported by ZEN (see below). The resulting image can then be saved in
CZI format and processed further using the functions available in ZEN.
Supported file types
§

JPG images

§

BMP

§

TIFF

§

PNG

§

GIF

§

DeltaVision images

§

MetaFluor images

§

Multi page images

Parameters

Parameter

Description

Multichannel

Activated: Activates the settings to import multichannel images.
Adjust the settings for the multichannel image to be imported in the
list below.

-

Use Channel
Name as Identifier

Z-Stack

Activated: Uses the name specified in the Name column to identify
the channel. The channel name will appear in the Preview display
field in the Specify the Identifiers section.
Deactivated: Activates the Identifier, Start Index and Interval columns in the Specify the Identifiers section.
Activated: Activates the settings to import Z-Stack images.
Adjust the settings for the Z-stack image to be imported in the list below.

-

Interval

Here you enter the value in µm for the distance between the individual slices. The total height of the Z-stack is calculated automatically
from this value and the number of slices.

-

Slices

Here you enter the number of slices of the Z-Stack image.

-

Range

Here you enter the total height (range) of the Z-stack in µm.
The distance between the individual Z-stacks is calculated automatically from this value and the number of slices and displayed in the Interval display field.
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Parameter
-

Extended Microscope Parameters
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Description
Activates additional parameters that are necessary for further processing of the imported image (e.g. for deconvolution), like:
§ Magnification:
Select the objective magnification that was used for acquisition
here.
§ Aperture:
Here you can enter the value of the numerical aperture of the objective that was used for acquisition.
§ Immersion:
Select the immersion medium that was used for acquisition here.

Time Series

Activated: Activates the settings to import time series images.

-

Interval

Here you enter the value for the interval between the individual time
points. Select the unit of time from the dropdown list to the right of
the input field.

-

Cycles

Here you enter the cycles of the time series. The entered value will affect the duration/the interval depending on which value you have selected.

-

Duration

Here you can enter the value for the duration of the entire time series.
Select the unit of time from the dropdown list to the right of the input
field. Enter the number of time points in the Time Points input field.

Tiles

Activated: Activates the settings to import tile images.

-

Columns

Here you can enter the number of columns of the tile image.

-

Overlap

Here you can enter the percentage by which the tiles do overlap.

-

Rows

Here you can enter the number of rows of the tile image.

-

Meander

Select this option, if the images to be imported were acquired in the
Meander acquisition/travel mode.

-

Comb

Select this option if the images to be imported were acquired in the
Comb acquisition/travel mode.

Positions

Activated: Activates the settings to import images of individual positions.

Scalings

To show the section in full, click on the arrow button

-

Use Current
Scaling

Uses the geometric scaling currently selected and displays the values
for Scale (X) and Scale (Y) with the corresponding unit in the relevant display field.

-

Define scaling

Enter the desired values in the Scale (X) input field and in the Scale
(Y) spin box/input field. Select the unit for the scaling value from the
dropdown list to the right of each input field.
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Parameter

Description

Automatic

If selected, all images that are available in an import folder are imported automatically.

-

Import From

ZEISS

Here you can select the import folder.
To select a folder, click on the folder button
to the right of the
display field. The names of the images are displayed in the File Name
list below the display field.

Sequential

-

Import From

If selected, an image sequence in a certain order (e.g. image dimensions that are encoded by means of numbers in the image name) can
be imported.
Here you can import images according to a File List or a Multi page
image.
Click on the folder button
to the right of the display field. The
names of the images are displayed in the File Name list below the
display field.

Specifiy the Identifiers

Here you can enter and check all the settings you need to identify
your images.

9.12.14.5 Import TXM
This function imports a txm file to ZEN.

Parameter

Description

Input

Selects a txm file for import.

9.12.14.6 Convert TXM Files to CZI
This function converts txm images to czi.

Parameter

Directory

Description
Selects the folder with txm images that should be converted to czi.
After the conversion, the images will again be stored in this folder.

Recursive

Converts also files in subfolders of the selected folder.

Overwrite

Overwrites already converted files.

Preview Only

Displays a preview of the images in the folder, but does not convert
them.
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9.12.14.7 Image Export
Using this method you can export single images into various file types so that you can continue to
use them in other programs. Multidimensional images (multichannel, Z-stack, time lapse, tile images) are exported as individual images.

1

2

3

4

1

File Type Section
Here you define the settings for the file type, e.g. format or compression.
For more information, see File Type section [} 208].
Depending on the file type you selected for the image export, the settings of the other
parameters change.

2

Image Data Section
Here you define, how to deal with the image data during the export, e.g. whether you
want to burn graphics firmly in the picture. For more information, see Image Data section [} 209].

3

Dimensions Section
Here you specify, how to proceed with the dimensions, e.g. whether you want to export
all the dimensions of an image, or only certain. For more information, see Dimensions
section [} 210].

4

Export to Section
Here you define other export settings, e.g. the export folder. For more information, see
Export to section [} 212].
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9.12.14.7.1 File Type section

Name

Function

File Type

Select the desired file type from the dropdown list:
§ JPEG (JPEG File Interchange Format)
§ BMP (Windows Bitmap)
§ TIFF (Tagged Image File Format)
§ Big TIFF Tiff Format (64 bit)
§ PNG (Portable Network Graphics)
§ WDP (JPEG XR)
§ SUR (DigitalSurf SUR)
Note that various options are available depending on the file type you
have selected.

Quality

Only available for the file types JPEG and JPEG XR.
Enter the image quality using the slider or input field to influence the
size of the file. Although low values result in very small files, image
quality may be considerably reduced.

Resize

Adjust the image size in percent using the slider or input field.

Convert to 8 Bit

Only available for the file types TIFF, BigTIFF, PNG and JPEG XR.
Activated: Converts a 16 bit gray level image into an 8 bit gray level
image, or a 48 bit color image into a 24 bit color image.

Compression

Only available for the file type TIFF and BigTIFF.
Select the compression method for reducing the data volume here:

-

None

Retains the data volume of the original image. No compression is performed.

-

LZW

Only available for the file type TIFF.
Performs lossless compression in accordance with the Lempel-ZivWelch algorithm (LZW).

-

ZIP

Only available for the file type TIFF.
Performs lossless compression in accordance with the ZIP method.

-

Loss less

Only available for the file type BigTIFF.
Performs lossless compression in accordance with the Lempel-ZivWelch algorithm (LZW).

-

Lossy

Only available for the file type BigTIFF.
Performs lossy compression in accordance with the JPEG XR (extended range) method.

BigTIFF

Only available for the file type BigTIFF.
Activated: Generates a BigTIFF image. The maximum image size is
larger than 4GByte.
Deactivated: Generates a TIFF image with maximum size of 4GByte.

TIFF Tiles

Only available for the file type BigTIFF.
Activated: Generates new rectangle tiles for internal data handling.
Deactivated: Combines tiles as stripes for internal data handling.
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Name

Function

Pyramid

Only available for the file type BigTIFF.

ZEISS

Activated: Calculates an image pyramid.
Merge All Scenes

Only available for the file type BigTIFF.
Activated: Generates one image including all scenes. Single scene images will be generated, if the checkbox is deactivated.

9.12.14.7.2 Image Data section
The following functions are only visible if the Show All mode is activated:

Parameter

Description

Original Data

Activated: Exports the image with the original channel colors and the
original display characteristic curve.

Shift Pixel

Activated: The pixel are shifted to 16 bit before converting to 8 bit.
For example, a 14 bit image is first transformed to a 16 bit image
which is then converted to a 8 bit image. The 14 bit range is mapped
to the wohle 8 bit range.
Deactivated: No shift takes place. A 14 bit image is treated as a 16
bit image and therefore the transformation to 8 bit covers only a reduced range.

Apply Display
Curve and Channel
Color

Activated: Exports the image with the changed channel color and
display characteristic curve settings. These settings are applied to the
pixel values of the exported images. They are particularly important if
you want to use dark images with a dynamic range of more than 8
bits in other programs.

Parameter

Description

Apply Display Settings and Channel
Color

–

Burn-in Graphics

Activated: Burns the graphic elements into the image. The pixels under the graphic element (e.g. scale bars) are overwritten. The burnt-in
graphic elements cannot be subsequently modified.

–

Zoom

Only available if Burn-in Graphics is activated.
Sets the zoom of graphic elements for export.
The default is 100%, which means that the graphical elements are
rendered as they would if the viewer zoom was 100%. When the
zoom increases, the graphical elements are rendered larger (e.g. with
zoom 200, graphical elements are rendered twice as large, but it corresponds to the size they would have if the viewer zoom was 50%).
Only available if Burn-in Graphics is activated.

–

–

Get Zoom
from Viewer

Gets the current zoom factor of the graphical elements in the 2D
view.

Merged Channels Image

Only visible for multichannel images.
Activated: Exports the pseudo color image of all selected channels.
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Parameter
–

Individual
Channels Image

Use channel names

ZEISS

Description
Only visible for multichannel images.
Activated: Exports the individual colored image of all selected channels.
Only visible for multi-channel images.
Activated: Integrates the channel name in the name of the exported
image.

Use Full Set of Dimensions

Activated: Includes all dimensions of the original file.

Define Subset

Activated: Creates a subset of the data, depends on the dimensions
available in the image, e.g. Channels, Region, Tiles.

At least one of the three checkboxes must be activated. If the Merged Channels Image and Individual Channel Image checkboxes are activated, you can export the individual colored images
and the pseudo color images in a single step.

Parameter

Description

Export to

Sets path to the folder where images will be exported.

Create Folder

Creates a folder for your exported data.

Generate xml file

Additionally, creates an xml file containing the meta data of the image.

Generate zip file

Creates a .zip file to be exported.

Prefix

Adds the specified name as a prefix to the exported data. By default
this is the name of the original image data.

Defaults

Sets the settings back to default.

9.12.14.7.3 Dimensions section
The following functions are only visible if the Show All mode is activated:

Parameter

Description

Use Full Set of Dimensions

Select this option if you want to export all dimensions without changing them.

Define Subset

Select this option if you only want to export individual dimensions or
subsets of individual dimensions.

Info
Each of the sections described below is only visible if the corresponding dimension is present in
the input image.
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Parameter

Description

Channels

Here you can select which channels of the input image you want to
be used. All channels are selected by default. To deselect a channel,
click on the relevant channel button.

Z-Position, Time,
Block, Scene

Here you can select which parts of the input image you want to use
for the resulting image.

-

Extract All

If selected, all parts of the corresponding image are extracted.

-

Extract Single

If selected, you can select a single image to be extracted.

-

Extract Range

If selected, you can select a certain range of images to be extracted.

-

Extract Multiple

If selected, you can select several continuous ranges and individual
sections.
Enter one or more sections that you want to select in the input field.
To do this, enter the first section, followed by a minus sign, and then
the last section. If you want to define an interval, after the last section
enter a colon and then the interval. The entry "2-10:2" means that every second section is selected from section 2 to section 10.
Enter a comma after the first section if you want to define another
section. You can also select individual sections separated by commas.
By entering "2-10:2,14-18,20,23", you select every second section
from section 2 to section 10, followed by sections 14 to 18, as well as
sections 20 and 23.

-

Get current position

Adopts the position from the current display in the image area.

-

Interval

Activated: Interval mode is active. The Interval spin box/input field
appears.
Enter the desired interval here. E.g. if you enter the value 2 only every
2nd value from the range is considered.

Region

Here you can select if you want to use the entire image or just a region (ROI) of the input image.

-

Full

If selected this option, the full image is used for the new image.

-

Rectangle region (ROI)

If selected this option, you can draw in a rectangle region of interest
which will be used for creating a new image.
If a rectangle region was drawn in you can see and change its coordinates by editing the X/Y/W/H input fields.

-

Keep tiles

Has only an effect, if a region (ROI) is defined.
Activated: Extracts the drawn in region including the complete tiles.
This setting is recommend when you want to apply DCV processing
functions on the resulting image.

Tiles

-

Export selected
tiles

Exports the tiles according to the selected original image.

-

Crop to selection and generate new tiles

Creates new tiles according to your entries in the fields Colums/Rows
and Overlap.
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Parameter
-

Colums /Rows
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Description
Only active if Re-Tile is activated.
Defines, with how many rows and colums the re-tiling is performed.

-

Overlap

Only active if Re-Tile is activated.
Defines the overlap of the re-tiled tiles in %.

9.12.14.7.4 Export to section

Parameter

Description

Export to

The path of the export folder is displayed automatically in the display
field.
To change the file path, click on the
display field.

button to the right of the

The following functions are only visible if the Show All mode is activated:

Parameter

Description

Create folder

Activated: Creates a separate folder with the name of the input image.

Create xml file

Activated: Creates two XML files containing the meta information relating to the input image.
§ Meta.xml contains all additional information relating to the input
image (e.g. hardware settings, dimensions).
§ Info.xml only contains additional information relating to the exported individual images (e.g. names, dimensions, sizes).

Generate zip file

Activated: Creates a ZIP file in which all exported individual images,
including the XML files, are saved.

Parameter

Description

Prefix

Here you can edit the prefix specified or enter a new name. The name
of the original image is specified by default.

9.12.15 Image Analysis
The group Image Analysis provides different options to analyze images in single or batch mode.
The measurement data can be embedded in the image, saved in a *csv-datalist, or saved as label
image.
9.12.15.1 Analyze
This function is applicable only for one image: This must be selected in the Input tool. The measurement data are embedded in the image.
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9.12.15.2 Analyze to File
This function is applicable only for one image: This must be selected in the Input tool. The measurement data is stored in a *csv list and is not embedded into the image.
The following file types are supported:
§

CZI

§

ZVI

§

BMP

§

TIF

§

JPG

Parameter

Description

Data Folder

Folder where the *csv-data lists will be stored.

Base Name

Name of the data list.

9.12.15.3 Analyze Batch
This function allows the analysis of all images in a folder.
The function Analyze Batch can only be applied to images with the file type *czi.
The measured data are embedded in each original image.

Parameter

Description

Image Folder

Folder of the *czi images to be measured.

9.12.15.4 Analyze Batch to File
This function allows an analysis of all images in a folder. The measured data are stored in a *csv
list and not embedded into the image.
The following file types are supported:
§

CZI

§

ZVI

§

BMP

§

TIF

§

JPG

Parameter

Description

Image Folder

Folder of the images to be measured.

Data Folder

Folder where the *csv-data lists will be stored.

Base Name

Name of the data list.

Append Data

Activated: For each class, an accumulated csv-data list is stored with
the measurement data of all images.
Deactivated: For each image, one data list is stored per class.
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9.12.15.5 Analyze to Label Image
The image processing functions Analyze to Label Image labels images based on an existing image analysis setting and the parameters which you select in the Parameters section.

Parameter

Description

Setting

Displays image analysis settings in the drop down list.

Initialization

Initializes the output image.

–

One channel

Creates a one channel output image.

–

One channel
and copy first

Creates a one channel output image and copies the content of the
first channel.

–

One channel
per class

Creates an output image with one channel per region class.

–

One channel
per class and
copy

Creates an output image with one channel per region class and copies
the content of the original channels of each class.

–

All referenced
channels

Creates all channels referenced in the image analysis setting.

–

All referenced
channels and
copy

Creates all channels referenced in the image analysis setting and
copies the content of the original image.

Label Mode

Selects the mode of labels applied to the image.

–

Region - Pixel
Type Maximum

Labels the region with the maximum value of the pixel type.

–

Region - Label
Value

Labels the region with the value specified by the Label Value slider/
input field.

–

Region - Region
ID

Labels the region with the region ID.

–

Region - Region
ID Color

Labels the region with the region ID color.

–

Region - Region
Class ID

Labels the region with the region class ID.

–

Region - Region
Class Color

Labels the region with the region class color.

–

Contour - Pixel
Type Maximum

Draws a contour with the maximum value of the pixel type.

–

Contour - Label
Value

Draws a contour with the value specified by the Label Value slider/
input field.

–

Contour - Region ID

Draws a contour with the color defined by the region ID.

–

Contour - Region ID Color

Draws a contour with the color defined by the region ID color.
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ZEISS

Description

–

Contour - Region Class ID

Draws a contour with the color defined by the region class ID.

–

Contour - Region Class Color

Draws a contour with the color defined by the region class color.

–

Contour2 - Pixel
Type Maximum

Draws a double contour with the value defined by the maximum
value of the pixel type.

–

Contour2 - Label Value

Draws a double contour with the value specified by the Label Value
slider/ input field.

–

Contour2 - Region ID

Draws a double contour with the color defined by the region ID.

–

Contour2 - Region ID Color

Draws a double contour with the color defined by the region ID color.

–

Contour2 - Region Class ID

Draws a double contour with the color defined by the region class ID.

–

Contour2 - Region Class Color

Draws a double contour with the color defined by the region class
color.

Pixel Type

Selects the pixel type for the output image.

–

8 Bit B/W

Creates a 8 bit black and white output image.

–

16 Bit B/W

Creates a 16 bit black and white output image.

–

24 Bit RGB

Creates a 24 bit colored output image.

–

48 Bit RGB

Creates a 48 bit colored output image.

–

32 Bit B/W Float

Creates a 32 bit black and white image.

Label Value

Selects the label value.

See also
2 Using Analyze to Label Image [} 108]
9.12.15.6 Analyze to Label Image Batch
The image processing functions Analyze to Image Batch labels images based on an existing image analysis setting and the parameters which you select in the Parameters section.

Parameter

Description

Setting

Displays image analysis settings in the drop down list.

Image Folder

Selects the folder of the images.

Initialization

Initializes the output image.

–

One channel

Creates a one channel output image.

–

One channel
and copy first

Creates a one channel output image and copies the content of the
first channel.
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Description

–

One channel
per class

Creates an output image with one channel per region class.

–

One channel
per class and
copy

Creates an output image with one channel per region class and copies
the content of the original channels of each class.

–

All referenced
channels

Creates all channels referenced in the image analysis setting.

–

All referenced
channels and
copy

Creates all channels referenced in the image analysis setting and
copies the content of the original image.

Label Mode

Selects the mode of labels applied to the image.

–

Region - Pixel
Type Maximum

Labels the region with the maximum value of the pixel type.

–

Region - Label
Value

Labels the region with the value specified by the Label Value slider/
input field.

–

Region - Region
ID

Labels the region with the region ID.

–

Region - Region
ID Color

Labels the region with the region ID color.

–

Region - Region
Class ID

Labels the region with the region class ID.

–

Region - Region
Class Color

Labels the region with the region class color.

–

Contour - Pixel
Type Maximum

Draws a contour with the maximum value of the pixel type.

–

Contour - Label
Value

Draws a contour with the value specified by the Label Value slider/
input field.

–

Contour - Region ID

Draws a contour with the color defined by the region ID.

–

Contour - Region ID Color

Draws a contour with the color defined by the region ID color.

–

Contour - Region Class ID

Draws a contour with the color defined by the region class ID.

–

Contour - Region Class Color

Draws a contour with the color defined by the region class color.

–

Contour2 - Pixel
Type Maximum

Draws a double contour with the value defined by the maximum
value of the pixel type.

–

Contour2 - Label Value

Draws a double contour with the value specified by the Label Value
slider/ input field.

–

Contour2 - Region ID

Draws a double contour with the color defined by the region ID.
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Description

–

Contour2 - Region ID Color

Draws a double contour with the color defined by the region ID color.

–

Contour2 - Region Class ID

Draws a double contour with the color defined by the region class ID.

–

Contour2 - Region Class Color

Draws a double contour with the color defined by the region class
color.

Pixel Type

Selects the pixel type for the output image.

–

8 Bit B/W

Creates a 8 bit black and white output image.

–

16 Bit B/W

Creates a 16 bit black and white output image.

–

24 Bit RGB

Creates a 24 bit colored output image.

–

48 Bit RGB

Creates a 48 bit colored output image.

–

32 Bit B/W Float

Creates a 32 bit black and white image.

Label Value

Selects the label value.

Format

Selects the format of the output image. You can save your image(s)
as:
§ czi
§ png
§ czi and png

See also
2 Using Analyze to Label Image [} 108]
9.12.15.7 Analyze Interactive Batch
This function allows the interactive analysis of all images in a folder. If steps of the image analysis
are marked as interactive in the image analysis setting, this function opens the Image Analysis
Wizard [} 777] with these steps. You can then adjust your analysis for each of the images. If you
deselect one of the interactive steps during the process, this step will not be shown for the analysis of the following images. The image analysis setting remains unchanged by the changes made
during Analyze Interactive Batch.
The measured data are embedded in each original image.

Parameter

Description

Image Folder

Folder of the *czi images to be measured.
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9.12.16 Lightsheet
This group of processing functions allows you to analyze multiview dual side illuminated Lightsheet images. The following functions are available:
§

Dual Side Fusion [} 218]

§

Lightsheet Convert Dimensions [} 219]

§

Lightsheet Processing [} 220]

§

Maximum Intensity Projection [} 228]

9.12.16.1 Dual Side Fusion
This function merges the image done with the lightsheet from the right side with the image of the
left side. It can be used for the following datasets acquired with Dual Side illumination:
§

Image (Snap function)

§

Time Series

§

Z-Stacks

§

Combinations of time series and z-stacks

§

Multiview experiments in combination with time series

Parameter

Description

Settings

Allows handling predefined settings (templates). See also General Settings [} 90].

–

New

Creates a new setting. Enter a name for the setting.

–

New from Template

Creates a new setting based on an existing template.

–

Rename

Renames the setting.

–

Save

Saves a modified setting under the current name. An asterisk indicates
the modified state.

–

Save As

Saves the current setting under a new name.

–

Import

Imports an existing setting.

–

Export

Exports the current setting.

–

Delete

Deletes the current setting.

Mean

The average intensity for each pixel is calculated using the values of
both illumination sides of the fusion.

DFT

Discrete Fourier Transform fusion according to publication. Fine
structures and details are more visible after the fusion, which might
be worsened when using Mean Fusion. However, this process can
create noticeable artifacts in the resulting image.

Maximum

The intensity of each pixel of both illumination images is compared
and the value with the higher intensity is used for the resulting image
of the fusion.
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Parameter

Description

Fusion Subset in X

Only available for Mean or Maximum fusion.
Selects which area of the left and the right illumination image should
be used for fusion.

–

Current View

Displays the selected view of a Multiview image in the 2D tab which
is used for fusion subset in x..
Note: The position of the sliders Left and Right as well as the Blending value have to be defined for each view individually.

–

Left

Selects the area of the left illumination side which is used for fusion.
The spin box shows the cut-off x pixel value. The cutoff is shown in
the 2D vie with a red line.
Note: It is best to set the illumination slider of the Dimensions view
control to 1 to see the left-side illuminated image.

–

Right

Selects the area of the right illumination side which is used for fusion.
The spin box shows the cut-off pixel value of the y axis. The cutoff is
shown in the 2D view with a blue line.
Note: It is best to set the illumination slider of the Dimensions view
control to 2 to see the right-side illuminated image.

–

Blending

Defines the number of pixels used within an existing overlap between
left and right illumination to crossfade both illuminations sides.
Note: To avoid a visible change in intensity along the two cut off lines
for Mean Fusion with Fusion Subset in X, an overlap of both illumination sides should remain in the center of the image.

9.12.16.2 Lightsheet Convert Dimensions
This function allows you to convert some dimensions into channels.
The following dimensions are available:
§

View (from Multiview)

§

Illumination (from Dual side)

The following dimensions are unavailable:
§

Time (from Time series)

§

Z (from Z-Stack)

§

Tile (from Tiling)

§

Position (from Positions)

Parameter

Description

Settings

Allows handling predefined settings (templates). See also General Settings [} 90].

–

New

Creates a new setting. Enter a name for the setting.

–

New from Template

Creates a new setting based on an existing template.

–

Rename

Renames the setting.

–

Save

Saves a modified setting under the current name. An asterisk indicates
the modified state.
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Description

–

Save As

Saves the current setting under a new name.

–

Import

Imports an existing setting.

–

Export

Exports the current setting.

–

Delete

Deletes the current setting.

View to channel

Converts views from a Multiview data set into channels.

Illumination to
channel

Converts illuminations from a Dual Side data set into channels.

9.12.16.3 Lightsheet Processing
Lightsheet processing allows you to deconvolve, register, and fuse Multiview images.

Parameter

Description

Settings

Allows handling predefined settings (templates). See also General Settings [} 90].

–

New

Creates a new setting. Enter a name for the setting.

–

New from Template

Creates a new setting based on an existing template.

–

Rename

Renames the setting.

–

Save

Saves a modified setting under the current name. An asterisk indicates
the modified state.

–

Save As

Saves the current setting under a new name.

–

Import

Imports an existing setting.

–

Export

Exports the current setting.

–

Delete

Deletes the current setting.

Deconvolution

Activated: Allows to deconvolve Lightsheet data (single views) of the
following formats:
§ Multiview experiments before registration and fusion (single or dual
side illumination):
Deconvolution is performed for each frame from all z-stacks and all
views. The process uses a point spread function (PSF) valid for single view images.
§ Multiview experiments after registration and fusion:
Deconvolution is performed on the fused dataset, hence only one
z-stack needs to be processed. It uses a star-like point spread function (PSF) computed from the fused Multiview image.
For more information, see Deconvolution (adjustable) [} 124].

Multiview

Activated: Allows registration, fusion, and deconvolution of Multiview images.
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–

Registration options

ZEISS

Description
Allows to select the alignment method:
§ Landmark based alignment [} 221]
§ Intensity based aligment [} 223]
§ Use Registration from File [} 225]
§ Interactive Registration [} 226]
The following datasets can be processed with this function:
§ Multiview datasets, single side illumination
§ Multiview datasets, dual side illumination, Dual Side without Fusion
§ Multiview datasets, dual side illumination, Dual Side with Fusion
§ Multiview datasets with Deconvolution
§ Multiview datasets without Deconvolution
The Registration generates the transformation matrices so that all
views are matched to overlay. As a result, a dataset is provided in
which all z-stacks of all views should already largely overlay. The reference at which registrations starts is always View 1 of the dataset. This
image can be used for control. If one or more views do not have the
same alignment, registration was not successful and the parameters
need to be adjusted. The Registration must always be done before
the Fusion of the data.

9.12.16.3.1 Landmark based alignment
Registration is done based on structural information within the image content.

Parameter

Description

Parameter Settings

Setting of alignment parameters.

–

Registration
Channel

Selects the registration channel. Use a channel with fiducials to which
other channels will be registered to.
Note: A selection of more than one channel for the registration
process is possible. For each selected channel an individual registration will be performed and, therefore, it is advisable to use one channel for the final registration. To test which channel will lead to the
best results, all channels can be selected for later comparison of the
results.

–

Threshold

Selects thresholds for the brightness of fiducials (beads).

–

Size

Selects thresholds for the size of fiducials (beads).

–

Size Variations

Selects thresholds for the variation in size difference.

–

Dual side fusion

This operation merges the image done with the lightsheet from the
right side with the image of the left side. See also Dual Side Fusion
[} 218].

–

Fusion Subset in
X

Activated:Selects which area of the left and the right illumination image should be used for fusion. Only available for Mean or Maximum
fusion. See also the description in Dual Side Fusion [} 218].
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Description

–

Ignore Sample

Activated: Uses a function to find incorrectly labeled fiducials and
eliminate them for registration.

–

Expand to maximum value

Activated: The volume of the resulting dataset after registration and
fusion is determined and additional black pixels (x,y) and z-slices are
added to the views during registration. This prevents loss of data for
later fusion.

–

Scaling X=Y=Z

Activated: The dimensions are downsized to the smallest to have the
same size. If the scaling in Deconvolution or PSF settings is changed,
the latter overrides the scaling settings here.

–

Individual Registration for every
Time Point

Activated: Each time point generates a transformation matrix and
each time point is registered individually.
The time necessary for registration is multiplied by the number of time
points and can increase substantially. However, if the motorized
movement of the sample by the system has changed (e.g. due to thermic effects on the system: not fully warmed up at start, incubation, air
conditioning of the room), the Individual Registration For Every
Time Point option is necessary.
Deactivated: One transformation matrix is generated for all the following time points based on the first time point. As a result, processing for registration has only to be done once which reduces processing time.

Parameter

Description

Input settings

A subset of a present time series can be selected for the Registration
and Fusion processing.

–

Processing Subset Time

Truncates time points.

–

Processing Subset Steps

Defines time-to-time point step size.

–

Scaling correction (µm)

Sets the geometric scaling between X/Y and Z.

Fusion

Fuses registered views in one z-stack or one z-stack over time.

–

None

No fusion is performed after Registration and Dual Side Fusion.

–

Mean Fusion

The pixel in the fused image is determined by averaging the intensity
level of the pixels for the involved views.

–

Mean Fusion +
Multiview DCV

Only available if the dataset has not undergone deconvolution before.
The pixel in the fused image is determined by averaging the intensity
level of the pixels of the involved views. After fusion, a deconvolution
is performed. The Deconvolution [} 124] interface is displayed if selected.

–

Blending

Controls the amount of Blending (smoothing) by fading the borders of
all z-stacks in order to prevent visible edge effects.
Note: The value for Blending should be as low as possible with typical
values from 20 to 80. This needs to be tested for every dataset.
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Description

–

Fusion Subset in
Z

Activated: Defines which portion of the z-stacks of the contributing
views of the experiment are used for the fusion process.

–

Current View

Selects the current view. For each view the z-range can be set via
slider, spin boxes, or mouse click in the image. Registration will not be
affected by the z-range settings.
Note that for later deconvolution the calculated point spread function
(PSF) of a Multiview experiment assumes that all views equally contribute to all areas of the image. This is not the case when using Subset Z and might result in artefacts of the deconvolution result.

–

Save unfused
data

Activated: Saves the registered image in addition to the fused image.

See also
2 Deconvolution (adjustable) [} 124]
9.12.16.3.2 Intensity based aligment

Parameter

Description

Parameter Settings

Setting of alignment parameters.

–

Registration
Channel

Selects the registration channel. Use a channel with fiducials to which
other channels will be registered to.
Note: A selection of more than one channel for the registration
process is possible. For each selected channel an individual registration will be performed and, therefore, it is advisable to use one channel for the final registration. To test which channel will lead to the
best results, all channels can be selected for later comparison of the
results.

–

Preregistration

Preregistration performs the process in a 2D maximum intensity projection of the z-stacks.
It is advisable to first perform a Pre-Registration to move similar
structures, which might facilitate the Registration, already into close
proximity.

–

None

No Preregistration is performed.

–

Hardware Rotation

The views are rotated solely based on the information from the rotation positioning of the sample holder which is saved in the metadata.

–

Trans Hardware
Rotation

The views are rotated solely based on the information from the rotation positioning of the sample holder which is saved in the metadata.
Additionally, the x, y, and z axis are moved to match the views.

–

Correlation
Hardware Rotation

The views are rotated solely based on the information from the rotation positioning of the sample holder which is saved in the metadata.
Additionally, the x, y, and z axis are moved to match the views. Crosscorrelation is used to determine the translation in x, y, and z.

–

Registration
Method

Registration uses the complete 3D information of the z-stacks.

–

Use Pre Register
Only

No Registration process is performed and only the result of the PreRegistration is used.
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Description

–

Translation

The registration only corrects along the x, y, and z axis.

–

Trans Rotation

The registration corrects along the x, y, and z axis and also the rotation along x and y.

–

Dual side fusion

Merges the image done with the lightsheet from the right side with
the image of the left side. See also Dual Side Fusion [} 218].

–

Fusion Subset in
X

Activated: Selects which area of the left and the right illumination
image should be used for fusion. Only available for Mean or Maximum fusion. See also the description in Dual Side Fusion [} 218].

–

Ignore Sample

Activated: Uses a function to find incorrectly labeled fiducials and
eliminate them for registration.

–

Expand to maximum value

Activated: The volume of the resulting dataset after registration and
fusion is determined and additional black pixels (x,y) and z-slices are
added to the views during registration. This prevents loss of data for
later fusion.

–

Scaling X=Y=Z

Activated: The dimensions are downsized to the smallest to have the
same size. If the scaling in Deconvolution or PSF settings is changed,
the latter overrides the scaling settings here.

–

Individual Registration for every
Time Point

Activated: Each time point generates a transformation matrix and
each time point is registered individually.
The time necessary for registration is multiplied by the number of time
points and can increase substantially. However, if the motorized
movement of the sample by the system has changed (e.g. due to thermic effects on the system: not fully warmed up at start, incubation, air
conditioning of the room), the Individual Registration For Every
Time Point option is necessary.
Deactivated: One transformation matrix is generated for all the following time points based on the first time point. As a result, processing for registration has only to be done once which reduces processing time.

Parameter

Description

Input settings

A subset of a present time series can be selected for the Registration
and Fusion processing.

–

Processing Subset Time

Truncates time points.

–

Processing Subset Steps

Defines time-to-time point step size.

–

Scaling correction (µm)

Sets the geometric scaling between X/Y and Z.

Fusion

Fuses registered views in one z-stack or one z-stack over time.

–

None

No fusion is performed after Registration and Dual Side Fusion.

–

Mean Fusion

The pixel in the fused image is determined by averaging the intensity
level of the pixels for the involved views.
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Description

–

Mean Fusion +
Multiview DCV

Only available if the dataset has not undergone deconvolution before.
The pixel in the fused image is determined by averaging the intensity
level of the pixels of the involved views. After fusion, a deconvolution
is performed. The Deconvolution [} 124] interface is displayed if selected.

–

Blending

Controls the amount of Blending (smoothing) by fading the borders of
all z-stacks in order to prevent visible edge effects.
Note: The value for Blending should be as low as possible with typical
values from 20 to 80. This needs to be tested for every dataset.

–

Fusion Subset in
Z

Activated: Defines which portion of the z-stacks of the contributing
views of the experiment are used for the fusion process.

–

Current View

Selects the current view. For each view the z-range can be set via
slider, spin boxes, or mouse click in the image. Registration will not be
affected by the z-range settings.
Note that for later deconvolution the calculated point spread function
(PSF) of a Multiview experiment assumes that all views equally contribute to all areas of the image. This is not the case when using Subset Z and might result in artefacts of the deconvolution result.

–

Save unfused
data

Activated: Saves the registered image in addition to the fused image.

9.12.16.3.3 Use Registration from File
When the registration for the dataset is already determined and the transformation matrix is
saved as an .xml file (Filename.czi.xml), this option can be selected.

Parameter

Description

Parameter Settings

Setting of alignment parameters.

–

Select a registration file […]

Opens the Windows File Explorer to select a file.

–

Dual side fusion

Merges the image done with the lightsheet from the right side with
the left side image. See also Dual Side Fusion [} 218].

–

Fusion Subset in
X

Activated:Selects which area of the left and the right illumination image should be used for fusion. Only available for Mean or Maximum
fusion. See also the description in Dual Side Fusion [} 218].

–

Expand to maximum value

Activated: The volume of the resulting dataset after registration and
fusion is determined and additional black pixels (x,y) and z-slices are
added to the views during registration. This prevents loss of data for
later fusion.

Parameter

Description

Input settings

A subset of a present time series can be selected for the Registration
and Fusion processing.

–

Processing Subset Time

Truncates time points.
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Parameter

Description

–

Processing Subset Steps

Defines time-to-time point step size.

–

Scaling correction (µm)

Sets the geometric scaling between X/Y and Z.

Fusion

ZEISS

Fuses registered views in one z-stack or one z-stack over time.

–

None

No fusion is performed after Registration and Dual Side Fusion.

–

Mean Fusion

The pixel in the fused image is determined by averaging the intensity
level of the pixels for the involved views.

–

Mean Fusion +
Multiview DCV

Only available if the dataset has not undergone deconvolution before.
The pixel in the fused image is determined by averaging the intensity
level of the pixels of the involved views. After fusion, a deconvolution
is performed. The Deconvolution [} 124] interface is displayed if selected.

–

Blending

Controls the amount of Blending (smoothing) by fading the borders of
all z-stacks in order to prevent visible edge effects.
Note: The value for Blending should be as low as possible with typical
values from 20 to 80. This needs to be tested for every dataset.

–

Fusion Subset in
Z

Activated: Defines which portion of the z-stacks of the contributing
views of the experiment are used for the fusion process.

–

Current View

Selects the current view. For each view the z-range can be set via
slider, spin boxes, or mouse click in the image. Registration will not be
affected by the z-range settings.
Note that for later deconvolution the calculated point spread function
(PSF) of a Multiview experiment assumes that all views equally contribute to all areas of the image. This is not the case when using Subset Z and might result in artefacts of the deconvolution result.

–

Save unfused
data

Activated: Saves the registered image in addition to the fused image.

9.12.16.3.4 Interactive Registration
The recorded views of an experiment are registered manually. The views of one channel at one
time point of the experiment are the basis for the procedure. The z-stacks of the individual views
are rotated based on the rotation information of the files metadata and transformed into channels, resulting in one maximum intensity projection image. Within this newly generated image,
the views, now behaving as channels, can be moved in x, y, z and rotated to overlay each other.
When all views are laid on top of each other, the Apply button uses the adjusted parameters to
register, and when required to fuse, the views for all time points of the experiment. An .xml file is
created which can be used for the Use registration from file option. This .xml file can be found
along with the processed data in the result folder.

Parameter

Description

Parameter Settings

Setting of alignment parameters.
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ZEISS

Description

–

Registration
Channel

Selects the registration channel that should be used to manually overlay all views of the image.
Note: Only one channel can be used for this procedure, all other
channels will not be displayed.

–

Current Time
Point

Indicates the selected time point of a time series as set with the time
slider in the Dimensions tab.

–

Front View

Converts views into channels and generates a maximum intensity projection along the z-axis of channels displaying the x- (horizontal) and
y- (vertical) axis of channels representing.
Note: It is advisable to assign different colors to the channel to ease
up alignment process. Channels can be turned on/off in the Dimensions tab.

–

Side View

Converts views into channels and generates a maximum intensity projection along the x-axis displaying the z- (horizontal) and y- (vertical)
axis of channels representing.
Note: It is advisable to assign different colors to the channel to ease
up alignment process. Channels can be turned on/off in the Dimensions tab.

–

View #

Selects the view to be aligned to View 1.
View 1 is the master view and the reference channel and cannot be
selected or moved. View # can be moved by translation and rotation
against View 1. It does not matter if alignment is started with Front
View or Side View. Three iterations between Front View and Side
View alignment are recommended.

–

Alignment X

Shifts the selected view against View 1 in X. Not available for Side
View.

–

Alignment Y

Shifts the selected view against View 1 in Y.

–

Alignment Z

Shifts the selected view against View 1 in Z. Not available for Front
View.

–

Rotation

Rotates the selected view around the position of the red cross overlay
within the image of the 2D tab.

–

Reset

Moves all views back to the position where the maximum intensity
projection was generated.

–

Preview

Produces a new image of the channel and the time point which is registered with the provided settings. The image will contain fused views
when Mean Fusion is selected for Fusion.

–

Dual side fusion

Merges the image done with the lightsheet from the right side with
the image of the left side. See also Dual Side Fusion [} 218].

–

Fusion Subset in
X

Activated: Selects which area of the left and the right illumination
image is used for fusion. Only available for Mean or Maximum fusion. See also the description in Dual Side Fusion [} 218].

–

Expand to maximum value

Activated: The volume of the resulting dataset after registration and
fusion is determined and additional black pixels (x,y) and z-slices are
added to the views during registration. This prevents loss of data for
later fusion.
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–

Scaling X=Y=Z

ZEISS

Description
Activated: The dimensions are downsized to the smallest to have the
same size. If the scaling in Deconvolution, PSF settings is changed, the
latter will override the scaling settings here.

Parameter

Description

Input settings

A subset of a present time series can be selected for the Registration
and Fusion processing.

–

Processing Subset Time

Truncates time points.

–

Processing Subset Steps

Defines time-to-time point step size.

–

Scaling correction (µm)

Sets the geometric scaling between X/Y and Z.

Fusion

Fuses registered views in one z-stack or one z-stack over time.

–

None

No fusion is performed after Registration and Dual Side Fusion.

–

Mean Fusion

The pixel in the fused image is determined by averaging the intensity
level of the pixels for the involved views.

–

Mean Fusion +
Multiview DCV

Only available if the dataset has not undergone deconvolution before.
The pixel in the fused image is determined by averaging the intensity
level of the pixels of the involved views. After fusion, a deconvolution
is performed. The Deconvolution [} 124] interface is displayed if selected.

–

Blending

Controls the amount of Blending (smoothing) by fading the borders of
all z-stacks in order to prevent visible edge effects.
Note: The value for Blending should be as low as possible with typical
values from 20 to 80. This needs to be tested for every dataset.

–

Fusion Subset in
Z

Activated: Defines which portion of the z-stacks of the contributing
views of the experiment are used for the fusion process.

–

Current View

Selects the current view. For each view the z-range can be set via
slider, spin boxes, or mouse click in the image. Registration will not be
affected by the z-range settings.
Note that for later deconvolution the calculated point spread function
(PSF) of a Multiview experiment assumes that all views equally contribute to all areas of the image. This is not the case when using Subset Z and might result in artefacts of the deconvolution result.

–

Save unfused
data

Activated: Saves the registered image in addition to the fused image.

9.12.16.4 Maximum Intensity Projection
The function allows you to perform a Maximum Intensity Projection (MIP) for selected dimensions.

Parameter

Description

Settings

Allows handling predefined settings (templates). See also General Settings [} 90].
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Description

–

New

Creates a new setting. Enter a name for the setting.

–

New from Template

Creates a new setting based on an existing template.

–

Rename

Renames the setting.

–

Save

Saves a modified setting under the current name. An asterisk indicates
the modified state.

–

Save As

Saves the current setting under a new name.

–

Import

Imports an existing setting.

–

Export

Exports the current setting.

–

Delete

Deletes the current setting.

Online Batch Processing

Activated: Starts the online batch processing.

Coordinate

Selects the coordinate for which the maximum intensity projection
(MIP) is performed.

–

Z

MIP of a z-stack.

–

C

MIP of channels.

–

T

MIP of a time series.

–

I

MIP of Illumination sides.

–

V

MIP of views.

Range

Sets the range of the dimension to be used for the maximum intensity
projection. The range can be set with the two slider bars or the spin
boxes.

9.12.17 Batch Processing Functions
9.12.17.1 Change scaling
This method is only available for batch processing.

Parameter

Description

X Scaling

Changes the scaling of the image in X-direction.

The following units are
possible:

-

m/px

-

cm/px

-

mm/px

-

µm/px

Changes the unit (length per pixel).
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Parameter
-

nm/px

-

pm/px

-

i/px

-

mil/px

Y Scaling

ZEISS

Description

Changes the scaling of the image in Y-direction.

The following units are
possible:

-

m/px

-

cm/px

-

mm/px

-

µm/px

-

nm/px

-

pm/px

-

i/px

-

mil/px

Z Scaling

Changes the unit (length per pixel).

Changes the scaling of the image in Z-direction.

The following units are
possible:

-

m/px

-

cm/px

-

mm/px

-

µm/px

-

nm/px

-

pm/px

-

i/px

-

mil/px

Pick scaling from file

Changes the unit (length per pixel).

Applies the scaling from another czi-file.
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9.12.17.2 Image Analysis Program
This method is only available for batch processing.

Parameter

Description

Setting

Selects an existing image analysis setting.

Apply

Applies the selected setting to the highlighted dataset. The defined classes and class names are displayed.

Class-Tree

Displays the class-tree of the selected image analysis setting.

9.12.17.3 Analyze to File

Parameter

Description

Setting

Selects an existing image analysis setting.

Data Folder

Specifies the folder where the analyzed csv-files will be stored.

Base Name

Specifies the prefix of the file name for the analyzed csv-files.

9.12.17.4 Draw Scale Bar Annotation
This method is only available for batch processing.

Parameter

Description

Distance from document bounds

Sets the distance of the Scale Bar from the bounds of the image
(in pixel).

Alignment

Sets the alignment of the Scale Bar.

-

Top Left

-

Top Center

-

Top Right

-

Middle Left

-

Middle Center

-

Middle Right

-

Bottom Left

-

Bottom Center

-

Bottom Right

Orientation

-

Horizontal

-

Vertical

Sets the orientation of the Scale Bar.
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9.12.17.5 Split Multiblock Image (for images until ZEN 2.1)

Parameter

Description

Split Mode

Chooses the mode how to split the multiblock image (in pixel).

-

Homogeneous
groups

Splits the multiblock image into the single dimensions. The
blocks will remain.

-

Single blocks

Splits the multiblock image into single blocks.

Target Folder

Specifies the folder where the split images are stored. The path
of the destination folder is displayed automatically in the display
field. To change the folder, click on the button to the right of the
display field.

Defaults

Restores the default values for the batch method.

9.12.17.6 Undo Stitching
This method is only available for batch processing.
Undoes a previously applied stitching of the image.
No method parameters necessary.
9.12.17.7 Attach PSF (Point Spread Function)
This method is only available for batch processing.
This method attaches a previously created PSF to the image file.

Parameter

Description

Channel

Selects the channel where the PSF should be attached.

PSF File

Selects the PSF-file created by the image processing function Create PSF.
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10 Importing/ Exporting Images
10.1 Workflow Export/Import
This example describes the workflow for the Image Export. The typical workflow is the same for
both export and import of images.
Prerequisite ü You have selected the Processing tab.
1. In the Method tool, open the Export/Import group and select the Image Export
method.
2. Under Method Parameters > Parameters, set the desired export settings, e.g. file type,
quality, export folder, etc..
3. Under Image Parameters > Input, select the image you want to export. To do this, click
on the small preview image within the Input tool. You will see a preview of all the open
images. To select an image, click on the image that you want to use. This is only necessary
if you have several images open simultaneously. By default, the image currently selected is
always used as the input image.
4. Export the image
On the top part of the Processing tab, click on the Apply button.
You have successfully exported the selected image.

10.2 Exporting Images
Using the Quick Export function you can export images automatically with a single click of the
mouse, without setting the method parameters.
Prerequisite ü You have acquired or opened an image.
1. In the Right Tool Area in the Images and Documents tool, click on the Quick Export
button
.
Alternatively, you can click on the Quick Export entry via the File > Export/Import.
The selected image is automatically exported with the default settings of the Image Export
method (JPEG, quality 95%, size 100%). The image can then be found in a subfolder within the
Windows image folder (…/User/My Pictures).
All images have 300 dpi.

Info
If you export a time lapse image using the Quick Export function, a movie is automatically generated using the default values of the Movie Export method.

10.3 Exporting Movies
Using the Quick Export function you can export movies automatically with a single click of the
mouse, without setting the method parameters.
Prerequisite ü You have acquired or opened an image from a Time Series or a Z-stack image.
1. In the Right Tool Area in the Images and Documents tool, click on the Quick Export
button
.
Alternatively, you can click on the Quick Export entry on the File > Export/Import.
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The selected experiment is automatically exported with the default settings of the Movie Export
method (AVI, original size). The movie can then be found in a subfolder within the Windows image folder (…/User/My Videos).

See also
2 Movie Export [} 195]

10.4 Exporting Multichannel Images
Here you will find out how to export individual images from a multichannel image with three
channels and save them automatically in a ZIP archive. You will also discover how to export the
whole multichannel image (pseudo color image) as an individual image.
Prerequisite ü You have acquired or opened a multichannel image.
1. On the Processing tab, open the parameters for Image Export (Ctrl+6 or via the File >
Export/Import > Export).
à You will see the default settings of the parameters for image export. Make sure that the
Show All mode has been activated.
2. Activate the Individual Channels Image checkbox.
à An image will be exported from each channel. The Multichannel Image checkbox is activated by default. This means that the pseudo color image (mixed color image from all
channels) will also be exported as an individual image.
3. Activate the Generate zip file checkbox under Export to. Activated the Create folder
checkbox, to create a subfolder with the name of the prefix.
à The ZIP archive is saved in the subfolder.
4. Click on the Apply button at the top of the Processing tab.
You have exported the images of the individual channels and the pseudo color image of your multichannel image and automatically saved them in a ZIP archive. The ZIP archive containing the 4
images can be found in the export folder indicated.

10.5 Exporting Multiscene Images
You can export multiscene images into the following file formats:
§

JPEG

§

BMP

§

TIFF

§

Big TIFF

§

PNG

§

WDP

§

SUR

Note that export of images to most of these formats is subject to limits of the file size that can be
created (typically ca. 2 Gb). For this reason, we recommend to use the Big TIFF-format. If this is
not possible because the Big TIFF-format does not fit your needs, check if the image size does not
exceed the resources of your computer when exporting your preferred format. A message will inform you, when the size exceeds your resources. You have the following options to work around:
§

With the Resize slider, resize the resolution to scale the image down.

§

Activate Original Data, deactivate Apply Display Settings and Channel Color.

§

With a rectangle, select a region of interest to minimize the image itself.
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Activate the Re-Tile radio button to cut the image again into tiles using the row and column
options.

You can extract different scenes and regions of the image.
Prerequisite ü You have loaded a multiscene image.
1. On the Processing tab, open the parameters for the method Export/Import | Image Export. Alternatively, click Ctrl+6 or via the File menu | Export/Import | Export.
à You will see the default settings of the parameters for image export. Make sure that the
Show All mode has been activated.

2.
3.
4.
5.
6.

7.

à In the Export section, the path of the export folder is displayed automatically in the display field.
In the File type section, define the format for your image to be exported.
à According to your selection, the functionalities might change.
If the format Big TIFF is selected, activate the Merge all Scenes checkbox to combine all
scenes of your ROI in one image. Deactivate the checkbox to export single files per scene.
Activate the Define Subset radio button .
à The Scene, the Region and the Tiles parameters are displayed.
In the Scene section, from the drop down menu, select which parts of the input image you
want to use for the resulting image.
In the Region section, from the drop down menu, select if you want to export the full image or a rectangle region. If you select Rectangle region, with the left mouse button, you
can drag a rectangle in the image according to your needs.
Click the Apply button.

You have exported one or more images to the export folder.
The naming follows a naming convention.
Naming convention of the exported file
The name of the exported file follows a convention: <Prefix>_<Suffix>.<File Format>.
Example: TMA1_m1.tif
If there are no dimensions, the image name will not contain a suffix. Example: TMA1.tif

Image name of exported file

Description of the exported image

<Prefix>_m<no.>

Contains re-tile data. The count starts from top left to right and in the
next row again from left to right.

<Prefix>_c<no.>

Contains channels.

<Prefix>_t<no.>

Contains time series.

<Prefix>_z<no.>

Contains z-stacks.

<Prefix>_ORG_<no.>

Contains original data.

The prefix is the image name you entered in the Prefix field in the Tiles section. Per default, the
prefix field contains the image name. The suffix contains all image information. Example: If you
export an z-stack with channel 1 and channel 2, and activate re-tile, the image name of one exported image could be: TMA1_z02c1+2m1.tif
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See also
2 Dimensions section [} 199]
2 Export to section [} 212]
2 File Type section [} 208]

10.6 Importing Z-Stack Images
Prerequisite ü You have saved the individual images of a Z-stack in a folder on your computer. The images
have been named systematically, e.g. Image_Z0, Image_Z01, etc...
1. On the Processing tab, open the parameters for Image Import (or via the File > Export/
Import > Import).
à You will see the default settings of the parameters for Image Import.
2. Activate the Z-stack checkbox. Deactivate all the other dimensions.
3. Enter the interval for the Z-stack. The number of planes is set automatically if the images
have been named systematically.
4. In the Import from section, select the folder that contains the individual images of your Zstack image.
à The individual images are displayed automatically in the list under the import directory.
5. Click on the Check Consistency button. This allows you to check whether the images can
be imported correctly.
à A check mark appears after each file name in the list. You can import the individual images.
6. Click on the Apply button at the top of the Processing tab.
The individual images are imported and combined to form a Z-stack image. You have successfully
imported a Z-stack image from individual images.
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11 Customizing the Application
11.1 Selecting a Screen Design
In the upper right corner of the program window under Design you can select a Light or Dark
screen layout . Optionally, you can change the design with the shortcut Ctrl+D.

11.2 Customizing Toolbar
Prerequisite ü You are in the Tools menu | Customize Application dialog.
ü The Toolbar tab is selected by default.
1. Click on an entry in the Available Toolbar Items list.
à You will see a list of all available items in this group.
2. Double-click on an item.
à The item will be added to the Selected Toolbar Items list and does appear in the Toolbar within the application. Alternatively you can add the items per Drag&Drop.
3. In order to change the order of symbols in the toolbar use the Up/Down buttons.
4. If you want to delete an Icon from the toolbar, click on the
Delete button.
5. Click on Close button to close the dialog. The changes will be effective right now.
You have successfully customized the Toolbar.

11.3 Adjusting the Workspace Zoom
1. To zoom in or out of the workspace move the slider left or right.

2. To reset workspace zoom to default click on Reset button.
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11.4 Showing/Hiding Workspace Areas
1. Click on show/hide buttons to show or hide areas.

11.5 Undocking/Docking Tool Windows
This function allows you to undock/dock a tool window. An undocked tool window can be positioned anywhere on the screen.
1. Click the Undock button to undock a tool window. Once undocked, the tool window can
be moved around by clicking and dragging it on the blue bar.

2. Click the Dock button to dock a tool window back to its place in the left tool area.

Info
With the dock all tools function in the Workspace Configuration you can globally attach all
undocked tool windows back to the Left Tool Area
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12 Software Modules & Extensions
12.1 Advanced Processing
12.1.1 Experiment Feedback
Experiment feedback (also known as conditional or adaptive experiments) allows you to define
specific rules and actions to be performed during the acquisition of an experiment. It is possible to
change the course of an experiment depending on the current system status or the nature of the
acquired data during acquisition. Moreover, it is possible to integrate certain tasks like data logging or starting of an external application, directly into the ZEN experiment. A typical use-case is
to connect the image acquisition with automated image analysis.
Feedback experiments can be set up and controlled with the Experiment Feedback Tool [} 736]
and the Script Editor [} 737]. Experiment feedback functionality is a part of the Advanced Processing module. For an example workflow for experiment feedback, see Workflow Experiment
Feedback [} 240].
Please note that we will not describe experiment feedback in detail here, as you will find a detailed instruction on how to perform feedback experiments and a lot of tutorials on the latest ZEN
DVD in the folder ......Manuals/ZEN(blue edition)/OAD Content/Experiment Feedback.
Key Features
§

Create smart experiments and modify the acquisition on-the-fly based on online image analysis, hardware changes or external inputs (e.g. TTL signals).

§

The adaptive acquisition engine allows modifying running experiments according to the rules
defined inside the feedback script.

§

The feedback script uses ZEN commands in combination with the Python programming language

§

The feedback script gives access to the current system status and results from the online image analysis during runtime of an experiment.

§

Data Logging or starting an external application (e.g. Python, Fiji, MATLAB, . . . ), directly from
within the imaging experiment is possible.
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12.1.2 Workflow Experiment Feedback

Fig. 12: Workflow Experiment Feedback
In the figure you can see the typical workflow of an Experiment Feedback experiment and the
most important steps involved. The yellow boxes Define Experiment, Define Image Analysis
and Define Rules and Observables show the most important steps for setting up a feedback experiment.

Step

Description

Define Experiment

Set up and configure the actual image acquisition experiment to
obtain the desired image data, e.g. time lapse, Z-stack, multichannel, tile acquisition etc. Once the setup of the acquisition is
completed, you acquire sample data which will be used in the
following step to setup and test the image analysis setting.

Define Image Analysis

Sets up an image analysis setting via the Image Analysis Wizard
for the use inside the feedback script, if an analysis step is required. Only parameters specified in the image analysis setting
can later be accessed from within the experiment feedback
script. Test the image analysis setting to ensure the results of the
image analysis are meaningful.
For more information on the Image Analysis Wizard, see Creating
a new image analysis setting [} 369].
For advanced analysis requirements it is also possible to use an
OAD macro to create an image analysis setting (*.czias file).

Define Rules and Observables

This step defines how the script actually works. Here, you define
the rules in the feedback script, e.g. which parameters are observed and how the experiment should react when a certain
event occurs.
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Step

Description

Start Experiment

Start the Experiment Feedback experiment and watch the output. The general concept behind this workflow can be described
as a loop, which is the actual acquisition. For every event, e.g.
when a new image has been acquired, the script will be executed. The rules are checked and if required, certain tasks are
carried out. Additionally, it is possible to log data into a text file
and/or start an external application at any time point during the
experiment.

See also
2 Script Editor for Experiment Feedback Dialog [} 737]
12.1.2.1 Editing the Feedback Script
To use the Experiment Feedback tool, you need to edit the feedback script.
The main loop script run will only be triggered, when an observable that is used in the main loop
script has changed. If the parameters within the loop script do not change, the script will not be
executed.
These changes can be:
§

A new image has been acquired

§

The XYZ position has changed

§

The status of a trigger port has been altered

§

The settings for filter, objective, light source etc. have changed

§

The incubation parameters have changed

For advanced use cases it is possible to execute the script with the command RunLoopScript in
conjunction with a timer.
1. Select Acquisition tab | Experiment Feedback tool | Edit Feedback Script.

à The Script Editor for Experiment Feedback dialog opens. For more information, see
Script Editor for Experiment Feedback Dialog [} 737]
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2. Create and edit the feedback script in the following sections: the PreLoop Script, the
Loop Script and the PostLoop Script. To do so, use the commands on the Command
tab. Add observables and actions to your experiment feedback script either via double-click
or drag-and-drop. All observables and actions are also available via IntelliSense auto-completion starting with ZENService.
3. If an image analysis is part of your feedback experiment, you can select an existing image
analysis you previously created. Select Command tab | Available Observables section |
Analysis drop-down menu.
à A list of the features that were defined in this image analysis setting, e.g. number of cells
detected, is displayed. If you selected an image analysis setting and use one or more features in the feedback script, this image analysis setting is executed for each acquired image. Note that only features you have previously defined in the Image Analysis Wizard
are available from within the Feedback Experiment. If you make any changes within the
image analysis wizard to an existing *.czias file you need to reload it in the feedback
script editor to activate the changes in the feedback experiment.
4. Click OK.
à The existing code is validated. You can only save and close the script editor if the code is
free from syntax mistakes.
The feedback script will be stored as part of the experiment file *.czexp.
12.1.2.2 Selecting script runtime conditions
The script runtime conditions describe how the different steps of the experiment Feedback
Script are executed. You can choose between Free Run and Synchronized execution.
1. Select Acquisition tab | Experiment Feedback tool, and select Free Run.

à The execution of all steps of the Feedback experiment are independent and not executed
sequentially.
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1. Select Acquisition tab | Experiment Feedback tool, and select Synchronized.

2. Click on the blue buttons to define the script slot and to change the execution order of the
script.
à The selected steps are executed sequentially.
§

The script run starts after the acquisition together with the online image analysis. Therefore,
the script execution, image analysis and writing of the image subblock to the hard drive are
not in sync.

§

The online image analysis starts after the acquisition of a frame is finished. Only when the image analysis is finished, the next script run is triggered. This guarantees that all analysis results
exist and can be used in the feedback script. The writing to disk is not synchronized.

§

The online image analysis starts after the acquisition of a frame is finished. The image data are
written to disk and only when all tasks are finished the next script run is triggered. This guarantees, that all analysis results exist and the image data is stored on disk before the next
script run is triggered. This option is relevant in case the script starts an external application to
analyze the data.
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12.2 APEER (on-site)
This module enables you to execute modules of the APEER platform with ZEN (blue edition).
APEER is an online platform to create customized workflows for image processing tasks of your
microscopy images. For more information, see https://www.apeer.com. This module for ZEN (blue
edition) is only available with the corresponding license.

12.2.1 System Requirements
To use the APEER on-site module locally on your Windows PC, your system needs to fulfill the
following requirements to run the Docker software:
§

Windows 10 64-bit: Pro, Enterprise, or Education (Build 16299 or later)

§

Hyper-V and Containers Windows Features must be enabled (for more information, see also
https://techcommunity.microsoft.com/t5/itops-talk-blog/step-by-step-enabling-hyper-v-foruse-on-windows-10/ba-p/267945)

§

BIOS-level hardware virtualization support must be enabled

§

64 bit processor with Second Level Address Translation (SLAT)

§

4GB RAM

These are the system requirements of Docker (as of September 2020) and they are subject to
change. For the current system requirements of Docker, please refer directly to the information
page for the Docker installation (https://docs.docker.com/docker-for-windows/install/).
System Performance Disclaimer
To use APEER on-site, Hyper-V needs to be enabled in Windows. Please be aware that this might
affect the overall PC system performance and, therefore, could lead to longer processing times or
to reduced acquisition performance in ZEN (blue edition). If you encounter performance issues it is
recommended to turn off Hyper-V again. The ideal case would be to use APEER (on-site) on a
dedicated, powerful workstation that is not directly attached to a microscope. Enabling the BIOS
level hardware virtualization did not influence the system performance and can be left switched
on.
Hardware Recommendations:
§

ZEISS MidRange Workstation

§

64 GB RAM or more (32 RAM dedicated to Docker Desktop)

12.2.2 Preliminary Work / Prerequisites
Following prerequisites need to be fulfilled to use this module:
§

Create an APEER Account
In order to use the functionality and download the APEER modules, you need an account on
the platform. Go to https://www.apeer.com to sign up.

§

Install Docker
To be able to use your APEER modules locally on your machine, you also have to install the
software called Docker (https://www.docker.com) which automates the deployment of code
inside software containers. For installation instructions on a Windows PC, see https://
docs.docker.com/docker-for-windows/install. You then have to manually allow access to your
hard drive. After the installation, start Docker and go to Settings > Shared Drives. There
you have to activate the checkbox for your hard drive (C) and click on Apply.
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§

Set up a remote Linux machine
If you want to execute the APEER modules on a remote computer, you have to set it up. Currently only Linux machines running Docker are supported for the remote execution. For information on how to set up such a computer, please ask your local IT administration/department.

§

Create a shared folder
If you want to execute the APEER modules on a remote computer, you additionally have to
create a folder to which both computers have access to over the network.

12.2.3 Creating and entering an API key
For the APEER modules, you also need an API key. Take the following steps to create the key and
enter it in ZEN.
Prerequisite ü Your PC has a connection to the internet and you are signed in on the APEER platform.
ü You have started ZEN.
1. Click on Tools > Options > APEER.
2. Click on the link above the input field (https://www.apeer.com/app/user/client-keys).
à In your browser, the page for your personal access tokens opens.
3. Click on New Access Token to create a new access token.
4. In the New Access Token window, enter a name, an expiration date, and select the desired access scopes for the token.
5. Click on Next.
à Your personal access token is created and displayed.
6. Copy your Personal token.
7. Go back to ZEN to Tools > Options > APEER and paste the token into the input field.
8. Under Default Execution Location, click on
.
9. Select a location where the module is executed on your computer and your results are
saved and click on OK.
10. Click on OK to apply the settings and close the Tools > Options window.
You have now created and entered an access token. You can now use APEER functionality in ZEN.

12.2.4 Setting up the remote module execution
If you want to execute the APEER modules on a remote Linux machine, you have to connect ZEN
to this computer.
Prerequisite ü Your PC is connected to the network with the remote computer.
ü You have set up a folder to which both PCs have access.
1. Go to Tools > Options > APEER.
2. In the Choose Execution Mode dopdown, select Use Remote Docker Host.
3. For Remote Docker Host API Address enter the address and port number of the remote
computer.
4. Click on Check Connection.
à ZEN contacts the remote computer with the given address and displays a green checkmarks if the connection was successful. Otherwise a red x is displayed and you have to
correct the address and/or port information for the remote computer.
5. If your remote computer requires an authentication, select it from the Choose Authentication Mode dropdown and provide the required credentials (username and password or a
certificate, depending on the selected mode).
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6. Map the folder path for the execution of the module and saving of results on your local
computer to the path of the same folder on the remote computer. For detailed information,
see Create a path mapping [} 246].
7. If you want to save the settings, click on Export Remote Settings, select the location in
the file browser, and click on Save.
8. Click on OK to save the setup and close the dialog.
You have successfully set up the remote execution. Your modules are now executed on the selected remote computer. For more information, see Executing APEER modules in ZEN [} 247].

See also
2 APEER Tab [} 642]

12.2.5 Create a path mapping
To execute an APEER module on your remote computer, you have to have a folder to which both
PCs have access to. You then have to tell ZEN which folder it is and what the corresponding directory for this very same folder looks like for the remote computer. Since currently only Linux machines can be used for the remote task, the file systems on both PCs are different and the folder
paths need to be mapped to one another.
Prerequisite ü You have set up a folder to which both PCs have access.
ü You are in Tools > Options > APEER.
ü For the Choose Execution Mode dopdown, Use Remote Docker Host is selected.
1. In the Local To Remote File System Mapping section, click on
à The Edit Mapping Dialog [} 643] opens.

.

2. For Local Computer Path, click on
.
à A file browser opens.
3. Select the shared folder to which both PCs have access to and click on OK.
4. For Remote Computer Path, enter the path to the same folder on the remote computer.
If you do not know the directory path, please contact your IT department or person who
set up the remote computer.
5. Click on Check Mapping to see if the two directories are correctly pointing to the same
folder.
à ZEN contacts the remote computer with the given address and displays a green checkmarks and corresponding message if the connection was successful. Otherwise a red x is
displayed and you have to correct the path mapping.
6. Click on OK.
You have successfully mapped the folder path of your local computer to the one on the remote
computer. You can now (continue to) set up the remote execution, see Setting up the remote
module execution [} 245].

12.2.6 Downloading an APEER module
Prerequisite ü You have done all the preliminary work and created an APEER API key. See also Creating and
entering an API key [} 245].
ü Your PC is connected to the internet.
ü You have started ZEN.
1. On the Applications tab, open the APEER On-Site: Module Manager tool.
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2. Click on Download Modules from APEER.
à A browser window opens.
3. In the browser window, select the module(s) you want to download and click on OK.
à The download of the module(s) starts.
After a successful download the module is displayed in the APEER On-Site: Module Manager
tool. It can now be used in ZEN.

See also
2 APEER On-Site: Module Manager [} 249]
2 APEER (on-site) [} 244]

12.2.7 Executing APEER modules in ZEN
Prerequisite ü You have downloaded an APEER module. For more information, see Downloading an APEER
module [} 246].
ü If you execute the module on a remote computer, both PCs have to be connected via network
and have access to the defined shared folder. See also Setting up the remote module execution [} 245].
1. On the Applications tab, open the APEER On-Site: Module Execution tool.
2. For module, select the module you want to use locally from the dropdown list.
3. If applicable, you can then select which Version of the selected module you want to use.
à The Module Parameters of the selected module are displayed.
4. Under Module Parameters, set the your parameters.
5. If your module supports multiple inputs and you want to use the module on more than one
image, activate the checkbox Use Batch Mode.
6. Under Module Input, click on
and select the input image(s) which should be processed by the module.
7. Select the Execution Settings Location where the module is executed on your computer
and your results are saved.
8. Click on Execute Module.
à Your selected APEER module is now executed.
9. To check the status and see the last executed modules, can click on Browse Results to
open the APEER Executions Browser [} 250].
You have successfully executed an APEER module.

See also
2 APEER On-Site: Module Manager [} 249]
2 APEER On-Site: Module Execution [} 250]

12.2.8 Example for APEER on-site
This chapter shows you how to download an APEER module and use it locally. For the purpose of
this example, the Auto Thresholding module is downloaded and used locally.
Prerequisite ü Your PC is connected to the internet.
ü You have started ZEN.
ü You have created an API key and entered it in Tools > Options > APEER. For more information, see Creating and entering an API key [} 245].
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1. On the Applications tab, open the APEER On-Site: Module Manager tool.
2. Click on Download Modules from APEER.
à A browser window opens.

3. Select Auto Thresholding and click on OK.
à The download of the module starts.
à After a successful download the module is displayed in the APEER On-Site: Module
Manager tool.

4. On the Applications tab, open the APEER On-Site: Module Execution tool.
5. In the Module dropdown list, select Auto Thresholding.
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à The parameter of the module Auto Thresholding are now displayed in the tool.

6. If applicable, you can change the Version of the module.
7. If you want to use the module on multiple images, activate the checkbox Use Batch
Mode.
8. For input_image, click on
and select your input image(s).
9. For Execution Settings Location, select a location where the module is executed on your
computer and your results are saved.
10. Click on Execute Module.
You have now downloaded the APEER module Auto Thresholding and executed it with ZEN.

12.2.9 Functions & Reference
12.2.9.1 APEER On-Site: Module Manager

Parameter

Description

Local Available
Modules

Displays a list with all the downloaded and locally available APEER
Modules. Click on

to display a short description of the respective

module and to have the possibility to delete it by clicking on
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Parameter

Description

Download Modules from APEER

Opens a browser window to download APEER modules. For more information, see also Downloading an APEER module [} 246].

See also
2 APEER (on-site) [} 244]
12.2.9.2 APEER On-Site: Module Execution

Parameter

Description

Module

Selects the module you want to execute locally. Displays all downloaded modules in a dropdown list.

Version

Sets which version of the currently selected module should be executed.

Module Parameter

Displays and sets all the parameters of the currently selected module.

Module Input

Selects the image(s) for which the module is executed.

–

–

Use Batch
Mode

Only available for modules that support multiple input images.

Batch Input

Only available for modules that support multiple input images and if
Use Batch Mode is activated.
Selects the input for Batch execution.

input_image

Activated: Enables the selection of multiple input images.
Deactivated: The input can only select one image.

Selects the input with a click on

.

Execution Settings
Location

Sets the path where the execution is located and where the results
are saved.

Stop Batch execution on error

Only available for modules that support multiple input images and if
Use Batch Mode is activated.
Activated: Stops the Batch execution if an error occurs.

Execute Module

Executes the selected module.

Browse Results

Opens the APEER Executions Browser [} 250].

See also
2 APEER (on-site) [} 244]
2 Executing APEER modules in ZEN [} 247]
12.2.9.3 APEER Executions Browser
This browser displays the last executed modules with detailed information.

Parameter

Description

Filter

–

Client or Username contains

Filters the executions that contain the characters entered in this field
as part of the client and/or username.
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Description

–

Status

Filters the executions that have the status that is selected from this
dropdown list.

–

Update Results

Updates the list of executions according to the filters.

List of Executions

–

Module Name

Displays the name of the executed module.

–

Start

Displays the start date and time.

–

Last Update

Displays date and time of the last update.

–

Status

Displays the status of this execution.

–

Client / Username

Displays the name of the client and user that started the execution.

–

Open Results

Opens a file browser at the location the results are saved.

–

Open Log

Open the log file for this execution.

–

Details

Opens the Details for APEER Execution Dialog [} 251].

12.2.9.3.1 Details for APEER Execution Dialog
Displays details for this APEER execution.

Parameter

Description

Module Name

Displays the name of the executed module.

Module Version

Displays the version of the executed module.

Start Date

Displays the start date and time.

Last Update

Displays date and time of the last update.

Current Status

Displays the current status of the execution.

Starting Client

Displays the name of the client that started the execution.

Starting User

Displays the name of the user that started the execution.

Results Directory

Displays the directory where the results are saved.

Status History

Displays the status history with date and time for each status the execution had.

Ok

Closes the dialog.

Open Results

Opens a file browser at the location the results are saved.

Open Log

Open the log file for this execution.
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12.3 APEER Workflows (online)
With this extension you can connect the ZEN software with the APEER platform (https://
www.apeer.com). It provides the following functionality:
§

Connect ZEN software to the APEER platform

§

Start workflows (including upload of the current image)

§

Optional: Download of workflow results

The current version of the APEER Workflows (online) is deployed together with the software. You
will find additional information also on the APEER Wiki under https://docs.apeer.com/ and the APPER user forum under https://forum.apeer.com/.
Prerequisites
§

Create an APEER Account
In order to use the functionality and download the APEER modules, you need an account on the
platform. Go to https://www.apeer.com to sign up.

§

API key
To use the functionality in ZEN, you need an API key. For detailed information, see Creating
and entering an API key [} 245].

12.3.1 Starting Workflows
Prerequisite ü You have acquired an image.
ü You have created an API key and entered it in ZEN. For more information, see Creating and
entering an API key [} 245].
1. On the Processing tab, select the APEER image processing function Start Workflow.
2. In the Input tool, select an image as an input for the workflow. Note that the desired images must be opened in ZEN.
3. In the Parameters tool, select an APEER workflow from the dropdown list under Workflow.
4. If you want to download the workflow results to your local computer, activate the checkboxes Wait for workflow finished and Download workflow results.
5. If you want that the workflow results are automatically opened in ZEN, activate the checkbox Display workflow results.
6. Click on Apply to execute the workflow.

12.3.2 Uploading Files
Prerequisite ü You have acquired an image.
ü You have created an API key and entered it in ZEN. For more information, see Creating and
entering an API key [} 245].
1. On the Processing tab, select the APEER image processing function Upload Files.
2. In the Input tool, select the image for the upload. Note that the desired images must be
opened in ZEN.
3. Click on Apply to upload the selected image.
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12.3.3 Functions & Reference
12.3.3.1 Start Workflow
With this image processing function you trigger a workflow on the APEER platform from ZEN. For
more information, see Starting Workflows [} 252].

Parameter

Description

Workflow

Selects a workflow from the APEER platform.

Wait for Finished
Workflow

Activated: ZEN waits until the workflow is finished on the APEER
platform.

Download Workflow Results

Only available if Wait for workflow finished is activated.

Display Workflow
Results

Only available if Download workflow results is activated.

Storage

Sets the storage location for the download of the workflow results.

Activated: Downloads the workflow resultss from the APEER platform to your local computer.

Activated: Displays the workflow results in ZEN after they have been
downloaded from the APEER platform.

See also
2 APEER Workflows (online) [} 252]

12.4 Automated Photomanipulation
This module is exclusively available for the Celldiscoverer 7 and allows automated photoactivation and bleaching at multiple positions. It is not applicable to Tile Regions. Using this module, the
system executes the following experiment steps without user interaction:
§

Acquisition of a multi-position image as defined in the Tiles Tool [} 531].

§

Identification of the photomanipulation ROIs based on a customized image analysis that was
defined beforehand in the Image Analysis Wizard [} 777].

§

Photomanipulation experiment as defined for Bleaching and in the Time Series Tool [} 732].

For Automated Photomanipulation you need the license for the Automated Photomanipulation
module and the Image Analysis license. The module is activated in Tools > Modules Manager >
Optional Software and the tool for the model is displayed on the Applications tab.

12.4.1 Using Automated Photomanipulation settings
Automated Photomanipulation offers you the possibility to save your whole experiment setup in a
settings file.
Creating an Automated Photomanipulation setting
1. On the Applications tab, open the Automated Photomanipulation tool.
2. Click on Options

and select New.

3. Name the setting and press Enter or click on

.

You have created a setting for Automated Photomanipulation.
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Saving an Automated Photomanipulation setting
When you have set up your Automated Photomanipulation experiment and created a setting, you
can save the setup as a setting.
1. Click on Options

and select Save.

Your experiment setup is now saved.
Importing and exporting an Automated Photomanipulation setting
1. On the Applications tab, open the Automated Photomanipulation tool.
2. Click on Options
and select Import or Export.
à A file browser opens.
3. Select the file you want to import or the folder where you want to export the setting to.
4. Click on Open / Save.
You have now imported/ exported a setting.
Deleting an Automated Photomanipulation setting
1. On the Applications tab, open the Automated Photomanipulation tool.
2. Select the setting you want to delete in the dropdown list.
3. Click on the Options
and select Delete.
4. Confirm that you want to delete the file.
The selected setting is deleted.

See also
2 Automated Photomanipulation Tool [} 255]
2 Performing an Automated Photomanipulation experiment [} 254]

12.4.2 Performing an Automated Photomanipulation experiment
For a successful Automated Photomanipulation experiment, you have to prepare a photomanipulation experiment at multiple positions and an image analysis setting.
Prerequisite ü You have activated the Automated Photomanipulation module in Tools > Modules Manager > Automated Photomanipulation.
ü You have defined and saved a suitable experiment for photomanipulation at multiple positions (including Tiles, Bleaching, and Time Series).
ü You have defined experiment positions in the Positions section of the Tiles tool. For more information, see Positions Section [} 535].
Important: Photomanipulation with Tile Regions is not supported!
ü On the Acquisition tab, you have selected if the photomanipulation should be executed at
All Tile Regions per Time Point (e.g. for photoactivation) or as Full Time Series per Tile
Region (e.g. for photobleaching).
ü You have defined photomanipulation settings in the Timed Bleaching tool. For more information, see Timed Bleaching Tool [} 762].
ü You have defined a suitable image analysis setting using the Image Analysis Wizard or an
OAD macro that detects the regions of interest where the photomanipulation should be executed. For more information, see Creating a new image analysis setting [} 369].
Important: The classes in the analysis and their corresponding channel names must exactly fit
to the channel names in the experiment!
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1. On the Applications tab, open the Automated Photomanipulation tool.
2. Create a setting to save your experiment setup. For more information, see Using Automated Photomanipulation settings [} 253].
3. For Experiment, select the experiment you want to use for photomanipulation. For more
information, see Set up a new experiment [} 44].
Note: You have to acquire a snap and draw one Experiment Region. Bleaching must be
activated. This enables you to define the settings for Timed Bleaching. This Experiment
Region is not used for the photomanipulation experiment.
4. For Analysis, select a suitable setting to analyze the multi-position image.
5. For Class, use the dropdown list to select the appropriate class / channel to identify the
photomanipulation regions of interest.
6. For Sorting Feature, define the acquisition order of the ROIs for photomanipulation. This
step depends on the selected features in the analysis (e.g. ID, mean intensity in channel x,
perimeter etc.). Per default, the photomanipulation per position is executed in the descending order of the IDs.
7. For Region Type, define the ROI shape and maximum ROI number per position for photomanipulation.
8. For Output Folder, define the folder where you want to store the experiment data.
The complete experiment including all positions and photomanipulation events is stored as
one .czi file. This folder also contains the first scanned image for ROI identification (InitialAnalysisSettingImage.czi) and the table of the ROIs (SingleObjectsTable.csv).
9. Click on Start.
à A InitialAnalysisSettingImage.czi image is acquired to identify the ROIs for photomanipulation and saved to your folder. The ROIs are listed in the SingleObjectsTable.csv table.
They are automatically imported as Experiment Regions for photomanipulation.
à Then the photomanipulation experiment at multiple positions is executed.
à In the Mean ROI tab of the resulting .czi file, the bleach markers are shown.
à To check the ROI selection, you can analyze the InitialAnalysisSettingImage.czi with the
predefined analysis.
à The Start button turns into a Stop button as long as Automated Photomanipulation is
running. Click on Stop to stop the running Automated Photomanipulation workflow.
You have successfully performed a Automated Photomanipulation experiment.

12.4.3 Functions & Reference
12.4.3.1 Automated Photomanipulation Tool

Parameter

Description

Options

–

New

Creates a new Automated Photomanipulation setting. Enter a name
for the setting.

–

Rename

Renames the setting.

–

Save

Saves the current setting.

–

Save as

Saves the current setting under a new name. Enter a name for the
setting.

–

Import

Imports an existing setting.
The setting is shown in the setting dropdown list.
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Description

–

Export

Exports the current setting.

–

Delete

Deletes the current setting.

Experiment

Selects the experiment setup to execute the photomanipulation including Tiles, Time Series and Bleaching.

Analysis

Selects the image analysis setting used to analyze the multi-position
image to define the Experiment Regions for photomanipulation.

Class

Defines the class / parameter to find the photomanipulation experiment regions.
Important: The classes in the analysis and their corresponding channel names must exactly fit to the channel names in the experiment.

Sorting Feature

Defines the acquisition order of the Experiment Regions for photomanipulation depending on the selected features in the analysis (e.g. ID,
mean intensity in channel x, perimeter etc.).

Region Type

Defines the shape of the photomanipulation area: Polygon, Circle,
Rectangle, Custom Circle/Rectangle (Size and Offset adjustable), Circle, and Rectangle are bounding / containing the detected photomanipulation regions.

Max. Number

Defines how many photomanipulation ROIs per position should be executed.

Offset

Only visible if Custom Circle or Custom Rectangle is selected.
Defines the Experiment Regions offset of the Custom Circle/Rectangle
in X and Y direction.

Size

Only visible if Custom Circle or Custom Rectangle is selected.
Defines the Experiment Regions size of the Custom Circle/Rectangle in
width and height.

Output Folder

Selects the folder where the experiment results are saved. A subfolder
will automatically be created for each run of an Automated Photomanipulation experiment, including the pre-bleach image for Experiment
Regions identification, the table of all Experiment Regions, and the experiment results.

Start

Starts the Automated Photomanipulation. The experiment can be
stopped with the Stop button in the Acquisition tab. Click on Stop
to stop the running Automated Photomanipulation workflow.

See also
2 Automated Photomanipulation [} 253]
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12.5 Confocal Topography
This module includes the following functionality:
Topography Acquisition
With the Topography Tool you can acquire and inspect surfaces or surface structures of different sample types (e.g. wafer plates, solar cells). By the help of the Topography Measurement
Wizard you can perform an confocal image acquisition of your sample. The advanced analysis of
the topography image is performed by the help of the ConfoMap software which is included in
the software package.
In the chapter Functions & Reference you find detailed functional descriptions of the Topography Tool [} 265] and the Topography Measurement Wizard [} 265].
In the chapter Workflow Topography Acquisition you find a detailed how-to guide for topography acquisition, see Introduction.
Layer Thickness Measurement
With the Layer Thickness Measurement Tool you can acquire z-stacks and perform layer
thickness measurements of one or more transparent layers (e.g. coatings, alloys). Here as well, the
Layer Thickness Measurement Wizard will guide you through the process. The measured values can be corrected by the refractive index of the coating.
In the chapter Functions & Reference you find detailed functional descriptions of the Layer
Thickness Measurement Tool [} 267] and the Layer Thickness Measurement wizard [} 267].
In the chapter Workflow Layer Thickness Measurement you find a detailed how-to guide for
layer thickness measurement, see Introduction.
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12.5.1 Acquiring Topography Images
If you want to acquire a topography image in ZEN, you need to start the topography measurement wizard.
Prerequisite ü You are on the Applications tab.
1. In the Topography tool, click on Start.
à The wizard starts. In the left tool area you see the Step 1/2 Setup, in which you can adjust the acquisition parameters for the topography image. In the center screen area you
see the live image from your sample in continuous mode.
As a default the system is set up to acquire only one single z-stack. In case your region of
interest (ROI) is all within your field of view (FoV) continue with step 5 of this guide. If
your ROI is bigger than your FoV, you can setup a tiles acqusition in the Tiles tool:
2. In the Tiles tool, enter the number of desired tiles in the X and/or Y direction input fields,
e.g. 3 x 3. This will create a 3 x 3 tiles image with 9 single tiles.

3. Click on Set stage position to define the anchor point of your tile scan at the current
stage position.
4. In the Navigation (must be expanded first) section click on the arrow buttons to navigate
through the single tile images. This can help to check if the tiles cover the full ROI.
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5. In the Acquisition Mode tool, adjust the settings for Objective, Frame Size, and Bits per
Pixel according to your requirements.

6. Focus on the surface. The default pinhole setting is Max. This allows you to easily focus on
the surface just like with a widefield microscope. Of cause focusing via the eyepieces is also
possible.
7. In the Channel tool, adjust the pinhole to the required diameter. For best performance of
the system we recommend to set the pinhole size to 1 Airy Unit (1AU button). Since the
depth of field is reduced in confocal images you most probably need to slightly adjust the
focus position.

8. Adjust the intensity of the laser. To do so focus on the brightest section of the z-stack. Then
adjust the laser either via the 405 nm slider or the Master Gain slider. Adjust the intensity
so that you do not see any overexposed pixels. (shown in red).

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

259

12 Software Modules & Extensions | 12.5 Confocal Topography

ZEISS

9. In the Z-Stack tool, set up the Z-Stack by adjusting the z-range (upper and lower limit of
your z-stack). We recommend to use First / Last mode for that.

à Make sure the whole surface, you want to measure, is within these limits. In case of a tile
scan you can use the navigation arrows in the Tiles tool to jump to the different tiles to
check.
10. Click on Next.
à The wizard moves to Step 2/2 Z-Stack Acquisition and starts the image acquisition.
à After image acquisition the topography image (height map) will be automatically generated. You will see the image in the center screen area after the acquisition and the processing is finished.
11. Adjust the thresholds by using the Noise Cut slider, if necessary. Note that pixels below the
lower threshold are displayed in blue color and pixels above the upper threshold in red
color.
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12. Finish your work in ZEN by choosing the following options:
- If you click on Export to Confomap the topography image will be directly opened in the
ConfoMap analysis software.
- If you click on Save Topography you can save the topography image to the file system.
- If you click on Save Z-Stack you can save the raw data of the z-stack.
You have successfully acquired a topography image. As the image analysis is performed with ConfoMap software read the ConfoMap documentation for further information.

12.5.2 Measuring Layer Thickness
If you want to perform layer thickness measurement in ZEN, you need to start the topography
measurement wizard.
Prerequisite ü You are on the Applications tab.
1. In the Layer Thickness Measurement tool, click on Start.
à The wizard starts. In the left tool area you see the step 1/3 Setup, in which you can adjust the acquisition parameters for the topography image. In the center screen area you
see the live image from your sample in continuous mode.
2. In the Acquisition Mode tool adjust the settings for Objective, Frame Size, and Bits per
Pixel according to your requirements.
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3. Focus on the surface. The default pinhole setting is Max. This allows you to easily focus on
the surface just like with a widefield microscope. Of cause focusing via the eyepieces is also
possible.
4. In the Channels tool, adjust the pinhole to the required diameter. For best performance of
the system we recommend to set the pinhole size to 1 Airy Unit (1AU button). Since the
depth of field is reduced in confocal images you most probably need to slightly adjust the
focus position.

5. Adjust the intensity of the laser. To do so focus on the brightest section of the z-stack. Then
adjust the laser either via the 405 nm slider or the Master Gain slider. Adjust the intensity
so that you do not see any overexposed pixels. (shown in red).
6. In the Z-Stack tool, define the z-stack by adjusting the z-range (upper and lower limit of
your z-stack). We recommend to use First / Last mode for that.
à Make sure that all layers, you want to measure, are within these limits. In case of a tile
scan you can use the navigation arrows in the Tiles tool to jump to the different tiles to
check.
7. Click on Next.
à The wizard moves to step 2/3 Sectioning and starts the image acquisition.
à After image acquisition and processing you will see the image in the center screen area.
8. Click on X-Z Layer or Y-Z Layer to create the corresponding cross section which you want
to analyze in detail.

9. Click on Next.
à The wizard moves to step 3/3 Measurement.
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à The selected cross section will appear on the right sight of the screen.

10. Draw in a profile perpendicular to your surface.
à The intensity distribution of your profile will appear left to the cross section.

11. Position the calipers on the maximum intensity of the profile.
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à A table with the measurement data will appear on top of the profile.

12. Click on Add measurement to table to transfer the data to the result table on the left.
Within the table you are able to rename the layers and calculate the true layer thickness by
adding the refractive index.
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13. Finally you have three options how to save your results:
- If you click Save table the result table is saved on the file system.
- If you click Save selected profile the drawn in profile is exported for further investigation
in third party software.
- If you click Save Z-Stack the raw data of the z-stack is saved on the file system.
You have successfully measured the layer thickness of your sample, saved the results table, the
profiles and the raw data of the z-stack.

See also
2 Layer Thickness Measurement Wizard [} 267]

12.5.3 Functions & Reference
12.5.3.1 Topography Tool

Parameter

Description

Image Acquisition

If this option is selected you can acquire an image by the help of the
Topography Measurement wizard.
The wizard guides you through the image acquisition. Then you can
export the image to ConfoMap for further processing.
The wizard is started by the Start button at the bottom of the tool.

Load Z-Stack

If this option is selected, you can load an existing confocal z- stack
from the file system.
Therefore simply click on the folder icon and select the z-stack image
from the file system. If you click the Start button, the Topography
wizard will directly switch to the last wizard step to apply the noise
cut and transfer the data to ConfoMap.

Automatic Noise
Cut

If activated, the wizard will automatically perform the noise cut filtering with the preset parameters in the tool.
If not activated, the noise cut filtering is an additional step in the Topography Measurement wizard.

-

Thresholds

Start

Here you can define thresholds for 8-bit and 16-bit images.
If you click on this button, the Topography Measurement Wizard
[} 265] is started.

See also
2 Layer Thickness Measurement Tool [} 267]
2 Layer Thickness Measurement Wizard [} 267]
2 Acquiring Topography Images [} 258]
12.5.3.2 Topography Measurement Wizard
When you have selected Image Acquisition in the Topography tool the Topography Measurement wizard consist of two steps:
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Step 1/2: Setup
This step allows you to choose an experiment or setup imaging parameters for a new image acquisition, e.g. number of tiles, acquisition mode or z-stack creation, see Step 1: Setup [} 266].
Note that when you have selected Load Z-Stack in the Topography tool and you start the wizard, this step is not available.
Step 2/2: Z-Stack Acquisition
The second step is Z-Stack Acquisition. The acquisition will be performed automatically. Additionally you can apply noise cut filtering. Pixels which are effected by the thresholds will be displayed
in red (upper threshold) or blue (lower threshold), see Step 2: Z-Stack Acquisition [} 266].

Info
The noise cut filtering will be skipped if the checkbox Automatic Noise Cut in the Topography tool is activated. The preset parameters will be immediately applied to the image and the
wizard continues with the export to ConfoMap.

See also
2 Topography Tool [} 265]
2 Layer Thickness Measurement Wizard [} 267]
2 Acquiring Topography Images [} 258]
12.5.3.2.1 Step 1: Setup
After the wizard is started, you will see the live image (Continuous mode) from your sample in the
Center Screen Area. You can setup the acquisition parameters in the left area of the screen. In the
next chapters the individual steps are described.
Note that these are default ZEN blue tools customized for acquisition of topography images, see
chapter Acquisition Setup Tools.

See also
2 Tiles [} 269]
2 Channel [} 269]
2 Acquisition Mode [} 270]
2 Z-Stack [} 272]
12.5.3.2.2 Step 2: Z-Stack Acquisition

Parameter

Description

Noise Cut

Here you can adjust the noise cut parameters manually. Therefore use
the slider or enter the lower and upper values in the input fields.

Save Surface

Save the image of the surface to the file system.

Export to ConfoMap

Exports the image to the ConfoMap software. The ConfoMap software will be started automatically after you have clicked the button.
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12.5.3.3 Layer Thickness Measurement Tool

Parameter

Description

Image Acquisition

If this option is selected you can acquire an image by the help of the
Layer Thickness Measurement wizard.
The wizard guides you through the image acquisition. Then you can
export the image to ConfoMap for further processing.
The wizard is started by the Start button at the bottom of the tool.

Load Z-Stack

If this option is selected, you can load an existing confocal z- stack
from the file system.
Therefore simply click on the folder icon and select the z-stack image
from the file system.

Start

If you click on this button, the Layer Thickness Measurement wizard (see chapter > [} 267]) is started.

See also
2 Topography Tool [} 265]
2 Topography Measurement Wizard [} 265]
2 Measuring Layer Thickness [} 261]
12.5.3.4 Layer Thickness Measurement Wizard
When you have selected Image Acquisition in the Layer Thickness Measurement tool the
Layer Thickness Measurement wizard consist of three steps:
Step 1/3: Setup
In this step you choose an experiment or setup the imaging parameters for a new z-stack acquisition e.g., track setup, acquisition mode, z-stack settings, see Step 1: Setup [} 268].
Step 2/3: Sectioning
In this step (orthogonal sectioning) you define the cross section of the sample, you want to analyze. Here, in addition to the center view (X/Y axis; blue frame), you will also see the section views
of the X/Z axes (top, green frame) and Y/Z axes (right, red frame), see Step 2: Sectioning [} 268].
Step 3/3: Measurement
In this step you draw one ore more intensity profiles in your cross section. In these profiles you
can measure and create tables containing the measurement results. Finally you can save the profile, the z-stack or the result table, see Step 3: Measurement [} 268].

See also
2 Layer Thickness Measurement Tool [} 267]
2 Topography Measurement Wizard [} 265]
2 Measuring Layer Thickness [} 261]
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12.5.3.4.1 Step 1: Setup
After the wizard was started, you see the live image (Continuous mode) from your sample in the
Center Screen Area. You can setup the acquisition parameters in the left area of the screen. In the
next chapters the individual steps are described. Note that these are default ZEN blue tools customized for acquisition of layer thickness measurement images.

See also
2 Channel [} 269]
2 Acquisition Mode [} 270]
2 Z-Stack [} 272]
12.5.3.4.2 Step 2: Sectioning
Here you can adjust the sectioning parameters.

Parameter

Description

X-Z Layer (green)

If selected the X-Z section will be used for further investigation.

Y-Z Layer (red)

If selected the Y-Z section will be used for further investigation.

Cut Lines

Here you adjust the position of the desired cut line. Therefore use the
slider or directly enter the position in the input field.

Mid button

If you click on this button, the corresponding cut line will be positioned in the middle (center) of the image.

Line Width

Here you adjust the line width of the corresponding cut line. Default
value is 1 (in pixel).

12.5.3.4.3 Step 3: Measurement
Here you can adjust the measurement parameters.

Parameter

Description

Profile mode

Here you can select the profile mode for the measurement:

-

Arrow

If selected, you can draw in an arrow in the profile. This will measure
the profile along the drawn in line of the arrow.

-

Rectangle

If selected, you can draw in a rectangle to the profile. This will measure the profile in the whole area of the rectangle.

Add measurement
to table

If you click on this button, the measurement result will be added to
the measurement table at the left side. In this table you can rename
your profile and correct the result by the refractive index.

Save selected profile

If you click on this button, the selected profile will be saved as .czt
file.

Save Z-Stack

If you click on this button, the Z-Stack image will be saved as .czi file.

Save table

If you click on this button, the table will be saved as .czt file.
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12.5.3.5 Tiles
Here you setup the tiles acquisition. The following parameters are available:

Parameter

Description

Number of Tiles

Here you can enter the desired number of tiles in X- and Y-direction.

Set stage position

If you click on this button, the current stage position is defined as
starting position for the tiles acquisition.

Start position
mode

Here you can define the alignment of the tile scan in respect of the
defined position.

-

Center

If selected, the start position is the center of the tile scan.

-

Upper Left

If selected, the start position is the upper left corner of the tile scan.

Navigation

Click on the arrow button to show the section in full.
Here you can check if each single image of your tile image is in focus
before you start the acquisition.
Navigate from on tile to another by using the arrow buttons or enter
the X/Y value, to check the set-up of your z-stack.

Start position

Displays the X and Y value of the starting position for the tiles acquisition.

12.5.3.6 Channel
With this tool you control and adjust the laser. The following parameters are available:

Parameter

Description

405 nm

Here you can set the required attenuation (in %) of the laser using the
slider, the arrows, or typing in the input field.

Pinhole

Adjusts the diameter of the pinhole.
The diameter is specified in micrometer. The text below translates this
diameter to Airy Units (AU) and section thickness.
For confocal topography measurements a pinhole size of 1 AU is recommended.

-

1 AU

Sets the pinhole diameter to the recommended value of 1 AU (Airy
Unit).

-

Max
(Default)

Opens the pinhole to its maximum diameter.

Master Gain

This is also the default setting for the pinhole. This allows you to easily
focus on the surface just like with a widefield microscope. Of cause
focusing via the eyepieces is also possible.
Here you can control the voltage of the PMTs. Higher voltage increases the gain of the PMT. The image becomes brighter and you
may be able to reduce the laser power. At higher voltage, the noise
level in the image increases.
The optimum between gain and noise depends on your experimental
requirements and on your sample. The maximum available voltage for
multialkali PMTs is 900V.
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Parameter

Description

Digital Offset

Here you can perform adjustments on the background of the image.

Digital Gain

Here you can digitally amplify the laser signal.

12.5.3.7 Acquisition Mode
Here you adjust scanning and acquisition parameters that you want to apply for the entire experiment.

Parameter

Description

Frame Size

Adjust the frame size (in pixel) of the displayed image by entering
the desired value in the two input fields.
To change the frame size you must stop the live image acquisition.

-

Presets button

By clicking on this button you can select from a list of default
frame sizes (e.g. 128 x 128 or 512 x 512).
In case of topography and layer thickness measurements we recommend to start with 1024 x 1024.

Scan Speed

Set the scan speed by adjusting the slider from 1 (slow) to 16
(very fast).
Note that the available maximum scan speed depends on the selected Frame Size and zoom factor.

-

Confocal button

By clicking on this button the frame size (image resolution) will
be set to an optimal value corresponding to the optical magnification (objective) and the zoom factor .
This provides an image where no information is lost and no
empty data are generated as optimal sampling is achieved. The
optimal value is calculated for the given objective and magnification settings matching a 2fold oversampling according to 2 fold
Nyquist. Rectangular image dimensions are preserved.

Direction

Following scanning directions can be selected:

-

Unidirectional

The laser scans in one direction only, then moves back to scan
the next line.

-

Bi-directional

The laser also scans when moving backwards, i.e. the scan time
is halved.
In case a pixel shift between forward and backward movement
(double image), resulting from bidirectional scanning, is visible,
use the Correction X / Correction Y sliders to correct it.
By clicking on the Auto button an automatic scan correction
will be performed.

Averaging

-

Number

Select the number of images you want to average (1 - 16).
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Description
Select the method which will be used for averaging:
§ Mean Intensity:
Uses the mean average of all images
§ Sum Intensity:
Uses the sum of all images.

-

Bits per Pixel

In the dropdown list you can adjust the color bit depth to 8 Bit
or 16 Bit (i.e. 256 or 65536 gray values).
To change the bit depth you must stop the live image acquisition.

Scan Area

In this section, you can adjust the position of the scan area.
The outer frame corresponds to the field of view of the microscope.
The inner frame represents the scan area. All changes (Offset,
Rotation, Zoom) made in this section will be immediately applied
to the scan area.
Following functions are available:

-

Offset

Adjust the offset by using the Left / Right or Up / Down sliders.
You can also enter a specific value in the input field.
If clicking on the C button behind the input filed the offset position will be reset to center position.
If you left click on the inner frame and hold down the mouse
button you can move the scan area freely. The positions in the
input fields will be adopted according to your adjustments.

-

Rotation

Adjust the rotation degree by using the Rotation slider. You can
also enter a specific value in the input field. If clicking on the O
button behind the input field the rotation degree will be reset to
default position (zero degree).

-

Zoom

Adjust the zoom level (from 0.5x - 40x) by using the Zoom
slider. You can also enter a specific value in the input field.
If you click on the 1/2 button behind the input field the zoom
level will be reset to default (0.5x).

-

Reset Scan Area

Resets all adjustment to the system defaults.
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12.5.3.8 Z-Stack
Here you setup the acquisition of the Z-Stack image.

Info
Z-stack images are always acquired from bottom to top automatically, irrespective of whether
you have defined the top or bottom Z-plane of your stack as the first Z-plane. This acquisition
sequence increases the accuracy of the Z-positioning.
For manually configuring Z-Stacks you have two modes available:

Parameter

Description

First / Last

If activated, you are able to configure the Z-stack via setting the first
and the last positions of the Z-stack, see Configuring a Z-Stack manually (First/Last Mode) [} 48].

Center

If activated, you are able to configure the Z-stack via setting the center plane of the Z-stack, see Configuring a Z-Stack manually (Center
Mode) [} 48].

Depending on which mode you have activated, you will see the following parameters for configuring the Z-stack:

Parameter

Description

Set Last/Set First

Only visible for First/Last mode.
By clicking on the Set Last and on the Set First button you determine the current position as last or first position of the Z-stack.

Range

Displays the range of the configured Z-stack from the last to the first
section plane.

Slices

Here you can enter the number of Z-slices that the Z-stack will have.

Interval

Here you can enter the desired distance between the Z-slices.

Optimal

The number on this button shows the distance calculated for the
channels set and the current microscope according to the Nyquist criterion. If you click on the button, this value is automatically adopted
into the Interval input field.

Keep

§ Interval:
Keeps the set interval between the section planes constant if you
change configuration parameters in the Z-Stack tool.
§ Slice:
Keeps the set number of Z-slices constant.

Center

Only visible for Center mode.
If clicking on this button the current position is set for the central Zplane. You can also enter the value in the input field to the right of
the button.

Offset

Here you can enter a value for an offset if desired.
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12.6 Correlative Array Tomography (CAT)
This module enables you to perform automated imaging of ultra-thin serial sections (ribbons) using the light- and scanning electron microscope. After calibration of the sample carrier and detection of the sections, regions of interest can be defined manually in a single section that will be automatically propagated to all sections. The selected regions of interest can then be imaged with
different contrast methods and magnifications using the LM.
In the SEM the previously defined regions of interest will then be imaged automatically after loading the image previously acquired at the LM. The corresponding 2D image sequences recorded by
the LM and SEM are aligned into a 3D Z-Stack using the integrated alignment and correlation algorithms of the ZEN Correlative Array Tomography module. This process results in a correlative 3D
data set combining LM and SEM information into one image volume.
For the correlative workflow, one CAT module has to be installed on the widefield system, a second module hast to be installed on the SEM. A detailed how-to guide of the workflow can be
found in the chapter The CAT Workflow [} 273].
The software module can be used with ZEISS widefield microscopes as well as with ZEISS scanning electron microscopes. In addition to the CAT tool the module offers four wizards. Detailed
descriptions of the functions of the tools and wizards can be found in the linked chapters.
§

Correlative Array Tomography tool, see CAT Tool [} 303].

§

Calibration Wizard, see Sample Holder Calibration Wizard [} 304].

§

Acquisition Wizard, see Acquisition Wizard [} 307].

§

Z-Stack Alignment Wizard, see Z-Stack Alignment Wizard [} 314].

§

Correlation Wizard, see Correlation Wizard [} 316].

12.6.1 Basics of Array Tomography
Array Tomography is a volumetric microscopy method employed to visualize and reconstruct 3D
images of serial sections. Tissue samples or cells embedded in resin are cut into consecutive sections with an ultramicrotome and collected onto a sample carrier (e.g. cover glass). The sequence
of the sections determines the z-position and allows the reconstruction of the 3rd dimension.
Therefore the z-resolution of the resulting 3D data set is determined by the thickness of the section.
The correlation of scanning electron microscope (SEM) data especially with an image acquired using a fluorescence light microscope (LM), enables the visualization of fluorescently labeled biological structures in their ultrastructural context not only in 2D but now in 3D with the ZEN Correlative Array Tomography module.

12.6.2 Sample Preparation
Type of Sample Carrier / Cover Glasses
We recommend cover glasses coated with Indium tin oxide and fiducials. Indium tin oxide minimizes charging effects in the scanning electron microscope. Cover glasses with fiducials enables
additional preparation steps after imaging the sample with the light microscopes and before
imaging with a scanning electron microscope.
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Deposition of Serial Sections on the Cover Glass
§

Sequence of serial sections
During serial sectioning, make sure that you know the sequence of the ribbons as well as the
start and the end point of the ribbons.

§

Positioning of serial sections on a cover glass
It is important to position the serial sections in the center of the cover glass. If the sections are
too close to the edge of the cover glass, it might happen that the objective touches the sample carrier during the image acquisition. This might happen particularly for immersion objectives. The consequence will be that the focus map is not calculated in the correct way or images are out of focus.

§

More than one ribbon (serial section) on a cover glass
Take care that the single serial sections are not in close contact to each other, this might confuse the numbering algorithm of the software and creates a wrong numbering.

12.6.3 Pre-Settings (Light Microscope)
Before you can start working with the CAT module, you have to check the following settings on
the light microscope system (hardware and software settings). In general the system is calibrated
by a service technician but we recommend to check the settings again especially when you have
changed components e.g. objectives or filter cubes. As these general settings are not described
here in detail please ask your service technician or read the ZEN Online Help.
§

Check Parcentricity and Parfocality
Note that the calibration of parcentricity and parfocality has to be done at the TFT display of
the microscope.

§

Check Camera Orientation and Stage Movement
Before checking the stage movement the correct camera orientation always has to be set first.
The camera orientation should match your view through the ocular of the microscope. If this
is not the case you can change the camera orientation in the Camera tool.
To check the stage movement we recommend to acquire a tiles image and check if the tiles
are put together correctly. If this is not the case you have to close ZEN software and open the
MTB 2011 software. There you must change the stage inversion in the configuration list under Motorized Stage.

§

Perform Shading Correction
Before starting the CAT workflow a shading correction has to be performed in ZEN software.
Please read the corresponding chapter in the ZEN Online Help.

12.6.4 Experiment Settings
For working with the CAT module you need to set up an experiment in the ZEN software first. As
this is already described in the ZEN Online Help, we will focus here on the most important settings
which are essential for the CAT workflow:
§

In the menu Tools | Options | Acquisition | Acquisition Tab the checkbox Enable Advanced Imaging Setup must be activated.

§

In the Imaging Setup tool Show All must be activated.

§

In the Imaging Setup tool Advanced Imaging Setup must be selected.

§

In the Imaging Setup tool in the lightpath display the following settings have to be adjusted:
– The Microscope Manager must be excluded from all settings. To exclude a setting, click on
the icon of the component / setting. You will see a menu where you can activate/deactivate
the checkbox Include in this Setting. If the checkbox is not activated, the component/setting is excluded from the selected setting. Note that you have to select each Before/After
setting and check if the components are excluded or included and adjust it accordingly.
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– The TL / RL Switch must be excluded from all settings.
– All TL / RL Shutters in the light path must be included in all settings. Note that icons of included settings are highlighted in blue color.
– All light sources (TL / RL ) within the light path must be included in all settings.
– The light intensity of the light sources for all settings must be the same (e.g. 2V).
§

In general for the Before Experiment and After Experiment settings adjust the following:
– All Shutters must be closed.

§

Example for Phase Contrast settings:
– For the Before TL Phase settings adjust the following:

- The TL Shutter must be opened
- The RL Shutter must be closed
– For the After TL Phase adjust the following:

- The TL Shutter must be closed
- The RL Shutter must be closed
§

Example for one Fluorescence Channel (here DAPI) settings:
– For the Before DAPI settings adjust the following:

- The TL Shutter must be closed.
- The RL Shutter must be opened
– For the After DAPI adjust the following:

- The TL Shutter must be closed.
- The RL Shutter must be closed
12.6.5 The CAT Workflow
In this chapter you will find how-to guides describing the typical CAT workflow. The chapter is for
users who search for an introduction to the CAT module and workflow. Starting from general
preparations to the acquisition on the LM (light microscope), we will also explain how to acquire
images with the SEM (Scanning Electron Microscope). After the image acquisition we will focus
on the image alignment and correlation.
Please note that we will not explain how to set up an experiment in detail as this step is beyond
the scope of this guide which is focused mainly on the CAT workflow. Instead of that please read
the chapter General Preparations [} 273], where we describe the most important pre-requisites
for a CAT experiment. We will not take a look at the further processing of the resulting images as
well.
12.6.5.1 Creating a new sample
If you have configured your experiment in ZEN (e.g. a multi-channel experiment) the next step is
to create and select a sample. When you work with the software for the first time you have to
create a new sample first.
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Prerequisite ü You are in the Correlative Array Tomography tool.

1. Click on Select / Specify.
à The Select Sample dialog opens.
2. Click on the
Add button under the List of specified samples.
à The New Sample dialog opens.
3. Enter the necessary sample information: Name, Description, Number of sample carriers,
Type of sample carrier and Section thickness.
4. Click on OK.
à The dialog closes. You will see the new sample in the List of specified samples.
5. Select the new sample from the list and click on OK.
You have created and selected a new sample.

Info
Note that specifying the correct number of sample carriers is important for the numbering of
the ribbons/sections afterwards. The sample information will be stored within the image data
and will be used for further image processing and data management.

12.6.5.2 Selecting the Sample Holder
Prerequisite ü You are in the CAT tool.
1. In the Sample Holder section click on Select… to open the Select Template dialog and
to choose the correlative sample holder you want to use. Different types of correlative
holders are available, see Appendix Correlative Sample Holders [} 318].

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

276

12 Software Modules & Extensions | 12.6 Correlative Array Tomography (CAT)

ZEISS

2. In the Select Template dialog select the correlative holder you want to use. If you want to
use your own sample holders, click on the
Add button below the list and follow the
instructions in the chapter Defining new sample holder templates [} 277].

3. Click on OK to close the dialog.
You can now continue with the calibration of the sample holder, as described in the chapter Calibrating the sample holder [} 278]. Note that the calibration of the sample holder is mandatory to
acquire images.
12.6.5.3 Defining a New Sample Holder Template
With this dialog you can define new correlative holders in addition to the existing holder templates. It is not mandatory to use correlative holders from ZEISS. User-defined correlative holders
with 3 fiducial markers can be used as well.
1. To open the dialog click on
Add in the Select Template dialog. This dialog can be
opened via the Shuttle & Find tool.
à The New Template dialog opens.

2. Type in a name for the new holder / sample carrier. An image of the new holder can be
loaded as well.
3. Insert the distances (in millimeters) between the first and the second marker and between
the second and third marker.
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à The distances can be determined using the Stage Control dialog accessible via the Light
Path tool in Right Tool Area tab. We recommend to do this before you start the New
template dialog. Write down the distances to be prepared to enter them within the New
Template dialog.
à Activate the live view in the Center Screen Area by clicking on the Live button in the Locate tab.
à Navigate the stage manually to the calibration marker on the sample holder by means of
the joystick and note the x/y-coordinates of the marker.
à Repeat this procedure for all three markers and calculate the distances between marker 1
and marker 2 and between marker 2 and marker 3, respectively.
12.6.5.4 Calibrating the Sample Holder
Correlative sample holders have three fiducial markers enabling a three point calibration (signed
with the numbers 1-2-3) The calibration markers consist of one small (length 50 µm) and a large
L-shape marker (length 1 mm). The bigger marker is used for coarse orientation, whereas the
smaller marker is used for the calibration.
12.6.5.4.1 Preparing Calibration
1. Click on Live in the Acquisition tab to activate the live view in the Center Screen Area.
2. Navigate the stage manually to the first calibration marker on the sample holder (marked
with No. 1) by means of the joystick. It is enough if you move the stage to the larger Lshaped calibration marker. The smaller marker will be detected automatically within the
Sample Holder Calibration Wizard.To locate the marker positions we recommend to use
a dry objective with low magnification (5x – 20x).

3. Open the CAT tool.
4. Click on Calibrate… to open the Sample Holder Calibration Wizard.
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12.6.5.4.2 Setting Calibration Options

Fig. 13: Sample Holder Calibration Wizard Options
In step 1 of the wizard, the following options should be activated to follow our recommended
workflow:
1. Check if the Automatic movement to next marker checkbox is activated.
à This will automatically move the stage to the next marker position after you have confirmed the position of the marker and clicked on Next.
2. Check if the Use automatic marker detection checkbox is activated.
à The software will try to find the correct positions of each marker automatically.
3. If you need to change the marker color, or check if the marker orientation is set correctly,
activate the Use settings for marker detection checkbox to access these functions.
4. Click on Next to move to the next wizard step.
12.6.5.4.3 Performing Calibration
1. Click on Set to detect the first marker position.
à An automatic stage calibration will be performed. After the stage calibration, the system
will try to detect the marker position of the small marker automatically.
à A message appears which asks if the marker was detected correctly.
2. Click on Yes to confirm the message.
3. Click on Next to move to the next step of the wizard.
à The stage will automatically move to the next (coarse) marker position. If the stage
moves into the wrong direction you can use the invert X / invert Y buttons to correct
the movement direction.
4. Repeat the previous steps and set marker position 2 and 3 accordingly.
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à After setting marker position 3 you will find a green check mark icon which shows that
the calibration was successful.

5. Click on Finish to save the calibration and close the wizard.
To check if the calibration was successful acquire an image and open the Tree view in the Center
Screen Area. There you should see the correlative calibration data in the list. If the Tree view is not
visible go to Tools | Options | Documents and activate the Enable Tree View checkbox.
12.6.5.5 Acquiring the LM image
The image acquisition will be performed by the help of the Acquisition Wizard which is opened
if you click on Start Acquisition Wizard in the Correlative Array Tomography tool.
The wizard contains the following 7 steps:
§

Overview Imaging [} 280]

§

Ribbon Definition (optional) [} 281]

§

Ribbon Imaging (optional) [} 282]

§

Section Specification [} 284]

§

ROI Specification [} 288]

§

ROI Imaging [} 289]

§

Re-Shoot (optional) [} 290]

12.6.5.5.1 Acquiring the overview image

Info
Take care that the Auto checkbox on the Dimensions tab is deactivated.

Prerequisite ü You have started the Acquisition Wizard via the CAT tool.
ü You are in step 1/7 Overview Imaging.
1. Check if Image Acquisition mode is selected. This is the default setting when entering the
wizard.
2. From the Experiment dropdown list select the experiment that you have prepared in advance.
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3. From the Objective list select an objective with a low magnification, e.g. 5x.
4. Select the Channel and the Light Source you want to use for acquiring the overview image. For the overview image we recommend to select Phase contrast as channel mode.
5. Move the stage to the upper left corner of your sample.
6. Click on Set start position to define the starting position of the overview image.
7. Move the stage to the bottom right corner of your sample.
8. Click on Set end position to define the end position of the overview image.
9. Click on Acquire Overview Image.
à The overview image will be acquired. Then you should see the complete sample showing
all ribbons you want to image.

10. Click on Apply Stitching to remove the offset between the single tile images.
You have successfully acquired the overview image. You can now continue with the next step by
clicking on Next.
12.6.5.5.2 Defining the ribbons

Info
When no detailed sample information is necessary to identify regions of interest within the sections, you can skip this step and the following step 3 Ribbon imaging as well. You can then go
on with the wizard step 4 Section specification [} 284].

Prerequisite ü You are in step 2/7 Ribbon Definition of the Acquisition Wizard.
1. Use the tools on the Ribbon Definition tab to mark the contour lines of the ribbons which
should be imaged. The contour lines are displayed in yellow color.
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à The software will automatically create as many tiles as necessary for imaging the ribbons.
The number of the tiles depend on the selected objective. The frames of the tiles will be
displayed in red color.

2. When you have marked the contours, click on Next.

See also
2 Specifying the sections [} 284]
12.6.5.5.3 Imaging the ribbons
Please note that this is an optional step and must be performed only when you have defined ribbons as described in step 2. In summary, you have to perform the same actions mentioned in step
1 but you should use an objective with higher magnification and apply the Global focus strategy
under Focus Surface.
Prerequisite ü You are in step 3/7 Ribbon Imaging.
1. Under Objective select an objective with a higher magnification than for the overview image, e.g. 10x. The objective should enable you to clearly recognize the structures of interest
on your sample.
2. Under Focus Surface select Global (all Regions/ Ribbons).
3. Click on Distribute Support Points....
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à The support points will be distributed automatically over the ribbons. They are displayed
as yellow circles with a point in the middle.

4. You can add further support points if necessary by using the Add button
below the
Distribute Support Points button. Simply click on the image at the position where you
would like to add another support point.
5. Click on Verify Support Points.
à Now you can check if each support point is
in focus. You will see the overview image in
the right image container and the detail image in the left image container. The verification process will start with the first support
point which was set. The current support
point is marked with a red crosshair. When
you activate Show stage position within
the image on the Ribbon Definition tab
below the Center Screen Area you will see
the current position of the stage in the image as a rectangle with a blue dashed frame.
6. Hold CTRL key and use the mouse wheel to adjust the focus for the corresponding support
point.
7. When the support point is in focus click on Confirm.
à The software will automatically move to the next support point.
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8. Repeat the last two steps until you have corrected and verified all support points. At the
end of the process you will see the message All points have been verified.

9. Click on Create Ribbon Image.
à The ribbon image will be generated. Note that each ribbon will be displayed as one
scene.
10. Again we recommend to click on Apply Stitching to remove the offset between the single
tile images.
You have successfully acquired the ribbon image and can now continue to the next step by clicking on Next.
12.6.5.5.4 Specifying the sections
In this step all sections will be identified by using a section detection algorithm. In summary you
have to mark the outline of at least one section on each ribbon. Then the section detection algorithm will detect the sections of the ribbon automatically. If the automatic section detection does
not work properly or if not all sections are detected you can stamp in the missing sections. It is
also possible to edit the shape, location and orientation of the section frames afterwards.
Prerequisite ü You are in step 4/7 Section Specification.
1. On the Section Definition tab select the Polygon tool.
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2. Mark the outline of one section in each ribbon. The outlines of these reference contours are
displayed in orange color.

3. Click on Apply.
à The software will try to detect the remaining sections automatically. When finished the
detected sections appear in green color.
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4. If not all sections can be detected, mark the last section which was detected and click on
the Stamp tool
in the Section Definition tab.
5. Stamp in the missing sections so that each section is marked.
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à Please take your time to check the numbering carefully. A correct numbering is prerequisite for a successful alignment of the sections, afterwards. The numbering of the ribbons
depends on how you deposited the ribbons during the cutting. To adjust the numbering
you have several options available in the context menu. To open the context menu move
the cursor over a section and right click with the mouse.

6. If the numbering is correct, proceed to the next wizard step by clicking on Next.
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12.6.5.5.5 Specifying the ROIs
Prerequisite ü You are in step 5/7 ROI Specification.
1. On the ROI Definition tab select the desired tool for marking a ROI, e.g. Rectangle or Circle.

2. Mark the desired ROIs in one section. Marked ROIs will be displayed in purple
color.

3. Click on Apply.
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à The software will position the defined region of interests in each section according to
section contours. The detected ROIs then appear on each section of the ribbons.

If the ROIs are detected correctly proceed with the next wizard step by clicking on Next.
12.6.5.5.6 Imaging the ROIs
In this step we will image the ROIs using a high magnification objective and apply a local focus
strategy. This will result in very detailed and sharp images of the ROIs which are used for the further processing (e.g. creating Z-Stacks and image correlation with SEM images).
Prerequisite ü You are in step 6/7 ROI Imaging.
1. Under Objective select an objective with a high magnification, e.g. 63x.
2. If you are using fluorescence samples you can now activate the corresponding fluorescence
channel.
3. Under Focus Surface select Local (per Region / Ribbon).
4. Click on Distribute Support Points.
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à According to the step 3 Ribbon Imaging the support points will be distributed automatically. The support points are distributed alternately outside and inside a ROI to guarantee best focusing results.

5. Click on Verify Support Points.
à The software will guide you through the process in the same way you were been guided
in step 3 Ribbon Imaging.
à If you have verified all existing support points the message All points have been verified will appear.
6. Click on Acquire Images.
The ROIs will be imaged now. You can use the next step to check each image of the ROIs and reacquire (re-shoot) images from ROIs which do not fit your expectations. To proceed with the next
step click on Next.
12.6.5.5.7 Re-Shooting ROIs
This step is basically used for re-acquiring images from ROIs that are out of focus.
Prerequisite ü You are in step 7/7 Reshoot.
1. Check if the Select Tiles mode is activated. This mode should be selected by default when
entering this step.
2. You can use the arrows on each side of the image to navigate through the ROI series or the
Z-Position slider on Dimensions tab.
3. Select an image you want to re-acquire by clicking on it with the left mouse.
à The image will be displayed with a dashed green frame.
4. Continue with checking the images and selecting the images you want to re-acquire.
5. When you have selected all images to re-acquire click on Acquire.
à The software will move to the first image which you have selected.
6. Adjust the focus and click on Snap.
7. Click on Replace to replace the old image with the new one.
à The software will automatically move to the next selected image to be re-acquired.
8. Continue until you have re-acquired all selected images.
9. Click on Finish.
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You have successfully completed the Acquisition Wizard for the light microscope images of your
ribbons. Continue with the process described in the next chapter of this guide.
12.6.5.6 Preparations for the SEM image
Prerequisite ü You have acquired the LM image according to the instructions in the chapter Acquiring the
LM image [} 280].
ü You have copied/transferred the image data of the light microscope to the SEM PC.
1. Start the Smart SEM software. Note that the SEM software is used for setting up the acquisition parameters, e.g. detector settings, magnification, display settings and scan speed.
2. Start the ZEN SEM software. Please take care that before you start ZEN , SmartSEM was
started.
à You will see the SEM Acquisition tab and the Correlative Array Tomography (CAT)
tool.

3. In the CAT tool click on Select / Specify ....
4. Select the sample file which you have created during the LM acquisition. It should be located in the LM folder which was generated automatically.
5. Select the sample holder you are using for your sample.
6. Calibrate the sample holder like described in the chapter Calibration.
You have successfully finished the general preparations. You can now continue with the acquisition of the SEM image.
12.6.5.7 Acquiring the SEM image
Prerequisite ü You have done the general preparations, see Preparations for the SEM image [} 291].
1. In the CAT tool click on Start Acquisition Wizard.
à You will see the first step Overview Imaging of the wizard.
2. Click on Load Image.
3. Select the image file containing the ROIs from the CAT / LM folder on your file system.
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à You will see the image containing the ROIs.

4. Click on Next.
à The wizard will now jump directly to step 6/7 ROI Imaging as the software recognizes
the marked ROIs in the image file.
à Before starting to acquire the ROIs we recommend to perform the offset correction.
Therefore proceed as follows:
5. In the ROI image click on a position with a prominent structure.
à The stage will move to that position automatically. Now you may recognize a difference
between the position you have clicked on and the actual position. This is the offset we
want to correct now.
6. Activate the offset correction checkbox.

à The controls for the offset correction will appear.
7. Click on Define 4 points in image.
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à The 4 correction points are distributed automatically within the image. The correction
points look like the support points (red outline with a red dot in the middle).
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8. Move the correction points to prominent positions on the sample containing structures
which are easy to recognize, e.g. the corner of the ribbons.

9. Click on Set correction offset. Note that for setting the offset correction you should use
the same magnification which will be used for image acquisition later.
à The stage moves to the first correction point.
à In the left image you will see the SEM image position. In the right image you will see the
correction point on the LM image. The positions do not match exactly.
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10. Move the SEM stage so that its position will match the correction point in the LM image.

11. If the positions do match confirm the message by clicking OK.
à The stage will move to the next correction point automatically.
à Repeat the last 3 steps for the remaining correction points.
à If you have finished the offset correction you should continue with verifying the support
points again. As this is exactly the same procedure like described for the LM acquisition,
read the chapters Imaging the ribbons [} 282] and Imaging the ROIs [} 289]. Note that
you must use the control panel for the SEM to adjust the SEM parameter.
12. After you have verified the support points click on Acquire.
The ROIs will be imaged with the SEM now. Depending on your experiment settings this can take
some time.
12.6.5.8 Aligning the Z-Stack Image
The wizard contains the following 6 steps:
§

Image Import

§

Pre-Processing

§

Image Review

§

Alignment

§

Manual Correction

§

Final Image Creation

1. In the CAT tool click on Start Z-Stack Alignment Wizard.
à You will see the first step Image Import of the wizard.
2. Click on Load Image and select the acquired Z-Stack image from the file system. In our example we choose the LM image. The same process has to be performed for the SEM image
afterwards.
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à You will see the Z-Stack image in the center screen area.

3. Click on Next.
à You will see step 2/6 Pre-Processing.
4. If your image is a tile image click on Apply Stitching to correct the offset between the individual tiles.
5. If your image is a SEM image click on Histogram Equalization to adjust the image display.
6. Click on Next.
à You will see step 3/6 Image Review. Note that in this step no image acquisition is possible. You can just replace an image by the next or previous image of the Z-Stack.

7. Select the image to be replaced by clicking on it with the mouse and click on Replace with
next or Replace with previous. Alternatively you can press the N or the P key. Note that
the table of the replaced image will not be saved.
8. Click on Next.
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à You will see step 4/6 Alignment.

9. If you have acquired a multi-channel image select the reference channel from the Channel
list.
10. Click on Start Alignment.
à The alignment of the Z-Stack image will be performed automatically. After the alignment
you will see the original Z-Stack image in the left image and in the right image you will
see the aligned Z-Stack image.
11. Click on Next.
à You will see step 5/6 Manual Correction.
à If you browse through the Z-Stack by using the Z-Position slider and you still realize a
shift between the single Z-Stack images, you can perform a manual correction of the single Z-Stack images. Therefore continue as follows:
12. Click on Define direction.
à A red arrow will appear in the right and in the left image.
13. Place the arrow in the left image at a prominent structure in the image which is easy to recognize through the full Z-Stack.
14. Select the right image and browse through the Z-Stack by using the Z-Slider on the Dimensions tab.
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15. When you realize a shift in an image adjust the arrow in the right image so that it matches
with the prominent structure marked with the arrow in the left image. Note that you have
to check and adjust the arrow for each image of the Z-Stack which does not match the position.

16. Click on Apply.
à The correction will be applied. If you want to correct the Z-Stack at another position,
simply repeat the procedure with another prominent structure. Of course you can undo
and redo actions by using the Undo / Redo buttons.
17. Click on Next.
à You are in step 6/6 Create final Z-Stack.
18. If you want to create the Z-Stack image from the complete image select Total and click on
Create final image.
19. If you want to create the Z-Stack image from the marked ROIs, select ROI. Note that you
can adjust the marked ROI in its size and position here. If you have marked more than one
ROI you can switch between the ROIs by using the Scene slider on Dimension tab.
20. Click on Create final image.
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You have successfully aligned and created the Z-Stack image. Of course you have to repeat the
process for the SEM image that was acquired.

12.6.5.9 Correlating the LM and SEM images
The wizard contains the following 4 steps:
§

Import Z-Stacks

§

Correlation

§

Manual Correction

§

Create Final Correlation Image

1. In the CAT tool click on Start Correlation Wizard.
à You will see the first step Import Z-Stacks.
2. Click on Left Container to load the aligned Z-Stack image from the SEM.
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3. Click on Right Container to load the aligned Z-Stack image from the LM.

4. Click on Next.
à You will see step 2/4 Correlation.
5. Under Transform decide whether you want to transform the Left Z-Stack into the Right
Z-Stack or vice versa.
6. Under Mode select 4 Points.
7. Click on Set Points.
8. Set the first 3 correlation points in the first Z-Stack image of the left image.
9. Set the corresponding 3 correlation points in the first Z-Stack image of the right image.
à After the third point in the right image was set, the software automatically jumps to the
last Z-Stack image.
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10. Set the fourth correlation point in the left image first and then set it in the right image.

11. Click on Create correlated Z-Stack.
à The correlated Z-Stack image will be generated and displayed in a separate image container.

12. Click on Next.
à You will see step 3/4 Manual Correction.
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13. In this step you can manually correct the alignment of the images by moving and/or rotating the images according to each other. To rotate the image use the handle at the top of
the image frame. To move the image simply left click on the image and hold the mouse
button pressed while moving the image.

14. If you finished the alignment of an image click on Accept. You can browse through the
correlated Z-Stack images by using the Z-Position slider in the Dimension tab.
15. Click on Next.
à You will see step 4/4 Create Final Correlation Image.
16. Click on Create Final Z-Stack.
à The correlated Z-Stack image will be created.

17. Click on Finish to exit the wizard.
You have successfully created an correlated Z-Stack image.
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12.6.6 Functions & Reference
12.6.6.1 CAT Tool
Using this tool you can calibrate and manage the sample holders and start the wizards which are
used for acquiring images from serial sections, generating Z-stack images out of the single images
and correlate two Z-Stack images from the light microscope (LM) and the scanning electron microscope (SEM).

Parameter

Description

Sample Name

Displays the name of the sample.

Select / Specify...

Opens the Select Sample Dialog [} 303].
There you can select a sample data sheet from the list or specify a
new sample with user specific information. The specified sample information will be used for image processing (i.e. Z-Stack alignment) or
for data management.

Sample Holder

Displays the name of the selected sample holder.

Select...

Opens the Select Template dialog. There you select the preferred
sample holder or define new holder templates, see Selecting the sample holder.

Calibrate...

Opens the Sample Holder Calibration Wizard [} 304]. There you can
calibrate the selected sample holder.

Apply to Image

Only visible if the Show All mode is activated.
Use this button only, when you forgot to calibrate the holder
before you acquire the image.
Applies a calibration to an acquired image. Do not remove the sample
from the correlative holder between image acquisition and calibration. Exception: correlative markers are on the sample holder.

Start Acquisition
Wizard

Starts the Acquisition Wizard. For more information see Acquisition
Wizard [} 307].

Start Z-Stack
Alignment Wizard

Starts the Z-Stack Alignment Wizard. For more information, see ZStack Alignment Wizard [} 314].

Start Correlation
Wizard

Starts the Correlation Wizard. For more information, see Correlation
Wizard [} 316].

12.6.6.1.1 Select Sample Dialog
Here you can select or create a sample data sheet.

Parameter

Description

Folder

Shows the location, where the files are saved.
If you click on the
button you can change the storage location.
The default path and folder is
C:\Users\user\Pictures\CAT Samples.
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Description
Within this folder, each sample is saved in a sub-folder. Images taken
during image acquisition within the CAT Acquisition Wizard will be
saved within the sub-folder, automatically.
For a better clarity sub-folders with the name „[Date][Time]“ will be
generated when another CAT run is started within the CAT acquisition
wizard. In case the file name will exceed a certain number of characters the name will be shortened using the sign „°“.

List of specified
samples

Shows the samples which are already specified within the software.
If you select a sample in the list and click OK, the sample will be used
in your experiment.
If you click on the
button, the New Sample Dialog opens.
There you can create a new sample definition which will be added to
the list, see Creating a new sample [} 275].
If you click on the Options button, you will see further options for
managing samples like Show/Edit or Refresh Sample List.

Information

Shows the specified sample information, e.g. name, description, number of sample carriers, sample carrier, and section thickness.

See also
2 CAT Tool [} 303]
12.6.6.2 Sample Holder Calibration Wizard

With the Sample Holder Calibration Wizard you calibrate the selected correlative sample holder.
Make sure that you have selected the desired sample holder, see Selecting the sample holder.
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12.6.6.2.1 Step 1: Options

Fig. 14: Sample Holder Calibration Wizard Options

Option

Description

Save marker images

Activated: the marker images are saved during the calibration.
The images can be used to check the calibration afterwards. Click
on the Select Folder (...) button to select a storage folder.

Move the stage to load
position before x/y
movement

Activated: the stage will move to load position before moving
to the next correlative calibration marker.

Automatic movement
to next marker

Activated: By clicking on the Next button within the wizard the
stage moves automatically to the next calibration marker.

In case of using an AxioObserver, the objective revolver moves to
load position.

Deactivated: You must use the joystick to navigate to the markers. This is necessary when using a correlative holder which has
no holder data deposited.
Use Autofocus at each
marker position

This option is active only if the Automatic movement to next
marker position checkbox is activated.
Activated: the focus is adjusted automatically after moving to
the next marker position.

Use automatic marker
detection

Activated: The software will detect the small calibration marker
automatically.
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Option

Description

Use settings for marker
detection

This option is active only if the Use automatic marker detection checkbox is activated.
Activated: shows settings for marker detection (see description
below). Here you select the properties of the calibration markers.

Settings for marker detection
Only visible if the Use settings for marker detection checkbox is activated.

Option

Description

Threshold marker detection: high – low

A low threshold for marker detection is used when the dimensions of the correlative L markers cannot be recognized precisely,
e.g. when the sample holder is slightly filthy.

Marker color

Here you select the color of the markers displayed in the live image.
White: the marker is displayed white on a dark background.
Black: the marker is displayed dark on light background.
Auto: the marker color is set automatically.

Marker orientation

Here you need to set the orientation of the L-markers on your
sample holder. Click on the corresponding button to select the
orientation of the calibration marker which you can see in the
live image

If you click on the Next button you will move to the next step of the wizard.
12.6.6.2.2 Step 2-4: Calibration
In steps 2-4 of the wizard you will be guided through the calibration procedure.

Fig. 15: Sample Holder Calibration Wizard
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Function

Holder position

Move to Position 1 button

ZEISS

Moves the stage to marker position 1. This is possible only if the
first position was set before and x/y coordinates are given.
Current button
Only visible for marker position 2 and 3.
Moves the stage to the current marker position. This is possible
only if the current position was set before and x/y coordinates
are given.
Stage movement to the
next marker

Here you can change the movement of the stage in x or y direction. This is necessary if during calibration the stage moves in the
wrong direction.

Marker position

By clicking on the Set button, the actual marker position will be
confirmed.

Click Finish to leave the wizard.
12.6.6.3 Acquisition Wizard
This wizard is used to image the serial sections or user-defined region of interest within the sections.
The steps Overview Imaging, Ribbon Imaging, ROI Imaging and Re-Shoot are image acquisition steps. The step Re-Shoot gives you the opportunity to image parts of the ROI-series or tiles
of a tile image, later.
The wizard consists of 7 steps which are described in the following chapters:
§

1/7 Overview Imaging [} 307]

§

2/7 Ribbon Specification (optional) [} 310]

§

3/7 Ribbon Imaging (optional) [} 310]

§

4/7 Section Specification [} 310]

§

5/7 ROI Definition [} 313]

§

6/7 ROI Imaging [} 313]

§

7/7 ReShoot (optional) [} 313]

12.6.6.3.1 Overview Imaging
In this step you can acquire an overview image that allows navigation on the sample. You will see
the positions of the serial sections on the sample carrier. In general, for the overview image an
objective with low magnification is used. This makes the acquisition fast due to a large field of
view and limited number of tiles.
Image acquisition with objectives with higher magnification is possible. But keep in mind, that the
number of tiles will increase due a smaller field of view as well as the acquisition time.

Info
We recommend to use phase contrast images for the acquisition. The used algorithm for the
automatic section specification, see step 4, is most reliable then.
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Parameter

Description

Image Acquisition /
Load Image

By selecting the corresponding button you can decide whether to acquire an overview image or load an image.

Image Selection

If you have selected Load Image, a saved image file from the file system can be chosen. Therefore simply click on the
igate to your image file.

button and nav-

The wizard will jump to the wizard step according to the information
saved within the loaded image.
Experiment

If you have selected Image Acquisition you have to select an experiment from the Experiment list.
Note that the experiment has to be set up and saved in advance, before you enter the wizard.

Objective

Here you can select the objective that you want to use for the acquisition of the overview image. As mentioned before, we recommend to
use an objective with a low magnification (e.g. 2.5x or 5x).

Channels

Here you can select the channels that you want to use for the acquisition of the overview image.
You can use more than one channel in one run, when your microscope is equipped with a motorized condenser.

Selected Light
Source

Here you can select the light source that you want to use for the acquisition of the overview image.
The light intensity can be adapted if a corresponding light source is
selected.

Camera Settings

Here you can adapt the camera settings like changing the exposure
time or activating / deactivating the shading correction.
If a shading correction has been performed and activated in the selected experiment, the checkbox will also be activated automatically
in the wizard.

Software Autofocus

Here you can activate the Software Autofocus functionality and apply
it to the overview image.
If activated, you can select the positions for focusing. During focusing
no live image will be visible.
Note that sensitive fluorescence labels might be bleached during the
autofocus process.
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Parameter

Description

Overview Image
Definition

Here you can define the size of the overview image by defining a start
and end position.

The software will calculate the area by means of the defined start and
end position (= overview image). The number of tiles and the memory
used will be displayed below the buttons.

-

Set start position

Sets the current stage position as start position of the image area.

-

Set end position

Sets the current stage position as end position of the image area.

-

Move to start
position

Moves the stage automatically to the defined start position. Note that
the start position has to be defined before.

-

Move to end
position

Moves the stage automatically to the defined end position. Note that
the end position has to be defined before.

No. of sample carrier

Only active, if you use more than one sample carrier for one correlative Z-Stack.
Here you have to select the number of the used sample carrier. The
total number of used sample carriers was defined in the CAT tool under Select / Specify sample.

Move the stage to
load position before xy movement

Activated: the stage will move to load position before moving to the
next correlative calibration marker.

Acquire Overview
Image

Starts image acquisition. The acquisition can be stopped in between.
Then the button will change to Restart. Before you restart the image
acquisition, you can modify the settings.

In case of using an AxioObserver, the objective revolver moves to load
position.

The status of the image acquisition is shown in the status bar of the
software.
After the overview image is taken, the image can be stitched. If you
click on the Apply Stitching button stitching will be carried out.
Next

Brings you to the next wizard step.

See also
2 Ribbon Definition [} 310]
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12.6.6.3.2 Ribbon Definition
This step is an optional step. It allows to image the ribbons with an objective with higher magnification, if necessary. E.g. when you would like to define the regions of interest by means of the
sample structure that can only be identified using lenses with higher magnification.
Therefore you can mark the outlines of the ribbon on your sample. If you can`t see the sample
structures, due to the overview image was acquired with a too low magnification, you can image
your sample again using a higher magnification.
For marking the outlines in the image use the tools from the Ribbon Definition tab (e.g. Rectangle, Circle or Polygon).

See also
2 Ribbon Imaging [} 310]
12.6.6.3.3 Ribbon Imaging
For this step a split view will appear. On the left side you see the Live image. On the right side you
see the overview image with the defined ribbons.

Info
To modify either the Live image or the image with the defined ribbons click on the corresponding container. The activated container will be marked with a white frame.
Again, like in step one for the overview image, you have to select the objective, channel, light
source and adapt the exposure time. Additionally you have to generate a focus surface to ensure
that your sample will be in focus during the image acquisition.
If you click on the Create Ribbon Image button, the ribbon image will be acquired.

See also
2 Section Specification [} 310]
12.6.6.3.4 Section Specification
To determine the positions of regions of interest (ROIs) within the sections, you have to define the
sections. The section lines generate the reference system for the ROI positions. The sections are
marked and outlined with a frame.

Info
Note that you must mark one section on each ribbon. Meaning when your sample has three
ribbons, three sections have to be marked overall.
We recommend to use phase contrast images for the section specification. The algorithm used for
the automatic section specification is most reliable when using phase contrast images. When
bright field images are used, the algorithm might be sub-optimal. In that case you have the opportunity to add and to move the section contours manually.
On the Section Definition tab you will find tools and options for creating sections in the image.
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Description

Reference Section

-

Select

Activates the selection mode (default).

-

Contour

If selecting this mode you can mark a contour line of a section.

-

Keep

Keeps the selected tool active. You can then use the tool several times
without interruption.

-

Step Backward

Undo the last step

-

Step Forward

Repeats the last step.

-

Delete

Deletes a selected graphical element.

Section Index

Here you can determine the starting number of the ribbons. This is
important when the ribbons of a sample are deposited on more than
one sample carrier.

Selected Channel

Shows the selected channel which is used for the detection.

Detection Sensitivity

Here you can adjust the detection sensitivity from Low to High by using the slider.
This will be done by modifying the contrast thresholds for the section
detection algorithm.
When setting a low sensitivity, sections will be recognized even if the
contrast between the section and the substrate is low; disadvantage:
sections will be recognized, even in areas where no serial sections are
deposited.
When setting a high sensitivity, the algorithm only recognizes sections, if there is a high contrast between section and substrate. If not
all sections were recognized you have the possibility to copy section
contours or to stamp section contours.

Section Detection

-

Apply

Starts the section detection on the sample. The software tries to detect each section within the ribbon.

Contrast Method

-

Auto

Auto is used by default. The system recognizes the contrast method
of the image automatically.

-

Ph.Contrast

Applies the phase contrast method. Even if you are using a brightfield
image, phase contrast will be applied as contrast method.

-

Brigthfield

Applies the brightfield contrast method. Even if you are using a phase
contrast image, brightfield will be applied as contrast method.

Use Internal Structure

Activate this checkbox only when sample structures are clearly visible
within the sections.
If activated, sample structures are used for section detection, additional to contrast differences between sections and substrate.
In case that sections are not detected properly, you have the possibility either to stamp section contours or to copy section contours.

Post Definitions
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-

Stamp tool

ZEISS

Description
If selecting this tool you can stamp in undetected sections after the
section detection is finished.
Therefore simply select the tool and move the mouse cursor in the
area nearby the last detected section. The cursor will change to a
stamp icon and you will be able to stamp in the missing section contours.

-

Accept Ref. Section

If you click on this button reference contours will transform into section contours.

When the section detection is finished you have different options for sorting the sections according to your needs, if necessary. Therefore right click on the detected sections. You will see a context menu with the following sorting options:

Parameter

Description

Sort

§ Sort all sections in reverse order
Sorts all sections which have a section contour. The initial section
with number 1 becomes the last section, the last section becomes
the first section with the number 1
§ Sort selected Ribbon elements in reverse order
Sorts the selected sections on a ribbon. The initial section with
number 1 becomes the last section, the last section becomes the
first section with the number 1

Copy selected sections from here

Copies the selected sections.

Copy selected Ribbon sections from
here

Copies all section contours on the selected ribbon.

Paste Section(s) to
here

Pastes the section contours (selection of certain section contours or all
sections of a ribbon) to the selected position.

Exchange numbering of selected
Ribbon sections

Exchanges the numbering of selected sections on different ribbons.

Highlight Related
Ribbon Sections

Highlights selected sections on a ribbon.

Merge two Ribbon
Sections

Merges sections on two different ribbons to one.

See also
2 ROI Specification [} 313]
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12.6.6.3.5 ROI Specification
In this step you can screen your sample for interesting sample regions (ROIs) and mark this area by
a graphical element. You can define several regions of interest within in one section.
On the ROI Definition tab you can draw either a rectangle, a circle or a freehand polygon/contour. Click on the Apply button to automatically identify the region of interest in all other sections. It is also possible to Undo / Redo an action using the corresponding buttons. To remove a
graphical element select it and click on the Delete (bin icon) button.

Info
With the arrow keys on your keyboard you can jump from one ROI to the next ROI along the
series to check if the structure of interest is still within the defined region of interest.

See also
2 ROI Imaging [} 313]
12.6.6.3.6 ROI Imaging
With this step you can image the ROIs which are detected and marked in the previous step. The
tile images will be generated from all defined region of interests automatically.

Info
The size of the snapped tile images of a ROI series can change due to the number of tiles
which are necessary to image the defined region of interest. The number of tiles can vary due
to the bending of the ribbon.

See also
2 Re-Shoot [} 313]
12.6.6.3.7 Re-Shoot
This step is helpful, if some tiles or regions of interest are blurry. These tiles/regions can be replaced by repeating the acquisition of the selected tiles or tile images. The procedure is as follows:
§

Select all blurry tiles, first.

§

Adjust the focus for each tile position.

§

Take new images.

Parameter

Description

Select Tiles

If this mode is active, you can select the tiles which you want to reshoot.
Use the Z-Position slider under Dimension tab or the arrows within
the Image area to scroll through the acquired images.
If you found a tile image that you want to re-shoot, simply click on it.
Then the color of the image frame turns from red to green.
Note that all tiles or blurry regions have to be defined, before the image acquisition can be repeated.
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Parameter

Description

Acquire

If this mode is active you can acquire the selected tiles again after the
focus was adjusted manually.
If you click on this button, the stage will move to the first tile and the
following buttons will appear:

-

Snap

Acquires a new image.

-

Replace

Replaces the old tile by the new tile.

-

Correct Brightness

In case the tile is brighter or darker, here you have the possibility to
adapt the brightness of the tiles image

Click Finish to exit the wizard.
12.6.6.4 Z-Stack Alignment Wizard
This wizard is used to align the single images of a Z-Stack image. The wizard consists of 6 steps
which are described in the following chapters:
§

1/6 Image Import [} 314]

§

2/6 Pre-Processing [} 314]

§

3/6 Image Review [} 315]

§

4/6 Alignment [} 315]

§

5/6 Manual Correction (optional step) [} 316]

§

6/6 Final Image Creation [} 316]

12.6.6.4.1 Image Import
In this step you can load your acquired Z-Stack images which you want to align. Therefore simply
click on the Load button and select the image file from the file system.

See also
2 Pre-Processing [} 314]
12.6.6.4.2 Pre-Processing
In this step you can perform pre-processing functions on the loaded image, e.g. Stitching (only for
tile images), Brightness and Contrast Correction (only for SEM images).

Parameter

Description

Apply Stitching
button

Only visible if a tile image is loaded.

Clip Limit

Reduces noise in the image. The higher the Clip Limit , the lower the
noise. The clip limit can be adjusted between 0 and 10 %.

Region Size

Defines the region for histogram equalization. The smaller the area,
the higher the contrast, but the noise will increase, too. The Region
Size can be adjusted from 16 to 1024 px.

If you click on this button, stitching is performed automatically on the
image. The stitching can be canceled (Undo) or repeated (Redo) by using the arrow buttons.
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Parameter

Description

Histogram Equalization

If you click on this button, the SEM images are adapted to the selected values. The Histogram Equalization can be canceled (Undo) or
repeated (Redo) by using the arrow buttons.

See also
2 Image Review [} 315]
12.6.6.4.3 Image Review
This step is used for reviewing the single images of a Z-Stack. This is necessary because certain images might not be useful for 3D reconstruction due to problems during the image acquisition or
sample preparation issues (wrinkles or ruptures within the section). These regions can be replaced
either by the previous image or by the following image. To review the images, the images can be
displayed as single 2D images in the 2D view or as images series in the Gallery view.

Parameter

Description

2D View

If selected, you can review the single images of a Z-Stack image by using the 2D view.
You can use the Z-Position slider to navigate through the single images.
To replace an image select the image and click whether on the Replace with next or Replace with previous button.
If you click on the Undo button the last action performed will be undone.

Gallery View

If selected, you can review the single images by using the Gallery
view. The single images of a Z-Stack image are displayed as an image
gallery.
If you found an image that does not meet your expectations, simply
select the image and replace it by the next or previous image.

See also
2 Alignment [} 315]
12.6.6.4.4 Alignment
In this step you perform the image alignment. Therefore simply click on the Start Alignment button. To cancel the alignment click on the Stop button.

Info
Before you start the alignment, select one channel as reference channel (e.g. DAPI, because it
stains the nucleus and the nucleus is a proper structure for performing alignment).
During alignment a splitter view is visible. In the left container you can see the original images, in
the right container you can see the aligned images.
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See also
2 Manual Correction [} 316]
12.6.6.4.5 Manual Correction
In this step (optional) you can navigate through the aligned images and check the result of the
alignment.
In case the results are unsatisfactory, you have the possibility to correct the alignment of the images manually. Misalignment can occur, when no characteristic structures are visible within the
images.

See also
2 Final Image Creation [} 316]
12.6.6.4.6 Final Image Creation
Last but not least, in this step you create the final image.

Parameter

Description

Total

If selected, the complete image will be used for the image creation.

ROI

If selected, only the ROI area will be used for the image creation.

Create final image
button

Creates the final aligned Z-Stack image.

Click Finish to exit the wizard.
12.6.6.5 Correlation Wizard
This wizard is used to correlate a Z-Stack image from the Light Microscope (LM) with the Z-Stack
image from the Scanning Electron Microscope (SEM). The wizard consists of 4 steps which are described in the following chapters:
§

1/4 Import Z-Stacks [} 316]

§

2/4 Correlation [} 317]

§

3/4 Manual Correction [} 318]

§

4/4 Create Final Correlation Image [} 318]

12.6.6.5.1 Import Z-Stacks
In this step you can import the aligned Z-Stack images from the LM and the SEM, e.g. the Z-Stack
image from the LM in the left container and the Z-Stack image from the SEM in the right container.
If you click on the Left Container button, the image is opened in the left image container.
If you click on the Right Container button, the image is opened in the right image container.

See also
2 Correlation [} 317]
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12.6.6.5.2 Correlation
In this step you correlate the images.

Parameter

Description

Transform

Here you select which Z-Stack will be transformed. During transformation a pixel in the overlay image of the Z-Stack is calculated by using
pixels of the two original images that shall be overlaid / merged.

Interpolation

Here you can select one of the following interpolation methods:

-

Nearest Neighbor

The gray value of the resulting pixel in the overlay image is made of a
pixel which is located next. This interpolation method is very fast.

-

Linear

The resulting or calculated pixel in the overlay image is assigned to a
gray value, which is the result of a linear combination of gray values
derive from pixels located nearby (in the original image).

-

Cubic

The calculated pixel in the overlay image is assigned to a gray value,
which is calculated by means of a polynomial function using gray values of pixels in the original images; these pixels are located nearby the
calculated pixel.

Mode

Here you can choose an algorithm mode:

-

3-Points

If selected, this mode enables you to set 6 correlation points after
clicking on the Set Points button (3 points in each Z-Stack in each
container )

-

4-Points

If selected, this mode enables you to set 8 correlation points after
clicking on the Set Points button (4 points in each Z-Stack), 3 points
in the first z-section, the last point in the last section

Correlation Points

If you click on the Set Points buttons you can set the correlation
points.
The number of correlation points is according to the selected algorithm. The cursor will change to a pipette symbol. Simply click in the
image to set the points. Start with setting the first three points in the
left container then set the corresponding correlation points in the
right container. If a correlation point is set, a check mark icon will appear in front of the corresponding point.
When you select the 4-Points-Algorithm the display will move automatically to the last image of the Z-Stack. Set the fourth correlation
point in both containers. Make sure that the positions in both ZStacks are identical. After you have set all correlation points the cursor
will be changed backwards from the pipette to the arrow.
Reset deletes all correlation points in the image.

Create correlated
Z-Stack

If you click on this button, the correlated Z-Stack will be generated
and opened in a new image container.

See also
2 Manual Correction [} 318]
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12.6.6.5.3 Manual Correction
In this step you can correct the correlation manually by moving and rotating the transformed image.
Therefore simply click on the Start button. Then you can interactively move the image by dragging and dropping it with the mouse or rotate the image by clicking on the circle button attached
on top of the green image frame or using the Rotation slider. You can also change the image
opacity by adjusting the corresponding slider.
If you click on the Accept button the manual correction will be adopted to the correlated image.

See also
2 Create Final Correlation Image [} 318]
12.6.6.5.4 Create Final Correlation Image
In this step create the final correlation image. Therefore simply click on the Create final Z-Stack
button. Click Finish to exit the wizard.
12.6.6.6 Correlative Sample Holders

Name

Image

Life Science cover glass
22x22

Life Science Cryo Holder
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ZEISS

Image

Life Science for TEM Grids

Cover glass with fiducials
22 x 22

MAT Flat Stubs A
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ZEISS

Image

MAT Flat Stubs

MAT Universal A
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ZEISS

Image

MAT Universal B_A

MAT Universal B_B
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12.7 Deconvolution
This module offers you wide range of parameters, which allow to adapt the deconvolution to the
sample conditions. The downside of this fact is, that using these parameters can be a challenge.
The following functions are available for deconvolution in ZEN and are described in the following
chapters:
§

Deconvolution (defaults): Four methods are available and are automatically adapted to the
type of instrument, which was used to acquire the image. This is the easiest to use deconvolution function

§

Deconvolution (adjustable): Offers access to all available function parameters and therefore
provides the necessary flexibility for demanding samples and sample conditions.

§

PSF Wizard: this function offers a wizard which guides the user through a series of steps to
create a PSF from a z-stack image of multiple fluorescent beads. This function is recommended to create experimentally measured PSF’s.

12.7.1 Basics of Deconvolution
Microscopy creates images of objects which should represent the nature of the object as well as
possible. Fluorescent light, which emanates from the object, passes through the various optical elements of the beampath and eventually gets collected by the detector. Unfortunately, on the way
to the detector the signal is changed in such a way, that the quality of the resulting image suffers.
As a consequence, the image is never a 100% correct representation of the object. This effect is
strongest seen in classical widefield fluorescence microscopy which does in fact not offer any optical sectioning capability, but also exists to a different degree in optical sectioning microscope systems, e.g. Confocal, Lightsheet or ApoTome.
Fortunately, the dominant function which has this deleterious effect on the image, is based on the
optical design principles of the light microscope and therefore well understood. We call this the
point spread function (PSF) of the microscope system.
Deconvolution is a mathematical method which can reverse the effect of the PSF on the image
and can therefore to a large extent restore the image to better represent the object. In the case of
widefield imaging, Deconvolution can even convey optical sectioning properties to the result image allowing true three-dimensional restoration.
The following improvements can be obtained by using deconvolution:
§

Denoising

§

Removal of out of focus light -> deblurring, improved contrast

§

Increasing signal to noise ratio by reassigning photons

§

Restoration of sparsely sampled data

§

Increase of resolution in X, Y and Z

As the object and the way, it was prepared, becomes part of the optical system during imaging,
the largest variable to consider when doing deconvolution is the sample itself. Since the sample
conditions can vary widely, information about the sample needs to be provided to the deconvolution function. The better the sample conditions are known, the better the outcome will be.
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12.7.2 Deconvolution (defaults)
This method allows you to use 4 different algorithms for deconvolution, without any further settings.
The following algorithms are provided in the Parameter tool:

Parameter

Description

Simple, very fast
(Nearest Neighbor)

Executes the fast Nearest Neighbor method using default parameters.

Better, fast
(Regularized Inverse
Filter)

Executes the Regularized Inverse Filter algorithm for image enhancement.

Good, medium speed
(Fast Iterative)

Executes the Fast Iterative restoration method.

Excellent, slow
(Constrained Iterative)

Executes the Constrained Iterative quantitative restoration
method.

12.7.3 Deconvolution (adjustable)
Deconvolution can be done either by using the computers CPU or by using a graphics card. Using
a graphics card can speed up deconvolution processing quite dramatically. A NVIDIA graphics
card is required which supports the CUDA processing library. Contact your sales representative for
further details about supported graphic card models.
For a detailed overview of all deconvolution methods (and its combinations) see Deconvolution
Methods in ZEN [} 337]. This method allows you to use and individually configure 4 different algorithms for deconvolution (short DCV). Under Parameters two tabs are available for detailed
configuration:
§

On the Deconvolution tab, you can select the desired algorithm and define the precise settings for it, see Deconvolution tab [} 323].

§

On the PSF Settings tab, you can see and change all key parameters for either generating a
theoretically calculated PSF, or selecting an experimentally measured PSF, see PSF Settings tab
[} 329].

12.7.3.1 Deconvolution tab

Info
Expert knowledge is required for some of the settings. If you are in doubt, leave the settings
unchanged.
Algorithm dropdown list
Here you can select the algorithm that is used. The following algorithms are available:
§

Nearest Neighbor

§

Regularized Inverse Filter

§

Fast Iterative

§

Constrained Iterative
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Enable Channel Selection
Activated: Applies the settings on a channel-specific basis. This allows you to set parameters for
each channel individually. You will see a separate, colored tab for each of the channels.
Deactivated: Applies the same settings to all channels of a multichannel image.
12.7.3.1.1 Normalization section
Here you can specify how the data of the resulting image are handled:

Parameter

Description

Clip

Sets negative values to 0 (black).
If the values exceed the maximum possible gray value of 65636 when
the calculation is performed, they are limited to 65636 (pixel is 100%
white).
Results from different input images can be quantitatively compared
with each other.

Automatic

Normalizes the output image automatically.
In this case the lowest value is 0 and the highest value is the maximum possible gray value in the image (gray value of 65636). The maximum available gray value range is always utilized fully in the resulting
image.
Results from different input images cannot directly be compared
quantitatively with each other.

12.7.3.1.2 Set Strength Manually section
If you have selected the Nearest Neighbor algorithm, the checkbox is always activated.

Info
If you have selected the Fast Iterative algorithm, the checkbox is also always activated. Using
the slider you can then enter the number of iterations used directly, as, in contrast to the other
methods, no regularization is performed.
Activated: Enter the desired degree of restoration using the slider.
To achieve strong restoration and best contrast, move the slider towards Strong.
To achieve lower restoration but smoother results, move the slider towards Weak.
If the setting is too strong, image noise may be intensified and other artifacts, such as "ringing",
may appear.
Deactivated: Determines the restoration strength for optimum image quality automatically. This
is recommended for widefield and confocal images and is therefore deactivated by default.
The restoration strength is inversely proportional to the strength of so-called regularization. This
is determined automatically with the help of Generalized Cross Validation (GCV).

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

324

12 Software Modules & Extensions | 12.7 Deconvolution

ZEISS

12.7.3.1.3 Convergence History
Only visible if the Show All mode is activated.
This section is only visible if you have selected the Fast Iterative or Constrained Iterative algorithm.
The progress of the calculation is displayed here as line graph. Several quality parameters are
measured for each iteration and once either an optimum or the maximum allowed number of iterations is reached, the processing is stopped. This display allows you to observe directly how the iterative method affects the available data. It also shows how many iterations have been used and
how much time is being used per iterations.
12.7.3.1.4 Corrections section
To show the section in full, click on the arrow button

.

Parameter

Description

Lamp Flicker

Activated: Analyzes the total brightness of each Z-plane. In the event
of non-constant deviations in the total brightness between neighboring planes, a compensation factor is taken into account.
Activate this function if you have acquired your images using an old
fluorescent lamp that exhibits strong fluctuations/flickering in brightness.

Fluorescent Decay

Activated: Corrects bleaching of the sample during acquisition of the
Z-stack.
This function should only be activated for widefield images. Use it if
your sample undergoes strong bleaching during acquisition.

Background

Activated: Analyzes the background component in the image and removes it before the DCV calculation.
This can prevent background noise being intensified during DCV.

Bad Pixel Correction

Activated: Employs a fully automatic detection and removal of spurious or hot pixels (also known as stuck pixels) in an image stack which
might interfere with the deconvolution result.
It is based on the analysis of the gray level variance in the neighborhood of each pixel in the image. It is recommended to use this parameter only, if stuck pixels are observed in the input image.

12.7.3.1.5 Advanced Settings section
Only visible if the Show All mode is activated.
This section is only visible if you have selected the Inverse Filter, Iterative (Fast) or Iterative algorithm.
To show the section in full, click on the arrow button

.

Depending on which algorithm you have selected, different advanced setting options are available. The relevant settings are described in the following chapters for each algorithm:
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12.7.3.1.6 Advanced settings (Regularized Inverse Filter)
Regularization
Here you can select which frequencies in the image are taken into account during regularization:

Parameter

Description

Regularization

-

Zero Order

Regularization based on G-difference, modeled on Tikhonov, but accelerated.

-

First Order

Regularization based on Good's roughness. Under certain circumstances, more details are extracted from noisy data. May be better
suited to the processing of confocal data sets.

GPU Acceleration

Only available, when having installed a suitable (NVIDIA, CUDA based)
graphics card. The checkbox is then activated by default. If
unchecked, CPU processing is being used instead.

12.7.3.1.7 Advanced settings (Fast Iterative)

Parameter

Description

Likelihood

Here you can decide which likelihood calculation you want to work
with:

-

Poisson (Meinel)

The calculation according to Meinel works with one convolution per
iteration and converges very fast, normally in 4-5 iterations. This
method can also produce artifacts, however.

-

Poisson
(RichardsonLucy)

The calculation according to Richardson-Lucy, on the other hand, normally requires hundreds of iterations and therefore takes considerably
longer. This method is, however, somewhat more robust producing
less artifacts. Precondition is however, that the PSF is known very
well.

Regularization

For the Poisson (Meinel) calculation it is also possible to perform
zero order (G-difference) regularization here as an option. This
means, however, that the calculation will take considerably longer
and the main advantage of the greater speed of Meinel is lost.

-

None

No regularization is performed.

-

Zero Order

Regularization based on G-difference, modeled on Tikhonov, but accelerated.

-

Total Variation

Total Variation regularization denoises the input data but protects the
edges of structures. This can improve results for noisy data but increases the computation time quite significantly.

Optimization

-

Numerical Gradient

If selected, an attempt is made to determine the trend of the iterations in advance and extrapolate this to the entire calculation. This
can significantly speed up the calculation.
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Description

First Estimate

-

Input Image

The input image is used as the first estimate of the target structure
(default).

-

Last Output Image

The result of the last calculation is used to estimate the next calculation. This can speed up a calculation that is repeated using slightly different parameters.

-

Mean of Input
Image

No estimate is made, the mean gray level of the input image is being
used. This is the most rigid application of deconvolution. It should be
chosen for confocal images, where the data sampling can be quite
sparse. The computation time will increase, but missing information
can be recovered from the PSF.

Maximum Iterations

Here you can indicate the maximum permitted number of iterations
that you want. In the case of Richardson-Lucy, you should allow significantly more iterations here.

Quality Threshold

Defines the quality level at which you want the calculation to be
stopped. The percentage describes the difference in enhancement between the last and next-to-last iteration compared with the greatest
difference since the start of the calculation. 1% is the default value.
Lowering this can bring about small improvements in quality.

GPU Acceleration

Only available, when having installed a suitable (NVIDIA, CUDA based)
graphics card. The checkbox is then activated by default. If
unchecked, CPU processing is being used instead.

GPU Tiling

Only available for very large images which exceed the available
graphic card memory.
With this function the image is split up in smaller portions which fit
into the memory of the graphic card. The function automatically determines into how many tiles the image must be split to allow maximum usage of the graphics card. The resulting tiles will automatically
be stitched together for the final output result.
If deactivated, tiling will not be done, however, in this case only certain sub-functions of deconvolution can run on the graphics card and
the speed increase compared to CPU processing will be lower. The
image quality might be higher than with tiling because there is no
need for stitching.

12.7.3.1.8 Advanced settings (Constrained Iterative)

Parameter

Description

Likelihood

Here you can decide which likelihood calculation you want to work
with:

-

Poisson

Calculation according to Poisson, this is normally the correct noise
model for microscopic images.

-

Gauss

Calculation according to Gauss. If detector noise is dominant over
sample noise, using a Gaussian noise model can be advantageous,
however, this is rarely the case with modern microscopy systems.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

327

12 Software Modules & Extensions | 12.7 Deconvolution

ZEISS

Parameter

Description

Regularization

Here you can enter which frequencies in the image are taken into account during regularization:

-

Zero Order

Regularization based on G-difference, modeled on Tikhonov, but accelerated.

-

First Order

Regularization based on Good's roughness. Under certain circumstances, more details are extracted from noisy data. This regularization can sometimes produce better results for the processing of confocal data sets.

-

Second Order

Regularization according to Tikhonov-Miller. Here higher frequencies
are penalized more than in the case of Good's roughness. Results
have a tendency to become overly smoothed.

Optimization

-

Analytical
(Newton Raphson)

Here an attempt is made to optimize the iterations analytically. This
option is usually faster but may also be somewhat less precise.

-

Line Search

Searches rigorously and comprehensively for the minimum. It is therefore more robust, but the calculation takes longer. Line search is recommended for confocal data sets especially, if they are noisy as this
can enforce convergence even for noisy and sparsely sampled data.

First Estimate

-

Input Image

The input image is used for the first estimate of the target structure
(default).

-

Last Output Image

The result of the last calculation is used to estimate the next calculation. This can speed up a calculation that is repeated using slightly different parameters.

-

Mean of Input
Image

No estimate is made for the next iteration. This is the most rigid application of deconvolution. It should be chosen for confocal images,
where the data sampling can be quite sparse. The computation time
increases increase, but missing information can be recovered from the
PSF.

Maximum Iterations

Here you can indicate the maximum permitted number of iterations
that you want.

Quality Threshold

Defines the quality level at which you want the calculation to be
stopped. The percentage describes the difference in enhancement between the last and next-to-last iteration compared with the greatest
difference since the start of the calculation. Lowering this can bring
about small improvements in quality.

GPU Acceleration

Only available, when having installed a suitable (NVIDIA, CUDA based)
graphics card. The checkbox is then activated by default. If
unchecked, CPU processing is being used instead.
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Description

GPU Tiling

Only available for very large images which exceed the available
graphic card memory.

ZEISS

With this function the image is split up in smaller portions which fit
into the memory of the graphic card. The function automatically determines into how many tiles the image must be split to allow maximum usage of the graphics card. The resulting tiles will automatically
be stitched together for the final output result.
If deactivated, tiling will not be done, however, in this case only certain sub-functions of deconvolution can run on the graphics card and
the speed increase compared to CPU processing will be lower. The
image quality might be higher than with tiling because there is no
need for stitching.
12.7.3.2 PSF Settings tab
All key parameters for generating a theoretically calculated Point Spread Function ("PSF") are
displayed here.

Info
Ordinarily, images that have been acquired using ZEN (of the *.czi type) automatically contain
all microscope parameters, meaning that you do not have to configure any settings on this
page. Most parameters are therefore grayed out in the display. It is possible, however, that as
a result of an incorrect microscope configuration values may not be present or may be incorrect. You can change these here. The correction of spherical aberration can also be set here.

12.7.3.2.1 Microscope parameters section
The most important microscope parameters for PSF generation that are not channel-specific are
displayed in this section.

Info
If you enter incorrect values, this can lead to incorrect calculations. If the values here are obviously wrong or values are missing, check the configuration of your microscope system.

Parameter

Description

Microscope dropdown list

Displays which type of microscope has been used. There are two main
options: conventional microscope (also known as a widefield microscope) and confocal microscope, for which the additional pinhole diameter parameter applies.

NA Objective

Displays the numerical aperture of the objective.

Immersion

Displays the refractive index of the immersion medium. Please note
that this can never be smaller than the numerical aperture of the objective. You can make a selection from typical immersion media in the
dropdown list next to the input field.

Scale lateral

Displays the geometric scaling in the X/Y direction.
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Parameter

Description

Scale axial

Displays the geometric scaling in the Z direction.

Override button

To change the input fields that are normally grayed out, click on the
button. The input fields and dropdown lists are now active.
The text on the button then changes to Reset. To restore the original
values saved in the image, click on the Reset button.

Master Reset

Resets the metadata to the values which were originally stored in the
image at time of acquisition. It reverts any changes made by pressing
the Override button.

12.7.3.2.2 Advanced section
Only visible if the Show All mode is activated.
To show the section in full, click on the arrow button

.

Phase Ring dropdown list
If you have acquired a fluorescence image using a phase contrast objective, the phase ring
present in the objective is entered here. This setting has significant effects on the theoretical Point
Spread Function ("PSF").
PSF generation dropdown list
There are two models for calculating the PSF:

Parameter

Description

Scalar Theory

The wave vectors of the light are interpreted as electrical field = intensity and simply added. This method is fast and is sufficient in most
cases (default setting).

Vectorial Theory

The wave vectors are added geometrically. However, the calculation
takes considerably longer.

Z-Stack
This field can only be changed if it was not possible to define this parameter during acquisition,
e.g. because the microscope type was unknown. It describes the direction in which the Z-stack
was acquired. Note that this setting is only relevant, if your are using the spherical aberration correction.

Parameter

Description

Descending

The Z-Stack descends away from the objective.

Ascending

The Z-Stack ascends towards the objective.
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12.7.3.2.3 Aberration correction section
Only visible if the Show All mode is activated.
Here you can select whether you want spherical aberration to be taken into account and corrected during the calculation of the PSF. As with the other PSF parameters, most values are extracted automatically from the information about the microscope that is saved with the image
during acquisition. The input option is therefore inactive.

Parameter

Description

Enable Correction

Activated: Uses the correction function. All options are active and
can be edited.

Embedding
medium

Here you can select the embedding medium used from the list.

Refractive index

Displays the refractive index of the selected embedding medium. Enter the appropriate refractive index if you are using a different embedding medium.

Manufacturer

Displays the manufacturer, if known.

Depth variance

When Aberration correction is activated, it is also possible to enable
the creation of depth variant PSF’s. This method allows for dramatic
improvements in image restoration of thicker samples by creating axially variant theoretical PSF’s as a function of the distance to the coverslip and the refractive index of the mounting medium.
To use depth variant aberration correction activate the checkbox. In
the spin box edit field you can define how many PSF’s should be generated. The more PSF’s you create, the better the results, but choosing many PSF’s will increase the processing time. You should choose
at least 3 PSF’s.
From the dropdown list you can choose between the PCA method
(Primary Component Analysis, M. Arigovindan et al., 2005, IEEE Transactions on Image Processing 14. nr. 4 p.450ff) which is best suited for
constrained iterative and fast iterative method and the Strata method
(Myneni and Preza, Frontiers in Optics 2009, Optical Society of America, paper CThC4.), which is best for regularized inverse filter and
Richardson Lucy iterative deconvolution.

Distance to cover
slip

Displays the distance of the acquired structure from the side of the
cover slip facing the embedding medium. Half the height of the Zstack is assumed as the initial value for the distance from the cover
slip. The value can be corrected if this distance is known. If possible,
this distance should be measured.
Note: Use Ortho View and the Distance Measurement option to
define the distance of the sample to the coverslip. It is also important
to estimate the position of the glass/embedding medium interface as
precise as possible. If the z-stack extends into the coverslip, the determined range of the stack which reaches into the glass should be entered as a negative value. Example: Z-stack is 26 µm thick, glass/
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Description
medium interface is positioned at 9 µm distance from the first plane
of the stack. Resulting value for Distance to cover slip: - 9.0 µm.

Cover slip type
(Thickness and type)

Commercially available cover slips are divided into different groups
depending on their thickness (0, 1, 1.5 and 2), which you can select
from the dropdown list. Cover slips of the 1.5 type have an average
thickness of 170 µm. In some cases, however, the actual values can
vary greatly depending on the manufacturer. For best results the use
of cover slips with a guaranteed thickness of 170 µm is recommended. Values that deviate from this can be entered directly in the
input field.

Cover slip ref. index

Select the material that the cover slip is made of from the dropdown
list. The corresponding refractive index is displayed in the input field
next to it.

Working distance

Displays the working distance of the objective (i.e. the distance between the front lens and the side of the cover slip facing the objective). The working distance of the objective is determined automatically from the objective information, provided that the objective was
selected correctly in the MTB 2011 Configuration program. You can,
however, also enter the value manually.

Override

Only active if the Enable correction checkbox is activated.
To reset the values, click on the Reset button.
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12.7.3.2.4 Channel specific section
In this section you will find all settings that are channel-specific. This means that they may be configured differently for each channel.

Parameter

Description

Use external PSF
checkbox

Activated: Uses an external measured PSF. You'll find an additional
input window under Image Parameters | Input where you can
choose the external PSF file. The software will check if the PSFs microscope parameters match with the input image. Deviations (10nm deviation in wavelength will be accepted) will make the software use a
theoretical PSF.

Attach to input
button

If an external PSF was selected you can attach the file to the input image. The saved input image will then contain the correct measured
PSF. Usage of a theoretical PSF is possible as well for such an image.
Just deactivate the Use external PSF checkbox.

Illumination display
field

Displays the excitation wavelength for the channel dye [in nm] by using the peak value of the emission spectrum. The color field corresponds to the wavelength (as far as possible).

Detection display
field

Displays the peak value of the emission wavelength for the channel
dye. The color corresponds to the wavelength (as far as possible).

Sampling lateral
display field

Depends on the geometric pixel scaling in the X/Y direction and displays the extent of the oversampling according to the Nyquist criterion. The value should be close to 2 or greater in order to achieve
good results during DCV. As, in the case of widefield microscopes,
this value is generally determined by the objective, the camera
adapter used and the camera itself, it can only be influenced by the
use of an Optovar. With confocal systems, the zoom can be set to
match this criterion.

Sampling axial display field

Depends on the geometric pixel scaling in the Z direction and displays
the extent of the oversampling according to the Nyquist criterion.
The value should be at least 2 or greater in order to achieve good results during DCV. This value is determined by the increment of the focus drive during acquisition of Z-stacks and can therefore be changed
easily.

Pinhole display field

Only available if a confocal microscope has been entered under the
microscope parameters.
Displays the size of the confocal pinhole in Airy units (AU).

NA Cond. display
field

Only visible if the microscope is a Conventional Microscope and
Transmitted Light has been selected as the illumination type.
Displays the numerical aperture of the condenser with which transmitted-light acquisition was performed.
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12.7.3.2.4.1 Microscope info section
Displays advanced microscope information that influences the form of the PSF in a channel-dependent way:

Parameter

Description

Illumination dropdown list

Here you can select the illumination method with which the data set
has been acquired. In the event that a Conventional Microscope
has been entered under the microscope parameters, the following options are available here: Epifluorescence, Multiphoton Excitation
and Transmitted Light. In the case of confocal microscopes, Epifluorescence is the only option.

Image Formation

Displays whether the imaging was incoherent (Conventional Microscope) or coherent (Laser Scanning Microscope).

Lateral Resolution

Displays the lateral resolution of the calculated PSF.

Axial FWHM

Displays the FWHM (Full Width Half Maximum) as a measure of the
axial resolution of the PSF.

12.7.3.2.4.2 PSF view section
This tool shows you the PSF that is calculated for a channel based on the current settings. If you
select the Auto Update checkbox, all changes made to the PSF parameters are applied immediately to the PSF view. This makes it possible to check quickly whether the settings made meet
your expectations.
1. To extract the PSF from the image, right click and select PSF snapshot.
The result is a new PSF document opened in the center screen area.

12.7.4 Creating a PSF - With Wizard and Without
The PSF Wizard combines two steps which are necessary for extracting experimental point spread
functions (PSF) from Z-Stacks of subresolution fluorescent beads:
§

A bead averaging step finds individual beads, presents them for inspection, allows you to select the ones you like and then creates an averaged combination of all selected beads. This
stack shows a single bead which is, as a consequence of the averaging function, fairly free of
noise.

§

The averaged bead stack is then run through the Create PSF function which removes background and residual noise, correctly scales the PSF and also converts the stack into a 32-bit
floating point format which is better suitable for the mathematical procedures used in deconvolution.

Prerequisite ü You have acquired a Z-Stack image. For more information, see Measuring the PSF using subresolution beads [} 99].
ü The use of the PSF wizard is activated.
1. Select the path to open the Parameters dialog box.
à The functions Use wizard and Bad Pixel Correction are activated by default.
2. On the Processing tab, press the Apply button.
à The PSF wizard opens and guides you throught the creation of the PSF.
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à If the Use wizard checkbox is not activated, the function shows the parameters for
Bead averaging. Note that these parameters are only available in Show all mode. We
recommend using the PSF wizard. The result of the wizard is a PSF file which you use in
deconvolution for images acquired under the same conditions.
This method determines the position of fluorescent beads in a Z-stack image. If these beads are
too close to one another they are excluded from the calculation. Beads which are far enough
apart from one another are combined into a single bead, from which it is then possible to calculate a PSF using the Create PSF function (Processing / Utilities).
Description of the algorithm
This function consists of a series of steps before and after processing. The aim is to find beads
that are far enough apart from one another. The processing steps are as follows:
§

Select input image

§

Image smoothing

§

Segmentation

§

Alignment of the center of the found beads

§

Averaging of the beads

Parameters
§

Bead proximity: Defines the distance between two neighboring beads in μm. A bead is excluded from the averaging if the distance to a neighboring bead is greater than the minimum
distance set. A smaller value leads to the detection off fewer beads, albeit ones that are further apart, while a larger value leads to the detection of more beads, but with the risk that
beads will partially overlap. Range between 2.1 and 20 µm.

§

Detection sensitivity: determines the sensitivity with which beads are being detected. Range
is between -5 to 5. Smaller Values lower the sensitivity excluding beads with weaker staining
and lower signal to noise ratio, higher values include also beads with weaker staining.

§

Average Beads: If activated, an image of an individual, averaged bead is produced. If deactivated, an image is produced in which each found bead is centered, but saved in the R dimension. A slider for Rotation (R dimension) appears on the Dimensions tab.

Bad Pixel Correction
This parameter employs a fully automatic detection and removal of spurious or hot pixels (also
known as stuck pixels) in an image stack which might interfere with the PSF extraction procedure.
It is based on the analysis of the gray level variance in the neighborhood of each pixel in the image. It is usually recommended to leave this parameter active.

12.7.5 Image types suitable for deconvolution
Most types of microscope images could in principle be deconvolved. However, there are practical
limitations, for example the image file sizes might be too large or imaging conditions might be
dominated by effects other than blurring by the point spread function. If, for example, a sample
has strong light scattering properties or if light is strongly absorbed by the sample, deconvolution
becomes difficult or impossible.
Deconvolution works both in 2D as in 3D. The PSF is very small in 2D, so the improvements of deconvolving 2D images are usually not very significant. Its full power deconvolution can show
when processing 3D image stacks which have been acquired according to the following general
rules:
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§

Acquisition of images with enough pixel resolution by choosing objectives with numerical
apertures >0.5 and using camera resolutions with small enough pixel sizes as recommended
by the Nyquist criterion.

§

Acquisition of Z-stacks with distance between individual planes not larger than recommended
by the Nyquist criterion (2 fold oversampling of the theoretically resolvable information, Optimal button in the Z-stack tool).

§

Acquisition of enough planes above and below the structure of interest. As a rule, acquiring
about half the axial PSF size above and below is enough to also get restoration of the structures at the top and bottom of the structure of interest.

§

Avoiding saturation of the detector.

§

Choosing imaging conditions to avoid sample bleaching.

§

Avoiding spherical aberrations by choosing objectives, which use a immersion medium with a
refractive index as close as possible to the mounting medium of the sample (for example using water immersion objectives for cell cultures in aqueous medium).

§

Choosing sample media with low background fluorescence (for example phenol red free culture media).

ZEN deconvolution is suitable for images from many different microscope types. The following list
of image types have been tested and are supported by ZEN deconvolution:

Imaging modality

Suitability for Deconvolution

Comment

Widefield fluorescence

+++

Ideally choose objectives
with a numerical aperture
>0.5.

LSM confocal imaging detecting

+++

Prerequisite is to have chosen a dye with the correct
excitation and emission
wavelengths before acquisition.

LSM Lambda and Online Fingerprinting imaging modes
detecting fluorescence

++

Exact excitation and emission
wavelengths are missing,
need to be added on the PSF
page before attempting deconvolution.

2-Photon (NLO) imaging using NDD (Non-descanned detectors)

+++

Excitation wavelength >
emission wavelength.

ApoTome fluorescence

+++

Only ApoTome raw images
should be deconvolved.

Spinning disk confocal

+

No spinning disk specific PSF
model available, still can get
good results when processing with a PSF according to
standard confocal conditions
(~1.2 airy units), or choose
measured PSF.
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Imaging modality

Suitability for Deconvolution

Comment

Lightsheet

-

Only single view deconvolution supported, image sizes
might be challenging, best
results for high NA objectives.

Airyscan

-

Airyscan raw data deconvolution is currently not supported, deconvolving already
processed images is not recommended.

Elyra

-

Currently not supported.

Bright field transmitted light
images

-

Not supported.

Axio Scan.Z1

+

Can be used for fluorescence
stacks, however, frequently
file sizes are prohibitive.
Also, ideally JPEG-XR compression should not be used.

Celldiscoverer 7

+++

Very well suited due to objectives specialized for life
cell imaging; recommended
use of Direct Processing
module to improve the
workflow.

12.7.6 Deconvolution Methods in ZEN
Method
(common name)

Reference

Settings

Comments

Nearest Neighbor

K. Castleman, “Digital image processing”, Prentice Hall
1997

Algorithm (default):

Ad-hoc “2D de-blurring algorithm” focuses on subtraction
of out of focus blur.

Regularized Inverse

For zero order g-difference:

Algorithm (default):

also known as:

Schaefer et al.
(2001)

Linear Least Squares

Nearest Neighbor

Regularized Inverse Filter

Uses difference of
observation and estimate as regularization term.

Advanced settings |
Regularization:
Zero order

Regularized Inverse
also known as:
Linear Least Squares

For first order regularization, or Good’s
roughness:
Verveer et al. (1997)

Algorithm:
Regularized Inverse

Uses Good’s roughness first derivative
of estimate as regularization term.

Advanced settings |
Regularization:
First order
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Method
(common name)

Reference

Settings

Comments

Regularized Inverse

Schaefer et al.
(2006)

Algorithm:

also known as:

Schaefer et al. (tbs)

Patented method for
maximum exploitation of ApoTome
raw images

Linear Least Squares

Advanced settings |
Regularization:

In conjunction with
structured illumination microscopy
(ApoTome)
Fast Iterative

Regularized Inverse

Zero / First order

Meinel (1986)

Algorithm (default):

Also known as:

Fast Iterative

Meinel Algorithm

Advanced settings |
Likelihood:

Gold Meinel

Classic, non-regularized Meinel algorithm.

Poisson (Meinel)
Fast Iterative

Meinel (1986),

Algorithm:

Meinel Algorithm +
Regularization:

For zero order g-difference:

Fast Iterative

Schaefer et al.
(2001)

Advanced settings:
- Likelihood:

Regularized Meinel
algorithm using gdifference (difference of observation
and estimate) term.

Poisson (Meinel)
- Regularization:
Zero order
Fast Iterative

Meinel (1986),

Algorithm:

Meinel Algorithm +
Optimization

Biggs (1998)

Fast Iterative
Advanced settings:
- Likelihood:

Meinel algorithm using a numerical gradient estimator as
proposed by D.
Biggs.

Poisson (Meinel)
- Regularization:
None / Zero order
- Optimization:
Numerical Gradient
Fast Iterative

Richardson (1972)

Algorithm:

Also known as:

Lucy (1974)

Fast Iterative

Richardson Lucy (RL)
Algorithm

Advanced settings |
Likelihood:
Poisson (Richardson, Lucy)

Fast Iterative

Richardson (1972)

Algorithm:

Also known as:

Lucy (1974)

Fast Iterative

Biggs (1998)

Advanced settings:
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(common name)

Reference

Richardson Lucy Algorithm +
Optimization
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Settings

Comments

- Likelihood:

convergence. About
a factor of 10 faster
than RL using a numerical gradient estimator as proposed
by D. Biggs.

Poisson (Richardson, Lucy)
- Optimization:
Numerical Gradient

Constrained Iterative

Verveer et al. (1997)

Algorithm (default):

Schaefer et al.
(2001)

Constrained Iterative
Advanced settings:
- Likelihood:
Poisson

Generic conjugate
gradient restoration
using squared estimate to impose positivity. Uses difference of observation
and estimate as regularization term.

- Regularization:
Zero order
Constrained Iterative

Verveer et al. (1997)

Algorithm:

Schaefer et al.
(2001)

Constrained Iterative
Advanced settings:
- Likelihood:
Poisson

Generic conjugate
gradient restoration
using squared estimate to impose positivity. Uses Good’s
roughness derivative
operator as regularization term.

- Regularization:
First order
Constrained Iterative

Tikhonov (1977)

Algorithm:

Verveer et al. (1997)

Constrained Iterative

Schaefer et al.
(2001)

Advanced settings:
- Likelihood:
Poisson
- Regularization:

Generic conjugate
gradient restoration
using squared estimate to impose positivity. Uses Tikhonov
Miller Phillips second
derivative operator
as regularization
term.

Second order
Constrained Iterative

Verveer et al. (1997)

Algorithm:

Schaefer et al.
(2001)

Constrained Iterative
Advanced settings:
- Likelihood:
Gauss

Generic conjugate
gradient restoration
using squared estimate to impose positivity. Uses difference of observation
and estimate as regularization term.

- Regularization:
Zero order
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Method
(common name)

Reference

Settings

Comments

Constrained Iterative

Verveer et al. (1997)

Algorithm:

Schaefer et al.
(2001)

Constrained Iterative

Generic conjugate
gradient restoration
using squared estimate to impose positivity. Uses Good’s
roughness derivative
operator as regularization term.

Advanced settings:
- Likelihood:
Gauss
- Regularization:
First order
Constrained Iterative
Also known as: ICTM
Iterative Constrained
Tikhonov Miller

van der Voort et al.
(1995) Verveer et al.
(1997)
Schaefer et al.
(2001)

Algorithm:
Constrained Iterative
Advanced settings:
- Likelihood:
Gauss
- Regularization:

Generic conjugate
gradient restoration
using squared estimate to impose positivity. Uses Tikhonov
Miller Phillips second
derivative operator
as regularization
term.

Second order
Constrained Iterative

Verveer et al. (1997)

Algorithm:

Schaefer et al.
(2001)

Constrained Iterative
Advanced settings:
- Likelihood:
Poisson/Gauss
- Regularization:
0/1/2nd order
- Optimization:

Generic conjugate
gradient restoration
using squared estimate to impose positivity.
Default for optimization is the fast
analytical (Newton
Raphson) method.
Line search may be
more accurate but is
also much slower

Line search / Analytical
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12.7.7 Table of Default Parameter for Deconvolution
The following table lists the parameters which are used by default for widefield, confocal, lightsheet and ApoTome images.

Microscope
Type

Widefield

Confocal

Lightsheet

ApoTome

General Deconvolution Parameter Defaults
Normali- zation

Auto

Auto

Auto

Auto

Backgound Correction

Off

Off

Off

Off

Flicker Correction

Off

Off

Off

Off

Decay Correction

Off

Off

Off

Off

Hot Pixel Correction

Off

Off

Off

Off

Auto

Auto

Manual (str 5)

Auto

Poisson

Poisson

Poisson

—

Regulari- zation

ZeroOrder

FirstOrder

ZeroOrder

—

Optimization

Analytical

LineSearch

Analytical

—

First Estimate

Input

Mean

Input

—

Maximum Number Of Iterations

40

7

40

—

Auto Stop Percentage

0.1

0.1

0.1

—

Poisson /
Richardson
Lucy

Poisson /
Meinel

—

Constrained Iterative Specific Defaults
Strength (automatic, manual;
range 0..10)
Likelihood

Fast Iterative Specific Defaults
Method

Poisson /
Meinel
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Microscope
Type

Widefield

Confocal

Lightsheet

ApoTome

Regulari- zation

None

None

None

—

Optimization

None

None

None

—

FirstEstimate

Input

Mean

Input

—

Maximum Number Of Iterations

15

50

15

—

AutoStop Percentage

0.1

0.1

0.1

—

Zero Order

Zero Order

First Order

Regularized Inverse Specific Defaults
Regulari- zation

Zero Order

12.7.8 Creating Deconvolution Settings
You can create settings for Deconvolution which can be saved, exported, and imported.
1. Open the Processing tab and select the method Deconvolution (adjustable).
2. In the Parameters window, activate Show All (if it is not already activated).
3. In the Input window, select the desired image for the Deconvolution.
Note: If you use the settings for Direct Processing, use a test image acquired with the identical experiment settings you will be using when running the experiment with Direct Processing.
4. Click on the context menu button

and select New from the drop-down list.

5. Enter a name for your settings and press the Enter key or click on the save button
.
6. Configure your settings in the Deconvolution or PSF settings tab.
For more information, see the help for Deconvolution tab [} 323] and PSF Settings tab
[} 329].
7. Click on the context menu button

and select Save.

You have now created and saved a Deconvolution setting. You can load this setting into the Direct Processing tool to use it for a Direct Processing experiment.

NOTICE
GPU
The setting also saves the status of the GPU. If you create the setting on a machine without a
GPU, export it, and import the setting on machine with GPU, the GPU will not be used. Therefore, the processing can be considerably slow. In this case, we recommend to create the setting directly on the machine where the processing is executed.
Exception for Direct Processing:
If you set up your experiment and your setting on an acquisition PC without a GPU, the processing PC will ignore the status and use the GPU (if available).

See also
2 Using Direct Processing with advanced deconvolution settings [} 350]
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12.8 Direct Processing
Direct Processing introduces functionalities directed to increase speed, usability, and reduce
costs for processing. Firstly, with Direct Processing you can select a processing function, which
is then directly executed as images are acquired. With this processing function, you save time by
avoiding lengthy post processing steps. Several different functions are available for Direct Processing. You can also define a sequence of functions (in a so-called pipeline), which are then executed one after another.
Secondly, Direct Processing allows an acquisition computer to communicate with a second PC
(processing computer) connected via a network connection. The acquisition computer instructs
the processing computer to process images as they are being acquired. Before you can use Direct
Processing, you need to connect the two computers. As there are numerous ways, how computers can be set up to become networked, we can only give some general advice here. Contact your
local IT administration for help on how to configure the computers in accordance to the local infrastructure.
One way is to connect the computer controlling the microscope system to a second computer via
a direct ethernet connection. If Network Discovery is switched on, Windows 10 will directly support such a point to point connection. Create a shared folder which can be accessed from both
computers. Since no other network traffic will use this connection, the whole bandwidth will be
available for saving data directly from the acquisition computer to a shared folder on the processing computer. This is the most efficient way as the acquired data do not have to be copied off the
acquisition computer after the acquisition has finished.
Alternatively, it is also possible, to use a processing computer which is already integrated into an
existing network. Depending on the network type and the kind of experiments being done, the
bandwidth might not be sufficient to directly stream data to the processing computer. In such
cases, to not limit the throughput of the acquisition, it is advisable to let the acquisition computer
acquire data to a local drive and instruct the processing computer where to look for the acquired
data.
For a communication via network, it is possible to link both computers with a discovery proxy. The
discovery proxy is a service where you can register all available processing computers and your acquisition computer can then ask this service for the list of these available PCs. You can also link
the PCs without such a discovery service, for which you then need the IP address and/ or network
name of the processing computer.
Note: It is possible to set up Direct Processing to acquire and process images on one and the
same workstation.

12.8.1 Direct Processing
This step-by-step-guide shows you how to perform Direct Processing.
§

Before using the Direct Processing functionality, the acquisition and the processing computers
need to be connected.
For more information, see also Connecting the acquisition computer with the processing
computer [} 344].

§

On the acquisition computer, settings need to be defined.
For more information, see also Direct Processing Tool on Acquisition Computer [} 351].

§

On the acquisition computer, settings in the Auto Save tool need to be defined.
For more information, see also Defining settings in the Auto Save tool [} 346].

§

On the processing computer, the receiving needs to be activated.
For more information, see also Direct Processing Tool on Processing Computer [} 354].
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Set up and run an experiment with Direct Processing.
For detailed information, see also Using Direct Processing [} 346].

See also
2 Using Direct Processing with advanced deconvolution settings [} 350]
2 Using Direct Processing with Airyscan [} 347]
2 Using Direct Processing with Deconvolution [} 349]

12.8.2 Connecting the acquisition computer with the processing computer
Before you can apply deconvolution on a processing computer, you need to connect the two
computers. For general information, see the Direct Processing [} 343]. For the communication via
network with or without a discovery proxy, please refer to the chapters Connecting the computers without discovery proxy [} 344] or Connecting the computers with discovery proxy [} 345] respectively.
12.8.2.1 Connecting the computers without discovery proxy
On the Processing PC
Prerequisite ü You are on the processing computer.
1. Open Tools > Options > Direct Processing.
2. Open the Setup Processing PC section and make sure that Announcement to Discovery
Proxy is deactivated.
3. Note down the name and/or the IP address and port of the processing PC. You can find the
IP and port under IP Address (this PC) and the computer name if you activate Send
Hardware Information. Alternatively, ask your IT department for information on how to
find the IP address or name of the computer.
Note: In some networks the computers might get assigned a new IP address over time
(e.g. each day), so using the computer name for establishing communication would be advisable.
4. If you want to display information about the processing computer on your acquisition computer, enter the information in the text box PC Description. If you want to have the hardware information, activate Send Hardware Information, and for displaying statistics
about the average job time, activate Send Processing Statistics.
5. Click on OK to close the Tools > Options dialog.
6. On the Applications tab, in the Direct Processing tool, click on Start Receiving.
Everything is now set up on the processing computer.
On the Acquisition PC
Prerequisite ü You are on the acquisition computer.
1. Open Tools > Options > Direct Processing.
2. Open the Setup Processing PC section and make sure that Announcement to Discovery
Proxy is deactivated.
3. Click on OK to close the Tools > Options dialog.
4. On the Acquisition tab, activate Direct Processing. This automatically activates Auto
Save as well.
5. In the Direct Processing tool, click on the Edit Connection button.
à The Connected Processing PCs dialog opens.
6. In the text fields, enter the name or the IP address and port of the processing computer.
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7. Click on Add.
à The processing computer is now added to the list.
8. Select your processing computer in the list and click on Connect. Alternatively, activate Automatically Select Processing PC and the processing PC is automatically selected for
each experiment based on the available PCs and their queue length (the PC with the shortest queue is selected).
à You are now connected to the processing computer.
9. Click on Close to exit the dialog.
Both computers are now connected and Direct Processing is set up. You can now configure and
run your experiment.

See also
2 Direct Processing [} 343]
2 Using Direct Processing with Deconvolution [} 349]
2 Using Direct Processing with advanced deconvolution settings [} 350]
2 Using Direct Processing with Airyscan [} 347]
12.8.2.2 Connecting the computers with discovery proxy
On the Processing PC
Prerequisite ü You are on the processing computer.
1. Open Tools > Options > Direct Processing.
2. Open the Setup Processing PC section and activate the checkbox Announcement to
Discovery Proxy.
3. Under IP Address (Discovery Proxy), enter the IP address and port of the discovery proxy.
4. If you want to display information about the processing computer on your acquisition computer, enter the information in the text box PC Description. If you want to have the hardware information, activate Send Hardware Information, and for displaying statistics
about the average job time, activate Send Processing Statistics.
5. Click OK to close the Tools > Options dialog and save the settings.
6. On the Applications tab, in the Direct Processing tool, click on Start Receiving.
Everything is now set up on the processing computer.
On the Acquisition PC
Prerequisite ü You are on the acquisition computer.
1. Open Tools > Options > Direct Processing.
2. Open the Setup Acquisition PC section and activate the checkbox Find from Discovery
Proxy.
3. Under IP Address (Discovery Proxy), enter the address of the Discovery Proxy. Alternatively, this can also be done or changed in the Connected Processing PCs dialog later.
4. Click on OK to close the Tools > Options dialog.
5. On the Acquisition tab, activate Direct Processing. This automatically activates Auto
Save as well.
6. In the Direct Processing tool, click on the Edit Connection button.
à The Connected Processing PCs dialog opens.
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7. Select your processing computer in the list and click on Connect. Alternatively, activate Automatically Select Processing PC and the processing PC is automatically selected for
each experiment based on the available PCs and their queue length (the PC with the shortest queue is selected).
à You are now connected to the processing computer.
8. Click on Close to exit the dialog.
Both computers are now connected and Direct Processing is set up. You can now configure and
run your experiment.

See also
2 Direct Processing [} 343]
2 Using Direct Processing with Deconvolution [} 349]
2 Using Direct Processing with advanced deconvolution settings [} 350]
2 Using Direct Processing with Airyscan [} 347]

12.8.3 Setting up your PC as discovery proxy
If you want to set up and use your computer as discovery proxy, take the following steps:
1.
2.
3.
4.

Open Tools > Options > Direct Processing > General Options.
For Communication Mechanism, select Network Based (WCF).
Open the Setup Discovery Proxy Server section and click on Start.
Click on OK to close the Tools > Options dialog.

This computer is now set up and used as discovery proxy.

12.8.4 Defining settings in the Auto Save tool
When using the Direct Processing functionality, perform the following steps on the acquisition
computer to define the settings in the Auto Save tool.
Prerequisite ü Acquisition tab > Auto Save tool is open.
1. In the Folder field, specify the directory, where acquired images will be stored. Under normal circumstances, this is automatically the folder, which has been specified as the communication folder. However, make sure that it is a shared folder which can be accessed from
both computers.
2. If you want images to automatically be stored in a new subfolder named with the current
date, activate the Automatic Sub-Folder option.
3. In the Name field, specify the file base name for the acquired images.
4. Activate the Close CZI Image After Acquisition option to release them from the acquisition computers memory.
On your acquisition computer, you have defined the settings in the Auto Save tool.

12.8.5 Using Direct Processing
Prerequisite ü You have connected acquisition and processing computer. For more information, see Connecting the acquisition computer with the processing computer [} 344].
ü To ensure that the processing computer reads incoming files and starts the processing, on the
Applications tab > Direct Processing tool, you have clicked the Start Receiving button.
ü On the Acquisition tab, you have set up your experiment for image acquisition.
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ü On the Acquisition tab, Direct Processing is activated. This activates the Auto Save tool as
well.
ü Depending on your settings, you have defined the folder where the acquired images are
stored in the Direct Processing or the Auto Save tool. For more information, see Auto Save
Tool [} 766]. Use a folder to which the processing computer has access.
1. On the Acquisition tab, open the Direct Processing tool.
2. From the Processing Function drop-down list, select the processing function you want to
use.
à The parameters of the function are displayed and the name of the function is displayed in
the pipeline container.
3. Set all the parameters of the function for your experiment. For detailed information about
the parameters refer to the descriptions of the individual image processing function.
4. To add another function or several other ones, click on Add Function.
à A new container is added in the pipeline.
5. Select the next pipeline container, select a processing function from the dropdown, and set
the parameters for each function.
à You have added and set up a sequence of processing functions.
6. Click on Start Experiment to run the experiment. Note: You can pause the processing. If
you stop the experiment, requests that have been sent earlier by the acquisition computer
are not processed. However, already processed images will be retained.
à The images are stored in the folder you have defined in the Auto Save or Direct Processing tool. When you abort the acquisition, the remote processing will not take place.
In case you have set up several processing functions, only the acquired image and the final output image are stored.
à The processing computer reads incoming files and starts the processing. The path to the
selected folder, the currently processed image as well as the images to be processed are
displayed in the Direct Processing tool. The processed image is saved to the same
folder specified in the Direct Processing tool. If the image name already exists in this
folder, the new file is saved under a new name <oldName>-02.czi.
7. To cancel the processing on the processing computer, on the Applications tab, in the Direct Processing tool, click on the Cancel Processing button.
Once processing is finished, you are notified on the acquisition PC and can open and view the acquired image as well as the processed image. This should be done on the processing computer, so
that you can immediately start a new experiment on the acquisition computer. However, you can
also automatically open the processed image on the acquisition PC with the respective setting on
the Direct Processing Tool on Acquisition Computer [} 351].
Information about Direct Processing (e.g. the duration) is available on the Info tab of the processed image.

See also
2 Using Direct Processing with Airyscan [} 347]
2 Using Direct Processing with Deconvolution [} 349]
2 Using Direct Processing with advanced deconvolution settings [} 350]

12.8.6 Using Direct Processing with Airyscan
Prerequisite ü This function is only available, if an Airyscan detector is available.
ü You have connected acquisition and processing computer. For more information, see Connecting the acquisition computer with the processing computer [} 344].
ü You have defined the settings on the acquisition computer. For more information, see Direct
Processing Tool on Acquisition Computer [} 351].
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ü To ensure that the processing computer reads incoming files and starts the processing, on the
Applications tab > Direct Processing tool you have clicked the Start Receiving button.
ü On the Acquisition tab, you have set up your experiment for image acquisition.
ü On the Acquisition tab, Direct Processing is activated. This activates the Auto Save tool as
well.
ü Depending on your settings, you have defined the folder where the acquired images are
stored in the Direct Processing or the Auto Save tool. For more information, see Auto Save
Tool [} 766]. Use a folder to which the processing computer has access.
1. In the Processing Function drop down list, select Airyscan Processing.

Note: If you uncheck the Auto Filter checkbox and activate Adjust per Channel, you can
set the Super Resolution parameter in a channel specific manner.
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2. Select the desired settings for Airyscan Processing. For details how to use of this function,
see Airyscan Processing [} 177]. Ideally, you have already checked the best parameters beforehand, using a sample image acquired under the same conditions as set up for the experiment.
3. Click on Start Experiment to run the experiment.
Note: You can pause the processing. If you stop the experiment, requests that have been
sent earlier by the acquisition computer are not processed. However, already processed images will be retained.
à The images are stored in the folder you have defined in the Auto Save or Direct Processing tool. When you abort the acquisition, the remote Airyscan processing will not
take place.
à The processing computer reads incoming files and starts the Airyscan processing. The
path to the selected folder, the currently processed image as well as the images to be
processed are displayed in the Direct Processing tool. The processed image is saved to
the same folder specified in the Direct Processing tool. If the image name already exists
in this folder, the new file is saved under a new name <oldName>-02.czi.
4. To cancel the processing, click on the Cancel Processing button.
Once processing is finished, you are notified on the acquisition PC and can open and view the acquired image as well as the processed images. This should be done on the processing computer
so that you immediately can start a new experiment on the acquisition computer. However, you
can also automatically open the processed image on the acquisition PC with the respective setting
on the Direct Processing Tool on Acquisition Computer [} 351].
When you open the image in the Image View, information about the executed Airyscan processing is available on the Info tab. Additionally, general information about Direct Processing (e.g. the
duration) is also available on the Info tab of the processed image.

12.8.7 Using Direct Processing with Deconvolution
Specify, how images should be processed during acquisition.
Prerequisite ü You have connected acquisition and processing computer. For more information, see Connecting the acquisition computer with the processing computer [} 344].
ü You have defined the settings on the acquisition computer. For more information, see Direct
Processing Tool on Acquisition Computer [} 351].
ü To ensure that the processing computer reads incoming files and starts the processing, on the
Applications tab > Direct Processing tool you have clicked the Start Receiving button.
ü On the Acquisition tab, you have set up your experiment for image acquisition.
ü On the Acquisition tab, Direct Processing is activated. This activates the Auto Save tool as
well.
ü Depending on your settings, you have defined the folder where the acquired images are
stored in the Direct Processing or the Auto Save tool. For more information, see Auto Save
Tool [} 766]. Use a folder to which the processing computer has access.
1. Select Acquisition tab > Direct Processing tool and select the processing function Deconvolution from the drop-down list. For details about Deconvolution operation and
which type of images are suitable for deconvolution, see Performing Deconvolution Using
Default Values [} 91].
2. Select a deconvolution method. We recommend Excellent, slow (Constraint Iterative).
3. Set up the experiment. For optimal processing efficiency, select the Full Z-Stack per channel option. This way, the processing can start as soon as a channel-Z-Stack has been completed.
4. Click on Start Experiment to run the experiment. Note: You can pause the processing. If
you stop the experiment, requests that have been sent earlier by the acquisition computer
are not processed. However, already processed images will be retained.
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à The images are stored in the folder you have defined in the Auto Save or Direct Processing tool. When you abort the acquisition, the remote deconvolution will not take
place.
à The processing computer reads incoming files and starts the deconvolution processing.
The path to the selected folder, the currently processed image as well as the images to
be processed are displayed in the Direct Processing tool. The processed image is saved
to the same folder specified in the Direct Processing tool. If the image name already exists in this folder, the new file is saved under a new name <oldName>-02.czi.
5. To cancel the processing on the processing computer, on the Applications tab, in the Direct Processing tool, click on the Cancel Processing button.
Once processing is finished, you are notified on the acquisition PC and can open and view the acquired image as well as the processed images. This should be done on the processing computer,
so that you immediately can start a new experiment on the acquisition computer. However, you
can also automatically open the processed image on the acquisition PC with the respective setting
on the Direct Processing Tool on Acquisition Computer [} 351].
When you open the image, in the Image View, on the Info tab, information about the executed
deconvolution is available. When Deconvolution is done through Direct Processing, the info about
Deconvolution parameters shows the suffix online and the Convergence History graph. Additionally, general information about Direct Processing (e.g. the duration) is also available on the
Info tab of the processed image.

12.8.8 Using Direct Processing with advanced deconvolution settings
Prerequisite ü You have connected acquisition and processing computer. For more information, see Connecting the acquisition computer with the processing computer [} 344].
ü You have defined the settings on the acquisition computer. For more information, see Direct
Processing Tool on Acquisition Computer [} 351].
ü To ensure that the processing computer reads incoming files and starts the processing, on the
Applications tab > Direct Processing tool you have clicked the Start Receiving button.
ü On the Acquisition tab, you have set up your experiment for image acquisition.
ü On the Acquisition tab, Direct Processing is activated. This activates the Auto Save tool as
well.
ü Depending on your settings, you have defined the folder where the acquired images are
stored in the Direct Processing or the Auto Save tool. For more information, see Auto Save
Tool [} 766]. Use a folder to which the processing computer has access.
ü You have advanced settings for Deconvolution. For more information, see Creating Deconvolution Settings [} 342].
1.
2.
3.
4.

On the Acquisition tab, open the Direct Processing tool.
Select the processing function Deconvolution from the drop-down list.
Activate the checkbox Use advanced Settings.
In the drop-down list, select your advanced settings for Deconvolution.
Note: Currently Direct Processing supports settings configured in the Deconvolution tab
of the image processing function Deconvolution (adjustable) and some settings of the
PSF tab.
5. Set up the experiment. For optimal processing efficiency, select the Full Z-Stack per channel option. This way, the processing can start as soon as a channel-Z-Stack has been completed.
6. Click on Start Experiment to run the experiment. Note: You can pause the processing. If
you stop the experiment, requests that have been sent earlier by the acquisition computer
are not processed. However, already processed images will be retained.
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à The images are stored in the folder you have defined in the Auto Save or Direct Processing tool. When you abort the acquisition, the remote Deconvolution will not take
place.
à The processing computer reads incoming files and starts the Deconvolution processing.
The path to the selected folder, the currently processed image as well as the images to
be processed are displayed in the Direct Processing tool. The processed image is saved
to the same folder specified in the Direct Processing tool. If the image name already exists in this folder, the new file is saved under a new name <oldName>-02.czi.
7. To cancel the processing on the processing computer, on the Applications tab, in the Direct Processing tool, click on the Cancel Processing button.
Once processing is finished, you are notified on the acquisition PC and can open and view the acquired image as well as the processed images. This should be done on the processing computer,
so that you immediately can start a new experiment on the acquisition computer. However, you
can also automatically open the processed image on the acquisition PC with the respective setting
on the Direct Processing Tool on Acquisition Computer [} 351].
When you open the image, in the Image View, on the Info tab, information about the executed
Deconvolution is available. When Deconvolution is done through Direct Processing, the info about
Deconvolution parameters shows the suffix online and the Convergence History graph. Additionally, general information about Direct Processing (e.g. the duration) is also available on the
Info tab of the processed image.

12.8.9 Functions & Reference
12.8.9.1 Direct Processing Tool on Acquisition Computer

Parameter

Description

Add Function

Adds another processing function to the pipeline.

Remove Function

Removes the currently selected processing function from the pipeline.

Pipeline

Displays a list of containers for possible processing functions. To set
the function for the currently selected container, use the Processing
Function dropdown list.
The functions in this pipeline are executed one after the other in the
sequence as given here. You can change the position of a function in
the pipeline via drag & drop.

Processing Function

Selects the processing function you want to use for Direct Processing for the currently selected container of the pipeline.

Parameter section

In this section you have different parameters, depending on the selected Processing Function. For more information, see:
§ Airyscan Processing Parameters [} 353]
§ ApoTome RAW Convert Parameters [} 179]
§ Deconvolution Parameters [} 353]
§ Denoise Parameters [} 116]
§ Unsharp Mask Parameters [} 159]

File Settings

-

Output Folder

Displays options to adjust setting for the output image(s).
Displays the path where the processed image is saved. Make sure that
a shared folder is selected where both the acquisition and the processing computers have access to.
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Description

-

Use Output
Folder from
Auto-Save

Activated: Synchronizes the output folder for Direct Processing with
the folder in the Auto Save tool. The Output Folder can only be
changed by editing the Folder in the Auto Save tool respectively.

-

Create Subfolders Automatically

Activated: Creates sub-folders in the output folder. All processed images end up in a new folder named with the current date.

-

Define File
Naming

Defines the filename of the processed image. Default: processed.czi.

-

Use Original
Name with Suffix

Activated: Uses the name of the file as it was acquired and adds the
defined file naming as a suffix.

-

File Name Preview

Displays a preview of the name of the processed acquisition image.

Processed Image

Selects if/how the processed image should be displayed here on the
acquisition PC.

-

Do Not Open
Automatically

The processed image is not opened automatically.

-

Display in Split
View

The processed image is displayed in a splitter document together with
the acquired image as soon as the first image data have been processed.

-

Only Open Final
Image

The processed image is displayed after processing is completed.

Connected Processing PC

-

Edit Connection

Displays the status of your connection to a processing PC (e.g. to
which you are connected, how the progress of your job is). If you are
not connected to a PC, you can edit your connections here.
Opens the Direct Processing PCs Dialog [} 355] which lists all the connected PCs that are ready to receive remote processing requests.
In case of file based communication, it checks if there is a processing
PC listening to the communication path. A message informs you
about the result.

For more information, see:
§

Using Direct Processing [} 346]

§

Using Direct Processing with Airyscan [} 347]

§

Using Direct Processing with Deconvolution [} 349]

§

Using Direct Processing with advanced deconvolution settings [} 350]
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12.8.9.1.1 Airyscan Processing Parameters
This set of parameters is only visible if Airyscan Processing is selected as Processing Function.
For the information, you can also see Airyscan Processing [} 177].

Parameter

Description

3D Processing

Only available for images with 5 or more z-positions.
If activated, this option improves the resolution in axial and lateral direction. The data set needs to have at least 5 z-sections acquired with
an optimal step size. 3D Processing is slower than 2D Processing. For
3D Processing, the whole z-stack (single channel and time point)
needs to fit into the physical memory.

2D SR Processing

Only available for 2D images.
Enhances the 2D resolution.
Note this only results in increased super resolution when images are
acquired with optimal settings and sufficient signal.

Auto Filter

If activated, a suitable Super Resolution parameter for the Airyscan
processing is automatically determined for the selected data set. To
manually adjust the Super Resolution parameter, deactivate the
checkbox.

Strength

Use this option for an increased (high) or decreased (low) strength of
the automatically assigned filter value. This is especially useful for 3D
processing, as the 2D preview of the processing filter value in the
Airyscan viewer does not allow to conclude the result after a 3D data
processing.
The increment of this parameter is ± 0.4 compared to the standard
auto Airyscan processing. This setting is not available when manual
processing strength is selected.

Adjust per Channel

Only visible, if Auto Filter is deactivated.
Only available for images with two or more Airyscan channels.
If activated, you can manually set channel specific Airyscan processing
parameters.

Super Resolution

Only available if Auto Filter is deactivated.
Manually adjusts the Super Resolution parameter.
Note: High strength might look attractive at some images, Z planes
or color channels, but other filtering artefacts might occur which appear like small rings in the image. Also the results will become very
sharp, but grainy. So carefully check your image data in order to avoid
such artefacts.

12.8.9.1.2 Deconvolution Parameters
This set of parameters is only visible if Deconvolution is selected as Processing Function.

Parameter

Description

Use advanced settings

Activated: Enables the drop-down menu to load an advanced Deconvolution setting.
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Description

Load Deconvolution Setting created in the Deconvolution function

Only available if Use advanced settings is activated.

-

Simple, very
fast (Nearest
Neighbor)

-

Better, fast
(Regularized Inverse Filter)

-

Good, medium
speed (Fast Iterative)

-

Excellent, slow
(Constraint Iterative)

ZEISS

Select advanced settings which were created in the image processing
function Deconvolution (adjustable). For more information, see
Creating Deconvolution Settings [} 342].
Note: Currently Direct Processing only supports settings configured in
the Deconvolution tab of the image processing function, the settings
on the PSF tab such as spherical aberrations correction cannot be
used in Direct Processing.
Only available if Use advanced settings is deactivated.
If Deconvolution is selected, the parameters are the same as for Deconvolution (defaults) except that Normalization will be set to Clip
in case of remote processing (normally it is Automatic). This is because only with Clip the output images show brightness values which
allow quantitative comparisons.
For Direct Processing, you cannot change any other values.
We recommend Excellent, slow (Constraint Iterative).
For more information, see Deconvolution (defaults) [} 323], for advanced Deconvolution see Deconvolution (adjustable) [} 323].

12.8.9.2 Direct Processing Tool on Processing Computer

Parameter

Description

Start / Stop Receiving

Starts or stops the reception of processing requests. The processing
computer waits for processing requests from the acquisition computer.
Note: If you click on Stop Receiving while an experiment is running,
the experiment is continued and processed. Only after finishing the
currently running experiment, a new experiment is processed.

Listening on

Shows the path where the computer is listening for processing requests.

Current request

Opens a dialog which shows the Listening directory. The current request field shows, which image is currently being processed. A
progress bar informs you, how close you are to completing the currently processed image.

Items in the queue

Displays the number of images to be processed. Note that due to the
integrative nature of the CZI images, individual scenes will not show
up as individual steps in the queue. Only when separated CZI documents are being produced, will the queue show a count >0.

Cancel Processing

Cancels the processing of the images in the output folder.

For more information, see Direct Processing [} 343].
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12.8.9.3 Direct Processing PCs Dialog

Parameter

Description

Use Discovery
Proxy

Activated: Uses a Discovery Proxy server for the communication between the computers. This control is synchronized with the respective
options in the Tools > Options > Direct Processing dialog.

–

Host Name

Only available, if Use Discovery Proxy is activated. Displays and edits
the name/IP address of the discovery proxy.

–

OK

Uses the defined Discovery Proxy.

Automatically Select Processing PC

Activated: Automatically selects a processing PC for each experiment
based on the available PCs and their queue length (the PC with the
shortest queue is selected).

Available Processing PCs list

Displays a list with all the available processing PCs. It provides the
name, an overview of how many jobs are currently in the Queue.
Your current PC is automatically listed, if you have clicked Start Receiving in the Direct Processing tool on the Applications tab.

–

Connect

–
Delete
Custom Processing
PC

Connects to the respective processing PC.
Only available for PCs that are added as Custom Processing PC.
Deletes the custom PC from the list.
Defines a custom PC for processing.

–

Host Name

Sets the name/IP address of the respective processing PC.

–

Port

Sets the port of the respective processing PC.

–

Add

Adds the defined custom PC to the list of available PCs.

Refresh

Refreshes the list of available PCs.

Close

Closes this dialog.

12.9 EM Processing Toolbox
This module offers functionality for the processing of FIB-SEM stacks. This chapter describes how
the different functions of the EM Processing Toolbox can be used to process a FIB-SEM-stack acquired with SmartFIB in the ZEN software. Note that parts of this special workflow also require
functionalities of the ZEN Connect module. To make yourself familiar with this module, see also
the documentation for ZEN Connect [} 562].
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12.9.1 Licensing of EM Processing
For using the EM Processing functionalities, you need the license for the EM Processing Toolbox module.
Overview
Product Name

EM Processing Toolbox

ZEN lite

n/a

ZEN pro

o

ZEN desk

o

ZEN system

o

ZEN slidescan

n/a

ZEN celldiscoverer

n/a

ZEN SEM

o

ZEN image processing

o

x=included; o=optional; n/a=not available

12.9.2 Workflow Overview
This chapter gives an overview how you can process your FIB-SEM stacks and align them. Consider the following workflow:
1. Sorting of image files:
With the function Sort SmartFIB Tiffs [} 121] you can sort your .tiff image files created by
SmartFIB according to channel name, number of pixels, image size, and spacing of the images, corresponding to slice thickness. Note that this function only works if the tiff files have
their default names (e.g. channel0_slice_0001.tiff or slice_0001.tiff)! Do not rename your files
before you use this function!
2. Image import and conversion:
With the special import functionality, you can import your FIB stack images and save them as
a czi for further processing in ZEN. You can import the stack into ZEN (see Importing SmartFIB
Tiffs [} 360]) or into ZEN Connect (see Importing a SmartFIB stack into ZEN Connect [} 573]).
3. Subset image creation:
If you want to reduce the imported z-stack to a particular z-range and region before applying
further processing steps, you can create a subset image of the imported FIB stack with the image processing function Create Image Subset [} 112].
4. Replacing individual slices in the z-stack:
If your stack contains image slices of bad quality which prevents further processing or segmentation, you can use the function Slices Replacement [} 120] to replace those slices with
the respective predecessor or successor. For more information, see also Replacing z-slices in a
z-stack [} 358].
5. Coarse alignment of the z-stack:
To minimize shifts in x and y in the z-stack and correct a potential beam shift, you can use the
image processing function Coarse Z-Stack Alignment [} 110] to roughly align the z-stack. For
more information, see also Aligning z-planes manually [} 357].
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6. Image processing:
Use the image processing functions [} 109] to process your image and reduce artifacts. For
general information about image processing, see also the chapter for the Image Processing
Workflow [} 90].
7. Automatic alignment of the z-stack:
Make an automatic fine alignment of the planes in your z-stack with the processing function
Z-Stack Alignment with ROI [} 122]. For more information, see also Aligning z-planes automatically (based on a ROI) [} 358].
8. Equalization:
Correct for variation of overall image intensity from image to image by equalizing the intensity
value throughout the entire z-stack with the function Z-Stack Equalization [} 123].
9. Cropping of a specific volume:
Identify a particular region of interest and cut it out of your stack with the function Cut Out
Regions [} 113]. For more information, see also Cutting out a volume from a z-stack [} 359].
10. Adding the processed z-stack to the ZEN Connect project:
Add your processed z-stack into the correlative workspace of the ZEN Connect module. For
this you can use the Add to Correlative Workspace button
in the toolbar, if you have
an open project. In the correlative workspace you can then align several z-stacks and images
(e.g. an overview image). For detailed information, see also Adding an open image to the ZEN
Connect project [} 568] and Aligning image data [} 576].
In order to import the data into a specific session in the ZEN connect project, right-click on
the respective session and select the czi file. The transformation that was applied to the session will then also be applied to the newly imported image.

12.9.3 Aligning z-planes manually
If you have an imported FIB-SEM stack which requires manual pre-alignment before using the automatic z-alignment, you can use the image processing function Coarse Z-Stack Alignment for
a manual alignment of your stack. See the following instruction.
Prerequisite ü You have opened your (imported) z-stack that needs alignment in ZEN.
1. On the Processing tab, select the image processing function Coarse Z-Stack Alignment.
2. Click on the Setup button.
à The Coarse Z-Stack Alignment Setup [} 111] opens.
à The current z-plane (selected by the Z-Position slider in the Dimensions tab) is displayed
in cyan and the following z-plane is displayed in red.
3. If you have an image with multiple channels, select the channel which should be displayed
in the Image View with the Channels tool.
4. With the Z-Position control in the Dimensions tab, go to the z-plane where the image
needs an alignment.
5. Select the Speed with which your alignment should be performed.
6. Shift the following z-planes with the arrow buttons in the top left of the setup until the x/ y
shift in the z-stack seems to be eliminated. Alternatively, you can also use the arrow keys
on your keyboard.
7. If necessary, adjust the speed step size during the alignment.
8. Repeat the steps 4 to 6 until all shifts in the z-stack are corrected.
à Every shift is displayed in the Shift List on the left side of the setup.
9. Click on Finish to save the changes and close the setup.
à The Shift List with all the shifts is displayed in the Parameters tool.
10. On the top of the Processing tab, click on Apply.
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You have now aligned the planes in your z-stack manually to correct a shift in x and/ or y within
the z-stack.

See also
2 Aligning z-planes automatically (based on a ROI) [} 358]

12.9.4 Aligning z-planes automatically (based on a ROI)
With the image processing function Z-Stack Alignment with ROI [} 122] you can perform an automatic alignment of the z-planes in a stack. This alignment can be based on a particular region of
interest that you can draw into your image.
Prerequisite ü You have opened your z-stack in ZEN.
1. On the Processing tab, select the image processing function Z-Stack Alignment with
ROI.
à The method's options are displayed in the Parameters tool.
2. For Quality, select the quality for the image alignment.
3. For Registration Method, select whether the alignment to optimize the z-stack should
perform a translation, a rotation, or both.
4. For Interpolation, select the interpolation method that should be used for the alignment.
5. Under Region, select Rectangle Region in the dropdown menu.
6. In the 2D view, draw a region of interest into your image to mark the structure(s)/ area of
particular interest.
7. In the Dimensions tab, use the Z-Position slider to check if the region of interest needs to
be adjusted. Note: The region of interest cannot be set for each plane individually. Make
sure that the drawn region is big enough to contain the structure(s)/ area of interest in every z-plane.
8. Adjust the region of interest if necessary. You can adjust and move it directly in the 2D view
or with the input fields in the Parameters tool.
9. If you want your output image to have the same size as your input image, activate the
checkbox Keep Size. The image will be cropped in the process, in the case that pixels are
shifted out of the area defined by the input image.
10. Under Channel Component, select one of the image channels whose alignment transformation matrix is then also applied to the other channel(s). If an alignment should be calculated for each channel individually, deactivate the checkbox Single Component. This step
is only applicable for images with multiple channels.
11. At the top of the Processing tab, click on Apply.
The z-planes of your image are now aligned automatically. The progress of the alignment process
is displayed in the progress bar on the bottom of the ZEN software.

12.9.5 Replacing z-slices in a z-stack
With the processing function Slices Replacement [} 120] you can replace slices of a z-stack with
the previous or next slice in the stack.
1. On the Processing tab, select the method Slices Replacement.
2. In the Dimensions tab, use the Z-Position slider or input field to select the slice you want
to replace.
3. Click on Replace with Next to replace the selected slice with the next one, or click on Replace with previous if you want to replace the slice with the previous one.
4. If you want to replace other slices as well, repeat the steps 2 and 3 for each slice.
à Each slice is listed in the Replacement Table on the left.
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5. Click on Apply.
You have now replaced the selected slice(s) with its previous and/or next one(s).
Replacing multiple slices
If you have several slices in your z-stack which you want to replace with the following or preceding slice, you can also take the following workflow:
1. On the Processing tab, select the method Slices Replacement.
2. Open the Gallery view of your z-stack.
3. In the Gallery view, press the Ctrl button and select all the slices you want to replace. As
an example, you select the slices 34, 37, and 38.
4. Click on Replace with Next to replace the selected slices with the next ones, or click on
Replace with previous if you want to replace the slices with the previous ones.
à Each slice is listed in the Replacement Table on the left. As an example, clicking Replace with previous would replace slice 34 with 33, and 37 and 38 with the slice 36.
5. Click on Apply.
You have now replaced the selected slices with its previous and/or next ones.

12.9.6 Cutting out a volume from a z-stack
With the processing function Cut Out Regions [} 113] you can define a region in your z-stack and
cut it out as a volume.
Prerequisite ü You have opened your z-stack in ZEN.
1. On the Processing tab, select the Method Cut Out Regions [} 113].
2. Under Parameters, click on Define Regions.
à The Define Regions setup [} 114] opens.
3. In the Dimensions tab, use the Z-Position slider to go to the first z-slice where you want
to mark your region of interest.
4. In the Region Edit section [} 114] on the left, click on Draw and select the type of region
you want to use (rectangular, circular, polygonal,...).
5. In the image, draw your so-called support region to mark the structure of interest.
6. Repeat the previous steps for the last slice where your structure of interest appears as well
as for those slices in between where significant changes (in shape and/or position) of this
structure take place.
7. Click on Interpolate.
à Interpolated regions are created for all slices between the support regions. The interpolated regions are displayed with a slightly darker color.
8. Use the Z-Position slider to move through your stack and examine whether the interpolated regions satisfyingly cover the structure of interest in your stack.
9. If you find a slice where the interpolated region does not cover your structure of interest,
draw a new support region on this slice and click on Interpolate again.
10. When the entire structure is marked satisfyingly by the interpolated regions, click on Finish.
à The Define Region setup closes and your image with the newly created regions is displayed in the Analysis view.
11. On the Processing tab, click on Apply.
Your marked structure is now cut out of the z-stack and opened as a new image.
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12.9.7 Importing SmartFIB Tiffs
In ZEN you can import SmartFIB stacks of Crossbeam microscopes. The orientation of these stacks
differs from standard z-stack acquisition, as the acquired images are tilted by a certain angle compared to a z-stack acquired on a light microscope. The import function calculates this tilt from the
metadata of the image. If the import finds no metadata concerning the tilt angle and the user
does not enter a value for the sample angle, it uses a default angle of 54 degrees (default angle
between FIB and SEM column at the Crossbeam) and the image is rendered with a 90 degree tilt
when displayed in a ZEN connect project. Alternatively, you can enter the angle of your sample
during import, e.g. as set during acquisition of the stack with SmartFIB, and the import then calculates the tilt angle based on this sample angle.
During import, the XY offset metadata of the individual slices is ignored by default and only the
offset of the first tiff file is considered. This default avoids the creation of a slanted z-stack, however in certain cases, such as on-grid-thinning configuration, the XY offset of the individual slices
needs to be taken into account.
1. On the Processing tab, select the image processing function Import SmartFIB TIFFs.
à The function settings are displayed in the Parameters tool.
2. Click on Select Files.
à A file browser opens.
3. Select the images you want to import as FIB stack.
Note: Select only images with consistent metadata with respect to number of pixels, image
size, and spacing of the images (i.e. use the Sort SmartFIB tiffs function before importing
the data).
Note: To make sure the stack is composed/ ordered correctly, watch out how the images
are sorted in the explorer and in which order you choose them.
4. Enter a File name for the FIB stack.
5. If you import images without scaling information, deactivate the Auto checkbox for XYScaling and manually enter the information.
Note: ZEN currently cannot determine automatically if scaling information is present.
6. You can set the slice distance manually if you deactivate the Auto checkbox for Z-Spacing.
This step is optional and should only be done if you have reason to believe the information
calculated with the metadata is incorrect. Leave the Auto checkbox activated and the slice
distance is automatically calculated with information saved in the metadata of the images.
Note: When you set the slice distance manually, the information in the metadata is ignored.
7. If you know the angle of your sample, deactivate the Auto checkbox for Sample Angle
and enter it. Otherwise the tilt for the image is calculated using the metadata, or the sample angle is set to the default of 54 degrees (default angle between FIB and SEM column at
the Crossbeam) and the image is rendered with a 90 degree tilt (if no information is available in the metadata).
8. If you want to consider the xy offset metadata of the individual slices for the import, activate the checkbox Read XY Offsets. Note that this can lead to a slanted z-stack depending on the sample and the metadata, assuming tilt correction was used during acquisition
with SmartFIB (e.g. if the metadata contain incorrect offset information).
9. Click on Apply.
The FIB stack is now imported into ZEN and a czi-file is created.
Note: When importing larger image files, it may take a while until the entire stack is visible in the
viewer.
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12.10 Guided Acquisition
With the Guided Acquisition module for ZEN (blue edition) you can create an automated
workflow to acquire images (overview), detect relevant objects (image analysis) and re-image
these positions, using another experiment, e.g. with higher magnification, Z-stack etc.
Guided Acquisition Workflow:
1. Scan or inspect a large area (or over a long period of time).
2. Perform an analysis to detect interesting objects
3. Acquire detailed images for every detected object
A possible application is to detect rare events, e.g. to find transfected cells. For example, the sample contains many cells that are stained with a blue dye, but only a few are additionally expressing
GFP. Guided Acquisition allows you to find these cells and run another, e.g. high-magnification,
experiment on these positions.
After performing a (low-magnification) overview scan, the image analysis detects all cells and determines which of them are expressing GFP, i.e. show a certain intensity in the GFP channel. Then
the microscope re-visits all GFP-expressing cells and performs a second acquisition there, e.g. with
higher magnification, a Z-stack etc.

The analysis results are saved automatically to a folder.
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12.10.1 Licensing of Guided Acquisition
For using the Guided Acquisition, you need the license for the Guided Acquisition module and
the Image Analysis license.
Overview
Product Name

Image Analysis

ZEN lite

o

ZEN pro

o

ZEN desk

x

ZEN system

x

ZEN slidescan

o

ZEN celldiscoverer

x

ZEN SEM

n/a

x=included; o=optional; n/a=not available

12.10.2 Preliminary work to Guided Acquisition
For a successful Guided Acquisition experiment, you need to prepare an overview and a detailed
experiment as well as an image analysis setting. If you want to process your overview image before it is analyzed, you also need a suitable setting for each processing step or function you want
to execute.
Overview scan
You have defined the experiment for the overview scan. Typically, the overview scan is using a
lower magnification in combination with a tile experiment.
Processing setting(s)
You have defined a suitable setting for each processing step or function you want to execute. For
more information, see General Settings [} 90].
Note that if you want to use Shading Correction with a reference image, you have to define your
setting in Batch mode!
Image analysis setting
You have defined a suitable image analysis setting. For more information, see Creating a new image analysis setting [} 369].
Detailed scan
You can perform for example the following experiments:
§

simple Z-stacks with a high-NA objective lens

§

Multi-Channel Z-stacks using an optical sectioning method like SD, Apotome or Airyscan

§

Tile experiments
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Parcentricity
If you use different detectors for the overview and the detailed scan, it might be necessary to correct for the shift between both detectors (to ensure parcentricity). For this you have to take an image at the exact same position with both cameras and then determine the offset between the
two (to ensure parcentricity). The reference to calculate this offset is the image taken with the
camera for the overview experiment. You can then enter the values for the shift in X and Y in the
guided acquisition setup.
Focus strategies
You have several options, to perform a focus strategy.
Detailed scan and overview scan can be defined with their own focus strategy using Focus Surface and/or Software Autofocus.
During the Guided Acquisition experiment, you can define additional focusing steps. These are independent from the focus strategy defined on the Acquisition tab. For more information, see Focus Strategy Tool [} 711].
For more information on Guided Acquisition, see Performing a Guided Acquisition [} 363].

12.10.3 Performing a Guided Acquisition
Prerequisite ü You have activated the Guided Acquisition module under Tools > Modules Manager >
Guided Acquisition.
ü You have calibrated the XY stage.
ü You have defined a suitable experiment for overview scans and for detailed scans.
ü You have defined a suitable setting for each processing step or function you want to execute.
ü You have defined a suitable image analysis setting using the Image Analysis Wizard or an
OAD macro that detects the objects of interest.
ü For more information, see Preliminary work to Guided Acquisition [} 362].
1. On the Applications tab, open the Guided Acquisition tool.
2. Create a setting to save your experiment setup. For more information, see Using Guided
Acquisition settings [} 365].
3. In the Overview Scan section, select the experiment you want to use for creating the overview image and the objective and (if available) after-magnification lens to be used. Note
that as default objective and after-magnification are not stored as part of an experiment.
For more information, see Set up a new experiment [} 44].
4. If your system is equipped with Definite Focus, the Find Surface and SW Autofocus
checkboxes are visible. Enable the checkbox to perform an additional focussing step before
the Overview Experiment.
5. If you want to process your overview image before it is analyzed, click on Add processing
method.
6. Select a Method for processing and a corresponding Setting.
7. In the Image Analysis section, select a suitable setting to analyze the overview scan and
detect the objects of interest.
8. In the Detailed Experiment section, select the experiment for the detailed scan, the objective and - if available - the after-magnification lens to be used. Note that as default objective and after-magnification are not stored as part of an experiment. For more information,
see Set up a new experiment [} 44].
9. If you use different detectors for the detailed and overview experiments, enter a X offset
and Y offset to correct the parcentricity.
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10. If your system is equipped with Definite Focus, the checkbox Find Surface is available. Enable this checkbox to use the Definite Focus to find z-position of the glass surface once before the detailed scans. Check SW Autofocus to perform a SW autofocus once before the
detailed scans. Optionally, check Recall Focus to store the difference between the glass
surface and the sample and use this value for each of the detailed experiments.
11. Define the folder where you want to store the experiment data.
12. Click Start.
An overview scan is performed and a .czi image is acquired and saved to your folder.

In the example above, the image in the top left shows the overview scan and three identified objects marked with an orange box. For these positions, a detailed scan is performed with a higher
magnification.
One Overview Scan Regions.csv and one OverviewScan Region.csv are displayed. The OverviewScan Region.csv table shows the found objects with ID, Bound Center X Stage [µm] and with Y
Stage [µm], Bound Width, and Bound Height [µm], as well as Image Scene Container
Name and Image Index Scene.
For each detected object a detailed scan is performed. For each object, a *.czi image is acquired
and stored in your folder.
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12.10.4 Using Guided Acquisition settings
Guided Acquisition offers you the possibility to save your whole experiment setup in a settings
file. This file is saved in the folder for your Guided Acquisition experiment together with all the
other settings (e.g. the overview and detailed experiment, the image analysis setting, and the image processing settings, if a processing step was selected).
Creating a Guided Acquisition setting
1. On the Applications tab, open the Guided Acquisition tool.
2. Click on the Options button

and select New.

3. Name the setting and press Enter or click on

.

You have created a setting for Guided Acquisition.
Saving a Guided Acquisition setting
When you have set up your Guided Acquisition experiment and created a setting, you can save
the set up as a setting.
1. Click on the Options button

and select Save.

Your experiment set up is now saved.
Importing and exporting a Guided Acquisition setting
1. On the Applications tab, open the Guided Acquisition tool.
2. Click on the Options button
and select Import or Export.
à A file browser opens.
3. Select the file you want to import or the folder where you want to export the setting to.
4. Click on Open / Save.
You have now imported/ exported a setting.
Deleting a Guided Acquisition setting
1. On the Applications tab, open the Guided Acquisition tool.
2. Select the setting that you want to delete in the drop down list.
3. Click on the Options button
and select Delete.
4. Confirm that you want to delete the file.
The selected setting is deleted.

See also
2 Performing a Guided Acquisition [} 363]
2 Guided Acquisition Tool [} 366]
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12.10.5 Functions & Reference
12.10.5.1 Guided Acquisition Tool

Parameter

Description

Options

-

New

Creates a new Guided Acquisition setting. Enter a name for the setting.

-

Rename

Renames the setting.

-

Save

Saves a modified setting under the current name. An asterisk indicates
the modified state.

-

Save As

Saves the current setting under a new name. Enter a name for the
setting.

-

Import

Imports an existing setting.

-

Export

Exports the current setting.

-

Delete

Deletes the current setting.

Overview Scan

-

Experiment

Selects the experiment setup to acquire the overview scan .

-

Objective

Selects the appropriate objective for the overview scan (typically with
a low magnification). If the objective has already been defined in the
experiment, it is read only/ greyed out here.

-

Optovar

Only visible if an optovar is available.
Selects the optovar for after magnification of the overview scan. If the
optovar has already been defined in the experiment, it is read only/
greyed out here.

-

Find Surface

Only visible if Definite Focus is licensed.
Performs a Find Surface before the overview scan. This step is independent from and additional to any focussing strategy defined in the
overview experiment.

-

SW Autofocus

Performs a SW Autofocus before the overview scan and sets the
found z-position as z-position for the overview scan. This step is independent from and additional to any focusing strategy defined in the
overview experiment.

-

Initial Range

Only available if SW Autofocus is activated.
Sets the range for the software autofocus.

Processing

-

Add processing
method

Section for processing steps to process the overview image before it is
analyzed.
Adds a step for a new processing method.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

366

12 Software Modules & Extensions | 12.10 Guided Acquisition

Parameter
-

Method

ZEISS

Description
Selects a processing method from a dropdown list.
Available processing methods:
§ Airyscan Processing
§ ApoTome Raw Convert
§ Deconvolution (defaults)
§ Shading Correction
§ Extended Depth of Focus

-

Setting

Selects the setting for the processing method from the dropdown list.
Note: If you want to use Shading Correction with a reference image, you have to define your setting in Batch mode!
Removes this entire processing step.

Remove
Image Analysis

-

Setting

Selects the Image Analysis Setting used to analyze the overview scan.

Detailed Experiment

-

Experiment

Selects the experiment setup to acquire a detailed scan at the position
of each object detected by the image analysis.

-

Objective

Selects the appropriate objective for the detailed scan (typically with
high magnification). If the objective has already been defined in the
experiment, it is read only/ greyed out here.

-

Optovar

Only visible if an optovar is available.
Selects the optovar for after magnification of the detailed scan. If the
optovar has already been defined in the experiment, it is read only/
greyed out here.

-

-

Detector Parcentricity Correction

Only visible if the detectors used in the overview and detailed experiment are different.

Find Surface

Only visible if Definite Focus is licensed.

Sets a correction for parcentricity for the two detectors. In the two
text fields you can enter the X offset and Y offset of the two different detectors in µm.

Performs a Find Surface before the first detailed scan. This step is independent from and additional to any focussing strategy defined in
the detailed experiment.
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Description

-

SW Autofocus

Performs a SW Autofocus before the first detailed scan and sets the
found z-position as z-position for the detailed scan. This step is independent from and additional to any focusing strategy defined in the
detailed experiment.
If the detailed experiment is not a tiles experiment the focus strategy
is automatically set to the “standard” behavior, i.e. the selected autofocus strategy will be performed on each tile of each detailed experiment or each timepoint for a time-series, respectively. If you want to
use a different strategy, e.g. perform the selected autofocus strategy
on each n-th tile of each detailed experiment, you have to activate the
Tiles checkbox for the detailed experiment.
Then you can select the desired frequency of autofocus in the Focus
Strategy tool under Stabilization Event Repetitions and Frequency when you switch to Expert mode.

-

Initial Range

Only available if SW Autofocus is activated.
Sets the range for the software autofocus.

-

Recall Focus

Only visible if Definite Focus is licensed and if both Find Surface and
SW Autofocus are checked.
Restores the saved focus position and applies it for each detailed experiment.

Output Folder

-

Output Folder

Determines the folder where the analysis results are saved.
A subfolder will automatically be created for each run of a Guided Acquisition experiment.
Note: When a ZEN Connect project is open, the output folder cannot
be set here, but is defined by the ZEN Connect project.
Note: When using Guided Acquisition with Direct Processing, make
sure that the processing computer has access to this output folder!

Open output
folder after execution

Activated: Opens the output folder after Guided Acquisition is finished.

Start

Starts Guided Acquisition.
The Start button turns into a Stop button as long as Guided Acquisition is running. Click on Stop to stop the running Guided Acquisition
workflow.

See also
2 Software Autofocus Tool [} 507]
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12.11 Image Analysis
This module enables you to create automatic measurement routines very easily. The Image Analysis wizard guides you through the steps to create an automatic measurement program. It allows
you to set up even complex measurement tasks easily. The steps of the wizard include image segmentation, object separation and measurement of geometrical or intensity features. After you
have completed the setup you can apply these settings to the data to be analyzed and obtain precise measurement results. You can display the results in table and list form and export them to
csv-format.
For more information, see the following examples:
§

Measuring Fluorescence Intensity in a Multichannel Image [} 371]

§

Counting Number of Fluorescence Signals per Nuclei [} 375]

§

Measuring Mean Fluorescence Intensity on a Ring around the Primary Object [} 382]

§

Counting the number of Objects in a Ring around the Nucleus [} 389]

See also the following descriptions:
§

Image Analysis Tool [} 775]

§

Image Analysis Wizard [} 777]

12.11.1 Creating a new image analysis setting
When creating a new analysis setting for your images, you can select the following segmentation
methods:
§

Segment region classes independently: This method allows you to define several classes
and subclasses. With this method, you can define the segmentation algorithm for each class
independently.

§

ZOI (Zones of Influence): This method constructs a zone of influence (ZOIs) and a ring
around each primary object. The primary objects are generated by segmenting the selected
image channel with the selected class segmenter. The ring is defined by its width and distance
from the primary object. The distance from the ZOI border from the ring can be specified. The
ZOI area also incorporates the primary object and ring area.

§

Segment binary images: This method allows you to segment binary images. With this
method, you can define several classes and subclasses. The step Automatic Segmentation
uses the defined binary image channels for each class to segment the image.

§

Whole image: This segmenter uses the whole image as a region. You can use this to perform
e.g. intensity measurements on the whole image without detecting objects. Therefore it is not
possible to create more classes or subclasses.

§

Interactive Segmentation: This method allows you to define multiple classes and subclasses. Unlike the other methods, it does not include an automatic segmentation step but
uses only the interactive segmentation step. That means, for each class all regions must be
drawn manually.

1. On the Analysis tab, in the Image Analysis tool, click on Options
and select New
from the dropdown menu.
2. In the Settings field, enter a name for your image analysis setting. Click on Save.
à A new *.czias file is created and saved in the ...\ZEN\Documents\Image Analysis Settings folder.
à You have created a new image analysis setting. As default the method "Segment region
classes independently" is used.
3. Click on Edit

.
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à The Segmentation Method Selection dialog opens.
4. From the Method drop down menu, select a method and click on OK.
à You have created a new image analysis setting using the method of your choice.
5. In the Image Analysis tool, click on Setup Image Analysis.
The Image Analysis Wizard opens with the Classes step and includes already a predefined set
of classes, depending on the selected method. Follow the steps in the wizard to define your image analysis. Each method comes with a predefined set of steps which allows you to make all
necessary settings for image analysis.
§

Classes: Allows you to add classes and subclasses.

§

Frame: Allows you to define a measurement frame. Only the area of the frame will be analyzed.

§

Region Filter: Allows you to define simple or complex conditions to filter the detected objects according to their parameters.

§

Automatic Segmentation: Allows you to set the parameters for the automatic segmentation.

§

Interactive Segmentation: Allows you to modify the results of the automatic segmentation
or draw/delete objects. Note: this step only generates relevant results in Analyze Interactively run.

§

Features: Allows you to select measurement features from an extensive list and to define
measurement features for classes and subclasses independently.

§

Results Preview: Shows a preview of your measurement results for the current view port.

For more information, see the following examples:
§

Measuring Fluorescence Intensity in a Multichannel Image [} 371]

§

Counting Number of Fluorescence Signals per Nuclei [} 375]

§

Measuring Mean Fluorescence Intensity on a Ring around the Primary Object [} 382]

§

Counting the number of Objects in a Ring around the Nucleus [} 389]

12.11.2 Creating an image analysis setting from an analyzed image
It is possible to create / extract an image analysis setting from an image which has already been
analyzed. This allows you to ensure that a new data set is analyzed exactly in the same way as a
previously analyzed data set.
Prerequisite ü You have an already analyzed image.
1. Open your already analyzed image in ZEN.
2. On the Analysis tab, in the Image Analysis tool, click on Options
3. In the drop down list, select Create setting from analyzed image.
4. Type in the name you want to give the analysis setting.
5. Press Enter or click on

.

.

You have now created and saved an image analysis setting from an already analyzed image.
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12.11.3 Measuring Fluorescence Intensity in a Multichannel Image
This topic will show you how to set-up a measurement program using the Image Analysis Wizard. After the setup is successfully completed, the program will be used to measure fluorescence
intensity in a multichannel image.
In this example we are using a multichannel image with 2 channels (1st channel blue, (DAPI) ),
2nd channel red (mRFP1)) of fluorescence-stained cells. First we detect the blue-stained cell nuclei
in the first channel. Then we measure the fluorescence intensity for both channels for the detected nuclei.

See also
2 Creating a new image analysis setting [} 369]
12.11.3.1 Step 1: Classes
Prerequisite ü You have created a new image analysis setting with the Segment region classes independently method.
ü You have opened the Image Analysis Wizard. For more information, see Creating a new image analysis setting [} 369].
1. In the Image Analysis Wizard 1/7 Classes, click on Class1 in the list and enter DAPI Individual Nuclei in the Name input field.
2. Click on Classes1 in the list and enter DAPI All Nuclei in the Name input field.

3. Click on Next.
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12.11.3.2 Step 2: (Measurement frame)
1. Deactivate the Interactive checkbox.
2. Click on Next.
12.11.3.3 Step 3: Automatic segmentation
1. Click on DAPI Individual Nuclei entry in the list.
2. In the Threshold section set the Tolerance parameter to 1%.
3. Click in the image on the blue-stained cell nuclei.
à The detected nuclei are overlaid in blue. The threshold values are displayed in the
Threshold section in the Lower / Upper input fields.

4. Click on the areas of the blue cell nuclei that have not yet been detected until these have
been completely overlaid.
5. Activate the Fill Holes checkbox.
à This fills any holes in the detected cell nuclei.
6. Select the Watersheds entry from the dropdown list in the Separate section and set the
number to 3.
à Clear separation lines are now visible between the cell nuclei.

7. Click on Next.
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12.11.3.4 Step 4: Region Filter
1. Deactivate the Execute checkbox.
2. Click on Next.
12.11.3.5 Step 5: Interactive segmentation
1. Deactivate the Interactive checkbox.
2. Click on Next.
12.11.3.6 Step 6: Features
1. Click on the DAPI Individual Nuclei entry in the list.
2. Click on the Edit button in the Region Features section.
à The Feature Selection dialog is opened.
3. Double-click on Intensity Mean Value of channel 'DAPI' and Intensity Mean Value of
channel 'mRFP1' features, one after another.
à The features are displayed in the Selected Features list on the left.
4. Remove superfluous features (e.g. Area, Perimeter) from the list. Select the feature and click
on the Delete button
.
5. Activate the Display checkbox for the features.

6. Click on OK.
à The selected features are displayed in the Region Features section.
7. In the section Annotation Options, activate the checkbox Color.
8. Select Yellow from the drop-down list.
9. Click on Next.
12.11.3.7 Step 7: Results Preview
1. Click on DAPI All Nuclei in the list.
à The number of measured cell nuclei is displayed in the data table to the right of the image.
2. Click on DAPI Individual Nuclei in the list.
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à The object ID and the values for the average fluorescence intensities per channel are displayed in the image at the cell nuclei in question and in the data list to the right of the
image.

3. Click on the Finish button.
à This saves the measurement program.
12.11.3.8 Executing the measurement program
Prerequisite ü You are in the Image Analysis tool.
ü You have loaded the measurement program that you have generated.
1. Click on the Analyze button.
à The measurement program is applied to the image.
à The Analysis View now also appears in the Center Screen Area.
2. In the Analysis View you will see your image with the measured cell nuclei overlaid in blue
and, to the right of this, the data list containing the individual measurements.
3. Deactivate the Fill checkbox in the Analysis control element.
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à The selected cell nuclei are displayed as contours.

4. Click on a row in the data list or alternatively on a cell nucleus in the image.
à The row in the data list containing the measurement values is highlighted. The associated
cell nucleus is surrounded by a red rectangle.
There is a direct link between the measured cell nuclei in the image and the measured values in
the data table. You can either click on a measured cell nucleus in the image or on a row in the
data table.l

12.11.4 Counting Number of Fluorescence Signals per Nuclei
This topic will show you how to set-up a measurement program using the Image Analysis Wizard. After this the program will be used to count the number of fluorescence spots in a multichannel image.
In this example we are using a multichannel image with 2 channels (1st channel blue (DAPI), 2nd
channel green (GFP)) of fluorescence-stained cell nuclei. First we detect the blue-stained cell nuclei
in the first channel and then the green stained signals in the second channel. Then we measure
the number of green fluorescence signals per nucleus.

See also
2 Creating a new image analysis setting [} 369]
12.11.4.1 Step 1: Classes
Prerequisite ü You have created a new image analysis setting with the Segment region classes independently method.
ü You have opened the Image Analysis Wizard. For more information, see Creating a new image analysis setting [} 369].
1. In the1/7 Classes, click on Classes1 in the list and enter Nuclei in the Name input field.
2. Select a blue color from the dropdown list in the Color section.
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3. Click on the Class1 entry in the list and enter Individual Nucleus in the Name input field.
4. Click on the blue channel icon in the Channel section .

5.
6.
7.
8.

à You have now setup a class pair for the nuclei.
Click on the Add Subclass button .
Click on Classes3 in the list and enter Signals in the Name input field.
Select a green color from the dropdown list in the Color section
Click on the Class3 entry in the list and enter Individual Signal in the Name input field.
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9. Click on the green channel icon in the Channel section.

à You have now setup a subclass for the signals inside the Individual Nucleus class (parent
class).
10. Click on Next.
12.11.4.2 Step 2: Measurement frame
1. Deactivate the Interactive checkbox.
2. Click on Next.
12.11.4.3 Step 3: Automatic Segmentation
1. Click on the Individual Nucleus entry in the list.
à The segmentation parameters (Smooth, Sharpen, Minimum Area, etc.) are displayed
below the list.
2. In the Smooth section select Gauss from the dropdown list and set the parameter Sigma
to 1.5.
3. Click on the blue-stained cell nuclei in the image.
à The detected nuclei are overlaid in blue. The threshold values are displayed in the
Threshold section in the Lower / Upper input fields.
4. Click on the areas of the blue cell nuclei that have not yet been detected until these have
been completely overlaid.
5. Select the Watersheds entry from the dropdown list in the Separate section and set the
number to 17.
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à Clear separation lines are now visible between the cell nuclei.

6. Click on the Individual Signal entry in the list.
à The segmentation parameters (Smooth, Image Sharpness, Minimum Area, etc.) are
displayed below the list.
7. In the Smooth section select Gauss from the dropdown list and set the parameter Sigma
to 1.5.
8. Click in the image on the green-stained signals.
à The detected signals are overlaid in green. The threshold values are displayed in the
Threshold section in the Lower / Upper input fields.
9. Click on the areas of the green signals that have not yet been detected until these have
been completely overlaid.
10. Activate the Fill Holes checkbox.
11. This fills any holes in the detected signals.
12. In the Separate section select the Watersheds entry from the dropdown list and set the
number to 17.
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à Clear separation lines are now visible between the signals.

13. Click on Next.
12.11.4.4 Step 4: Region Filter
1. Deactivate the Execute checkbox.
2. Click on Next.
12.11.4.5 Step 5: Interactive Segmentation
1. Deactivate the Interactive checkbox.
2. Click on Next.
12.11.4.6 Step 6: Features
1. Click on the Nuclei entry in the list.
2. Click on the Edit button in the Regions Features section.
à The Feature Selection dialog is opened.
3. Double-click in the right-hand list on the ID.
à The features are displayed in the Selected Features list on the left.
4. Remove superfluous features from the list. Select the feature and click on the
Delete button.
5. Click on the Individual Nucleus entry in the list.
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6. Click on the Edit button in the Features of individual regions section.
à The Feature Selection dialog opens.
7. Double-click in the right-hand list on the ID of the parent.
à The features are displayed in the Selected Features list on the left.
8. Remove superfluous features (e.g. Area, Perimeter) from the list. Select the feature and click
9.
10.
11.
12.

on the
Delete button.
Click on the Signals entry in the list. This list contains the statistical features of the individual signals.
Click on the Edit button in the Regions Features section.
à The Feature Selection dialog opens.
Double-click in the right-hand list on the ID, Count.
à The features are displayed in the Selected Features list on the left.
For the newly added feature Count, open the Copy drop-down menu and select Copy to
the parent single region.
à The feature is copied to the results table of the parent, in this case the individual nucleus.

13. Remove superfluous features from the list. Select the feature and click on the
Delete button.
14. Click on the Individual Signal entry in the list.
15. Click on the Edit button in the Features of individual regions section.
à The Feature Selection dialog opens.
16. Remove superfluous features (e.g. Area, Perimeter) from the list. Select the feature and click
on the
Delete button.
17. Click on the OK button.
à The selected features are displayed in the Regions Features section.
18. Click on Next.
12.11.4.7 Step 7: Results Preview
1. Click on Nuclei in the list.
à The number of measured nuclei is displayed in the data table to the right of the image.

2. Click on Individual Nucleus in the list.
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à The ID of the parent, the ID and Signals Count (the number of green signals) of the measured nuclei is displayed in the data list to the right of the image.

3. Click on Signals in the list.
à The ID of the parent (corresponds to the ID of the nucleus) and the number of measured signals are displayed in the data table to the right of the image.

4. Click on the Finish button.
à This saves the measurement program.
12.11.4.8 Executing the measurement program
Prerequisite ü You are in the Image Analysis tool.
ü You have loaded the measurement program that you have generated.
1. Click on the Analyze button.
à The measurement program is applied to the image.
à The Analysis View now also appears in the Center Screen Area.
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à In the Analysis View you see your image with the measured cell nuclei overlaid in blue
and the signals overlaid in green. Right of this, you see the data list containing the number of signals per nucleus.

à Only the number of signals of measured nuclei is displayed. Nuclei touching the frame
are not taken into account.

12.11.5 Measuring Mean Fluorescence Intensity on a Ring around the Primary Object
The following example shows how to use the Zone of Influence (ZOI) method to measure intensities within a ring that is associated to the main object, e.g. the cell nucleus. An application example are transport assays where the intensities of a certain fluorescent marker in the cytoplasm are
compared to the intensities within the nucleus.
In this example we use a multichannel image of fluorescence-stained cells. The cell nuclei are
stained with AF568 and the mitochondria are stained with AF488. First, we detect the nuclei in
the AF568-channel as primary object. A zone of influence is generated around each detected primary object. In this area, we can define a ring and specify its thickness and distance from the
main object. You can use this ring to measure intensities or to detect further sub-objects on it. For
more information, see Counting the number of Objects in a Ring around the Nucleus [} 389].

See also
2 Creating a new image analysis setting [} 369]
12.11.5.1 Step 1: Classes
Prerequisite ü You have set up the image analysis setting with the method ZOI (Zones of Influence). This
has created the classes ZOIs/ZOI, Primary Objects/Primary Object, and Rings/Ring by default.
ü You have opened the Image Analysis Wizard. For more information, see Creating a new image analysis setting [} 369].
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1. If you want to extend the predefined list of classes, in the Image Analysis Wizard 1/6
Classes, click Add Subclass.
à You can find an example how to detect objects on the ring in Counting the number of
Objects in a Ring around the Nucleus [} 389].
2. If neccessary, click Add Class to extend the predefined list by another independent class of
objects.
Note that you cannot add further rings.
3. Select the image channel which you want to use for object detection. In this example, the
primary objects (the nuclei) are in the AF568 channel. Therefore, click on the class Primary
Object and select the channel containing the nuclei.

Parameter

Description

ZOIs

Class of all zone of influences

ZOI

Individual zone of influence

Primary Objects

Class of all primary objects

Primary Object

Individual primary object

Ring

Individual ring

Ring Segment

Part of a ring (a ring often consists of only one ring segment)

Add Class

Adds a new independent class (under base).

Add Subclass

Adds a new subclass to primary object, ring or another class.

Remove Class

Removes the selected class or subclass.

Name

Name of the classes. You can rename them, if necessary.

Channel

Select the channel to be used for object detection
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Parameter

Description

Color

Changes the color how the classes will be displayed.

ZEISS

12.11.5.2 Step 2: Frame
Optionally, you can define the area to be analyzed of each image. In case there are shading effects or other reasons that make you want to include only a certain area of each image for analysis, you can define a frame (rectangle, circle or polygon). Only the area within this frame will be
further analyzed.
With the Mode parameter, you can furthermore choose how the analysis treats objects that are
cut by the border of the image or the frame:
§

Cut at frame: Cuts the objects at the frame.

§

Inside only: Discards all objects that are cut by the frame.

Note that the whole ZOI is taken into account for the decision if the object is inside the frame or
not (not only the primary object). This means there are cases where the primary object might lie
completely within the image / frame, but the Ring or ZOI is cut by the border. If you select Inside
only these objects will be discarded.
Comparison of image analysis results for Cut at frame compared to Inside only:

Fig. 16: Cut at frame

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

384

12 Software Modules & Extensions | 12.11 Image Analysis

ZEISS

Fig. 17: Inside only
12.11.5.3 Step 3: Automatic Segmentation
1. Select Primary Object and set up suitable parameters to detect the objects, i.e. threshold,
area, separation.
à As soon as objects are detected, the ZOI and Ring are automatically created around each
primary object with the preset parameters.
2. To modify Ring Distance and Width, select the Ring Element class.
à Now, you can define the location and dimension of the ring flexibly. You can set it at the
edge of the main object or inside the main object. You can also define an arbitrary distance.
3. Define the following parameters:
à Ring Distance: Distance from surface of the primary object. Negative values means that
the ring starts at the defined distance within the primary object. Ring Width: Defines the
width of the ring.
à The ZOI is automatically adapted to exceed the class with the larger diameter, i.e. either
ring or primary object, by at least 3 pixel (default setting).
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Fig. 18: Ring distance: 0 pixel; Ring width: 10 pixel

Fig. 19: Ring distance: 5 pixel; Ring width: 10 pixel

Fig. 20: Ring distance: -5 pixel; Ring width: 5 pixel
Modifying the ZOI Width
1. Select ZOI-class, and with the ZOI Width slider, set the distance. You can set the distance
between the outer border of the ZOI and the outer border of either ring or primary object,
respectively. The ZOI Width is at least 3 pixels larger than either the ring or the primary object, whichever is larger. The ZOI area incorporates also the area of the ring and the primary
object, and thus can serve for example for measuring features over the complete cell.
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Fig. 21: ZOI Width set to 30 pixel
12.11.5.4 Step 4: Region Filter
You can define conditions for the primary objects (and additionally defined subclasses) to be measured, e.g. include only objects of a certain size, shape, intensity or other parameters. You can define suitable parameters for each of the defined objects.
1. Select the Primary Object and click Edit. From the list of features on the right, you can
add features via double-click. Once you have added all desired features, click OK.
à The selected conditions appear in the left tool area.
2. Set the minimum and maximum values by clicking on the objects with the desired features,
or by entering the numbers directly.
The following figure is an example and shows the result if a certain condition of the circularity of
each primary object needs to be fulfilled.

Fig. 22: Region Filter based on the circularity of the primary object
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12.11.5.5 Step 5: Features
You can define individual measurement features for each class. You can copy the measurement
features defined for one class to the other classes via Copy to all.
1. Select the class for which you want to define measurement features, and click Edit. From
the list of features on the right you can add features to the selected features list on the left.
à These features are automatically calculated for every object during image analysis. All
classes have the ID of the parent and ID as default features. With these IDs you can later
group the associated parameters from the result excel lists, if necessary.
à The class Ring additionally has Area and Count as default parameters.
à To attribute the mean intensity for channel AF488 (the mitochondria) measured on the
Ring to the Primary Object, select Ring and click Edit The Feature Selection window
opens.

2. From the feature list on the right select Intensity Mean Value of channel 'AF488' and
add it to the selected features on the left. In the Copy column, from the drop-down menu
in the Intensity Mean Value of channel 'AF488' row, click
.
à This measurement feature is copied to the corresponding Primary Object.
12.11.5.6 Step 6: Result Preview
In this step you see a preliminary result of the image analysis.
1. Click on the different objects in the Analysis tab to get the preliminary measurement result
for all objects.
2. Click Finish, to save the analysis settings and close the wizard.
à The wizard closes. The analysis settings are saved.
12.11.5.7 Executing the measurement program
You have the following options to run a predefined image analysis setting on your data set:
§

Analyze Interactively: Analyze interactively with all steps that have been selected with the
checkbox Interactive during setup of the image analysis.

§

Analyze: Runs the image analysis setting without dialog.

When the analysis is finished, the main view switches to the Analysis tab and displays the segmented image along with the results of the analysis.
Select the different objects to display the corresponding measurement tables. The data in the tables and the regions in the image are interlinked. A click on the object in the image highlights the
corresponding line in the data table and vice versa.
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12.11.6 Counting the number of Objects in a Ring around the Nucleus
This example is similar to Measuring Mean Fluorescence Intensity on a Ring around the primary
Object [} 382] and also uses the same data. This example shows how to count the number of objects on a ring that is associated with the main object, e.g. the cell nucleus. The images are taken
from AF568 stained nuclei. The mitochondria are stained with AF488. The channel of the nuclei is
used for image segmentation. The ZOI-segmentation method attributes a zone of influence (ZOI)
and a ring to each detected nucleus. This area is used as a search range to detect subobjects, in
this case the mitochondria.

See also
2 Creating a new image analysis setting [} 369]
12.11.6.1 Step 1: Classes
Prerequisite ü You have created a new image analysis setting using the ZOI method.
ü You have opened the Image Analysis Wizard. For more information, see Creating a new image analysis setting [} 369].
1. In the Image Analysis Wizard 1/6 Classes, select Ring or Ring Element and click Add
Subclass to extend the predefined set of classes with a subclass of the Ring Element.
2. Another class below the Ring Element is added. Give this class a meaningful name, e.g. Mitochondria / Mitochondrion.
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3. The cell nuclei (primary objects) are stained with AF568 (red channel), therefore you need
to select this channel to segment the cell nuclei. Select Primary Object and for Channel
select AF568.

4. Click on Mitochondrion and in the field Channel select AF488.
à The mitochondria are stained with AF488, therefore you need to use this channel for image segmentation.
12.11.6.2 Step 2: Frame
For more information, see Step 2: Frame [} 384].
12.11.6.3 Step 3: Automatic Segmentation
Prerequisite ü For more information, see Step 3: Automatic Segmentation [} 385].
1. Additionally, you need to set the segmentation parameters for the object Mitochondrion.
Choose suitable parameters to segment the objects.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

390

12 Software Modules & Extensions | 12.11 Image Analysis

ZEISS

à You have detected the mitochondria on the ring.

12.11.6.4 Step 4: Region Filter
For more information, see Step 3: Automatic Segmentation [} 385].

See also
2 Measuring Mean Fluorescence Intensity on a Ring around the Primary Object [} 382]
12.11.6.5 Step 5: Features
You can define individual measurement features for each class. The measurement features defined for one class you can copy to the other classes via Copy to all.
1. Select the class for which you want to define measurement features, and click Edit. From
the list of features on the right you can add features to the selected features list on the left.
à These features are automatically defined for every object during image analysis. All
classes have ID of the parent and ID as default features. This allows you to later to
group the associated parameters from the excel lists, if necessary.
à The class Ring additionally has Area and Count as default parameters.
2. In this example, we count the number of objects (the number of mitochondria fragments)
within each ring. To attribute the number of mitochondria fragments to the Primary Object, select Mitochondria and click Edit.
à The Feature Selection dialog opens.
3. In the parameter list on the right, select the feature Count. In the Copy drop-down menu,
click
.
à This measurement feature is copied to the corresponding Primary Object.
12.11.6.6 Step 6: Preview Result
In this step you see a preliminary result of the image analysis.
1. Click on the different objects in the Analysis tab to get the preliminary measurement result
for all objects.
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2. Select the Primary Object to get a list with preliminary measurement results with the features ID of the parent, ID, Area, and Ring Mitochondria Counts. Note that the results are
preliminary and only include the part of the image you see in the viewport.

à The result of the image analysis shows Ring Mitochondria Counts as a feature of Primary Object.
3. In the table, click on column Ring Mitochondria Counts to sort the entries in increasing
or decreasing order.
4. Click on Finish to save the analysis settings and to close the wizard.
You can now run the analysis as described in Measuring Mean Fluorescence Intensity on a Ring
around the Primary Object [} 382].

12.11.7 Performing an interactive analysis
The image analysis tool allows you to perform an analysis interactively. It runs the selected analysis setting with all the steps that have been marked as interactive in the setup. Steps that you
have not marked as interactive in the Image Analysis Wizard are run with the values predefined
in the image analysis setting. The program does not pause to allow you to change these values interactively.
Analyze Interactively also allows you to directly execute an image analysis on an czi image without predefining an image analysis setting. For that you need to have an image analysis setting
where all steps are marked as interactive. Then it is possible to modify every step of the Image
Analysis Wizard during Analyze Interactively and do a one-time image analysis on the dataset
without creating a new setting. In order to retrieve an image analysis setting from an already analyzed dataset, see Creating an image analysis setting from an analyzed image [} 370].
Note: When you analyze an image interactively, the modifications of the settings during the interactive analysis are not saved.
Prerequisite ü You have defined an image analysis setting where all analysis steps you want to adjust interactively are marked as interactive.
1. On the Analysis tab, open the Image Analysis tool.
2. For Setting, select your image analysis setting.
3. Click on Analyze Interactively.
à The Image Analysis Wizard opens with all the steps that are defined as interactive in
the setting.
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4. Modify your settings for each step and click on Next to get to the following step in the
wizard.
5. At the end, click on Finish to close the wizard.
You have now analyzed your image interactively and the results of this analysis are displayed.

12.11.8 Creating a measurement data table
1. Click on the Create Measurement Data Table button on the Analysis tab.
à The two data lists are now separate documents.
2. Save each of the data lists via the File menu | Save As. Allocate a name and select .csv as
the file type.
à The measurement data tables are saved in CSV format and can therefore be opened directly in Excel.
3. Click on the image and save it via the File menu | Save As. Allocate a name and select .czi
as the file type.
The image is saved with the measurement results. If you open the image, the measurement results can be viewed in the Analysis View.

12.11.9 Charts and Tables of the Analysis View
The Analysis View shows different charts and tables depending on the analysis, the experiment,
and the selected options in the Custom Chart tab [} 857]. The axes of the charts are configured in
the Custom Chart tab and the shown analysis results are always those of the class selected in the
Analysis tab. An image of the charts can be exported with the Chart Export Tab [} 856]. You can
zoom into a chart by using the mouse wheel or drawing a zoom rectangle. To zoom out to the
original view, double click on the background of the plot.

Info
§

To highlight the row of the table containing the measured values of an object, click on a
segmented object in the image or in the chart. To highlight multiple rows, press Ctrl and
click on multiple object/ data points.

§

To highlight the corresponding segmented object in the image, click on a row in the table
or on the data point in the chart. To highlight multiple objects, press Ctrl and click on multiple rows/ data points.

§

To highlight the measured value of an object in the scatter chart or in the histogram, click
on one or more rows in the table. The corresponding data point in the chart turns red. To
change the chart type, on the Custom Chart tab, click on the corresponding Chart Type
button. To highlight multiple objects, press Ctrl and click on multiple rows/ objects.
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Standard table and chart
As a standard, a table with all analysis results and a chart configured according to the input in the
Custom Chart tab are shown besides the analyzed image.

Multiple Scenes chart
For experiments containing multiple scenes, the Analysis View offers a chart which shows the results of all / multiple scenes. To see this chart, activate the checkbox Multiple Scenes in the Custom Chart tab. You can customize the displayed results with the Sample Carrier tab. For more
information, see Selecting data for the multiple scenes chart [} 396].

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

394

12 Software Modules & Extensions | 12.11 Image Analysis

ZEISS

Time Series chart
For time series experiments, the Analysis View offers a chart and table which display the analysis
results over time. To see this chart, activate the checkbox Time Series in the Custom Chart tab.
You can use the slider (the blue box) to browse through the individual points in time, which highlights the respective data in the table, and vice versa.

Heatmap
For multi well / multi chamber experiments, the Analysis View offers a heatmap to display the
measurement results on a well / chamber level. To see this map, activate the checkbox Heatmap
in the Custom Chart tab.

See also
2 Custom Chart tab [} 857]
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12.11.9.1 Selecting data for the multiple scenes chart
Prerequisite ü In the Custom Chart tab, the Multiple Scenes checkbox must be activated.
1. Click on the Sample Carrier tab.
2. Select the desired well/ scene. To select multiple wells/ scenes, press the Ctrl key and click
on the individual wells. Alternatively, select the desired wells with the pressed left mouse
key. To select a specific region of wells, press the Shift key and click on the two wells which
mark the corners of the region.
The chart displays the data of the selected wells/ scenes.

See also
2 Custom Chart tab [} 857]
2 Sample Carrier Tab [} 857]
12.11.9.2 Heatmap Calculation
The heatmap displayed in the Analysis View is calculated based on statistical features which you
add in the Features step of the Image Analysis Wizard.
The statistical measurement is done on the basis of the top class objects of your analysis setting.
Consider the following example:

To calculate, for example, the Mean Area of the Classes 1, the area of all Class 2 objects is
summed up and then the total area is divided by the count of objects.
This table shows the offered statistical parameters and the calculation description:

Parameter

Description

Area

Calculates the total area of all objects found in a well or chamber.

Area Percentage

Calculates the percentage that the area of all objects has in respect to
the whole frame area (area of all objects divided by the whole frame
area).

Count

Calculates the count of objects.

Intensity Std

Calculates the intensity standard deviation divided by the number of
objects.

§ sn = Number of the scenes in a well or chamber
§ os = Number of objects found in the scene s
§ xi = Intensity standard deviation of the object i
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Parameter

Description

Mean Intensity

Calculates the mean value of the mean of the intensity and divides it
by the number all objects in all scenes.

§ sn = Number of the scenes in a well or chamber
§ os = Number of objects found in the scene s
§ xi = Intensity mean value of the object i
Mean Area

Calculates the mean value of the mean of the area and divides it by
the number of all objects in all scenes.

§ sn = Number of the scenes in a well or chamber
§ os = Number of objects found in the scene s
§ xi = Mean area of the object i

12.11.10 Measurement Features
The software can automatically detect and measure the following properties of objects:
ACP X Unscaled

The x coordinate of the first pixel in the first line of a region
To identify measurement objects, the image is scanned from
top left to bottom right. The so-called ACP (anti-coincidence
point) is the first point that has been identified for a new object. The parameter Acp X indicates the x-coordinate of this
point.
§ Unit: pixels
§ Value range: 1 ... image size in x-direction

ACP X Unscaled WCS

The x coordinate of the first pixel in the first line of a region
To identify measurement objects, the image is scanned from
top left to bottom right. The so-called ACP (anti-coincidence
point) is the first point that has been identified for a new object. The parameter Acp X indicates the x-coordinate of this
point in the world coordinate system (WCS).
§ Unit: pixels
§ Value range: 1 ... image size in x-direction
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The y coordinate of the first pixel in the first line of a region
To identify measurement objects, the image is scanned from
top left to bottom right. The so-called ACP (anti-coincidence
point) is the first point that has been identified for a new object. The parameter Acp Y indicates the y-coordinate of this
point.
§ Unit: pixels
§ Value range: 1 ... image size in y-direction

ACP Y Unscaled WCS

The y coordinate of the first pixel in the first line of a region
To identify measurement objects, the image is scanned from
top left to bottom right. The so-called ACP (anti-coincidence
point) is the first point that has been identified for a new object. The parameter Acp Y indicates the y-coordinate of this
point in the world coordinate system (WCS).
§ Unit: pixels
§ Value range: 1 ... world coordinate size in y-direction

Area

Area of a region
Area of a region excluding any holes it may contain. The areas
of the holes are not included in the measurement. If you want
to include them, use the Area filled parameter.
§ Unit: Unit of area of the scaling assigned to the image (e.g.
μm²)

Area Convex

Area of convex hull of a region
The current region is surrounded by a convex polyline. The
(filled!) area of the resulting region is then measured.
§ Unit: Unit of area of the scaling assigned to the image (e.g.
μm²)

Area Filled

Area of filled region
Area of a region including any holes it contains. The holes are
interpreted as belonging to the region or are filled prior to the
measurement. If you do not want the holes to be measured,
use the Area parameter.
§ Unit: Unit of area of the scaling assigned to the image (e.g.
μm²)

Area Filled
Unscaled

Area of filled region
Area of a region including any holes it contains. The holes are
interpreted as belonging to the region or are filled prior to the
measurement. If you do not want the holes to be measured,
use the Area parameter.
§ Unit: pixels²
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Area of a region unscaled
The Area unscaled parameter corresponds to the Area parameter. However, the scaling of the image is not taken into
account for the measurement. The (unfilled!) area of a region is
displayed in pixels in each case.
§ Unit: pixels²

Bound Bottom

Minimum y-coordinate of the bounding box of a region
Indicates the y-coordinate of the bottom edge of a bounding
box for a region. The box is drawn in parallel to the x and y
axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Bound Bottom Unscaled

Minimum y-coordinate of the bounding box of a region
Indicates the y-coordinate of the bottom edge of a bounding
box for a region. The box is drawn in parallel to the x and y
axis.
§ Unit: pixels

Bound Bottom Unscaled
WCS

Minimum y-coordinate of the bounding box of a region
Indicates the y-coordinate in the world coordinate system
(WCS) of the bottom edge of a bounding box for a region. The
box is drawn in parallel to the x and y axis.
§ Unit: pixels

Bound Bottom WCS

Minimum y-coordinate of the bounding box of a region
Indicates the y-coordinate in the world coordinate system
(WCS) of the bottom edge of a bounding box for a region. The
box is drawn in parallel to the x and y axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Bound Height

Indicates the height (size in y-direction) of a bounding box for
a region. The box is drawn in parallel to the x and y axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)
§ Formula: Bound top - Bound bottom
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Indicates the height (size in y-direction) of a bounding box for
a region. The box is drawn in parallel to the x and y axis.
§ Unit: pixels
§ Formula: Bound top - Bound bottom

Bound Left

Minimum x-coordinate of the bounding box of a region
Indicates the x coordinate of the left-hand edge of a bounding
box for a region. The box is drawn in parallel to the x and y
axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Bound Left
Unscaled

Minimum x-coordinate of the bounding box of a region
Indicates the x coordinate of the left-hand edge of a bounding
box for a region. The box is drawn in parallel to the x and y
axis.
§ Unit: pixels

Bound Left
Unscaled
WCS

Minimum x-coordinate of the bounding box of a region
Indicates the x coordinate in the world coordinate system
(WCS) of the left-hand edge of a bounding box for a region.
The box is drawn in parallel to the x and y axis.
§ Unit: pixels

Bound Left
WCS

Minimum x-coordinate of the bounding box of a region
Indicates the x coordinate in the world coordinate system
(WCS) of the left-hand edge of a bounding box for a region.
The box is drawn in parallel to the x and y axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)
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Maximum x-coordinate of the bounding box of a region
Indicates the x coordinate of the right-hand edge of a bounding box for a region. The box is drawn in parallel to the x and y
axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Bound Right
Unscaled

Maximum x-coordinate of the bounding box of a region
Indicates the x coordinate of the right-hand edge of a bounding box for a region. The box is drawn in parallel to the x and y
axis.
§ Unit: pixels

Bound Right
Unscaled
WCS

Maximum x-coordinate of the bounding box of a region
Indicates the x coordinate in the world coordinate system
(WCS) of the right-hand edge of a bounding box for a region.
The box is drawn in parallel to the x and y axis.
§ Unit: pixels

Bound Right
WCS

Maximum x-coordinate of the bounding box of a region
Indicates the x coordinate in the world coordinate system
(WCS) of the right-hand edge of a bounding box for a region.
The box is drawn in parallel to the x and y axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Bound Top

Maximum y-coordinate of the bounding box of a region
Indicates the y coordinate of the top edge of a bounding box
for a region. The box is drawn in parallel to the x and y axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)
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Maximum y-coordinate of the bounding box of a region
Indicates the y coordinate of the top edge of a bounding box
for a region. The box is drawn in parallel to the x and y axis.
§ Unit: pixels

Bound Top
Unscaled
WCS

Maximum y-coordinate of the bounding box of a region
Indicates the y coordinate in the world coordinate system
(WCS) of the top edge of a bounding box for a region. The box
is drawn in parallel to the x and y axis.
§ Unit: pixels

Bound Top
WCS

Maximum y-coordinate of the bounding box of a region
Indicates the y coordinate in the world coordinate system
(WCS) of the top edge of a bounding box for a region. The box
is drawn in parallel to the x and y axis.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Bound Width

Indicates the width (size in x-direction) of a bounding box for a
region. The box is drawn in parallel to the x and y axis.
§ Formula: Bound right - Bound left
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Bound Width
Unscaled

Indicates the width (size in x-direction) of a bounding box for a
region. The box is drawn in parallel to the x and y axis.
§ Formula: Bound right - Bound left
§ Unit: pixels
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The x coordinate of the geometric center of gravity of a region
Depending on the shape of the object, this point may also lie
outside a region. The associated y-coordinate is determined via
the Center Y parameter.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Center X Unscaled

The x coordinate of the geometric center of gravity of a region
Depending on the shape of the object, this point may also lie
outside a region. The associated y-coordinate is determined via
the Center Y parameter.
§ Unit: pixels

Center X Unscaled WCS

The x coordinate in the world coordinate system (WCS) of the
geometric center of gravity of a region
Depending on the shape of the object, this point may also lie
outside a region. The associated y-coordinate is determined via
the Center Y parameter.
§ Unit: pixels

Center X
WCS

The x coordinate in the world coordinate system (WCS) of the
geometric center of gravity of a region
Depending on the shape of the object, this point may also lie
outside a region. The associated y-coordinate is determined via
the Center Y parameter.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Center Y

The y coordinate of the geometric center of gravity of a region
Depending on the shape of the object, this point may also lie
outside a region. The associated y-coordinate is determined via
the Center X parameter.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)
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The y coordinate of the geometric center of gravity of a region
Depending on the shape of the object, this point may also lie
outside a region. The associated y-coordinate is determined via
the Center X parameter.
§ Unit: pixels

Center Y Unscaled WCS

The y coordinate in the world coordinate system (WCS) of the
geometric center of gravity of a region
Depending on the shape of the object, this point may also lie
outside a region. The associated y-coordinate is determined via
the Center X parameter.
§ Unit: pixels

Center Y WCS

The y coordinate in the world coordinate system (WCS) of the
geometric center of gravity of a region
Depending on the shape of the object, this point may also lie
outside a region. The associated y-coordinate is determined via
the Center X parameter.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Circularity

Sqrt(Roundness) = Sqrt(4 × Area / (π × FeretMax²))

Compactness

4 × π × Area / PerimeterConvex²

Convexity

PerimeterConvex / PerimeterCrofton

Diameter

Diameter of a circle with an area equal to that of the object
The object is measured using the Area) parameter. A circle
with the same area as the object is created. The diameter of
this circle is returned.
§ Formula: Sqrt ((4 / π) × Area)
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Diameter Unscaled

Diameter of a circle with an area equal to that of the object
The object is measured using the Area) parameter. A circle
with the same area as the object is created. The diameter of
this circle is returned.
§ Formula: Sqrt ((4 / π) × Area1)
§ Unit: pixels
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Angle of the major axis of the ellipse
The major axis of an ellipse with the same geometric moment
of inertia as the current region is determined in accordance
with the Ellipse major parameter. The angle to the x-axis is
then determined. The indication of the angle always relates to
a counterclockwise direction.
§ Unit: degrees
§ Value range: 0 ... 180°

Ellipse Angle
Unscaled

Angle of the major axis of the ellipse
The major axis of an ellipse with the same geometric moment
of inertia as the current region is determined in accordance
with the Ellipse major parameter. The angle to the x-axis is
then determined. The indication of the angle always relates to
a counterclockwise direction.
§ Unit: degrees
§ Value range: 0 ... 180°
This tool uses unscaled pixels for calculating the angle. The results may differ from the results of Ellipse Angle.

Ellipse Major

Length of the major axis of the ellipse
Length of the major axis of an ellipse with the same geometric
moment of inertia as the region. The moment of inertia is calculated about the center of gravity of the region.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Ellipse Major
Unscaled

Length of the major axis of the ellipse
Length of the major axis of an ellipse with the same geometric
moment of inertia as the region. The moment of inertia is calculated about the center of gravity of the region.
§ Unit: pixels

Ellipse Minor

Length of the minor axis of the ellipse
Length of the minor axis of an ellipse with the same geometric
moment of inertia as the region. The moment of inertia is calculated about the center of gravity of the region.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)
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Length of the minor axis of the ellipse
Length of the minor axis of an ellipse with the same geometric
moment of inertia as the region. The moment of inertia is calculated about the center of gravity of the region.
§ Unit: pixels

Feret Maximum

Maximum feret of a region
The maximum feret of a region is determined on the basis of
distance measurements. Two straight lines are positioned on
opposite sides of the object, like a sliding caliper, at 128 angle
positions. The corresponding distance is measured for each angle position. The maximum value determined is the maximum
feret.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Feret Maximum Angle

Angle of the maximum feret of a region in relation to the xaxis
The maximum feret is determined as described in Feret Maximum. The angle of the maximum feret in relation to the x-axis
is then determined. The indication of the angle always relates
to a counterclockwise direction.
§ Unit: degrees
§ Value range: 0 ... 180°

Feret Maximum Unscaled

Maximum feret of a region
The maximum feret of a region is determined on the basis of
distance measurements. Two straight lines are positioned on
opposite sides of the object, like a sliding caliper, at 128 angle
positions. The corresponding distance is measured for each angle position. The maximum value determined is the maximum
feret.
§ Unit: pixels

Feret Minimum

Minimum feret of a region
The minimum feret of a region is determined on the basis of
distance measurements. Two straight lines are positioned on
opposite sides of the object, like a sliding caliper, at 128 angle
positions. The corresponding distance is measured for each angle position. The minimum value determined is the minimum
feret.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Feret Minimum Angle

Angle of the minimum feret of a region in relation to the x-axis
The minimum feret is determined as described in Feret Minimum. The angle of the minimum feret in relation to the x-axis
is then determined. The indication of the angle always relates
to a counterclockwise direction.
§ Unit: degrees
§ Value range: 0 ... 180°
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Minimum feret of a region
The minimum feret of a region is determined on the basis of
distance measurements. Two straight lines are positioned on
opposite sides of the object, like a sliding caliper, at 128 angle
positions. The corresponding distance is measured for each angle position. The minimum value determined is the minimum
feret.
§ Unit: pixels
b

Feret Ratio

Feret ratio
The ratio of Feret Minimum to Feret Maximum is calculated. This ratio makes it possible to make statements on the
form of the measured objects. If the feret ratio has a low
value, long, elongated objects are present. Values approaching
1 indicate the presence of compact or circular objects, as in
this case Feret Minimum and Feret Maximum have very
a:b similar values. The Form circle is also suitable for making
statements on the circularity of an object.

a

§ Formula: FeretMin / FeretMax (a / b)
§ Unit: none
§ Value range: 0 ... 1
Feret Vertical
to Maximum

The ratio between the feret distance at 0° and the Feret Maximum

a b

§ Unit: none

a:b
Fiber Length

Length of a fiber-like region
To calculate the fiber length, a structure that is actually similar
to a fiber is required. Here it is not the distance between a
start and end point that is determined. The check can be done
using the Form circle, among other things.
§ Formula: ¼ × (Perimeter + (Sqrt (Perimeter² - 16 × Area))
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Fiber Length
Unscaled

Length of a fiber-like region
To calculate the fiber length, a structure that is actually similar
to a fiber is required. Here it is not the distance between a
start and end point that is determined. The check can be done
using the Form circle, among other things.
§ Formula: ¼ × (Perimeter1 + (Sqrt (Perimeter1² - 16 × Area))
§ Unit: pixels
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Form factor of a region
Describes the form of a region on the basis of its circularity. A
perfect circle is given the value 1. The more elongated the region is, the smaller the form factor. The calculation is based on
the Area filled and Perimeter Crofton parameters.
§ Formula: 4 × π × Area / PerimeterCrofton²
§ Unit: none
§ Value range: 0...1

ID

Sequential ID of the object

ID of the Parent

Sequential ID of the object's parent

Image Container Category

Returns the container category (e.g. sample, control) of the
current scene (well).

Image Index
Block

Index for the individual image slices of a multi-block image.

Image Index
Position

Index for the individual image slices of a Position List image.

Multi-block images are composed of blocks of different dimensions.

If the image was acquired using the Position List tool, the Image Index Position returns the number of the image that
contains the object.
In contrast, the ID parameter is a global counter, i.e. the number of the object.
The Index Position can be used to guarantee unambiguous
assignment between measured regions in the image and the
individual lines of a data table, especially in cases where several images are measured, as automatic assignment is then no
longer possible. To achieve this, the Index Region parameter
must also be selected as a region feature and also be inserted
into the graphics plane as an annotation(Draw Features). It is
also advisable to activate the Image name parameter as a region feature so that the correct original image can be
reloaded.
§ Restriction: This value is only available for images that have
previously been acquired with AxioVision or saved in AxioVision ZVI format.
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Image Index
Scene

Index for the individual image slices of a scene image

Image Index
Time

Index for the individual image slices of a time series image.

Image Index
Z

Index for the individual image slices of a Z stack image.

Image Scene
Name

Returns the name of the scene (well).

Indicates the unambiguous number of the scene in an image.
The word Scene refers to a coherent object on a slide that
contains several objects for examination. The Index Scene can
be used to guarantee unambiguous assignment between measured regions in the image and the individual lines of a data table, especially in cases where several images are measured, as
automatic assignment is then no longer possible. To achieve
this, the Index Region parameter must also be selected as a
region parameter and must also be inserted into the graphics
plane as an annotation (Draw Features). It is also advisable to
activate the Image name parameter as a region parameter so
that the correct original image can be reloaded.

Index
Intensity
Maximum of
channel 'C1'

The pixel value of the brightest pixel in the object.

Intensity
Mean Value
of channel
'C1'

The average brightness (pixel value) of the pixels in the object.

Intensity Minimum of
channel 'C1'

The pixel value of the darkest pixel in the object.

Intensity
Range of
channel 'C1'

The difference between the pixel value of the brightest and
darkest pixels in the object, i.e. Intensity Maximum of channel 'C1'-Intensity Minimum of channel 'C1'

Intensity
Standard Deviation of
channel 'C1'

The standard deviation of the brightness (pixel value) of the
pixels in the object.

Number of
the region
holes

Calculates the number of holes enclosed by the object
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Perimeter of a region
This parameter is specially optimized for measuring the perimeters of circles. If the measured region contains holes, the total
perimeter including the perimeters of the hole structures is determined. If you only want the perimeter of the outside contour to be determined, use the Perimeter filled parameter.
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Perimeter Unscaled

Perimeter of a region
This parameter is specially optimized for measuring the perimeters of circles. If the measured region contains holes, the total
perimeter including the perimeters of the hole structures is determined. If you only want the perimeter of the outside contour to be determined, use the Perimeter filled parameter.
§ Unit: pixels

Radius

Radius of a circle with an area equal to that of the object
The object is measured using the Area) parameter. A circle
with the same area as the object is created. The radius of this
circle is returned.
§ Formula: Sqrt ((1 / π) × Area)
§ Unit: Unit of the scaling assigned to the image (e.g. μm)

Radius Unscaled

Radius of a circle with an area equal to that of the object
The object is measured using the Area) parameter. A circle
with the same area as the object is created. The radius of this
circle is returned.
§ Formula: Sqrt ((1 / π) × Area1)
§ Unit: pixels

Region Class
Color

Returns the color of the class to which the object is assigned

Region Class
ID

Returns the ID of the class to which the object is assigned

Region Class
Name

Returns the name of the class to which the object is assigned

Roundness

Formula: 4 × Area / (π × FeretMax2)
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12.12 ImageJ
This extension offers following possibilities:
§

Easy exchange of images, from simple two-dimensional images, to more complex, multidimensional entities, like Z-stacks, time series and so on. The exchange can go both ways, from
ZEN to ImageJ, as well as from ImageJ to ZEN.

§

Execute functions in ImageJ, without having to leave the ZEN environment.

§

Combine the two benefits, introduced above: sending a ZEN image to ImageJ, having it processed there, and then returning the resulting image back to ZEN in one single step.

Note that different versions and variants of ImageJ and Fiji exist. This document is based on the
ImageJ/Fiji version 1.46. See notes for specifics of other versions and variants. For the sake of simplicity, Fiji is implied also, wherever ImageJ is mentioned in the following text.

12.12.1 Preparations

Info
Note that the extension for ImageJ is not available in ZEN lite.
1. Install ImageJ on your computer. Make sure that you use the latest version (check for online updates after installation).
2. Download loci_tools.jar and drop it into in the ImageJ/plugins folder.
3. Note the name of the folder with your preferred alternative. While you can switch freely
among them all, it makes sense to stick to one and the same environment, once you have
started to add your own programs and macros.
4. The ImageJ/Fiji folder you will eventually decide on, can either belong to you alone or be
shared among other users of the system. It is up to you decide, what you prefer: if you are
the only user, nobody will meddle with its contents (images, macros etc), but then, you will
need to copy and distribute the contents, if they are of interest to others as well.
You have successfully fulfilled all prerequisites. You can now continue with setting up ImageJ
within ZEN software.

12.12.2 Activate ImageJ Extension
The extension is automatically included in the ZEN installation. To set it up, start the software and
then proceed as follows:
1. Go to Tools > Options > ImageJ.
2. In the ImageJ Executable dropdown list, select your preferred ImageJ.exe.
3. If you prefer another executable or your preferred executable is not in the list, click on the
last entry ... to search for it.
You have successfully set up ImageJ extension within the software. Now you can start working
with the extension.
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12.12.3 Sending and retrieving images
1. In the Left Tool Area, click on the Extensions tab.
à The tool group ImageJ will appear containing the Apply tool.

2. To send an image from ZEN to ImageJ select the image in ZEN.
3. In the Apply tool, click on the Send Image button.
à The image will be sent to ImageJ and opened within a new image frame. You can now
edit the image within the ImageJ application.
4. To retrieve an image from ImageJ to ZEN select the image in ImageJ.
5. Click on the Retrieve Image button.
à The image will be opened in ZEN.
You have successfully exchanged images between ZEN and ImageJ.

12.12.4 Use ImageJ Methods
The extension offers the possibility of sending images to ImageJ to get processed, to retrieve the
result of the operation or both. The following instruction will show the basic steps which are necessary to apply ImageJ methods on any images.
Prerequisite ü You are on the Extensions tab in the ImageJ group.
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1. In the Methods tool select the command or method to be executed, e.g. an ImageJ macro.

2. In the Parameters tool, specify if the method selected will need an input image and/or
provide a resulting image.
3. In the Apply tool, click on the Apply button to execute the command.
You have successfully applied an method to an image.

12.12.5 Image Type Send/Retrieve Conventions
ZEN to ImageJ

Image Type

Received
as…

.tif, .jpg, .bmp, .png, .gif

Original

.ome.tif

Original
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Image Type

Received
as…

Comments

2D image B/W .czi

32-bit (RGB)

Convert the image in ImageJ to the required
pixel type using Image > Type command

2D image 24/48 bit
color .czi

32-bit (RGB)

2D image 36/42 bit
color .czi

-

Convert the CZI image to 24/48 bits before
sending it or using it in a method

Multi-channel x Z-Stack x
T-series

MD image

If necessary reassign the dimensions using
Image > Hyperstacks for instance. Channel
colors may be different from those set in ZEN

Tiled images

-

Only the first tile gets loaded.

12bit B/W images

Error in ImageJ

Workaround: convert the pixel type of the
image to 16 bits in ZEN

Image Type

Received
as…

Comments

.tif, .jpg, .bmp, .png, .gif

Original

.ome.tif

Original

2-D images, B/W and RGB

B/W, RGB TIF

Multi-channel x Z-Stack x
T-series

MD image

Hint: select RGB in Quick Color Setup to get
the same colors for channels as in ImageJ

Tiled images

-

Only the first tile gets loaded.

ImageJ to ZEN
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12.13 Intellesis
This module enables you to use machine-learning algorithms for segmenting images using pixelclassification. It uses different feature extractors to classify pixels inside an image based on the
training data and the labeling provided by the user. There are a variety of use cases because the
functionality itself is "data-agnostic" meaning it can be used basically with every kind of image
data.
The extension has the following main functionality:
§

Any user can intuitively perform image segmentation without advanced training by simply labeling what shall be segmented.

§

Import of any image format readable by the software, incl. CZI, OME-TIFF, TIFF, JPG, PNG
and TXM (special import required).

§

Creation of predefined image analysis settings (*.czias) using machine-learning based segmentation that can be used inside the ZEN measurement framework.

§

Integration of the Trainable Segmentation processing function within the OAD environment.

Application XRM (X-Ray Microscopy) image from sand stone showing the main steps when working with the
Example: Intellesis Trainable Segmentation module.

1 Original Image
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4 Segmented Image

Application Cells image with Phase Gradient Contrast on the Celldiscoverer 7 and segmented using Intellesis
Example: Trainable Segmentation.

1 Original Image

2 Labeled Image

3 Overlay of Original Image and Segmentation
Result

4 Segmented Image

Note:
The training of Intellesis models is CPU / GPU specific. A model trained on GPU only runs on a
GPU machine. If a model trained on GPU is transferred to a CPU-only machine, the model has to
be retrained to run on this machine.
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12.13.1 Fact Sheet
§

Simple User Interface for Labelling and Training

§

Integration into ZEN Measurement Framework

§

Support for multi-dimensional datasets

§

Machine-Learning Tool for Pixel Classification powered by Python
– Scikit-Learn
– Tensorflow
– Dask

§

Client / Server Architecture with REST-API

§

Engineered Default Feature Sets (CPU)
– 25 or 33 Features

§

Neural Network (vgg19) Layers for Feature Extraction (GPU)
– 64, 128 (red. 50) or 256 (red. 70) Features for 1st, 2nd or 3rd layer

§

Random Forest Classifier for Pixel Classification (CPU)

§

Option to download pre-trained DNNs (Deep neural Networks) for specific sample types (subject of change)

§

Post Processing: Conditional Random Field (CRF)

§

IP-Functions for creating masks and confidence maps

§

Python Scripting Integration able for advanced automation

§

SW Trial License available

12.13.2 FAQ/Terminology
Term / Question

Description

Machine Learning

The Intellesis Trainable Segmentation module uses machine learning to automatically identify objects within an image according to a
predefined set of rules (the model). This enables any microscopy user
to perform image segmentation even on complex data sets without
programming experience or advanced knowledge on how to set up
an image segmentation.

What is a "Model" ?

A model is a collection of rules according to which the software attributes the pixels to a class. Such a class is mutually exclusive for a
given pixel, i.e. a pixel can only belong to one class. The model is the
result of (repeated) labeling and training a subset of the data. After
the model is trained (the labels provided by the user were used to
"train" the classifier), it can be applied to the full data set in image
processing or it can be used to create an image analysis setting
(*.czias) to be used with the ZEN image analysis module.
In image processing the trained model can be applied to an image/or
data set and perform segmentation automatically. As result you will
get two images, the segmented image on the one hand and a confidence map on the other hand.
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Term / Question

Description

What is a "Class" ?

A class is a group of objects (consisting of individual pixels) with similar features. According to the selected model the pixels of the image
will be attributed as belonging to a certain class, e.g. cell nuclei, inclusions in metals, etc..
Every model has by default already two classes built-in, because at
least two classes are needed (e.g. cells and background or steel and
inclusions). Of course, more classes can be defined if necessary.

What is "Labeling" ?

Instead of using a series of complex image processing steps in order
to extract the features of the image, you just need to label some objects in the image that belong to the same class. Based on this manual
labeling the software will attribute the pixels of the image as belonging to a certain class. In order to refine the result, you can re-label
wrongly attributed pixels and this way assign them to another class.

What is "Training" ?

During the training process (within the training user interface) you can
repeatedly label structures as belonging to one class, run the training,
check if the result matches your expectation and if necessary refine
the labeling in order to improve the result. The result is a trained
model (a set of rules) which produce the desired result when applied
to the training data.
With the labeled pixels and their classes a classifier will be trained. The
classifier will then try to automatically assign single pixels to classes.

Training UI
(User Interface)

The user interface for training is the starting point of the automatic
image segmentation process. Here you import images, label and train
the model which you can later use for automatic image segmentation.
Within this interface you can load the training data, define the classes
of objects found in your data and train the classifier to assign the objects to the correct classes.

What is "Segmenting" or "Segmentation"?

In general segmentation is the combination of pixels of the same class
within an image. Before you can perform segmentation the segmentation model has to be trained. Within the Training UI you train the
software by labeling specific objects or structures that belong to different classes. A pseudo-segmentation is performed each time you
train the model so that you see if the feature extractor works for your
image.
One output of the Intellesis Trainable Segmentation processing
function is the fully segmented image or data set using the trained
model. The second output is the confidence map.

Confidence Map

The confidence map is one of two resulting images when you apply a
trained model to an image by using the processing function Intellesis
Trainable Segmentation.
The (resulting) grayscale image encodes the reliability of the segmentation. Areas which can be addressed to a certain class with a high
confidence will appear bright, whereas areas which have a lower confidence to belong to a certain class will appear dark. The confidence is
represented by a percentage value, where 0 means "Not confident at
all" (dark) and 100 "Very confident" (bright).

What is a "Feature"?

A feature is a specific property of an image, that will be calculated by
using a predefined set of filters and processing functions. This process
results a so-called "Feature Vector" for every pixel. This is the information that will be used for training the model.
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Term / Question

Description

What is a "Feature
Extractor"?

A feature extractor is a predefined set of processing functions that is
used to create the feature vector for every pixel. As feature extractor
a specific layer of a pre-trained neuronal network can be used as well.

Prediction

When the model that was trained on example data is applied to a
new unlabeled data set the result is called a prediction.

Multi-Channel Images

The Intellesis Trainable Segmentation module supports multichannel data sets. It is important to understand that in case of multichannel images every pixel can still only belong to one class, i. e. the
classes are mutually exclusive.
The additional information of having more than one intensity value
per pixel (e.g. one for every channel) is also used for classification.
Example: If you have overlapping regions A and B in the image that
you want to classify then consider labeling three independent classes:
§ Class 1: A
§ Class 2: B
§ Class 3: A overlapping with B
If you want to segment an individual channel from a multi-channel
image, use the Create Subset IP function first to extract the desired
channel.

12.13.3 Operating Concept
The operating concept can be generally split in three parts:
The Training User Interface which is accessed via the Intellesis Trainable Segmentation tool on Analysis tab. Within the training user interface you can label the images to be used as input for training a specific
model, see User Interface - Training [} 421].
Training

Processing

The Image Processing (IP) function Intellesis Trainable Segmentation, which can be used to segment images resulting in binary masks.
Those masks can be used in subsequent ZEN workflows, such as 2D or
3D analytics or they can be exported for further use in external 3rd party
software packages. You will find more details under Using a Trained
Model for Image Processing [} 434].
The automatic creation of Image Analysis (IA) settings (*.czias), which
allows to use a trained model for automated segmentation and measurement of image data within the ZEN Image Analysis Wizard. To familiarize with the basic steps take a look at our step-by-step guide in the
chapter Using a Trained Model for Image Analysis [} 435].

Analyzing
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12.13.4 Workflow Overview
ZEN Intellesis Trainable Segmentation offers three main workflows. The general workflows
and the basic steps involved are shown inside the diagram.
§

Labeling and Training your images -> results in a Trained Model.

§

Using the Trained Model to segment images -> results in Binary Masks.

§

Using the Trained Model for image analysis -> results in classified pixel for subsequent segmentation and measurements of objects.

Fig. 23: Process description of the Intellesis workflow
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12.13.5 User Interface - Training
The Training user interface is accessed via the Analysis tab. Open the Intellesis Trainable Segmentation tool, select or create a new a model and click on Start Image Training. The user interface for training will be visible:

1

2

3

4

Fig. 24: User Interface for Training

1

Labeling and Training Settings
On the left side you find elements for managing the classes. You can add and delete
classes and select them for labeling an image.
You can change the label opacity and the segmentation opacity by adjusting the corresponding slider. Opacity determines to what degree it obscures or reveals labels or segmentations. Opacity of 1% appears nearly transparent, whereas 100% opacity appears
completely opaque. Additionally, you can hide all segmented pixels where the confidence
value is below a certain threshold set by the Min. Confidence (%) slider.
With the different parameters of the Segmentation options and the Postprocessing
options it is possible to further improve the results of the training and the (pseudo-)segmentation. The Train & Segment button starts the automatic training algorithm and
then performs the pseudo-segmentation of the defined classes in the image.

2

Center Screen Area
This area shows the sample image. You can directly start labeling the classes within the
image.
When you are inside the image, the actual brush size for labeling is represented by a
square. If the brush size is very small, the square is changed into a dotted circle with a
small point inside.

3

Image Gallery
On the right side you can import and select the images you want to use for training and
segmenting.

4

Labeling Options
Below the center screen area you can adjust the Labeling Mode or Brush Size.
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Info
When you use images with large X/Y dimensions, e.g. large tile images, the segmentation will
be only performed on a subset of the whole image in order to avoid long waiting periods. The
current image subset maximum size in X/Y is 5000 pixels and is centered on the current view
port. Nevertheless all labels inside the complete image will be used for training, but the segmentation preview (pseudo-segmentation) will be only applied to that subset.

12.13.5.1 Segmentation Options

Parameter

Description

Basic Features 25

A predefined feature set using 25 features.

Basic Features 33

A predefined feature set using 33 features.

Deep Features 50

The complete or reduced feature set from either the 1st, 2nd or 3rd
layer of a pre-trained network is used to extract the respective number of features.

Deep Features 64
Deep Features 70
Deep Features 128
Deep Features 256

For the selection of the parameters note the following:
§

There is no "right" selection. We recommend to always try different parameters for the same
image to see which one works best.
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12.13.5.2 Postprocessing Options

Parameter

Description

No Postprocessing

This parameter is set by default. No further postprocessing will be applied on the images.

Conditional Random Field (CRF)

If selected, this post processing function is applied to the output of
the pixel classification. This can improve the segmentation results, depending on your sample. The CRF algorithm tries to create smoother
and shaper borders between objects by re-classifying pixels based on
confidence levels in their neighborhood.
Note: If CRF is activated, the returned confidence map does not reflect the outcome of the majority votes of all decision trees of a specific class anymore. Therefore, a map containing only ones will be returned when the CRF postprocessing option is activated.

12.13.5.3 Labeling Options

Parameter

Description

Undo / Redo

When you click on the arrows you can undo/redo the last actions you
have performed.

Labeling Mode

Here you can select between labeling and erase mode.

Brush Size

Here you can set the brush size of the labeling / erasing tool.
Note that the brush size can be changed alternatively by holding the
Strg key and using the mouse wheel (when the cursor is inside the image area.)

All Labels

When you click on Clear, all labels in the active image will be deleted.
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12.13.5.4 Image Gallery
In the right tool area under Images & Documents you find the area for handling the images to
be used for training. Here you can load and select the images you want to use for training. When
you click on a loaded image, the image will be visible in the Center Screen Area.

Fig. 25: Image Gallery with additional info
In the list of images you have certain possibilities to gain advanced information about the image.
If you load a new image only the preview image, file name and type of image are displayed.
When you have started to label an image of a larger data set, a small arrow appears on the left
side of the preview image. If you click on the arrow, a list of the images that contain labels will be
displayed, containing dimension and image number (e.g. for a Z-stack, Z:400 indicates that the
slice number 400 contains labels).
If you click on this information the corresponding image will be automatically displayed in the
center screen area. This is very helpful when you are working with large data sets such as zstacks, scenes or time-series and you want to quickly load the image which you have already labeled.
12.13.5.5 Select Channel dialog
This dialog is only displayed if a multi-channel image is imported.

Parameter

Description

Training Mode

Here you can select the mode for training.

–

Single Channel

Only one channel of the image is imported for training.
Such models trained on one channel can only be used inside the Image Analysis Wizard for the Intellesis Class Segmenter.

–

Multispectral

All channels of the image are imported for training.

Select Channel

Only visible if Single Channel is chosen as the training mode.
In the drop down list you can choose the channel you want to import
for training.
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Parameter

Description

OK

Confirms the settings and imports the image accordingly.

Cancel

Cancels the image import and closes the dialog.

ZEISS

12.13.6 Intellesis Models
12.13.6.1 Creating a New Model
Prerequisite ü You have completed the general preparations.
1. On the Analysis tab, in the Intellesis Trainable Segmentation tool, click on Options
and select New.
2. Enter a name and a description for the new model and click on
3. Click on Start Training.
à The user interface for training opens.
4. In the Right Tool Area under Open Images click on Import Images.
5. Select the image for training from the file system and click on Open.
à The image will be visible in the list. Note that all imported images will be included to your
training model.
6. Select the image from the list.
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à The image will be displayed in the Center Screen Area. Note that on a later stage you
can add more images to refine the training via Import Images.
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7. Switch to the Left Tool Area and continue with the definition of the classes. Depending
on your image and what you want to segment you can define a certain amount of classes.
When you start with a new model you will see the two predefined classes Object and
Background. If you click on Add Class a new class is added. You can rename these
classes by a double-click and entering a new name.
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8. Now move the courser inside the image and start labeling the areas which you want to assign to the selected class. To label within the image simply hold down the left mouse key
and move the mouse.

9. After labeling a few areas with different classes click on Train & Segment.
à The software will now start the training. The system will try to automatically recognize
other areas of the same classes. Depending on the image, the pixel classification can take
a while. When finished the image will have the additional channel Seg(menation) containing the segmentation preview.
10. If you are not satisfied with the result you can label more details of the corresponding
classes. Therefore you can zoom into the image or change the brush size of the courser.
The more accurate you label the different classes within the image, the better the recognition will be. When you finished the labeling you have to click on Train & Segment again.
You can repeat that process until you are satisfied with the segmentation result.
Note that at this point as a result you will only see a pseudo segmented image and only the
area visible in the main window will be segmented (max. area 5000x5000 px). The full segmentation of an image/data set is performed on the Processing tab by using the trained
model within the Trainable Segmentation processing function.
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Fig. 26: Trained model with refined labeling and pseudo segmentation results

Info
For a good training result always note the following:
§

The more accurate you perform the labeling the better the result will be. You can start
with a coarse labeling (as indicated in the image above) and then check the result for problematic areas where you should refine the labeling (as shown in Fig. 6.1)

§

Accurate labeling is generally preferred over "just labeling everything" roughly.

§

Take care to also label some areas which contain edges of objects and transitions between
two classes.

§

Really use an iterative approach: check the segmentation / training results before labeling
huge amounts of pixels.

12.13.6.2 Importing Models
Prerequisite ü You have completed the general preparations.
ü You have a trained model (*.czmodel file) or a pre-trained neural network available which you
want to import.
ü You are on the Analysis tab.
1. In the Intellesis Trainable Segmentation tool, click on Options

and select Import.

2. In the file browser, select the model *.czmodel file or your network from the file system.
The network can also be imported by selecting the respective JSON file.
3. Click on Open.
à The model will now be available in the dropdown list.
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4. Select the model and click on Start Training to work with the model, e.g. if you want to
train more details.
If you want to use the model for image processing switch to the Processing tab. In the
Trainable Segmentation processing function you can select the imported model and apply it to the desired images/data sets.

See also
2 Using a Trained Model for Image Processing [} 434]
2 Using a Trained Model for Image Analysis [} 435]
12.13.6.3 Exporting a Model
Prerequisite ü You have created and selected a model for advanced image segmentation.
1. On the Analysis tab, in the Intellesis Trainable Segmentation tool, click on Options
and select Export.
If you want to export the full model containing all images select Export with Images (see
also Exporting with Images [} 430]).
2. Select the file location and click on Save.
The model will be exported as *.zip file which contains the trained segmenting routine as well as
the images which were used for training. In case of the option where the images are not included, only the model files itself will be exported. Such a model is meant to be used for segmentation purposes or to create an Image Analysis Setting, but not for the Training Process anymore.
12.13.6.4 Exporting with Images
You can export a training model as a zip file, so that you can continue to use them in other programs.
Prerequisite ü You have selected a trained model with images.
1. On the Analysis tab, in the Intellesis Trainable Segmentation tool, click on Options
and select Export With Images.
à The file explorer opens.
2. Navigate to the folder where you want to store the training model and click on Save.
You have exported your model with all images.
12.13.6.5 Renaming a Model
Prerequisite ü You have selected a training model.
1. On the Analysis tab, in the Intellesis Trainable Segmentation tool, click on Options
and select Rename.
à The Model field is editable.
2. Enter a new name for the model and save it.
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12.13.6.6 Cloning a Model
Prerequisite ü You have selected a training model.
1. On the Analysis tab, in the Intellesis Trainable Segmentation tool, click on Options
and select Clone.
à The name of the currently loaded model disappers and the Model field is editable.
2. Enter a new name for the model and save it.
You have cloned an existing model.
12.13.6.7 Creating Analysis Setting
1. On the Analysis tab, in the Intellesis Trainable Segmentation tool, click on Options
and select Create Analysis Setting.
à The file browser opens with the default location for image analysis settings.
2. If you want to change the location, select a new path for saving the setting.
3. Click on Save.
You have now created and saved an image analysis setting.
For more information, see also Using a Trained Model for Image Analysis [} 435].
12.13.6.8 Deleting a Model
Prerequisite ü You have selected a training model.
1. On the Analysis tab, in the Intellesis Trainable Segmentation tool, click Options
and select Delete.
à The Deleting Model dialog opens.
2. Click on Yes to confirm that you want to delete the model.
You have deleted the model. The model you worked with before is selected.
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12.13.7 Editing Classes
1. To add a new class to the Classes list, click on Add Class.
à The classes have a random color by default.

2. To change the color of a class, select the class and click on the colored rectangle next to
Color.
à You see the Color Selection dialog.
3. Select a new color from the list.
4. To change the opacity of the labels within the image, adjust the Opacity slider.
5. To rename a class double click on the class entry and enter a new name. Press Enter or click
on the Save icon to save the new name.
6. To delete the selected class, click on Delete Class.

12.13.8 Importing Labels from Binary Mask
With this class specific function you can import binary images from an external source as labels
for the current selected class. This is helpful when the "ground truth" for a specific image is available or when you want to use an image obtained by a different modality.

Info
Be aware that this function overwrites existing labels for this class and that this functionality
can possible create a huge number of labels that might lead to memory issues depending on
the system configuration and the selected feature extractor.
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Prerequisite ü The label image to be imported has exactly the same dimension in XY as the currently selected training image.
ü You have opened the Intellesis Trainable Segmentation Wizard. For more information, see
Creating a New Model [} 425].
1. Right-click a class and select Import Labels from Binary Mask.
à The Explorer opens.
2. Navigate to the label image you want to import, and click Open.
The imported image is displayed in the Image view. The displayed labels have the color of the selected class and fit exactly with the class of the loaded image.

12.13.9 Converting segmentations to labels
With this function you can convert the result of a segmentation directly to labels and thereby increase the number of labels for the next training step.
Prerequisite ü You have opened theTraining user interface. For more information, see Creating a New
Model [} 425].
ü You have performed a segmentation.
1. Right-click a class and select Segmentation to Labels.
The segmentations are converted to labels.

12.13.10 Using neural networks for Intellesis
In ZEN you can use pre-trained neural networks as models for image segmentation. You can use
networks provided by Zeiss or load your own networks. Each network has to be imported to ZEN
via the Intellesis Trainable Segmentation tool as a model. For more information, see Importing
Models [} 429].
After the import the network can be used as a normal segmentation model for the following
workflows:
§

Segment single channel images using the respective image processing function, see also Using
a Trained Model for Image Processing [} 434].

§

Create an image analysis setting based on the network (no hierarchy), see also Using a
Trained Model for Image Analysis [} 435].

§

segment a specific class in the Automatic Segmentation [} 779] step of the Image Analysis
Wizard.

Using networks provided by Zeiss
Zeiss provides some pre-trained networks for you to use (subject to change without notice). These
networks are available for download on the ZEISS GitHub page for Open Application Development (OAD) and can be found inside the Machine-Learning section under Model Downloads.
Note: These networks are copyright protected!
Condition of Use
These pre-trained networks were trained with "best-effort" on the available training data and is
provided "as is" without warranty of any kind. The licensor assumes no responsibility for the functionality and fault-free condition of the pre-trained network under conditions which are not in the
described scope. Be aware that no pre-trained network will perform equally good on any sample,
especially not on samples it was not trained for. Therefore, use such pre-trained networks at your
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own risk and it is up to the user to evaluate and decide if the obtained segmentation results are
valid for the images currently segmented using such a network. By downloading you agree to the
above terms.
Detailed Information about pre-trained DNNs
Such networks are specific for the application they have been trained for. Detailed information
can be provided on demand.
Using your own networks
You can also train and use your own networks. To be able to use your own networks in ZEN, your
networks have to fulfill certain specifications detailed in the ANN Model Specification.
An example of how to train a model and convert it into a czmodel can be found here: Importing
External Networks in ZEN. It also explains the usage of the PyPi package which is free to use for
everybody.

12.13.11 Using a Trained Model for Image Processing
Prerequisite ü You have a trained model available for automatic image segmentation.
ü You have opened the image which you want to segment under Images & Documents.
1. On the Processing tab under Method open the group Intellesis Trainable Segmentation and select the Segmentation entry.
2. Open the Method Parameters and select the trained model from the Model list. Note
that the model must be trained on images with similar features otherwise the segmentation
will not work properly.
3. Select the desired Output Format.
If you select Multi-Channel, the result will be a multi-channel image, where every class
that was defined in the trained model will be in their own channel. This output format can
be easily viewed inside the ZEN 3D view and can be combined with the original image
data easily.
If you select Labels, you will get an image with one channel, where the pixels belonging to
the different classes will be labeled with different colors and will be represented by distinct
pixel values.
4. Under Input Parameters select the image which you want to segment. Note that it must
be already opened in the ZEN software, otherwise it will not be available in the list.
5. Click on Apply.
à The automatic image segmentation using the trained model is performed.
à After a short while you will get two resulting images, depending on the output format:
- the multi-channel or labels image and
- the confidence map.

Fig. 27: The image shows (from left to right): original image, segmented image, confidence map
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See also
2 Segmentation [} 441]

12.13.12 Using a Trained Model for Image Analysis
Once having trained a model for segmentation you can use it also in the Image Analysis wizard
of the software for further analysis. In order to use the trained model, you must first create a new
image analysis (IA) setting (*.CZIAS format) first.
Prerequisite ü You are in the Trainable Segmentation tool.
1. Select the trained model of which you want to create an analysis setting.
2. Click on the Options
and select Create Analysis Setting.
à The dialog for saving the setting opens. The setting will be saved as *.czias file in the ZEN
default folder for image analysis settings (usually under User/Documents/Carl Zeiss/
ZEN/Documents/Image Analysis Settings).
3. Click on Save.
4. Now change to the Image Analysis tool and select the setting from the dropdown-list.
Note that the setting will be only available in the dropdown list when you have used the
default folder for saving. Otherwise the setting must be loaded from the file system (specific location) via the Import option (see Importing Models [} 429]).
à The model will be loaded with its predefined classes.
5. You can now continue with setting up an image analysis. For more information about the
Image Analysis Wizard, see Image Analysis Wizard [} 777].

à Sandstone Dataset segmented using Intellesis inside the Image Analysis Wizard showing the actual segmentation step. Instead of conventional thresholds, the classifier will be
used to identify pixels.
à It is possible to allow only for pixel above a certain classification confidence (valid for all
classes) using the Min. Confidence (%) parameters.
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à The binary functions Fill Holes and Separate will be only applied on the resulting binary
masks from the classification and are therefore independent from the actual classification
process.

à Sandstone Dataset segmented using Intellesis inside the Image Analysis Wizard showing the measurement results for one particular class (shown in green).
à You can also use the IP function inside the ZEN Blue Batch Tool similar to all the other
functions to segment several images using different models at once in one run.

12.13.13 Using Intellesis within OAD
The Intellesis Trainable Segmentation module allows to use the Trainable Segmentation
processing function within the ZEN Open Application Development (OAD ) environment.

Method / Command

Description

Zen.Processing.Segmentation.TrainableSegmentation
(Input, Model, Output Format)

Function to segment an image using a
trained model.
The output result is an image.

§ Input

ZenImage - Defines the input image to
be segmented.

§ Model

ModelName - Defines the name of the
model.

§ Output Format:
SegmentationFormat.MultiChannel
SegmentationFormat.Labels

Function to segment an image using a
trained model.
The output result is an array of images
containing the segmented image and
the confidence map.

Zen.Processing.Segmentation.TrainableSegmentationWithConfidenceMap

Addresses the Trainable Segmentation
function including a confidence map.

§ Input

ZenImage - Defines the input image to
be segmented.
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Method / Command

Description

§ Model

ModelName - Defines the name of the
model.

§ Output Format:
SegmentationFormat.MultiChannel
SegmentationFormat.Labels

SegmentationFormat - Optional argument; Defines the desired output format, e.g. Multi-Channel or Labels

Zen.Processing.Segmentation.MinimumConfidence

Addresses the Minimum Confidence
function.

§ Input

ZenImage - Defines the input image to
be segmented.

§ Model

ZenImage - Confidence map containing
the confidence values in %.

§ Threshold

Minimum Threshold – value in % - only
pixel inside mask >= this values will be
kept.

ZenIntellesis.GetAvailableFeatureSets()

Returns all available feature sets as an
array of strings.

ZenIntellesis.GetAvailablePostProcessings()

Returns all available post-processing options as an array of strings.

ZenIntellesis.ImportModel(modelfile, allowOverwrite)

Imports a model file into the model
repository and overwrites an existing
one, if the option was set to True. Returns a ZenIntellesisModel.

§ modelfile

File path to modelfile to be imported.

§ allowOverwrite

Allows overwriting an existing model.

ZenIntellesis.ListAvailableSegmentationModels()

Lists all available segmentation models.
Returns an array of ZenIntellesisModels.

12.13.14 Remarks and Additional Information
§

Segmentation Performance in general depends among other factors on the system performance, the available and free RAM and GPU memory.

§

Whenever using ZEN Intellesis Trainable Segmentation it is strongly recommend not
to use other memory- or GPU-intensive applications at the same time.

§

The training of Intellesis models is CPU / GPU specific. A model trained on GPU only
runs on a GPU machine. If a model trained on GPU is transferred to a CPU-only machine, the
model has to be retrained to run on this machine. The reason is that Tensorflow will give
slightly different results depending on whether the Tensorflow-CPU or Tensorflow-GPU is
used.

§

Deep Feature Extraction will use the GPU (NVIDIA only) if present on the system. It is recommended to use an GPU with at least 8GB of RAM.

§

The installation of the GPU version of Intellesis can be selected during the installation process
of ZEN itself.

§

When installing the GPU libraries it is required to use the latest drivers which can be obtained
from the NVIDIA homepage (https://www.nvidia.com/Download/index.aspx?lang=en-us).
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§

In case of using an approved ZEISS workstation the latest drivers can be found on the installation DVD.

§

When using Deep Feature Extractor on a GPU system, Tensorflow will occupy only as much as
GPU RAM as needed to ensure system stability. When the segmentation is finished this GPU
memory released automatically (with the current version).

§

Therefore, when starting another GPU-intensive application, for example GPU-DCV, the GPU
memory cannot be used by this new process and a CPU fallback will be used or performance
issues may occur.

§

In such a case, restart ZEN to free all possible GPU memory and then start using GPU-DCV (or
similar applications).

12.13.15 Functions & Reference
12.13.15.1 Feature Extractors

12.13.15.1.1 Intellesis Basic Features
§

For calculating the features various filters with various filter sizes and parameters are applied
to the region around this pixel (2D Kernels).

§

Results are concatenated and yield the final feature vector describing the pixel.
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12.13.15.1.1.1 Basic Features 25
Used Filters:
§

Gaussian filter (5 different sigma) = 5 feature dimensions

§

Sobel filter (5 sigma) = 5 feature dimension

§

Gabor filter (6 theta, 1 different sigma, 2 different frequencies) = 12 feature dimensions

§

Hessian filter (1 sigma) = 3 feature dimensions (one for derivative in direction xx, one for derivative in direction xy and one for derivative in direction yy)
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12.13.15.1.1.2 Basic Features 33
Used Filters:
§

Gaussian filter (20 different sigma) = 20 feature dimensions

§

Sobel filter (1 sigma) = 1 feature dimension

§

Gabor filter (1 theta, 2 different sigma, 2 different frequencies) = 4 feature dimensions

§

Mean filter (5 different sizes) = 5 feature dimensions

§

Hessian filter (1 sigma) = 3 feature dimensions (one for derivative in direction xx, one for derivative in direction xy and one for derivative in direction yy)
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12.13.15.1.2 Intellesis Deep Features
§

Entire image as input for pre-trained network.

§

Note: If you use the CPU for segmentation with Deep Feature sets, the results can be different on different machines because they are hardware (CPU) dependent.

§

Take the output from an intermediate layer of that network as feature vector, e.g. output
from layer 3 was processed by preceding layers 1 and 2.
–
–
–
–
–

Deep Features 50: Using layer 2 with reduced feature dimension = 50
Deep Features 64: Using layer 1 with full feature dimension = 64
Deep Features 70: Using layer 3 with reduced feature dimension = 70
Deep Features 128: Using layer 2 with full feature dimension = 128
Deep Features 256: Using layer 3 with full feature dimension = 256

12.13.15.2 Image Processing Functions
12.13.15.2.1 Minimium Confidence

Parameter

Description

Threshold slider

Adjusts the minimum confidence level in %.

12.13.15.2.2 Segmentation
Using the Segmentation image processing function you can apply a trained segmentation model
to an image/data set.

Parameter

Description

Model

Select the trained model here.
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Parameter

Description

Output Format

When applying the Segmentation processing function to an image
you will always get two output images. The processed image and the
confidence map.
The following output formats for the processed image are available.

-

Multi-Channel

If selected, the output image will be a multi-channel image.
Each class which is defined within the model will result in a separate
channel.

-

Labels

If selected, the output image will be a single-channel image.

See also
2 Using a Trained Model for Image Processing [} 434]
12.13.15.2.3 Utilities
Here you can convert an output image generated with the Segmentation IP function according
to your needs:

Parameter

Description

Labels to Channels

Converts the resulting image with the output format "Labels" to a
multi-channel image.

Channels to Labels

Converts the resulting image with the output format "Multi-Channel" to an image containing a single channel image with labels.
Under Parameters you can additionally adjust the Unlabeled Pixel
Value and the Output Pixel Type (8 Bit B/W or 16 Bit B/W).

12.13.15.3 Intellesis Trainable Segmentation Tool

Parameter

Description

Model

Shows the selected model. If you have several models available you
can select the corresponding model from the drop-down list.

Options

–

New

Creates a new, empty model. For more information, see Creating a
New Model [} 425].

–

Rename

Renames an existing model. For more information, see Renaming a
Model [} 430].

–

Delete

Deletes an existing model. For more information, see Deleting a
Model [} 431].

–

Create Analysis
Setting

Creates and stores a *.czias file in the specific folder for image analysis
settings. The file can then be used in the Analysis Wizard. For more
information, see Creating Analysis Setting [} 431].

–

Clone

Clones (duplicates) an existing model. For more information, see
Cloning a Model [} 431].
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Description

–

Export

Exports the model to the file system. For more information, see Exporting a Model [} 430].

–

Export With Images

Exports the model including all images to the file system. For more information, see Exporting with Images [} 430].

–

Import

Imports a model to the ZEN software. For more information, see Importing Models [} 429].

Description

Displays a descriptions of the selected model.

Postprocessing

Selects a postprocessing.
For more detailed information, see Postprocessing Options [} 423]

–

No Postprocessing

No postprocessing will be applied on the images.

–

Conditional
Random Field

If selected, this post processing function is applied to the output of
the pixel classification. The CRF algorithm tries to create smoother
and shaper borders between objects by re-classifying pixels based on
confidence levels in their neighborhood.
Note: If CRF is activated, the returned confidence map does not reflect the outcome of the majority votes of all decision trees of a specific class anymore. Therefore, a map containing only ones will be returned when the CRF postprocessing option is activated.

Start Training

Opens the Training UI, see User Interface - Training [} 421]
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12.14 Macro Environment
The acronym OAD for Open Application Development is a term describing both the OAD platform
on ZEN as well as the process of developing applications on it. The platform has been made available for our customers to enhance the functionality of ZEN in a flexible way. With OAD typical microscopy workflows can be integrated into the ZEN software. A short list of OAD highlights:
Macro Interface to access the major functionality of ZEN and its objects and the access to external
libraries like the .Net Framework to significantly enlarge the field of application.
The software offers the following components which we regard as main parts for Open Application Development (OAD):
§

Macro Runtime Environment (integrated)

§

Macro Recorder

§

Macro Editor

§

Macro Debugger

§

Macro Interface (Object Library)

§

ImageJ Extension

Basic functionality
All ZEN Products (ZEN lite excluded) come with a basic macro functionality which allows to play
existing macros within the software (Macro tool).

Info
Within ZEN you can only run .czmac macro files which are aquired or saved in the ZEN macro
environment. To run your macros they must be located in the folder: …/User/Documents/Carl
Zeiss/ZEN/Documents/Macros.
Advanced functionality
The Macro Recorder, Editor and Debugger form the Integrated Development Environment (IDE)
comes with the ZEN module Macro Environment. The IDE for the Macro Environment consists
of two parts. There is a reduced IDE in the Right Tool Area which you find within the Macro tool
[} 804]. The full blown IDE is available in the Macro Editor dialog and allows users to generate
and work with macros similar to Excel/Word macros. The Macro Interface is built into the software and therefore not a separate product. The ImageJ Extension is the first extension for ZEN
and will be free of charge. It will not be available in ZEN lite.
User forum
A user forum was established to allow users to exchange macros and to discuss solutions. You
will find a lot of example macros and further documentation there. The user forum can be
reached under www.zeiss.com/ZEN-OAD.
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12.14.1 Running an existing macro
Prerequisite ü You work with a licensed version of the software, e.g. ZEN pro, desk or system. Note that
the macro environment for ZEN lite is not available.
ü You have not licensed the Macro Environment module.
ü You have a macro file available that you want to play in ZEN.
1. Copy your macro file in the following folder:
.../User/My Documents/Carl Zeiss/ZEN/Documents/Macros.
2. Start the software.
3. In the Right Tool Area open the Macro tool.
à You see your macro in the list under User Documents.
4. Select your macro.
5. Click on the Run button.
Your macro is executed. You have successfully played a macro in ZEN.

12.14.2 Recording a macro
This guide shows how to record a macro of a simple processing workflow.
Prerequisite ü You have licensed the Macro Environment module.
ü You are in the Right Tool Area in the Macro tool.
1.
2.
3.
4.
5.
6.
7.

Click on the Record button.
Load a color image via the menu File > Open…
Go to the Processing tab.
Under Method select Edges > Sobel.
Under Method Parameters > Normalization select the entry Clip.
Under Image Parameters set your color image as Input Image.
At the top of the Processing tab, click on the Apply button.
à The Sobel method will be applied to your image. The output image will be generated
and opened in a new image container.
8. In the Macro tool click on the Stop button.
You have successfully recorded a macro for a simple processing workflow. The workflow can now
be repeated automatically just by playing the recorded macro file.

12.15 Panorama
This module enables you to create overview images of large areas of your sample.
Prerequisites
For the interactive panorama acquisition following prerequisites are necessary:
§

All available microscope components in the MTB (MicroToolBox) have to defined correctly.

§

The Panorama module is activated in the menu Tools > Modules Manager.
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12.15.1 Prerequisites
Prerequisite ü You are on the Locate tab.
1. In the Lightpath tool set the components that you want to use for the acquisition.

à All these settings will be stored as metadata of the image.
à Additionally the optical components will be used to automatically determine the pixel
size for the scaling.
2. Click on the Live button.
à Now you see the cameras live image of your sample in the Center Screen Area.
3. Click on the Set Exposure button.
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à The exposure time will be calculated automatically.
4. Alternatively you can set the camera parameters manually in the Camera tool.
5. Focus on your sample now.
You have completed the prerequisites for a panorama experiment.

12.15.2 Acquiring a Reference Image
Before starting the experiment itself, we recommend to acquire a reference image for the shading
correction first. This image will be used later for processing the panorama image.
1. Move the sample to an empty field.
2. Click on the Snap button to acquire this position as reference image.

3. Save the image and let it opened in the background.
You have successfully acquired a reference image for the shading correction.
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12.15.3 Settings for the Panorama Experiment
Prerequisite ü You are on the Acquisition tab.
ü You have started the live mode via the Live button.
1. Activate the Panorama checkbox.
2. Move the sample to the desired start field of the panorama image to be acquired.
3. Check the defined exposure time again if necessary.
4. In the Imaging Setup tool, you can check the settings before/after the experiment.

5. In the Acquisition Mode tool, click the Get button to transfer the active camera settings
into the experiment.
As an alternative you can define your experiment settings here as well.
6. In the Panorama tool you can adjust several options for automatic or manual stitching, if
desired.
7. Finally save your experiment with a suitable name in the Experiment Manager.
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12.15.4 Acquiring the Panorama Image
1. Click on the Start Experiment button to start the Panorama acquisition.
à You will see the reduced display of the start image in the Center Screen Area.

à The displayed image is a live image. You can still change position and focus.
2. Click on the Acquire Tile Image button in the Center Screen Area to acquire the first tile
image.
à The image will be acquired and stored. The live image is still active as an overlay to the
stored image.
3. Move the blue frame with the active live image in the desired direction aside the stored image by using the mouse.

4. Now move the sample to the corresponding neighbor position using the microscope stage.
à Try to position the structures in the overlap region as good as possible.
5. Click again on the Acquire Tile Image button to acquire this tile to the image.
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6. Move the blue frame to the next position.

7. Continue these steps until you acquired the desired panorama image of your sample.
8. After acquiring the last tile image click on the Stop button to close the live mode.

9. Finally end the experiment via the Stop button on the Acquisition tab.
à As a result you now see the recorded panorama image in a new image container.
10. Save the image as a raw image (*.czi).
You have successfully acquired and stored a panorama image.

Info
§

You can adapt the size of image and surrounding area with the zoom keys F7 and F8 to
your needs.

§

Keep a sufficient overlap area of the live with the stored image.

§

In the case of errors during the following processing steps you therefore always have access to the original image data.
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12.15.5 Processing the Panorama Image
The next chapters will show you how to process panorama images with the Stitching processing
function. Using this method you can correct an offset between the tile images. We will show you
the different settings and make a comparison of the output images. So you can see which settings
will give you the best result.
Prerequisites
Prerequisite ü You are on the Processing tab.
1. Open the Method tool and select in the group Geometric the Stitching function.
The following instructions will all base on this selection and show the different settings and results
of this function.
12.15.5.1 Stitching (Defaults)
1. In the Method tool open the Geometric group.
2. Select the Stitching function.
3. Click on the Apply button in the Processing tab to start the processing.
à The stitching process will take a while depending on the image size.

à In the Status bar you can see the work in progress.
You have successfully used the Stitching function. As you still can see shadows and edges in the
output image we will show you how to use the function receiving better results in the following
chapters.
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12.15.5.2 Stitching with Shading Correction
If your tile images contain a certain background shading you can correct this if you have acquired
a reference image for the shading correction. This image has to be opened in the Center Screen
Area.
1. Select in the tile image for the stitching in the Input tool as first input.
2. In the Parameters tool select the New Output button.

3.
4.
5.
6.

à This will keep the original image and create a new output image.
Activate the Correct Shading checkbox.
Select the Reference entry from the dropdown list.
à This will let you select your reference image which is opened in Center Screen Area.´
Now as a second input image select the reference image for the shading correction in the
Input tool.
Click on the Apply button to start the processing.

As a result you will get a stitched panorama image without any shading influences. The next
chapter will show you how to get rid of the edges which are still visible between the tiles.
12.15.5.3 Stitching with Fuse Tiles
With very low shading content in the image you have an alternative method to homogenize the
image transitions between the single tiles.
1. Under Image Parameters in the Input tool select the tile image for the stitching.
2. In the Parameters tool, click on the New Output button.
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3. Activate the Fuse Tiles checkbox.

4. Click on the Apply button to start the processing.
This function will smoothly average all edge regions of the tiles via their grey values in order to
avoid sharp edges. With high background shading this function alone will not be sufficient.
12.15.5.4 Stitching with Fuse Tiles and Shading Correction
For extreme cases you have the possibility to combine both transition corrections.
1. In the Parameters tool click on the New Output button.
2. Activate the checkboxes Correct Shading and Fuse Tiles.

3. Under Image Parameters in the Input tool select the tile image for the stitching and the
reference image for the shading correction.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

453

12 Software Modules & Extensions | 12.15 Panorama

ZEISS

4. Click on the Apply button.
Both settings will be applied to the image. With this method you will receive a perfectly stitched
image with no visible transition areas between the tiles any more.
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12.15.5.5 Image Comparison via Split Display
You can create a Multi Image to compare the different results of your processed images via the
Splitter-Mode.
1. To compare different images, you can select the Split Display via the Create New Multi
Image
button.
2. On the Split Display tab you can define how many images shall be displayed in X- and Ydirection aside each other and how they shall be synchronized, e.g. 2 Columns and 2
Rows.

3. Move each of the different panorama images via drag&drop from the Right Tool Area >
Images and Documents gallery to an empty frame in Center Screen Area.
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In our example we show the transition areas of the tile image as raw image (top left), as fused
tile image (top right), as shading corrected tile image (bottom left) and finally the combination
of shading correction and fused tiles (bottom right). In this last image no transitions between
the tiles are visible any more.

12.15.6 Functions & Reference
12.15.6.1 Panorama Tool
Here you can adjust settings for the panorama acquisition.
After you have acquired the single tile images simply activate the Perform stitching after the
experiment checkbox. If you want to stitch the images manually, click on the Perform Stitching
button, after you have finished the experiment.
The panorama acquisition itself is performed interactively via in the Panorama view. If you click
on 'Start Experiment' the Panorama view will be opend and you can start to acquire the single
tile images.

See also
2 Panorama View [} 457]
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12.15.6.2 Panorama View
In this view you see the representation of the microscope stage. The Live image from the camera
(blue frame) is automatically shown in the middle of the image area. Furthermore a tool window
is displayed, that allows you to control the image acquisition, e.g. perform auto exposure or acquire an individual tile image.

See also
2 General View Options [} 887]
12.15.6.2.1 Stage View
In the image area the full travel range of the microscope stage is displayed. You can control the
stage view using the arrow icons at the edges of the image area. The view can be enlarged, reduced or moved using the general control elements.
Navigator frame
The current stage position is shown as a tile outlined in blue, the Navigator frame. In the Navigator frame you can see the camera's live image.
To move the frame, double-click on the position on the microscope stage to which you want to
move it.
To acquire images, use the Acquisition buttons in the Tools window.

See also
2 Tools window [} 457]
12.15.6.2.2 Tools window
The tool window for panorama view is normally visible in the lower right corner of the center
screen area. It becomes active, if you move the cursor over it. You can use it to set acquisition parameters and acquire tile images for your panorama image.

Parameter

Description

Center to Live Navigator

Centers the stage view at the current position of the Navigator frame.

Action Buttons

With the three action buttons (Live, Set Exposure, Continuous)
you're able to control acquisition parameters like you are used to do it
on the Acquisition tab.

Acquire Tile Image

Acquires a tile image. This comprises all activated channels as well as
Z-stacks. After the acquisition the tile image is placed in the corresponding location in the stage view.
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12.16 Physiology (Dynamics)
Using the MeanROI offline functions you can specify user-defined measurement regions (ROIs) after acquisition of your time lapse experiment and analyze their time-dependent changes in intensity. You can display the intensity curves in charts or export the values in the form of tables. This
basic functionality is available for time series images and time series with z-stack images opened
in the software (excluded ZEN lite), or multi-positions (scenes) where a full time series is collected
sequentially at each position (Full time series per tile Region).
The Physiology (Dynamics) module expands the MeanROI offline functions to give you the option of calculating online/offline (during/post acquisition) ratios and makes additional display layouts, and analysis functions available (Timeline view, ROI tracing etc.). To open the MeanROI
view, see the following instruction:
Prerequisite ü You have acquired a time series experiment with one or more channels. The experiment is
open and the first time point is displayed in the 2D view.
1. Select the MeanROI tab from the image view tabs in the Center Screen Area.
à The MeanROI view opens.
You are now prepared to start working with the MeanROI view. The following chapters will
show you the first steps.

See also
2 Acquiring Time Series Images [} 49]

12.16.1 Workflow MeanROI View (offline)
12.16.1.1 Drawing in ROIs
Prerequisite ü You are in the MeanROI View or in the MeanROI Setup on Acquisition tab.
1. Go to the Graphics tab in the View Options.
2. Select a tool for drawing in ROIs, e.g. the Polygon tool.
3. Activate the Keep tool checkbox.
à The selected tool remains active after you have drawn in an ROI. This means you can
draw in several ROIs without having to re-select the tool.
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4. Using the selected tool, in the image view draw in the objects or regions (ROIs) for which
intensity measurements are required.

à The ROIs are displayed in the list (Annotations/ Measurements Layer) on the Graphics
tab.
à Intensity measurements are performed for each ROI and displayed in the chart area to
the right of the image view.
You have successfully defined measurement regions for the intensity measurement.

NOTICE
Measurement time
Note that the time taken to initially create measurements will vary as some date is cached to
memory. Thus, when a long time series image is opened that already contains ROIs, you might
have to wait briefly until ZEN completes its measurements. The duration depends on e.g. number of ROIs, number of time points, image size, number of pixels etc.

12.16.1.2 Adjusting ROIs for Time Points
If objects move laterally in the course of the time series, you can adjust the ROIs at each Time
Point in order to follow the objects.
Prerequisite ü You have defined at least one ROI.
ü You are in the MeanROI view.
1. Open the Dimensions tab in the general view options.
2. Use the Time slider to scroll through the time points. Stop at the first time point at which
you want to adjust a ROI.
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3. Open the ROI Tracing tab and activate the Enable ROI Tracing checkbox. To edit the po-

4.

5.

6.

7.

sition of a single Key frame change the Key Frame Edit Mode to single mode
.
Note that you can only select the key frame edit mode if the frame number is set to a value
>1.
Adjust the position of the ROI using drag & drop. To do this, select the ROI in the image
area by pressing the left mouse button. Then move the ROI to the new position and release
the mouse button. Note that rectangular or contour ROIs can also be rotated.
If necessary, you can change the shape of a ROI, by right-clicking on a ROI and selecting
Edit Points (e.g. for polygon contours). It is also possible to rotate a ROI if necessary.
Note that if the area of the ROI changes, the mean intensity value will change. For ratio values in which thresholding is applied, only "valid" pixels will be respected (see Basics of Calculation of Intensity and Ratio Values [} 463]). Ratios can only be performed if you have
the module Physiology (Dynamics).
Adjust the shape/ rotation of the ROI, by drag & drop the contour points/ via the rotation
handle.
à Changes to the position and shape of the ROIs are adopted for all subsequent time
points.
Repeat the previous steps for all other time points for which you want to adjust an ROI.
For a selected ROI you can see a list of the time points in which its position/shape was
modified. As the distance (in frames) between each key frame can vary, a linear interpolation is used to smoothly progress the ROI through the time points. Alternatively, deactivate
this (constant) or set it to a spline method that may better describe the progression of the
object you are tracing.

You have successfully adjusted the measurement regions to the course of the experiment.
12.16.1.3 Adjusting the Display
Here you will find out how to adjust the display of the measured intensity values in charts and tables according to your wishes.
Prerequisite ü You are in the MeanROI view or MeanROI Setup.
ü You have defined at least one ROI.
1. Select the Layout tab in the view options.
2. To adjust the layout of the image and diagram display, select the desired display mode under Image and Chart.
3. If you also want your data to be displayed in table form (note for MeanROI setup the table
is only displayed after the acquisition is completed), select the desired display mode under
Image and Chart with Table. With the Export tab, you can export the data table directly
as a comma separated values file or create a separate data table document.
Tables created in this manner contain additional information, for details see Basics of Calculation of Intensity and Ratio Values [} 463]. The table in the MeanROI view only shows
two values per ROI and time point, the mean intensity of pixels above the set threshold per
channel and the mean ratio value derived from (common) "valid" pixels.
4. In the MeanROI view (not the MeanROI setup) you can interact with a table in various
ways. See Interaction with a table in MeanROI view [} 464].
5. You can determine the zoom (range) of the charts of all given channels (including Ratio
charts) by clicking on the chart, selecting it, and scrolling with the mouse wheel.
6. For Offline Analysis only: Select a suitable layout for the image, chart and table display.
7. If you want to adjust the axis scaling (range), go to the Charts tab in the view options.
8. To define the minimum and maximum values of the axes manually, click on the Fixed button under X-/Y-Axis.
à The Min and Max input fields for the axis are activated.
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9. Enter the desired values first into the Max and then the Min input fields.
à The minimum and maximum axis values of the diagrams are adjusted. Note that the Yaxis scaling can be adjusted individually for each chart.
10. To change the unit of the X axis, click on the Fixed button under X Units.
à The dropdown menu for the units is activated. You can now select the desired unit.
11. On the Layout tab, it is also possible to determine if a given channel view and/ or chart
panel should be hidden. This is useful if these do not contain information that needs to be
visible, thus increasing space on the screen for the remaining items. For example, in many
applications transmitted light is used to monitor the specimen, but the intensity information
(chart) is not required. The controls behave in a similar manner to the channel toggles on
Dimensions tab.
You have successfully adjusted the display of the intensity values.
12.16.1.4 Using Background Correction
Use this function to subtract background values from the measurement values. A background correction will allow you to make a better comparison of the magnitude of any fluorescent intensity
changes observed over the time course of an experiment. Determine the background value with
the help of a Background ROI or define a fixed value. Note that the background correction for ROI
is only available if there are at least two ROI defined in the image!
If the ratio calculations are enabled, the background correction parameters are defined on the Ratio tab. The background correction values on MeanROI tab are disabled, i.e. not used in this
case.
Defining a Background ROI
Prerequisite ü You are in the MeanROI view or MeanROI setup.
1. At the desired time point of the time series, draw a ROI into a part of the image that contains only background signal in all channels.
2. Go to the MeanROI tab > Background Correction section and activate the radio button
ROI. Note that this function is only available if two or more ROIs are present.
3. In the drop down, select the ROI-ID of the ROI that you defined in the first step.
4. To edit the Background ROI, simply draw a new ROI and select it from the dropdown list.
You have successfully defined a Background ROI. The mean intensity of the background ROI is
subtracted from the measured values of the ROIs in a channel- and time-point-specific manner.
The corrected values are adopted into all diagrams and tables.
Defining a fixed background value
Prerequisite ü You are in the MeanROI View or MeanROI Setup.
1. On the MeanROI tab in the Background Correction section select the Constant option.
à The associated input field is activated.
2. Enter a fixed background value into the Constant input field.
3. Press Enter to update the measurements.
The defined background value is subtracted from all measured values of the ROIs in a time-pointspecific manner.
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12.16.1.5 Exporting a Data Table
Prerequisite ü You are in the MeanROI view.
ü You have defined at least one ROI.
1. Select the Export tab in the View Options.
2. In the Data Table section click on the Save As (*.csv) button.
à The Save As dialog opens.
3. Enter a suitable file name, navigate to the desired folder and click on Save.
à All the measurement data are saved as comma-separated values in a csv file. This contains the time information, marker events, the geometric area of the ROIs, the area of
ROI adjusted by threshold (only with Physiology (Dynamics) module), the mean intensity of the ROI, the mean intensity of the ROI adjusted by threshold (only with Physiology (Dynamics) module), mean ratio value (only with Physiology (Dynamics) module),
focus position, and incubation events/ values (if configured) for each channel and each
ROI.
12.16.1.6 Calculating a Ratio for One Wavelength
Prerequisite ü To calculate ratios (quotient of two fluorescence intensities) and display ratio images, you
need the Physiology (Dynamics) module.
ü You have a suitable image data set open.
ü You are in the MeanROI view on the Ratio tab (view option).
1.
2.
3.
4.

Activate the checkbox Enable Ratio Calculation.
In the Method dropdown list, select the Single Wavelength (F/F0) entry.
In the Calculation dropdown list select the channel for calculating the ratio.
In the Reference image (Ft0) setup, define the frames of the time series image from which
you want the reference value Ft 0 to be calculated.
5. Click on the Update button.
à The ratio values are calculated. The ratio image and a diagram for the ratio values are
displayed in the MeanROI view. For very large images (pixels and time points) it might
be necessary to use the Cache Ratio Image function on the Ratio tab, as this will eliminate flickering when playing through the images at speed.
You have successfully calculated a ratio for a single wavelength dye such as Fluo-4.
12.16.1.7 Calculating a Ratio for Two Wavelengths
Prerequisite ü To calculate ratios (quotient of two fluorescence intensities) and display ratio images, you
need the Physiology (Dynamics) module.
ü You have a suitable image date set open.
ü You are in the MeanROI View on the Ratio tab (view option).
1. In the Method dropdown list select the Dual Wavelength or any other of the Ratio Type
formulas present. entry.
2. In the Calculation dropdown lists select the channels for calculating the ratio.
à The ratio values are calculated automatically.
3. Click on the Cache ratio image button to cache all the ratio images of the current time series with the given ratio calculation parameters.
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à The ratio values are calculated. The ratio image and a ratio diagram are displayed on the
MeanROI view. For very large images (pixels and time points) it might be necessary to
use the Cache Ratio Image function on the Ratio tab, as this will eliminate flickering
when playing through the images at speed.
You have successfully calculated a ratio for a dual wavelength dye such as Fura-2.
12.16.1.8 Basics of Calculation of Intensity and Ratio Values
The ratio calculation in ZEN blue MeanROI / Physiology functions in the following manner:
After you have set up the ratio to your satisfaction (background correction/ thresholding), you can
gather/ view all the results using the export functions found on the export tab in MeanROI view.
You can also view a smaller table within the MeanROI view itself by activating the appropriate
layout.
How are your threshold and background values handled for intensity and ratio measurements?
The threshold value will be applied prior to background subtraction if both are active. If this is this
is the case, then for charts/tables the intensity values of any given ROI are handled this way: if a
pixel in the ROI is under the threshold value, it will be ignored for the calculation of the mean
value of the ROI. After that the background is subtracted from the mean value to get the corrected intensity value of the ROI (note if no pixel remains valid in the ROI after the application of
the threshold, the corrected mean intensity is always 0 and hence the ratio is also 0). In the case
of the ratio image, each pixel is "validated" based on the threshold value. If the pixel is above the
threshold then the pixel value is kept (i.e. is valid), otherwise it is set as NaN (Not a Number,
which is not the same as zero) and is considered invalid). As before, background correction is
done after threshold. If the pixel value is NaN, the ratio pixel value is NaN. If the pixel is still valid
then use pixel value - background value in the ratio calculation. If a negative value results, it is
clipped to 0.
The following example shows how a ratio value is generated based on the applied background
and thresholding values:
Consider a region of interest that is 6 pixels wide by 1 pixel high. The pixels of the region in the
Wavelength 1 image are as follows:
[50, 75, 100, 125, 150, 175].
For the purpose of this example, assume the threshold = 60 for wavelength 1.
ZEN thresholds Wavelength 1 to obtain:
[--, 75, 100, 125, 150, 175].
The pixels of the region in the Wavelength 2 image are as follows:
[25, 25, 25, 25, 100, 100].
For the purpose of the example, assume the threshold = 50. ZEN thresholds Wavelength 2 to obtain:
[---, ---, --- , ---, 100, 100].
ZEN computes the Ratio by only rationing the averaged values for the valid pixels in each individual wavelength. To recap, the pixels for each wavelength were:
[--, 75, 100, 125, 150, 175] (Wavelength 1)
[---, ---, --- , ---, 100, 100] (Wavelength 2)
The ratio value of this region is calculated by taking into account only the common area, which
corresponds to the area of the sum of the valid pixels common to the two wavelengths (which in
this example is only 2 “valid” pixels).
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Using the threshold values as above, the pixels that are used to calculate the ratio average are:
150/100
175/100
which gives a ratio of 1.625.
To get an overview of all the results, including the original values not corrected for there validity
in this manner, use the data table creation function in the MeanROI export tab. This opens, for example, a new document or allows you to export the results as a *.csv file. This data table/ *.csv includes for each ROI the following information /measurements:

Value in ID in table header

Description

<Channel name>_<Region
ID>_Area

Geometric area of ROI (constant for both channels).

<Channel name>_<Region ID>_IntensityAreaThrs

Threshold corrected area within ROI for given
channel.

<Channel name>_<Region ID>_IntensityMean

Mean intensity of pixels within the geometric area
of the ROI.

<Channel name>_<Region ID>_IntensityMeanThrs

Mean intensity of pixels above the set threshold
for the given channel.

Ratio <Region ID>

Mean Ratio value derived from common “valid”
pixels.

This is repeated for the second channel, and at the very end you will find the Ratio value. Thus,
the threshold corrected values are provided for each channel (mean intensity and the corresponding area from which this is derived) as well as the ratio value for the common valid pixels. Relative
time, markers, focus values and parameters from the incubation (if configured) are also listed. In
the embedded table in Mean ROI view you will find a summary that gives the following values:
Mean intensity of pixels above the set threshold for each channel (wavelength) and the corresponding ratio values. No Area values are given here.
12.16.1.9 Interaction with a table in MeanROI view
In the MeanROI view (not the MeanROI setup) you can interact with a table in the following
ways:
§

Scroll up or down or left to right. Time values are given at the far left and at the far right any
markers are shown at the time point they were created. In between you find the values for
each ROI in the first channel, then the second and so on, then the ratio values.

§

If you click on the column header you select the entire column and in your charts you will see
the trace corresponding to this ROI is highlighted by a thicker line. Multiple columns can be
selected by pressing and holding shift key.

§

If you click any given value in a column, not only will the trace of the corresponding ROI be
highlighted, the images that correspond to this time point will be displayed, and the playhead
(vertical blue line) of all charts will synchronise to this time point. This allows quick and easy
examination of the data/ events.
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12.16.2 Workflow Physiology (Dynamics) Experiments
If you own the Physiology (Dynamics) module you can use the MeanROI setup to specify userdefined measurement regions (ROIs) before the acquisition of your time lapse experiment and analyze their time‑dependent changes in intensity online during acquisition. Ratios can also be calculated and displayed online - these are the typical functions used in physiology/ calcium Fura-2 applications.
Before the experiment
A precondition for a physiology experiment is a Time Series experiment (which can include a zstack acquisition), which is set up in the Time Series tool. Adding a time dimension to your experiment allows you to activate the optional tool Dynamics. This tool contains the button for
opening MeanROI Setup. Here you can draw in ROIs and adjust the display layout of the measurement results. Note that when the setup is opened a snap is automatically acquired, on the basis of which you can configure the settings for the subsequent experiment, like for example the
ratio parameters. The structure of the MeanROI setup is based on the MeanROI view [} 859],
making it easier to learn. Note that online measurements on tiles and positions experiments are
not possible, but you can perform measurements on tiles or position data collected over time (i.e.
multi-scene time series) in MeanROI view post acquisition.
During the experiment
After being started, physiology experiments are displayed in the online mode of the MeanROI
View. This allows you to analyze and follow the experiment during acquisition. The structure and
options largely correspond to the offline mode of the MeanROI View. We therefore recommend
that you familiarize yourself with the MeanROI View (offline) [} 458] before performing your Physiology experiment.
After the experiment
After you have performed your Physiology experiment the data are displayed in the offline mode
of the MeanROI view and can be analyzed, processed and exported there. For more information,
see also Workflow MeanROI View (offline) [} 458].
Prerequisite ü To perform physiology experiments, you need the Physiology (Dynamics) module.
ü You have created a new experiment [} 44], defined at least one channel [} 43] and adjusted
the focus and exposure time.
ü You are on the Acquisition tab.
1. Activate the Time Series tool in the Acquisition Dimensions section.
à The Time Series tool appears in the Left Tool Area under Multidimensional Acquisition.
2. Enable the Dynamics tool in the experiment manager.
à The Dynamics tool now appears in the in the Left Tool Area under Applications.
à Note that the tool is not available if the Tiles or Panorama dimensions are activated.
Deactivate these dimensions to make the tool available.
3. Set up a time series experiment [} 49].
4. Open the Dynamics tool.
5. Click on the MeanROI Setup button.
You have completed the general prerequisites for Physiology experiments.
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12.16.2.1 Setting up an Experiment in MeanROI Setup
Prerequisite ü You have read the Workflow Physiology (Dynamics) Experiments [} 465] chapter.
1. Activate the Dynamics checkbox in the Experiment Manager.
2. In the Dynamics tool, click on the MeanROI Setup button.
à MeanROI setup opens.
à An image is acquired automatically, on the basis of which you can configure your settings. You can click on Snap at any time to update the image.
12.16.2.1.1 Drawing in ROIs
Prerequisite ü You are in the MeanROI View or in the MeanROI Setup on Acquisition tab.
1. Go to the Graphics tab in the View Options.
2. Select a tool for drawing in ROIs, e.g. the Polygon tool.
3. Activate the Keep tool checkbox.
à The selected tool remains active after you have drawn in an ROI. This means you can
draw in several ROIs without having to re-select the tool.
4. Using the selected tool, in the image view draw in the objects or regions (ROIs) for which
intensity measurements are required.

à The ROIs are displayed in the list (Annotations/ Measurements Layer) on the Graphics
tab.
à Intensity measurements are performed for each ROI and displayed in the chart area to
the right of the image view.
You have successfully defined measurement regions for the intensity measurement.
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NOTICE
Measurement time
Note that the time taken to initially create measurements will vary as some date is cached to
memory. Thus, when a long time series image is opened that already contains ROIs, you might
have to wait briefly until ZEN completes its measurements. The duration depends on e.g. number of ROIs, number of time points, image size, number of pixels etc.

12.16.2.1.2 Adjusting the Display
Here you will find out how to adjust the display of the measured intensity values in charts and tables according to your wishes.
Prerequisite ü You are in the MeanROI view or MeanROI Setup.
ü You have defined at least one ROI.
1. Select the Layout tab in the view options.
2. To adjust the layout of the image and diagram display, select the desired display mode under Image and Chart.
3. If you also want your data to be displayed in table form (note for MeanROI setup the table
is only displayed after the acquisition is completed), select the desired display mode under
Image and Chart with Table. With the Export tab, you can export the data table directly
as a comma separated values file or create a separate data table document.
Tables created in this manner contain additional information, for details see Basics of Calculation of Intensity and Ratio Values [} 463]. The table in the MeanROI view only shows
two values per ROI and time point, the mean intensity of pixels above the set threshold per
channel and the mean ratio value derived from (common) "valid" pixels.
4. In the MeanROI view (not the MeanROI setup) you can interact with a table in various
ways. See Interaction with a table in MeanROI view [} 464].
5. You can determine the zoom (range) of the charts of all given channels (including Ratio
charts) by clicking on the chart, selecting it, and scrolling with the mouse wheel.
6. For Offline Analysis only: Select a suitable layout for the image, chart and table display.
7. If you want to adjust the axis scaling (range), go to the Charts tab in the view options.
8. To define the minimum and maximum values of the axes manually, click on the Fixed button under X-/Y-Axis.
à The Min and Max input fields for the axis are activated.
9. Enter the desired values first into the Max and then the Min input fields.
à The minimum and maximum axis values of the diagrams are adjusted. Note that the Yaxis scaling can be adjusted individually for each chart.
10. To change the unit of the X axis, click on the Fixed button under X Units.
à The dropdown menu for the units is activated. You can now select the desired unit.
11. On the Layout tab, it is also possible to determine if a given channel view and/ or chart
panel should be hidden. This is useful if these do not contain information that needs to be
visible, thus increasing space on the screen for the remaining items. For example, in many
applications transmitted light is used to monitor the specimen, but the intensity information
(chart) is not required. The controls behave in a similar manner to the channel toggles on
Dimensions tab.
You have successfully adjusted the display of the intensity values.
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12.16.2.1.3 Using Background Correction
Use this function to subtract background values from the measurement values. A background correction will allow you to make a better comparison of the magnitude of any fluorescent intensity
changes observed over the time course of an experiment. Determine the background value with
the help of a Background ROI or define a fixed value. Note that the background correction for ROI
is only available if there are at least two ROI defined in the image!
If the ratio calculations are enabled, the background correction parameters are defined on the Ratio tab. The background correction values on MeanROI tab are disabled, i.e. not used in this
case.
Defining a Background ROI
Prerequisite ü You are in the MeanROI view or MeanROI setup.
1. At the desired time point of the time series, draw a ROI into a part of the image that contains only background signal in all channels.
2. Go to the MeanROI tab > Background Correction section and activate the radio button
ROI. Note that this function is only available if two or more ROIs are present.
3. In the drop down, select the ROI-ID of the ROI that you defined in the first step.
4. To edit the Background ROI, simply draw a new ROI and select it from the dropdown list.
You have successfully defined a Background ROI. The mean intensity of the background ROI is
subtracted from the measured values of the ROIs in a channel- and time-point-specific manner.
The corrected values are adopted into all diagrams and tables.
Defining a fixed background value
Prerequisite ü You are in the MeanROI View or MeanROI Setup.
1. On the MeanROI tab in the Background Correction section select the Constant option.
à The associated input field is activated.
2. Enter a fixed background value into the Constant input field.
3. Press Enter to update the measurements.
The defined background value is subtracted from all measured values of the ROIs in a time-pointspecific manner.
12.16.2.2 Starting and Influencing an Experiment
Prerequisite ü You have read the Workflow Physiology (Dynamics) Experiments [} 465] chapter and set up
an experiment in MeanROI Setup.
ü You are on the Acquisition tab.
1. Start your Physiology experiment by clicking on the Start Experiment button.
à The time series experiment is started. The MeanROI View [} 859] (online) opens and displays the current images and the intensity curves for each ROI measured online. The intensity curves are displayed in the Time Line View and in the diagrams. Note that the
MeanROI view will display at the third time point. This is noticeable when the interval
time is longer. Thus this display delay should fall into the typically base line of this type of
experiments, i.e. prior to the first stimulus of the sample.
2. You can pause the experiment at any time by clicking on the Pause Experiment button
and continue it again by clicking on the Continue Experiment button.
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3. The Focus can be adjusted during the experiment. To prevent images that are not sharp
being acquired, pause your experiment and use the Live acquisition button to adjust the focus. Then continue the experiment. Note that using the Live view only works with experiments run in interactive mode. In triggered acquisition scenarios this is not possible.
4. Adjust the display of the intensity values during the experiment by changing the settings on
the Layout or Charts tab. The unit of the X-axis cannot be changed during the experiment.
5. You can move and change ROIs during acquisition. The changes are adopted for all time
points, see Drawing in and adjusting ROIs. Note that ROI tracing functions (these allow objects to be followed in XY) are only available after an acquisition.
6. Activate Switches in the Time Series tool during the experiment to perform the corresponding actions.
à Various events, such as the activation of switches or the pausing of the experiment, are
labeled in the Time Line view by markers.
7. On the Dimensions tab deactivate the Follow Acquisition checkbox to analyze the data
acquired up to that point. To do this, select the corresponding time points using the Time
slider, the diagram sliders or the Time Line view slider in the MeanROI view.
8. Change the size of the area marked in blue in the Time Line View to adjust the section displayed in the charts (time axis).
You have successfully started the experiment, analyzed it online and influenced it.
12.16.2.2.1 Adjusting ROIs during experiments
If objects move laterally in the course of the experiment, you can adjust the ROIs at any time during the experiment in order to follow the objects.
Prerequisite ü You have defined at least one ROI.
ü You have started your Physiology experiment.
1. In the Experiment Manger click on Pause experiment button.
2. Adjust the position of the ROI using drag & drop. To do this, select the ROI in the image
area by left-clicking and hold the mouse button down. Then move the ROI to the new position and release the mouse button.
3. To change the shape of an ROI left click on an ROI and drag the bounds to adjust the size.
à Changes to the position and shape of the ROIs are adopted for all time points.
4. Repeat the previous steps for all subsequent ROIs that you wish to adjust. Note that you
can select multiple ROIs and adjust all the positions simultaneously.
You have successfully adjusted the measurement regions (ROIs) to the course of the experiment.

12.16.3 Sample Experiment Fura-2 with DG4/5
12.16.3.1 Step 1: Creating channels
Prerequisite ü To perform the experiment, you need the Physiology (Dynamics) module.
ü You have a Sutter DG4/5 with appropriate excitation filters for Fura-2 and a Fura-2 filter
set in the microscope's reflector wheel.
ü You are on the Acquisition tab.
1. Create a new experiment in the Experiment Manager, e.g. "Physiology Fura-2".
2. Add the channel Fura-2 using Smart Setup.
3. Activate the Time Series checkbox in the acquisition dimensions.
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4. Open the Channels tool.
5. Select the Fura-2 channel from the list.
6. Click on Options
and select Duplicate.
7. Select the first Fura-2 channel from the list.
8. Click on the Options
and select Rename.
à You can now rename the channel, e.g. Fura-2 340 nm.
9. Repeat steps 7 and 8 to rename the second channel, e.g. Fura-2 380 nm.
10. Select the Fura-2 380 nm channel.
11. Select another LUT from the dropdown list, e.g. red.
12. Select the entry 21 HE Ex. FURA 380 from the Excitation dropdown list.
à The excitation filter is used for this channel.
13. Adjust the exposure time and focus for both channels.
You have created the channels for your experiment.
12.16.3.2 Step 2: Setting up a time series and creating switches
1. Open the Time Series tool.
2. Using the Duration slider and the dropdown list for the unit, specify the duration of the experiment, e.g. 10 min.
3. Using the Interval slider and the dropdown list for the unit, specify the length of the interval between acquisitions, e.g. 1 second.
4. To create interactive switches open the Interactive Switches section in the Time Series
tool. This section is visible only if the Show All mode is activated.
5. Click on the Add button
.
à A new switch is added.
6. Edit the switch by clicking on the arrow to the right of the switch.
à The switch properties are visible.
7. Enter a name, e.g. Fast. Activate the Color checkbox and select a color, e.g. blue. Define
an action to be performed when you activate the button, e.g. As fast as possible.
You have successfully set up a time series and created a switch.
12.16.3.3 Step 3: Setting up an online ratio
1. Open the MeanROI setup from inside the Dynamics tool.
à Mean ROI definition opens and snaps of the configured channels are acquired automatically and displayed in the Center Screen Area. The diagrams for each image are displayed
to the right of this.
2. Select the Online Ratio tab from the view options and activate live ratio generation.
3. Under Method select the Dual Wavelength entry from the dropdown list.
4. Under Calculation select the Fura-2 340 nm entry from the dropdown list in the numerator of the formula.
5. Under Calculation select the Fura-2 380 nm entry from the dropdown list in the denominator of the formula.
à A preview of the ratio image, which is calculated according to the ratio settings, is displayed.
You have successfully activated the ratio functions and specified the calculation of the ratio.
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12.16.3.4 Step 4: MeanROI Setup
1.
2.
3.
4.
5.
6.

Open the MeanROI setup from inside the Dynamics tool.
On the Graphics tab, select a tool for drawing in ROIs, e.g. Circle.
Activate the Keep Tool checkbox.
Draw your ROIs into one of the images.
Deactivate the Keep Tool checkbox and select the selection tool (arrow) again.
On the Layouts tab select a layout for the image and diagram display, e.g. multichannel
image and single channel charts.
7. Go to Charts tab and click on the Fixed button under X Units and select a unit from the
dropdown list, e.g. seconds.
8. Click on Exit at the top left of MeanROI Setup.
You have successfully configured and adjusted the MeanROI Setup.
12.16.3.5 Step 5: Starting, analyzing and influencing an experiment
1. Start the experiment by clicking on the Start Experiment button.
à The experiment is started. In our example an image is acquired every second for a period
of 10 minutes. The experiment opens in the online mode of the MeanROI View, which
displays the current images and measurements.
2. Activate the created switch at the desired time point. To do this, open the Switches section in the Time Series tool. Click on a switch as soon as you want its action to be performed, e.g. click on the "Fast" switch to acquire the subsequent images as quickly as possible one after the other. A marker will mark the time point at which the switch was activated on the X axis in the color of the switch (e.g. blue).
3. Once the time series has been completed you can analyze the experiment in the offline
mode of the MeanROI view, process it and export its values.
You have successfully performed the experiment.
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12.17 Shuttle & Find

Fig. 28: SEM / LM system for correlative microscopy
This module enables you to relocate sample positions in two different microscopes, e.g. a light
microscope and a scanning electron microscope (SEM). Afterwards you can correlate the two images to one merged image. This technique is called correlative microscopy or just "CorrMic". It is
used to combine the two worlds of scanning electron microscopy and light microscopy and brings
it together in one image.
The samples can be mounted in special designed correlative holder systems (with three correlative
calibration markers) from ZEISS. Also user-defined holder systems with three calibration markers
can be used. Biological samples are mainly deposited on cover glasses or on TEM grids. In contrast
to biological samples, the shape and size of material samples vary strongly. In respect to these requirements, the correlative holders were designed accordingly.

Fig. 29: Example of a correlative ZEISS sample holder
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12.17.1 Settings and Image Acquisition with the Light Microscope
Before acquiring an image with the light microscope and using it for correlative microscopy, it is
necessary to make general settings e.g. stage calibration, camera orientation, calibrating objectives and setting the correct scaling. Please notice that we do not describe all theses topics within
this guide as we focus on the Shuttle & Find workflow only.
Furthermore we will not describe basic functionality of the software in this guide, like program
layout or general image acquisition topics.

See also
2 Shuttle & Find Sample Positions at the Electron Microscope [} 480]
12.17.1.1 Mounting the Sample Holder to the LM

Fig. 30: Mounting of cover glasses or TEM grids
1. Place the cover glass (2) in the suitable sample holder and fix it.

In case of using the holder Life Science Cover Glass 22x22:
– Remove the clamping frame (1) using tweezers.
– Insert the cover glass (2) in the sample holder (3).
– Slide in the clamping frame into the sample holder until the clamps are clicking into place
(4).

In case of using the holder Life Science for TEM grids:
– Lift the spring of the appropriate position and turn it sidewards (5).
– Insert the TEM grid (6) into the provided holding spot of the holder and fix it with the spring
(7).

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

473

12 Software Modules & Extensions | 12.17 Shuttle & Find

ZEISS

Fig. 31: Inserting a sample holder
2. Insert the sample holder (1) into the mounting frame of the microscope stage in the following
way:
– For inverted stands, see (3).
– For upright stands, see (2).
12.17.1.2 Starting the LM Software
For correlative microscopy with light microscopes ZEN (blue edition) software has to be installed.
In addition you need to licence the Shuttle & Find modul.
1. To start the software click on the corresponding program icon on your desktop.
à The application selection window will appear.
2. Click on ZEN pro or ZEN system to start the desired application.
à The software will start now. Make sure that you have activated the Shuttle & Find module in the menu Tools > Modules Manager ...
3. In the Left Tool Area switch to the Acquisition tab and activate Shuttle & Find.
4. Open the Shuttle & Find tool.
You have successfully started the software. Now you can start working with the Shuttle & Find
module.
12.17.1.3 Selecting the Sample Holder
Prerequisite ü You have activated Shuttle & Find in the Experiment Manager.
ü You are in the Shuttle & Find tool.
1. Click on the Select… button to open the Select Template dialog and to choose the correlative holder you want to use. Different types of correlative holders are available, see Appendix Correlative Sample Holders
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2. In the Select Template dialog select the correlative holder you want to work with. If you
want use your own sample holders, click on the Add button
below the list and follow the instructions in the chapter Defining a new sample holder template [} 475].

3. Click on the Ok button to close the dialog.
You can now continue with the calibration of the sample holder, like it is shown in the chapter
Calibrating the sample holder [} 476]. The calibration of the sample holder is mandatory to acquire images.
12.17.1.4 Defining a New Sample Holder Template
With this dialog you can define new correlative holders in addition to the existing holder templates. It is not mandatory to use correlative holders from ZEISS. User-defined correlative holders
with 3 fiducial markers can be used as well.
1. To open the dialog click on
Add in the Select Template dialog. This dialog can be
opened via the Shuttle & Find tool.
à The New Template dialog opens.

2. Type in a name for the new holder / sample carrier. An image of the new holder can be
loaded as well.
3. Insert the distances (in millimeters) between the first and the second marker and between
the second and third marker.
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à The distances can be determined using the Stage Control dialog accessible via the Light
Path tool in Right Tool Area tab. We recommend to do this before you start the New
template dialog. Write down the distances to be prepared to enter them within the New
Template dialog.
à Activate the live view in the Center Screen Area by clicking on the Live button in the Locate tab.
à Navigate the stage manually to the calibration marker on the sample holder by means of
the joystick and note the x/y-coordinates of the marker.
à Repeat this procedure for all three markers and calculate the distances between marker 1
and marker 2 and between marker 2 and marker 3, respectively.
12.17.1.5 Calibrating the Sample Holder
Correlative sample holders have three fiducial markers enabling a three point calibration (signed
with the numbers 1-2-3) The calibration markers consist of one small (length 50 µm) and a large
L-shape marker (length 1 mm). The bigger marker is used for coarse orientation, whereas the
smaller marker is used for the calibration.
12.17.1.5.1 Preparing Calibration
1. Click on Live in the Acquisition tab to activate the live view in the Center Screen Area.
2. Navigate the stage manually to the first calibration marker on the sample holder (marked
with No. 1) by means of the joystick. It is enough if you move the stage to the larger Lshaped calibration marker. The smaller marker will be detected automatically within the
Sample Holder Calibration Wizard.To locate the marker positions we recommend to use
a dry objective with low magnification (5x – 20x).

3. Open the Shuttle & Find tool.
4. Click on Calibrate… to open the Sample Holder Calibration Wizard.
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12.17.1.5.2 Setting Calibration Options

Fig. 32: Sample Holder Calibration Wizard Options
In step 1 of the wizard, the following options should be activated to follow our recommended
workflow:
1. Check if the Automatic movement to next marker checkbox is activated.
à This will automatically move the stage to the next marker position after you have confirmed the position of the marker and clicked on Next.
2. Check if the Use automatic marker detection checkbox is activated.
à The software will try to find the correct positions of each marker automatically.
3. If you need to change the marker color, or check if the marker orientation is set correctly,
activate the Use settings for marker detection checkbox to access these functions.
4. Click on Next to move to the next wizard step.
12.17.1.5.3 Performing Calibration
1. Click on Set to detect the first marker position.
à An automatic stage calibration will be performed. After the stage calibration, the system
will try to detect the marker position of the small marker automatically.
à A message appears which asks if the marker was detected correctly.
2. Click on Yes to confirm the message.
3. Click on Next to move to the next step of the wizard.
à The stage will automatically move to the next (coarse) marker position. If the stage
moves into the wrong direction you can use the invert X / invert Y buttons to correct
the movement direction.
4. Repeat the previous steps and set marker position 2 and 3 accordingly.
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à After setting marker position 3 you will find a green check mark icon which shows that
the calibration was successful.

5. Click on Finish to save the calibration and close the wizard.
To check if the calibration was successful acquire an image and open the Tree view in the Center
Screen Area. There you should see the correlative calibration data in the list. If the Tree view is not
visible go to Tools | Options | Documents and activate the Enable Tree View checkbox.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

478

12 Software Modules & Extensions | 12.17 Shuttle & Find

ZEISS

12.17.1.6 Acquiring the LM Image
Basically image acquisition is performed as you are used to do it within ZEN software. The file format for Shuttle & Find data is the common *.czi file format. Saved images can be loaded in ZEN
via the menu File | Open.
After image acquisition the next step in the correlative workflow is to define / draw in ROIs / POIs
in your image. Therefore you can use the Region tools on the S&F tab, see Regions, Find and Dimensions [} 490].

Fig. 33: LM image
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12.17.2 Shuttle & Find Sample Positions at the Electron Microscope
Now you can transfer (Shuttle) the sample and the LM (Light Microscope) image file (.czi) to the
SEM (Scanning Electron Microscope). There you can easily relocate (Find) the same sample positions and acquire a corresponding image within the ZEN SEM software. Therefore exactly the
same steps have to be done as for the light microscope.
12.17.2.1 Mounting the Sample Holder to the SEM
For imaging your sample in the SEM, insert the sample holder (2) in the special SEM adapter (1)
and mount it to the SEM.

Info
The arrow of the sample holder has to face the arrow of the SEM adapter.

Fig. 34: Sample holder mounted in SEM adapter
12.17.2.2 Starting the ZEN SEM Software
For correlative microscopy with scanning electron microscopes SmartSEM and ZEN (blue edition)
SEM have to be installed. SmartSEM is still the control software of the scanning electron microscope. ZEN (blue edition) SEM comes as an add-on for SmartSEM to perform correlative microscopy and using Shuttle & Find on a SEM.
Prerequisite ü You have started SmartSEM.
1. Start the ZEN software by clicking on the program icon on your desktop.
à The application selection window appears.
2. Click on the SEM button to start.
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à You will see the program interface with a reduced user interface comparing to the software. In the Left Tool Area the SEM Acquisition tab and the Processing tab are available only. On the SEM Acquisition tab you will find the Shuttle & Find tool which has 3
additional buttons at the lower part of the tool.

12.17.2.3 Selecting the Sample Holder
This step is exactly the same step like for the light microscope, so please read the chapter Selecting the Sample Holder [} 474] if you want to know the exact steps which you have to perform.
12.17.2.4 Calibrating the Sample Holder
Like the step before this step is exactly the same like for the light microscopy, so please refer to
the chapter Calibrating the sample holder [} 476] for details.

Info
§

The calibration of the sample holder has to be done on both systems the LM and the SEM.
Otherwise the relocation of your sample positions or ROIs / POIs stored in the image won`t
be successful.

§

Note that for Shuttle & Find the beam shift must be switched off. The beam shift is deactivated in SmartSEM as follows:
– Call up the shortcut menu Center Point / Feature by right-clicking on the Stage property page.
– Select Center Point / Feature and select Stage only.
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12.17.2.5 Acquiring an EM Image
1. Load your LM image to ZEN SEM (.czi).
à The image will be displayed in the center screen area.
2. Activate the Live mode.
à You will see the Live image from the SEM. Notice that all settings for the SEM image
have to be done within the SmartSEM software.
3. Activate the S&F View in Center Screen Area.
4. Go to the S&F tab.
5. Check if the Double click in image to move stage and Show splitter view checkboxes
are activated (default setting).
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à In the left image container you see the live image from the SEM. The right image container is empty.
6. Drag the loaded LM image from the Images and Documents gallery into the empty image
container.
Now you can easily relocate sample positions by double clicking within the image or on the ROI/
POI button (if ROI / POI are drawn in and selected) on S&F tab.
For image acquisition you have to use the Snap button within ZEN SEM. Notice that we will not
describe setup and image acquisition with the SEM. Please read the online help or user guide for
the SEM software.

Fig. 35: SEM and LM image
12.17.2.6 Fine Calibration of the Sample Holder
The precision of relocation can be improved by determination of an offset value. This value describes the position offset between the loaded image and the live image. The defined offset value
is only valid for the loaded image. If another image is loaded or if you close the dialogue, the offset value will be deleted.
Prerequisite ü An offset is visible when you try to relocate marker positions on the live image comparing to
the LM image.
1. Click on the Set Offset button.
à The stage moves to the selected marker position. Then a message appears which asks
you to move the stage to the correct position.
2. Move the stage manually to the correct position by using the joystick.
3. Confirm the message by clicking on the OK button.
Now you can repeat the relocation. The positions should be identical now.
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12.17.3 Correlating Two Loaded Images
Prerequisite ü You have acquired and loaded two images containing S&F calibration data (e.g. LM / SEM) to
be correlated. If the images are not oriented identically you can use the Mirror Image buttons under Options on the S&F Correlation tab.
ü You see the two images next to each other (splitter view) in the center screen area. If not,
drag your images from the Images and Documents gallery into the center screen area.
1. Click on the Set correlation points button in the S&F Correlation tab.
à The cursor will change to a pipette symbol.
2. Click in the left image to set a correlation point. Set all 3 marker points in the left image
first, before you set the corresponding 3 markers in the right image. If a correlation point is
set, a check mark icon will appear in front of the corresponding point.
à Make sure that the positions in both images are identical. After you have set all 6 points
the cursor will be changed backwards from the pipette to the arrow.
3. Click on the Create Correlation button.
The correlated image will be generated and opened in a new image container.

Fig. 36: Correlated image
Tips & Tricks
§

It is also possible to set each correlation point individually. Therefore under Left Image /
Right Image click on the Arrow button behind a point (e.g. Point 1). Then click on the desired position within the image.

§

To improve the accuracy of the identification you can zoom into the images by using the
mouse wheel.
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To edit/move a point, click on the point you would like to move. When the point is marked
with a dashed rectangle you are able to move the point by holding the left mouse button. Alternatively, below Left Image / Right Image click on the points Arrow button you want to
move and click on a new position within the image.

12.17.4 Correlation of Live Image and Loaded Image
Prerequisite ü You have activated the Live mode.
1. Select the S&F view in the Center Screen Area and click on the S&F Correlation tab.
à The splitter view will become visible in the Center Screen Area. In the left image container you see the live image.
2. Drag the corresponding LM image from the Documents and Images Gallery into the
Center Screen Area.
3. Click on Set correlation points button to set the correlation points. Always start with setting 3 points in the left (live) image, then continue with setting the identical points (in the
same order) in the loaded image.
4. After setting all 6 correlation points the image correlation will be performed automatically.
The correlated image will be visible in a third image container below the live image and the
loaded image.

12.17.5 Shuttle & Find with an EVO 10
To use Shuttle & Find (SW and correlative holders) with an EVO 10 make sure that the stage limits
(for x, y and z) are set as follows:
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Holder Positions
The holder positions must be oriented like shown in the images

NOTICE
If you set a wrong orientation the stage cannot be moved to all correlative markers because of
the stage limits for the EVO 10.
4 The holder has to be mounted into the EVO in that the way that the correlative markers
(1) and (2) have to be near the chamber door whereas marker (3) is located furthest from
the chamber door (see Mounting A/B).
4 If necessary, the SEM image can be rotated according to the LM image using the option
Scan Rotate in SmartSEM.
Mounting A:
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12.17.6 Functions & Reference
12.17.6.1 User Interface

1

2

3

Fig. 37: User Interface

1

Shuttle & Find View
Area where the images are displayed. For more information, see Shuttle & Find View
[} 489].

2

Shuttle & Find Tool
Here you choose and calibrate your sample holders. For more information, see Shuttle &
Find Tool [} 487].

3

Shuttle & Find View Options
Here the Shuttle & Find specific view options are available. For more information, see
S&F Tab [} 489] and S&F Correlation Tab [} 492].

See also
2 Sample Holder Calibration Wizard [} 493]
12.17.6.2 Shuttle & Find Tool
Here you choose and calibrate your sample holders. The tool is visible only if you have activated
the Shuttle & Find checkbox in the Experiment Manager.

Fig. 38: Shuttle & Find Tool
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Parameter

Description

Sample holder

Here you see the name and preview of the selected sample
holder.

Select...

Opens the Select Template dialog. There you select the preferred sample holder or define new holder templates, see Selecting the Sample Holder [} 474].

Calibrate...

Opens the Sample Holder Calibration Wizard [} 493]. There you
can calibrate the selected sample holder.

Apply to Image

Only visible if the Show All mode is activated.
Use this button only, when you forgot to calibrate the
holder before you acquire the image.
Applies a calibration to an acquired image. Do not remove the
sample out of the correlative holder between image acquisition
and calibration.

Shuttle & Find tool for SEM
Only visible if you have started the ZEN SEM software.
The tool window is adapted to the requirements of the correlative workflow on a SEM. Therefore
three additional buttons are available.

Fig. 39: Shuttle & Find tool in ZEN SEM software

Parameter

Function

Scale bar

Adds a scale bar to the snapped (acquired) image.

Annotation bar

Adds an annotation bar to the snapped (acquired) image.

Select...

By clicking on this button a dialog opens to select parameters for
the annotation bar. You can select max. 9 parameters for the annotation bar.
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12.17.6.3 Shuttle & Find View
Besides the Shuttle & Find tool in the Left Tool Area, the S&F (Shuttle & Find) view is visible
in the Center Screen Area of the ZEN software. If the S&F view is selected, the S&F tab and S&F
Correlation tab will appear as specific view options under the image area.

Fig. 40: Shuttle & Find View
12.17.6.3.1 S&F Tab
Here you find helpful options and tools to draw in and relocate regions of interests (ROIs) or
points of interest (POIs) within the sample image.
12.17.6.3.1.1 Options

Parameter

Description

Mirror Image

Here you can mirror the image horizontally or vertically
by using the two buttons at the right. The alignment of the
images depends on the microscope (upright/inverted) and
orientation of the sample holder.

Keep tool

Activated: Keeps the current tool active. That's helpful if
you want to draw in more than one ROI/POI.

Auto color

Activated: Uses a new color for each new element which is
drawn in.

Snap to Pixel

Activated: Draws in graphical elements using the pixel grid.
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Parameter

Description

Use fine calibration value

Activated: Uses the measured fine calibration.
The precision of relocation and therefore the quality of the
overlay image can be improved by determination of an offset value. This value describes the offset between the
loaded image and the live image. The defined offset value is
only valid for the loaded image which you can see in the
container. If another image is loaded or if you close the dialogue, the offset value will be deleted.
Determine the offset by identification of a POI (Point Of Interest) within the snapped image. To identify a POI use the
buttons in the Regions section. By clicking on the Set Offset button, the stage moves to the supposed sample position. Compare the sample position within the live image
with the set POI and correct the stage in that way that both
shown positions are identically. Confirm the fine calibration
with the OK button. Now the fine calibration is measured
and the checkbox is activated.
More information, see Fine Calibration of the Sample
Holder [} 483].

Double click in image to
move stage

Activated: Moves the stage to the position you have double clicked on.

Refocus after stage movement

Activated: Adjusts the focus automatically after the stage
has moved.

Move stage in z-direction
before x/y movement

Activated: Moves the stage to the load position before it
moves to the next correlative calibration marker.

Show splitter view

Activated: Activates Splitter Mode in the Center Screen
Area.

12.17.6.3.1.2 Regions, Find and Dimensions

Fig. 41: Regions, Find, Dimension
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Regions and Find tool bar

Parameter

Selection mode

Draw rectangle

Description
Selects the ROIs or POIs in the image area. If you are currently in another mode, you can switch back to the Selection mode using this
button.
Draws in a rectangle (Region of Interest (ROI)) that is always parallel
to the edges of the image.
Draws in a marker point (Point of Interest (POI)).

Draw marker
Moves the stage to the center of the opened image.
Center
Moves the stage to the selected ROI / POI.
ROI / POI
Shows the current stage position as a rectangle in the image.
Show stage position
Dimension section
Here you see coordinates and dimensions of the selected graphical element in the list. If the
Scaled checkbox is activated, the unit is µm, otherwise Pixel.
§

Parameter X: Shows the horizontal position (x coordinate) of the center of the graphical element.

§

Parameter Y: Shows the vertical position (v coordinate) of the center of the graphical element.

§

Parameter W: Shows the width of the graphical element.

§

Parameter H: Shows the height of the graphical element.

Graphical elements list
Here you see the list of all ROI / POI which are drawn in.

Parameter

Description

Eye symbol

Shows or hides the ROI / POI in the image.

Lock symbol

Locks a ROI / POI to prevent changes.

Type

Displays the icon for the tool type (ROI/POI). To format a graphic element, double-click on the icon. The Format Graphic Elements dialog opens.

ID

Only visible if the Show All mode is activated.
Displays the ID for the graphic element. To do this, activate the checkbox at the corresponding list entry.
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A

Only visible if the Show All mode is activated.

ZEISS

Displays annotations for a graphic element (ROI). To do this, activate
the checkbox at the corresponding list entry. Then double click on the
checkbox. The Format Graphic Elements dialog opens. Choose an
annotation you want to have displayed within the image from the
Annotation dropdown list.
M

Only visible if the Show All mode is activated.
Displays measurement data for a graphic element. To do this, activate
the checkbox at the corresponding list entry.

Name

Displays the name of the graphic element. To change the name, double-click in the Name field. Then enter the text of your choice.

12.17.6.3.2 S&F Correlation Tab
Here you find all functions to overlay (correlate) two images.

Fig. 42: S&F Correlation tab

Parameter

Description

Transform

Here you select which image will be transformed. Choose via the Left
Image/Right Image buttons, which image should be transformed in
the other. During transformation a pixel in the overlay image is calculated by using pixels of the two original images that shall be overlaid /
merged.

Interpolation

Here you can select one of the following interpolation methods:

-

Nearest Neighbor

The gray value of the resulting pixel in the overlay image is made of a
pixel which is located next. This interpolation method is very fast.

-

Linear

The resulting or calculated pixel in the overlay image is assigned to a
gray value, which is the result of a linear combination of gray values
derive from pixels located nearby (in the original image).
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Cubic

Mirror image
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Description
The calculated pixel in the overlay image is assigned to a gray value,
which is calculated by means of a polynomial function using gray values of pixels in the original images; these pixels are located nearby the
calculated pixel.
Here you can mirror the image horizontally or vertically. Therefore
simply click on the corresponding button.
Mirroring an image is necessary, when the loaded image shows a different orientation than the live image.

Show Correlation

Activated: Opens the correlated image in a new image document /
new container.

Set correlation
points

Enables you to set 6 points (3 points in each image) as correlation
markers in a row, see Correlating Two Loaded Images [} 484].

Reset

Deletes all correlation points in the images.

Create Correlation

Active only, if all correlation points are set in both images.
Creates a correlative overlay image. A third image container with the
correlated image will be opened in the Center Screen Area and the
Show Correlation checkbox will be activated automatically.

12.17.6.4 Sample Holder Calibration Wizard

Fig. 43: Sample Holder Calibration Wizard
With the Sample Holder Calibration Wizard you calibrate your selected correlative sample holder.
The wizard is opened via the Shuttle and Find tool. Make sure that you have activated the Shuttle and Find tool and selected a sample holder, see Selecting the Sample Holder [} 474].
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12.17.6.4.1 Step 1: Options

Fig. 44: Sample Holder Calibration Wizard Options

Option

Description

Save marker images

Activated: the marker images are saved during the calibration.
The images can be used to check the calibration afterwards. Click
on the Select Folder (...) button to select a storage folder.

Move the stage to load
position before x/y
movement

Activated: the stage will move to load position before moving
to the next correlative calibration marker.

Automatic movement
to next marker

Activated: By clicking on the Next button within the wizard the
stage moves automatically to the next calibration marker.

Use Autofocus at each
marker position

This option is active only if the Automatic movement to next
marker position checkbox is activated.

In case of using an AxioObserver, the objective revolver moves to
load position.

Activated: the focus is adjusted automatically after moving to
the next marker position.
Use automatic marker
detection

Activated: The software will try to detect the small calibration
marker automatically.

Use settings for marker
detection

This option is active only if the Use automatic marker detection checkbox is activated.
Activated: shows settings for marker detection (see description
below). Here you select the properties of the calibration markers.
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Settings for marker detection
Only visible if the Use settings for marker detection checkbox is activated.

Option

Description

Threshold marker detection: high – low

A low threshold for marker detection is used when the dimensions of the correlative L markers cannot be recognized precisely,
e.g. when the sample holder is slightly filthy.

Marker color

Here you select the color of the markers displayed in the live image.
White: the marker is displayed white on a dark background.
Black: the marker is displayed dark on light background.
Auto: the marker color is set automatically.

Marker orientation

Here you need to set the orientation of the L-markers on your
sample holder. Click on the corresponding button to select the
orientation of the calibration marker which you can see in the
live image

If you click on the Next button you will move to the next step of the wizard.
12.17.6.4.2 Step 2-4: Calibration
In steps 2-4 of the wizard you will be guided through the calibration procedure.

Fig. 45: Sample Holder Calibration Wizard

Option

Function

Holder position

Move to Position 1 button
Moves the stage to marker position 1. This is possible only if the
first position was set before and x/y coordinates are given.
Current button
Only visible for marker position 2 and 3.
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Function
Moves the stage to the current marker position. This is possible
only if the current position was set before and x/y coordinates
are given.

Stage movement to the
next marker

Here you can change the movement of the stage in x or y direction. This is necessary if during calibration the stage moves in the
wrong direction.

Marker position

By clicking on the Set button, the actual marker position will be
confirmed.

12.17.6.5 Correlative Sample Holders

Name

Image

Life Science cover glass
22x22

Life Science Cryo Holder

Life Science for TEM Grids
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Image

Cover glass with fiducials
22 x 22

MAT Flat Stubs A
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Image

MAT Flat Stubs

MAT Universal A
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Image

MAT Universal B_A

MAT Universal B_B
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12.18 Software Autofocus
This module offers a configurable image based autofocus functionality that will search through a
series of axially stepped images analyzing the “sharpness” of each. The z-value of the image returning the maximum sharpness is set as the new plane of observation.
The module requires the microscope to be fitted with a motorized Z-drive. It does not require a zpiezo actuator nor is the z-piezo used by the software autofocus (SWAF) in the current implementation. On the Acquisition or Locate tab the settings for the SWAF can be adjusted in the Software Autofocus tool. These can also be called (and tested) by clicking the Find Focus (AF) button
on the main button bar on Acquisition tab. SWAF settings are stored as part of an experiment on
Acquisition tab.
The configuration allows the function of the SWAF run to be matched to the conditions under
which the focus should be found. A basic description of the functions adjusted by the individual
controls can be found in the chapter Functions & Reference. However, before going into the description of each parameter, we will try to address the following questions: How does the SWAF
in the software attempt to locate the “focus”? And how do the parameters settings influence its
behavior in this respect?

12.18.1 Terminology & Abbreviations
Perhaps the best place to start is with an explanation of the terms encountered when working
with focus strategies before looking at the individual strategies in detail. Many of these terms are
also encountered in the Tiles and Software Autofocus module. The nomenclature takes some
time familiarize with due to its subtleties. Here is a list of the more common terms:

Term / Abbreviation

Description

SWAF

Stands for Software Autofocus.

DF,DF.1 or DF.2

Stands for Definite Focus, Definite Focus.1 or Definite Focus.2

Tile

One of the individual image fields that make up a tile region i.e. a 2x2
Tile region is made up of 4 tiles arranged as a grid. The tiles have a
given overlap with their neighbors (default setting 10 %) allowing
them to be stitched together as one image if necessary. Unless otherwise specified by a focus strategy, each tile has the same z-value as
the parent Tile region. After acquisition the individual tiles are displayed together as part of the tile region to which they belong, which
in turn makes up one scene.

Tile Region

In a tile experiment a tile region refers to a ordered group of individual image fields (or tiles) that belong together and are arranged in the
form of a grid (these arrangements can be based on quadrilaterals,
circles, ellipses or freehand polygons) with a predefined overlap (default 10%) to facilitate stitching the images together. With the help of
tile regions it is possible to acquire areas with dimensions that vastly
exceed the size of an individual image field. Within an experiment a
number of tile regions can be acquired at various localities/ wells/ containers on the sample. Each tile region is based on an X and Y coordinate of the stage and a Z coordinate of the focus drive and are defined using the Tiles tool. After acquisition the individual tile regions
are displayed as scenes to facilitate viewing.
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Term / Abbreviation

Description

Position

In a tile experiment positions refer to independent, individual image
fields that placed at various locations on the sample. A position corresponds to (or is in some ways equivalent to) a tile region consisting of
just one tile. Each position is based on an X and Y coordinate of the
stage and a Z coordinate of the focus drive. Individual positions or position arrays (grouped individual positions) are defined using the Tiles
tool. After acquisition the individual positions are displayed as scenes.

Reference Channel

The channel selected as a reference z-value for focus strategies and
events in particular a SWAF. The selected reference channel can be
changed in the Reference channel expander or in the Channels tool. It
is also possible to define a relative axial offset to the reference channel. This can be done for one or more other channels.

Focus Surface

Refers to the interpolated surface of z-values derived from support
points (discrete z-values) defined by the user (or by functions such as
SWAF or DF.2) prior to the experiment (or immediately before acquisition start). A focus surface can be “local” or “global”. The local form is
confined to a single Tile region and attempts to describe the sample
topography covered by the tile region such that all its image fields
(tiles) will be in focus. The global surface form is technically identical,
but is associated with a sample carrier, and defined in the sample carrier template dialogue. Thus, tile regions or positions placed on this
carrier will follow the slope or contour defined by a topography that
covers part or most of the sample carrier. In both cases the surface is
defined by interpolation from discrete z-values – so called “support
points”. Note that a positions z-value is used as its local surface, and
as such does not require a support point. Global and local surfaces
cannot be mixed in a single experiment (or block).

Support Point

To create a focus surface it is necessary to define one or more support
points. Support points are user defined collections of z-values that
correspond to the desired plane of observation at a given XY-coordinate. They can also be defined initially by a SWAF run or DF.2 recall
focus function- initially, after the experiment is started, but before the
first loop of images are acquired. The number of support points, defined by the user, can be distributed automatically by an algorithm, re
arranged individually by hand or placed at the current stage position.
The number of support points employed determines the degree of interpolation that can be used to generate the topography of the focus
surface. Typically, the interpolation criteria (minimum number of support points required to generate a certain degree) should be over
filled with support points, and a lower interpolation degree selected
for more robust results. By default the software employs an interpolation degree of level 2 (which can generate a parabolic saddle surface
with at least 9 support points). If too few support points are used the
next lower level (a “tilted plane”) will be use automatically. Higher interpolation degrees have to be manually selected, but for most use
cases are typically not necessary.
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Term / Abbreviation

Description

Z-value

The current Z coordinate of the focus drive that is used to define a
Tile region, position or support point when it is created by the user.
Note that the individual tiles of a tile region all have the same initial zvalue unless support points are used either in the context of a local or
global focus surface, a software autofocus is used to determine them
individually or a definite focus stabilization adjusts them. The z-value
of a position defines its z-coordinate initially when a local focus surface is used. Positions spread on a global focus surface (carrier based)
are adjusted accordingly as are the individual image fields of a tile region.

Adapt Z Values/
Focus Surface

The focus strategy Use Z Values/ Focus Surface defined in Tiles
Setup allows the Focus surface or z-values defined in the Tiles tool to
be modified by the result of a SWAF or DF stabilization based on
these initial values. These functions are not available when no SWAF
module is present or no DF is configured. The function has several
module / hardware dependent variations:

- As Additional Action

In focus strategies that use a focus surface or z-value defined by the
Tile setup (tool) it is possible to optionally execute a so called “additional action” (a stabilization event) that adapts the focus surface/ zvalues. This occurs after the reference z-value has been reached as defined in the tiles set-up for each discreet z-value (i.e. each tile/position
or the defining focus surface). Depending on the system configuration
this can be a SWAF run or a DF stabilization. In the case of a SWAF
run the initially defined reference z-value is used to center the search
range defined in the SWAF settings. Thus, a SWAF run can be centered on the sample topology increasing the effectiveness and/ or
speed at which a maximum is detected and subsequently used for image acquisition. In certain applications, such as Correlative array tomography (CAT) this function can be performed with DF instead. In
this case a local focus surface is used to make sure that the DF stabilization stays within the catchment range of the device (only important for DF.1!). Complimentary to this is the number of support points
needed to initially define the surface can be significantly reduced for a
large elongated Tile region - which greatly reduces set-up time to image the extremely thin (typically 70 nm thick or less) “ribbon” of serial
sections.

- Update with Single
Offset

In combination with a Definite Focus or SWAF if a time series is used
it is possible to make use of a focus surface or z-value defined by the
Tiles setup and execute a so called “update” (a stabilization event) –
this makes use of a SWAF run or a DF stabilization to update the Focus surface/ z-value defined initially by the Tiles set-up. In a time series
the update action is performed once each time point (or every nth) at
a single discrete “wait position” (default center of 1st Tile region / position). A change in Z (thermal or residual focal drift) at the wait position - if detected - is then applied to all the focus surfaces or Z-values
defined in the Tiles Setup (adapting them all by the change in Z, applied as a common offset). In some cases it is useful to be able to define a specific waiting position – for example when a special sample
carrier is used were the DF reflex signal might be disturbed by its
structure/optical properties at the first tile region/position. Alternatively, if using a SWAF some kind of fiducial marker or such is available at this position that does not change (e.g. bleaching or movement) can be used.
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Term / Abbreviation

Description

- Update with Multiple Offset

For Definite Focus.2 only an additional function is available that allows the device to be initialized on each and every z-value prior to the
experiment and hence stabilize and update these individually according to their location relative to the sample/ glass interface. This function can be used with or without a time series dimension. Thus, DF.2
enables true multi-location experiments in which the user defined zvalues (including support points) are used by DF.2 to create a stabilization map that is monitored and updated throughout the experiment.

Initial Definition
for Z Values/ Focus
Surface

This function allows you to select how the initial z-values used in the
experiment are defined. By default this is By Tiles Setup and the zvalues specified there (in the Tiles tool) are used. However, it is possible to define or adjust these z-values directly before the experiment
(after clicking Start Experiment) either with a SWAF run or a with a
DF.2 Recall Focus (Axio Observer). For the Celldiscoverer 7 this drop
down offers the additional options Find Surface or Find Surface +
Additional Offset to define the initial z-values. In this case the z-values are initially defined by the z-values resulting from this “pre-run”
before the imaging loop starts. This can be particularly useful when
working with multi well plates or chamber slides where the sample is
located at a similar position relative to the carrier surface in each well
or chamber. It also allows the imaging loop of the experiment itself to
be speeded up and to be run in a triggered or compromised protocol
(fast acquisition) thus reducing the time to complete the imaging loop
of the experiment.

Stabilization Event
Repetitions and
Frequency

Defines the frequency and repetition of stabilization events within a
given focus strategy. For the DF and SWAF focus strategies you can
determine when and where in the experiment these event are executed in synchrony to the imaging loops – a loop here means time series, or positions for example, with the event synchronized to occur
immediately prior to the chosen loop. A general limitation of this implementation (to limit code complexity) is that these stabilization
events can only be synchronized to iterate with a single imaging loop
entity i.e. the selection is only possible in a mutually exclusive manner.
These settings can be accessed only when 'Show all' is activated and
expert mode is selected. Initially default settings are assigned and can
be restored by clicking the 'Standard' button. In 'Expert' mode the
settings are displayed and can be, if necessary, modified. Depending
on the dimensions of the experiment or focus strategy different parameters can be modified to meet the experiment needs. For the Tile
Region loop you can optionally select were the event occurs within
the Tile region - either in the center or at the 1st Tile of the region
(typically upper left hand corner). This is of use when using SWAF
events as often the upper left hand corner of a Tile region might not
contain sample, thus often the SWAF run will not return a suitable
maxima (new z-value). Finally, focus strategies that include Definite
Focus and are used with a time series dimension may also allow stabilization during the interval of the time series i.e. asynchronous to the
imaging loops of the experiment. This might be necessary if the time
interval is on the order of tens of minutes, or if a large thermal drift is
expected (more significant for DF.1), or if the time series has no or a
very short interval (i.e. fast as possible acquisition at a single position)
allowing synchronized events to be disabled completely.
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Term / Abbreviation

Description

Focus Surface Outlier

Under Tools > Options > Acquisition > Tiles you find the option
Enable Removing of Focus Surface Outlier. By two parameters
you can define how so called “outlier” values are handled prior to calculation (interpolation) of a focus surface. This is particularly helpful
when the z-values that will be used for this purpose contain one or
more values that differ obviously from the others (for example if a
SWAF run has returned a z-value that does not lie close the sample
plane of interest). If not removed such values locally distort the focus
surface potentially producing “blur” in the resulting images. By default
a linear fit is used to detect such outliers in combination with a statistical threshold value (sigma). Values that do not meet these criteria
(i.e. are significantly outside this) are classified as outliers and are not
used to calculate the focus surface that will be subsequently generated for the experiment. In extreme use cases it is possible to modify
the sigma value or use a mean value instead of a linear fit for this purpose, but typically these default values never need to be changed.

12.18.2 When is focus the "right" focus?
In microscopy, the focus can be implied from image parameters, such as the contrast or intensity,
that vary with the position of the objective’s plane of observation in the sample and the level of
detail at a given plane. However, an algorithm that tries to detect (and maximize) such values will
only return an axial position that corresponds to a plane of interest if these coincide (which is typically the case with (thin) samples with a singular discrete plane of detail).
This becomes increasingly difficult with higher numerical aperture (NA) lenses, thicker samples,
and less pronounced levels of detail (modulated as change in contrast or intensity in the resulting
image). Hence, SWAF is not to be understood as a focus finder, but can be used as a method for
reliably searching over a given axial range and locating such a plane in a sample. Thus, although
not all samples and imaging conditions will be appropriate, SWAF is an approach that allows a
useful detection of a focus plane as a start for further imaging activities.

12.18.3 Software Autofocus in ZEN
Basically, the SWAF searches, with a pre-set z step size, within a given range of z values for the
image plane that returns the maximal “sharpness” value. The step size or sampling rate of the
SWAF is determined by the objective NA and wavelength (more details are given below). In turn
the (automatic) search range is also largely determined by the objective NA – obviously optics dictate that higher NA objectives have smaller search ranges and vice versa. For SWAF to be useful
for the application in question the image plane that returns the maximal sharpness should ideally
be equivalent to the plane of interest in the sample – i.e. thus sample characteristics determine
whether SWAF is the appropriate method to reliably detect the desired plane of observation. The
component algorithms and functions of the SWAF, their relationships and the basic SWAF workflow are visualized schematically in the image below:
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Fig. 46: SWAF Workflow
The SWAF run is driven and controlled by the Maximizer which in turn controls the z-drive and
camera to acquire a sequence of images at predefined axial intervals. Each of these images is
transferred in sequence to a merit function that calculates a sharpness value for the image. This
value is returned to the maximizer were a table of sharpness values is maintained. The Maximizer
searches for (using either unidirectional (“full”) or bidirectional (“smart”) axial travel) and determines when a maximal sharpness value is found. Next data fitting is performed locally around the
returned maximum to refine its position. Subsequently, the SWAF sets this z-value as the resulting
axial position of the z-drive. If no maximum is found the Maximizer detects an error condition and
throws a corresponding exception (error message). In this case the z-drive returns to its position
of origin, thus minimizing the likelihood of a sample/ objective collision incident.

12.18.4 FAQ
12.18.4.1 What should I do to adjust parameters of a SWAF run prior to using it in experiments?
In the first instance test the SWAF with the default settings and select an appropriate channel to
be the reference channel – remember that you can uncheck the reference channel in the Channels
tool i.e. so that it will not be imaged, but will still be used for a focus strategy or SWAF. Consider
using a transmitted light channel if possible as this will not be subject to bleaching. Remember
that the sample plane that returns a maxima from the SWAF run is not necessarily the same plane
as that which you’re interested in imaging.
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If this is the case, then you need to capture z-stacks with a suitable range or make use of the focus offset function that allows each channel to be offset by a relative value in z to the reference
channel. Typically, once you have established that a maxima can be reliably found with the default
SWAF parameters you might want to consider optimising the SWAF run by modifying the parameters to reduce the time required to complete it or to reduce sample exposure (phototoxic stress
levels).
12.18.4.2 The SWAF returns an error message. What does this mean and how can I correct this?
The most typical error encountered is that the SWAF run does not find (return) a clear maxima
and hence fails (hits so called search boundary). This might be because the step size set is too
course (i.e. the maxima is missed occasionally) or the search range does not contain a clear sharpness maxima e.g. due to lower contrast/ intensity (signal to noise) or a lack of signal.
This can happen, for example, at the 1st tile (upper left) of a tile region which is empty such as is
often that case in the corners of such tile regions. In this case it is possible to modify the SWAF focus strategy in the Tile Region loop such that the SWAF will be executed at the centre of the tile
region. In ZEN 2.3 and higher if a SWAF failure occurs at a given loop entity then a fall-back applies such that the initial or last known z value will be used.
12.18.4.3 SWAF returns a failure after reaching a search boundary – what`s wrong?
If you are able to optimize the SWAF and the reference channel is typically robust for this then the
solution might require that you look at the overall stability of the focus due to environmental variables such as vibrational isolation, temperature flux, evaporation of fluid from sample vessels, or
poor lighting conditions (extraneous light).
Generally, if these are optimized then better overall results can be expected, if this is not the case
then the fluctuations they cause might be the source of such reliability problems when detecting
the sharpness maxima. Other things to consider are optical disturbances such as loss or poor immersion of the objective (bubbles), or artefacts caused by sample characteristics (for example (cell)
debris moving across the FOV during the SWAF run). Perhaps it is possible to use a fiducial marker
if the sample allows this (see Auto Focus ROI above).
12.18.4.4 When should I use the Full or Smart setting?
This depends entirely on the sample in question and manner in which it is imaged (e.g. reflected
or transmitted light). However, if we are to generalize then the answer might simply be given as
follows. A Full search will return the global sharpness maxima from the entire search range defined in the SWAF tool. The search always runs in one direction i.e. the z-movement of the actuator is unidirectional always moving against gravity.
Smart on the other hand is intended for quickly* detecting a local sharpness maxima by allowing
a bidirectional search pattern. Thus, the full setting is typically a more extensive search that takes
longer to accomplish. However, the smart setting may be suitable and saves a great deal of time
and reduces sample light exposure.
*Typically, it will be the case that Smart is faster, but under some circumstances it might be
slower. This will likely be the case when the maximum is far away from the starting position.
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12.18.4.5 Can I change camera parameters in a SWAF run e.g. exposure time or binning?
In the implementation of SWAF in ZEN blue version 2.1 and earlier it was not possible to change
the acquisition parameters directly. The exposure time setting using by the SWAF is based on the
exposure time setting of the reference channel. Thus, longer exposure times of the reference
channel increase the exposure time employed by the SWAF up to a maximum of ca. 100 ms.
Thus, weak signals in the reference channel may cause an increased likely hood that no clear maximum will be found. Binning settings of a camera used by the reference channel are not taken
into account and SWAF always uses 1x1 binning – this may cause issues with cameras processing
smaller pixels (e.g .new AxioCam models).
In ZEN Blue version 2.3 and higher the SWAF has be further adapted to address the described limitations. Thus, exposure times defined for the Reference channel are used even when these exceed 100 ms. Settings that apply to all the channels defined in the acquisition mode tool still apply to the SWAF i.e. an independent binning setting for the reference channel is not yet possible.
Thus, please take this into account when setting up your SWAF parameters. In addition, the SWAF
run has been streamlined and can make use of triggered acquisition when supported by the camera making the SWAF run ca. a factor of two faster than in previous versions.

12.18.5 Functions & Reference
12.18.5.1 Software Autofocus Tool

Parameter

Description

Mode

Here you can select the sharpness measurement mode.

-

Auto

This is the default setting. If selected, the software makes a
choice based on the configuration of the microscope. Such that
for Widefield approaches or transmitted light the sharpness measure is always Contrast based.
On the other hand, for optical sectioning methods (e.g. Spinning
Disk) the software will automatically select an Intensity based
approach to determine the sharpness values.
If the microscope configuration can`t be detected automatically
you can manually select the sharpness measurement mode.

-

Contrast

If selected the contrast based mode will be used for sharpness
measurement.
This is the standard setting for Camera acquisition.

-

Intensity

If selected the intensity based mode will be used for sharpness
measurement.
This is the standard setting for Confocal acquisition.
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Description
Only available for LSM systems with imaging tracks other than
MPLX and Airyscan SR. Using those tracks might lead to overexposure of the channel and failure for the Autofocus.
If activated, the reflex of the laser on the cover glass surface is
detected.
An offset is used to focus onto the sample. You need to add the
offset once by clicking the Find Offset button while the sample
is in focus. The method requires a refractive index mismatch between the immersion medium and the cover glass and is therefore not for oil immersion objectives.
For Reflex mode, the Search parameter should ideally be set to
Smart. After the offset was defined, you can manually reduce
the search range in order to facilitate shorter focusing times. The
acquisition settings (e.g. laser line, PMT gain, emission filters) are
configured automatically.

Quality

-

Default

This parameter determines the merit function that will be used to
calculate the contrast value of the image when Contrast mode is
used by the SWAF (Software Autofocus) run to measure sharpness.
If selected, a composite of weighted merit functions is used.
Use this setting if the sample cover a greater part of the camera
field of view.

-

Low Signal

If selected, a single merit function to determine the value is used.
Use this setting if the image is noisy or the sample covers a small
area of the field of view. As might be the case if you work with a
calibration slide or beads.

Search

-

Smart

There are two options Smart and Full. These define a different
type of primary maximizer used to run the SWAF, which in turn
determines a number of additional characteristics and parameters of the entire process. To learn more about this, read the FAQ
entry [} 506].
If selected, an alternative maximizer is used that can search in a
bidirectional manner and will stop when a local maximum is
found in the sharpness values (i.e. a significant decrease of
sharpness in both z directions). Again if an error condition is detected the Smart maximizer will throw an exception.
For specific information on the Software Autofocus using LSM
Tracks in this context, also refer to chapter Software Autofocus
using LSM Tracks [} 510].

-

Full

If selected, the maximizer employed with this setting uses a unidirectional movement of the z-drive stepping through the entire
relative or fixed search range defined in the SWAF tool (see Autofocus Search Range). The Full maximizer will return a global
maximum for the autofocus run or throw an exception when an
error condition is detected.
For specific information on the Software Autofocus using LSM
Tracks in this context, also refer to chapter Software Autofocus
using LSM Tracks [} 510].
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Parameter

Description

Sampling

Here you can select the step size of how the search range is sampled.

-

Default

Uses the default step size (dz = 1/sqrt(2) * 2 * n* lambda/NA).

-

Fine

Uses a small Z-distance (0.5 * dz) between the individual focus
images that are used to calculate the best focus position.
This doubles the number of z-slices for the given range.

-

Medium

Uses a medium Z-distance (2 * dz) between the individual focus
images that are used to calculate the best focus position.
Halves the number of z-slices for given range.

-

Coarse

Uses a large Z-distance (4 * dz) between the individual focus images that are used to calculate the best focus position.
Reduces number of z-slices by a factor of four.

Autofocus Search
Range

-

Relative Range

Here you can switch between two distinct approaches for the
autofocus search range:
This is the default mode.
If selected, the software autofocus is calculated over a relative
range. To learn more, read Relative Autofocus Search Range.

-

Automatic Range

Activated: Calculates the range for the autofocus search automatically depending on the objective set.

-

Range

Only active if the Automatic Range checkbox is deactivated.
Here you can enter a range that you want to be used for the autofocus search.

-

Step Size

Shows the distance between the individual focus images set under Range.

-

Fixed Range

If selected, the software autofocus is calculated over a fixed
range.
To learn more, read Fixed Autofocus Search Range.

-

Set Last

Defines the current Z-position as the end (last) point for the software autofocus. Alternatively, you can enter the desired value in
the input field to the left of the button.

-

Range

Displays the area which is used for the autofocus search. Adopt
the area via the Set Last/Set First buttons or the input fields.

-

Step Size

Displays the selected Sampling distance between the individual
focus shots.

-

Set First

Defines the current Z-position as the start (first) point for the
software autofocus. Alternatively, you can enter the desired
value in the input field to the left of the button.

Autofocus ROI

Here you can define a Spot Meter or Focus ROI such that the pixels evaluated by the SWAF are limited to a user defined region of
the image.
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Description
This is particularly usefully if you use a fiducial marker such as a
speck of dirt or other constant artefact that serves as a reference
for the sample focus at a fixed position over time.
The autofocus ROI is displayed in the live image of the sample
enabling it to be positioned and resized as necessary. As an additional aid to help focusing you can also use the focus bar function of the live image that monitors the image contrast in the live
image or Spot Meter ROI.

-

Spot Meter / Focus
ROI

Activated: Only uses the values from the Spot Meter / Focus-ROI
to calculate the focus position.
The Focus-ROI is displayed in the live image as an red dashed rectangle. You can adopt it by clicking on the frame and changing
its size and position.
Note that this option is not available for LSM acquisition.

12.18.5.2 Software Autofocus using LSM Tracks
Confocal Tracks are also suitable as reference Channels for the Software Autofocus. As LSM acquisition is by design slower compared to Camera acquisition, some optimizations are done in
the background in order to speed up the focusing action.
The typical mesasure for the correct focus position in confocal images is the intensity. Hence the
aim of the SWAF is here not to generate images of a certain quality, but only to evaluate relative
image intensities along the z-stack. This allows us to use very coarse scanning parameters.
Generally, the SWAF for LSM uses a fixed Frame Size of 64*64 pixels in combination with the
fastest possible scan speed at the currently configured zoom. To further speed up the acquisition,
bidirectional scanning is used. Whatever Laser power you specify in the Channels tool window
for this Track is used during the SWAF action. Of note, while you assing a reference Channel, the
corresponding Track with all its channels will be active during the focusing.
Some behavior depends on the selected Search Mode Full or Smart.
In the Full search, the system will use the detector gain as configured in the Channels tool window.
In contrast, the Smart search aims to start close to the likely intensity maximum of the z-Stack.
This focus position is approximated by a fast line z-stack in the center of the image frame. As the
line scan generates less pixels and a higher noise level, a useful dynamic range needs to be ensured. To this end, the fast line z-stack is repeated several times with increasing PMT gain. After
the line scan, regardsless if an intensity peak was found or not, a frame wise autofocus will follow.
In case no peak could be indentified, e.g. because of a sparsely distributed sample, the Smart
search will start at the original z-position and not optimization of the starting position will take
place. Essentially, the Smart search will outperform the Full search on high Search Ranges and
a highly varying effective focus position.
If the focus fluctuations are preditably small, a narrow Search Range in combination with a Full
search might be faster. As a final remark, Camera-based Autofocus can be time-saving, especially
when the search range needs to be large and a Full Search is required. While Camera and LSM
cannot be combined into one image document, the deactivated camera Track may be still be used
as a reference Track.
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12.19 Tiles & Positions
This module enables you to acquire images that are made up of a number of individual images
(tiles). To do this, it is possible to define tile regions and positions.
If you have licensed the Tiles & Positions module, the basic functions of the Tiles tool will be
supplemented by the Advanced Setup functionality. This will allow you to set up Tiles experiments more easily and also to use sample carriers and focus surfaces.
Note that when you activate the Tiles tool in any experiment for the first time, the software will
automatically select the suitable focus strategy Use Z Values/ Focus Surface defined in Tiles
Setup. This focus strategy also is only available if you have licensed the Tiles & Positions module
and it can be optimized with the Focus Strategy Wizard [} 716] in the Focus Strategy Tool
[} 711]. In the case that you do not have the Tiles & Positions module, ZEN will still select the
appropriate focus strategy for you.
1

1

Tile Regions

2

Positions (Single Positions)

3

Position-Array

2

3

Info
If you want to acquire tile regions or positions with different z-positions, you need to use a
suitable focus strategy. To find out more read the chapters Using focus strategies [} 86].

See also
2 Introduction [} 86]
2 Set up a new experiment [} 44]
2 Acquiring Multi-Channel Images with Cameras [} 43]
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12.19.1 General Preparations
Prerequisite ü The Tiles module is activated under Tools > Modules Manager... > Tiles & Positions.
ü To set up Tiles experiments, you require a motorized stage. This must be configured and calibrated correctly in accordance with the camera orientation. For more information read Calibrating the stage and selecting the channel [} 512].
ü You are on the Acquisition tab.
ü You have created a new experiment [} 44], defined at least one channel [} 43] and correctly
set the focus and exposure time.
1. Activate the Tiles checkbox in the Acquisition Dimensions section to display the Tiles
tool.
à In the Left Tool Area the Tiles tool appears in the Multidimensional Acquisition tool
group.
You have successfully completed the general preparations. You can now continue with the next
steps of this guide.

See also
2 Setting up a simple tiles experiment without the Tiles & Positions module [} 513]

12.19.2 Calibrating the stage and selecting the channel
On start up of a system with motorized stage and/or focus a request will appear asking if the
components should be driven to the end switches and calibrated. This ensures that you begin
working with absolute coordinates in this session with the microscope. If the microscope power is
cycled then this process should be repeated. This function is of particular use if you continually
work with a sample carrier e.g. 96 well plate, of the same format mounted in the same manner
repeatedly with a given experiment template. If you perform a carrier calibration once with a calibrated stage, then the carrier calibration is essentially always valid. This is done in the Sample
Carrier section of the Tiles tool. Note these features are only available if you have a Tiles and
Positions license.

Info
The request to calibrate stage and focus on Startup can be activated/deactivated under Tools
> Options > Startup/Shutdown > Stage/Focus Calibration.

1. Put your Sample Carrier on the stage.
2. Go to the Acquisition tab.
3. Choose a low magnification objective (e.g. 10x) from the Microscope tool in the Right
Tool Area.
4. Click on the Live button and find your focus area either using transmitted or fluorescence
light.
5. In the Stage tool of the Right Tool Area, activate the Show all mode and then click on
Calibrate.
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6. Check if the alignment and orientation of your camera and joystick is correct by dragging
the software joystick up, down, left and right and observe whether the movement of your
image corresponds to movement of the circle.
The alignment of the camera is correct if the movement of a given stage axis is congruent
to the corresponding axis of the image. An offset in the alignment will be seen as a saw
tooth pattern along the edge of a tiled image (e.g. 4x4 tile region).
In addition, check whether the image movement also corresponds accordingly when you
move the hardware joystick of the stage.
7. If the orientation of the camera to the software joystick (stage tool, right tool area) is incorrect, go to the Camera tool, activate the Show all mode, and click on Model Specific.
The orientation of the camera (image) can be adjusted by flipping, rotating, or mirroring.
8. Alternatively, you can and may also need to invert the x- and y-axis of your stage in the
MTB in order to align the hardware joystick and the software-controlled stage movement.
9. Ensure that all the prerequisites (e.g. channel and camera settings) for a Tiles & Positions
experiment on your sample are fulfilled. If necessary, use theSmart Setup for the setup.
10. After you have defined at least one channel (e.g. EGFP), activate the Tiles checkbox.
11. If you wish to work with a sample carrier, complete the following steps. Open the Tiles
tool in the Multidimensional Acquisition section and activate the Show all mode.
12. In the Tiles tool, open the Sample Carrier section.
13. Click on Select....
14. Select a predefined Sample Carrier template and click on OK.

12.19.3 Setting up a simple tiles experiment without the Tiles & Positions module
Prerequisite ü You are on the Acquisition tab in the Tiles tool.
1. Start the Live mode to use the stage to locate a point that you want to be at the center of
your tile region.
2. Bring the specimen into focus using the focus drive.
3. Open the Tile Regions section.
4. The Tiles mode is activated by default. In this mode enter the number of tiles you want in
the X and Y input fields, e.g. X = 3, Y = 3 equals a tiles region containing 9 tiles.
Alternatively, you can enter the size of the tile region that you want to add. To do this, activate the Size mode.
5. Click on Add
.
à The tile region is added to your experiment. The current stage position and focus determines the center and the z-position of the tile region.
6. To add further tile regions, move the stage to another position on the sample and repeat
the previous steps.
à The added tile regions (TR1, TR2, etc.) are displayed in the tile regions list.
à If you scroll to the right in the table, you can read the Size of the tile regions.
7. Save the experiment. To do this, in the Experiment Manager click on Options
and
select Save As. Enter a name for the experiment in the input field (e.g. Simple Tile Experiment).
8. Click on the Start Experiment button.
à The Tile Region experiment is acquired.
à The individual tile regions are displayed in the acquired file as scenes and can be selected
using the Scene slider on the Dimensions tab. If you deactivate the Scene checkbox, all
tile regions are displayed as an overview.
You have successfully set up and acquired a simple Tile Region experiment.
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NOTICE
Shortcut
You can also add a predefined tile region at the current stage position by pressing the F9 button on your keyboard. The size of this region is the last defined number of tiles in x and y, or a
square of 3x3 tiles if you have never defined a region before.

12.19.4 Setting up a simple positions experiment without the Tiles & Positions module
Prerequisite ü You are on the Acquisition tab in the Tiles tool.
1. Open the Positions section.
2. Start the Live mode to use the stage to locate a position that you want to acquire.
à The X and Y coordinates of the current position are displayed in the Current X/Y display
fields.
3. Bring the specimen into focus using the focus drive.
4. Click on the Add
.
à The current position is added to your experiment.
5. To add further positions, move the stage to another position on the sample and repeat the
previous steps.
à The added positions are shown in the list in the Single Positions section with their X, Y
and Z-coordinates.
6. Save the experiment. To do this, in the Experiment Manager click on Options
and
select Save As. Enter a name for the experiment in the input field (e.g. Simple Tile Experiment).
7. Click on the Start Experiment button.
à The Positions experiment is acquired.
à The individual positions are displayed in the acquired file as scenes and can be selected
using the Scene slider on the Dimensions tab. If you deactivate the Scene checkbox, all
positions are displayed simultaneously as an overview.
You have successfully set up and acquired a Positions experiment.

NOTICE
Shortcut
You can also add a single position at the current stage position by pressing the F10 button on
your keyboard.
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12.19.5 Tiles & Positions with Advanced Setup
Advanced Setup makes it easier for you to create tile regions and positions by displaying the distribution and dimensions of tile regions and positions in the travel range of the stage. You can
generate a Preview Scan and drawn in tile regions or positions precisely on the basis of this template. For the preview scan you have the option of using an objective with a lower magnification
and/or a different channel (e.g. transmitted light).

Info
To ensure that the individual z values of the tile regions and/or positions are taken into account, ZEN automatically selects the most appropriate focus strategy [} 86] when the checkbox Tiles is activated. For the experiment described here no further modification needs to be
made. If you want to acquire all tile regions at the same z-position then you must select None
from the dropdown list in the Focus Strategy tool. The individual z-positions are then ignored
and the current z-position at the time the experiment is started is used for all tile regions. In
the case that you do not have the Tiles & Positions module, ZEN will still select the appropriate focus strategy for you.

Prerequisite ü To set up tiles experiments in Advanced Setup, you need the Tiles & Positions module.
ü You have read the chapter the general introduction of Tiles & Positions [} 511].
ü You are on the Acquisition tab in the Tiles tool.
1. Click on the Show Viewer button.
à The Tiles Advanced Setup view opens. For more information, see Tiles Advanced Setup
[} 544].
à The live mode is activated automatically. Deactivate the live mode if you do not need it
to prevent bleaching of the sample. To do this, click on the active Stop button in the
Left Tool Area. This default behavior can be changed in Tools > Options > Acquisition > Tiles & Positions.
12.19.5.1 Generating a Preview Scan
Prerequisite ü You have selected an objective with a relatively low magnification in your experiment settings.
ü You are in Advanced Setup.
1. In the left toolbar, click on Preview Scan.
à The Preview Scan Toolbar [} 548] is displayed as the top toolbar.
2. In the top toolbar, deactivate Use Existing Experiment Settings and select/ unselect the
channels that you want to use for the preview scan.
3. If necessary, use the live mode to adjust the focus area and exposure following a change of
objective or channel.
4. To obtain a better overview, slightly zoom out of the Advanced Setup view.
5. Start the Live mode to use the stage to locate approximately the center of the region for
which you want to generate a preview scan.
6. In the left toolbar [} 547] in the Tiles section, click on the Setup by contour button.
à The Contour Toolbar [} 548] is displayed as the top toolbar.
7. In the top toolbar, select the Rectangular Contour tool.
8. In the Stage View, use the tool to draw a rectangle that approximately encloses the region
for which you want to generate a preview scan.
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9. Alternatively, in the Stage View, use the live image to navigate to the edge of the area that
you want to image. We recommend, for example, the bottom left corner. Add the first
marker. Now navigate to the upper edge of the object and add a second marker. Finally, if
necessary, navigate to the right edge and add a third marker and click on Done. You can
optimize the tile region by selecting a circular contour shape for your sample instead.
à A tile region is created for the marked region and displayed in the list in the Tile Regions
section of the Tiles tool.

10. With the help of the Live mode, check whether the desired image region is covered by the
tile region. To do this, use the stage to locate the corners and edges of the tile region and
increase or reduce the yellow selection frame as necessary.
11. In the left toolbar, click on Preview Scan and in the top toolbar click on Start.
à A series of snap images is acquired to generate a preview of the marked region.
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You have successfully generated a preview scan.
Before you continue with the actual experiment, carry out the following steps:
1. In the Tiles Regions section, deactivate the preview tile region (TR 1) by deactivating the
checkbox of the corresponding list entry. This prevents the acquisition of the preview tile
region during the actual experiment.
2. In the Microscope Control tool in the Right Tool Area, select the objective you want to
use for final acquisition.
3. Use the Live mode to adjust the focus area and exposure accordingly.
You can now continue setting up the tile experiment.

See also
2 Channels Tool [} 702]
2 Tiles Advanced Setup [} 544]
2 Tiles & Positions with Advanced Setup [} 515]
12.19.5.2 Creating Tile Regions by Contour
Prerequisite ü You have generated a preview scan [} 515] that will help you to position the tile regions more
easily.
1. In the left toolbar [} 547] in the Tiles section, click on the Setup by contour button.
à The Contour Toolbar [} 548] is displayed as the top toolbar.
2. In the top toolbar, select the desired contour tool.
3. Use the contour tool in the stage view to draw in the tile regions you want to acquire.

à Tile regions are created for each marked region. They are added to the list in the Tile Regions section of the Tiles tool.
You have successfully created tile regions in Advanced Setup.
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12.19.5.3 Creating Tile Regions by Predefined
1. In the left toolbar [} 547] in the Tiles section, click on the Setup by predefined button.
à The Predefined Toolbar [} 549] is displayed as the top toolbar.
2. In the top toolbar, choose how many tiles in x and y dimension you want to add.
3. Click on Add Tile Region to add the respective tile region.
You have now created tile regions in the Advanced Setup.

NOTICE
Shortcut
You can also add a predefined tile region at the current stage position by pressing the F9 button on your keyboard. The size of this region is the last defined number of tiles in x and y, or a
square of 3x3 tiles if you have never defined a region before.

12.19.5.4 Creating Tile Regions by Carrier
Prerequisite ü You have selected and calibrated a sample carrier with one or more wells/ containers.
1. In the left toolbar [} 547] in the Tiles section, click on the Setup by carrier button.
à The Tiles Carrier Toolbar [} 550] is displayed as the top toolbar.
2. In the Carrier tab, select the individual wells for which you want to create tile regions by
pressing the Ctrl key and clicking on the desired wells.
à The selected wells are now bordered by a blue circle.

3. In the top toolbar, select Fill Factor and enter the desired value in the Fill Factor input
field.
4. Click on

.

According to the selected Fill Factor, the wells will be filled with a calculated number of tiles that
are located around the center. To create a given size of tile region, use the Columns/Rows function in a similar manner.
12.19.5.5 Creating Positions by Location
1. In the left toolbar [} 547] in the Positions section, click on the Setup by location button.
à The Positions Location Toolbar [} 551] is displayed as the top toolbar.
2. In the top toolbar, click on the Add button
.
3. In the stage view, click on the location where you want to add a position.
à The added positions are displayed in the stage view and the Single Positions list in the
Positions section of the Tiles tool.
You have successfully created positions in Tiles- Advanced Setup.
Note: ZEN will query if you want to add a position that has more than 66 % overlap of the field
of view in either x or y with an existing position.
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NOTICE
Shortcut
You can also add a single position at the current stage position by pressing the F10 button on
your keyboard.

12.19.5.6 Creating Positions by Array
1. In the Tiles tool, open the Positions section and click on Position Arrays.
2. In the left toolbar [} 547] in the Positions section, click on the Setup by array button.
à The Position Array Toolbar [} 551] is displayed as the top toolbar.
3. In the top toolbar, choose either the rectangular or circular Contour, adjust the Number
of required positions and the Bias where the positions should be located.
4. Mark the interesting area in the Center Screen Area with a pressed left mouse button.
The positions will be generated automatically.
12.19.5.7 Creating Positions by Carrier
Prerequisite ü You have selected and calibrated a sample carrier template [} 529].
ü You are on the Acquisition tab.
1. To obtain a complete overview of the sample carrier, zoom out of the view using the
mouse wheel. If necessary, use the panning tool (press Alt and the left mouse button) to
move the stage view as needed.
2. In the left toolbar [} 547] in the Positions section, click on the Setup by sample carrier
button.
à The Positions Carrier Toolbar [} 552] is displayed as the top toolbar.
3. Select the containers in which you want to distribute positions by pressing the Ctrl key and
clicking on the relevant containers.
4. In the top toolbar adjust the Number of required positions and the Bias where the positions should be located. Alternatively, if you want to create the positions as a Grid, adjust
the Columns, Rows, and Overlap.
5. Click on the Create button

.

à The selected containers are each filled with a Position Array (group of positions).
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à In the Positions section of the Tiles tool, the Position Arrays are displayed in the Position Arrays list.
You have successfully used a sample carrier to create positions.

12.19.6 Copying a Tile Region or Position
To copy and paste a specific Tile Region or Position, follow these instructions.
1. Right-click the respective tile region or position and select Copy. Alternatively, press Ctrl+C.
If you want to copy multiple tile regions and positions, select multiple regions or positions
by dragging a selection box across the objects or click to select multiple objects while pressing the Ctrl button.
2. Right-click in the setup and select Paste. Alternatively, press Ctrl+V.
The copied tile regions/ positions are now pasted next to the originally copied regions/ positions.
Copying Tile Region or Position settings between wells
When you want to copy and paste a tile region or position setting (e.g. a certain arrangement of
tiles, positions or local support points) from one well to other wells or even to all containers of a
carrier, apply the following workflow.
1. Select the well from where the tile region/ position setting should be copied.
à The selected well is now highlighted by a blue border.
2. Right click within the selected well in the Center Screen Area (outside the tile region) to
open the context menu.
3. Select Copy Container for replication.
4. If you want to choose specific wells use the left mouse button to select the wells into which
you want to paste the copied tile region/ position setting.
5. Right click in the Center Screen Area and select the context menu entry Paste Replication to and either choose Selected Container or All Container.
The copied tile region/ position setting is pasted into the selected wells or all the wells of the carrier with the same relative coordinates to the center of each well.

12.19.7 Adjusting Z-Values
If you add positions or tile regions, the current Z-value is automatically adopted for the tile region
or position.
§

Learn about how to adjust and verify the Z-values of positions in the chapter Adjusting Z-Values of Positions [} 521].

§

Learn about how to adjust and verify the Z-values of tile regions in the chapter Adjusting ZValues of Tile Regions [} 521]. Note that the Z-values defined here are valid for all tiles in the
respective tile region.
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Info
To ensure that the individual z values of the tile regions and/or positions are taken into account, ZEN automatically selects the most appropriate focus strategy [} 86] when the checkbox Tiles is activated. For the experiment described here no further modification needs to be
made. If you want to acquire all tile regions at the same z-position then you must select None
from the dropdown list in the Focus Strategy tool. The individual z-positions are then ignored
and the current z-position at the time the experiment is started is used for all tile regions. In
the case that you do not have the Tiles & Positions module, ZEN will still select the appropriate focus strategy for you.

See also
2 Creating a Local Focus Surface [} 522]
12.19.7.1 Adjusting Z-Values of Tile Regions
Prerequisite ü You have set up a Tiles experiment with at least one tile region.
1. To check the z-value of tile regions, open the Tile Regions section in the Tiles tool.
à The z-values of the tile regions are displayed in the Z column of the list.
2. Double-click on the list entry of the tile region that you want to check.
à The stage automatically locates the center of the tile region and the associated z-position.
3. Use the Live mode to check the z-value of the tile region.
4. To adjust the z-value, set the new z-position with the Focus tool.
5. In the Tile Regions list, click on Options
and select Set Current Z For Selected
Tile Regions. Alternatively, in the Tile Regions list, right-click the tile region entry and select Set Current Z For Selected Tile Regions.
6. To check further tile regions, repeat steps 2 to 4.
7. To check and adjust large number of tile regions, click on the Verify button.
à The Verify Tile Region dialog opens. There you have a interface for the verification
process of each tile region.
8. Click on Close after you have verified all tile regions.
You have successfully checked and adjusted the individual z-values for the tile regions.

See also
2 Introduction [} 86]
12.19.7.2 Adjusting Z-Values of Positions
Prerequisite ü You have set up a tile experiment with at least one position.
ü You are on the Acquisition tab in the Tiles tool.
1. To check and adjust the z-value of positions, open the Positions section.
à The z-values are displayed in the Z column of the Single Positions list.
2. Double-click on the list entry of the position that you want to check.
à The stage automatically locates the position.
3. Use the Live mode to check the z-position of the position.
4. To adjust the z-value, set the desired position using the focus drive.
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5. In the Single Positions list, click on Options
and select Set Current Z For Selected Positions. Alternatively, in the Single Positions list, right-click the position entry
and select Set Current Z For Selected Positions.
6. To check and adjust a large number of positions, use the Verify Positions dialog.
7. To do this, click on the Verify Positions button in the Positions section.
à The Verify Positions dialog opens.
8. Select the Helper Method you want to use. This will support you in determining the z-values. The options are Autofocus (AF) and Definite Focus (DF). If you have neither then
you can only adjust z-values manually.
9. Click on the Move to Current Point button.
à The stage moves automatically to the position in the list that is highlighted in blue. Alternatively, you can double-click on the position in the list that you want to check.
10. In the Live mode use the Focus (or SW Autofocus) tool to adjust the desired z-value.
11. Click on the Set Z and Move to Next button.
à The position is marked with a check mark.
à The stage moves automatically to the next position in the list.
12. Repeat the last 3 steps until you have checked all the points in the list.
à The message All points have been verified appears.
13. Close the Verify Positions dialog.
You have successfully verified and adjusted the individual z-values for positions.

See also
2 Introduction [} 86]

12.19.8 Local and Global Focus Surfaces
12.19.8.1 Introduction
Local Focus Surface
To acquire large tile regions on tilted or uneven specimens, you need to assign individual z-values
to each tile of a tile region efficiently. ZEN will help you do this by creation of a Local Focus Surface. Note that a local focus surface is always associated with precisely one tile region. Thus, you
need to create a focus area separately for each tile region.
Global Focus Surface
To create a focus area covering the entire sample, you need to create a Global Focus Surface.
Global focus surfaces are based on a sample carrier template (e.g. for slides or multiwell plates)
and result in a focus surface that is valid for the entire sample carrier and therefore for all the tile
regions and positions it contains. This allows you to compensate for any tilting and curvature of
the sample carrier.
12.19.8.2 Creating a Local Focus Surface
To create local focus surfaces, you must distribute support points across your tile regions and assign their focus position. Tile-region-specific focus values are then interpolated to generate a focus surface that approximates the topology of the area you want to image.
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12.19.8.2.1 Distributing Support Points
Prerequisite ü To create a local focus surface you need the Tiles & Positions module.
ü You have set up a Tiles experiment with at least one tile region.
ü You are on the Acquisition tab in the Tiles tool.
1. Click on the Show Viewer button.
à The advanced tile setup opens.
2. Select a tile region for which you want to create support points. To do this, click on the corresponding tile region in the list in the Tile Regions section of the Tiles tool. Alternatively,
you can select tile regions by clicking directly on the desired tile region in the Advanced
Setup view. Both methods allow you to select several tile regions when pressing the Ctrl
key.
3. Open the Focus Surface and Support Points section in the Tiles tool.
4. To add a single support point at the current stage position, click on Current Position. Alternatively, you can add a single support point to the center of the currently selected tile region by clicking on Center of Tile Region.
5. Under Add Multiple Support Points, you have the settings to add multiple support
points. Indicate the number of Columns and Rows for the distribution of the reference
points. Alternatively, recommended for larger tile regions (>200 tiles), you can use the distribution method Onion Skin. Depending on the total size and shape you might need to
adjust the density parameter and/ or the maximum number of support points to optimize
the result. Typically, this method works best with large irregular or rounded tile regions.
6. Click on Distribute.
à The support points are distributed within the selected tile region(s) and shown as yellow
points
in the stage view.
à The support points of the selected tile region are displayed with their coordinates in the
Local (per Tile Region) list in the Focus Surface and Support Points section of the
Tiles tool.
7. If necessary, you can adjust the distribution of the support points manually in the Tiles Advanced Setup. You can change the position of the support points using drag & drop.
8. Repeat the steps until you have distributed reference points across all desired tile regions.
You have successfully distributed support points across the tile regions.
12.19.8.2.2 Verifying Z-Values of Support Points
1. Click on the Verify button in the Focus Surface and Support Points section of the Tiles
tool.
à The Verify Tile Regions / Positions dialog opens.
2. Select the Helper Method you want to use. This will support you in determining the z-values. The options are Autofocus (AF) and Definite Focus (DF). If you have neither then
you can only adjust z-values manually.
3. Click on the Move To Current Point button.
à The stage automatically moves to the support point that is highlighted in the reference
point list. Alternatively, you can also double-click on the support point you want to check
in the list .
4. In the Live mode use the Focus tool to adjust the z-value.
5. Click on the Set Z and Move to Next button.
à The checked reference point is marked with a green check mark.
à The stage moves automatically to the next support point in the list.
6. Repeat the last 3 steps until you have checked all the support points.
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à The message All points have been verified appears.
7. Close the Verify Tile Regions/Positions dialog.
You have adjusted and verified the z-values of all support points.

Info
Positions always have a focus, which is determined by the z-value of the position. If you use
positions in addition to tile regions, you can verify the z-values of the positions with the help of
a similar dialog. Open this dialog by clicking on the Verify button in the Positions section of
the Tiles tool.

12.19.8.2.3 Selecting Interpolation Degree
1. If necessary, select the interpolation level in the Interpolation Degree dropdown list in the
Focus Surface and Support Points section of the Tiles tool.
You have successfully created a local focus surface. You can now start the experiment. To ensure
that the tiles are acquired along the focus surface the software automatically selects the most appropriate focus strategy. For more information on focus strategies read the chapter Working with
Focus Strategies [} 86].

Info
The minimum number of support points necessary per tile region is indicated in the Interpolation Degree dropdown list for each entry. The calculation is more solid if the number of support points exceeds this minimum number. We therefore recommend that you only increase
the interpolation degree as far as the surface of the sample demands, even if you have set
more support points. If the number of support points does not correspond to the minimum
number for the selected interpolation degree, the interpolation degree will be reduced automatically. By default, ZEN uses a second order interpolation degree that creates a parabolic focus surface and requires at least 9 support points. Typically, this will be suitable for many samples and imaging scenarios.

12.19.8.3 Creating a Global Focus Surface
To create a global focus surface, you must distribute support points across your sample carrier
and define their focus position. A focus area across the sample carrier is then interpolated from
the values of these reference points.
12.19.8.3.1 Distributing Support Points
Prerequisite ü You have configured the general settings for setting up a tile experiment (experiment created,
at least one channel defined, Tiles dimension activated).
ü To create a global focus surface, you need the Tiles & Positions module.
ü You are on the Acquisition tab in the Tiles tool.
1. Open the Sample Carrier section.
2. Click on the Select... button.
à The Select Template dialog opens.
3. Select the sample carrier template that you want to use.
4. Click on Options

and select Copy And Edit....
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à A copy of the existing template is generated and opened in the sample carrier editor.
5. To distribute support points across the sample carrier template, open the Global Support
Points section.
6. Select the containers in which you want to create global support points. To do this, press
the Ctrl key and click on the containers.
7. Click on the Distribute One Support Point For Each Selected Container button.
à One support point is assigned to each selected container.
à The support points are distributed automatically across the sample carrier.
à You can add further support points manually using the Add button
8. To close the Editor window, click on OK.
9. To select the edited sample carrier template, click on OK.

.

à If you wish to re-edit the global support points at any time, click on the Edit icon
the sample carrier section to open the sample carrier editor again.
10. To calibrate the sample carrier, click on the Calibrate button and follow the wizard.

in

You have successfully distributed support points across a sample carrier template and have selected and calibrated it.
12.19.8.3.2 Verifying Z-Values of Support Points
1. In the Tiles tool open the Focus Surface and Support Points section.
2. Go to the Global (on Carrier) tab.
à All the support points of the selected sample carrier template are displayed in the Support Points list.
3. Click on the Verify button.
à The Verify Global Support Points dialog opens.
4. Select the Helper Method you want to use. This will support you in determining the z-values. The options are Autofocus (AF) and Definite Focus (DF). If you have neither then
you can only adjust z-values manually.
5. Click on Move To Current Point.
à The stage automatically moves to the support point that is highlighted in the list. Alternatively, you can also double-click on the support point in the list.
6. In the Live mode use the Focus (or SW Autofocus) tool to set the z-value.
7. Click on Set Z and Move to Next.
à The support point is marked with a check mark.
à The stage automatically moves to the next support point in the list.
8. Repeat the last 3 steps until you have checked all the support points.
à The message All points have been verified appears.
9. Close the Verify Global Support Points dialog.
You have adjusted and verified the Z-values of all support points.
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12.19.8.3.3 Selecting Interpolation Degree
1. Select the interpolation degree in the Interpolation Degree dropdown list in the Focus
Surface and Support Points section.
You have successfully created a global focus surface.
You can now set up your tile experiment using the sample carrier. Further information on this can
be found under: Using Sample Carriers [} 529]. To ensure the tiles are acquired along the focus
surface during the experiment the software automatically selects the most appropriate focus strategy in the Focus Strategy tool. For information on focus strategies read the chapter Working
with Focus Strategies [} 86].

Info
The minimum number of support points necessary is indicated in the Interpolation Degree
dropdown list for each entry. The calculation is more solid if the number of support points exceeds this minimum number. We therefore recommend that you only increase the interpolation degree as far as the surface of the carrier demands, even if you have created more support
points. If the number of support points does not correspond to the minimum number for the
selected interpolation degree, the interpolation degree will be reduced automatically. Interpolation degree 1 – Tilted Plane (at least 4 support points) is typically sufficient to compensate for any tilting of the sample carrier.

12.19.9 Assigning Categories to Tile Regions and Positions
In some cases it can be helpful to not only display the well number together with the acquired images (Path: Graphics > Frequent Annotations > Carrier Container Name) but also to create
certain additional annotations for different tile regions or positions, e.g. "control condition" or
"experimental condition 1".
For that purpose, the software allows you to add and edit names and categories to the different
tile regions/ positions that have been generated.
1. In order to assign individual names to different individual positions and/or tile regions in a
well plate experiment, in the Tiles tool click on the respective name in the Tile Regions or
Positions list. You can now edit the name field, press Enter to finish.
2. Repeat this step to rename different tile regions or positions.
3. To assign or edit categories of your tile regions/ positions, first select all desired tile regions/
positions that should be grouped in the same category.
4. Under the Tile Regions / Positions list, in the Properties section Category, click on the

5.
6.
7.
8.

options button
and select New from the dropdown list.
à The New Category window opens.
Enter a Name and add a Description for the selected tile regions/ positions.
Assign a Color for the new category by clicking on the color bar and choosing a preferred
color.
Click on OK to create the new category.
à The New Category window closes and the new category is created.
As Category choose the desired category for the selected tile regions/ positions from the
drop down list.

The chosen category is now assigned to the selected tile regions/ positions.
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Info
§

To display the name of your Tile Region/ Position later in your acquired image(s), go to
Graphics > Frequent Annotations > More… and select Image.Scene.Name from the
metadata list.

§

Note that a predefined category can also be applied to a differentiated selection of Tile Regions/ Positions from more than one well.
Note also, that the assigned color is only used as a feature in the Tiles tab (Left Tool Bar
Area).

§

To display a Tile Region/ Position Category feature (Name and/or Description) in your acquired image, you go to Graphics > Frequent Annotations > More…. Type “category”
in the search bar and select the desired feature to be displayed. (Although the option
"Color" is given, no reasonable element will be displayed by the software)

§

To adjust parameters of your annotations (e.g. font size), right-click on it and go to Format > Graphical Elements.

Displaying categories in the Tiles/ Positions List (Left Tool Area)
Prerequisite ü You have selected several different positions or tile regions and assigned different categories.
1. Under Positions or Tile Regions of the Tiles tool, select a position or tile region.
2. Right-click on the selected position/ tile, choose Sort and select By Category
The positions/ tiles will be sorted alphabetically according to the assigned categories.

12.19.10 Re-positioning Sample Carrier after Incubation
When you want to take images of positions/ tile regions on a sample carrier, that has to be taken
off the stage, e.g. for incubation purposes or changes of the immersion medium, proceed as follows to re-position your sample carrier.
Starting the Experiment
Prerequisite ü You have run the stage calibration and have located your sample, see chapter Calibrating the
stage and selecting the channel [} 512].
ü You have set up at least one channel and adjusted the light/ camera exposure time.
ü You have activated the Tiles checkbox and the Show All mode
1. In the Tiles tool, open the Sample Carrier section and click on Select.
à The Select Template dialog opens.
2. Select the template of your choice.
3. Adjust the surface of the sample carrier. Refer to the chapter Creating a Global Focus Surface [} 524].
4. Click on OK.
à The Select Template dialog closes.
5. Click on Calibrate.
à The Sample Carrier Calibration Wizard opens.
6. Move a sample reference point into the middle of the crosshair. This reference point can be
any unique, identifiable point on the slide and does not have to in the middle of the slide.
7. Click on Next.
8. Under X/Y Position click on Set Zero.
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Click on Next.
As Calibration Method, select Search Reference Point
Click on Next.
Click on Set Current X/Y.
In the Tiles tool, click on Show Viewer and add positions/tile regions at your locations of
interest.

14. Once you have defined all your positions/ tile regions, click on Options
on the Acquisition tab to in the Experiment Manager.
15. Save your experimental settings, including the lists of positions/ tile regions, by selecting either the Save As or Export entry.
16. Start your experiment and record images from your selected positions/ tile regions.
17. Remove your sample off the stage and e.g. put it back into the incubation chamber.
18. Close the software.
You have done all settings for a successful re-positioning of your sample carrier after the experiment.

Info
§

For demo purposes, select a standard slide that can mimic your test sample.

§

Regarding calibration of your template, you can customize your own carrier see the chapter Customizing a Sample Carrier Template [} 529], but for slides with one coverslip or
well, there is only the option for Single Reference Point Calibration. For Multi-well plates,
you will have the option for 7-point, 4-point, 3-point or 1-point calibration. This becomes
important for adjusting for the rotation of the sample.

§

It is assumed that you just use a conventional glass slide with some cells or tissue that is
positioned in the center

§

You can zoom in and out using the mouse scroller, and move the stage in the Center
Screen Area to a point of interest with a double-click on the sample carrier.

§

With Save As the settings will be saved directly in the Experiment Manager. With Export
the settings will be saved in a folder of your choice.

Re-Positioning of the Sample Carrier after the experiment

Info
If you cycle the power on the microscope the software will prompt you to calibrate the stage
and/ or focus drives. Thus, if the calibration of the multi-well plate was performed under the
same conditions then the sample carrier calibration will still be valid. You must however, ensure that other parameters like plate orientation and placement on the microscope have not
changed.
1. Restart the software.
2. In the Acquisition tab go to the Experiment Manager and Reload or Import your experimental settings including your list of positions/ tile regions.
3. In Tiles tool under Sample Carrier, click on Calibrate.
à The Sample Carrier Calibration Wizard opens.
4. Move your previously chosen sample reference point into the middle of the crosshair.
5. Click on Next.
6. Under X/Y Position click on Set Zero.
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Click on Next.
As Calibration Method, select Search Reference Point.
Click on Next.
Click on Set Current X/Y.
Now, you still need to verify the Z-offset of your positions. Therefore, follow the corresponding instructions given in the chapters Adjusting Z-Values of Tile Regions [} 521] and
Adjusting Z-Values of Positions [} 521].

All of your selected positions/tile regions are now re-assigned to the correct X/Y/Z-values in relation to your (unique identifiable) reference point.
You can re-start your experiment and record images from your selected positions/tile regions.

See also
2 Customizing a Sample Carrier Template [} 529]

12.19.11 Using Sample Carriers
Use a sample carrier template to display the size and appearance of your sample carrier (e.g. slide
or multiwell plate) in Advanced Setup. This allows you to distribute tile regions or positions easily across your sample carrier.
12.19.11.1 Selecting a Sample Carrier Template
Prerequisite ü You have configured the general settings for setting up a tile experiment (experiment created,
at least one channel defined, Tiles dimension activated).
ü You are on the Acquisition tab in the Tiles tool.
1. Open the Sample Carrier section and click on the Select... button.
à The Select Sample Carrier Template dialog opens.
2. Select an existing sample carrier template or generate a new template by clicking on
.
3. To close the dialog, click on OK.
4. Calibrate the sample carrier by clicking on the Calibrate button.
à The Sample Carrier Calibration Wizard opens.
5. Follow the wizard until you have fully calibrated the sample carrier.
à The information The sample carrier is calibrated appears in the Sample Carrier section.
You have successfully selected a sample carrier.
12.19.11.2 Customizing a Sample Carrier Template
If you want work with a sample carrier that is not listed in the template database, you will need to
apply the following workflow in order to create a new template.
Prerequisite ü You have done all prerequisites for a Tiles & Positions experiment
ü You have defined at least one channel.
ü You have activated the Tiles checkbox.
1. Go to the Acquisition tab.
2. Open the Tiles tool and activate the Show All mode.
3. Open the Sample Carrier section and click on the Select… button.
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à The Select Template dialog opens.
4. Click on the Options
and select New Template.
à The New Sample Carrier Template dialog opens.
5. Choose a Category that corresponds to the type of your carrier and assign a Name to your
template.
6. For example if you select Slide, you can now configure the Width and Height of the slide
and adjust the location of a Reference Point.
7. If you select a Multislide, Petri Dish, Multiwell or Multichamber template, you can configure and adjust additional parameters of your carrier.
8. In case you need to modify one of the above depicted templates even further, first select
the Category that appears closest to your carrier, go again to the Category tab and then
choose Custom.
You have customized a sample carrier template or set up a custom one.

12.19.12 Importing Images into the Advanced Setup
In the Tiles - Advanced Setup, you have several options to open/import images. Follow the respective workflow.
Importing preview scan images
Prerequisite ü You are in the Advanced Setup.
1. In the ZEN menu bar, click on File > Tiles > Import Preview Image. Alternatively, right
click in the viewer and select Import Preview Image from the context menu.
à A file browser opens.
2. In the file browser, select your preview scan image (*.czi) and click on Open.
You have now imported a preview scan image into the Tiles Advanced Setup.
Importing an image already opened in ZEN
Prerequisite ü You are in the Advanced Setup.
ü You have an image opened in ZEN.
1. In the Right Tool Area, in the Images and Documents tool, select the image you want
to import.
2. Drag and drop the image into the viewer of the Advanced Setup.
You have now imported an already opened image into the Tiles Advanced Setup.
Importing from Explorer
Prerequisite ü You are in the Advanced Setup.
ü You have opened the path to your image (*.czi) in the Windows File Explorer.
1. In the Windows File Explorer, select the image you want to import.
2. Drag and drop the image into the viewer of the Advanced Setup.
You have now imported an image from the Windows File Explorer driectly into the Tiles Advanced Setup.
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12.19.13 Exporting Tile Images
Prerequisite ü You have acquired or opened a tile image.
1. On the Processing tab, open the parameters for Image Export (Ctrl+6 or via File > Export/Import > Export).
à You will see the settings of the parameters for Image Export. Make sure that the Show
All mode has been activated.
2. Select the file type that you want to use. We recommend the PNG format, as this is a format that offers lossless compression with an acceptable file size.
3. Activate the Apply Display Curve and Channel Color checkbox. This means that the images will be exported with the settings you have made, e.g. tonal value corrections or contrast. If you activate the Original Data checkbox, the images are exported unchanged. In
this case, the settings from the display curve, e.g. tonal value corrections and contrast, are
not adopted.
4. Select the Define Subset radio button.
à The settings for the available dimensions open.
5. Open the settings for the Tiles dimension.
6. Select the Existing Tiles radio button.
7. Click on the Apply button at the top of the Processing tab.
à You have exported the individual tiles from a tile image. The files can be found in the export folder indicated.

12.19.14 Functions & Reference
12.19.14.1 Tiles Tool

Info
The basic Tiles tool is only visible if you have a motorized stage configured with your microscope. The Tiles Advanced Setup and many other functions are only available if you own the
Tiles & Positions module and when it is activated in the Modules Manager. Additionally,
you must activate the corresponding checkbox on the Acquisition tab in the Experiment
Manager. This tool is part of the basic license for LSM.
In the Tiles tool you configure the acquisition of images that consist of several image fields.
Therefore you define Tile Regions or Positions. In addition you can set up focus surfaces and
sample carrier templates here.
The Tiles tool is located in the Left Tool Area under Multidimensional Acquisition.

Parameter

Description

Show Viewer

Only available if you have the Tiles & Positions license.
Opens the Tiles Advanced Setup [} 544] view in the Center Screen
Area.
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Info
The Sample Carrier, Focus Surface and Options sections are only visible if the Show All
mode is activated.
If you have no license for the Tiles module you will only find Tile Regions, Positions and Options sections here.
The different sections of the tool are described in the next chapters.
12.19.14.1.1 Tile Regions Section
Here you can define the desired tile regions and add it to the image.
Note: This section with controls is only visible if you have no license for Tiles & Positions. With a
license, these controls are selected from the Left Toolbar [} 547] in the Tiles Advanced Setup.

Parameter

Description

Contour

This parameter is only visible if the Show All is activated.
Here you select the shape or contour of the tile region that you are
adding. Simply click on the corresponding button to select the desired
contour. The selected contour is highlighted in blue color.

-

Rectangle

If selected, you can create rectangular tile regions.

-

Circle

When selected, you can create circular tile regions.

Mode

-

Tiles

If selected, you have to enter the number of tiles as a reference for
the size of the tile region.
Enter the number of tiles in the X/Y input fields. If you are adding a
circular tile region, enter the number of tiles for the diameter in the
Diameter input field.

-

Size

If selected, you have to enter the size as a reference for the size of the
tile region.
Enter the size of the tile region in the X/Y input fields. If you are
adding a circular tile region, enter the diameter of the tile region in
the Diameter input field.
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Description

-

Stake

If selected, you can define a tile region by the placement of at least
two markers (user defined X/Y stage coordinates). If you want to
modify the tile region (expand/reduce) you have to adjust the tile region to the desired size. To complete the tile region press Done. Circular or rectangular tile region can be created in this manner by selection of the appropriate contour.

-

Add

Adds the tile region to the image. The added tile region will also appear in the Tile Regions List and is activated for acquisition.
Added tile regions are displayed in the form of red grids in the stage
view of the Advanced Tiles Setup.

Tile Region List Options

Parameter

Description

Tile Regions List

Displays the added tile regions. The list contains the following columns:

-

Checkbox

Activates the relevant list entry for acquisition.

-

Name

Here you can edit the name of the tile region.

-

Category

Displays the category of the tile region. Categories can be defined in
the view options of the advanced tiles setup on the properties tab.

-

Tiles

Displays the number of tiles of the tile region.

-

Z

Displays the Z-position of the tile region.

-

Size

Displays the size of the tile region along its x and y axes in micrometers.

Up

and

Down

With the Up/Down buttons you can shift the selected list entry one
position up or down in the tile regions list. This allows you to modify
the acquisition order. Note that the order in the list will only be respected if the sorting of tile regions/ positions is deactivated in the
Options section (Stage Travel Optimization)!
Deletes the selected list entry.

Delete
If you click on the button, you see the following options:
Options

-

Set Current Z
for Selected Tile
Regions

Sets the current Z-Position for all selected tile regions.

-

Set Current X/Y/
Z for Selected
Tile Regions

Sets the current X/Y/Z-Position for all selected tile regions.

-

Delete

Deletes the current tile region.

-

Delete All

Deletes all tile regions.

-

Activate

Activates the current tile region for acquisition.
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Description

-

Deactivate

Deactivates the current tile region for acquisition.

-

Unlock

Unlocks the current tile region. The tile regions or positions are only
locked if created in carrier mode.

-

Unlock All

Unlocks all locked tile region.

-

Sort

By Center Position (Y -> X) sorts all tile regions according to their
overall Y position.
By Center Position (X -> Y) sorts all tile regions according to their
overall X position.
By Category sorts all tile regions according to their category.
Note that the order in the list will only be respected if the sorting of
tile regions/ positions is deactivated in the Options section (Stage
Travel Optimization)!

-

Convert to Positions…

Converts a selected tile region into Positions or a Position Array.

Properties Tile Region

Only visible if you have the Tiles & Positions license.
Displays the name of the currently selected tile region if one region is
selected.

Category

Only visible if you have the Tiles & Positions license.
Shows the currently assigned category of the selected tile region. The
Default category is set for all new tile regions.
Only visible if you have the Tiles & Positions license.

Options

Opens the options for editing and creating categories.

-

New

Opens the New Category dialog to create a new category.

-

Edit

Opens the Edit Category dialog to edit the selected category.

-

Delete

Deletes the selected category and sets the category of the tile region
to Default.

X

Only visible if you have the Tiles & Positions license.
Displays and sets the x-value of the selected tile region.

Y

Only visible if you have the Tiles & Positions license.
Displays and sets the y-value of the selected tile region.

Z

Only visible if you have the Tiles & Positions license.
Displays and sets the z-value of the selected tile region.

Set Current Z

Only visible if you have the Tiles & Positions license.
Sets the Z dimension at the current Z position of the focus drive.

Width

Only visible if you have the Tiles & Positions license.
Displays and sets the width of the selected tile region.

Height

Only visible if you have the Tiles & Positions license.
Displays and sets the height of the selected tile region.

Verify

Only visible if you have the Tiles & Positions license.
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Description
Opens the Verify Tile Regions dialog. There you can verify each
point of the tile region according focus und position.

12.19.14.1.2 Positions Section
Current Position section
Displays the current stage position.
Note: This section is only visible if you have no license for Tiles & Positions. With a license, this
functionality is visible in the Left Toolbar [} 547] of the Tiles Advanced Setup.

Parameter

Description

X Position

Displays the x coordinate of the current position.

Y Position

Displays the y coordinate of the current position.
Adds the current position to the Positions List and activates it for acquisition.

Add
Display mode section

Parameter

Description

Single Positions

Shows the Single Positions List.
To learn more about single positions see glossary "Position".

Position Arrays

Shows the Position Arrays List and the Positions of selected Array List, that shows a full Single Positions List for the selected position array.
To learn more about position arrays see glossary "Position".

Single Position
List / Position Array List

Displays the added positions/ position arrays. The list contains the following columns and buttons.

–

Checkbox

Activates the relevant list entry for acquisition.

–

Name

Displays and edits the name of the single position.

–

Category

Displays the category of the single position. Categories can be defined
in the view options of the advanced tiles setup on the properties tab.

–

Contour

Only visible if you have selected Position Arrays.
Displays the contour of the position array.

–

Positions

Only visible if you have selected Position Arrays.
Displays the number of positions of the position array.

–

Size

Only visible if you have selected Position Arrays.
Displays the size of the position array.

–

X

Displays the x-position of the single position.

–

Y

Displays the y-position of the single position.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

535

12 Software Modules & Extensions | 12.19 Tiles & Positions

Parameter
–

Description

Z

–
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Displays and edits the z-position of the single position.
and

With the buttons you can shift selected list entry one position up or
down in the tile regions list. This allows you to modify the acquisition
order.
Note that the Tile Regions/Positions checkbox has to be deactivated in Tiles Options [} 555].
Note that the order in the list will only be respected if the sorting of
tile regions/ positions is deactivated in the Options section (Stage
Travel Optimization)!
Deletes the selected list entry.

–
Delete

–
Options

Opens the Options for editing Single Positions [} 537] or Options for
editing Position Arrays [} 537] respectively.

Verify

Opens the Verify Tile Regions or Verify Positions Dialog [} 542].

Properties Position

Only visible if you have the Tiles & Positions license.
Displays the name of the currently selected position.

Category

Only visible if you have the Tiles & Positions license.
Shows the currently assigned category of the selected tile region. The
Default category is set for all new tile regions.
Only visible if you have the Tiles & Positions license.

Options

Opens the options for editing and creating categories.

-

New...

Opens the New Category dialog to create a new category.

-

Edit…

Opens the Edit Category dialog to edit the selected category.

-

Delete

Deletes the selected category and sets the category of the tile region
to Default.

X

Only visible if you have the Tiles & Positions license.
Displays and sets the x-value of the selected tile region.

Y

Only visible if you have the Tiles & Positions license.
Displays and sets the y-value of the selected tile region.

Z

Only visible if you have the Tiles & Positions license.
Displays and sets the z-value of the selected tile region.

Set Current Z

Only visible if you have the Tiles & Positions license.
Sets the Z dimension at the current Z position of the focus drive.
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12.19.14.1.2.1 Options for editing Single Positions

Parameter

Description

Set Current Z for
Selected Positions

Sets the current Z-Position for all selected positions.

Set Current XYZ
for Selected Position

Sets the current X-Y-Z-Position for the selected position.

Delete

Deletes the current position.

Delete All

Deletes all positions.

Activate

Activates the current position for acquisition.

Deactivate

Deactivates the current position for acquisition.

Sort

Sorts the list entries according to the chosen parameter.

-

By Center Position (Y -> X)

Sorts all positions according to their overall Y position.

-

By Center Position (X -> Y)

Sorts all positions according to their overall X position.

-

By Category

Sorts all positions according to their category.

Import stage
marks as positions

Only visible if you have the Tiles & Positions license.
Imports the marks from the Stage tool as positions.

12.19.14.1.2.2 Options for editing Position Arrays

Parameter

Description

Set Current Z for
all Positions in selected Arrays

Sets the current Z-Position for all positions in the selected arrays.

Delete

Deletes the current position array.

Delete All

Deletes all position arrays.

Activate

Activates the current position array for acquisition.

Deactivate

Deactivates the current position array for acquisition.

Unlock

Unlocks the current position array.

Unlock All

Unlocks all locked position arrays.

Sort

Sorts the list entries according to the chosen parameter.

-

By Center Position (Y -> X)

Sorts all positions according to their overall Y position.

-

By Center Position (X -> Y)

Sorts all positions according to their overall X position.
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12.19.14.1.3 Sample Carrier Section
Only visible if the Show All mode is activated and only available with a licence for the Tiles &
Position module.

Parameter

Description

Sample Carrier

Displays the selected sample carrier template. If no template is selected it will display None.

Select...

Opens the Select Template Dialog [} 557]. Here you can select the
sample carrier template.

(Edit Support Points)

Delete

Opens the sample carrier selection/editor dialog. Here you can edit
and add global support points to the selected sample carrier.
Deletes the selected sample carrier from the sample carrier field. The
template will still be available in the Select Sample Carrier Template dialog.

Calibrate...

Only available if a suitable channel is configured for the experiment.
Opens the Sample Carrier Calibration Wizard which guides you
through the sample carrier calibration.

Move Focus Drive
to Load Position
Between Containers

Activated: Moves the focus drive to the loading position during the
movement of the stage to another container of the sample carrier
(e.g. a well or slide). This prevents possible damage. Note that this behavior is only applied during an experiment.

12.19.14.1.4 Focus Surface and Support Points Section
Only visible if the Show All mode is activated.

Parameter

Description

Selected Tile Region

Displays the number of currently selected tile regions.

Current Position

Adds a support point at the current stage and focus position. Only
available if the stage is positioned within the yellow bounding of the
selected tile region.

Center of Tile Region

Adds a support point at the center of the currently selected tile region.

Method

Selects which method is used to add multiple support points.

-

Generic

Distribution method with a simple column and row approach. ZEISS
recommends using this method for smaller tile regions (<200 tiles) of
a regular shape, e.g. quadratic, rectangular, and circular.

-

Onion Skin

Distribution method for mid- or larger tile regions (>200 tiles) of an irregular shape like you might use to image large area tissue specimens,
e.g. brain slices.

Columns

Only available with Generic. Sets the number of columns of support
points within the selected tile region.

Rows

Sets the number of rows of support points within the selected tile region.
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Description

Density

Only available with Onion Skin.

ZEISS

Determines the number of support points (up to a preset maximum
number) that are used to cover the tile region. Example: A square tile
region with 400 tiles has 20 support points with the default parameters. The parameter density is set with a standard value of 5%. This
means that in a, for example, approximately square tile region of 400
tiles about 20 support points are created.
Margin

Only available with Onion Skin.
This parameter allows you to control how close support points can be
placed along the edges of your tile region. The value defines the distance to the tile regions boundary as a number of tiles. The default is
1 and allows support points to be placed in the outer most "layer" of
tiles. A value of 2 allow support points only from 2 "layer" of tiles
from the boundary, etc. This feature is useful if a software autofocus
(SWAF) is used to determine the z-values of your support points.
Sometimes tiles in the boundary regions might not contain any structure. Thus, the SWAF cannot adjust the support points z-value.

Max.

Only available with Onion Skin.
Determines the maximum number of support points for a tile region.
As the density parameter is set to 5%, this would necessitate for very
large specimens that the number can get very large. But a larger number of focus points does not always mean a better quality calculation
of the focus surface. For this reason, you can define a maximum number of focus points in the range of 24 to 36 points.

Distribute

Distributes the entered number of support points defined in the column and row input fields within the tile region. Previously defined
support points will be deleted.

Local (per Tile Region) / Global (on
Carrier) tab

Displays a list with local or global support points. You have the following columns and options:

X

Displays and edits the x coordinate of the focus reference point.

Y

Displays and edits the y coordinate of the focus reference point.

Z

Displays and edits the z coordinate of the focus reference point.

Container

Allows you to sort the global support points according to their container on the sample carrier.
Only visible on the Global (on Carrier) tab.

Add

Adds a new support point to the selected tile region at the current
stage and focus position.
Deletes the selected list entry.

Delete
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Description

Options

–

Add Support
Point at Current
Stage and Focus Position

Adds a new support point at the current stage and focus position.

–

Set Current Z
for Selected
Support Points

Sets the current Z-Position for all selected support points.

–

Set Current X/Y/
Z for Selected
Support Points

Sets the current X-Y-Z-Position for the selected support point.

–

Delete

Deletes the current support point.

–

Delete All

Deletes all support points from the current tile region.

–

Delete all Support Points
from Selected
Tile Regions

Deletes all support points from the selected tile regions.

–

Delete all Support Points
from all Tile Regions

Deletes all support points from all tile regions.

–

Set Current Z
for Selected
Support Points

Only visible on the Global (on Carrier) tab.
Sets the current z-position for all selected support points.

Set current XYZ

Sets the current x/y/z position for the selected support point.

Set current Z

Sets the current z-position for all selected support points.

Interpolation Degree

Displays the selected degree of interpolation.
Selects a degree of interpolation from the dropdown list.

Verify

Opens the dialog to verify the support points.

The more variable the surface of your specimen the higher you should choose the interpolation
degree. For higher degrees you will need more support points. The minimum number of support
points required for each interpolation degree is given in the dropdown list. As an overachievement of this minimum number ensures a solid calculation, we recommend minimizing the interpolation degree even if you added more support points. Increase the interpolation degree only so far
as the surface condition of your specimen demands. If the number of support points is too low for
the selected interpolation degree, the next lower level for which the minimum is forefilled will be
used. By default, ZEN uses the second order parabolic saddle surface that requires at least 9 support points. For most applications you will not need to adjust this setting.
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The properties of a selected global support point slightly differ from those of a local one as you
cannot edit the X/Y dimensions because they are fixed by the sample carrier template you have
selected. Therefore there is no Set Current X/Y/Z button for global support points. If you want
to edit the number and XY dimension of your global support points this can be done directly via
the Sample Carrier section of the Tiles tool.
12.19.14.1.5 Options Section
Only visible if the Show All mode is activated.
Here you can set options like acquisition and stage travel behavior during the experiment.
Changes in this section of the tool affect all elements, tile acquisitions, positions and position arrays.

Parameter

Description

Tile Overlap

Defines the overlap in percent of individual tiles of the tile regions.
The value is set to 10 % by default.
Note that lower overlap might cause artifacts when stitching the image as there is less information for a robust correlation. No overlap
will not allow the images to be stitched correctly.

Stage Travel Optimization

In this section you can adjust settings for stage traveling during an experiment or preview scan ( only with Tiles & Positions module). Note
that in some cases the preview scan function will automatically select
a travel mode for the stage that is more appropriate.

Travel in Tile Regions

-

Meander

Acquires tile regions following a meander pattern – alternately from
both travel directions (left -> right; right -> left). This scan movement
is faster.

-

Comb

Acquires tile regions following a comb pattern – always from one
travel direction only (left -> right). This scan movement is more precise.

-

Spiral

Acquires tile regions following a spiral pattern – from the center of
the region to the outer bounds in a clockwise motion. This mode
works only for regions with rectangular or elliptical contours.

Tile Regions/Positions

Activated: Individual positions and tile regions are not acquired in
the sequence in which they are defined in the Tile Regions list.
The stage movement will be automatically adapted to the location of
the individual tile regions and positions. If you add or remove tile regions or positions, the sequence of acquisition therefore also changes.

-

Sort by X, then
Y

The tile regions and positions are sorted by their absolute position
(first x, then y).

-

Sort by Y, then
X

The tile regions and positions are sorted by their absolute position
(first y, then x).

Carrier Wells/Container

Activated: Applies the selected travel patterns (meander or comb)
when acquiring tiles in sample carriers with wells/containers. When,
for example meander is used, the stage travel between wells will be
e.g. A1, A2 ....A4 --> B4, B3 .....B1 etc.
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-

Meander

Acquires tile regions following a meander pattern – alternately from
both travel directions (left -> right; right -> left). This scan movement
is faster.

-

Comb

Acquires tile regions following a comb pattern – always from one
travel direction only (left -> right). This scan movement is more precise.

Use Stage Speed
from Stage Tool

This function is only visible if the corresponding option is activated in
Tools > Options > Acquisition > Tiles & Positions. By default,
backlash correction will be used during stage movement.
Activated: The software uses the stage travel speed which is set in
the Stage tool (Right Tool Area).

Stage and Focus
Backlash Correction

Activated: Stage and focus positioning is done with a backlash correction which is more precise but slightly slower.

Move Focus to
Load Position Between Regions/Positions

Activated: The focus drive is moved to the load position while moving to another tile region, position, or well.

Split Scenes into
Separate Files

Activated: The scenes (e.g. tile regions and positions) are stored into
separate physical files. They are still combined into one logical image
file.

Image Pyramid
During Acquisition

Activated: An image pyramid is generated during the acquisition.
This optimizes the image for fast display. If this option is not activated, the acquired image will not be shown and updated in the document area while the acquisition is running.

12.19.14.1.6 Verify Tile Regions or Verify Positions Dialog
Note that the z values of positions, tile regions (unless they have at least one support point), local
support points, and global support points are verified in a separate dialog accessed via the Focus
Surface and Support Points section. As the dialog contains the same items and options for verifying the Z values it is described here once.

Parameter

Description

Tile Regions/Positions List

Displays all the tile regions (TR), positions (P), or support points (SP)
currently active in your experiment. The list contains the following columns and buttons:

-

Status

Here you can see if the Z-Position is already verified. Then a green
checkmark will appear in the corresponding row.

-

Name

Displays the name of the selected object.

-

Z (µm)

Displays the z-position of the tile region, position, or support point.

-

Tile Region

Shows the tile region to which the local support point belongs.

-

Array

Shows if the position is part of an Position Array.
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Parameter

Description

-

Opens the options menu for verifying tile regions / positions, see description below.

Options
Verification Helper
Method

-

None
(manual adjustment)

If selected, you need to manually adjust the focus for each point to be
verified.

-

Autofocus (AF)

Only available if your system has a motorized focus drive (z-axis) and
the software autofocus module.
If selected, you can use the software autofocus for adjusting the focus
for each point to be verified. The corresponding buttons will then appear in the dialog.

-

Definite Focus
(AF)

Only available if your system has a Definite Focus device.
If selected, you can use the definite focus for adjusting the focus for
each point to be verified. The corresponding buttons will then appear
in the dialog further below.

Move to Current
Point

Moves the stage to the selected object.

Include Z when
Moving to Points

Activated: ZEN moves to the selected object and adjusts the position
of the z-drive to the currently assigned z-value.

Set Z & Move to
Next

Sets the current z value for the selected support point and sets the
status to verified. Then the software moves the stage to the next support point.

Run AF (or DF) and
Set Z

This button is only visible if you have selected Autofocus (AF) or Definite Focus (DF) as Helper Method.
Runs the software autofocus / definite focus and sets the current z
position to verified.

Use AF (or DF) to
Verify the Remaining

This button is only visible if you have selected Autofocus (AF) or Definite Focus (DF) as Helper Method.
Automatically moves to the remaining points and determines the z
value with the software autofocus for them.

Options for verifying tile regions/positions

Parameter

Description

Current Point Verified

Here you can change the status of the selected support point from
verified to unverified (or vice versa).

Set all Points as
Verified

Changes the status of all points to verified.

Reset Verification
State of all Points

Changes the status of all points to unverified.
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Parameter

Description

Set Current Z for
Selected Points

The current z value is set for all selected points. You can press Ctrl and
the left mouse button to select multiple points, or Ctrl + A to select
all.

Set Current Z for
all Points

The current z value is set for all points.

Apply Z-Offset...

Opens al dialog to apply a z-offset for all or the selected points.

12.19.14.2 Tiles Advanced Setup
Here you can visualize and plan your Tiles and Positions experiment. The advanced tiles setup
opens by clicking on the Show Viewer button in the Tiles tool on the Acquisition tab of the
Left Tool Area. In the Center Screen Area you can see the Stage view [} 545]. When the Tiles
Advanced Setup opens, the stage view is zoomed to a predefined factor. You can change the
Zoom in the Dimensions tab, or by scrolling the mouse wheel.
To navigate around you have the following options:
§

Move the mouse pointer of the live navigator, then press and hold the left mouse button and
drag the live navigator to the desired location. Release the left mouse button to finish.

§

Place the mouse pointer at a location where you want to move the stage and double click.

§

Use the software joystick in the Stage tool of the Right Tool Area to navigate. Alternatively
use the hardware joystick of your stage controller.

§

In each corner and along each edge with the arrowheads, you can click to move the view in
this direction. Additional settings and tools relating to tile regions or positions can be found in
the specific view options.

1

2

3

4
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1

Left Toolbar
Here you select which setup you use to set tile regions or position. for more information,
see Left Toolbar [} 547].

2

Top Toolbar
Depending on what you have selected on the Left Toolbar, different features to create
tiles or positions are displayed here. For more information, see Top Toolbar [} 547].

3

Stage View
The Stage View shows the full travel range of the microscope stage, along with the current stage position, the graphical display of sample carriers, and your acquired mosaic
images. For more information, see Stage View [} 545].

4

View Options
General and tiles specific [} 554] view options are displayed here.
Note that the functionalities between activated and deactivated Show All layout might
differ.

12.19.14.3 Stage View
The Center Screen Area shows the full travel range of the microscope stage, along with the current stage position, the graphical display of sample carriers and your acquired mosaic images. You
can control the stage view using the arrow icons at the edges of the image area. The view can be
enlarged, reduced or moved using the general control elements.

Symbol

Parameter

Description

Selected/Active

Represents the Selected/Active container/well by a
blue border.

Live Navigator

Shows the current stage position including the live image as a frame outlined in blue. To move the frame,
double-click on the position to which you want to
move it. Alternatively hold the left mouse button on
the live navigator tool while dragging the mouse.
The frame can also be used to control acquisition. If
you click on one of the frame's blue arrow icons, an
image is acquired. The Live Navigator tool is moved
one frame width in the relevant direction. You can create tile images of your sample easily in this way.

Tile Region

Represents the tile regions in the stage view by a red
grid.

Positions

Represents positions in the stage view by a yellow plus
symbol wit a red frame.

Position Array

Represents the position arrays in the stage view by the
corresponding position symbols surrounded by a
dashed line.

/
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Parameter

Description

Local Support
Point

Represents local support points in the stage view by a
yellow circle with a dot in the middle.

Global Support
Point

Represents global support points in the stage view by a
white circle with a dot in the middle.

A right-click in the Stage View displays a context menu with Tiles & Positions specific options
[} 546].
12.19.14.3.1 Specific Tiles & Positions Context Menu Options
When you right click in the Stage View of the Tiles Advanced Setup, you have the following
Tiles & Positions specific options:

Parameter

Description

Show Images

Activated: Displays images in the Stage View.

Remove Images

Displays the options of what images are removed from the Stage
View.

–

All

Removes all images.

–

All Manual
Snap Images

Removes all manually taken snap images.

–

All Preview
Scan Images

Removes all preview scan images including preview images imported
into the Stage View.

Import Preview
Image

Opens the file browser to select an image which gets imported into
the Stage View.

Save Preview Images

Opens the preview images in separate image documents in ZEN,
which allows you to save them or work with them if necessary.

Bring Navigator
into View

Re-centers the Stage View onto the current stage position coordinates at the preset zoom level. You can also activate this function
with Ctrl + B.

Show Tile Regions
Name

Activated: Displays the names of the of the tile regions in the Stage
View.

Show Tile Rectangle for Positions

Activated: Displays a red rectangle around the individual positions in
the Stage View.

12.19.14.4 Tiles Toolbars
In the Tiles - Advanced Setup your main features to create regions and positions are in two
toolbars on top and on the left of the viewer. The options available in the top toolbar depend on
what is selected in the left toolbar.
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12.19.14.4.1 Left Toolbar
Here you select which setup you use to set tile regions or positions.

Parameter

Description

Preview

Displays the tools to define the settings for a preview scan (see also
Preview Scan Toolbar [} 548]). Typically a low magnification objective
and a channel which protects your sample (e.g. transmitted light) is
used. This will give you a low resolution overview of the sample to
mark tile regions and/or positions.

Tiles

Here you can select which setup you want to use to set the tile regions. The corresponding tools are displayed in the Top Toolbar
[} 547].

–

Displays the tools to define tile regions by means of contour (see also
Contour Toolbar [} 548]).
Setup by contour
Displays the tools to define tile regions by means of number or size
(see also Predefined Toolbar [} 549]).

–
Setup by predefined

Displays the tools to define tile regions by specifying two or more
marker positions (see also Stake Toolbar [} 550]).

–
Setup by stakes

Displays the tools to define tile regions automatically by means of the
fill factor of the sample carrier (see also Tiles Carrier Toolbar [} 550]).

–
Setup by carrier
Positions

Here you can select which setup you want to be used to set the positions. The corresponding tools are displayed in the Top Toolbar
[} 547].

–

Displays the tools to define positions by means of the location (see
also Positions Location Toolbar [} 551]). You can add various positions in the Stage View using the mouse.

Setup by location

–
Setup by array

Displays the tools to define positions by means of position arrays (see
also Position Array Toolbar [} 551]). You can add various contours for
position arrays in the stage view.
Displays the tools to define positions automatically on the relevant
sample carrier (see also Positions Carrier Toolbar [} 552]).

–
Setup by carrier
12.19.14.4.2 Top Toolbar

Depending on what you have selected on the Left Toolbar [} 547] of the Tiles - Advanced
Setup, different features to create tiles or positions are displayed. For information on the various
top toolbars, see the list below.
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12.19.14.4.2.1 Preview Scan Toolbar
Here you can define the settings for a preview scan. Typically a low magnification objective and a
channel which protects your sample (e.g. transmitted light) is used. This will give you a low resolution overview of the sample to mark tile regions and/or positions.

Parameter

Description

Use Experiment
Settings

Uses the settings of the experiment for the preview scan.

Channel

Only available if Use Experiment Settings is deactivated.
Displays the channels for the preview scan. If you deactivate Use Experiment Settings, you can deselect individual channels here.

Camera Binning

Only available if Use Experiment Settings is deactivated.
Sets the binning of the camera for the preview scan experiment only.
The exposure time will be compensated automatically for the preview
scan. Note that higher binning will reduce the scan time (due to
shorter exposures of the camera), but reduce the image resolution.

Delete existing
preview images

Activated: Deletes the already existing preview images before the
preview scan is started.

Start

Starts the preview scan to acquire the overview image.

See also
2 Generating a Preview Scan [} 515]
12.19.14.4.2.2 Contour Toolbar
Here you can define the tile regions by means of the contour.

Parameter

Selection Mode

Description
With this tool you can select an already created tile region by clicking
on it to move or edit it.
With this tool you can draw a rectangle tile region.

Rectangle
With this tool you can draw a elliptical tile region.
Ellipse
With this tool you can draw a polygonal tile region.
Polygon
Keep Tool

Activated: Keeps the selected tool active. You can use the tool several times in succession without having to reselect it.

See also
2 Creating Tile Regions by Contour [} 517]

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

548

12 Software Modules & Extensions | 12.19 Tiles & Positions

ZEISS

12.19.14.4.2.3 Predefined Toolbar
Here you can define the tile regions by means of the number or size.

Parameter

Description
Draws a rectangular tile region.

Rectangle
Draws a circular tile region
Circle
Tiles

Using this mode you have to enter the number of tiles as a reference
for the size of the tile region.
Enter the number of tiles in the X / Y input fields. If you are adding a
circular tile region, enter the number of tiles for the diameter in the
Diameter input field.

Size

Using this mode you have to enter the size as a reference for the size
of the tile region. Enter the size of the tile region in the X / Y input
fields. If you are adding a circular tile region, enter the diameter of
the tile region in the Diameter input field.
The anchor of the defined shape is at the top left.

Top left anchor
position
The anchor of the defined shape is centered.
Center anchor position
The anchor of the defined shape is at the bottom right.
Bottom right anchor position
Add Tile Region

Adds the tile region to the Tile Regions List and activates it for acquisition.
Added tile regions are displayed in the form of red grids in the stage
view of the Advanced Tiles Setup.
Select an element in the stage view to edit or move it.

Selection
Adds the current tile definition in the image area.
Add Tile Region
Keep Tool

Activated: Keeps the selected tool active. You can use the tool several times in succession without having to reselect it.

See also
2 Creating Tile Regions by Predefined [} 518]
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12.19.14.4.2.4 Stake Toolbar
Here you can define the tile regions with stake markers.

Parameter

Description
Adds a marker position to the current stage and focus position.

Add Marker Position
Removes the last marker position.
Remove Marker
Position
Draws a rectangular tile region.
Rectangle
Draws a circular tile region
Circle
Draws a polygonal tile region
Polygon
Done

Saves the current tile regions setup and resets the marker positions.

12.19.14.4.2.5 Tiles Carrier Toolbar
Here you can define the tile regions automatically by means of the fill factor of the sample carrier.

Info
§

A sample carrier must have been selected in the Sample Carrier [} 538] section of the Tiles
tool.

§

Manually created tile regions and positions (setup by Contour and setup by Predefined)
will be deleted, if you switch to the setup by Carrier. If you want to combine manual and
automatic setup, first use setup by Carrier and then switch to a manual setup. Tile regions
that are created automatically by setup by Carrier, are defined to a container and permanently assigned and locked by default, against manual editing. You can unlock the tile regions in the Tiles tool by selecting the desired tile region and unlocking it via the options
menu in the tile regions list. You can also unlock all tile regions here if necessary.

Parameter

Description

Select Sample Carrier

Only visible if no sample carrier is currently selected.
Opens the dialog to select a sample carrier template.
Creates a tile region for every selected sample carrier container.

Create
Removes the tile region in every selected sample carrier container.
Remove
Fill Factor

Here you can enter the fill factor used to fill the selected container.
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Parameter

Description

Columns/Rows

Here you can add single tile regions to a container by defining the
number of columns and rows of the tile. The tile region is always
placed at the center of the well container.

ZEISS

See also
2 Creating Tile Regions by Carrier [} 518]
12.19.14.4.2.6 Positions Location Toolbar
Here, you can define the positions by means of the location. You can add various positions in the
Stage View using the mouse.

Parameter

Description
Selects an element in the stage view to edit or move it.

Selection
Adds a new position on the stage view.
Add
Keep Tool

Activated: Keeps the selected tool active. You can use the tool several times without having to reselect it.

Current X / Y

Displays the current stage position (X/Y).

Add Position

Adds a new position at the current stage position.

See also
2 Creating Positions by Location [} 518]
12.19.14.4.2.7 Position Array Toolbar
Here you can define the positions by means of position arrays. You can add various contours for
position arrays in the stage view.

Parameter

Selection

Description
With this tool you can select an already created position array to
move or edit it.
With this tool you can draw a rectangular position array.

Rectangle
With this tool you can draw a elliptical position array.
Ellipse
Keep Tool

Activated: Keeps the selected tool active. You can use the tool several times in succession without having to reselect it.

Distribute Positions by

–

Number

Activates the input for Number and Bias.
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Grid

–

Number

ZEISS

Description
Activates the input field for an Overlap.
Only visible if Number is selected.
Shows the current number of positions that are distributed to newly
created position array. Change the number to increase or decrease
the number of single positions obtained by a position array.

Bias

Only visible if Number is selected.
Adjusts the overall position of the single positions in the position array.

-

None

The single positions of the position array will be distributed evenly
within the array.

-

Center

The single positions of the position array will mainly be distributed
near to the center of the position array. Less positions will be at the
edges of the array.

-

Edge

The positions of the position array will be distributed to the edges of
the array. Less positions will be in the center of the array.

Random

Only visible if Number is selected.
Activated: The single positions will be distributed randomly within
the position array. The overall bias will still be taken into account.

Overlap

Only visible if Grid is selected.
Shows the current degree of overlap in % of each position in the array relative to its neighbors. Both positive and negative values are
possible.

See also
2 Creating Positions by Array [} 519]
12.19.14.4.2.8 Positions Carrier Toolbar
Here you can define the positions automatically on the relevant sample carrier.

Info
§

A sample carrier must have been selected in the Sample Carrier [} 538] section of the Tiles
tool.

§

Manually created tile regions and positions (setup by Contour and setup by Predefined)
will be deleted, if you switch to the setup by Carrier. If you want to combine manual and
automatic setup, first use setup by Carrier and then switch to a manual setup. Tile regions
that are created automatically by setup by Carrier, are defined to a container and permanently assigned and locked by default, against manual editing. You can unlock the tile regions in the Tiles tool by selecting the desired tile region and unlocking it via the options
menu in the tile regions list. You can also unlock all tile regions here if necessary.

Parameter

Description

Select Sample Carrier

Only visible if no sample carrier is currently selected.
Opens the dialog to select a sample carrier template.
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Create

Remove

ZEISS

Description
Creates a position array for every selected container of the sample
carrier.
Removes the position array for every selected container of the sample
carrier.

Distribute Positions by

–

Number

Activates the input for Number and Bias.

–

Grid

Activates the input field for an Overlap.

Number

Only visible if Number is selected.
Shows the current number of positions that are distributed to newly
created position array. Change the number to increase or decrease
the number of single positions obtained by a position array.

Bias

Only visible if Number is selected.
Adjusts the overall position of the single positions in the position array.

-

None

The single positions will be distributed evenly within the array.

-

Center

The single positions will mainly be distributed near to the center of
the position array. Less positions will be at the edges of the array.

-

Edge

The positions will be distributed to the edges of the array. Less positions will be in the center of the array.

Random

Only visible if Number is selected.
Activated: The single positions will be distributed randomly within
the position array. The overall bias will still be taken into account.

Columns

Only visible if Grid is selected.
Sets the number of columns of the position array in each container of
the sample carrier.

Rows

Only visible if Grid is selected.
Sets the number of rows of the position array in each container of the
sample carrier.

Overlap

Only visible if Grid is selected.
Shows the current degree of overlap in % of each position in the array relative to its neighbors. Both positive and negative values are
possible.

See also
2 Creating Positions by Carrier [} 519]
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12.19.14.5 Tiles View Options
This view options are specific for the Tiles & Positions module.
12.19.14.5.1 Tiles Tab
Here you can define how the software behaves when the live image is started and the Tiles - Advanced Setup is open.

Parameter

Description

New Tab

Opens the live or continuous image into a new image container.

Separate Container

Opens a live or continuous image into a separate container. Both the
Tiles - Advanced Setup and the live or continuous images are visible
in parallel. We recommend to activate this checkbox, especially if you
use two separate monitors. You may also want to use the Automatic
Contanier Layout setting found in the view option dropdown list of
the Document bar [} 22] in the Center Screen Area [} 21].

Tiles View

Displays the live or continuous image in place in the Stage View of
the Tiles - Advanced Setup.

Center to Stage
Position

You can use this function if you need quickly to re-find your current
location. Re-centers the Stage View onto the current stage position
coordinates at the preset zoom level. You can also activate this function with Ctrl + B. You can call the function to focus the image with
the mouse wheel by pressing and holding the Ctrl key when the
mouse cursor is over the stage view.

12.19.14.5.2 Carrier Tab
Only visible if a sample carrier is selected.
Here you can see a graphical preview of the sample carrier being used.
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Info
Only the containers/wells whose tile regions and positions were set up with the Tiles Carrier
Toolbar [} 550] or the Positions Carrier Toolbar [} 552] will be taken into account.
Please note the following features of the display:

Symbol

Description

/

Empty containers/wells, meaning that no tile regions or positions
were set up with the Carrier option, are represented by a grey container/well.
The currently Active container/well is represented by a blue border.

/
A container/well only filled with Tile Regions is represented by a yellow filled container/well.
/
A container/well only filled with Positions is represented by a orange
filled container/well.
/
A container/well filled with Tile Regions and Positions is represented by a half yellow, half orange filled container/well.
/

Info
Right click opens a small context menu. Here you can copy the contents of the selected well,
or paste the contents to the selected or all wells.

12.19.14.6 Tiles Options
The additional options for the tiles module allow to set up several options for image acquisition
and additional information. The tiles options dialog can be found in the menu bar under Tools >
Options > Acquisition > Tiles & Positions.
Note: For the changes to be effective you might need to close and reopen the advanced setup
viewer.

Parameter

Description

Automatically
Start Live Mode in
the Advanced
Setup View

Activated: Automatically starts the Live mode in the Center Screen
Area if you klick in the Acquisition tab in the Tiles tool on the Advanced Setup button.

Automatic Snap by
Clicking the Live
Navigator Buttons

Activated: Acquires an image if you click on one of the frame's blue
arrow icons. The Live Navigator tool moves one frame width in the
relevant direction. You can create tile images of your sample easily in
this way.

Uncheck this option to prevent unnecessary specimen bleaching. The
default is not activated.
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Parameter

Description

Enable Stage
Movement with
Live Navigator

In the Live navigator tool the current stage position including the live
image is shown as a frame outlined in blue. To move the frame, double-click on the position to which you want to move it. Alternatively,
place the mouse cursor over the blue frame, press and hold the left
mouse button and drag the live navigator to the desired location.
Activated: Allows you to move the Live Navigator tool by dragging
it to a new location.

Show Stage and
Focus Backlash
Correction Setting
in the Options

Activated: In the Tiles option, the setting to switch the backlash correction on or off is shown. Per default it is hidden.

Delimiter for CSV
Export/Import

Specifies the delimiter for a CSV export or import. Select Comma (default), Semicolon or Tab.

Ask Whether Support Points/Positions Should be
Overwritten

When the support points and/or positions are determined by a software autofocus run the existing points can be overwritten with the
new Z values.

Focus Surface Outlier Determination

Ignores support points that are significantly outside the interpolated
focus surface.

Activated: Shows a message box asking if the points should be overwritten if there is a autofocus Z value.

You have the following setting options available:

-

Maximum Interpolation Degree
for Outlier Detection

This value can be 0 or 1. If 1 then a linear fit is used to detect the outlier support points. This is the default. If 0 a simple average value is
used to detect outliers.

-

Threshold in
Terms of the
Standard Deviation (Sigma)

This parameter defines a threshold value to determine which of the
support points are outliers from the fitting process. This is defined by
the standard deviation (sigma value) set in the spin box. Support
points not meeting this criteria are subsequently ignored when the focus surface is determined.

Delay Time After
Stage Movements

Defines a delay period which is used for all stage movements in a tiles
and position experiment or movements controlled in the advanced tile
setup. The delay helps prevent movement in samples where, for example, a large volume of liquid is present in the sample holder. It can
be used with the stage speed and acceleration options to optimise experiments with this type of sample.

Binning Compensation of Exposure
Time in Preview
Scans

Defines the power to which the binning ratio is modified to automatically determine the exposure time value used for a preview scan were
the binning setting between the experiment and preview scan differs.
The default value is 2.0 i.e. quadratic. Thus, for example the exposure
time would be reduced by a factor of four if the experiment binning is
1x1 and the preview scan binning is 2x2. The value can be varied between 1.0 and 2.0 in steps of 0.1.
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Description

Live Image in Sample Carrier Calibration Wizard (relevant only for systems with camera)

-

Use Imaging
Device from Selected Channel
with "Acquisition" Settings

Activated: Default setting for the live image that allows navigation
and focus interaction during the carrier calibration wizard.

-

Use Active
Camera with
"Locate" Settings

This option is only relevant for systems with a wide field (camera
based) detector.
Activated: Allows you to alternatively apply locate camera settings
for use in the carrier calibration wizard (live image). By default the experiment settings for the currently selected channel/track will be used.

12.19.14.7 Select Template Dialog
In this dialog you can select a sample carrier or enter a dialog to create a custom carrier. A preview of the selected carrier is shown on the right side of the list.

Parameter

Description

Workgroup Templates

Shows a list of all custom sample carrier templates.

ZEISS Templates

Shows a list of predefined ZEISS sample carrier templates for several
sample carriers.
Opens the New Sample Carrier Template dialog [} 558] to create a
new template.

Add

Deletes the selected sample carrier template.
Delete

Options

–

New Template...

Opens the New Sample Carrier Template dialog [} 558] to create a
new template.

–

Show/Edit...

Opens the selected template in the Edit Sample Carrier Template dialog [} 558] and allows editing.
ZEISS templates are read only. If you want to edit a ZEISS template
you have to use the Copy and Edit... option.

–

Copy

Copies the selected template.

–

Copy and
Edit...

Copies the selected template and opens it in the Edit Sample Carrier
Template dialog [} 558] dialog for editing.

–

Import

Imports a template.

–

Export

Exports the selected template.
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Description

–

Delete

Deletes the selected template.

–

Refresh Templates

Refreshes the list of templates after creating a new one.

OK

Opens the selected sample carrier and closes the dialog.

Cancel

Closes the dialog without opening a sample carrier.

12.19.14.8 Edit Sample Carrier Template dialog
The dialog for editing a template and creating a new one are the same. If you create a new template the dialog fields are empty. On the right you see a live template preview of the setting for
the template and global support points.

1

2

3

1

Basic Template Settings
Here you have the basic settings for the sample carrier templates. For more information,
see Basic Template Settings [} 559].

2

Preview
Here you can see a preview of the sample carrier.

3

Global Support Points
Here you have the settings for global support points. For more information, see Global
Support Points Settings [} 560].
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12.19.14.8.1 Basic Template Settings

Parameter

Description

Name

Shows the name of your template. You can enter/ edit the name.

Category

Shows which sample carrier category the template uses. You can
choose between Slide, Multislide, Petri Dish, Multiwell, Multichamber and Custom. The category defines the overall appearance
of the template and affects the further editing possibilities of the template.

Size

–

Width

Sets the width of the sample carrier template.

–

Height

Sets the height of the sample carrier template.

Container

Depending on the category of the template you have different options for editing in this section.

–

Type

Shows if the containers of the template are rectangles or circles. If the
category is Custom you can manually set the type of containers.

–

Columns

Shows how many columns of containers the template contains.
You can not edit this field if the templates category is Slide or Petri
Dish

–

Rows

Shows how many rows of containers the template contains.
You can not edit this field if the templates category is Slide or Petri
Dish

–

Width
Height

Only available for rectangular containers.
Determines the width and height of the containers. Not active for
Slide.

–

Diameter

Only available for circular containers.
Determines the diameter of the containers. Not active for Slide.

–

Distance X

Determines the distance in x direction between the containers from
center to center. Not active for Slide and Petri Dish.

–

Distance Y

Determines the distance in x direction between the containers from
center to center. Not active for Slide and Petri Dish.

Area

–

Centered in X

Activated: The containers will be positioned centered in X direction
on the sample carrier template.

–

Centered in Y

Activated: The containers will be positioned centered in Y direction
on the sample carrier template.

Reference Point

–

Location Mode

The reference point is marked by a Yellow X in the preview.
Defines the position of the templates reference point. You can choose
between Center, Top Left, Top Right, Bottom Left, Bottom Right
and Custom. With Custom you can modify the position directly in
the schematic by dragging the yellow reference point X with the
mouse cursor.
The default position of the reference point varies with the type of carrier.
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Description

–

Position X

Only active if you have selected Custom location mode.
Sets a custom x position for the reference point of the template.

–

Position Y

Only active if you have selected Custom location mode.
Sets a custom y position for the reference point of the template.

12.19.14.8.2 Global Support Points Settings
To show the section in full, click on the arrow button

Parameter

.

Description

Global Support
Points list

–

X column

Displays the X coordinate of the support point.

–

Y column

Displays the Y coordinate of the support point.

–

Z column

Displays the Z coordinate of the support point.

–

Container column

Shows the container of the support point.
Deletes the selected list entry.

Delete
Opens the Options for editing global support points.
Options

–

Set Current Z
for Selected
Support Points

Sets the current z-value for the selected support points.

–

Delete

Deletes the selected support points.

–

Delete All

Deletes all support points.

Properties of Selected Support
Points

–

X

Sets the X coordinate of the selected support point.

–

Y

Sets the Y coordinate of the selected support point.

–

Z

Sets the Z coordinate of the selected support point.

–

Set Current Z

Sets the Z dimension to the current z position of the stage.

Distribute Support
Points

–

Columns

Sets the number of columns of support points within the template.

–

Rows

Sets the number of rows of support points within the template.
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Description

–

Distribute

Distributes the entered number of support points defined in the column and row input fields within the template. Previously defined support points will be deleted.

–

Distribute One
Support Point
for each Selected Container

Sets one support point in the center of the selected containers. Previously defined support points will be deleted.

Add by Clicking

–
Selection

Select a support point to move it.
Support points distributed by the Distribute One Support Point for
each Selected Container button can not be moved.
Add a new support point on the template preview.

–
Add

–

Keep Tool

Activated: Keeps the selected tool active.
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12.20 ZEN Connect
This module enables you to work with images from multiple sources: zoom in from the full
macroscopic view of your sample down to nanoscale details. The Correlative Workspace (CWS) is
the efficient way to analyze and correlate images from multiple sources. You can manage, correct, and align these images in 2D as well as in 3D. It works with images from SEM, FIB-SEM, Xray, light microscopes and any optical images, e.g., from your digital camera. Its sample-centric
workspace lets you build a seamless multimodal, multiscale picture of your sample. Use it to guide
further investigations and target additional acquisitions.
The module employs a novel graphical user interface concept that makes it easy to investigate all
your samples. Design a workflow tailored precisely to the complexity of your experiment, no matter whether it’s a simple task or a compound experiment. A sophisticated workflow environment
guides you all the way from the setup for automated acquisition to post processing and customized exports, and right on through to analysis.

12.20.1 Licensing of ZEN Connect
For working with ZEN Connect projects or images, you might need a separate license file.
The basic ZEN Connect functionality is available for all versions. Additionally, there are the following licenses for ZEN Connect:
Connect
This license includes the following:
§

Interactive control of stage movement from the correlative workspace

§

Export of merged project view as image

§

Movie export as fly-through videos

§

Import of third-party microscopy images powered by Bioformats

§

SerialEM export

Connect 2D Add-on
This license requires the Connect license. Additionally, it includes the following functionalities:
§

S&F calibration

§

Definition of regions of interest in the correlative workspace

§

Retrieval of defined regions of interest

Connect 3D Add-on
This license requires the Connect license. Additionally, it includes the following functionalities:
§

Control of the displayed z-position in ZEN Connect

§

Alignment of images in z-dimension

§

View two 3D stacks (requires 3Dxl license)

§

Import FIB stacks
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12.20.2 Introduction to the User Interface
1

2

3
4
5

1

Image View
Area where you interact with images. Here, for example, you can select images and align
them.
ZEN Connect provides its own 3D viewer. For more information on the user interface of
this 3D viewer, see ZEN Connect 3D View [} 564]. You can use the view tabs on the left
side of the Image View to switch between the two viewers.

2

ZEN Connect Tool
Area where you manage your projects and contained images. For more information, see
ZEN Connect Tool [} 601].

3

Button bar below Image View
Functionalities to pan, zoom, select a region, toggle region captions or view modes, and
select a carrier/holder. For more information, see Button bar below Image View [} 597].

4

Regions Tool
Displays a list of Regions of Interest which are drawn into a ZEN Connect project. For
more information, see Regions Tool [} 606].

5

View Options
Area for general view options of the Dimensions Tab [} 887] and specific view options
on the Alignment Tab [} 595]. The Alignment tab is only visible when you have entered
the mode to align images (see also Activating the Alignment Process [} 576]).
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12.20.3 ZEN Connect 3D View
1

2

3

1

3D Image View
Area where you interact with the two 3D volumes and use the options of the three tool
bars left, right, and below the Image View. For more information, see Tool bars [} 836].

2

ZEN Connect Tool
The standard ZEN Connect tool where you manage your projects and contained images.
For more information, see ZEN Connect Tool [} 601].

3

View Options
Area for general view options, like the Dimensions Tab [} 887], and the 3D specific view
options (3D Tab [} 840], Appearance Tab [} 841], and Series Tab [} 845]).
Note: The 3D specific view options do not offer all the functionality compared to the
standard 3D view in ZEN.

See also
2 Opening images in ZEN Connect 3D view [} 565]
2 Aligning images in the ZEN Connect 3D view [} 584]

12.20.4 Opening the Correlative Workspace
1. Start the software. For more information, see Starting the Software [} 17].
The software opens and ZEN Connect is available.
Note that before working with ZEN Connect, you need to create a ZEN Connect project. For
more information, see Creating a ZEN Connect project [} 565].
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12.20.5 Opening images in ZEN Connect 3D view
In the ZEN Connect 3D view you can display two z-stacks as 3D volumes and interact with them.
Note that a single image or more than two images cannot be displayed in this 3D view.
Prerequisite ü You have opened a ZEN Connect project with at least two z-stacks.
1. In the tree view of the ZEN Connect tool, select two z-stacks you want to display in the 3D
view.
Note: The order in which you select the two stacks is important! The stack selected first will
be labelled as fixed in the 3D view and the second selected stack as adjustable. Only the
adjustable one can later be aligned in the 3D view and the fixed image serves as a reference.
2. Right click and select Show in 3D. Alternatively, click on the context menu button
and select Show in 3D.
The ZEN Connect 3D view opens and displays the two selected z-stacks as 3D volumes. The two
stacks displayed in the 3D view are marked with an icon in the tree view of the ZEN Connect
tool.

See also
2 Aligning images in the ZEN Connect 3D view [} 584]

12.20.6 Non Image Data
In Zen Connect, it is also possible to import non image data into your project, have a visual representation (marker) of it in your image area, and align the position of the data marker with respect
to the images in the project. The data is listed under Non-Image Data in the tree of the ZEN
Connect tool and represented by the marker
in the image area. Per default, the marker for
this non image data is toggled invisible. To toggle data visible and invisible, see also Moving or
hiding images [} 570].

See also
2 Importing non image data [} 574]
2 Aligning non image data [} 586]

12.20.7 Project and Image Management
12.20.7.1 Creating a ZEN Connect project
Within a ZEN Connect project, in the ZEN Connect tree view, you manage your data in a project
structure tree combined with the viewer. Before acquiring or importing any images, you need to
create the ZEN Connect project. Only within a ZEN Connect project, you can use all ZEN Connect functionality.
You can open only one ZEN Connect project at a time.
Prerequisite ü You have set up the sample on the microscope.
1. In the ZEN Connect tool, press the Create button.
à The New Document Dialog [} 616] dialog opens.
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2. In the New ZEN Connect Project Setup area, select the Project Path where you want to
store the ZEN Connect project file.
3. Select the relevant data to configure the ZEN Connect project. If you select the holder/carrier now, you can change it later. Note: If you change the holder/carrier after a S&F calibration, the S&F calibration needs to be redone.
4. Click on OK.
à The ZEN Connect project is created with the project file name <Projectname>.a5proj.
Note that all new images are saved in the subordinated folder <Projectname_data>.
You can always check the path on the Acquisition tab in the Auto Save tool. Alternatively, right- click on the project container in the Center Screen Area and select Open
Containing Folder.
à In the Image View , the sample holder is displayed.

à In the ZEN Connect tool, the empty ZEN Connect project is displayed. Here, the structure of the ZEN Connect project will be displayed as soon as you acquire or import images. In the folder on your computer, the ZEN Connect project file <CWS project
name>.a5proj is generated. A <ZEN Connect project name>.a5lock is generated to prevent more than one user to work on the project at the same time. It is generated any time you load a ZEN Connect project.
à At the bottom of the Image View, a scale bar with size, the width of the field of view
(FOV), and scaling is displayed.
à You have created a ZEN Connect project.
5. Acquire an image.
à In the Project View, a new session node is created, and each acquisition is displayed.

à In the Image View, all images are displayed. They are signed with a colored frame (blue:
normal image, red: selected image).
6. When you close the project or the software, you are prompted to save the project file.
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For information on setting up holders and carriers, see Selecting and clearing carrier / holder
[} 589].
For information on the ZEN Connect Tool, see ZEN Connect Tool [} 601].
12.20.7.2 Loading a ZEN Connect project
You can load any of your ZEN Connect projects to continue with your work. You can also load
existing ZEISS Atlas 5 projects.

Info
Open first the ZEN Connect project before performing a S&F calibration.

Prerequisite ü You have created a ZEN Connect project, or an ZEISS Atlas 5 project is available. ZEISS Atlas
5 projects belong to the ZEISS ATLAS 5 software. ZEN Connect supports these formats.
1. Select File > Open, navigate to the ZEN Connect project and open it.
In the ZEN Connect Project View, the current state of the Connect project is displayed. In the
Image View, the sample holders are marked, and previously acquired images are displayed. The
current stage position is marked with a cross hair. If you want to acquire additional images to the
project, align the new session with the existing data.

See also
2 Opening or deleting a ZEN Connect project from the data storage [} 593]
12.20.7.3 Adding an image to the ZEN Connect project
You can import simple images, such as camera images or more complex images, such as a light
microscope image with overlays, into your ZEN Connect project.
You can use an imported image as a backdrop to navigate the region. You can correlate imported
images with sample holder marks, e.g., fiducials or other images through the alignment process.
The imported image is displayed according to its position in the Layers View along with any
other image in the project.
The metadata of .CZI-images are read natively and are also imported.
Prerequisite ü You have loaded a ZEN Connect project.
1. In the ZEN Connect tool in the on Project View , right-click a session and select Add image. Alternatively, for the Import button, select Add image. If you want to add an image
from ZEN Data Storage (without downloading it), right click in the Imported Data and select Add image from storage.
à You are prompted to select the image you want to add.
2. If you want to import the image as a background image (at the lowest level of the project
structure), activate the Background Image checkbox.
3. You also have the option to copy the image in a subfolder of the file where the project data
is stored before adding it to your project. Activate Copy files.
4. Click on Open.
The image is imported to your ZEN Connect project.
In the Project View, it is displayed in the tree, subordinated to Imported Data.
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If Shuttle & Find-calibration is available for the image and the image is at least in one session in
the ZEN Connect project, the image is placed in the Image View according to the Shuttle & Find
stage position. Take care that you select the correct sample holder when importing an S&F-calibrated image. The correct sample holder is the same sample holder that was used during acquisition.
If no Shuttle & Find data is available, the image is displayed centrally in the FOV of the Image
View.
To add an open image to a project, see Adding an open image to the ZEN Connect project
[} 568], and to add a dataset, see Adding datasets when adding images [} 569].
Additionally, you have the following options to import data in your ZEN Connect project:
§

Importing Data [} 572]

§

Importing Third-party images [} 572]

§

Importing a SmartFIB stack into ZEN Connect [} 573]

§

Saving an image to the data storage [} 592]

§

Importing non image data [} 574]

Note: If you import an Airyscan image, Zen Connect displays only the raw data and not the calculated Airyscan. Such images should be processed before you add them to Zen Connect. If you
want to add an unprocessed Airyscan image, a warning will appear asking if you want to continue.
Note for z-stacks: When you use the Global Z slider and are beyond the range of a certain image, only a frame for this image is displayed to show where the image is positioned.
12.20.7.4 Adding an open image to the ZEN Connect project
Prerequisite ü You have loaded a ZEN Connect project.
ü You have an open image (which is not part of the project).
1. Click on File > Add to ZEN Connect Project.
Alternatively, you can use the button
in the tool bar which is available if you customize
your application by clicking on Tools > Customize Application... > File > and double
click Add to ZEN Connect Project. This button is automatically available in the tool bar
for all users of the EM Processing Toolbox module.
The image is added to your ZEN Connect project.
Additionally, you have the following options to import data in your ZEN Connect project:
§

Importing Data [} 572]

§

Importing Third-party images [} 572]

§

Importing a SmartFIB stack into ZEN Connect [} 573]

§

Saving an image to the data storage [} 592]

Note: If you import an Airyscan image, Zen Connect displays only the raw data and not the calculated Airyscan. Such images should be processed before you add them to Zen Connect. If you
want to add an unprocessed Airyscan image, a warning will appear asking if you want to continue.
Note for z-stacks: When you use the Global Z slider and are beyond the range of a certain image, only a frame for this image is displayed to show where the image is positioned.

See also
2 Adding an image to the ZEN Connect project [} 567]
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12.20.7.5 Adding datasets when adding images
Optionally, you can add datasets to organize your imported data.
Prerequisite ü A ZEN Connect project is loaded.
1. In the Project View tree, select right-click Imported Data and select Add dataset. Alternatively, in the ZEN Connect tool, select Add dataset for the Import button.
2. Navigate to the image you want to add. Select it, and click Open.
The image is included in your ZEN Connect project, located below New dataset.
12.20.7.6 Zooming images
You can zoom images in and out of a field of view (FOV).
Zooming to
Prerequisite ü A ZEN Connect project is loaded.
1. In the Project tree View, right-click an image and select Zoom to. Alternatively, click on
the Context menu button and select Zoom to.
The image is centered in the view space of the Image View.
Zooming to 100%
Prerequisite ü A ZEN Connect project is loaded.
1. In the Project tree View, right-click an image and select Zoom to 100%. Alternatively,
click on the Context menu button and select Zoom to 100%.
The image is zoomed in the view space of the Image View to 100%.
12.20.7.7 Removing images from the ZEN Connect project
You can remove images from your ZEN Connect project. Images you acquired and added to the
project, you can also delete permanently from the disk.
Prerequisite ü You have loaded a ZEN Connect project.
1. In the Project view or in the Layer view, select the images to remove.
2. Right-click the image, and select Remove data. Alternatively, click on the Context menu
button and select Remove data. If you want to remove an acquired image, you are asked
if you also want to delete it from the disk.
The images are removed from the ZEN Connect project. If you remove all images from the
folder, the folder is removed as well. Removing data cannot be undone.

See also
2 ZEN Connect Tool [} 601]
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12.20.7.8 Renaming images in a ZEN Connect project
Prerequisite ü You have loaded a ZEN Connect project.
1. In the Project view or in the Layer view, select an image to rename.
2. Right-click, select Rename data and rename the image, or press the F2 key. Alternatively,
you can double click the image name to rename it, or click on the Context menu button
, and select Rename data.
You have renamed the image. It is updated either in the Layer or the Project view respectively.
The image name is not changed on the disk.
12.20.7.9 Opening images in ZEN
Prerequisite ü You have loaded a ZEN Connect project.
1. In the Project View or in the Layers View, select one or more images you want to open,
and right-click Open image(s) in ZEN. Alternatively, click on the Context menu button
and select Open image(s) in ZEN. Additionally, you can also simply double click on
an image in the Project View or in the Layers View.
The image is opened in ZEN and displayed on a separate tab.

NOTICE
ZEN Data Storage
If you have opened a project from ZEN Data Storage, you can also open an individual image
this way. The image is then downloaded and each change is not updated in the viewer and
the project until you upload the image again. For information on uploading an image to the
data storage, see Saving an image to the data storage [} 592].

12.20.7.10 Showing an image in the Explorer
You can locate an image on your computer.
Prerequisite ü You have loaded a ZEN Connect project.
1. In the Project View or in the Layers View, right-click an image and select Show in Explorer. Alternatively, click on the Context menu button
plorer.

and select Show in Ex-

The explorer opens and the folder with the selected image is displayed.
12.20.7.11 Moving or hiding images
In the Layers View, you can move images over and under other images, or hide them completely. In the Project View, you can hide images.
Prerequisite ü You have loaded a ZEN Connect project with at least two images.
1. To change the image order, in the Layers View, move the image by dragging it up or
down.
à In the Image View, the changed order is immediately visible.
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2. To hide the image from the ZEN Connect project, in the Layers View, activate or deactivate the image by clicking the
Eye icon on the right of the image name. Alternatively, in the Project View, right-click Show/Hide or click on the Context menu button
and select Show/Hide.
The results of your changes are displayed immediately in the Image View.

See also
2 ZEN Connect Tool [} 601]
12.20.7.12 Starting a new session
To organize your work, you can start a new session within your ZEN Connect project any time.
Prerequisite ü You have loaded a ZEN Connect project.
1. In the ZEN Connect tool, click on the Context menu button
sion.
Alternatively, click on the New Session button.

and select New ses-

A new session is activated. As soon as you acquire a new image, a new session node is created,
and the new image will be subordinated.

See also
2 ZEN Connect Tool [} 601]
12.20.7.13 Toggling view modes
In ZEN Connect you can switch between two different view modes for your projects. The default
is the carrier/ holder view mode, where the coordinate system of the correlative workspace is
aligned with the screen and images of the current system/ session might be rotated. The second is
the stage centric view mode, where the coordinate system of the current session is aligned with
the screen and the carrier/ sample holder as well as other sessions might be rotated.
Prerequisite ü You have opened a ZEN Connect project.
1. In the button bar below the Image View of the correlative workspace, click on the button
for the carrier/ holder

or the stage centric

view mode.

The view is changed according to the selected view mode.
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12.20.7.14 Closing a ZEN Connect project
You have the following options to close a ZEN Connect project:
1. Click on File > Close
2. In the Image View, click on the cross next to the ZEN Connect project name.

12.20.8 Import and Export
12.20.8.1 Importing Data
You can import simple images, such as camera images or more complex images, such as a light
microscope image with overlays, to your ZEN Connect project. For more information, see Adding
an image to the ZEN Connect project [} 567].
Alternatively, you have the option to import BioFormats into your ZEN Connect project. For more
information, see Importing Third-party images [} 572].
Note: If you import an Airyscan image, Zen Connect displays only the raw data and not the calculated Airyscan. Such images should be processed before you add them to Zen Connect. If you
want to add an unprocessed Airyscan image, a warning will appear asking if you want to continue.

See also
2 ZEN Connect Tool [} 601]
12.20.8.2 Importing Third-party images
ZEN uses BioFormats as an integrated library for reading and writing life sciences image file formats. It is capable of parsing both pixels and metadata for a large number of formats. It achieves
this by converting proprietary microscopy data into an open standard called the OME data model.
With BioFormats, you can read proprietary formats and convert them into an intermediate format,
e.g., CZI or OME-TIFF. For example, it is possible to load simple images you can import simple images, such as camera images or more complex images, such as a light microscope image with
overlays, to your ZEN Connect project.
Prerequisite ü You have licensed the Third Party Import.
1. Select File > Export/Import > BioFormats Import.
2. Navigate to the image with the proprietary image format you want to import, select it, and
click Open.
The image is converted and added to ZEN (not to the ZEN Connect project itself).
Alternatively, you have the following options to import data in your ZEN Connect project:
§

Adding an image to the ZEN Connect project [} 567].

§

Importing Data [} 572]

For more information on BioFormats, see http://www.openmicroscopy.org/bio-formats/
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12.20.8.3 Importing a SmartFIB stack into ZEN Connect
With ZEN Connect you can import SmartFIB stacks of crossbeam microscopes and align them with
data from light microscopes. The orientation of these stacks slightly differs from standard z-stack
acquisition, as the acquired images are tilted by a certain angle compared to a usual z-stack. The
import calculates this tilt from the metadata of the image. If the import finds no metadata concerning the tilt angle and the user does not enter a value, it uses a default of 90 degrees. Alternatively, you can enter the angle of your sample during import, if you know it, and the import then
calculates the tilt angle based on this sample angle.
During import, the XY offset metadata of the individual slices is ignored by default and only the
offset of the first tiff file is considered. This default avoids the creation of a slanted z-stack in case
some slices contain incorrect metadata. Activate the checkbox consider individual slice offsets
on the import dialog to change the behavior.
Prerequisite ü You have opened/created a ZEN Connect project.
1. In the Project view, select the session where you want to import the FIB stack.
2. Right click on the session and select Import SmartFIB z-stack.
Alternatively, select Import SmartFIB z-stack for the Import button.
à A file browser opens.
3. Select the images you want to import as FIB stack.
Note: Select only images which belong to one dataset!
Note: To make sure the stack is composed/ ordered correctly, watch out how the images
are sorted in the explorer and in which order you choose them.
4. You can enter a name for the FIB stack. This step is optional.
5. If you import images without scaling information, you can manually enter them as optional Z-stack XY scaling.
Note: ZEN currently cannot determine automatically if scaling information are present!
6. You can set the slice distance. This step is optional and should only be done if you have
reason to believe the information calculated with the metadata is incorrect. Leave the input
field empty and the slice distance is automatically calculated with information saved in the
metadata of the images.
Note: When you set the slice distance manually, the information in the metadata is ignored.
7. If you know the angle of your sample, enter it under optional sample angle. Otherwise
the tilt for the image is calculated with the metadata or set to the default of 90 degree (if
no information is available in the metadata).
8. If you want to consider the XY offset metadata of the individual slices for the import, activate the checkbox consider individual slice offsets. Note that this can lead to a slanted
z-stack if the metadata contain incorrect offset information!
9. Click on Open.
The FIB stack is now imported into the selected session.
Note: When importing larger image files it may take a while until the entire stack is visible in the
viewer. This also applies when you open a project that contains such larger stacks.
Note: To improve the alignment of the z-stack, the TrakEM2 format is supported. Before importing the SmartFIB z-stack, use a specific fiji script (for information, see https://imagej.net/Register_Virtual_Stack_Slices#API_documentation) that creates xml-files with TrakEM2 format within
the passed input folder. Those xml-files are then considered during the import and replace the
stage-position information with the computed pixel delta x/y shifts. Only the stage-position of the
first image is used for absolute positioning, all other images of the stack are positioned according
to this first slice and the computed shifts.
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12.20.8.4 Importing non image data
Prerequisite ü You have opened/created a ZEN Connect project.
1. In the ZEN Connect tool, select Import non-image data for the Import button.
à A file browser opens.
2. In the file browser, select your file. If the file should be copied into the data folder of the
project, make sure the checkbox Copy Files is activated (it is activated by default). If the file
should only be linked into the project, deactivate the checkbox.
3. Click on Open.
You have successfully imported the non-image data into your ZEN Connect project. The file is
listed under Non-Image Data in the tree of the ZEN Connect tool.

See also
2 Non Image Data [} 565]
12.20.8.5 Exporting single image data
You can export data of ZEN Connect projects as a single image for distribution to collaborators,
or for the use in publications. The content can be a single image, tiles, a collection of images, or a
view of the entire ZEN Connect project. You can drag or resize the region to control the area
that you want to export, or activate if image names and frames are shown on the exported image
or not. You can pan and zoom using the mouse in the Image View to get fine control of the export area.
Prerequisite ü You have loaded a ZEN Connect project.
ü In the loaded ZEN Connect project, you have activated and deactivated the respective areas
of interest.
1. In the ZEN Connect tool, open the Project View or the Layers View. Right-click an image and select Single Image Export.
Alternatively, select an image and select Single Image Export for the Export button.
à A wizard opens.
2. Make your settings and click Export Data.
3. Navigate to the folder where you want to store the exported image. The default file name
is the ZEN Connect project name. Click Save.
You have exported one image in a standard image format. The exported image is based on the
export area you set up in the Image View.

See also
2 Configure single image export wizard [} 597]
2 ZEN Connect Tool [} 601]
12.20.8.6 Exporting a Zen Connect project as a video
You can export data of ZEN Connect projects as a video.
Prerequisite ü You have loaded a ZEN Connect project.
ü In the loaded ZEN Connect project, you have activated and deactivated the respective areas
of interest.
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1. In the ZEN Connect tool, open the Project View or the Layers View. Right-click an image and select Video Export.
Alternatively, select an image and select Video Export for the Export button.
à The wizard for video export opens.
2. Choose your key frames by positioning the export area in the Image View and add them
to the list of key frames by clicking Add current view as key frame.
3. Make your settings, and click Export Data.
4. Navigate to the folder where you want to store the exported video. The default file name is
the ZEN Connect project name. Click on Save.
You have exported a video in a standard video format.

See also
2 ZEN Connect Tool [} 601]
2 Video Export wizard [} 599]
12.20.8.7 Exporting data for SerialEM
ZEN offers the functionality to export image data as a MRC file which makes it compatible to the
software application SerialEM and available for TEM users. This export is available for z-stacks and
multi channel images with all the common pixel types (8/16 Bit, 32 Bit Float, RGB 24/32/48). Tiles,
time series, multi-scene images, and images with unprocessed data or special dimensions are not
supported. For images with more dimensions, you can use the image processing function Create
Image Subset [} 112] to extract a single image or stack and then export it with this function.
The export creates a MRC file as well as a NAV file, which contains regions of interests (e.g.
points, rectangles, polygons,...). The NAV file can be loaded in the SerialEM software and it then
loads the MRC file, so that the image with the respective regions is shown.
Prerequisite ü You have opened an image in ZEN.
1. Click on File > Export/Import > MRC Export.
à A file explorer opens.
2. In the file explorer, select a folder to save the file.
3. Name the file and click on Save.
You have exported the image data as a MRC (and NAV) file.
12.20.8.8 Exporting a ZEN Connect project from the data storage
In ZEN, you can export a ZEN Connect project from the ZEN Data Storage to use it locally (e.g. on
a machine with no access to the database).
Prerequisite ü You have opened your project from the database in ZEN. For more information, see Opening
or deleting a ZEN Connect project from the data storage [} 593].
1. In the ZEN Connect tool, select Export Project... for the Export button.
2. In the file browser, select the location where you want to export your project.
3. Click on OK.
à Your project is exported to the selected location. The state of the export is displayed in
the progress bar. For each exported project a subfolder is created in the selected export
location.
You have successfully exported your project from the data storage.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

575

12 Software Modules & Extensions | 12.20 ZEN Connect

ZEISS

12.20.9 Handling of images and data
12.20.9.1 Alignment
The module Shuttle & Find allows the correlation of two images. For more information on Shuttle
& Find, see Module Shuttle & Find.
Additionally to that functionality, in a ZEN Connect project, you can manually align images in
your workspace to correct their position or size with respect to the samples. Within a ZEN Connect project, you can calibrate your system using a sample holder with fiducial markers by moving
between the markers and confirming their positions. To do so, you activate the alignment process
and start aligning image data.
12.20.9.1.1 Activating the Alignment Process
The alignment process lets you align your current session with fiducial marks or previous images.
You can align image data manually.
You should create a new session any time the alignment of the sample in the microscope has
been disturbed.
Prerequisite ü A ZEN Connect project is loaded.
1. In the Layer View, or in the Project View, select the image you want to align. Alternatively, you can select a region to select a couple of images.
à The image is marked with a square in each frame corner.

à As long as the alignment process is not activated, this is indicated with a little lock next
to the cursor.
2. Right-click the selected image and select Align Data.
Alternatively, right-click the image(s) in the ZEN Connect tool and select Align Data.You
can also select Align for the Alignment button and click it.
You have activated the alignment process for one or more images. The Alignment Tab [} 595] below the Image View is displayed.
You can start aligning image data. If you start an alignment on a session node, the set alignment
is used for all current and future images of the session. You can use this if you change your sample between different systems and want to align their coordinate systems to each other.

See also
2 ZEN Connect Tool [} 601]
12.20.9.1.2 Aligning image data
In the alignment process, you have various options to align image data. Note that you can change
the alignment mode during the alignment process. The alignment edits you have made are preserved, but you have to restart the pinning process if you have inserted any pins before changing
the mode.
Note: The alignment process can be executed multiple times. Each time you run the alignment
process, the end result of the last alignment is used as the starting point for the new alignment. If
the initial image was far out of alignment at the start, it is easiest to do the alignment process
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once roughly, and then do the alignment process a second time with more precision. The second
alignment will use the first alignment as a starting point, and will allow you to establish a more
precise alignment quickly.
Prerequisite ü You have loaded a ZEN Connect project and activated the alignment process.
1. In the Alignment tab, select one of the following alignment modes and the region you
want to align.
Translate Only
1. Click and drag with the mouse to translate the image you are aligning with respect to everything else.
à You can zoom in and out with the mouse wheel, or press and hold the CTRL key to pan
while you are in the process of aligning the image.
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Translate and Rotate Only
1. Right-click at the location you have lined up to insert the first pin, a red and grey pin icon.
The pin locks the image to the reference at this location. Press the DEL key to remove the
last pin you inserted.
à After you insert the first pin, your input will rotate the item around the first pin, when
dragging it with the mouse.
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Translate, Rotate and Scale Only
1. If one of the images is smaller than the other, you can scale it. Right-click to insert a pin,
and drag with the mouse to scale and rotate the image.
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Translate, Rotate, Scale and Shear
1. Right-click to insert a second pin, and drag with the mouse to shear the image.
à After you insert the second pin, your input will also stretch and shear the item.

Image data from microscopes should not need to be stretched or sheared to perform alignment.
If you need to provide much input after inserting the second pin, this might be an indication of
other problems, such as equipment calibration issues.
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Alignment Handles
1. If you select Alignment Handles, you can use handles to rotate, translate, and scale the
image.

Flipping the image horizontally and vertically
You can flip your image, to mirror it.
§

To flip the image horizontally, click on the Flip Horizontally button

§

To flip the image vertically, click on the Flip Vertically button

§

To flip the image stack in z direction, click on the Flip in Z button

.

.
.

Reset alignment
1. Click on the Reset button to reset the alignment you performed.
à The alignment is reverted as it was when you started aligning. The alignment mode ist
still activated.
Cancel alignment
1. Click on the Cancel button to reset the alignment you performed.
à The current alignment is cancelled and reverted to the alignment in place before you
started the alignment mode. The alignment mode is not activated any longer.
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Finish alignment
1. Click on the Finish button to finish the alignment mode and to save the alignment information.
Clear alignment
1. Click on the Clear button.
à The session is restored to it’s un-aligned state.

See also
2 Aligning images in z direction [} 582]
2 Rotating a z-stack [} 584]
2 Alignment Tab [} 595]
12.20.9.1.3 Aligning images in z direction
In ZEN Connect you can not only align your images/ sessions in x and y direction, but also in z.
Prerequisite ü You have opened a ZEN Connect project containing images/ z-stacks with z information.
1. Select the image or session you want to shift in z direction.
2. In the ZEN Connect tool, select Align for the Alignment button and click it. Alternatively,
right click on the image and select Align Data.
à The Alignment Tab [} 595] is displayed below the Image View.
3. For Alignment Mode select 3D Alignment in the dropdown list.
4. For Relative Z Offset set the value for your shift in z direction.
5. Click on Finish.
You have now aligned your data in z direction. For an illustration of the alignment see Example
for z alignment [} 583].
Note that for the z alignment the view of the aligned stack remains the same, whereas the view
of the other stacks changes.
Setting an image to the current Global Z
You can also set the center of a z-stack to the currently selected z-position of the Global-Z slider.
Prerequisite ü You have opened a ZEN Connect project containing images/ z-stacks with z information.
1. Activate the Global-Z slider and move to the z-position where you want your image to be
placed.
2. Select the image you want to shift in z direction.
3. In the ZEN Connect tool, select Align for the Alignment button and click it. Alternatively,
right click on the image and select Align Data.
à The Alignment Tab [} 595] is displayed below the Image View.
4. For Alignment Mode select 3D Alignment in the dropdown list.
5. On the Alignment tab, click on the Set to current Global-Z button.
6. Click on Finish.
You have now set the center of your z-stack to the currently selected Global-Z.
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12.20.9.1.3.1 Example for z alignment
This chapter serves as an illustration of how and what is happening for z alignment in ZEN Connect. Consider the following situation:

This image illustrates two z-stacks with five planes and different z coordinates (with µm as unit).
The green line simulates the position of the Global-Z slider. Here, the Correlative Workspace
would show you plane 1 of the first stack and an empty frame where the second stack would be
because the Global-Z is beyond the range of the second stack.
Aligning Stack 2 in z direction
Now the second stack is aligned according to the workflow described in Aligning images in z direction [} 582] with a Relative Z Offset of 3µm. The result then is the following:

All z planes of Stack 2 are shifted by 3µm and now the z-plane 1 of Stack 1 and z-plane 3 of Stack
2 would be visible in the Correlative Workspace.
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Aligning the whole session in z direction
Now the whole session with both images is shifted with a Relative Z Offset of 4µm.

Now the first stack is out of range of the Global-Z slider, so the Correlative Workspace would
show you plane 1 of Stack 2 and an empty frame where Stack 1 is located.

See also
2 Using the Global-Z slider [} 591]
12.20.9.1.4 Rotating a z-stack
In the alignment mode you can also perform a three dimensional rotation of a z-stack.
Prerequisite ü You have opened a ZEN Connect project.
1. Select the z-stack you want to rotate.
2. In the ZEN Connect tool, click on Align. Alternatively, right-click the image and select
Align Data.
à The Alignment Tab [} 595] below the Image View is displayed.
3. For Alignment Mode, select 3D Alignment.
4. Activate the checkbox Apply 3D Rotation.
à The Manipulation Controls for rotation are activated.
5. Use the respective sliders or input fields to rotate the z-stack around the x, y, or z axis. Alternatively, you can use the View Cube Control to rotate the stack interactively.
6. Click on Finish.
You have now rotated the selected z-stack around the respective axis.
12.20.9.1.5 Aligning images in the ZEN Connect 3D view
With the ZEN Connect 3D view you can display and align two z-stacks as 3D volumes. You can rotate and translate the volume in this 3D view.
Note: You can only align one of the volumes, which is classified as adjustable. The other volume, classified as fixed, cannot be aligned. Which volume is the fixed and which the adjustable
one depends on the selection in the tree view when you open the 3D view (see also Opening images in ZEN Connect 3D view [} 565]) and can be seen in the Dimensions tab option Selected
Image.
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Translating the 3D volume in x and y direction
Prerequisite ü Two z-stacks are opened in the ZEN Connect 3D view.
1. On the Dimensions tab, for Selected Image choose the volume which is considered as
the adjustable image.
2. On the left tool bar, click on the arrow button
.
3. In the image view, continuously press the middle mouse button and move the mouse to
shift the volume in x and y direction.
4. When the volume is in the desired position, stop pressing the mouse button.
5. Click on Apply in the tool bar below the image view to apply the changes to the project.
You have now shifted the 3D volume in x and y direction and applied the changes to the project.
Translating the 3D volume in z direction
Prerequisite ü Two z-stacks are opened in the ZEN Connect 3D view.
1. On the Dimensions tab, for Selected Image choose the volume which is considered as
the adjustable image.
2. On the left tool bar, click on the arrow button
.
3. In the image view, continuously press the right mouse button and move the mouse to shift
the volume in z direction.
4. When the volume is in the desired position, stop pressing the mouse button.
5. Click on Apply in the tool bar below the image view to apply the changes to the project.
You have now shifted the 3D volume in z direction and applied the changes to the project.
Rotating the 3D volume
Prerequisite ü Two z-stacks are opened in the ZEN Connect 3D view.
1. On the Dimensions tab, for Selected Image choose the volume which is considered as
the adjustable image.
2. On the left tool bar, click on the arrow button
.
3. In the image view, continuously press the left mouse button and move the mouse to rotate
the volume.
4. When the volume is in the desired position, stop pressing the mouse button.
5. Click on Apply in the tool bar below the image view to apply the changes to the project.
You have now rotated the 3D volume and applied the changes to the project.
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12.20.9.1.6 Aligning non image data
Prerequisite ü You have opened a ZEN Connect project with non image data.
ü Your non image data is toggled visible, see also Moving or hiding images [} 570].
1. In the ZEN Connect tool or in the image view, right-click the non image data and select
Align Point Position. Alternatively, in the ZEN Connect tool, select the non image data
and select Align for the Alignment button and click it.
à You enter the alignment mode.
2. In the image area, click at the position where you want to place the none image data.
3. Click on Finish.
You have aligned your non image data.

See also
2 Non Image Data [} 565]
12.20.9.1.7 Aligning images in the Manual Alignment Wizard
Prerequisite ü You have opened a ZEN Connect project.
1. In the correlative workspace or in the ZEN Connect tool, select the image(s) you want to
align.
2. In the ZEN Connect tool, for the Alignment button, select Manual Alignment Wizard
and click on it.
à The ZEN Connect Alignment Wizard [} 608] opens.
3. To translate the selected image(s), set the distance in x and y direction with the Translate
parameter section on the left.
à The translation is immediately displayed in the Image View.
4. To scale the image, set the scaling factor in x and y in the Scale section.
à The scaling is adjusted according to the input.
5. To rotate the image, first select the Rotation Center and then enter an Angle. The current
rotation center is represented in the image by a pin.
à The selected image(s) is/are rotated.
6. To flip/mirror the image horizontally, click on

.

7. To flip/mirror the image vertically, click on
.
8. If you want to shear your image, activate Enable.
à Additional shearing pins are displayed in the image. The two pins that form the "baseline" for shearing a connected by a line.
9. Use the two pins to position the baseline and then move the pinpoint to shear the image.
10. Click on Finish to save the alignment and close the wizard.
You have aligned the selected image(s) in the ZEN Connect project.

NOTICE
Alignment Handles
You can also use the alignment handles of the selected image(s) to translate, scale, and rotate
the image.
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NOTICE
View Options
You can use the available options of the Dimensions tab [} 887] to adjust the image view (e.g.
use the Global-Z slider). The image which is adjusted by the Dimensions tab can be selected
in the tree view of the Select Node For Dimensions tab.

See also
2 Using the Global-Z slider [} 591]
12.20.9.1.8 Aligning images in the Point Alignment Wizard
Prerequisite ü You have opened a ZEN Connect project.
1. In the correlative workspace or in the ZEN Connect tool, select the image(s) you want to
align.
2. In the ZEN Connect tool, for the Alignment button, select Point Alignment Wizard and
click on it.
à The ZEN Connect Point Alignment Wizard [} 610] opens.
3. In the list on the left, use the
button to add as many points as necessary for your
point alignment.
With one point only a translation operation is possible, with two translation and rotation,
and three or more points enable all transformations.
4. In the Algorithm dropdown list, select the alignment operations you want to perform.
5. Click on Draw for the first point.
à You enter the drawing mode for the first point.
6. In the Image Window on the left, click to set the point in your image(s) (Subject point).
7. In the Project Window on the right, click to set the corresponding location for this point
in the project (Reference point).
à Both color makers in the table are green and the first point for the alignment is set successfully.
8. Repeat these three steps for every point you add/need.
9. If you want to redraw a point pair, click on Redraw and click to set the new positions in
both windows.
10. Click on Next.
à The second step of the wizard opens. It displays a preview of the final alignment result
and values for the parameter changes.
11. If you want to change the alignment, click on Back to get back to the previous step. Otherwise, click on Finish to save the alignment and close the wizard.
You have aligned the selected image(s) in the ZEN Connect project.
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12.20.9.2 Zooming to Extent
Prerequisite ü You have loaded a ZEN Connect project.
1. In the button bar below the Image View, click the
Alternatively, click on the Context menu button

Zoom to Extent icon.
and select Zoom to extent.

In the Image View, the sample holder is centered. All images in the ZEN Connect project are
displayed.

See also
2 ZEN Connect Tool [} 601]
12.20.9.3 Panning & Zooming
1. In the button bar below the Image View, click the
Pan & Zoom icon.
à With your mouse you can pan and zoom in and out in the Image View.
Shortcut for panning
1. Press the mouse wheel and move the image. Alternatively, press the Alt key and left click
the image.
You can use panning without having to click the Pan & Zoom icon.

See also
2 Button bar below Image View [} 597]
12.20.9.4 Selecting region
You select a region to later apply the Alignment Mode to the image contained in this region.
Prerequisite ü You have loaded a ZEN Connect project.
1. In the button bar below the Image View, click the Select Region icon. Alternatively, press
the CTR key, and click the desired image in the Project View.
à The image in the selected region is activated.
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In the ZEN Connect tool, both in the Project view and in the Layers view, the image within
the selected region is highlighted.
12.20.9.5 Toggling the display of region caption and frame
For a better overview, you can toggle the display of the image name and of the frame of images
in the Image view of your ZEN Connect project .
Prerequisite ü You have loaded a ZEN Connect project.
1. To toggle the region caption, in the button bar below the Image View, click the A button.
The region caption of the images are displayed or hidden.
12.20.9.6 Selecting and clearing carrier / holder
The sample is usually mounted on a carrier or directly on a sample holder. Select the appropriate
sample holder for your configuration when you configure your project.
We offer specific sample holders and carriers with certain markers, e.g., "L"-markers or others.
These CorrMic sample holders are necessary for a Shuttle & Find workflow. Note: If you change
the holder/carrier after a S&F calibration, the S&F calibration needs to be redone.
Prerequisite ü You have loaded a ZEN Connect project.
1. In the button bar below the Image View, click the Select Carrier / Holder button.
2. Select a template you want to add to your ZEN Connect project, and click OK.

à The frame of the selected template is displayed in the Image View of your ZEN Connect project.
3. To deselect the carrier / holder, click the Select Carrier / Holder drop down list and select
Clear / Carrier Holder.
For information on correlative sample holders, see Correlative Sample Holders [} 496].

See also
2 Select Template Dialog [} 594]
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12.20.9.7 Grabbing an image
You can create an image from the loaded ZEN Connect project.
Prerequisite ü You have loaded a ZEN Connect project.
1. In the button bar below the Image View, select the Grab Image button.
à A new tab opens. In the Image View, the grabbed image is displayed.
2. Right-click and save the image to your computer.
You have saved the image. It is not part of your ZEN Connect project.
12.20.9.8 Using Regions of Interest in Zen Connect
ZEN Connect offers the functionality to draw and delete Regions of Interest in a project. The regions are shown in the project and listed in the Regions Tool [} 606] and they are saved and
loaded together with the project.
Drawing a Region of Interest
Prerequisite ü You have loaded a ZEN Connect project.
1. In the button bar below the Image View, click on the
2. Draw a rectangular region into your project.

button.

The Region of Interest is displayed in your project.
Deleting a Region of Interest
Prerequisite ü You have loaded a ZEN Connect project with Regions of Interest.
1. In the Regions tool, select your region in the list and click on the
Alternatively, right-click on your region of interest and select Delete.

button.

The selected region is deleted.
Renaming a Region of Interest
Prerequisite ü You have loaded a ZEN Connect project with Regions of Interest.
1. In the Regions tool, select your region in the list and click on the
2. Enter a name for the selected region and press Enter.

button.

The region is renamed according to your input.
Zooming to a Region of Interest
Prerequisite ü You have loaded a ZEN Connect project with Regions of Interest.
1. In the Image View or the list of the Regions tool, right-click on the Region of Interest and
select Zoom To.
The view zooms to the selected region.
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12.20.9.9 Using the Global-Z slider
In ZEN Connect you can use a mode called Global-Z if you have a project with at least one zstack. In this mode, you can change the displayed z plane of all z-stacks in the project with only
one slider, the Global-Z slider. The range of the slider is comprised of the z values of all stacks in
the project. The displayed slice for each stack is always the one closest to the value set by the
Global-Z slider, as long as the value is within the boundaries of the entire stack. When you use
the Global Z slider and are beyond the range of a certain z-stack, only a frame is displayed to
show where the stack is positioned.
Note: If you have selected a particular z-stack, the Global-Z and Z-Position sliders are interdependent. Changing the value with one slider updates the other slider as well.
Prerequisite ü You have opened a ZEN Connect Project with z-stacks.
1. Activate the Global-Z checkbox on the Dimensions tab.
2. Use the slider or the input field to set a global value for z.
All the slices closest to the set value are displayed for all z-stacks. Z-stacks which are out of range
are illustrated by an empty frame.

12.20.10 ZEN Data Storage
You can store your data on your computer's file system. Additionally, you have the option to save
your projects and images in a database called ZEN Data Storage. This makes the information more
accessible, as you can search within the database and filter your results. The data storage is an additional product which has to be installed. For more information, refer to the installation guide of
ZEN Data Storage.
To activate the access and use of the database, go to Tools > Modules Manager and activate
Data Storage Client. Afterwards please restart the software.
12.20.10.1 Setting up the ZEN Data Storage
After the installation of ZEN Data Storage (for information see the respective installation guide),
you have to set up the server in ZEN (blue edition). This setup has to be done once on every machine using the data storage.
Prerequisite ü You have installed ZEN Data Storage.
ü You are logged in as an administrator (if you use ZEN with user management).
ü In Tools > Modules Manager, the Data Storage Client is activated.
1.
2.
3.
4.

Click on Tools > Options > Settings.
Under Document Server Url, enter the url of your ZEN Data Storage server.
Click on Server Setup.
Click on Yes to confirm the message and setup ZEN Data Storage.
à The server is set up in ZEN and a setup dialog opens.
5. Click on Close to exit the setup dialog.
6. Click on OK to close the Tools > Options dialog.
You have successfully set up your ZEN Data Storage server in ZEN.

See also
2 Storage Settings Tab [} 646]
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12.20.10.2 Saving an image to the data storage
You can save any image to the data storage. You can also open images from the data storage,
update them, and save the updated image to the data storage.
Prerequisite ü You have opened an image.
1. Click on File > ZEN Data Storage > Save Image.
The image is saved to the data storage.
12.20.10.3 Saving a ZEN Connect project to the data storage
You can save existing ZEN Connect projects that are currently saved on your computer to the data
storage. If you save a project with images, the image information is contained in the Project
View. You can check it in the Layers View.
Optionally, you can create a new project and save it immediately to the data storage.
Prerequisite ü You have loaded a ZEN Connect project that is saved to your computer, or you are in the
process of creating a new Connect project.
1. Click on File > ZEN Data Storage > Save ZEN Connect Project.
The ZEN Connect project is saved to the data storage.

See also
2 Saving an image to the data storage [} 592]
12.20.10.4 Opening or deleting an image from the data storage
1. Click on File > ZEN Data Storage > Open Image.
à The Stored Documents dialog is displayed.
2. Double-click the image you want to open. Alternatively, select the image and click on
Open.
The Stored Documents closes and the image is loaded in ZEN.
Deleting an image from the data storage
Prerequisite ü You have opened the Stored Documents dialog.
1. Right-click the image you want to delete, and click on Delete document.
à You are prompted to confirm the operation.
2. Click on Yes.
The image is deleted from the data storage.

See also
2 Stored images in the data storage [} 607]
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12.20.10.5 Opening or deleting a ZEN Connect project from the data storage
Prerequisite ü You have saved a ZEN Connect project to the data storage. For more information, see Saving
a ZEN Connect project to the data storage [} 592].
ü If your ZEN Connect project is saved to your computer, open it from there, and save it to the
data storage. For more information, see Loading a ZEN Connect project [} 567].
1. Click on File > ZEN Data Storage > Open ZEN Connect project.
à A list with stored documents is displayed.
2. Select the ZEN Connect project and click on Open.
In the ZEN Connect Project View, the current state of the project is displayed. In the Image
View, the sample holders are marked and previously acquired images are displayed. Note that the
project including its images is linked in the data storage. So please take care that these files are
not moved or deleted as the links will be broken.
The current stage position is marked with a cross hair.
Deleting a Connect project from the data storage
Prerequisite ü You have opened the Stored Documents dialog.
1. Right-click the project you want to delete and click on Delete document.
à You are prompted to confirm the deleting.
2. Click on Yes.
The ZEN Connect project is deleted from the data storage.

See also
2 ZEN Connect Tool [} 601]
2 Stored Connect projects in the data storage [} 606]
12.20.10.6 Configuring the Stored Documents table
In the Stored Documents dialog, you select Connect projects or images to open or to delete.
You can configure the columns of the table according to your needs.
1. Click on File > ZEN Data Storage > Open ZEN Connect Project or File > ZEN Data
Storage > Open Image.
à The Stored Documents dialog opens.
2. Right-click into the header of the table and activate the columns you want to see in the table.

See also
2 Stored Connect projects in the data storage [} 606]
2 Stored images in the data storage [} 607]
12.20.10.7 Filtering Connect projects and images in the data storage
Prerequisite ü A ZEN Connect project is available in the data storage.
1. Click on File > ZEN Data Storage > Open ZEN Connect Project or File > ZEN Data
Storage > Open Image.
à The Stored Documents dialog opens.
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2. Click on the Options button
.
à The search area with filter panel and metadata of the search results is displayed, e.g.,
Smartzoom 5. The number in brackets indicates the amount of search results.

3. To limit the search results, select a term of interest.
à The available images are displayed accordingly.
4. Optionally, enter a term you are looking for in the Search field, e.g., the file name.
The available images are displayed accordingly.

See also
2 Stored images in the data storage [} 607]

12.20.11 Functions & Reference
12.20.11.1 Select Template Dialog
In the Select Template Dialog, you select carriers and holders.

Parameter

Description

Celldiscoverer

Only available for celldiscoverer application.
Shows a list of celldiscoverer sample holders.

Tiles

Shows a list of all generic sample holders.

Correlative

Shows a list with all relevant correlative sample holders.

See also
2 Selecting and clearing carrier / holder [} 589]
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12.20.11.2 Alignment Tab
The alignment tab is visible, as soon as you enter the alignment mode. For more information, see
Activating the Alignment Process [} 576].
You can perform Three-Point Alignment:
§

Line-up an imported image with reference marks, such as the precision fiducials on a CorrMic
Holder.

§

Line-up features in an imported image with LM, EM and SEM images of the same features.

§

Line-up a session of LM, EM and SEM imagery with previously acquired LM, EM and SEM imagery session.

With the three-point alignment process you can set the position, rotation, and scale of an image
or tile. This is used to line the image or tile up with reference marks or other images. Once an image is lined up, it can be used as a reference (road map) to move the stage to control further image acquisition.

Parameter

Description

Alignment Mode

Sets which data properties you can change during the alignment.

-

Translate Only

Moves the item you are aligning in x and y only without changing its
size or orientation.

-

Translate and
Rotate Only

Moves the item in x and y direction and changes its orientation. It
does not change the scale of the item you are aligning.

-

Translate, Rotate and Scale
Only

Moves, reorients, and resizes the item you are aligning. It does not
shear it.

-

Translate, Rotate, Scale and
Shear

Supports full three-point alignment.

-

Alignment Handles

Displays alignment handles to rotate and resize the image.

-

3D Alignment

Displays options to align an image in z direction and for three dimensional rotation.
Mirrors the image in the horizontally.

Flip Horizontally
Mirrors the image in the vertically.
Flip Vertically
Mirrors the image stack in z direction around the middle z-height.
Flip in Z
Relative Z Offset

Only visible if 3D Alignment is selected.
Sets the z offset for the selected image.

Step Size

Only visible if 3D Alignment is selected.
Sets the step size for the Relative Z Offset input.

Set to current
Global-Z

Only visible, if 3D Alignment is selected and only active if the
Global-Z slider is activated on the Dimensions tab.
Sets the z value of the currently selected Global-Z as the z value for
the center of the z-stack.
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Parameter

Description

Apply 3D Rotation

Only visible, if 3D Alignment is selected.
Enables the controls below for the three dimensional rotation of the
z-stack.

-

Rotation X-Axis

Sets the rotation along the x-axis with the slider or input field. Click
on the
button to reset the angle.

-

Rotation Y-Axis

Sets the rotation along the y-axis with the slider or input field. Click
on the
button to reset the angle.

-

Rotation Z-Axis

Sets the rotation along the z-axis with the slider or input field. Click
on the
button to reset the angle.

-

Angle Step Size

Sets the angle step size for the slider/input fields above.

-

View Cube Control

With this cube control, you can rotate the stack interactively. It has a
visual representation of the current stack (white box) and the cutting
plane which is displayed in the 2D view above.

-

Presets

Sets the View Cube Control to a predefined position. You can set it
to the Default, or you can select an orientation from the dropdown
of the button to show the Default, Viewer Perspective, Left, or
Right orientation.

-

Manual Control

Controls the orientation of the View Cube Control.

Reset

Resets the alignment as it was when you started this alignment operation.

Clear

Resets the alignment to where it was when the data was first acquired or imported.

Finish

Exits from the alignment operation, keeping the alignment you have
established.

Cancel

Returns to the alignment as it was when you started, and exits from
the alignment operation.

See also
2 Aligning image data [} 576]
2 Aligning images in z direction [} 582]
2 Rotating a z-stack [} 584]
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12.20.11.3 Button bar below Image View

1

2

3

4

Parameter

5

6

7

8

9

Description

1

Zoom To Extent

Resets the view space of the Image View to be centered on the holder
with a field of view (FOV) that includes all visible images in the
project.
For more information, see Zooming to Extent [} 588].

2

Pan & Zoom

Activates the mouse for panning around and zooming in and out in
the Image View.
For more information, see Panning & Zooming [} 588].

3

Select Region

Selects an image/ a region in the Image View.
For more information, see Selecting region [} 588].

4

Create Region
of Interest

Creates a Region of Interest in the Image View.
For more information, see Using Regions of Interest in Zen Connect
[} 590].

5

Toggle Region
Captions

Hides or displays image names and frames of images in the Image
View.
For more information, see Toggling the display of region caption and
frame [} 589].

6

Select Carrier /
Holder

Opens a dialog to select a carrier or sample holder that matches.
For more information, see Selecting and clearing carrier / holder
[} 589].

7

Stage Centric
View Mode

Activates a stage centric view mode where the coordinate system of
the current session is aligned with the screen and the carrier/sample
holder as well as other sessions might be rotated.
For more information, see Toggling view modes [} 571].

8

Carrier/ Holder
View Mode

Activates the carrier/holder view mode where the coordinate system
of the correlative workspace is aligned with the screen and images of
the current session might be rotated.
For more information, see Toggling view modes [} 571].

9

Grab Image

Creates an image of the ZEN Connect project.
For more information, see Grabbing an image [} 590].

12.20.11.4 Configure single image export wizard
With the Configure single image export wizard, you configure the parameters of the image
you want to export.

Parameter

Description

Color Style

Controls the color format of the export. Select RGB (color) or Intensity (black and white).

-

Based on the RGB (Red-Green-Blue) color model. Be aware that color
files may be up to three times as large as intensity files.

RGB
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Description

-

Images are saved in 8-bit format.

Intensity

ZEISS

Export Format

Selects the format for the exported file. Only the file formats that support the number of pixels you are exporting will be shown. If your export is too large, formats like BMP, JPG and TIFF are not displayed. If
you wish to export to one of these formats, you must pick a larger
pixel size, or smaller export area for your export.

-

Raw image

Exports the image as a raw binary dump of the pixel values. A XML
file is also written detailing the image width and height in pixels, the
pixel size in microns, the bits per sample and samples per pixel. Raw
files are not limited in size.

-

CZI image (Single Channel)

Exports the image as a Carl Zeiss Image file. CZI files are not limited in
size. The images are exported in a single channel CZI.

-

CZI image
(Multi-Channel)

Exports the image as a Carl Zeiss Image file. CZI files are not limited in
size. The images are exported as a multi-channel CZI.
Note that the resulting image might look different when reopened in
ZEN than it does in ZEN Connect.

-

Tif image

Exports the image as a standard TIFF file. TIFF files are limited in size.

-

Tif tiles

With this option, the export is in TIFF format, but broken into 2K x 2K
tiles saved as individual TIFFs. An XML file is written listing the file
names of the tiles and their positions. This export option is unlimited
in size, but designed for someone who is writing scripts to import the
data into image processing applications or similar.

-

Bitmap image

Exports the image as a standard Windows Bitmap. Bitmap files are
limited in size.

-

Jpg image

Exports the image as a standard JPEG file. JPEG files are limited in size.

Show Data Bar

Burns the currently configured data bar into the exported image. Activate the Show Data Bar checkbox.

Show Region Caption

Controls if image names and frames are shown in the exported image.

Rotation

Rotates the view to the desired orientation. Drag the slider, or in the
text field, type in the value.

Pixel Size

Sets the pixel size of the export. Type the pixel size in the Pixel Size
field. The smaller the pixel size, the more disk space your export will
take. Click the 1:1 button to reset the pixel size to the native resolution.

Width (px)

Width value to directly alter the export pixel counts and export area
(the pixel size is unchanged).

Height (px)

Height value to directly alter the export pixel counts and export area
(the pixel size is unchanged).

Width (µm)

The full width of the export area in µm.

Height (µm)

The full height of the export area in µm.

Approx. Data Size

The actual file size after export may be less than the listed data size
based on compression in some file formats.
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Parameter

Description

Export Data

Starts the export with your settings.

Finish

Saves the changes and closes the wizard.

Cancel

Closes the wizard without saving the changes.

ZEISS

For more information on exporting single images, see Exporting single image data [} 574].
12.20.11.5 Field of View Width dialog

Parameter

Description

FOV Width

Displays the current width of the field of view and allows you to enter
a value.

OK

Sets the width to the entered value.

Cancel

Closes the dialog box without setting the field of view.

12.20.11.6 Pixel Size dialog

Parameter

Description

Pixel Size

Displays the current pixel size and allows you to enter a value.

OK

Sets the pixel size to the entered value.

Cancel

Closes the dialog box without setting the pixel size.

12.20.11.7 Video Export wizard

Parameter

Description

Burn in Data Bar

Burns the currently configured data bar into the exported video.

Show Region Caption

Controls if the image names are shown in the exported video.

Show Region Outline

Controls if the image frames are shown in the exported video.

Export Resolution

Sets the resolution and format for the video export.
Resolutions available in the drop down list:
§ 320 x 240 (4:3)
§ 428 x 240 (16:9)
§ 640 x 480 (4:3) (=default value)
§ 854 x 480 (16:9)
§ 960 x 720 (4:3)
§ 1280 x 720 (16:9)

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

599

12 Software Modules & Extensions | 12.20 ZEN Connect

Parameter

ZEISS

Description
§ 1440 x 1080 (4:3)
§ 1920 x 1080 (16:9)

Zoom to Extent

Places the image to the center of the preview area.

Rotation

You can use the slider or the input field to rotate the view.

Start Delay

Sets the delay at the start of the video. The default setting is 1,0 seconds.

Key Frames

Lists the key frames, including the data of the position and FOV.

Move Up
Move Down
Delete key

Moves the selected key frame up in the list.
Moves the selected key frame down in the list.
Deletes the selected key frame.

frame
Go to key

Displays the selected key frame.

frame
Reset key
frame to current
view

Sets the values of the selected key frame to the current view.

Options

–

Load Export Key
Frames

Loads stored key frames.

–

Save Export Key
Frames

Saves the key frames in XML format.

Transit To

Sets the transition time for zooming to a selected key frame. The default setting is 3,5 seconds.

Pause At

Sets the time to stay at the selected key frame. Default setting is 0,5
seconds.

Return to first at
end

Returns to the first key frame at the end of the video.

Add current view
as key frame

Adds the current view as a key frame.

Preview export

Displays a real-time preview of the video.

Export Data

Exports and saves the video.

Finish

Saves the changes and closes the wizard.

Cancel

Cancels the video export.

See also
2 Exporting a Zen Connect project as a video [} 574]
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12.20.11.8 ZEN Connect Tool
The ZEN Connect tool provides a layers view and a tree view of image data that you have acquired for the ZEN Connect project. Every image that you have acquired for the ZEN Connect
project is listed. As you acquire or import more image data, the new image data will be listed in
the views.
The ZEN Connect tool offers different options to open a ZEN Connect project or to create a
new ZEN Connect project.

Alternatively, you can create a new ZEN Connect project via File > New Document. For more
information, see New Document Dialog [} 616].
The ZEN Connect tool displays the following:
§

Images that have been acquired for the ZEN Connect project.

§

Images that have been imported for the ZEN Connect project.

§

Position of the image in the project or the layers.
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12.20.11.8.1 ZEN Connect Project tree view

1
2
3

4
5

Fig. 47: Tree view: ZEN Connect project (Example)

1

Sample holder
Here: Custom Carrier 1

2

Imported Data
Subordinated, the data added to the ZEN Connect project is displayed. These images
are not acquired within the Connect project.

3

On top, the session node is displayed. It contains the following information. Subordinated, the acquired images are listed.
Here: LM (Microscope)
Here: 20190326 (Date <yyyymmdd>)
Here: 125358 (Time <hhmmss>)
Here: New-01-02 (Image taken in this session)

4

Image Information
Displays the objective magnification with which an image was acquired (here: 40x). Additionally, the icon is displayed for a z-stack image.

5

Z-Stacks which are opened in the ZEN Connect 3D view [} 564] are displayed with another icon in the tree view.
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12.20.11.8.2 ZEN Connect Project Layer view

1
2

Images in your ZEN Connect project are displayed in the Image View according to its position in
the Layers View. With drag & drop, you can move images over and under other images. You can
also hide them completely
. For more information, see Moving or hiding images [} 570]. Additionally, you can see the objective magnification with which the image was acquired and if an
image is a z-stack

.

12.20.11.8.3 Button bar

Parameter

Description

Change Opacity

Changes the opacity of layers. A layer’s overall opacity determines to
what degree it obscures or reveals the layer beneath it. A layer with
1% opacity appears nearly transparent, whereas one with 100%
opacity appears completely opaque.

Alignment

Only available if you have selected one or more images or a session.
Starts the currently selected alignment operation for the selected image(s) or session. Click on the arrow button to select an alignment.

–

Align

Activates the alignment process for the selected data.
For more information, see Activating the Alignment Process [} 576].
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Description

–

Align system

Activates the alignment process for the current microscope session.
For more information, see Activating the Alignment Process [} 576].

–

Manual Alignment Wizard

Opens the ZEN Connect Manual Alignment Wizard [} 608] for manual
alignment. For more information, see also Aligning images in the
Manual Alignment Wizard [} 586].

–

Point Alignment
Wizard

Opens the ZEN Connect Point Alignment Wizard [} 610].
For more information, see also Aligning images in the Point Alignment Wizard [} 587].

Import

Starts the currently selected operation to add and/or import an image.
Click on the arrow button to select an import operation. For more information, see also Importing Data [} 572].

–

Add image

Opens a explorer to add an image. For more information, see Adding
an image to the ZEN Connect project [} 567].

–

Add image
from storage

Opens a window to add an image from the ZEN Data Storage. For
more information, see Adding an image to the ZEN Connect project
[} 567].

–

Import non-image data

Opens the file browser to select non-image data for an import. For
more information, see also Importing non image data [} 574].

–

Import SmartFIB
z-stack

Imports a SmartFIB z-stack.
For more information, see Importing a SmartFIB stack into ZEN Connect [} 573].

–

Add dataset

Adds a dataset.
For more information, see Adding datasets when adding images
[} 569].

Export

Starts the currently selected operation to export an image. Click on
the arrow button to select an export operation.

–

Single Image
Export

Exports the selected data in one single image.
For more information, see Exporting single image data [} 574].

–

Video Export

Exports the selected data as a video.
For more information, see Exporting a Zen Connect project as a video
[} 574].

–

Export Project

Opens a file browser to export your current ZEN Connect project.
For more information, see also Exporting a ZEN Connect project from
the data storage [} 575].

New Session

Creates a new session.
For more information, see Starting a new session [} 571].

Context menu

–

Zoom to

Zooms one or more selected images into the center of the Image
View.
For more information, see Zooming images [} 569].
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Description

–

Zoom to 100%

Zooms to the selected image in the Image View and displays it at
100% scale.
For more information, see Zooming images [} 569].

–

Show/Hide

Toggles the image/session between being shown or being hidden.
For more information to hide images, see Moving or hiding images
[} 570].

–

Open image(s)
in ZEN

Opens the selected image(s) in ZEN.
For more information, see Opening images in ZEN [} 570].

–

Open Attachment

Only available for non-image data.
Opens the attached file in the respective application.

–

Show in Explorer

Locates an image or file on your computer.
For more information, see Showing an image in the Explorer [} 570].

–

Remove Data

Removes the selected image from the ZEN Connect project, but does
not delete it from the computer.
For more information, see Removing images from the ZEN Connect
project [} 569].

–

Delete

Only visible for non-image data.
Deletes the file from the project and from the project folder. If the file
was added as a link, only the link in the project is deleted.

–

Rename Data

Renames an image.
For more information, see Renaming images in a ZEN Connect project
[} 570].

–

Align Data

Aligns data of the two selected images.
For more information, see Aligning image data [} 576].

–

Single Image
Export

Exports the selected data in one single image.
For more information, see Exporting single image data [} 574].

–

Video Export

Exports the selected data as a video.
For more information, see Exporting a Zen Connect project as a video
[} 574].

–

Add image

Opens a explorer to add an image. For more information, see Adding
an image to the ZEN Connect project [} 567].

–

Add image
from storage

Opens a window to add an image from the ZEN Data Storage. For
more information, see Adding an image to the ZEN Connect project
[} 567].

–

Import SmartFIB
z-stack

Imports a SmartFIB z-stack.
For more information, see Importing a SmartFIB stack into ZEN Connect [} 573].

–

Show in 3D

Only available if two images are selected in the tree view.
Opens the two images in the ZEN Connect 3D viewer.
For more information, see Opening images in ZEN Connect 3D view
[} 565].

–

New Session

Starts a new session. The images acquired next will be subordinated
below a new session node.
For more Information, see Starting a new session [} 571].
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Description

–

Clear alignment

Resets the alignment and places the selected image at its initial position.

–

Zoom to extent

Resets the view space of the Image View to be centered on the
holder with a field of view (FOV) that includes all visible images in the
project.
For more information, see Zooming to Extent [} 588].

–

Export Project

Opens a file browser to export your current ZEN Connect project.
For more information, see also Exporting a ZEN Connect project from
the data storage [} 575].

–

Import non-image data

Opens the file browser to select non-image data for an import. For
more information, see also Importing non image data [} 574].

12.20.11.9 Regions Tool
This tool displays a list of Regions of Interest which are drawn into a ZEN Connect project.

Parameter

Description
Deletes the Region of Interest selected in the list.

Delete

Rename

Allows the user to rename the Region of Interest which is currently selected in the list.

See also
2 Using Regions of Interest in Zen Connect [} 590]
12.20.11.10 Stored Connect projects in the data storage
You can configure the table according to your needs. For more information, see Configuring the
Stored Documents table [} 593]. You can also filter data of stored documents. For more information, see Filtering Connect projects and images in the data storage [} 593].

Parameter

Description

Search

Searches the database for the term entered in the text field.

File name

Displays the name of the ZEN Connect project. You can sort the file
names alphabetically.

File Size

Displays the file size.

Created Date

Displays the creation timestamp.

Last Access

Displays at what date the image was last opened.

Comment

Displays a comment.

Cancel

Closes the dialog.
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Parameter

Description

Open

Opens the Connect project.
For more information, see Opening or deleting a ZEN Connect project
from the data storage [} 593].

12.20.11.11 Stored images in the data storage
Double-click to open the image. For more information, see Opening or deleting an image from
the data storage [} 592].
You can configure the table according to your needs. For more information, see Configuring the
Stored Documents table [} 593]. You can also filter data of stored documents. For more information, see Filtering Connect projects and images in the data storage [} 593].

Parameter

Description

Search

Searches the database for the term entered in the text field.
Displays a filter panel with metadata.

Options
Preview

Displays the preview of the image.

File Name

Displays the file name and the format of the image. You can sort the
file names alphabetically.

Original File Name

Displays the original file name in case you have uploaded the image
as a third party image with the ZEN Data Storage Uploader.

File Size

Displays the file size.

Software Application

Displays with which software application the image was acquired.

Software Application Version

Displays the version of the software application.

Created Data

Displays the creation day.

Last Change

Displays at what date the image was last changed.

Comment

Displays a comment.

Microscope Name

Displays the name of the microscope.

System Name

Displays the system name.

Objective Name

Displays the name of the objective.

Objective Magnification

Displays the objective magnification.

Reflector

Displays the reflector.

Channel Name

Displays the name of the channel.

Camera Name

Displays the name of the camera.

Scaling

Displays the scaling.
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Parameter

Description

Imaging Light
Source Name

Displays the name of the imaging light source.

Z-Slider

If the image contains a z-stack, with the slider you can select a single
z-slice.

T-Slider

If a time series is contained in the image, with the T-slider you can select a certain point of time.

12.20.11.12 ZEN Connect Manual Alignment Wizard

1

2

3

1

Alignment Parameter
Control parameters to align the respective image in the project. For more information,
see Alignment Parameter section [} 609].

2

Image View
Displays the images of the project and allows alignment of images.

3

View Options
Here you have the general options of the Dimensions tab [} 887]. The options are always
those of the image selected in the Select Node For Dimensions tab.

See also
2 Aligning images in the Manual Alignment Wizard [} 586]
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12.20.11.12.1 Alignment Parameter section

Parameter

Description

Translate

–

Step Size

Sets the step size for the translation in x and y.

–

X-Direction

Sets the translation in x direction. The reset button
value to the default.

resets the

–

Y-Direction

Sets the translation in y direction. The reset button
value to the default.

resets the

Scale

–

X-Direction

Sets the scaling factor in x direction. The reset button
value to the default.

resets the

–

Y-Direction

Sets the scaling factor in y direction. The reset button
value to the default.

resets the

Rotate

–

Rotation Center

Defines the rotation center around which the image is rotated. It is indicated in the Image View with a pin.

–

Angle

Sets the rotation angle. The reset button
default.

–

Custom

You can set the pin in the image to your custom rotation center.

resets the value to the

Flip/Mirror
Mirrors the image in horizontal direction.

–
Horizontally

Mirrors the image in the vertical direction.

–
Vertically
Shear

–

Enable

Activated: Activates the shearing mode and displays the three shearing pins in the image.

–

Reset Shearing
Pins

Resets the pins to the default location.

Reset All Parameters

Resets all alignment parameters in the wizard to the default values.

Parameter

Description

Finish

Saves the changes and closes the wizard.

Cancel

Closes the wizard without saving.

See also
2 Aligning images in the Manual Alignment Wizard [} 586]
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12.20.11.13 ZEN Connect Point Alignment Wizard
This wizard guides you through a three-point alignment of the image in your ZEN Connect
project.

See also
2 Aligning images in the Point Alignment Wizard [} 587]
12.20.11.13.1 Step 1: Setup Points

1

2

3

1

Point Alignment Options
Options to configure your point alignment. For more information, see Point Alignment
Options [} 610].

2

Image Window
Displays the image(s) you are aligning. Area where you set the reference points.

3

Project Window
Displays all the images of the project except the one you are aligning. Area where you
set the subject points.

See also
2 Aligning images in the Point Alignment Wizard [} 587]
12.20.11.13.1.1 Point Alignment Options

Parameter

Description

Point list

–

Name

Displays the name of the point.
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Subject

ZEISS

Description
Displays the status of the subject point with a color.
§ Yellow: You are in drawing mode and have not yet set the subject
point in the Image Window.
§ Green: You have set the subject point.

–

Reference

Displays the status of the reference point with a color.
§ Red: You have not yet set the subject point and cannot set the subject point.
§ Yellow: You are in drawing mode and have not yet set the reference point in the Project Window.
§ Green: You have set the reference point.

–

Draw

Only visible if no points have been drawn for the current point entry.
Enters the drawing mode for the respective point.

–

Cancel

Only visible if you are in drawing mode.
Cancels the drawing of points for the current point.

–

Redraw

Only visible if you have already drawn the reference and subject point
for this entry.
Reenters the drawing mode to redraw the points for this entry.
Adds another point entry in the list.

–
Add

–
Delete
Algorithm

Deletes the currently selected list entry and removes all drawn points
of the entry.
Selects the algorithm for alignment. The algorithm is preselected
based on the number of positioned points.

–

Autoselect

Automatically selects the algorithm suitable for the drawn points.

–

Translation

Moves the item you are aligning in x and y only, without changing its
size or orientation.

–

Translation and
Rotation

Moves the item in x and y direction and changes its orientation. It
does not change the scale of the item you are aligning.

–

Translation and
Scale

Moves and resizes the item you are aligning.

–

Allow all transformations

Supports all possible transformations.

Parameter

Description

Next

Moves on to the next step of the wizard.

Finish

Saves the changes and closes the wizard.

Cancel

Closes the wizard without saving.

See also
2 Aligning images in the Point Alignment Wizard [} 587]
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12.20.11.13.2 Step 2: Preview
This step displays a preview of the finished alignment and the parameter values of each alignment.

Parameter

Description

Algorithm Result

Displays the resulting alignment changes.

Translation

Displays the resulting translation in X-Direction and Y-Direction.

Rotation

Displays the resulting rotation angle around the z-axis.

Scaling

Displays the resulting scaling factor for the X-Dimension and Y-Dimension.

Back

Moves to the previous step of the wizard.

Finish

Saves the changes and closes the wizard.

Cancel

Closes the wizard without saving.
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13 Software Functions & Reference
13.1 Menus
13.1.1 File Menu
Menu item

Description

Short
cut

New Document

Opens the New Documents selection dialog. You can
create new images or new tables. For more information, see New Document [} 616].

Ctrl +
Shift+N

New Image

Open an empty image container in the center screen
area into which you can snap an image, for example.

Ctrl+N

Open...

Opens the Open Document dialog window. Here you
can select the file you want to open.

Ctrl+O

Save

Saves the selected file.

Ctrl+S

Save As CZI

Saves the selected file under a new name. In case of an
image only .czi file format can be used.

Ctrl
+Shift+S

Save As with Options...

Saves the selected file under a new name. Advanced
options can be selected:
File type: czi, jpeg, jpg, png, tif, tiff, bmp, gif, wmp,
wdp
Compression (only for czi and jpg/jpeg):
§ Original: The image keeps the compression of the
original image.
§ Uncompressed: The image is saved without compression.
§ Compressed (JPEG XR): An uncompressed image
will be compressed with the selected quality. A compressed image keeps the compression.
§ Force Compression (JPEG XR): A compressed image will be decompressed and compressed with the
selected quality.
Zoom Level (only for pyramid images): Different zoom
levels can be selected, depending on the image pyramid.
Set as default: Sets the selected options as default
saving options.

Rename

Opens the Rename dialog window. Enter a new name
for the file. Confirm the entry with Yes.

Delete

Deletes the selected file.

Export/Import

§ Export
Opens the image processing function Image Export
[} 207] to export an image.
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Description

Short
cut

§ Movie Export
Opens the image processing function Movie Export
[} 195] to export images in the form of film sequences.
§ OME TIFF Export
Opens the image processing function OME TIFF Export [} 200] to export images into OME TIFF format.
§ ZVI Export
Opens the image processing function ZVI Export
[} 203] to export images into ZVI format.
§ MRC Export
Exports image data into the MRC format, which is
compatible to SerialEM. It also creates a NAV file,
which stores positions of interest. For more information, see Exporting data for SerialEM [} 575].
§ Import
Opens the image processing function Image Import
[} 204] to create a multidimensional image (multichannel, Z-stack, time lapse, tile, position image)
from individual images.
§ BioFormats Import
Imports third-party images using BioFormats as an
integrated library for reading and writing life sciences image file formats. For more information, see
Importing Third-party images [} 572].
§ Import TXM
Opens the image processing function Import TXM
[} 206] to import a txm file to ZEN.
Send to arivis Vision
4D

This function is only available, if arivis Vision 4D is installed and has a valid license.
When using this command, Vision 4D opens and the
current image is imported into Vision 4D. The current
display settings in ZEN are preserved as much as possible.
Note: special CZI image types such as ApoTome raw
images, Airyscan raw images, or some other image
types are not always supported in Vision 4D. In these
cases convert them into normal processed images before sending them to Vision 4D for further analysis.

Add to ZEN Connect
Project

Adds the image to the currently opened ZEN Connect
project.

Send to ZEN Black

The software installation includes a copy of ZEN
Black. In some cases it might be necessary to transfer
images from the software to ZEN Black to make use
of special functions found only in ZEN Black.

Close

Closes the selected file.

Save All

Saves all open files.

Open File Browser

Opens the file browser in the Center Screen Area.
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Menu item

Description

Open Containing
Folder

Opens the folder in which the selected file is located.

ZEN Data Storage

Only available if you have a connection to ZEN Data
Storage and the module is activated in Tools > Options.

Short
cut

§ Open ZEN Connect Project
Displays a dialog to open a Connect project from
data storage.
§ Save ZEN Connect Project
Saves the current Connect project to the data storage.
§ Open Image
Displays a dialog to open an image from data storage.
§ Save Image
Saves the current image to the data storage.
Recent Files...

Opens the Recent Files dialog window. The Recent
Files dialog displays the files you have used previously,
separated according to file type.

Recently Opened
Files

Opens a list containing the file paths of recently
opened files.

Print Preview

Opens the Print Preview [} 617] dialog for the selected
file.

Login

Opens the Login dialog window.

Tiles

Opens a submenu with functions associated with the
tiles tool. Here, parameters can be imported and exported.

Ctrl+R

Ctrl+F2

§ Export Tiles Experiment
Opens a dialog to export the current Tiles experiment either to an XML or a CSV file.
§ Import Tiles Experiment
Opens a dialog to import a Tiles experiment either
from an XML or a CSV file.
§ Import Stage Marks
Imports the existing positions from the Stage Tool
(Marks) as single positions in the Tiles experiment.
§ Import Preview Image
Imports an existing image document as a preview
image into the Navigation/Tiles view. This function
is also available with right mouse-click in the Tiles Advanced Setup view.
§ Save Preview Images
Saves existing preview/snap images into a separate
image document.
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Description

Short
cut

§ Extract Sample Carrier Template
Opens a dialog to extract the current sample carrier
template from the Tiles experiment as a new template with the calibrated dimensions.
Exit

Exits the software.

Alt+F4

See also
2 Image Export [} 207]
13.1.1.1 New Document Dialog
Here you can create different types of new, empty documents (images, tables, and ZEN Connect
projects).
Select the desired document type and click on OK. The image or table will be generated and
opened in the current workspace.

Parameter

Description

Images

Creates a new, empty image file (*.czi).

Tables

Creates a new table (*.czt).
The following elements are only visible if you have clicked on the Tables button:

-

Document
name

Here you can enter the name of the new table-document.

-

Columns

Enter the number of columns that you want the new table to have in
the input field.

-

Rows

Enter the number of rows that you want the new table to have in the
input field.

-

Column Name

Here you can enter the title of the column.

-

Column type

Here you can select the desired data type of a column. The following
types are available:
§ String
§ Integer
§ Real

-

Default Value

ZEN Connect
Project

Here you can enter a default value that you want the column cell to
contain.
Creates a ZEN Connect project. For more information, see Creating a
ZEN Connect project [} 565].
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13.1.1.2 Print Preview Dialog

Parameter

Description

Printer

Here you can select the printer that you want to use.

Properties

Opens a dialog window containing the printer properties. Here you
can configure advanced settings. This dialog window is dependent on
the printer.

Format

Here you can select the page format e.g. A0 to A6, Letter or A4 Register.

Width

Displays the width of the page according to the chosen format.

Height

Displays the height of the page according to the chosen format.

All pages

Activated: Prints all pages of the report.

Selected Pages

Activated: Prints a certain number of pages of the report.
In the input field to the right, enter the pages that you want to print.
Example:The entry 1-3; 5 prints pages 1,2,3 and 5.

Pages per sheet

Here you can select how many pages you want to print on one sheet.

Number of copies

Here you can enter the number of copies that you want to print.

Collated

Only active if you have chosen to print several copies.
Activated: Sorts the pages of each copy printed.

Auto fit

Activated: Adjusts the size of the report or image to the size of the
page.

Scale pages

Activated: Adjusts the size of the report or image to the factor set in
the input field to the right. Here you can set the desired enlargement/
reduction factor for the report or image.
A factor of 100% corresponds to the Auto fit option.

Print

Prints the report using the options set.

Down
Up
Auto fit

Displays the next page.
Displays the previous page.
Here you can select the zoom factor with which the page view is displayed in this dialog.

13.1.2 Edit Menu
Menu item

Description

Short
cut

Undo

Undoes the last action.

Ctrl+Z

Redo

Redoes the last action.

Ctrl+Y

Cut

Cuts the selected graphic element out of the image.

Ctrl+X
Shift
+Del
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Menu item

Description

Short
cut

Copy

Copies the selected graphic element.

Ctrl+C
Ctrl+Ins

Paste

Inserts the copied graphic element into the image.

Ctrl+V
Shift+Ins

Delete

Deletes the selected element.

Del

Select All

Selects all graphic elements drawn into the image.

Ctrl+A

Display

Here you can manage image display settings. Functions
include copy, paste, export or import of the display settings.

ROI (Region of Interest) | Draw Region of
Interest

Draw a certain rectangular region that is of particular
interest to you into the image. The ROI is displayed
with red boundaries. You can draw several regions into
an image.

Ctrl+U

ROI (Region of Interest) | Draw Rotatable
Region of Interest

Draw a certain rectangular region that is of particular
interest to you into the image. This region can be rotated and is displayed with yellow boundaries. You can
draw several regions into an image.

Ctrl
+Shift+R

ROI (Region of Interest) | Create Subset
Images from ROI

Creates new image documents from the selection regions you have drawn in. All dimensions of the image
are taken into account here. This function works for
both the non rotatable and rotatable ROIs (the red and
the yellow regions).

Ctrl
+Shift+C

Create Image from
View

Creates an image from the current view.

13.1.3 View Menu
Menu item

Description

Zoom

Here you can configure various zoom settings.

Player

Here you can navigate through a Z-stack or a time series image.

Text View

Displays the text name of a file in the Document bar.

Small Thumbnail View

Displays a small preview image and the name of a file in the
Document bar.

Large Thumbnail View

Displays a large preview image and the name of a file in the
Document bar.

1 Container

Displays one image container in the Center Screen Area.

2 Containers

Displays two image containers in the Center Screen Area.

3 Containers

Displays three image containers in the Center Screen Area.

Automatic Container Layout

Uses the predefined container layout.
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Menu item

Description

Shared View Controls

General and specific view controls are shared for all containers and are active for the currently selected image container.

Separate View Controls

Each container has its own separate general and specific view
controls that become active when the associated image container is selected.

Show All (Global)

Activates the Show All mode in every tool.

Show Macro Environment

Activates the Macro Tool [} 804] in the Right Tool Area. If
you have licensed the Macro Environment module, the
Macro menu appears in the Menu bar. The Macro Environment is deactivated by default.

13.1.4 Acquisition Menu
Menu item

Description

Short cut

Locate Snap

Acquires a single image with the
active camera.

F2

Locate Live

Shows a live image from the active camera in the Center Screen
Area. On the Locate tab the
Live mode is activated.

Shift+F2

Acquisition Snap

Executes only if you have defined
at least one channel on Acquisition tab in the Channels tool.
Acquires and displays all the defined channels as an overlay.

Acquisition Live

Executes only if you have defined
a channel on Acquisition tab in
the Channels tool.
Uses the currently selected channel for a live image.

Set Exposure

Executes only if you have defined
a channel on Acquisition tab in
the Channels tool.
Executes an exposure time calculation for the active camera.

Set White Balance

Executes a white balance measurement.

Find Focus

Executes the Software Autofocus
Running. On the Acquisition tab
the Find Focus mode is activated.

Start Experiment

Only active, if you have configured an experiment on Acquisition tab.
Starts a defined experiment.
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Menu item

Description

Stop Experiment

Only active, if you have started an
experiment on Acquisition tab.
Stops a running experiment.

Pause Experiment

Only active, if you have started an
experiment on Acquisition tab.
Pauses a running experiment.

Continue Experiment

Only active, if you have paused
an experiment on Acquisition
tab.
Continues the paused experiment.

Dual Camera Calibration
Wizard…

Only visible if a dual camera configuration is active.

Short cut

Starts Dual Camera Calibration
Wizard.
ApoTome Phase Calibration Wizard…

Only visible if a ApoTome configuration is active.
Starts ApoTome Phase Calibration Wizard.

ApoTome Focus Calibration Wizard…

Only visible if a ApoTome configuration is active.
Starts ApoTome Focus Calibration Wizard.

13.1.5 Graphics Menu
Menu item

Description

Short cut

Select

Starts the selection mode.

Alt+F1

Draw Region of Interest

Allows you to draw in a region of interest (ROI).

Crtl+U

Text

Allows you to add a text field to the image.

Scale bar

Allows you to add a scale bar to the image.

Line

Allows you to add a line to the image.

Arrow

Allows you to add an arrow to the image.

Rectangle (aligned)

Allows you to add an aligned rectangle to the
image.

Circle (Diameter)

Allows you to add a circle to the image.

Ellipse

Allows you to add a ellipse to the image.

Contour (Spline)

Allows you to add a contour (spline) to the image.

Profile

Adds an intensity profile along a drawn in arrow region.
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Menu item

Description

Rectangle Profile

Adds an intensity profile within the drawn in
rectangle region.

Scaled Profile

Adds an intensity profile with an scaling bar to
the image.

Grid

Activated: Adds a grid to the image.

Frequent Annotations

Adds frequently used annotations to the image,
e.g. Relative Time, Channel Name.

Distance

Adds distance annotations to the image, e.g.
Length, Curve length.

Multiple Distances

Allows you to add annotations for measuring
multiple distances to the image.

Region

Allows you to add region annotations to the
image, e.g. Contour, Rectangle.

Circle

Allows you to add circle annotations to the image.

Angle

Allows you to add angle annotations to the image.

Points

Allows you to add points of interest (POI) to the
image such as events or markers.

Format

Allows to open the dialog for formatting
graphical elements. Also you will find options
for resetting customized graphical elements.

Burn-in Annotations...

Creates a new image with all annotations
burned-in to the image.

Show Bounding Box

Shows bounding boxes around graphics/annotations.

Hide Bounding Box

Hides bounding boxes around graphics/annotations.

Bring to Front

Brings selected graphic/annotation to the front
of the image.

Send to Back

Sends selected graphic/annotation to the back
of the image.

Bring Forward

Brings selected graphic/annotation one layer
forwards.

Send Backwards

Sends selected graphic/annotation one layer
backwards.
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13.1.6 Macro Menu

Info
This menu is available only if you have licensed the Macro Environment module.
§

Activate the Macro Environment controls in the View menu by klicking on Show Macro
Environment.

Menu item

Description

Record a New macro

Starts recording a new macro.

Stop Recording

Stops recording the macro.

Macro-Editor…

Opens the Macro Editor Dialog [} 622].

13.1.6.1 Macro Editor Dialog
The macro editor represents the IDE (Integrated Developer Environment) to edit, execute, debug
and manage macros. It is started via the menu Macro > Macro Editor or from the Macro tool in
the Right Tool Area.
1
2
3

4

5

6

1

Menu bar
For a detailed description of the menus, please read Macro Editor Menus [} 623].

2

Tool bar
With the icons you can quickly access the most important functions, like saving or editing
macros.

3

Button bar
Here you find the buttons to record and control macros. For more information, see Button Bar [} 625].

4

Macro list
Displays all macros and folders. The macros can be moved into a different folder via drag
and drop. Macros and folders can be edited via right-click context menu, see also Macro
List Context Menu [} 625].
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5

Code Window
The central area of the Macro Editor shows the program code of the selected macro. Edit
and write your macros in here. You can either use the Record button or type in the program code directly. Also a multi-document view is available, meaning that you can open
several code windows at once.

6

Watch/ Message Window
Here you can observe variables of the macro program code. Enter the variable directly in
the column Name. You can also mark the variable in the macro and add it using Add
Watch of the right mouse key context menu.
The Message window displays messages when using the print command in a macro.

13.1.6.1.1 Macro Editor Menus
File Menu

Menu item

Description

New Macro

Opens the New Macro in the Macro programming
area.

Import

Opens a file browser to select and import a macro.

Save

Saves the selected macro.

Save As…

Saves the macro under a new name.

Rename…

Opens the Rename dialog window. Enter a new name
for the macro.

Delete

Deletes the selected macro.

Close

Closes the selected macro.

Short
cut

Ctrl+S

Edit Menu

Menu item

Description

Short
cut

Cut

Cuts the selected line out of the macro.

Ctrl+X
Shift
+Del

Copy

Copies the selected line in the macro.

Ctrl+C
Ctrl+Ins

Paste

Inserts the copied line into the macro.

Ctrl+V
Shift+Ins

Find

Finds the entered text.

Ctrl+F

Replace

Replaces the detected text with the new text..

Ctrl+H

Undo

Undoes the last action.

Ctrl+Z

Redo

Redoes the last action.

Ctrl+Y
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Record Menu

Menu item

Description

Record

Starts recording.

Stop Recording

Stops the recording of the active macro.

Debug Menu

Menu item

Description

Short
cut

Start Debugging

Starts the debugger and executes the macro up to a
breakpoint or error.

F5

Start Without Debugging

Executes the macro up to a breakpoint or error without
debugging.

Ctrl+F5

Pause

Pauses debugging.

Shift+F5

*Continue (DEBUG)

Continues debugging.

Shift+F5

Stop

Stops the running macro at the active command.

Shift+F5

Step Into

Starts the debugger stepwise, command by command,
without stepping into function blocks.

F11

Step Over

Starts the debugger stepwise, command by command,
and steps into function blocks.

F10

Step Out

Starts the debugger stepwise, command by command,
and steps out of function blocks.

Shift
+F11

Toggle Breakpoint

Sets/removes a breakpoint in the active line to stop/
continue the macro in debug mode.

F9

Set Line To Execute

Sets the pointer in the next active command line.

F8

Reset

Resets all variables of the Python interpreter.

Help Menu

Menu item

Description

Short
cut

Contents...

Opens the Online Help dialog.

Ctrl+F1

Macro Object
Model…

Opens the Macro Object Model Online Help dialog.
This documentation includes descriptions of all objects
available for the macro editor.

Forum…

Opens the OAD forum in your web browser.
Internet access required.

GitHub

Opens the ZEISS GitHub page for OAD in your web
browser.
Internet access required.
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13.1.6.1.2 Button Bar
On this bar you find the buttons to record and control macros.

Parameter

Description

New

Creates a new empty macro.

Record

Starts macro recording.

Run

Executes the active macro completely.

Debug

Starts the debugger and executes the macro up to a breakpoint or error.

Step Over

Starts the debugger stepwise, command by command, without stepping into function blocks.

Step Into

Starts the debugger stepwise, command by command, and steps into
function blocks.

Step Out

Starts the debugger stepwise, command by command, and steps out
of function blocks.

Pause

Pauses macro recording.

Stop

Stops the running macro at the active command.

Reset

Resets all variables of the Python interpreter.

Breakpoint

Sets/removes a breakpoint in the active line, to stop/continue the
macro in debug mode, in the active line.

Set Line

Sets the pointer in the next active command line.

Run to cursor

Sets the pointer to the current cursor position.

13.1.6.1.3 Macro List Context Menu
Folder menu
This context menu is only displayed if you right-click a folder in the Macro list.

Parameter

Description

Add Macro

Adds a new macro to the folder.

Add Folder

Adds a new subfolder.

Rename

Allows renaming the folder.

Delete

Deletes the folder.

Replace with Content

Deletes the folder and moves all macros in the folder into the next
higher folder.

Expand All

Only available for folder on the top level.
Expands all (sub-)folders.

Collapse All

Only available for folder on the top level.
Collapses all (sub-)folders.
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Macro menu
This context menu is only displayed if you right-click a macro in the Macro list.

Parameter

Description

New

Creates a new macro.

Save

Saves the current changes.

Save as

Saves the macro with a new name.

Rename

Allows renaming the macro.

Delete

Deletes the macro.

13.1.7 Tools Menu
Menu item

Description

Axio Scan Calibration…

Only available for Axio Scan systems.
Opens the Axio Scan Calibration wizard. By the wizard you
can calibrate the following functions:
§ mapping of the preview camera to the scan camera,
§ parfocality of the objectives,
§ parcentricity of the objectives.
§ shading correction of the optical system (including fluorescence) and color calibration.
It is not necessary to execute all steps, e.g. the shading correction for fluorescence and the color calibration can be
skipped.

Diagnostics

Opens the Diagnostics dialog. There you receive detailed reports on your entire system state.
Ctrl+Shift+D

Kitchen Timer…

Opens the Kitchen Timer dialog. There you can set a time
period after which an alert is played.

Dosimeter…

Opens the Dosimeter dialog. There you can set multiple time
points at which an alert is played.

Dye Editor…

Opens the Dye Editor Dialog [} 55].

Extension Manager…

Opens the Extension Manager dialog.

Modules Manager…

Opens the Modules Manager [} 627] dialog.

Users and Groups...

Opens the Users and Group Management [} 627] dialog.

Settings Editor...

Opens the Settings Editor dialog.
Select from existing hardware settings or adopt the settings
from the hardware being used into the software. You can
also transfer settings from the software to the hardware that
you are using.

System Maintenance and
Calibration...

Opens the System Maintenance and Calibration dialog.
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Menu item

Description

Calibration Manager…

Opens the Calibration Manager dialog.

Customize Application…

Opens the Customize Application [} 627] dialog.

Scaling…

Opens the Scaling [} 629] dialog.

Sample Carrier/Holder
Templates…

Opens the Sample Carrier Templates dialog.

Options…

Opens the Options Dialog [} 631].

13.1.7.1 Modules Manager Dialog
Here you can activate or deactivate the modules for which you currently own a license. Note that
all the changes made here are implemented immediately.

Parameter

Description

Available Products

Here you can see the products available for your license. Click on the
relevant button to select the product.

Included Modules

In this list you can activate/deactivate the modules that are included
with your product.
Activate the checkbox to activate the corresponding module.

Optional Modules

In this list you can activate/deactivate the modules that you have licensed as an option for your product.

Optional Hardware

In this list you see the hardware that you have configured.

Select All

Activates all available modules.

Unselect All

Deactivates all available modules.

Save Information...

Saves the current selection of modules within a .txt file.

13.1.7.2 User and Group Management Dialog
Here you can create new users and groups and manage their access rights.
Activate the user and group management by activating the checkbox Enable User Management. For more details read also the chapter Managing Users and Groups.

See also
2 Creating a new user [} 37]
2 Adding users to a group [} 38]
2 Managing access rights for user groups [} 40]
13.1.7.3 Customize Application Dialog
Here you can customize the application layout, e.g. adopt the toolbar or shortcuts.
To learn more about how to customize the application, read the chapter Customizing Toolbar
[} 237].
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Toolbar Tab
Here you can add menu items to the Toolbar as buttons for a quick access.

Parameter

Description

Available Toolbar
items

In this list you see all menu items that you can add to the Toolbar.

Add
Selected Toolbar
Items

Adds a selected item to the tool bar. It then appears in the Selected
Toolbar Items list.
In this list you see all the added menu items. Select the items here in
order to sort them.
Deletes a selected item from the Selected Toolbar Items list.

Delete
Up

Moves a selected item one position up in the Selected Toolbar
Items list.

Down

Moves a selected item one position down in the Selected Toolbar
Items list.

Separator

Inserts a vertical separator into the Toolbar after the currently selected item of the Selected Toolbar Items list.

Close

Closes the Customize Application dialog and saves the adjustments.

Shortcuts Tab

Parameter

Description

Available Commands

In this list you see all commands from the Menubar and edited
Macros. Klick on the arrow on the left of the entry to show available
commands.

Shortcut for the
selected item:

If you have selected a command from the Available Commands list,
the related shortcut is displayed here.
If the field is empty, no shortcut yet exists for the selected command.

Remove

Deletes a shortcut of the selected command.
Default shortcuts, e.g. Strg+S can not be removed.

Type a shortcut

Here you can type in a shortcut by clicking on the desired keys of your
keyboard.
If a shortcut is already used for another command, it is displayed in
the Shortcut is used by: display field.

Add

Adds a shortcut to a chosen command.

Shortcut is used
by:

If you typed in a shortcut which is already used, the related command
is displayed here.

All commands
with shortcuts:

In this list you see all the shortcuts and their related commands.

Close

Closes the Customize Application dialog and saves the adjustments.
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Soft Keys Tab

Parameter

Description

Available Items list

In this list you see all items from the Menubar, Hardware Settings
and edited Macros. Klick on the arrow on the left of the entry to
show available items.

Soft Keys

The items from the Available Items list can be assigned to the buttons Function0-Function9 via drag & drop.

Reset All

Resets all the adjustments.

Close

Closes the Customize Application dialog and saves the adjustments.

13.1.7.4 Scaling Dialog

Fig. 48: Scaling Dialog
Here you can specify how your images are scaled.

Parameter

Description

Active Scaling:

Shows the scaling that is set currently.

Units

Select the desired unit for the current scaling here.
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Parameter

Description

Select Automatically

Activated: Calculates the scaling automatically from the microscope
and camera configuration.

Scaling

Select scalings which are stored on your system e.g. Pixel, Theoretic.
The scaling details will be displayed in the fields below the list. If a display field is empty, it will not be used in the calculation of the scaling.

Options

By clicking on the you can perform the following actions :

-

Activate Scaling

Activates the selected scaling. The scaling will be applied to all images
that are acquired from this time point onward.

-

Assign Scaling
to Image

Assigns the selected scaling to the current image.

-

Import

Opens the Import Scaling dialog window. Here you can select a scaling file (.czsc) that you want to import.

-

Export

Opens the Export Scaling dialog window to export the selected scaling. Select the folder in which you want the exported scaling file to be
saved and specify a file name (.czsc).

-

Delete

Deletes the selected scaling.

Interactive Calibration...

Opens the Open file for interactive scaling dialog, if there is no image yet selected.
Starts the Scaling Wizard [} 630] in the Center Screen Area for the
currently selected image.

13.1.7.4.1 Scaling Wizard
Here you can create a new scaling. To do this, draw a reference line with a predefined length in
the current image. An image of a calibration slide is best suited for this purpose.

Fig. 49: Scaling Wizard

Parameter

Description

Tool Bar

Here you can draw in two types of reference line. Therefor klick on
one of the following buttons.
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Parameter

Description

-

If selected, the courser is in selection mode. You can move the dialog
window or select a reference line to edit it.

Select

-

-

Draw Reference
Line

This tool is selected by default.

Draw Parallel
Reference Line

With that tool you draw in two parallel lines along a distance with a
known length. The two parallel lines correct errors in the parallel axis
resulting from the drawing of the lines. A third, corrected line is
drawn in automatically from which the scaling is determined.

With that tool you draw in a line along a distance with a known
length (e.g. using an object micrometer or calibration slide). Then you
can adjust the length and units in the input field and dropdown list.

Automatic Line
Detection

Activated: Automatically detects individual lines of the scale bar in
the image close to the interactively defined distance. Using this
method the centers of the lines are determined exactly, increasing the
precision of the scaling.

Length input field

Here you must enter the length of the line you have drawn in.

Unit selection

Here you must select the corresponding unit of your drawn in line.

Scaling

Shows the calculated pixel scaling according to the drawn in line.

Name

Here you can enter the name for the scaling that will be created.

Save Scaling

Saves the scaling that has been created under the specified name. The
scaling can be selected in the Scaling dialog under Available Scalings.

13.1.7.5 Options Dialog
Here you can configure the settings for general software options.
13.1.7.5.1 General Tab

Parameter

Description

Select Automatically

Activated: Automatically selects the user language of the operating system as the user language for the software.

Fixed Language

Select the language from the dropdown list in which the software will be run next time it is started.

13.1.7.5.2 Startup/Shutdown Tab

Parameter

Description

Show Splash
Screen

Activated: Displays the splash screen when the software starts.

Show Application
Selection

Activated: Shows the application selection dialog when the software
starts.
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Parameter

Description

Reload Last Used
Documents

Activated: Reloads all image documents, that were open when you
last exited the system when the software starts.

Experiment

Selects the desired bahaviour on system start up with regard to the
experiment management on the Acquisiton tab.

-

Load default
experiment

Loads an experiment with the set default values.

-

Load empty
experiment

Loads an empty experiment.

-

Load last used
experiment

Loads the last used experiment.

Request Stage/Focus Calibration on
Startup

Activated: Shows a message which asks you to perform stage/focus
calibration.

13.1.7.5.3 Naming Tab
Here you can specify how images are (automatically) named and indexed. Changes will be stored
after the session is ended.

Parameter

Description

Category

Select the category of the file you want to be named automatically, e.g. an Image or an Experiment.

Prefix

Here you can enter a prefix for the file name, e.g. IMG.

Digits

Select how many digits you want the counter to have.

Format

Here you can specify what information you want to include to
the file name. From the Format-IDs list below you can add the
desired attribute to the name. Therefore simply double click on
the desired format in the list.

Initial Counter Value

Here you can enter the desired first value of the counter.

Suffix

Here you can enter a prefix for the file name.

Preview

Displays the preview of the naming format that will be allocated
next for the selected category.

Save/Restore Counter
Value

Activated: Saves the counter values for the individual categories.
If the software is restarted, the values are restored.

Format IDs

Shows all the attributes which can be used for the Format field.

13.1.7.5.4 Saving Tab

Parameter

Description

Auto Save after Snap

Activated: Automatically saves images that are acquired on the
Locate tab using the Snap button.
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Parameter

Description
Deactivated: Saves images that are acquired on the Locate tab
using the Snap button temporarily in the Auto Save Path\Temp.
The image will be marked with an asterisk and will be deleted if
it is closed without saving.

Don't Open a Document Window

Only active if the Auto Save after Snap checkbox is activated.

Auto Save Path

Specifies the folder where the images are saved automatically.

Show "Discard All"
Button in Dialog to
Save Modified Documents

If activated, the Discard All button is displayed in the Save Documents dialog.
NOTICE! If you click on this button all un-saved images
will be deleted.

Activated: Closes the automatically saved images immediately
after acquisition.

See also
2 Auto Save Tool [} 766]
13.1.7.5.5 Documents Tab
Default Settings for New Images section

Parameter

Description

Show Rulers

Activated: Displays rulers at the top and left-hand edge of the
image – the units used are according to the scaling settings.

Auto Fit

Activated: Automatically adjusts the zoom factor of the image
so that the entire image is visible and the view area is filled.

Use Interpolation for
Image Display

Activated: Displays pixels in interpolated form.

Set Logarithmic Scale
in Histogram

Activated: On the Display tab the frequency distribution (yaxis) of the histogram is plotted using a logarithmic scale.

Show Viewport Scalebar in 2D View

Activated: Shows a scale bar within a small window in 2D view.

Show Viewport Scalebar in Live Window

Activated: Shows a scale bar within a small window in the Live
window.

Show Navigator in 2D
View

Activated: Shows the Navigator window in the image area.

Use Pan Mode in 2D
View for Tile Images

Activated: Pan mode will autoatically activated for tiled images
opened in 2D view.

Display section

Parameter

Description

Enable Tree View

Additionally shows the Tree view in the Center Screen area.
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Parameter

Description

Show Time series/
movie images
without Bounding
X/Y Area

Activated: Time series or movie images acquired when the stage coordinate is adjusted are shown without the bounding X/Y area (black
boarder).

Show Rotation
Slider in Dimensions tab

Shows the Rotation Slider in the Dimensions Tab.

Image Rendering

Parameter

Description

Use Advanced
Renderer for Image Acquisition
(Note that in a few
instances display
artifacts can occur)

Usually the advanced renderer is deactivated during acquisition.
This check box activates the renderer during acquisition, which can
cause an appearance of display artifacts.

3D View section

Parameter

Description

Run Performance
Assessment

Runs a test routine which evaluates the performance of the graphic
card installed on the workstation. The result is an adjustment of the
precision and accuracy parameters to allow fluid interaction with the
rendered volume in 3D view.

Graphics Hardware
Class

Selects the performance class of your graphics hardware. A higher
performance class allows you to see your data in more detail but may
lead to crasheson unsuitable hardware. The following classes are
available:
§ Very Low
§ Low
§ Normal
§ High
§ Very High

Interactive Precision

Controls the interactive precision in %.

Interactive Accuracy

Controls the interactive accuracy in %.

Show Logo

Activated: Logo is displayed in the lower right corner of the 3D view.

Export Logo

Activated: Exports the logo in render series and snapshots.
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13.1.7.5.6 Acquisition Tab
General section

Parameter

Description

Automatically Add
Scalebar Annotation at Snap

Activated: Automatically adds a scale bar to the image, if it was acquired via the Snap button.

Show a Request to
Move Manual or
Coded Hardware
Components

Activated: Shows a dialog which asks you to move manual components. You have to confirm the dialog and move the component by
hand.

Show a Confirmation Dialog for
Channel/Track
Deletion

Activated: Shows a dialog which asks you to confirm to delete a
channel or a track.

Lock Device Controls in Right Tool
Area During Running Experiments

Activated: Prevents controls in the right tool area from be undocked
during an experiment.

Camera/Live section

Parameter

Description

Stop Live after
Snap

Activated: Automatically closes the Live mode after an acquisition
via the Snap button.

Stage/Focus Control in Live/Continuous View

Enables to navigate the stage and focus in Live and Continuous
view.

Show Camera Expert Options

Activated: Shows advanced (expert) camera options on Locate tab
within the Camera tool.

Use Centered Camera ROI only

Activated: Positions a camera ROI at the center of the camera chip
regardless of its size.
Centered Camera ROI = center of camera detector

Configure the travel speed of the focus by adjusting the values in the
corresponding fields from Very Slow = 0,005 to Very Fast = 50,0.
Reset your adjustments by clicking on the Default button.

Acquisition Tab section

Parameter

Description

Acquisition Tab
without channel
support

Activated: Enables the use and set-up of experiments without any
channel support in the Acquisition tab.

Prevent Execution
of After Channel
Setting while Live
Mode is Active

Activated: Prevents execution of after channel setting automatism
while Live mode is active.
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Parameter

Description

Automatically start
Live Mode when
Exposure Measurement was Started

Activated: Starts theLive mode when the Set Exposure button has
been pressed such that the live image begins immediately after the
Set Exposure measurement is complete.
Deactivated: Takes a Snap subsequent to Set Exposure.

Switch to next Enabled Acquisition
Block in Experiment Designer

Activated: Automatically switches to the next enabled acquisition
block in the Experiment Designer during a running experiment.

Enable Imaging
Setup

Shows the Imaging Setup tool on Acquisition tab.

Enabled Advanced
Imaging Setup

Only active, if the Enable Imaging Setup checkbox is activated.
Activated: Shows the Standard/Advanced option on the Acquisition tab on top of the Imaging Setup tool. As the advanced options
should be touched by experts only, this option is deactivated per default.

Z-Stack section

Parameter

Description

Adjust Auto-ZStack Focus Match
on First Slice

Determines the degree of match between the image focus of the first
image and that determined as the true focus (center plane of the resulting Z-stack).

Adjust Auto-ZStack Focus Match
on Last Slice

Determines the degree of match between the image focus of the last
image and that determined as the true focus (center plane of the resulting Z-stack).

Delay Time After
Focus Move

Specifies a delay time after each focus movement during Z-Stack experiments in ms.

Tiles & Positions section

Parameter

Description

Automatically
Start Live Mode in
the Advanced
Setup View

Activated: Automatically starts the Live mode in the Center Screen
Area if you klick in the Acquisition tab in the Tiles tool on the Advanced Setup button.

Automatic Snap by
Clicking the Live
Navigator Buttons

Activated: Acquires an image if you click on one of the frame's blue
arrow icons. The Live Navigator tool moves one frame width in the
relevant direction. You can create tile images of your sample easily in
this way.

Enable Stage
Movement with
Live Navigator

In the Live navigator tool the current stage position including the live
image is shown as a frame outlined in blue. To move the frame, double-click on the position to which you want to move it. Alternatively,
place the mouse cursor over the blue frame, press and hold the left
mouse button and drag the live navigator to the desired location.

Uncheck this option to prevent unnecessary specimen bleaching. The
default is not activated.

Activated: Allows you to move the Live Navigator tool by dragging
it to a new location.
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Parameter

Description

Show Stage and
Focus Backlash
Correction Setting
in the Options

Activated: In the Tiles option, the setting to switch the backlash correction on or off is shown. Per default it is hidden.

Delimiter for CSV
Export/Import

Specifies the delimiter for a CSV export or import. Select Comma (default), Semicolon or Tab.

Ask Whether Support Points/Positions Should be
Overwritten

When the support points and/or positions are determined by a software autofocus run the existing points can be overwritten with the
new Z values.

Focus Surface Outlier Determination

Ignores support points that are significantly outside the interpolated
focus surface.

Activated: Shows a message box asking if the points should be overwritten if there is a autofocus Z value.

You have the following setting options available:

-

Maximum Interpolation Degree
for Outlier Detection

This value can be 0 or 1. If 1 then a linear fit is used to detect the outlier support points. This is the default. If 0 a simple average value is
used to detect outliers.

-

Threshold in
Terms of the
Standard Deviation (Sigma)

This parameter defines a threshold value to determine which of the
support points are outliers from the fitting process. This is defined by
the standard deviation (sigma value) set in the spin box. Support
points not meeting this criteria are subsequently ignored when the focus surface is determined.

Delay Time After
Stage Movements

Defines a delay period which is used for all stage movements in a tiles
and position experiment or movements controlled in the advanced tile
setup. The delay helps prevent movement in samples where, for example, a large volume of liquid is present in the sample holder. It can
be used with the stage speed and acceleration options to optimise experiments with this type of sample.

Binning Compensation of Exposure
Time in Preview
Scans

Defines the power to which the binning ratio is modified to automatically determine the exposure time value used for a preview scan were
the binning setting between the experiment and preview scan differs.
The default value is 2.0 i.e. quadratic. Thus, for example the exposure
time would be reduced by a factor of four if the experiment binning is
1x1 and the preview scan binning is 2x2. The value can be varied between 1.0 and 2.0 in steps of 0.1.

Live Image in Sample Carrier Calibration Wizard (relevant only for systems with camera)

-

Use Imaging
Device from Selected Channel
with "Acquisition" Settings

Activated: Default setting for the live image that allows navigation
and focus interaction during the carrier calibration wizard.
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Description
This option is only relevant for systems with a wide field (camera
based) detector.
Activated: Allows you to alternatively apply locate camera settings
for use in the carrier calibration wizard (live image). By default the experiment settings for the currently selected channel/track will be used.

Panorama section

Parameter

Description

Automatically
Start Live Mode in
the Panorama
View

Activated: Specifies that the live mode will start running automatically when you begin a panorama experiment.

Automatically
Move Stage/Live
after an Acquisition

Activated: Automatically moves the stage half a camera frame diagonally after acquisition of a snap image. Thus, the snap image can be
inspected.

Enable Transparency Effect on
Selected Tile Image

Activated: Displays the selected tile image with a transparency effect
that enables you to see it in relation to the tiles underneath (lower
layer = earlier acquisition) and those above (upper layer = more recent
acquisition) at the same time.
You can also adjust the degree overlap of the panorama grid. The default value is 20%, changes require a re-start to become affective.
Note that this and the transparency effect parameters are only relevant for manual stages.

Grid Overlap

Specifies the degree of overlap for the panorama grid in %. A software restart is required.

Show Live
Panorama Acquisition Options

Activated: Note that the option should only be activated, if you
have issues with the camera / live image during acquisition. It is only
available for troubleshooting and normally not needed.
Not activated: Default. The software tries to use the determined
value for the current camera automatically. If you are unsure, if your
camera supports the functionality, we recommend leaving the default.

Focus Strategy section

Parameter

Description

Show a Dialog to
Prepare the Definite Focus Initialization

Activated: Reminds you to make appropriate adjustments to the focus prior for initialization at the start of experiments using Definite Focus.

Enable Definite Focus Stabilization
on a Suitable Fallback Position

Activated:Specifies whether the last successfully determined z position is used if the primary focus action (Definite Focus or Autofocus)
fails.

Show Definite Focus Setting "Resolution and Speed"

Activated: An additional section is displayed in the definite focus
strategy. This allows selection of three definite focus modes for
greater speed or accuracy of the stabilization.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

638

13 Software Functions & Reference | 13.1 Menus

ZEISS

Experiment Feedback section

Parameter

Description

Time until a deadlock of the synchronized script is
assumed

Sets the time until a deadlock of the synchronized script is assumed.
Here you can adjust the time until ZEN assumes that a deadlock has
occurred after a synchronized script has been executed. If this value is
exceeded the function is aborted.

Mixed Mode Options section

Parameter

Description

Activate the online
disparity warping

Specifies whether the disparity map is used to warp the LSM and
Airyscan frames.

Path to disparity
map

Displays the path where the disparity map is saved.

Interpolation
Mode

Sets the interpolation mode.

–

Nearest Neighbor

The output pixel is given by the gray value of the input pixel that is
closest to it.

–

Linear

The output pixel is given by the gray value resulting from the linear interpolation of the input pixels closest to it.

–

Cubic

The output pixel is given by the gray value resulting from a cubic polynomial function interpolation of the input pixels closest to it.

Disparity Map Calibration Integrates
the Radial Distortion

Activated: Integrates the radial distortion for the calculation of the
disparity map.
Note: This option should not be deactivated because it will have a
negative effect on the quality of the results.

LSM section

Parameter

Description

Online Scanner
Correction

Activated: Enables the online scanner correction. It ensures an optimal image quality at scan speeds > 13.

Airyscan Processing Baseline Shift

Activated: Adds an offset of 10.000 to the processed Airyscan images. This allows to display details in the processed Airyscan image
that have negative intensity values and are therefore normally cut
from the histogram.

Bidi Auto Correction

Automatically corrects line shifts for bidirectional scanning for Multiplex Imaging modes

Set lasers OFF
when unused for
30 minutes (requires ZEN restart)

When activated any laser which is not activated for an experiment will
automatically be set to OFF mode after 30 minutes. This does not apply to multiphoton lasers.

Activate extended
zoom range

Activates the extended zoom range.
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Parameter

Description

Enable Z-Piezo

Activated: Uses the Z-Piezo drive (if available) for the acquisition of ZStacks. Stacks with a range that is larger than the specified working
range of the piezo drive are automatically carried out using the microscopes focus drive.

Z-Piezo Range

Select the range of the Z-Piezo drive. Note that the precision in the
high range is lower compared to the default range.
Note: This function is not available with LSM 980. With LSM 980 the
range of the Z Piezo is always 500 µm with high precision.

13.1.7.5.7 User Tab
Here, you can enter user and company information. These are written into the image metadata
during acquisition.

Parameter

Description

User Information

Type in contact information of the software user here.

Company Information

Type in contact information of the company/institute/facility here.

Logo

Upload a company logo to the company profile here. Therefore click
on the

button.

13.1.7.5.8 Data Tables Tab
Data Table Import Options section

Parameter

Description

Start Import in Row
No.

Defines the starting row of the data table into which the data
will be imported.

Automatic CSV format
detection

Activated: Automatically tries to detect the format of the data
table when importing the table to the software.

Use first imported row
as column caption

Activated: Uses the first imported row as the caption for the
column.

Use second imported
row as column unit

Activated: Uses the second imported row as the unit for the column.

Use column, decimal
and list separator from
windows regions settings

Activated: Uses the settings which are configured in the Windows regions settings when importing a table to the software.

Column Separators

Active only if you have deactivated the checkboxes Automatic
CSV format detection and Use column, decimal and list
separator from windows regions settings.
Configures the import options according to the format of your
data table you want to import, e.g. specify the type of column or
decimal separator.
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Parameter

Description

Decimal Separator

Active only if you have deactivated the checkboxes Automatic
CSV format detection and Use column, decimal and list
separator from windows regions settings.
Select here, which decimal separator should be used.

Thousands Separator

Active only if you have deactivated the checkboxes Automatic
CSV format detection and Use column, decimal and list
separator from windows regions settings.
Select here, which thousands separator should be used.

Data Table section

Parameter

Description

Number of Decimal Places

Set the maximum number of decimal places for the numbers imported
into the data table here.

13.1.7.5.9 Macro Editor Tab
Macro Configuration section

Parameter

Function

Show Inherited
Members in Popup

Activated: Shows the inherited members of the ZEN class in a pop-up
window.

Show line Numbers

Activated: Shows the line numbers.

Disable fullscreen
mode while debugging

Activated: Disables the fullscreen mode during debugging.

TCP Macro section

Parameter

Description

TCP Macro Section

Activated: Enables to enter the TCP Port Number.

Allow IPv4 Nat
Traversal

Attention! For experts only. Do only activate this option if you know
what you are doing.

Macro Recorder

Parameter

Description

Overwrite Interactive Recording
Flag

Activated: Overwrites the parameter for interactive execution of a
function during recording with the macro recorder.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

641

13 Software Functions & Reference | 13.1 Menus

ZEISS

13.1.7.5.10 APEER Tab

Parameter

Description

API Key

Sets/displays your private API Key which is required for the use of the
APEER functionalities within ZEN. For more information, see Creating
and entering an API key [} 245].

Choose Execution
Mode

Selects if the execution should be done locally or on a remote server.
Available options:
§ Use Local Docker Desktop
§ Use Remote Docker Host

Default Execution
Location

Only visible if Use Local Docker Desktop is selected.
Selects a default location where the APEER module is executed and
the outputs are saved.

Parameter

Description

API Key

Sets/displays your private API Key which is required for the use of the
APEER functionalities within ZEN. For more information, see Creating
and entering an API key [} 245].

Choose Execution
Mode

Selects if the execution should be done locally or on a remote server.
Available options:
§ Use Local Docker Desktop
§ Use Remote Docker Host

Default Execution
Location

–

Use Docker
Desktop with
WSL 2

Only visible if Use Local Docker Desktop is selected.
Selects a default location where the APEER module is executed and
the outputs are saved.
Only visible if Use Local Docker Desktop is selected.
Activated: Docker Desktop uses WSL 2 (Windows sybsustem for
Linux).

Remote Docker Options
Only visible if Use Remote Docker Host is selected.

Parameter

Description

Remote Docker
Host API Address

Sets the address and port of the remote Docker host.

Check Connection

Checks if the remote Docker host can receive a request. A green
checkmarks indicates a successful connection, otherwise a red x is displayed.

Choose Authentication Mode

Selects the mode how you have to authenticate yourself to the remote host.

–

No Authentication

The remote host needs no authentication.

–

Basic Authentication

Displays a field to enter the Username and Password required for
the remote host. Also the checkbox to Use TLS (https).
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Description

–

Certificate File
Authentication

Displays a field to browse for the Certification File and enter a Password (optional) required for the remote host.

–

Windows Certificate Authentication

Displays a field to browse for a Certificate from Windows Store required for the remote host.

Local to Remote
File System Mapping

Area to map a folder path from the local computer to the same path
on the remote computer.

Path List

Displays and maps the path of a folder on this machine to the path of
the same folder on the remote Linux machine.

–
–

Deletes the currently selected path mapping.

–

Opens the Edit Mapping Dialog [} 643] to edit the currently selected
path mapping.

–

Opens the Edit Mapping Dialog [} 643] to add a new path mapping.

Export Remote
Settings

Opens a file browser to export the current settings as an xml file.

Import Remote
Settings

Opens a file browser to select and import an xml file with settings for
the remote setup.

Advanced Settings

Parameter

Description

Client Name

Sets a custom client name for this computer.

Ports that can be
used for the
Docker Containers

Defines the ports which can be used by the Docker containers.

See also
2 APEER (on-site) [} 244]
2 APEER Workflows (online) [} 252]
13.1.7.5.10.1 Edit Mapping Dialog

Parameter
Local Computer
Path

Description
Selects the path to the folder on this local computer. Click on
open a file explorer and browse to the folder.

to

Remote Computer
Path

Defines the path the same folder on the remote computer.

Check Mapping

Checks if the two paths point to the same folder and displays if the
check is successful or not.

Ok

Saved this path mapping and closes the dialog.
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Parameter

Description

Cancel

Closes the dialog without saving.

13.1.7.5.11 Direct Processing Tab
On this tab you have the options to set up the communication between PCs for Direct Processing.
For more detailed information, see Connecting the acquisition computer with the processing
computer [} 344] and for general information see the chapter for Direct Processing [} 343].
Setup Acquisition PC
In this section you can set up the acquisition computer if you use a discovery proxy. For more information, see also Connecting the computers with discovery proxy [} 345].

Parameter

Description

Find From Discovery Proxy

Activated: Displays the control to define a Discovery Proxy from
which you can get a list of available PCs for processing.

IP Address (Discovery Proxy)

Only visible if Find From Discovery Proxy is activated.
Sets the address of the Discovery Proxy from which you can get a list
of available PCs for processing.

Setup Processing PC
In this section you can set up the processing computer.

Parameter

Description

Announcement to
Discovery Proxy

Activated: Uses a Discovery Proxy server for the communication between the computers. For more information, see Connecting the computers with discovery proxy [} 345].

IP Address (Discovery Proxy)

Only visible if Announcement to Discovery Proxy is activated.
Sets the IP address for the Discovery Proxy.

IP Address (this
PC)

Displays the IP address of your computer and allows you to change
the Port.

PC Description

Here you can add specific information about the processing computer
that will be visible on the acquisition computer.

Send Hardware Information (optional)

Activated: Displays the hardware information of this computer,
which is also visible on the acquisition computer.

Send Processing
Statistics (optional)

Activated: Displays Direct Processing statistics (processing speed),
which is also visible on the acquisition computer.

Setup Discovery Proxy Server
In this section you can set up your own computer as a Discovery Proxy. For more information, see
also Setting up your PC as discovery proxy [} 346].
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Parameter

Description

IP Address (this
PC)

Displays the IP address of your computer.

Start/Stop

Uses your computer as Discovery Proxy. The button changes to Stop
to stop acting as Discovery Proxy.

IP Address to clipboard

Only available if the Start button has been clicked.
Copies the IP address of your computer to the clipboard.

13.1.7.5.12 ZEN Connect

Parameter

Description

Stage Size

–

Stage Size in
mm

Positions the images initially in a better way in the correlative
workspace. For example, for 130x100mm stage an image at stage position 65x50mm will be placed in the center of the correlative
workspace.
Note that the stage size will only be taken into account for better initial positioning if you have calibrated the stage upon startup or later,
but before creating the ZEN Connect project.

Stage Move Confirmation

–

Deactivate Confirmation

Activated: No confirmation dialog is shown when the stage is moved
with double click in the Correlative Workspace.
Deactivated: A confirmation dialog is shown each time the stage is
moved with double click in the Correlative Workspace.

3D Rotation

–

Show Outlines
of Rotated
Cube

Activated: Displays a yellow outline of a rotated image in the Correlative Workspace. This outline is only visible in alignment mode, if 3D
Alignment is selected and Apply 3D Rotation is activated.

2D Image Sets

–

Always display
single plane
data sets

Activated: Always displays single plane data sets in the correlative
workspace, even if the z-value set by the Global-Z is out of range for
the 2D image(s).

13.1.7.5.13 ImageJ Tab
This tab is only shown if the ImageJ extension is activated.

Parameter

Description

ImageJ Folder

Shows you where the software is installed.

ImageJ executable

Select your preferred .exe file in the drop down list.

Shift Pixels to 16
bit

Activated: Shifts the grey value of a 10-bit or 12-bit image to 16-bit.
Deactivated: No shift takes place.
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Description

Assume macro has
input

–

False

The software does not expect macro input.

–

True

The software expects macro input.

Default preferred
conversion

You can specify the default for the preferred conversion.

–

Automatic

Uses the automatic conversion setting.

–

Always

Image is always converted.

–

Keep

Image is not converted.

Default preferred
file format

You can select the default setting for the preferred file format.
Available options in the drop down list:
§ Automatic
§ czi
§ Ome Tiff
§ Tiff
§ Tiff With Display Mapping

13.1.7.5.14 Storage Settings Tab
Here you can configure the settings for the ZEN Data Storage.

Parameter

Description

Document Server
Url

Sets the Url of the ZEN Data Storage server.

Reset to Defaults

Resets all settings for the ZEN Data Storage to their defaults.

Server Setup

Sets up the ZEN Data Storage server.

See also
2 Setting up the ZEN Data Storage [} 591]

13.1.8 Window Menu
Menu item

Description

Shortcut

Full Screen

Sets the Full Screen mode to maximize
the image view area size.

F11

Next Window

Displays the next open image in the
Center Screen Area (direction of
movement is to the right).

F6

Previous Window

Displays the previous open image in the
Center Screen Area (direction of
movement is to the left).

Ctrl+F6
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Menu item

Description

Shortcut

Close

Closes the currently selected image.

Ctrl+F4

Close All

Closes all the open images.

Ctrl+Alt+W

See also
2 Full Screen mode [} 908]

13.1.9 Help Menu
Menu item

Description

Shortcut

Contents…

Opens the online help contents page.

Ctrl+F1

Index…

Opens the online help index page.

Ctrl+F2

Readme

Opens the file path to the Readme PDF-file.

Create Service
Report...

Opens the dialog to create the service report. For more details, read chapter Creating
a Service Report [} 1049].

About ZEN…

Shows notices of the producer.
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13.2 Main Tabs
13.2.1 Locate Tab
Depending on the system configuration and the licensed modules this tab can have a different appearance. In general you can use the locate tab for finding or "locating" interesting areas on your
sample.
For mixed systems (e.g. LSM including a microscope camera) the section System Mode is available additionally.
In the Eyepiece mode (for confocal systems) this tab contains only functions for controlling the
light path and viewing the sample via the eyepiece, see Microscope Control Tool [} 666]. In the
Camera mode this tab contains more control elements and tools, see Tools on Locate tab

Fig. 50: Locate tab (Camera mode)
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System Mode section
This section is only visible if a camera is installed with the system.
Here you can switch the system mode between Eyepiece and Camera mode. To switch between
the 2 modes simply click on the corresponding button. In the table below you find a description
of the two modes:

Mode

Description

Eyepiece mode

If you switch to Eyepiece mode the system adjusts the light path
automatically to the eyepiece. The following list shows the
changes in the ocular mode in detail:
§ All Action buttons are hidden
§ Only the Microscope Control tool is visible
§ Within the Microscope Control tool only the light path leading to the eyepiece is displayed.
§ All possible light paths to cameras are hidden.

Camera mode

§ All Widefield relevant components are displayed as usual.
§ The LSM Scan Head icon is not displayed in the light path.

Transmitted Light/Reflected Light section
Only visible if you have configured a motorized TL/RL shutter in MTB (MicroToolBox).

Parameter

Description

Off

Closes the shutter of the transmitted/reflected light source on a motorized microscope.

On

Opens the shutter of the transmitted/reflected light source on a motorized microscope.

Switch To section
These buttons configure the light path either for transmitted light observation or fluorescence observation. The observation is either via Ocular or Camera which is set in the System Mode section. The shutter for either observation path is not opened to avoid unwanted illumination of the
sample. Shutter for either mode can be operated directly on the microscope hardware or using
the controls in the Transmitted Light/Reflected Light section.

Mode

Description

Transmission

Click on the Transmission button to set the beam path in the microscope for observation of the sample using transmission illumination.
This includes all motorized components of the microscope excluding
the shutter in front of the transmitted light source. On a fully motorized microscope no further changes in HW are necessary apart from
opening the light shutter and setting the illumination strength of the
halogen lamp to achieve transmission observation of the sample.
Note: When switching to Acquisition the light shutter is closed.
When switching back to Locate the settings for Transmission observation will be restored.
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Mode

Description

Fluorescence

Click on the Fluorescence button to open up the Add Dye or Contrasting Method Dialog [} 809].
Chose the dye you want to observe in fluorescence mode, then close
the tool. The beam path is set for fluorescence observation including
all motorized components of the microscope excluding the shutter in
front of the reflected light source. On a fully motorized microscope no
further changes in HW are necessary apart from opening the light
shutter and setting the illumination strength of the reflected light
source to achieve fluorescence observation of the sample.
Note: When switching to Acquisition the light shutter is closed.
When switching back to Locate the settings for Fluorescence observation will be restored.

Favorites section

Parameter

Description

Configure...

Here you can configure further buttons with your favorite hardware
setting functions. Click on the button to open the Configuration dialog.

Action buttons section
With these buttons you control the microscope and the camera and acquire your images.

Fig. 51: Action buttons

Parameter

Find Focus

Function
Only visible if you have configured a motorized focus in the MTB (MicroToolBox).
Starts an autofocus search using the current settings from the Software Autofocus tool.

Set Exposure

Starts an automatic exposure time measurement with the settings defined in the Light Path and Camera tool or (for LSM) the settings in
the Imaging set up tool.

Live

Opens Live View and shows the live image from the active camera or
the first channel of the first track when acquisition is performed with
LSM.

Continuous

Starts a series of Snaps using the settings defined in the Light Path
and Camera tool. In contrast to a live image, the exact same camera
setting that has been set in the Camera tool is used. The result at the
end of this mode is a single, acquired image that can be saved.
Acquires a single image.

Snap button
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Function
Only active if one of the acquisition buttons has been clicked.
Stops the function of the relevant acquisition button.

Stop
Active Camera section

Parameter

Description

Link Cameras

Only active if you have connected two structurally identical cameras
to your system.
Activated: Acquires images using two cameras in parallel. This is often the case with 2-channel images for ratio measurements or FRET
measurements.

Active Camera

Shows the active camera. If you have several cameras connected, you
can select the detector to use here.

Tools section
Depending on which modules you have purchased you see different tools available in this section,
see Tools on Locate tab.

See also
2 Microscope Control Tool [} 666]
13.2.1.1 Configure your hardware setting favorites Dialog
Here you configure up to 20 new buttons to get quick access to your preferred camera and hardware settings.

Info
To create and edit settings you need the settings editor. Click on Tools > Settings Editor.

Parameter

Description

Favorite Settings

If you have not yet defined any buttons, you will see an empty list
here. To create a new button, click on the Add button
. Your
Favorites are displayed as buttons on the Locate tab in the Favorites
section.
You can configure your favorite setting in the input fields:

-

Name

Here you can enter a name for the button.

-

Hardware Setting Ref.

Shows the selected hardware settings.

-

Camera Setting
Ref.

Shows the selected camera settings.

-

Color

Here you can select a color for the related button. Click on the color
dropdown list to choose a color.
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Use Color also
for Button Text
coloring
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Description
Activated: Uses the selected color as the button text color.

Available hardware settings on
disc

Here you see a list of all hardware settings that are saved on your
hard drive. Select the hardware setting that you want to use with the
configured button. To add a hardware setting, simply drag & drop
them to the desired button configuration.

Available camera
settings on disk

Here you see a list of all camera settings that are saved on your hard
drive. Select the camera setting that you want to use with the configured button. To add a camera setting, simply drag & drop them to the
desired button configuration.

13.2.2 Acquisition Tab
Here you configure and control your acquisition experiments.

Info
The content of the tab changes depending on the configuration of your imaging system and
the options that you activate or deactivate.
Settings that you configure in the top part of the tab have an effect on settings in the bottom
part of the tab. Settings that you configure in the Acquisition Parameter tool group, e.g. in
the Channels tool also apply to the acquisition of all images that you configure in the Multidimensional Acquisition tool group.

1
2
3
4

5
6

Fig. 52: Acquisition tab
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Experiment Manager
The area above the blue tools where you can load and save your experiments, control acquisition and decide which tools will appear in the certain tool groups.
For further information on Experiment Options, see Experiment Options [} 654].

2

Smart Setup
Opens the Smart Setup dialog, see Smart Setup

3

Sample Navigator
The Sample Navigator wizard is a tool to find the focus plane and quickly acquire an
overview scan of your sample. You can also simplify the search for a region of interest
for the actual imaging experiment. For further information, see Using the Sample Navigator with LSM 980 and LSM 900 [} 69].

4

Action Buttons
With these buttons you control microscope and camera and acquire your images. For
further information on action buttons, see Action Buttons [} 653].

5

Acquisition Dimensions
Here you activate the desired dimensions (e.g. Z-Stack or Tiles) for your experiment. A
drop down menu appears when selecting the dimensions to determine the sequence of
acquisition. For more information, see Acquisition Sequence [} 662].
The corresponding fields to the right of each dimension show a preview of how extensive the experiment will be (e.g. 9 Tiles).
Below the dimensions section you activate additional experiment features (e.g. Auto
Save) or special modules (e.g. Shuttle & Find).

6

Experiment Preview
Here you can see a graphical representation of the configured experiment. The Disc icon
indicates that you have enabled Auto Save function for the experiment.

See also
2 Smart Setup [} 655]
13.2.2.1 Action Buttons
With these buttons you control microscope and camera and acquire your images.
The Acquisition buttons on the Acquisition tab differ from the Acquisition buttons on the Locate
tab.
The buttons on the Locate tab relate to an individual image. The buttons on the Acquisition tab
relate to a multidimensional image with at least one channel.

1

1

2

3

4

5

6

Find Focus
Only visible if you have configured a motorized focus (MicroToolBox).
Starts an autofocus search using the settings from the Focus Devices tool. The autofocus search is performed for the selected reference channel in the Channels tool.
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Set Exposure
Starts an automatic exposure time measurement with the settings defined in the Light
Path and Camera tool.

3

Live
Starts the Live Mode. In the Center Screen Area you see the live image from the camera.

4

Continuous
Starts a series of Snaps using the settings defined in the Light Path and Camera tool.
In contrast to a live image, the exact same camera setting that has been set in the Camera tool is used.

5

Snap
A so called "Snap" acquires a single image (snapshot).
For widefield systems an additional tiles snap option is available. You can choose between 2x2, 3x3, 4x4 and 5x5 presets.

6

Stop
Only active if one of the acquisition buttons has been clicked.
Stops the function of the relevant acquisition button.

13.2.2.2 Experiment Options
In the Options
shortcut menu you can create new experiments and rename, save, import,
export or delete existing experiments.

Menu item

Description

New

Creates a new, empty experiment. Enter a name for the experiment.

New from Template

Create a new experiment based on an existing experiment. The template experiment will not be modified. You can create your own template experiments by placing them in the folder Carl Zeiss\ZEN\Templates\Experiment Setups, which is located in the windows public
documents folder and in the documents folder for each user.

Rename

Enables you to enter a new name for the experiment.

Save

Saves a modified experiment under the current name. An asterisk indicates the modified state.

Save As

Saves the current experiment under a new name. Enter a name for
the experiment.

Reload

Reloads the selected experiment.

Set As Startup Default

Selecting this option will assign the currently loaded experiment as a
default experiment, which is loaded every time the software is started.
The startup default experiment is indicated by a special icon
hind the experiment name.

be-

You can decide to start the software with a particular default experiment, with the last used experiment or with an empty new experiment in Tools > Options > Startup/Shutdown > Experiment.
Import

Imports an existing experiment. The experiment is shown in the Experiment Selection dropdown list.
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Description

Export

Exports the current experiment.

Delete

Deletes the current experiment.

ZEISS

13.2.2.3 Smart Setup
Smart Setup offers you support when configuring multichannel acquisition experiments. To start
it click on the Smart Setup button on the Acquisition tab.
Select the fluorescent dyes and contrast techniques that you want to include in your experiment
from a large dye database. Smart Setup takes the configuration of your microscope hardware and
the properties of the selected dyes into account. Based on this information, it makes one or more
suggestions for acquisition. You can adopt these into your experiment as required and make further changes to them there.

Info
If Smart Setup is unable to make a proposal, it is not possible to use the selected dyes, contrast techniques, or current microscope hardware to make acquisitions. Select other dyes or
another contrast technique or configure your acquisition experiment using the Acquisition
Mode tool and the Channels tool.
For working with Smart Setup please note the following:
§

Smart Setup tries to configure the motorized components of your system for the acquisition
of multichannel images.

§

Smart Setup does not change any parameters of other acquisition dimensions (e.g. Z-stack,
Time series, or Multi-position acquisitions).

§

For widefield tracks it does not influence any camera parameters (e.g., Exposure time or Resolution).

§

For LSM tracks it adjusts parameters within the Imaging Setup, the Acquisition Mode and the
Channels tool windows.

Depending on your system you will see two buttons on top of the dialog.

Fig. 53: Smart Setup Modes
If you select the LSM button you can use Smart Setup for configuring confocal experiments, see
Smart Setup (LSM) [} 658].
If you select the WF button you can use Smart Setup for configuring widefield experiments, see
Smart Setup (WF) [} 656].
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13.2.2.3.1 Smart Setup (WF)

Fig. 54: Smart Setup (WF)

1

Imaging Mode Selection

2

Detector Selection

3

Experiment Configuration

4

Motif Buttons

5

Graphical Display of Proposals

Parameter

Description

Detector Selection
(2)

Only visible if two or more cameras are configured for the system.

Configure your experiment (3)

Here you can add up to four reflected light fluorescence channels and
one transmitted light contrast technique to your experiment. The
added dyes or the contrast technique are shown in the list below.

Here you can select the desired camera for the experiment.

If you click on the Add button the Add Dye or Contrast Technique
[} 809] dialog will be opened. There you can select the desired dye or
contrast technique from the Dye Database.
Motif buttons (4)

Here you can optimize image acquisition regarding particular requirements like speed or quality.
All parameters, e.g. camera resolution or dynamic range in the Acquisition Mode or the Channels tool, were set automatically. They will
essentially influence the camera, detector, and lightning settings.
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Description
§ The system will try to set the optimal resolution for the camera in
the Acquisition Mode tool. The resolution will be calculated from
camera parameters and numeric aperture; Microscanning will not
be applied even if the camera supports this mode.
§ The dynamic range for all fluorescence channels will be set to 50%
or 80% for all transmitted light channels.

-

Speed

§ If binning is supported, one binning category will be set for the
camera under the optimal resolution in the Acquisition Mode
tool.
§ Sets dynamic range of all fluorescence channels to 20% or 50% for
transmitted light channels.
§ Sets power of all Colibri-LEDs to 100%.
§ Sets EMGain of the camera (if available) to half of Gain max. Sets
read mode of camera to fastest.
§ Creates an acquisition configuration which removes all reducers or
neutral filters.
§ Changes acquisition sequence for dimensions to fastest. Only effective with 2 or more dimensions.

-

Signal

§ Sets the optimal resolution for the camera in the Acquisition
Mode tool. Microscanning will be applied if the camera supports
this mode.
§ Sets the dynamic range for all fluorescence channels to 90% or
100% for all transmitted light channels.
§ Sets power of all Colibri-LEDs to 75%.
§ Sets EMGain of the camera (if available) to 10% of Gain max. Sets
read mode of camera to slowest.

-

Default

Sets all parameters in Channels and Acquisition Mode tool to the
default values. All changes will be overwritten and reset.

-

Current

No changes are made. Only the necessary hardware settings for acquisition are applied by Smart Setup.
NOTICE! If you changed hardware settings in the Acquisition
Mode tool manually and do not want to lose them, make sure
you select the Current button.

Proposals (5)

Here you can see the proposals made by Smart Setup displayed
graphically. You can find a detailed description of the graphical display under Graphical Display of Proposals [} 661].
The proposals change the imaging settings in the Imaging Setup
tool window accordingly.
The number and type of proposals depend on the microscope hardware being used, the selected dyes, and the contrast technique:

-

Best Signal

This proposal results in the best signal strength.

-

Fastest

This proposal results in the fastest acquisition.

-

Best Compromise

This proposal results in the best compromise between signal strength
and fastest acquisition.
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Parameter

Description

Show Excitation
checkbox

Shows the excitation spectrum of the selected dyes in the graphical
display.

Show Emission
checkbox

Shows the emission spectrum of the selected dyes in the graphical
display.

OK button

Adopts the proposal displayed as the current acquisition experiment.
The suggestion overwrites existing experiments on the Acquisition
tab.

Cancel button

Ends Smart Setup. The suggestions are not adopted into the experiment.

13.2.2.3.2 Smart Setup (LSM)

1
2
3

4

5

11

10

9

8

7

6

Fig. 55: Smart Setup (LSM)
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Parameter

Description

1

Imaging Mode
Selection

Here you can select the LSM or WF imaging mode.

2

Detection
Mode

If your system is equipped with an Airyscan detector, you can use
Smart Setup to generate proposals for Airyscan instead of confocal acquisition, see also Airyscan Mode.

3

Configure
your experiment

Here you can add up to 8 reflected light fluorescence channels
and one transmitted light contrast technique to your experiment.
The added dyes or the contrast technique are shown in the list.
If you click on the Add button the Add Dye or Contrasting
Method Dialog [} 809] dialog will be opened. There you can select the desired dye or contrast technique from the Dye Database.

4

Motif buttons

Here you can optimize image acquisition regarding particular requirements like speed or quality.
If clicking on a button different parameters in the Acquisition
Mode or the Channels tool, were set automatically.
The automatic settings will influence parameters like Frame Size,
Speed, Direction, Bit Depth (in Acquisition Mode tool) and Pinhole Diameter, Gain, Laser Power (in Channels tool), depending
on the selected button.
Various proposals for further experiment settings are shown in
the graphical display below the buttons.

- Current

No changes are made. Only the necessary hardware settings for
acquisition are applied by Smart Setup.
NOTICE! If you changed hardware settings in the Acquisition Mode tool manually and do not want to lose them,
make sure you select the Current button.

- Speed

§ Sets the frame size to 400x400 pixels
§ Sets the scanning speed to maximum value
§ Sets the scanning direction to bi-directional
§ Opens the pinhole to 2 Airy Units (AU)

- Signal

§ Aims to provide high quality images with best signal to noise
ratio.
§ Sets the frame size to a minimal value that fulfills the Nyquist
criterion, but to a maximum of 2048x2048 pixel
§ Sets the scanning speed to 6
§ Sets the scanning direction to uni-directional
§ Sets the Bit Depth to 16 bit

5

Proposals

Here you can see the proposals made by Smart Setup displayed
graphically. You can find a detailed description of the graphical
display under Graphical Display of Proposals [} 661].
The proposals change the imaging settings in the Imaging
Setup tool window accordingly.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

659

13 Software Functions & Reference | 13.2 Main Tabs

No.

Parameter

ZEISS

Description
The number and type of proposals depend on the microscope
hardware being used, the selected dyes, and the contrast technique:

- Fastest

This proposal results in the fastest acquisition.

- Best Signal

This proposal results in the best signal strength and minimizes
the level of cross talk.

- Smartest

Combines the advantages of Fastest and Best Signal. It minimizes
the number of tracks as well as cross talk.

(Line)

6

Cancel button

Ends Smart Setup. The suggestions are not adopted into the experiment.

7

OK button

Adopts the proposal displayed as the current acquisition experiment. The suggestion overwrites existing experiments on the Acquisition tab.

8

Sample Navigator button

Opens the Sample Navigator, see Sample navigator LSM 980 and
LSM 900.

9

Reset button

Clears the list of selected dyes and/or contrasting methods.

10

Show Emission checkbox

Shows the emission spectrum of the selected dyes in the graphical display.

11

Show Excitation checkbox

Shows the excitation spectrum of the selected dyes in the graphical display.
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13.2.2.3.3 Graphical Display of Proposals

Info
The bars in the graphs only show relative values. The actual strength of the emission signal and
the crosstalk in the image can deviate substantially from this estimate, as Smart Setup has no
knowledge of the strength with which the sample has been dyed with the individual dye components.

1

2

3

4

Fig. 56: Emission Signal, Speed, Crosstalk, and Tracks

1

Emission Signal
A filled, colored bar in the Emission Signal display field shows the relative emission signal to be expected for the corresponding channel. The channel color corresponds to the
color of the selected dye in the Configure Experiment section.

2

Speed
A gray bar in the Speed display field represents the approximate acquisition speed that
can be expected. This is the time required for the movement of microscope hardware
during multichannel acquisition. Camera exposure times or parameters for other acquisition dimensions are not taken into account here.

3

Crosstalk
A hatched bar in the Crosstalk display field shows the expected relative crosstalk originating from one or more dyes for other channels.

4

Tracks display
Only visible if the Show Excitation and / or Show Emission checkboxes are activated.
The various tracks are labeled with T1, T2 etc.. The white lines show the excitation and
emission spectra of the dyes schematically. The spectra are filled in color in the places
that will be acquired by the acquisition configuration suggested by Smart Setup. Transmitted light channels are displayed as a white field.
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13.2.2.4 Reuse
The Reuse functionality is only available if you have loaded an image in *.CZI image format. Then,
the Reuse button will then appear on the Acquisition tab. Otherwise, the Reuse button is not
active.
With this function you can apply the experiment setup of the acquired image to the current experiment. This will help you to easily reproduce the acquisition conditions for the next image. The
function only works correctly if the system configuration at the time of acquisition is identical to
the system configuration at the time when you execute the function.
Removing components (e.g. filter cubes, LEDs, cameras, etc.) can result in an experiment being
created incorrectly. It is therefore essential that you check after executing the Reuse function
whether the configuration of the experiment is in line with your expectations.
Using the Reuse function for a Z-stack promts a confirmation asking whether to place the Z- stack
at the current focus position or the original focus position of the acqired image.
Note, that the original position may be way off the current position and starting an experiment
right away can lead even lead to the destruction of your sample.

Info
Clicking on the Reuse button overwrites the current experiment without a prompt and marks
it as having been modified. This can be seen from the appearance of an asterisk after the file
name. If you want to keep the experiment in its previous form, you must save the modified experiment with a new file name under Experiment Manager | Options | Save As.
If you acquire images and save them in *.CZI image format, the following acquisition conditions
are saved together with the image:
§

Information on the type and status of your imaging system

§

Time of acquisition

§

Parameters set in the software.

13.2.2.5 Acquisition Sequence
The available options in the dropdown list depend on the selected acquisition dimensions.

Acquisition dimensions

Selection option

Function

Z-Stack

Full Z-Stack per Channel

Acquires the complete Zstack for a channel and then
processes the next channel.

All Channels per Slice

Acquires all channels for
each Z-plane and then locates the next plane of the Zstack.

Full Z-Stack per Channel

Acquires the complete Zstack at a tile/position for
each channel and then processes the next channel.
Once all Z-stacks at a tile/position have been acquired,
the next one is located.

Z-Stack
Tiles
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Selection option

Function

All Channel per Slice

Acquires all channels at a
tile/position for each Z-plane
before locating the next
plane of the Z-stack. Once all
Z-planes and channels at a
tile/position have been acquired, the next one is located.

Full Z-Stack per Channel

Acquires the complete Zstack for each channel for a
time point and then processes the Z-stack of the
next channel.

All Channels per Slice

Acquires all channels for
each Z-plane for a time point
before locating the next
plane of the Z-stack.

All Tile Regions per Time
Point

Acquires images for all channels as well as images at all
positions of the experiment
for each time point and then
waits for the next time point.

Time series per tile

Acquires the complete time
series at a position with all
channels, before doing the
same at the next position.
Connected tile images are,
however, acquired in full for
each time point.

Time-Regions-Tiles-Channels-Z

Acquires images for all channels as well as images at all
positions of the experiment
for each time point and then
waits for the next time point.
The complete Z-stack is acquired at every position for
each channel and the next
channel is then processed.

Time-Regions-Tiles-ZChannels

Acquires images for all channels as well as images at all
positions of the experiment
for each time point and then
waits for the next time point.
Acquires all channels for
each Z-plane and then locates the next plane of the Zstack.

Time Series

Tiles
Time Series

Z-Stack
Tiles
Time Series
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Selection option

Function

Regions-Time-Tiles-Channels-Z

Acquires the complete time
series at a position with all
channels, before doing the
same at the next position.
Acquires the complete Zstack for each channel and
then processes the next
channel.

Regions-Time-Tiles-ZChannels

Acquires the complete time
series at a position with all
channels, before doing the
same at the next position.
Connected tile images are,
however, acquired in full for
each time point. Acquires all
channels for each Z-plane
and then locates the next
plane of the Z-stack.

13.2.3 Processing Tab
Here you apply processing functions to acquired or loaded images. For general information of the
image processing, see Image Processing Workflow [} 90]. For the detailed descriptions of the
functions and the processing workflow please read more under Image Processing Functions.

1

2

3

4

Fig. 57: Processing Tab
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1

Function
Using Single processing, you can apply a selected processing method, with the relevant
method and image parameters, to a single image.
Using Batch processing, you can apply a selected processing method, with the relevant
method and image parameters, to a list (batch) of images. In this mode only a limited selection of processing functions is available. For more information, see Applying Batch
Processing [} 102].
With the Apply button you apply the selected method to the input image.

2

Method
Here you select the image processing functions. Open the Method tool to show the list
of IP functions.

3

Method Parameters
Here you configure the parameters of the selected image processing function. Click on
the Parameters tool to show the parameters of the selected IP function.

4

Image Parameters
Here you configure the image parameters of the input and output image. Click on the Input tool or Output tool to open input/output image settings. For more information, see
Image Parameters - Input Tool [} 769] and Image Parameters - Output Tool [} 769].

13.2.4 Analysis Tab
Here you find different tools available for image analysis.

See also
2 Interactive Measurement Tool [} 770]
2 Image Analysis Tool [} 775]
2 Intellesis Trainable Segmentation Tool [} 442]

13.2.5 Applications Tab
On this tab you have the following tools available:
§

Guided Acquisition Tool [} 366]
for creating an automated workflow to acquire images (overview), detect relevant objects (image analysis) and re-image these positions with another experiment.

§

Topography Tool [} 265]
for acquiring or loading an existing confocal z- stack and exporting it to ZEISS ConfoMap for
further processing.

§

Layer Thickness Measurement Tool [} 267]
for acquiring or loading an existing confocal z- stack and perform layer thickness measurements.

§

Automated Photomanipulation Tool [} 255]
for creating an automated workflow to acquire multi-position images, determine relevant
ROIs for photomanipulation (image analysis), and execute the photomanipulation experiment
at these ROIs.

§

Direct Processing Tool on Processing Computer [} 354]
for ensuring that the processing computer reads incoming files and starts the processing in
case of remote processing.

§

arivis Vision4D Tool [} 797]
for sending an image to the arivis Vision4D software and open it with an analysis pipeline.

§

APEER [} 244]
for downloading an APEER module and using it locally in ZEN.
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13.2.6 Extensions Tab
Our extensions concept allows to extend ZEN basic functionality by implementing third party extensions, e.g. ImageJ. The extensions concept is a part of OAD (Open Application Development) for ZEN (see also Open Application Development (OAD)).
Depending on which extension you have activated, you will see the extension's functions and
controls on the Extensions tab. Please notice that we will not describe any functions of third
party extensions here. Therefore use the third party documentation for each extension.
You can find more information on OAD and the supported extensions under www.zeiss.com/
zen-oad.
For more information on ImageJ, see ImageJ [} 411] .

13.3 Tools
13.3.1 Tools on Locate Tab
13.3.1.1 Microscope Control Tool
The configuration of your system according to your MicroToolBox (MTB) configuration setting is
shown here. A valid microscope configuration has to be created first using the MTB2011 Configuration program. The light path follows the light starting with the light source to the specimen and
from there to the camera or eyepiece. It displays control elments for all motorized and manually
operated components. Here you can interactively adjust the microscope and its components.

Info
If you are not using any motorized components, you will have to make the relevant adjustments manually.
Keep the following points in mind when working with this tool:
§

To adjust a component, left-click on the relevant icon.

§

Icons with an arrow symbol in the bottom right corner contain dialogs that allow you to configure additional settings. To open the dialogs, left-click on the corresponding icon.

§

Icons with a hand symbol in the bottom left corner indicate components that have to be operated manually.

Icon

Parameter

Description

Eyepiece

Displays the total magnification of the selected beam path with
all activated intermediate magnifications above the Eyepiece
icon. To direct the light path fully to the eyepiece, simply leftclick on the icon.

Shutter

Here you can set the shutter to Open or Closed. The status is
displayed in text form above the icon.

/
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Parameter

Description

Reflector
Turret

Here you can select one of the configured filter cubes for reflected light techniques from the list.

Nosepiece /
Objective

Select the desired Objective from the list.

Stage

Here you see the options for Stage Control and Focus Control.
§ Stage >>: Opens the Stage Tool [} 798] in the Right Tool
Area.
There you can move the microscope stage virtually with the
help of a software joystick or by entering absolute coordinates. You can also calibrate the stage within that tool.
§ Focus >>: Opens the Focus Tool [} 800] in the Right Tool
Area.
There you can move the focus drive virtually with the help of a
software joystick or by entering absolute coordinates. You can
also calibrate the focus drive within that tool.

Aperture
Diaphragm

Adjust the diaphragm opening (0% to 100%) using the slider or
spin box/input field.

Filter
Wheel

Here you can enter the first neutral density filter (e.g. 0.4%, 6%,
100%, 100%) that you require.

Condenser

The condenser is only available in the Transmitted Light path.

Camera/
Eyepiece
Switch

Select whether you want to direct the light to the camera only
(100% Camera), to the camera and the eyepiece (30% Eyepiece/70% Camera) or to the eyepiece only (100% Eyepiece)
from the list .

Camera

Shows the selected camera above the icon.

Microscope
Manager

Opens the Microscope Manager [} 668] dialog.

Reflected
Light/
Transmitted Light
Switch

If your microscope has a halogen lamp for both reflected and
transmitted light illumination, here you can select whether you
want to control the halogen lamp for reflected light illumination
or the halogen lamp for transmitted light illumination.

6x Motorized Beam
Splitter
Wheel

This device is part of the Motorized Dual Filter Wheel. Select the
desired Dichroic position from the dialog. Switching time is
about 300 msec between neighboring positions.

Select the contrast method from the list (e.g. brightfield, darkfield, phase contrast ring 1, 2, 3, DIC I, II, III).
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Description

6x Motorized Emission Filter
Wheel

This device is part of the Motorized Dual Filter Wheel. Select the
desired Emission Filter position from the dialog. Switching time is
between 60 and 240 msec between neighboring positions (depending on the speed configuration in the MTB2011 Configuration program).

6x Motorized Excitation Filter
Wheel

Select the desired Excitation Filter position from the dialog.
Switching time is between 70 and 300 msec between neighboring positions (depending on the speed configuration in the
MTB2011 Configuration program).

12x Motorized
vReflector
Changer

If a Motorized Dual Filter Wheel and a Motorized Emission Filter
Wheel is present, up to 12 virtual Reflektor positions can be configured in the MTB2011 Configuration program. Select the desired filter combination from the list of available positions. This is
more convenient than adjusting excitation, dichroic and emission
filters individually.

13.3.1.1.1 Microscope Manager

Parameter

Description

Contrast Manager
Mode

Select the setting for the contrast mode from the Mode dropdown
list.

-

Off

The Contrast Manager is not used. All settings must be made manually or via a settings file.

-

On Demand

The function of the Contrast Manager is activated via the touch
screen on the microscope.

-

Contrast Retaining

If core components (e.g. condenser, reflector, shutter) for a certain
contrast technique are changed, dependent components are also
changed accordingly.

Method

Select one of the available methods for the contrast mode here.

Light Manager
Enabled

Activated: Activates the Light Manager. Activates the Mode dropdown list in the Light Manager.

Mode

Select a setting for adjusting the brightness of the light here.

-

Objective

Adjusts the brightness of the light via the lamp voltage. The color
temperature changes accordingly.

-

Classic

Adjusts the brightness on the basis of the available filter wheels. The
color temperature is retained. Only if the brightness adjustment cannot be achieved via the filter wheels does adjustment take place via
the lamp voltage.

Dazzle Protection

Activated: Activates dazzle protection.
Dazzle protection prevents light from passing through the eyepiece
and dazzling the user, for example when reflector positions are
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Description
changed. This is mainly achieved by closing the reflected or transmitted light shutter. If no shutters are installed, the lamp voltage is adjusted.

Parfocal Correction

Activated: Parfocal correction is activated.

Parcentral Correction

Activated: Parcentral correction is activated.

13.3.1.2 Camera Tool
Here you can configure all the settings for the selected camera.
Please note that the functions and settings in this tool depend on which camera you are using
meaning not all cameras have all the functions described in here.
13.3.1.2.1 Exposure Time Section
The Exposure Time section enables you to control the exposure settings of your camera.
If you use automatic exposure, you can select an area on the camera sensor which is used to calculate the exposure time.

Parameter

Description

Time

Specifies the duration of the image acquisition. Selects the unit of
time (min, ms, s, µs).

Auto Exposure

Activated: The exposure time is calculated automatically every time
an image is acquired. The exposure time in the corresponding input
field fluctuates accordingly.
Deactivated: The exposure time must be set manually.

Intensity

Enables you to compensate for underexposure or overexposure if you
are not content with the auto exposure result.
§ 5% - 100%: Darkens the image (compensates for overexposure)
§ 100% - 200%: Brightens the image (compensates for underexposure)

Set Exposure

Starts a one-off measurement of the exposure time, which is then
used for all subsequent images. Deactivates the Auto Exposure
checkbox.
If you are not satisfied with the result, you can adjust the measured
exposure time manually.

Spot Meter / Focus
ROI

Activated: The exposure time and focus measurements use the intensity values within a specified area instead of the entire camera sensor
area. This improves the results for the area to be acquired.
If the red Spot Meter / Focus ROI frame is not visible in the live image, right-click in the live image and select Spot Meter / Focus ROI
from the context menu.
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Parameter

Description

Binning

Here you can set the binning.
Binning combines the information of neighboring camera pixels
into a single larger pixel. For example, if the binning is set to 2 ×
2, four pixels are combined to one.
Increasing the binning means weaker signals can be detected for
a given exposure time.
For CCD cameras, binning increases sensitivity by improving the
signal-to-noise ratio, with resolution being decreased by the
same factor.
In the case of CMOS cameras, only the signal intensity is increased and the pixel count and resolution gets reduced correspondingly.

Binning-independent
Brightness

Only visible when the Show all mode is activated.

IP Quality

Here you can select the color interpolation quality (IP Quality)
for the acquired image. Please note that this function does not
apply to Live mode.

Because Binning generally increases signal intensity, the brightness of the image normally also increases correspondingly. By activating this checkbox, the brightness level is automatically fixed
(depending on the camera, either through exposure time adjustment or averaging), no matter the binning setting.

Fast: color interpolation for optimum speed (shorter computation).
High: color interpolation for optimum quality (less artifacts). This
mode is only effective with binning factor 1.
Subsampling

Here you can reduce the amount of data acquired to achieve
faster frame rates. By subsampling 2x2, the effective pixel pitch is
increased by sampling only every other pixel, thus reducing the
overall data size of your image.
The modern CMOS sensors in the Axiocam 705 and 712 offer a
on-chip subsampling mode. This subsampling mode enables a
dramatic increase in frame rate especially for time series acquisition (at short exposure times) at an full field of view of the camera.
In addition, the amount of produced image data is decreased. As
this is done by skipping every second pixel in x and y direction,
the optical resolution is decreased accordingly. Especially in high
magnification objectives at lower NA values, the image resolution is optically limited. So this function can be used to minimize
empty image information.

Resolution

Displays and selects the camera resolution, e.g. 1024 x 1024 px.
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13.3.1.2.2 White Balance Section
This section is only visible if you are using a color camera.
The section enables you to adjust the color balance to a neutral hue independent of the light
source used.
Save suitable white balance settings using the Settings section to ensure color reproducibility of
images acquired in the future.

Parameter

Description

Auto

Compensates for the color temperature of the light source automatically to yield a neutral hue.
The entire camera sensor area is measured. If there are no pure white
areas on the sample and Auto does not yield the desired results, measure and compensate for the color temperature of the light source as
follows:
§ Transmitted light: Move the sample such that a clear and transparent region is illuminated or remove the sample from the microscope. Click the Auto button to perform the auto white balance.
§ Reflected light: Use a neutral surface (e.g. a piece of white paper)
as a sample. Click the Auto button to perform the auto white balance.
You can now acquire white balanced images of your sample with the
above settings.

Pick...

Enables you to select a reference pixel for white balance from the live
image.
The selected pixel should be neutral white.

3200 K

Applies a predefined color balance setting to compensate for the
color temperature of a halogen light source at approximately 3200 K.

5500 K

Applies a predefined color balance setting to compensate for the
color temperature of an LED light source at approximately 5500 K.

Show Channels

Enables you to set the color balance of each color channel (red/cyan,
green/magenta and blue/yellow) individually to make the image appear neutral.

Color Temperature

Changes the overall color temperature of the image from cool (blue
cast) to warm (red cast).
The color channels (red/cyan, green/magenta and blue/yellow) are adjusted automatically. The Color Temperature setting can work
against the settings applied using Show Channels.
Use Color Temperature for fine tuning in combination with Pick... if
Pick... does not give perfect results.

Saturation

Changes the colorfulness of the image.

Reset

Resets any color changes and sets the white balance value to 6500 K.
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13.3.1.2.3 Acquisition ROI Section
In this section you can define a Region Of Interest (ROI) on the camera sensor which will be
used for acquisition. A smaller ROI can increase the acquisition speed.
The region of interest is indicated by a blue frame in the preview window and can be moved and
resized freely. The preview window always shows the entire camera sensor area which can be acquired.
The Pixel Size shown below the preview window indicates the size in µm to which a pixel corresponds. This depends on the camera sensor properties and on the binning.

Parameter

Description

Maximize

Selects the entire available image sensor area as the region of interest.

Center

Positions the region of interest precisely at the center of the image.

Size

Sets the width and height of the region of interest in pixels.

Offset

Specifies the position of the top left corner of the Acquisition ROI
(blue frame) with respect to the top left corner of the preview window.

Refresh Overview

Acquires and displays an image in the preview window with the current ROI settings. This has no effect on the image in the Center
Screen Area.

Crop

Allows you to specify a ROI (Region of Interest) in a snapped image.
The "cropped" area is used as ROI for the next image acquisition.
If no image is available in the Center Screen Area the button is deactivated.

13.3.1.2.4 Gain Section
Using the gain adjustment amplifies the signal intensity and brightness of the camera image while
at the same time reducing the available dynamic range.
For Axiocam 702, 705, and 712 models: The Gain mode allows an signal amplification as specified in the camera data sheet. For these CMOS sensor based camera models, also the sensitivity of
the cameras is amplified and the cameras can detect weaker signals. Please note, that by amplifying a signal, the max/min signal intensity which can be acquired will be limited. The consequence
is a reduction of the available dynamic range. Gain 4 (opt) is a best compromise between sensitivity and available dynamic range. Gain 1x (min) is the minimum signal amplification with the highest dynamic range. Gain 16x (max) is the highest sensitivity with the smallest dynamic range.
HDR (0.2x) Mode
The High Dynamic Range Mode of the 702, 705, 712 cameras offers a method to increase the
available dynamic range by a factor of 5x. This methods returns noise free information in very dim
image areas and can record simultaneously very bright image areas. As the additional intensity
range is extended for brighter image signals, regular signals get 5 times dimmer (0.2 times) compared to a standard setting. This is achieved by combing two images with different adjustments:
one at a shorter exposure and a low gain value for the bright signals and one image at longer exposure times and higher gain for the weak signals. The used exposure times are automatically derived from the current camera setting. It also works in the live image mode, but reduces the frame
speed accordingly.
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Please execute a proper exposure readjustment after activating this feature. This feature is very
useful if the camera should acquire reflective surfaces, i.e. in materials applications, or in polarization microscopy of minerals.
13.3.1.2.5 Post Processing Section
Here you can apply basic image processing functions while acquiring the image. This can be helpful if certain image processing steps are necessary for any acquired image and saves image processing work later in a job.
Depending on the camera model, different settings are available.

Parameter

Description

Black Reference

Influences the live image and each image acquired. For the black reference to work, you first need to acquire a reference image. Define a
corresponding reference image using the Define button.
Activated: Applies the measured black reference to the image.
Deactivated: The measured black reference is not used. The reference image is retained.
If longer exposure times are used (from exposure times of approx.
>5s, depending on the camera), individual bright pixels may become
visible with CCD or CMOS sensors. With the help of the black reference these effects are measured and corrected in accordance with the
exposure time employed.
It is recommended that you repeat this measurement at certain intervals.
This correction is recommended in particular for applications that involve long exposure times, i.e. for which very little light is used (live
cell imaging, fluorescence images).
The availability of a black reference for the selected camera can be
checked on the menu Extras | Calibration Management.

-

Define

Automatically defines the black reference. The measurement lasts for
several seconds. The Black Reference checkbox is then activated automatically.

Info
For the measurement the camera must see a completely dark image. The light path to the
camera must therefore be blocked. Set the eyepiece switch to 100% eyepiece and close the reflected light/transmitted light shutter. To define the black reference, click on the Define button.
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Parameter

Description

Shading Correction

Shading correction is used to correct optical effects, such as minor differences in illumination or static contaminants in the beam path, with
the help of a reference image. The reference image must be acquired
without a sample. You can select between two modes Global and
Specific from the dropdown list (see description below).
After you have selected the mode simply click on the Define button.
Activated: Applies the defined shading correction to the image. The
applied correction mode is multiplicative.
Deactivated: The measured shading correction is not used. The reference image is retained.

-

Define

Automatically calculates the shading correction.

-

Global

Performs an objective specific shading correction. This is the default
method for shading correction. The following components will be
considered:
§ Magnification: Objective and Optovar
§ Camera bit depth and RGB/BW mode
§ Camera type and port position
Fluorescent filters or other fluorescence specific components are not
considered.
In principle, shading correction is objective specific. A separate reference image has to be created for each objective. Once calibration has
been completed, the correction image associated with the objective
being used is loaded automatically if shading correction is active. If no
correction image is available for an objective, the Shading Correction checkbox is automatically deactivated when the objective in
question is swung in. Objective recognition on a motorized or encoded microscope is required for these automatic actions.

-

Specific

Performs channel-specific shading correction. In this case the fluorescence filter block used is saved with the shading file. If the fluorescence channel is changed, a previously created reference image is also
loaded.
The availability of created reference images can be checked on the
menu Tools | Calibration Manager. Incorrect reference images can
also be deleted there. The following components will be considered:
§ Contrasting method and condenser
§ Fluorescence reflector and beam splitter
§ Spinning disc fluorescence filter

Info
An empty image without structures at a medium illumination intensity is required for the shading correction measurement. To create this image, locate an empty position on the slide outside the sample and acquire an image for shading correction there. There must be no visible
structures on the slide, as these will be incorporated into the correction image and could then
lead to a visible artifact at other positions. It may be necessary to clean the slide and defocus
the microscope slightly. You should bear in mind that Köhler illumination needs to be set correctly. No part of the image must be overexposed.
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Parameter

Description

Enable Noise Filter

Activated: Filters the noise in the acquired image according to the
adjusted threshold. Affects acquired images only. The live image does
not change.
Deals with sporadic bright events in single pixels on CMOS sensors,
like blinking pixels in dark images or spurious cosmic ray events. This
feature is most useful for situations with high gain settings for acquisition of very dim signals with CMOS or EMCCD cameras. In combination with a correct black reference an absolutely flat signal background can be produced.

-

Threshold

The higher the value, the greater the tolerance for noise. The lower
the value, the stronger the noise reduction.
The noise filter reduces the extent to which individual pixels deviate
from the average value of their nearest neighbors. The Threshold
corresponds to a tolerance value. If the deviation of the middle pixel
value from the average value of the pixels immediately surrounding it
exceeds the tolerance value (i.e. it is interpreted as noise), it is replaced by the average value.
This technique reduces the noise of individual pixels that are produced, in particular with EMCCD cameras and CMOS cameras. The selected technique prevents any changes being made to object edges,
as in most cases these are larger than individual pixels.
This filter is also suitable for removing individual "hot pixels" from an
image without having to acquire a reference image in advance.

Enable Unsharp
Mask

Enhances contrasts at fine structures and edges. Thus, the resulting
image appears clearer and enriched in detail.

-

Strength

Controls the amount of contrast enhancement applied to fine structures and edges. The higher the strength, the darker or lighter the resulting edges, compared to the original image.

-

Radius

Determines the size of detail to be enhanced. A small radius enhances
smaller details.
The radius also affects the appearance of enhanced edges. A large radius leads to a visible halo along enhanced edges. The larger the radius, the broader the halo.

-

Color Mode

Determines the calculation method, which affects the appearance of
the output image.
§ RGB:
– The Unsharp Mask filter calculates the sharpness for each color
channel individually.
– The color saturation and the color of structures may be changed
and color noise may occur.
§ Luminance:
– The Unsharp Mask filter calculates the sharpness based on the
luminance signal computed from the RGB channels.
– This mode avoids possible color noise or shift in color saturation,
which could be induced by certain image textures.

-

Auto Contrast

Activated: Enables you to adjust the Contrast Tolerance (0-20).
Auto Contrast only works in RGB color mode.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

675

13 Software Functions & Reference | 13.3 Tools

Parameter
-

Contrast Tolerance

ZEISS

Description
Increasing the contrast during unsharp masking is achieved by broadening the distribution of intensities. This corresponds to a spread of
the image histogram.
Controls how much the intensity distribution is spread and thus how
strong the contrast is increased.
§ Contrast Tolerance = 0 : No spread of intensities, no increase of
contrast
§ Contrast Tolerance = 20: Maximum spread of intensities, maximum increase of contrast

-

Clip To Valid
Bits

Activated: Composes the processed image of the same colors as the
original image (i.e. the value range of the output image is adjusted to
the color range of the input image).
Deactivated: Colors not present in the original image may appear in
the processed image.

See also
2 Shading Correction [} 120]
13.3.1.2.6 Settings Section
In this section you can save all the settings you have made in the camera tool to a settings file
(*.czcs). This is very helpful because you can restore/load your saved settings very quickly when
starting the software again.

Parameter

Description

Default

Resets all camera settings in the Camera tool to the factory default settings. These settings can also be selected from the dropdown list of available camera settings to the right of the Default
button. To do this, select the Original Settings entry.

Options

Opens the Options [} 676] menu.

Reload

Undoes the changes you have made to a loaded setting and restores the original status of the loaded setting.

13.3.1.2.6.1 Camera Tool Options

Parameter

Description

New

Creates a new camera setting. Enter a name for the camera setting in
the input field. To save the camera setting, click on the Disc icon to
the right of the input field.

Rename

Renames the current camera setting. Enter another name for the camera setting in the input field. To save the camera setting, click on the
Disc icon to the right of the input field.

Save

Saves the current camera setting.
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Parameter

Description

Save As

Saves the current camera setting under a new name. Enter a new
name in the input field. To save the camera setting, click on the Disc
icon to the right of the input field.

Import

Imports an existing camera setting.

Export

Exports the selected camera setting.

Delete

Deletes the selected camera setting.

13.3.1.2.7 Mode Section
In this section you can adjust how the software retrieves the camera sensor data.

Parameter

Description

Color Mode

This parameter is available for color cameras only.

–

RGB

Transmits the image data of a color camera unchanged. This corresponds to the standard operating mode of a color camera.

–

B/W

Treats the image data of the color channels as grayscale. The data of
related color channels are averaged. The saturation of the camera appears reduced as a result.
This process does not change the spectral properties of a color camera. The image information of the color sensor still undergoes color
interpolation. An infrared filter also restricts the spectral sensitivity of
the color camera compared to the spectral sensitivity of a genuine
black and white camera.

Live Speed

Here you can select the live image update speed (For CCD based Axiocam models = slow, medium, fast).
Enables you to focus or to find regions of interest on a sample
quickly. A high live image update speed reduces the exposure time of
the live image, even at longer exposure times used for image acquisition.
To achieve a similar impression of image brightness, however, the image data supplied must be adjusted digitally, which may generate a
certain amount of noise or reduce the resolution of the live image.
For CMOS sensor based camera model (e.g. 712 / 705) High Res, Fast,
Low Light).

–

Fast

Represents the image optimized and requires a shorter computation
time.

–

High

Represents the image without artifacts and with a higher image quality. This mode is only effective with binning factor 1.
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Parameter

Description

Bit Depth

The Bit Depth function enables the reduction of the delivered camera
bit depth. It is translating the 14 bit based camera data values into a
smaller value of 12 bit or 8 bit. This has an visible effect of the number range in the image histogram, the dynamic range and the corresponding image file size in an uncompressed CZI image.
As default, the Axiocam models deliver 14 bit per pixel (Axiocam 503/
506/ 512/ 702) and 12 bit/pixel in case of the Axiocam 305. 14 bit
and 12 bit per pixel values need to be stored in two bytes in an CZI
image file. In case of an translation to 8 bit per pixel, only one byte is
needed. Therefore it is possible to reduce the produced image file size
by a factor of two. This is especially beneficial, if large amount of image data is acquired.
By reducing the native camera bit depth to smaller values, the available number range for the digital image signal is decreased. Therefore, the available amount of resolvable intensities in one image scene
is decreased accordingly.

–

LUT min/LUT
max
(only available
for 8 bit mode)

LUT stands for Look Up Table. It describes the translation method for
quickly translating digital numbers in a different range. If the full
swing of the input signal is not used, the reduction of bit depth can
be adopted accordingly by the translation starting point "Lut min" and
the translation end point "Lut max".
If the used intensity range equals just an 8 bit value range, no information is lost and the unused bits can be excluded from being stored
by an suitably adjusted translation table.
Available range is 0 to 1. The value 0 equals 0% of the input range.
The number 1 equals 100% of the input range.

–

Gamma
(only available
for 8 bit mode)

The 14 bit to 8 bit translation is linear by default, which equals a
Gamma value of 1. By assigning values larger or smaller then 1, the
translation becomes non linear.
Values <1 selectively reduce dim signal intensities.
Values >1 selectively amplify dim signal intensities.

13.3.1.2.8 Trigger Control Section
Only visible if the selected camera has a trigger input/output.
Trigger Out section
Using the trigger output you set how the camera sends a trigger signal to an external component
(e.g. shutter).

Info
Activate both checkboxes if you want the trigger signal to be generated both during the live
image and during acquisition.

Parameter

Description

Enable for Snap

Activated: Generates the trigger signal during the acquisition of an
image.

Enable for Live

Activated: Generates the trigger signal during the live image.
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Description

Control Signal

-

Active High

The Control Signal jumps from 0 Volts to 5 Volts when the camera's
exposure begins. Following exposure it returns to 0 Volts.

-

Active Low

The Control Signal jumps from 5 Volts to 0 Volts when the camera's
exposure begins. Following exposure it returns to 5 Volts.

Shutter Open Delay

Here you can enter the delay before acquisition.

Trigger In section
The trigger input allows you to trigger acquisition by the camera using an external trigger signal.

Info
Due to its inertia, a mechanical shutter needs a certain amount of time to change from the
closed to the open position after the control signal has been generated. To ensure that this
transitional state is not recorded during the exposure of the sensor, the start of actual acquisition can be delayed by an adjustable period of time.

Parameter

Description

Enable for Snap

Activated: Only acquires the image after the trigger signal has been
received.

Control Signal

-

Active High

The Control Signal jumps from 0 Volts to 5 Volts when the camera's
exposure begins. Following exposure it returns to 0 Volts.

-

Active Low

The Control Signal jumps from 5 Volts to 0 Volts when the camera's
exposure begins. Following exposure it returns to 5 Volts.

13.3.1.2.9 Model Specific Section
Only visible if the Show All mode is activated.
To show the section in full, click on the arrow button

.

In this section you see additional, model-specific camera settings depending on which camera you
use on your system.
Reset button
Resets all entries to the original values.
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13.3.1.2.9.1 Axiocam 506
Camera Identifier
A clear identifier for the currently active camera is displayed here. It consists of the product name
and part of the serial number. This is helpful if you want to identify the camera in question, e.g.
when working with a dual camera system.
Orientation dropdown list
Here you can select the orientation of the camera image. This allows you to adjust the camera image to the properties of the different camera ports. The following selection options are available:
§

Original

§

Flip Horizontally

§

Flip Vertically

§

Rotate 90 CW

§

Rotate 90 CCW

§

Rotate 180

§

Mirror at +45 Diagonal

§

Mirror at -45 Diagonal

Acquire section
Readout Speed (MHz)
Readout speed can be varied between 39 MHz and 13 MHz if the camera is operated on the
USB3.0 bus. In case the camera is connected to the slower USB2.0 Bus only the 13 MHz mode is
available. At the slower 13 MHz the signal quality is slightly improved due to a reduced noise of
the signal transmission.
Cooling
Status information, if camera cooling is active. The Axiocam 506 can be operated without active
cooling. Cooling is deactivated if the USB2.0 connector of the camera is not supported to the PC
or to a USB compatible power supply.
Readout Port
The Axiocam 506 uses a high performance CCD sensor with four readout ports. It can be adjusted
to quadport, dualport, singleport and Auto mode. Maximum speed is reached by using all four
ports and short exposure times. When exposure time gets larger than the readout time the benefit for using multiple ports is getting insignificant. By switching the readout mode to single port,
the most homogenous signal quality can be reached as all data is sent through one single processing chain. In Auto mode, the number of used readout ports is selected automatically depending on the exposure time.
Readout Time
The valid camera readout (in ms) time is given in this status window which is defined by the number of used ports or by defining a sensor sub region window (ROI).
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Temperature
The valid CCD sensor temperature is shown here. It is adjusted to 18 C°. It can not be changed. If
a black reference is used it should be used at the same sensor temperature when it was created.
If free air circulation for the camera housing is blocked, it may happen that the sensor temperature is increased and the dark current of the sensor may be higher than normal. If the camera is
operated without cooling (USB 2.0 port of camera not connected) the sensor temperature is increased and dark current will be higher than normal. This should be considered when using the
camera at longer exposure times.
13.3.1.2.9.2 Axiocam 712 / 705
Camera Identifier
A clear identifier for the currently active camera is displayed here. It consists of the product name
and part of the serial number. This is helpful if you want to identify the camera in question, e.g.
when working with a dual camera system.
Orientation dropdown list
Here you can select the orientation of the camera image. This allows you to adjust the camera image to the properties of the different camera ports. The following selection options are available:
§

Original

§

Flip Horizontally

§

Flip Vertically

§

Rotate 90 CW

§

Rotate 90 CCW

§

Rotate 180

§

Mirror at +45 Diagonal

§

Mirror at -45 Diagonal

Acquire section
Readout Speed (MHz)
Readout speed can be varied between 39 MHz and 13 MHz if the camera is operated on the
USB3.0 bus. In case the camera is connected to the slower USB2.0 Bus only the 13 MHz mode is
available. At the slower 13 MHz the signal quality is slightly improved due to a reduced noise of
the signal transmission. In case of the 7 series Axiocam models, the readout clock speed is 37
MHz. This speed is fixed and can not changed.
Cooling
Status information, if camera cooling is active. The Axiocam models of the 5 and 7 series can be
operated without active cooling. Cooling is deactivated if the USB2.0 connector of the camera is
not supported to the PC or to a USB compatible power supply.
Readout Time (ms)
The valid camera readout time is given in this status window which is defined by the number of
used ports or by defining a sensor sub region window (ROI).
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Post Processing section
SW Subsampling
The software subsampling feature is used to reduce the image size, which helps to reduce the
amount of the image data load in case of long time lapse or multi-dimensional images. As this is
done by software processing, the full image is acquired and prepared before it is downsized by
this function. Especially in high magnification objectives at lower NA values, the image resolution
is optically limited. So this function can be used to minimize empty image information. This feature works with all Axiocam 3 series, 5 series, and 7 series models. In case of the 7 series models,
the on chip sub sampling offers a speed benefit.
Temperature
The valid sensor temperature is shown here. It is adjusted to 18 C°. It can not be changed. If a
black reference is used it should be used at the same sensor temperature when it was created.
If free air circulation for the camera housing is blocked, it may happen that the sensor temperature is increased and the dark current of the sensor may be higher than normal. If the camera is
operated without cooling ( USB2.0 port of camera not connected) the sensor temperature is increased and dark current will be higher than normal. This should be considered when using the
camera at longer exposure times.
13.3.1.3 Movie Recorder Tool
Here you can acquire image sequences in the form of videos using the camera's fastest burst
mode.

Info
To play the acquired Movie, use the Player tab in the Center Screen Area (Only visible in
Show All mode).

Parameter

Description

Start Movie

Starts the acquisition. The button changes into the Pause button. The
animated Stop button appears in the window above the button.

Pause Movie

Pauses the acquisition. The button changes into the Continue button.

Continue Movie

Continues acquisition if it has been paused. The button changes into
the Pause button.

Stop

Stops acquisition. Save the acquired movies either
§ in the internal CZI format via File menu | Save as...
§ as a series of individual images via File menu | Export/Import | Export
§ or as an AVI file via File | Export/Import | Movie Export.
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13.3.1.4 Live Panorama tool
With this tool you can acquire a panorama image exceeding the size of a single image.

Parameter

Description

Start Live
Panorama

Starts the acquisition. The button disappears. The animated Stop button appears in the window above the button.
For more information, see Acquiring a Panorama Image Automatically [} 49].

13.3.1.5 Manual Extended Depth of Focus Tool

Parameter

Description

Z-Stack

If activated, an EDF image is acquired out of a Z-Stack image.

Quality

Here you can select the quality level that you want the function to
work with.

Registration
Method

Here you can select the method (or a combination of these) to be
used to align the images.

-

Translation

The neighboring sections of the Z-stack image are shifted in relation
to each other in the X and Y direction.

-

Rotation

The neighboring sections of the Z-stack image are rotated in relation
to each other.

-

Iso Scaling

The magnification is adjusted from section to section.

-

Skew Scaling

The neighboring sections of the Z-stack image are corrected for skewness / shearing.

-

Affine

The neighboring sections of the Z-stack image are shifted in the X and
Y direction, rotated and the magnification is adjusted from section to
section.

Interpolation

Here you can select how you want interpolation to be performed if a
pixel is calculated from several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial
function of the input pixels closest to it.

Mode

-

Timer

Acquires an EDF (Extended Depth of Focus) image automatically after
the interval you have set.

-

F12 Key

Acquires an EDF image when you press F12 key.
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Parameter

Description

Interval

Only active, if you have clicked on the Timer button.
Set interval (in sec.) here, after which the automatic acquisition begins.

Start

Starts the acquisition of an image series.
Press the Pause button to pause acquisition.
Press the Continue button, to continue acquisition.
Press the Stop button to stop acquisition. The image with extended
focus will be calculated from all single images.

13.3.2 Tools on Acquisition Tab
13.3.2.1 Imaging Setup Tool
Only visible, if the Enable Imaging Setup checkbox in the Tools > Options > Acquisition > Acquisition Tab is activated.
View and adjust the hardware parameters used for confocal (LSM) or camera (WF) experiments.
All hardware parameters set to detect one or more specific signals simultaneously are defined as
one track. Specific tracks can be combined for image acquisition which is then called a multitrack
acquisition.

Info
Note that the Microscope Control tool on the Locate tab has a similar appearance and similar control elements but its function differs from the Imaging Setup tool described here.
If there is no track configured, you need to add a first track to the experiment by clicking on the
drop down button. To see a list of the availalbe acquisition modes, click on the arrow on the right
side of the button.

Fig. 58: Imaging Setup without tracks
If tracks are available each track will show as a button with the respective name (Track1, Track2,
etc.) on the top of the tool. The active track is highlighted in blue color and the type of acquisition
track is indicated below the button. Some tracks can be combined for image acquisition and run
as a multitrack acquisition. All active tracks for acquisition are either blue (current active track and
settings displayed below) or dark grey with white writing. Inactive tracks not used for acquisition
are dark grey with grey writing. Tracks which cannot be combined for image acquisition with the
current active track(s) are two-dimensional grey with grey writing. Switch between the tracks by
clicking on the corresponding track button. Use the Delete
button to delete tracks and access further options for editing via the Options
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Fig. 59: Imaging Setup with tracks
Depending on what kind of track you have selected the Imaging Setup tool has a different appearance. For a detailed description of the specific parameters read the chapters Imaging Setup
(WF) [} 685] and/or Imaging Setup (LSM 980) [} 963].
Tracks of different kind are not always compatible with each other. It is e.g. not possible to combine camera and LSM acquisition into one single image. The Imaging Setup and Channels tool will
automatically disable incompatible tracks upon creation of new tracks. To re-enable incompatible
tracks, you need to deactivate first the active tracks. Once all incompatible tracks are disabled, the
remaining tracks can be activated again.
13.3.2.1.1 Imaging Setup (WF)
By selecting a WF track you can see the graphical display of the acquisition light path with various
icons. The arrangement of the icons represents the typical set-up of the microscope components
configured on your system. For a description of the most common icons, read Reflected/Transmitted Light Path.
The associated hardware settings are shown above the icons and can be changed here. To
change the relevant hardware settings, left-click on the icons. In the shortcut menus you will see
numerous selection and setting options for adjusting your settings.

Info
Any change you make is automatically adopted and written to the corresponding hardware
setting of the experiment. If you want to undo these changes, do not save the experiment. Instead, reload the experiment in the Experiment Manager.
If you change the hardware settings in this section, please bear the following points in mind:
§

If the checkbox Include in this setting is activated the component is activated. Activated
components are included into the hardware settings of the experiment and subsequently applied in the experiment. Activated components are highlighted in blue color.

§

Components with a deactivated checkbox are not adopted into the hardware settings of the
experiment and are not subsequently applied in the experiment. These components are displayed with a grayed-out icon.

§

Components with a filled-in checkbox and a triangle underneath are only partially adopted
into the hardware settings of the experiment and subsequently applied in the experiment. To
show the sub-components, click on the triangle under the checkbox. To adopt the sub-components into the hardware settings of the experiment and subsequently apply them in the experiment, activate the relevant checkboxes for the sub-components.
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13.3.2.1.2 Advanced Imaging Setup
Only visible, if the Enable Advanced Imaging Setup checkbox in the Tools menu | Options |
Acquisition | Acquisition Tab | Enable Imaging Setup is activated.
There is a switch on top of the tool. By clicking on the button you can switch from the Standard
to the Advanced Imaging Setup.

Fig. 60: Advanced Imaging Setup
The Advanced Imaging Setup offers additional options for controlling an experiment. The Before/
After Experiment settings can be found right under the Standard/Advanced button.
Additionally the Experiment Settings Pool can be found at the bottom of the tool. We recommend that you talk to ZEISS Service staff or Imaging Specialists before you try to change settings
here, as they should be changed only if you know what you are doing.
Before/After Experiment settings

Parameter

Description

Before/After Experiment

Shows the name of the hardware setting that will be applied immediately before or after the experiment.

Options

Opens the Options menu for the specific hardware setting.

Go!

Applies the selected hardware settings.

Previous/Next

The buttons allow you to navigate through the various hardware
settings.

Experiment Settings Pool

Parameter

Description

Clear all unused hardware settings from experiment

By clicking on the Clear button you can delete all unused hardware settings from your experiment.

All available hardware
settings in experiment

Here you can see all available hardware settings.
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13.3.2.2 Acquisition Mode Tool
In the Acquisition Mode tool you can set the various acquisition parameters that you want to
apply for the entire experiment.

Info
If you have created an experiment using the Experiment Designer tool, the settings in the
Acquisition Mode tool only apply to the relevant experiment block and may differ in the next
block.
In terms of content and appearance, the Acquisition mode tool is largely dependent on which
imaging mode was chosen in the Imaging Setup tool, either LSM tracks or widefield channels.
If you have configured LSM tracks, including e.g. Airyscan or Lambda Tracks, please read the
chapter Parameters for LSM Imaging Modes [} 688].
If you have configured widefield channels, please read the chapter Parameters for Widefield
Mode [} 692].
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13.3.2.2.1 Parameters for LSM Imaging Modes
Adjust scanning and acquisition parameters that you want to apply for the entire experiment.
In case the experiment is run as a multiblock experiment, the settings apply to one experiment
block only.
Note that the available controls vary with the chosen track mode for LSM:
§

LSM confocal

§

Airyscan SR

§

Airyscan MPLX

§

NDD

§

LSM Lambda

§

LSM Online Fingerprinting

1
2

3

4

5
6

7
8

9
10
Fig. 61: Acquisition Mode tool

No.
1

Parameter

Description

Scan Mode

Select the Scan Mode.
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Description

- Frame

Activates the frame scan mode. If this mode is selected you will
see the representation of the scanning frame in the Scan Area
section.

- Line

Activates the line scan mode. If this mode is selected you will see
the representation of the scanning line in the Scan Area section.
A line scan must be 128 pixels or more. Lower values are set
back to 128 pixels. A line scan cannot be used to define a bleach
region within a time series.

Not available for Airyscan acquisition, as at least 32 lines are required to perform Airyscan processing.

- Spot

Activates the spot scan mode. If this mode is selected (only available for LSM confocal mode) the scanner is stationary at a spot
and the signal intensity is acquired from this one position.

Note that one acquisition cycle / Snap consists of 1000 pixels
each with the defined integration time. When acquiring a time
series in spot scan mode, higher scan speeds will result in one or
more dark pixels at the beginning of each acquisition cycle. Reduce the speed to avoid this behaviour. Spot scan cannot be
combined with an acquisition region defined in the Experiment
Regions tool.

2

Crop Area

- Zoom

Clicking the button projects a rectangular overlay into the center
of the displayed image document representing the area of 2 x
zoom. The overlay graphics can be adjusted to the sample region
to be imaged in any rectangular rotated or non rotated from
within the boundaries of the scan field. The subsequent image
acquisition will then be confined to this area.
Note that with a tile image the function will fail if the current
stage position is not in the center position of the tile region because Crop Area is confined to the Scan Area and does not
move the stage.
Adjust the zoom level from 0.5x (0.6 for LSM 980 on Axio Observer and Axio Imager; 0.7 for LSM 980 on Axio Examiner) 40x by using the Zoom slider.
You can also enter a specific value in the input field. If clicking on
the 1 button behind the input field the zoom level will be reset
to default (1,0x) for confocal acquisition, 1.7 for Airyscan SR
tracks on LSM 980; and 1.3x for Airyscan tracks using LSM 900.
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3

Scan Area

In this expandable section, you can adjust the position of the
scan area.
The outer frame corresponds to the field of view of the microscope.
The inner frame represents the scan area. All changes of Offset
and Rotation made in this section will be immediately applied to
the scan area.
Following functions are available:

- Offset

Adjust the offset by using the Left / Right or Up / Down sliders.
You can also enter a specific value in the input field.
If clicking on the C button behind the input filed the offset position will be reset to center position.
If you left click on the inner frame and hold down the mouse
button you can move the scan area freely. The positions in the
input fields will be adopted according to your adjustments.

- Rotation

Adjust the rotation degree by using the Rotation slider. You can
also enter a specific value in the input field. If clicking on the O
button behind the input field the rotation degree will be reset to
default position (zero degree).

- Reset Scan

Resets all adjustment of Rotation, Offset and Zoom to the system defaults.

Area

4

Frame Size /
Sampling

- Presets button

- Confocal button

Adjust the frame size (in pixel) of the displayed image by entering
the desired value in the two input fields.
By clicking on this button you can select from a list of default
frame sizes (e.g. 128 x 128 or 512 x 512). We recommend to
start with 512 x 512 px.
By clicking on this button the frame size (image resolution) will
be set to an optimal value corresponding to the optical magnification (objective), the zoom factor and the wavelengths included
in the experiment. This provides an image where no spatial information is lost and no empty data is generated as optimal sampling is achieved. The confocal value is calculated for the given
objective and magnification settings matching a 1 fold sampling
according to 1 time Nyquist. Rectangular image dimensions are
preserved.
When you press this button once, it will change its color to blue.
This indicates that the optimal sampling will be maintained as
you continue to change acquisition parameters like zoom, Laser
lines or add more tracks. This active state of the button will be
lost once you manually edit the frame size or click the button
again.

- SR button

Clicking this button (for Airyscan SR mode only) sets the sampling to 2x Nyquist for superresolution mode.
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Parameter

Description

Scan Speed

Set the scan speed by adjusting the slider from 1 (slow) to 19 (for
LSM 900 the limit is 16) (very fast). The corresponding values for
FrameTime and Pixel Time will be displayed above the slider.
Please note that the available maximum scan speed depends on
the selected Frame Size and zoom factor. Maximum Speed is
available with a zoom factor of 13.2 (LSM 980) or 6.5x
(LSM 900).
By clicking on the Max button the maximal possible scan speed
will be set automatically.
When you click this button once, it will change its color to blue.
This indicates that the system will always use the highest possible
scan speed as you continue to change acquisition parameters like
zoom or frame size. Click the button again to deactivate this permanently active state.

6

Direction

Following scanning directions can be selected:

- Unidirectional

The laser scans in one direction only, then moves back with
beam blanked and scans the next line.

- Bi-directional

The laser also scans when moving backwards, i.e. the scan time
is reduced by about a factor of two.
Please note that the pixel shift between forward and backward
movement (double image) resulting from bi-directional scanning
must be corrected. To do that use the Correction X / Correction Y sliders.
By clicking on the Auto button an automatic scan correction will
be performed.
For optimal results this correction should be repeated every time
scan parameters like rotation, frame size, zoom or speed are
changed.

7

Line Step

Only available if the Frame Scan Mode is selected.
Select the desired line step size (from 1-10).
According to your selection only every n-th line is scanned. The
lines in between are interpolated. This fast scan mode is called
Step Scan. This feature is not available for Airyscan acquisition.

8

Averaging

- Number

Select the number of images you want to average (2x - 16x).

- Mode

Select the mode for averaging :
§ Repeat per Line:
The calculation of the average is based upon individual lines,
which are acquired sequentially before moving on. By this, the
data used for the averaging are is closely connected, but the
acquisition of the full frame takes respectively longer.
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Description
§ Repeat per Frame:
The calculation of the average is based on individual full
frames. Each frame is scanned quickly, but there is a higher
delay between the individual data sets taken for the averaging.

- Method

Select the method which will be used for averaging:
§ Mean Intensity:
Uses the mean average of all images
§ Sum Intensity:
Uses the sum of all images.

9

Bits per Pixel

Use the buttons to adjust the color bit depth to 8 Bit or 16 Bit
(i.e. 256 or 65536 gray values).

10

HDR Illumination

This parameter is only available if you have licensed the HDR
Confocal Basic module.
If activated, a HDR effect will be applied to the image. This effect
will boost weak structures without saturating bright areas in the
image and enable an optimal representation of the morphology
of weak and bright objects within the same image.
To achieve this, the image will be scanned three times with increasing the excitation intensity. Areas in the image, that displayed overexposure will be excluded in the following scans in
order to avoid photobleaching. It is recommended to use 16bit
for the acquisition of HDR datasets.
Note: HDR imaging is not possible when using an Experiment Region for Acquisition (see Experiment Regions Tool); whatever is
activated first (HDR or Experiment Region for Acquisition) will
then not allow to activate the other function.
HDR was developed based on ideas and a concept of O. Ronneberger and R. Nitschke (Albert-Ludwigs-University Freiburg,
Department of Computer Science and Life Imaging Center at
ZBSA).

13.3.2.2.2 Parameters for Widefield Mode
13.3.2.2.2.1 Camera Section
In this section you can adopt camera settings from the active camera to your experiment and adjust basic camera settings.

Parameter

Description

Get Settings from Active Camera

-

Get

Applies the settings from the active camera to your experiment.

-

Default

Resets the camera settings to factory default.
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Parameter

Description

Binning

Here you can set the binning.
Binning combines the information of neighboring camera pixels
into a single larger pixel. For example, if the binning is set to 2 ×
2, four pixels are combined to one.
Increasing the binning means weaker signals can be detected for
a given exposure time.
For CCD cameras, binning increases sensitivity by improving the
signal-to-noise ratio, with resolution being decreased by the
same factor.
In the case of CMOS cameras, only the signal intensity is increased and the pixel count and resolution gets reduced correspondingly.

Binning-independent
Brightness

Only visible when the Show all mode is activated.

IP Quality

Here you can select the color interpolation quality (IP Quality)
for the acquired image. Please note that this function does not
apply to Live mode.

Because Binning generally increases signal intensity, the brightness of the image normally also increases correspondingly. By activating this checkbox, the brightness level is automatically fixed
(depending on the camera, either through exposure time adjustment or averaging), no matter the binning setting.

Fast: color interpolation for optimum speed (shorter computation).
High: color interpolation for optimum quality (less artifacts). This
mode is only effective with binning factor 1.
Subsampling

Here you can reduce the amount of data acquired to achieve
faster frame rates. By subsampling 2x2, the effective pixel pitch is
increased by sampling only every other pixel, thus reducing the
overall data size of your image.
The modern CMOS sensors in the Axiocam 705 and 712 offer a
on-chip subsampling mode. This subsampling mode enables a
dramatic increase in frame rate especially for time series acquisition (at short exposure times) at an full field of view of the camera.
In addition, the amount of produced image data is decreased. As
this is done by skipping every second pixel in x and y direction,
the optical resolution is decreased accordingly. Especially in high
magnification objectives at lower NA values, the image resolution is optically limited. So this function can be used to minimize
empty image information.

Resolution

Displays and selects the camera resolution, e.g. 1024 x 1024 px.
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13.3.2.2.2.2 Acquisition ROI Section
In this section you can define a Region Of Interest (ROI) on the camera sensor which will be
used for acquisition. A smaller ROI can increase the acquisition speed.
The region of interest is indicated by a blue frame in the preview window and can be moved and
resized freely. The preview window always shows the entire camera sensor area which can be acquired.
The Pixel Size shown below the preview window indicates the size in µm to which a pixel corresponds. This depends on the camera sensor properties and on the binning.

Parameter

Description

Maximize

Selects the entire available image sensor area as the region of interest.

Center

Positions the region of interest precisely at the center of the image.

Size

Sets the width and height of the region of interest in pixels.

Offset

Specifies the position of the top left corner of the Acquisition ROI
(blue frame) with respect to the top left corner of the preview window.

Refresh Overview

Acquires and displays an image in the preview window with the current ROI settings. This has no effect on the image in the Center
Screen Area.

Crop

Allows you to specify a ROI (Region of Interest) in a snapped image.
The "cropped" area is used as ROI for the next image acquisition.
If no image is available in the Center Screen Area the button is deactivated.

13.3.2.2.2.3 Fast Acquisition Section
In this section you can set 3 different modes for acquisition.

Parameter

Description

Interactive

Using this mode you can intervene manually at certain points during
acquisition. The acquisition is comparatively slow.

Compromise

This mode is activated automatically if only individual hardware components, but not the whole system, are compatible with the Triggered
mode for acquiring an experiment.

Triggered

Fast acquisition via the hardware.

-

Validate

To establish whether the system is able to perform an experiment in
Triggered mode, click on the Validate button. The validation result
is displayed in the info box below the button bar.
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13.3.2.2.2.4 Post Processing Section
In this section on the Acquisition Tab in the Acquisition Mode tool you can apply basic image
processing functions while acquiring the image. This can be helpful if certain image processing
steps are necessary for any acquired image and saves image processing work later in a job. Depending on the camera model, different parameters can be available.

Parameter

Description

Black Reference

Influences the live image and each image acquired. For the black reference to work, you first need to acquire a reference image. Define a
corresponding reference image using the Define button.
Activated: Applies the measured black reference to the image.
Deactivated: The measured black reference is not used. The reference image is retained.
If longer exposure times are used (from exposure times of approx.
>5s, depending on the camera), individual bright pixels may become
visible with CCD or CMOS sensors. With the help of the black reference these effects are measured and corrected in accordance with the
exposure time employed.
It is recommended that you repeat this measurement at certain intervals.
This correction is recommended in particular for applications that involve long exposure times, i.e. for which very little light is used (live
cell imaging, fluorescence images).
The availability of a black reference for the selected camera can be
checked on the menu Extras | Calibration Management.

-

Define

Automatically defines the black reference. The measurement lasts for
several seconds. The Black Reference checkbox is then activated automatically.

Info
For the measurement the camera must see a completely dark image. The light path to the
camera must therefore be blocked. Set the eyepiece switch to 100% eyepiece and close the reflected light/transmitted light shutter. To define the black reference, click on the Define button.

Parameter

Description

Enable Noise Filter

Activated: Filters the noise in the acquired image according to the
adjusted threshold. Affects acquired images only. The live image does
not change.
Deals with sporadic bright events in single pixels on CMOS sensors,
like blinking pixels in dark images or spurious cosmic ray events. This
feature is most useful for situations with high gain settings for acquisition of very dim signals with CMOS or EMCCD cameras. In combination with a correct black reference an absolutely flat signal background can be produced.
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Description
The higher the value, the greater the tolerance for noise. The lower
the value, the stronger the noise reduction.
The noise filter reduces the extent to which individual pixels deviate
from the average value of their nearest neighbors. The Threshold
corresponds to a tolerance value. If the deviation of the middle pixel
value from the average value of the pixels immediately surrounding it
exceeds the tolerance value (i.e. it is interpreted as noise), it is replaced by the average value.
This technique reduces the noise of individual pixels that are produced, in particular with EMCCD cameras and CMOS cameras. The selected technique prevents any changes being made to object edges,
as in most cases these are larger than individual pixels.
This filter is also suitable for removing individual "hot pixels" from an
image without having to acquire a reference image in advance.

Enable Unsharp
Mask

Enhances contrasts at fine structures and edges. Thus, the resulting
image appears clearer and enriched in detail.

-

Strength

Controls the amount of contrast enhancement applied to fine structures and edges. The higher the strength, the darker or lighter the resulting edges, compared to the original image.

-

Radius

Determines the size of detail to be enhanced. A small radius enhances
smaller details.
The radius also affects the appearance of enhanced edges. A large radius leads to a visible halo along enhanced edges. The larger the radius, the broader the halo.

-

Color Mode

Determines the calculation method, which affects the appearance of
the output image.
§ RGB:
– The Unsharp Mask filter calculates the sharpness for each color
channel individually.
– The color saturation and the color of structures may be changed
and color noise may occur.
§ Luminance:
– The Unsharp Mask filter calculates the sharpness based on the
luminance signal computed from the RGB channels.
– This mode avoids possible color noise or shift in color saturation,
which could be induced by certain image textures.

-

Auto Contrast

Activated: Enables you to adjust the Contrast Tolerance (0-20).
Auto Contrast only works in RGB color mode.
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Description
Increasing the contrast during unsharp masking is achieved by broadening the distribution of intensities. This corresponds to a spread of
the image histogram.
Controls how much the intensity distribution is spread and thus how
strong the contrast is increased.
§ Contrast Tolerance = 0 : No spread of intensities, no increase of
contrast
§ Contrast Tolerance = 20: Maximum spread of intensities, maximum increase of contrast

-

Clip To Valid
Bits

Activated: Composes the processed image of the same colors as the
original image (i.e. the value range of the output image is adjusted to
the color range of the input image).
Deactivated: Colors not present in the original image may appear in
the processed image.

13.3.2.2.2.5 Mode Section
In this section you can adjust how the software retrieves the camera sensor data.

Parameter

Description

Color Mode

This parameter is available for color cameras only.

–

RGB

Transmits the image data of a color camera unchanged. This corresponds to the standard operating mode of a color camera.

–

B/W

Treats the image data of the color channels as grayscale. The data of
related color channels are averaged. The saturation of the camera appears reduced as a result.
This process does not change the spectral properties of a color camera. The image information of the color sensor still undergoes color
interpolation. An infrared filter also restricts the spectral sensitivity of
the color camera compared to the spectral sensitivity of a genuine
black and white camera.

Live Speed

Here you can select the live image update speed (For CCD based Axiocam models = slow, medium, fast).
Enables you to focus or to find regions of interest on a sample
quickly. A high live image update speed reduces the exposure time of
the live image, even at longer exposure times used for image acquisition.
To achieve a similar impression of image brightness, however, the image data supplied must be adjusted digitally, which may generate a
certain amount of noise or reduce the resolution of the live image.
For CMOS sensor based camera model (e.g. 712 / 705) High Res, Fast,
Low Light).

–

Fast

Represents the image optimized and requires a shorter computation
time.

–

High

Represents the image without artifacts and with a higher image quality. This mode is only effective with binning factor 1.
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Parameter

Description

Bit Depth

The Bit Depth function enables the reduction of the delivered camera
bit depth. It is translating the 14 bit based camera data values into a
smaller value of 12 bit or 8 bit. This has an visible effect of the number range in the image histogram, the dynamic range and the corresponding image file size in an uncompressed CZI image.
As default, the Axiocam models deliver 14 bit per pixel (Axiocam 503/
506/ 512/ 702) and 12 bit/pixel in case of the Axiocam 305. 14 bit
and 12 bit per pixel values need to be stored in two bytes in an CZI
image file. In case of an translation to 8 bit per pixel, only one byte is
needed. Therefore it is possible to reduce the produced image file size
by a factor of two. This is especially beneficial, if large amount of image data is acquired.
By reducing the native camera bit depth to smaller values, the available number range for the digital image signal is decreased. Therefore, the available amount of resolvable intensities in one image scene
is decreased accordingly.

–

LUT min/LUT
max
(only available
for 8 bit mode)

LUT stands for Look Up Table. It describes the translation method for
quickly translating digital numbers in a different range. If the full
swing of the input signal is not used, the reduction of bit depth can
be adopted accordingly by the translation starting point "Lut min" and
the translation end point "Lut max".
If the used intensity range equals just an 8 bit value range, no information is lost and the unused bits can be excluded from being stored
by an suitably adjusted translation table.
Available range is 0 to 1. The value 0 equals 0% of the input range.
The number 1 equals 100% of the input range.

–

Gamma
(only available
for 8 bit mode)

The 14 bit to 8 bit translation is linear by default, which equals a
Gamma value of 1. By assigning values larger or smaller then 1, the
translation becomes non linear.
Values <1 selectively reduce dim signal intensities.
Values >1 selectively amplify dim signal intensities.

13.3.2.2.2.6 Model Specific Section
Only visible if the Show All mode is activated.
To show the section in full, click on the arrow button

.

In this section you see additional, model-specific camera settings depending on which camera you
use on your system.
Reset button
Resets all entries to the original values.
13.3.2.2.2.6.1 Axiocam 105
Camera Identifier
A clear identifier for the currently active camera is displayed here. It consists of the product name
and part of the serial number. This is helpful if you want to identify the camera in question, e.g.
when working with a dual camera system.
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Orientation dropdown list
Here you can select the orientation of the camera image. This allows you to adjust the camera image to the properties of the different camera ports. The following selection options are available:
§

Original

§

Flip Horizontally

§

Flip Vertically

§

Rotate 180

Acquire section
Gain Boost checkbox
If activated, the image signal is amplified so that the image becomes brighter. The gain factor is
1.7x. This factor is in addition to the standard Gain control.
13.3.2.2.2.6.2 Axiocam 712 / 705
Camera Identifier
A clear identifier for the currently active camera is displayed here. It consists of the product name
and part of the serial number. This is helpful if you want to identify the camera in question, e.g.
when working with a dual camera system.
Orientation dropdown list
Here you can select the orientation of the camera image. This allows you to adjust the camera image to the properties of the different camera ports. The following selection options are available:
§

Original

§

Flip Horizontally

§

Flip Vertically

§

Rotate 90 CW

§

Rotate 90 CCW

§

Rotate 180

§

Mirror at +45 Diagonal

§

Mirror at -45 Diagonal

Acquire section
Readout Speed (MHz)
Readout speed can be varied between 39 MHz and 13 MHz if the camera is operated on the
USB3.0 bus. In case the camera is connected to the slower USB2.0 Bus only the 13 MHz mode is
available. At the slower 13 MHz the signal quality is slightly improved due to a reduced noise of
the signal transmission. In case of the 7 series Axiocam models, the readout clock speed is 37
MHz. This speed is fixed and can not changed.
Cooling
Status information, if camera cooling is active. The Axiocam models of the 5 and 7 series can be
operated without active cooling. Cooling is deactivated if the USB2.0 connector of the camera is
not supported to the PC or to a USB compatible power supply.
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Readout Time (ms)
The valid camera readout time is given in this status window which is defined by the number of
used ports or by defining a sensor sub region window (ROI).
Post Processing section
SW Subsampling
The software subsampling feature is used to reduce the image size, which helps to reduce the
amount of the image data load in case of long time lapse or multi-dimensional images. As this is
done by software processing, the full image is acquired and prepared before it is downsized by
this function. Especially in high magnification objectives at lower NA values, the image resolution
is optically limited. So this function can be used to minimize empty image information. This feature works with all Axiocam 3 series, 5 series, and 7 series models. In case of the 7 series models,
the on chip sub sampling offers a speed benefit.
Temperature
The valid sensor temperature is shown here. It is adjusted to 18 C°. It can not be changed. If a
black reference is used it should be used at the same sensor temperature when it was created.
If free air circulation for the camera housing is blocked, it may happen that the sensor temperature is increased and the dark current of the sensor may be higher than normal. If the camera is
operated without cooling ( USB2.0 port of camera not connected) the sensor temperature is increased and dark current will be higher than normal. This should be considered when using the
camera at longer exposure times.
13.3.2.2.2.6.3 AxioCam ERc5s
Camera Identifier
A clear identifier for the currently active camera is displayed here. It consists of the product name
and part of the serial number. This is helpful if you want to identify the camera in question, e.g.
when working with a dual camera system.
Sharpness
Using this function you can increase the impression of sharpness in an image.
Orientation dropdown list
Here you can select the orientation of the camera image. This allows you to adjust the camera image to the properties of the different camera ports. The following selection options are available:
§

Original

§

Flip Horizontally

§

Flip Vertically

§

Rotate 180

13.3.2.2.2.6.4 AxioCam ICc5
Camera Identifier
A clear identifier for the currently active camera is displayed here. It consists of the product name
and part of the serial number. This is helpful if you want to identify the camera in question, e.g.
when working with a dual camera system.
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Orientation dropdown list
Here you can select the orientation of the camera image. This allows you to adjust the camera image to the properties of the different camera ports. The following selection options are available:
§

Original

§

Flip Horizontally

§

Flip Vertically

§

Rotate 90 CW

§

Rotate 90 CCW

§

Rotate 180

§

Mirror at +45 Diagonal

§

Mirror at -45 Diagonal

13.3.2.2.2.6.5 AxioCam HRc
Camera Identifier
A clear identifier for the currently active camera is displayed here. It consists of the product name
and part of the serial number. This is helpful if you want to identify the camera in question, e.g.
when working with a dual camera system.
Orientation dropdown list
Here you can select the orientation of the camera image. This allows you to adjust the camera image to the properties of the different camera ports. The following selection options are available:
§

Original

§

Flip Horizontally

§

Flip Vertically

§

Rotate 90 CW

§

Rotate 90 CCW

§

Rotate 180

§

Mirror at +45 Diagonal

§

Mirror at -45 Diagonal

Readout Speed (MHz)
The High Speed mode activates the faster 24 MHz mode, for which the digitization accuracy is
set to 12 bits per pixel. This mode offers advantages if sufficient light is available and situations
need to be acquired quickly: fast time series or tile images.
In High Accuracy mode the readout speed is 12 Mhz and the digitization accuracy 14 bits per
pixel. This mode offers advantages if very little light is available and you want the camera to acquire very weak signals just above the camera's noise level.
13.3.2.2.2.6.6 AxioCam MRm
Camera Identifier
A clear identifier for the currently active camera is displayed here. It consists of the product name
and part of the serial number. This is helpful if you want to identify the camera in question, e.g.
when working with a dual camera system.
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Orientation dropdown list
Here you can select the orientation of the camera image. This allows you to adjust the camera image to the properties of the different camera ports. The following selection options are available:
§

Original

§

Flip Horizontally

§

Flip Vertically

§

Rotate 90 CW

§

Rotate 90 CCW

§

Rotate 180

§

Mirror at +45 Diagonal

§

Mirror at -45 Diagonal

13.3.2.3 ApoTome Mode Tool

Parameter

Description

Enable ApoTome

Activated: Uses the ApoTome for acquisition and experiments.

Phase Images

Select here the number of phase images per optical sectioning. 5
phase images are the default value.

Live Mode

Here you set the display of the Live Mode. Default value is Grid Visible.

13.3.2.4 Channels Tool

Info
The basic Tiles tool is only visible if you have a motorized stage configured with your microscope. The Tiles Advanced Setup and many other functions are only available if you own the
Tiles & Positions module and when it is activated in the Modules Manager. Additionally,
you must activate the corresponding checkbox on the Acquisition tab in the Experiment
Manager. This tool is part of the basic license for LSM.
In the Channels tool you can configure channels for Widefield acquisition. The tool offers you the
option of entering the hardware settings for acquisition manually or performing the configuration
automatically. Its is not recommenced for LSM channels as you still need to open up Imaging
Setup or use Smart Setup to chose specific channels and adapt the spectral range for detection.
If there is no channel available, you will be asked to add a LSM (various modes) or a WF channel
to the experiment. Therefore click on the corresponding button.
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Fig. 62: Channels Tool (without channels)
The following tool appearance is only visible if you have added one or more channels in Widefield
mode:

1

2

3

Fig. 63: Channels tool

1

Channels list
Displays the selected channels of your experiment. For more information, see Channels
list [} 704].

2

Light Source section
Displays settings for the light source or the lasers (LSM). For more information, see Light
Source section (WF) [} 706] or Lasers section [} 708].

3

Channel settings
Displays settings for your channels. For more information, see Channel Settings (WF)
[} 706] / Channel Settings (LSM) [} 710].
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13.3.2.4.1 Channels list
Please bear the following points in mind for the channels list:
§

The selected channel is highlighted by a light gray bar.

§

The reference channel for the auto focus is highlighted by a blue font color and marked with
Ref..

§

The preview color (LUT) for the channel is shown on the right side of the list. To change the
preview color for the channel, click on the colored rectangle with the arrow icon and select
an alternative color from the shortcut menu. The preview color is also shown in the sections
for channel-specific hardware settings as a thin line on the left side of the list.

Info
If you select a dye or contrast technique in the Add Dye or Contrasting Method dialog, a
suggestion for the hardware settings for the acquisition of this channel is made automatically.
If no suggestion can be made, a channel without hardware settings is added. You will then see
a corresponding indication in the status area of the program interface.
List control elements

Parameter

Description
Navigates one row down.

Down
Navigates one row up.
Up
Opens the Add Dye or Contrasting Method Dialog [} 809].
Add
Deletes the selected channel.
Delete
Focus Ref.

Sets the selected channel as reference channel for focus actions or
stitching during acquisition.
Opens the Options [} 705] shortcut menu.

Options
Laser Range section

Parameter

Description

High Intensity
Laser Range

Activated: Uses a high intensity laser range , where you can adjust
the lasers between 0.2 and 100 % of their power. This is especially
relevant for bleaching experiments.
The setting affects all tracks. While switching, the system is trying to
keep the intensities at a similar level. If the currently selected intensity
is outside of the overlapping range (0.2 % to 3.5-5 %) the closest
possible value is used.
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Description
Note: This section is only available with LSM 900.
The LSM is working by default in a laser power range between
0.01 % and 3.5-5 % of the available laser intensity. The available minimum and maximum in the default range is depending on the laser.

13.3.2.4.1.1 Channels Tool Options Menu

Parameter

Description

Add New...

If WF channels are added this function opens the Add Dye or Contrasting Method Dialog [} 809] to add more WF tracks.
If LSM channels were added this function will add a new LSM track.

Duplicate

Creates a new track with the same settings and dye as the currently
selected track.

Rename

Assigns a new name to the channel of the currently selected track. To
change the name of the track, you can directly click into the respective field of the channels list.

Reset Color

Resets the color of the selected track(s) to default.

Select All

Selects all tracks of the list.

Delete

Deletes the selected track.

Delete All

Deletes all existing tracks.

Set as Reference
Channel

Defines the selected channel as the reference channel for focusing actions.
Note that, you can also set Channels of inactive Tracks as Reference
Channels. The Autofocus will in this case be performed on this channel, but the Channel or Track will not be part of the resulting image
document. Using this approach, e.g. Camera tracks may be used for
fast focusing within a Confocal experiment, while the acquisition of
Camera and Confocal into one image is not possible.
Note: Do not use a Lamdba or Online Fingerprinting track as reference track for SW Autofocus as the focus search will be extremely
slow.

Compare...

Opens the Compare channels dialog, where the active channels are
displayed horizontal so you can easily compare and adjust key parameters of the active tracks.

13.3.2.4.2 Channel-specific settings (WF)
The settings always relate to the channel you have selected in the Channels list.
To show the settings for all channels, click on the
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13.3.2.4.2.1 Light Source section (WF)

Fig. 64: Light Source Section
In this section you can select the available light sources from the Selected Lightsource dropdown list and adjust the corresponding settings. You can adjust the parameters of the light
sources without having to save these in the hardware settings. You can therefore adjust the intensity of the laser lines or LEDs, for example, immediately before starting an acquisition.
If your system is equipped with a TIRF slider, the TIRF angle and type of illumination can also be
set here.
If you select the Use Setting entry, the settings for the light sources disappear. The light source
parameters from the hardware settings are used instead for the acquisition of the channel.
13.3.2.4.2.2 Channel Settings (WF)

Parameter

Description

Dye name

In the input field after the selected dye you can enter an additional
name.

Camera

Select the desired camera for the channel from the dropdown list.

Time

Adjust the exposure time for the camera using the slider or spin box/
input field. Select the unit of time from the dropdown list at the right
of the spin box/input field.

Shift

Only visible if the Show All mode is activated.
Here you can enter the range of the camera's dynamic range that is
utilized.

Auto Exposure

Activated: Automatically determines the camera's exposure time for
the selected channel. The value set manually is ignored.

Set Exposure

Starts an exposure time measurement for the channel. After the measurement the value is adopted as the exposure time setting.

Shading Correction

Activated: Uses the calculated shading correction for this channel. To
learn more about shading correction read the chapter, Post Processing Section [} 673].

-

Define

Automatically calculates the shading correction.

-

Specific

Performs channel-specific shading correction.

-

Global

Performs an objective specific shading correction. This is the default
method for shading correction.

EM Gain

Only visible for EMCCD camera models. Sets the EM gain value.
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Parameter

Description

Focus Offset

Only visible if the Show All mode is activated.
Here you can enter the focus offset from the channel to the Z-position
of the reference channel or to the current position. The Lock icon
shows that this setting will be synchronized between all channels of
this track.

Pixel Shift

Only visible if the Show All mode is activated.
Here you can define the pixel shift in X and Y.
The defined pixel shifts are applied to images collected with Snap,
contentious or in an experiment.

Display

Only visible if the Show All mode is activated.
Here you can select an existing predefined display setting to be automatically applied to this channel after acquisition.
Please note, that this does not apply for Live acquisition. There always
the last used setting will be applied.

Parameter

Description

Z-Stack Mode

Only visible if the Z-Stack checkbox is activated in the Experiment
Manager and while Show All mode is active.

-

Full Z-Stack

Acquires the Z-stack as defined in the Z-Stack tool.

-

Single slice only

Acquires a single slice of the Z-stack only. Select the single slice in the
input box under the list. If the Use center checkbox is activated, the
center focus plane will be used for acquisition.

-

Single slice, rest
black

Acquires an image of a single slice of the Z-stack only. All other Zslices of the stack are filled with black images. Select the single slice in
the input box under the list. If the Use center checkbox is activated,
the center focus plane will be used for acquisition.

-

Fill with single
slice

Acquires an image of a single slice of the Z-stack only and fills all
other Z-slices with this slice. Select the single slice in the input box under the list. If the Use center checkbox is activated, the center focus
plane will be used for acquisition.

13.3.2.4.3 Channel-specific settings (LSM)
The settings always relate to the channel you have selected in the Channels list.
To show the settings for all channels, click on the

button | Select All in the Channels list.

If you are using FCS for LSM 980, see the chapter Channels Tool - Measurement Settings [} 920]
for specific information.
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13.3.2.4.3.1 Lasers section

Fig. 65: Lasers Section

Parameter

Description

Laser

Select the lasers lines needed for sample illumination for the current
track.
Activate the required lasers by activating the corresponding checkbox.
The laser lines along with sliders will appear. Set the required attenuation (%) using the sliders, the arrows, or typing a number into the input field. In case the laser is not yet ready for operation (see alsoLaser
tool), the checkbox and text will be indicated in red. For tunable multiphoton lasers an editing field is displayed. Write the desired wavelength into the editing box to tune the laser to this wavelength. For
multiple tracks the actual tuning is immediately done for the first active track. For subsequent tracks the tuning happens whenever the
previous tracks are deactivated or deleted or during the actual experiment. In case a tunable and a fixed line are available, the tuning range
has a gap which is defined by the filter combining the tunable and
fixed line to get both beams onto the same optical path.

Relative laser
power

Displays the relative percentage of the laser light that is applied to the
sample. For more information, see Display of relative laser power for
different magnifications [} 709].

Pinhole

Adjusts the diameter of the pinhole.
The diameter is specified in micrometer. The text below translates this
diameter to Airy Units and section thickness which is grasped by the
system for the configured detection range and excitation wavelength.
The Airy Unit size and, derived from this, the section thickness of the
optical slice is determined by the emission detection range. Diameter
Pinhole = 1.22 x (detection wavelength / numerical aperture). For the
calculation of the detection wavelength the center of the emission
range is taken. Laser lines set within the detection range reduce the
detection range (lower border determined by the laser line) and shift
the center point accordingly. Without any defined detection range
(i.e. no emission filter) the system takes the center of the potential detection range defined by the hardware parameters of the detector.
Within one track the lowest detection range is taken for the calculation.
When increasing the pinhole diameter an information mark might appear. It signals when at the given optical parameters the resolution in
Z is no longer optimal. The tool tip showing with the information
mark informs about what is the best step size for Z stacks to not loose
resolution. For LSM confocal tracks using NLO lasers for excitation the
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Description
section thickness is calculated based on a formula leaving out the settings of the pinhole, Hence no Airy Unit value is displayed. These
tracks should always be setup with a completely open pinhole.
The control is not available for Airyscan and NDD tracks. For Airyscan
tracks the physical pinhole is automatically opened and set to the optimal diameter. NDD tracks do not have a pinhole.

1 AU

-

Sets the pinhole diameter to a value that is corresponding to 1 Airy
unit for the configured detection wavelength, excitation wavelength(s) and objective.
When you click this button once, it will change its color to blue. This
indicates that the system will always use a pinhole diameter corresponding to 1 AU as you continue to change acquisition parameters
like excitation or emission wavelengths. Click the button again to deactivate this permanently active state.

Max

-

Opens the pinhole to its maximum diameter. This can be useful to
find the focal plane and is the recommended setting when using a
multiphoton laser for excitation.

13.3.2.4.3.1.1 Display of relative laser power for different magnifications
When using certain objective/ magnification changer combinations, only a portion of the laser
light is applied to the sample due to the optical design of the system (see the table for applicable
laser power below). This information is displayed as relative laser power (for LSM tracks) and relative laser power in confocal mode (for Airyscan MPLX tracks) in the Channels tool. The value is
based on the currently used hardware settings (defined in the Right Tool Area) and does not reflect the before/after settings in experiments and experiment blocks.
The laser power is calculated in the following way:
§

For confocal tracks: Relative laser power (%) = applicable laser power depending on objective/
magnification changer * adjusted laser power.

§

For Airyscan tracks: Relative laser power in confocal mode (%) = applicable laser power depending on objective/magnification changer * equivalent laser power in confocal mode.

Applicable Laser Power (relative)

5x/0,35

20x/0,7

20x/0,95

50x/1,2

0,5x

100%

49%

100%

92%

1x

100%

49%

64%

23%

2x

49%

12%

23%

6%
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13.3.2.4.3.2 Channel Settings (LSM)

Parameter

Description

Master Gain

Slider and editing box to control the voltage of the PMTs. Increasing
the gain of the PMT corresponds to a higher voltage of the detector.
The image becomes brighter and you may be able to reduce the laser
power. At higher voltage, the noise level in the image increases as the
dark noise of the detector becomes visible in the images predominantly as single bright pixels.
The optimum between gain and noise depends on your experimental
requirements and on your sample. The maximum available voltage depends on the type of the detector and is 1200V for multialkali PMTs,
900V for GaAsP PMTs and 1000V for Airyscan. GaAsP PMTs and
Airyscan have a minimum voltage of 500V.

Display

Select an existing predefined display setting to be automatically applied to this channel after acquisition.
Please note, that this does not apply for Live acquisition. There always
the last used setting will be applied.

Mode

For specific GaAsP channels and one cooled Multialkaline PMT of the
LSM 980, the detectors can be run in photon counting mode. This optional mode is activated by clicking the button Photon Counting.
In photon counting mode no Digital Offset and Digital Gain slider is
available. Master Gain is set to a calibrated value to have optimal settings for photon counting. Offset must not be changed for this mode
either.
In photon counting mode an artificial maximum of detectable photons is set. For all GaAsP detectors and the side PMT (Ch2) this value
is defined by CRmax/digital gain (CRmax = maximal count rate) defined by the software, which is 4 MHz for the BiG.2 and Ch2 and 2
MHz for Chs (32 channel GaAsP array). Higher count rates are regarded as saturation.
Note that too much light on the detectors (higher count rates for
some ms) leads to detector shut down to avoid damage.
Note that images acquired in photon counting mode are displayed in
their original count rate per pixel and hence will appear fairly dark
compared to intensity mode images. Adjust the display to improve the
signal visibility.

The following functions are only visible if the Show All mode is activated:

Parameter

Description

Digital Offset

Digital Offset allows to change the background of an image. It is calibrated such that the minimum grey values are set to zero. In case image information with zero as grey level value is not accepted increase
the offset until no zero value pixel is present in the image. You can
check this with the histogram function or the range indicator LUT.
This control element is not available for Airyscan SR tracks.
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Parameter

Description

Digital Gain

Digital Gain increases the amplification of the signal on the digital
level. It is set to a value of 1. This value corresponds to 3 times the
minimal possible value. This amplification provides a certain buffer for
a possible detector overload. When decreasing the Digital gain to its
minimum value of 0,3 an overload of the detector by increasing the
master gain (or laser power) is reached earlier.
Detectors will downregulate the voltage or shut down completely
when partially or completely overloaded. Increase the digital gain and
downregulate the master gain when very bright samples are imaged
to avoid detector overload.

Parameter

Description

Z-Stack Mode

Only visible if the Z-Stack checkbox is activated in the Experiment
Manager and while Show All mode is active.

-

Full Z-Stack

Acquires the Z-stack as defined in the Z-Stack tool.

-

Single slice only

Acquires a single slice of the Z-stack only. Select the single slice in the
input box under the list. If the Use center checkbox is activated, the
center focus plane will be used for acquisition.

-

Single slice, rest
black

Acquires an image of a single slice of the Z-stack only. All other Zslices of the stack are filled with black images. Select the single slice in
the input box under the list. If the Use center checkbox is activated,
the center focus plane will be used for acquisition.

-

Fill with single
slice

Acquires an image of a single slice of the Z-stack only and fills all
other Z-slices with this slice. Select the single slice in the input box under the list. If the Use center checkbox is activated, the center focus
plane will be used for acquisition.

13.3.2.5 Focus Strategy Tool
Here you can select the focus strategy that you want to apply. The strategies that are available depend on the dimensions selected (Z-stack, time series, tiles), the hardware devices present (e.g.
Definite Focus) and software licenses (e.g. Software Autofocus module).
In general focus strategies determine and/or update a Reference Z-Position, which in most cases
is used directly for acquisition.

Info
The software automatically selects the most appropriate focus strategy e.g. Use Z Values/ Focus Surface defined in Tiles Setup when you activate the tiles dimension and no focus strategy i.e. other than None has been selected by you previously.
Exceptions
§

When z-stacks are acquired, the center of the z-stack determines the Reference Z-Position.

§

Defined offsets for channels and z-stacks shift acquisition in relation to the Reference Z-Position.

§

If two focusing methods are combined, the Reference Z-Position of the first method is used as
the starting point for the subsequent method.
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Focus Strategy Wizard

–

Optimize this
focus strategy

Focus Strategy dropdown list

–

None

Opens the Focus Strategy Wizard [} 716] to optimize this focus strategy used for your tiles experiment.
Depending on your system, experiment configuration and licensed
modules, the following strategies are available:
No focus strategy has been selected. This is the default setting for all
experiments that do not include a tiles dimension. In this case the
software automatically selects the Use Z Values/ Focus Surface defined in Tiles Setup strategy.
The current z-position at the time the experiment is started is set as
the Reference z-Position and remains unchanged during the experiment.
Exception:
By default, Z-stacks are acquired at the fixed Reference Z-Position that
has been defined as the center in the Z-Stack tool. You can change
this setting in the Z-Stack Acquisition section of the Focus Strategy tool.

–

Absolute Fixed
Z Position

Only available if the Tiles & Positions module is not licensed.
A focus strategy that makes use of the z values defined for tiles and
positions when using a motorized stage.

–

Software Autofocus

Only available if you have licensed the Software Autofocus module.
Note that any focus surface / z-values defined in the tiles setup are ignored if this strategy is selected. If you want to use the values setup in
the Tiles tool select the strategy Use Z Values/ Focus Surface defined in Tiles Setup.
The focus position is determined via the sharpness calculation or intensity calculation of a series of images (Z-stack) and set as the Reference Z-Position. The settings are configured in the Software Autofocus tool.

–

Definite Focus

Only available if your microscope system has attached a Definite Focus device.
Note that any focus surface / z-values defined in the tiles setup are ignored if this strategy is selected. If you want to use the values setup in
the Tiles tool select the strategy Use Z Values/ Focus Surface defined in Tiles Setup.
Definite Focus attempts to maintain a certain distance to the cover
glass of the sample in order to compensate for mechanical and thermal movements. The Definite Focus is initialized at the start of the experiment by setting the current distance as the reference distance.
You will be requested to define this value at the start of the experiment.
When the focus is stabilized during the experiment, the current distance is adjusted to the reference distance. This is achieved by moving
the focus drive accordingly. The new z-position resulting from this is
used as the Reference Z-Position for acquisition. The repetitions and
frequency of these events is performed with predefined standard settings. If you want to adjust these for a particular experiment, select
the Expert mode (only visible in Show all).
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–

Combine Software Autofocus
and Definite Focus

Only available for Tiles or Time Series experiments.
This strategy allows you to combine the functions of Definite Focus
and Software Autofocus. This can be done in two ways, see descriptions below.
Note that in both cases it is possible to modify the time point and frequency at which these events occur. The repetitions and frequency of
these events is performed with predefined standard settings. If you
want to adjust these for a particular experiment, select the Expert
mode (only visible in Show all).

–

Use Z Values/
Focus Surface
defined in Tiles
Setup

Only available if you have licensed the Tiles & Positons module.
This strategy is selected automatically when the Tiles dimension is activated and no previous strategy was selected i.e. None.
In the Tiles & Positons module (optional module), a focus surface
can be defined in two ways: Local (for tile regions and/ or positions)
or Global (based upon a carrier e.g. petri dish, slide, plate).

Software Autofocus as Reference
for Definite Focus

Only available if Combine Software Autofocus and Definite Focus
is selected.
Software Autofocus moves the focus drive to the focus position that
has been calculated. Taking this as the starting point, a new reference
distance is defined for the next distance stabilization performed by
Definite Focus.
This can reduce the likely-hood of a stabilization failure when the
sample is long and elongated and the carrier possibly tilted.

Definite Focus as
Start for Software
Autofocus

Only available if Combine Software Autofocus and Definite Focus
is selected.
The last valid Reference Z-Position defined by Definite Focus is the
starting position for the Software Autofocus search. This allows you
to optimize the search range and step size of Software Autofocus.

Initial Definition
for Z Values/ Focus
Surface

By default this is given by the Tile Setup (user defined values from
the Tiles tool) from the Support Points / Positions / Tile regions list.
It is optionally possible to use the Software Autofocus function or
the Definite Focus. The Recall Focus function initially defines these
value prior to the start of the image acquisition. The resulting z-values
can overwrite the existing listed values in the support points/ positions
list.

Z Values/ Focus
Surface

–

Local (per Region/Position)

For Tile Regions:
A local focus surface can be defined for a Tile region in two ways.
§ For large tile regions or samples in which the plane of interest ("focus") is described by a slope or parabolic you can define one or
more "support points" for each tile region. These can be arranged
in a regular or irregular manner. Each support point is assigned a
discrete z-value ("focus"). From these the software is able to interpolate a local focus surface with a chosen degree of complexity in
an attempt to describe the contour of the plane of interest for the
Tile region.
§ When no support points are used the z value assigned to the Tile
region defines the "focus" for all the tiles it contains. For small tile
regions on a suitable sample this might be sufficient.
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For Positions:
For positions the local focus surface is defined by the discrete Z-value
assigned to it. A position cannot have support points.

–

Global (Carrier
based)

Adapt Z Values/
Focus Surface

A global focus surface is defined based on a selected carrier template.
To create a global focus surface you need to add support points by
creating or editing a carrier template from the appropriate section of
the Tiles tool. Thus, a group of support points are used to help describe the tilt or curvature of the carrier (again by a process of interpolation). Tile regions or position "placed" upon this global focus surface
are mapped onto it accordingly.
Activated: Adapts the focus surface / z-values by the following options (if available):

–

Definite Focus /
Software Autofocus

Here you select if you want to adapt the settings by using Definite Focus or Software Autofocus (SWAF). Depending on this selection and
the available dimensions of your experiment the following additional
functions can be selected from the second dropdown list:

–

SWAF / As additional action

The Reference Z-Position calculated from the Local Focus Surface is
used as the starting point for an additional software autofocus search
which updates the Reference Z-Position.
This allows you to reduce the search range and/or step size of the
Software Autofocus (faster).

–

SWAF / Update
with single offset

This option is only available for Time Series experiments.
This option allows a focus surface (local or global) to be updated by
the activity of a software autofocus run. The focus surface is regularly
adjusted by means of a software autofocus search which is performed
exclusively at a single defined waiting position. A resulting correction
of the Reference Z-Position is adopted for all focus areas.
This strategy is only relevant if Tiles and Time Series experiments are
combined. Again the repetition and frequency of the software autofocus stabilization can be modulated to meet the experiment needs.

–

Definite Focus /
As additional
action

The Reference Z-Position calculated from the Local Focus Surface is
used as the starting point for a Definite Focus stabilization, which updates the Reference Z-Position (adjusts this to a single stabilization
offset, defined at the start of the experiment such that the distance
between the coverslip and objective will be the same).
This method only makes sense in the context of a very thin sample,
where the sample lies at a constant close distance to the interface.
For Definite Focus. This also reduces the likely-hood of a stabilization
failure.

–

Definite Focus /
Update with
single offset

This option is available for Time Series experiments only.
This option allows a focus surface (local or global) to be updated by
the activity of a Definite Focus stabilization. The focus surface is regularly adjusted by means of a definite focus stabilization, which is performed exclusively at a single defined waiting position. A resulting
correction of the Reference Z-Position is adopted for all focus areas.
This strategy is only relevant if Tiles and Time Series experiments are
combined. Again the repetition and frequency of the definite focus
stabilization can be modulated to meet the experiment needs.
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Definite Focus /
Update with
multiple offsets

This option is only available for Definite Focus.2.
This approach allows a focus surface (local or global) to be updated
by the activity of a Definite focus stabilization with multiple unique
offsets. These unique stabilization offsets are determine immediately
before the start of the experiment so that the z-values of all the support points/ positions/ tile regions are adapted individually respective
to their initial z-value.
This strategy can be applied to a tiles experiment with or without a
time series dimension. The repetition and frequency can only be adjusted for the time series loop.

Stabilization Event
Repetitions and
Frequency

Only available for Definite Focus in combination with Tiles or Time
Series experiments.

–

-

Standard

This mode uses default settings for stabilization which we recommend
to use if you are not familiar with the Definite Focus device.

-

Expert

This mode allows advanced settings for using Definite Focus stabilization.
Under Synchronized with Image Acquisition you can select how
Definite Focus is used:
§ Time Series
If activated, this setting repeats Definite Focus at certain predefined
points within a image acquisition loop (e.g. every second time
point).
§ Tile Regions / Positions
If activated, this setting repeats Definite Focus at certain Region /
Positions (e.g. every second position). Optionally, you can also select to run the stabilization for each tile region at either the center
(Center of Regions) or the first acquired tile of the region (First
Tile of Regions).
§ Tiles
If activated, this setting repeats Definite Focus at a certain Tile (e.g.
every second Tile)
Under During Time series interval you can enable Periodic Stabilization.
Periodic Stabilization is available for experiments that include Time
Series only.
If activated, a stabilization with a defined Period (e.g. every 10 s) will
be performed. This mode is useful if long intervals are needed between image acquisition loops. This mode can be combined with the
stabilization events before discrete imaging loops.

Reference Channel
and Offsets

Displays a table with the currently defined channels. The column Offset sets an offset in µm. The button Set as Reference Channel sets
the currently selected channel as reference.

For more information on focus strategy, see Introduction [} 86].
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13.3.2.5.1 Focus Strategy Wizard
This wizard guides you through the setup of a suitable focus strategy for your experiment. Currently this wizard is only available to help you optimize the focus strategy for a tiles or positions
experiment. Therefore, the Tiles & Positions license is necessary for this wizard.
General Wizard Controls

Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard. No changes are applied to your focus strategy
settings.

Finish

Saves the setup and the changes based on your progress and closes
the wizard.

13.3.2.5.1.1 Preparation Step
This step serves as a preparation for the setup.

Parameter

Description

Best Practice
Checklist

Displays a list of best practices to consider before continuing with the
setup.

Dimensions

Displays the currently configured dimensions of your experiment. To
change the dimensions in your experiment you have to leave the wizard and change them on the Acquisition tab.

Reference Channels & Offsets

–

Name

Displays the name of the experiment channels.

–

Offset (µm)

Sets and displays the offset for each channel.
The reference channel is used by the software autofocus. If your desired focus in the specimen should be offset to the result of the software auto focus, enter the relative values (in µm) here. It can be defined for each channel (fluorophore) in the image independently. Offsets can be used without the software autofocus to create a relative
difference in focus for any channel to the reference channel.
Offset values can be determined outside the wizard. This is a manual
process specific for your given sample and application. Values in the
Channels tool or Focus Strategy tool will appear here and can be
modified.

–

Set as Reference Channel

Objective

Sets the currently selected channel as reference channel.
Only available if a Definite Focus is configured.
Shows the selected objective and if it is compatible with Definite Focus (if DF 2 is configured).
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13.3.2.5.1.2 Determine Initial Focus Values Step
This step helps you to determine initial focus values for you experiment. You can use the Software
Autofocus [} 717], the Definite Focus [} 717], or you can do it manually in the Tiles tool.
When you create/ add a position or tile region, it is always assigned a z-value that corresponds to
the current focus position. You can manually adjust these values directly in the respective section
of the Tiles tool [} 531]. For more information, see also Adjusting Z-Values [} 520]. Alternatively,
you can click on the Verify button to open the Verify Tile Regions or Verify Positions Dialog
[} 542] which helps you adjust the values.
13.3.2.5.1.2.1 Determine Initial Focus Values (Software Autofocus)
If you select to apply the Software Autofocus (SWAF), ZEN uses the SWAF to determine the z-values for positions, tile regions or their support points. Make sure that your sample is suitable for
use of the SWAF which uses the settings of the reference channel.
Every experiment in ZEN blue has SWAF settings. They can be seen and modified in the Software
Autofocus Tool [} 507]. The default settings are usually a good starting point, but should be optimized according to the sample. You can find a detailed description of the parameters in the help
chapter for the tool. The adjustments will help reduce the time it takes to run the search but still
reliably determine the focus.

See also
2 Determine Initial Focus Values Step [} 717]
13.3.2.5.1.2.2 Determine Initial Focus Values (Definite Focus)
If you select to apply Definite Focus.2 (DF.2), ZEN uses the DF.2 device on your Axio Observer to
determine the z-values for positions, tile regions or their support points. Make sure that the selected objective and your sample are suitable for use of the Definite Focus.2.
In the first step of this wizard, ZEN indicates if the selected objective can be used. You should test
your sample with DF.2 beforehand, but typically the following guidelines can be given:
§

Sample with coverslip glass or glass bottom (suitable)

§

Objective type = air/dry lens and sample fixed (suitable)

§

Objective type = oil immersion and sample fixed (not suitable)

§

Objective type = oil immersion and sample aqueous media i.e. cells in culture (suitable)

§

Objective type = water immersion and sample fixed or aqueous (suitable)

Definite Focus uses a difference of the refractive index to detect the position of the objective relative to the sample/ cover slip surface. This position can be stored and recalled quickly with high
resolution (accuracy) and reproducibility (precision). You can also define an offset to this position
by focusing into the sample as required and clicking on Store focus in the Definite Focus Tool
[} 802] (right tool area).
Definite Focus.2 can be used to setup the z-values of your positions, tile regions or their support
points. It is considerably faster than using a Software Autofocus. Keep in mind that this approach
will adjust the all z-values according to the local topology of the sample surface relative to the objective. Thus, your sample should be in focus if it follows this topology.

See also
2 Determine Initial Focus Values Step [} 717]
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13.3.2.5.1.3 Sample Size and Distribution Step
This step determines which focus surface is needed for the experiment based on the sample size
and distribution. For general information, see Focus Surfaces in ZEN [} 718]. The first two options
require a local focus surface, which can be employed with or without a sample carrier. If your
sample corresponds to the third option, a global focus surface is necessary, which can only be
used and modified with a sample carrier template.

Parameter

Description

Sample Carrier

Selects a sample carrier and displays the name of the currently selected one.

–

Select

–
Edit Support
Points

–
Delete
Move Focus to
Load Position Between Container

Opens the Select Template Dialog [} 557] to select a sample carrier.
Opens the sample carrier selection/editor dialog. Here you can edit
and add global support points to the selected sample carrier.

Deletes the selected sample carrier from the sample carrier field. The
template will still be available in the Select Template dialog.
Only visible if a sample carrier is selected.
Activated: The focus drive moves to the load position while moving
to another container of the sample carrier (e.g. a well or a slide). This
can prevent possible damage/collisions with obstructions that occur
between different areas of the sample carriers underside.

13.3.2.5.1.3.1 Focus Surfaces in ZEN
Depending on the nature of your sample, its size, and its location on the sample holder, ZEN provides two options that employ a so called focus surface to help keep your sample in focus. A focus surface is basically a topographical map of a certain part of the sample. Like the contour lines
on a map, this tells the microscope for any XY coordinate on it how the objective should be set in
Z in order to make sure the image of the sample is sharp.
In principle, ZEN uses the same method regardless of the size of the sample. A focus surface can
simply be a single z-value assigned to your position or small tile region. For larger more complex
objects it is more sophisticated. For example, large tile regions created to image an entire tissue
section might have several hundred images that make it up. It is not plausible to have a single zvalue that defines the focus, neither is it efficient to define the z-value at each of these several
hundred images. In this case the focus surface is defined by a limited number of z-values at discrete locations. The z-values of these “support points” are used to create a topographical map –
the focus surface - by interpolation. It covers the entire region you want to image and defines the
focus of a single image acquired on it. In this way huge areas can be imaged where every frame is
focused correctly.
ZEN defines two types of focus surface:
§

Local: Use this mode to image groups of positions, small tile regions or mixtures of both at
high and lower magnifications. It is also used to image large tiles or a number of large tiles
i.e. tissues sections or embryos. This is the standard setting for most imaging applications.
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Global: Use this mode to image samples that are widely spread across your sample carrier.
The global focus surface is assigned to and defined on your sample carrier template. In this
manner it is typically used at lower magnifications when a very precise local z-value is not
needed to create a sharp image. In some cases this allows it to be used for more than one
sample carrier after another if they are mounted in a regular and consistent manner.

See also
2 Sample Size and Distribution Step [} 718]
13.3.2.5.1.4 Adapting Focus Values Step
This step is only available if at least a DF.2 or SWAF is configured. You are asked if you want/need
to adapt the focus during your experiment. If you have both Definite Focus and Software Autofocus configured, you are also asked if the focus is static relative to the sample carrier. Depending
on your configuration and selection, the adaptation of focus values via Definite Focus or Software
Autofocus is displayed in the next step of the wizard.
13.3.2.5.1.4.1 Adapting Focus Values in ZEN
Adaption of the focus values in your experiment might not always be necessary. Typically, if you
have followed the suggestions laid out at the beginning of the Focus Strategy wizard for best
practice and your experiment does not involve creating time lapse images of the specimen or long
extended periods of imaging (i.e. the sample is fixed or no longer living), you might not need to
adapt the focus at all during the imaging process. The z-values or focus surface values you define
will probably be stable enough that the images of the specimen will remain sharp.
However, in many cases, especially when living samples are involved, it is necessary to adapt your
z-values. Depending on the configuration of the system two approaches are available to adapt
your z-values:
§

Software Autofocus: This is a technique that adapts the focus based on taking a series of
images at planes above and below the current z-value. The system evaluates these images
based on contrast or intensity and then determines where the highest value lies. This plane
becomes the new z-value and in most cases it is the plane we are interested in or can be used
as reference for it. Z-stacks are centered relative to this value. This allows an adaptation of zvalues when the sample moves (e.g. growth, migration), but also if the sample and sample
carrier drift together. By its very nature this approach might need optimization to get better,
more reliable, and/ or faster results.

§

Definite Focus.2: This is a function to quickly determine the distance between your objectives front lens and the sample. Using DF.2, only the drift of the sample and sample carrier together can be adapted. This can be done to restore or maintain this distance anywhere and at
any time. If necessary you can adjust this distance depending on the location in the sample
and how far into it the focus is required. Adaptation of the focus with Definite Focus.2 is very
quick and highly repeatable. As it is based on the physical principles of light refraction, it requires certain characteristics of the sample and objective. ZEN informs you if the objective is
not suitable and adjusts the selection in the Focus Strategy wizard accordingly.
See also the chapter Determine Initial Focus Values (Definite Focus) [} 717] which gives some
basic guidance on the types of sample that can be used with the different objective types.

See also
2 Adapting Focus Values Step [} 719]
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13.3.2.5.1.5 Adapting Focus Values with Software Autofocus Step
This step guides you through the adaptation of focus values with the Software Autofocus. The options displayed here depend on whether the experiment is a time series or not, and also on the
type of sample which you have selected in the Sample Size and Distribution Step [} 718].
13.3.2.5.1.6 Adapting Focus Values with Definite Focus Step
This step guides you through the adaptation of focus values with the Definite Focus. The options
displayed here depend on whether the experiment is a time series or not, and also on the type of
sample which you have selected in the Sample Size and Distribution Step [} 718].
13.3.2.5.1.7 Manually and Interactively Setting Focus Values Step
This wizard step provides you with detailed information on how to set focus values manually. The
displayed information depends on the sample characteristics you have selected in the Sample Size
and Distribution Step [} 718].
13.3.2.6 Experiment Regions Tool
This tool allows to define Regions of Interest (ROIs) which are used for image acquisition, sample
manipulation (bleaching) and image analysis.
If you are using FCS for LSM 980, see the chapter Overview Acquisition Tools [} 918] for FCS specific options in the Experiment Regions tool.

Fig. 66: Experiment Regions Tool (Show All) - Enable Import deactivated and activated
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Parameter

Description

Enable Import

Activate this option to show additional controls for the import of Regions which were created by an Image Analysis workflow upfront.
This option is only available in Show all mode.

Import as shape:
Toolbar

Select here, which type of Shape the imported. The shape of the created Experiment Region can either be a polygon, a simplified polygon
or a rectangle or ellipse with the approximate size of the bounding
box from the analysis region.
Alternatively you can define a custom rectangle or ellipse with specific
size and an offset relative to the center of the bounding box of the
analysis result.

Import regions as

When you press this button, the currently selected regions from an
Image Analysis result will be imported into the list of Experiment Regions. The properties, e.g. if the regions will be used for bleaching
and analysis, are defined by the neigboring checkboxes.

Color

Select here the color which will be used to indicate the imported regions in the image.

Toolbar

Use the tools from the toolbar to draw ROIs into the image.

Edit Regions in
Current Image

To add a new Experiment Region to your experiment, you need to
click the Edit Regions in Current Image button first. The button will
turn to blue to indicate that Experiment Regions are displayed in the
image and can be added or manipulated. When the button is not enabled, all standard graphical elements are shown in the image, but
not Experiment Regions. Standard graphical elements are used for image analysis and annotation, but will not have an impact on the next
image acquisition.
Experiment regions which are used e.g. for bleaching, are automatically converted into standard graphical elements while the experiment
is performed.
It is not possible to edit Experiment Regions when the image is displayed in certain viewers. Switch back to the 2D view, in case the button is disabled.

Keep Tool

Activated: Keeps the selected graphic tool for multiple actions.

Auto Color

Activated: Assigns different colors for each drawn ROI.
Only available in Show all mode

ROIs List

This list shows all drawn in ROIs .
Their Type (form and color), ID (number ) are listed as identifiers. For
each ROI certain properties can be chosen by activating the according
checkbox:

-

Acquisition

Activated: Acquires images only within the ROI(s).
Use this parameter in combination with Fit frame size to bounding
box of acquisition regions.

-

Bleaching

Activated: Performs a bleaching experiment will be within the selected ROI(s).
The bleaching parameters are specified in the Timed Bleaching
Tool, sse chapter Timed Bleaching Tool [} 762].
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-

Analysis

ZEISS

Description
Activated: Uses data for Mean of ROI analysis in the MeanROI view
from the corresponding ROI(s) .

Save

Saves the selected ROI(s) to the file system.

Load

Loads ROI(s) from the file system.

Delete

Deletes the selected ROI(s) from the ROIs list.

The following parameters are only visible in the Show All mode.
Dimensions

-

X/Y

Shows the X / Y position of a selected ROI.
Enter new values in the input fields.

-

W/H

Shows the Width (W) and Height (H) of the selected ROI.
Enter new values in the input fields.

-

Angle

Shows the rotation angle of the selected ROI.
Enter a new value in the input field.

-

Position regions
relative to image

The experiment region is placed in relation to the current field of
view. Use this option if the regions should maintain their position
within the image in case the stage is moved.
When this option is deactivated, the regions are defined by their stage
coordinates. In this case, regions can be placed on certain structures
of your sample and the regions will stay there when the stage is
moved.
Note, that the system will not attempt to automatically move to these
positions e.g. during bleaching experiments, if they are not accessible
in the current scan area.

Fit frame size to
bounding box of
acquisition regions

Activated: Fits all ROIs that are marked as Acquisition ROIs in the table to the total frame that the scanner will cover.
This can decrease imaging time, since the scanner has not to move
over the complete frame of the original image, in which the ROIs
were drawn.
While the frame size is reduced, the scan speed will maintain its value
as configured in the Acquisition Mode tool. In order to achieve maximum acquisition speed, you should use the Acquisition Mode Tool
to manually reduce the frame size and adjust the speed correspondingly.
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13.3.2.7 Experiment Designer Tool

Info
This tool is only visible if you have licensed and activated the module in the Modules Manager. Additionally you must activate the corresponding checkbox on the Acquisition tab in
the Experiment Manager. This tool is part of the basic license for LSM.
In the Experiment Designer you can create experiments for multidimensional acquisition. Experiments can consist of any number of components. A component is referred to as an experiment
block. Each experiment block has a distinct number, which is shown above the block. To create a
new experiment block click on the Create Acquisition button and select the desired type of
block (Acquisition, Delay, Wait, Execute blocks) then click on the button again. The block will appear in the Timeline of the experiment which you see below the blocks.
Please note the following when working with experiment blocks:
§

Each acquisition block can be seen as its own independent single experiment with its own individual settings.

§

Each experiment block can have its own dimensions (e.g. channel settings like exposure time,
active camera, camera parameters; Z; T).

§

Focus strategies are block specific as well.

§

You can change the order of experiment blocks via drag & drop in the experiment timeline.

Special actions that influence the course of an experiment are performed by means of a special
block. In the Show All mode you can define Loops and Repetitions and specify the number of image files.

Parameter

Description

Import

Opens the Import experiment blocks from other experiments Dialog [} 724]. Here you can choose blocks to import from existing
experiments.

Export

Opens the Export Experiment Blocks dialog. You can choose
here, which experiment blocks you want to export to to the file
system.

Create Acquisition
Block

Adds a new, empty acquisition block to the experiment timeline.

Create Delay Block

Adds a Delay block to the experiment timeline. A delay block
pauses the experiment for a predefined period. After that period
the experiment continues automatically.
You can set the length of the pause in the Properties section
with the Delay slider or input field by clicking on a Delay block.
The delay will be shown within the block.
If the Synchronize with preceding blocks checkbox is activated, the duration of the delay block is reduced by the measured execution time of the preceding blocks.
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Parameter

Description

Create Wait Block

Adds a Wait block to the experiment timeline. A wait block holds
the experiment in idle status as long as clicking on the Continue
Experiment button in the message box. This can be used for
adding a solution or changing the buffer of the specimen. The
message box will be shown when a wait block is reached. You
can enter a message text into the input field in the Properties
section by clicking on a Wait! block.

Create Execute Block

Adds an Execute block to the experiment timeline. A execute
block executes a selected hardware setting.
You can change the blocks properties by clicking on the corresponding block.
If the Sequential checkbox is activated the experiment will continue while the hardware setting is executed. If it is deactivated
the experiment will wait until the hardware setting was executed.
By clicking on the
Options [} 725] button the options for
configuring and selecting the hardware settings will appear.
If a hardware setting was selected, the Go! button is active. If
clicking on this button the selected hardware setting will be applied immediately.

Duplicate

Duplicates the selected block and inserts the newly created block
after the last block.

Delete

Deletes the selected block from the timeline.

13.3.2.7.1 Import experiment blocks from other experiments Dialog
Here you can import experiment blocks from existing experiments.

Parameter

Description

Choose Experiment

Here you select the experiment you want to import experiment blocks
from. The experiment must have been saved on your computer before.

Select desired
blocks

Here you can select the experiment blocks you want to import. Simply
click on an experiment block to select it. The selected block is marked
in blue. If you want to import all blocks of an experiment don't select
a block but continue by clicking on the Import button directly. This
will import all experiment blocks at once.

Import

Imports the experiment or the selected experiment blocks to the experiment timeline.

Cancel

Cancels the import.
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13.3.2.7.2 Create Execute Block Options

Parameter

Description

Edit Setting/Light Path

Opens the light path dialog in which you can change the relevant
hardware setting.

Set to None

Removes the existing hardware setting.

Get Current Hardware

Adopts the current device status.

Experiment Settings
Pool

The shortcut menu shows a list of the existing hardware settings.

Harddrive Folder

The shortcut menu shows a list of the saved hardware settings.

From File...

Opens the Import Hardware Settings dialog window. Select a ZIS
hardware settings file (*.czhws).

Export to User Folder

Exports the current hardware setting.

13.3.2.7.3 Loops and Repetitions section
Only visible if the Show All mode is activated.
Here you can specify which experiment blocks should be repeated during the experiment. You
can define as many repetitions as you like for each experiment. An experiment block may only appear once within the repetitions defined.

Info
If you define several repetitions, the following conditions must be met:
§

Repetitions must form a complete unit.

§

One repetition may not be placed within another.

If these conditions are not met, the repetition cannot be performed. In this case a yellow warning symbol appears under the Active field.

Parameter

Description

Loops

Enter the number of loops that you want to be performed.

Start

Enter the number of the starting block.

End

Enter the number of the end block.

Active

If the checkbox is activated, this repetition is performed in the
experiment.
Adds a new repetition to the experiment.

Add
Deletes the selected repetition.
Delete

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

725

13 Software Functions & Reference | 13.3 Tools

ZEISS

13.3.2.8 Z-Stack Tool

Info
The basic Tiles tool is only visible if you have a motorized stage configured with your microscope. The Tiles Advanced Setup and many other functions are only available if you own the
Tiles a& Positions module and when it is activated in the Modules Manager. Additionally
you must activate the corresponding checkbox on the Acquisition tab in the Experiment
Manager. This tool is part of the basic license for LSM.
In the Z-Stack tool you can configure acquisitions that comprise several Z-planes of your sample.
You can set all the parameters manually using two different modes (see Manual Configuration
[} 728]) or have configuration performed automatically (see Z-Stack Automatic Configuration
[} 727]).
Z-Stack Graphical Display
The graphical display in the left area of the tool represents the configured Z-stack. In the case of
inverse microscopes the objective appears in stylized form at the bottom of the Z-stack. In the
case of upright systems it appears at the top.

Fig. 67: Graphical Display of the Z-Stack
The blue plane indicates the current section plane. The round L, C and F buttons refer to the corresponding planes (L = Last, C = Center, F = First). To change the current Z-position, click on the
relevant buttons. The blue plane then jumps to the desired position.
The values at the top and bottom of the measurement scale on the right-hand side of the graphic
indicate the distance to the center of the Z-stack.
The Position display field below the graphic indicates the Z-position at which the section plane is
located. Here you can navigate precisely to the relevant Z-positions.
The Slice # display field below the graphic indicates the number of the current slice.
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13.3.2.8.1 Z-Stack Automatic Configuration

Info
Before you perform automatic configuration, the current focus position must be at the center
of the sample. The camera's current field of view must always be at a position on the sample
that shows a signal in the selected channel.
If you click on the Z-Stack Auto Configuration button of the tool the automatic configuration is
performed.
Note that Z-stack automatic configuration only works with microscopes and systems that do not
use an optical sectioning technique. If you use an LSM, ApoTome, VivaTome, Spinning Disc
(CSU) or another technique for generating optical sections, the Z-stack must be configured manually.
The following parameters are set automatically:
§

Z-position of the central plane

§

Distance between the individual planes

§

Number of section planes

Parameter

Description

Start Auto Configuration

Automatically configures the Z-stack using the current sample.
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13.3.2.8.2 Manual Configuration

Info
Z-Stack images are always acquired from bottom to top automatically, irrespective of whether
you have defined the top or bottom z-plane of your stack as the first z-plane. This acquisition
sequence increases the accuracy of the z-positioning.
For manually configuring z-stacks you have two modes available. Please note that these modes
are only available if Show All is activated.

Fig. 68: Z-Stack Tool (Show All activated)

Parameter

Description

First / Last Mode

If activated, you are able to configure the z-stack via setting the first
and the last positions of the z-stack, see Configuring a Z-Stack manually (First/Last Mode) [} 48].

Center Mode

If activated, you are able to configure the z-stack via setting the center plane of the z-stack, see Configuring a Z-Stack manually (Center
Mode) [} 48].

Depending on which mode you have activated, you will see the following parameters for configuring the z-stack:

Parameter

Description

Set Last/Set First

Only visible for First/Last mode.
By clicking on the Set Last and on the Set First button you determine the current position as last or first position of the z-stack.
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Parameter

Description

Range

Displays the range of the configured z-stack from the last to the first
section plane.

Slices

Here you can enter the number of z-slices that the z-stack will have.

Interval

Here you can enter the desired distance between the z-slices.

Optimal

The number on this button shows the distance calculated for the
channels set and the current microscope according to the Nyquist
criteria. If you click on the button, this value is automatically adopted
into the Interval input field.
When you click this button once, it will change its color to blue. This
indicates that the system will always use the optimal interval as you
continue to change acquisition parameters. Click the button again or
manually edit the interval to deactivate this permanently active state.
Note: If you change the objective while the button is activated, the
value might not be updated correctly!

Keep

§ Interval:
Keeps the set interval between the section planes constant if you
change configuration parameters in the Z-Stack tool.
§ Slice:
Keeps the set number of z-slices constant.

Center

Only visible for Center mode.
If clicking on this button the current position is set for the central zplane. You can also enter the value in the input field to the right of
the button.

Offset

Here you can enter a value for an offset if desired.

Optimize Sectioning and Step

This function is for LSM only.
The tool allows to set the pinhole of each track to a diameter such
that the section thickness of each track is identical. This can only be
achieved if the tracks are switched in Frame mode during acquisition
allowing hardware to be changed between tracks.
Each channel is represented by a graphical display of two z-slices. The
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Description
channel name, the z-slice thickness and the current overlap of two zslices in percent are given above the graphic.

-

Match Pinhole

Changes the pinhole of the tracks to match the smallest available section thickness.
Hence to go for a specific section thickness identical for all tracks, set
the pinhole of one track to achieve the desired section thickness and
open up the pinhole of all other tracks to maximum. Then click on
Match Pinhole to get the right settings for all tracks.
In case the step interval is subsequently changed to lower or higher
settings, clicking Match Pinhole changes the pinhole size for all
tracks to achieve again 50% overlap between the single steps in each
track.

-

Optimal

Sets the interval for all tracks to the optimal value. The optimal value
is based on the current smallest available section thickness of the current tracks which is defined by the pinhole settings.

-

Undo

Resets all parameters to the default values.

-

X:Y:Z = 1

Matches the settings in Z to the settings in X and Y. This produces a
cubical voxel. This can be useful for later import into third party software for rendering.

The settings of Auto Z Brightness Correction are part of the image acquisition and are reused
with other settings of an image. They are also part of an experiment setting. However, the function is not activated for reuse or when loading an experiment as the settings apply to the absolute
z-position in µm used when the (previous) image was acquired. If the new stack is acquired in a
different position, using the previously defined settings (extrapolate) can lead to a an extreme
overexposure of the sample. Enable test will always be deactivated when an image stack is reused
or an experiment is loaded.
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Worflow:
In order to reuse the Auto Z Brightness parameters for subsequent z-stacks make sure to manually
set the center (or first or last) position of the first z-stack to zero (Focus TW, Z-position: Set Zero)
before defining the Auto Z parameters. Set the center (or first or last) position of all following ZStacks also to zero to be able to reuse the Auto Z Brightness parameters accordingly. When saving and loading the parameters, the same logic applies. When switching between linear and
spline interpolation during continous scan, the current acquisition parameters are not updated until the z-position is changed.

Parameter

Description

Auto Z Brightness
Correction

This function is for LSM only.
If activated, certain acquisition parameters (Laser power, Master gain,
Digital offset and Digital gain) are automatically adjusted according to
the predefined settings while the Z-Stack is being acquired.
Note that Z Piezo is not used for Z stack acquisition when the master
gain should be adjusted with z position. The gain adaptions take too
long to be set between z slices. When indicating a change in master
gain the slower z focus function of the microscope is used instead.
The settings are typically adjusted while focusing through the sample
when the system is in continuous scan mode. Activate the option Enable Test to allow an update of the settings during focusing either
with the focus control of the microscope or using ZEN. ZEN does not
show the update of the values during the acquisition of the experiment.
Note that resetting the focus position in the Focus tool does not affect or shift the absolute position values in the list.

-

Add

Adds the current Z-position to the list and stores the currently configured settings. If the position is already in the list, the values are updated. The positions do not need to be added in a certain order.

-

Move to

Changes the focus position to the selection in the list. This can also be
done by a double click on the list item. If Enable Test is activated,
the parameters are immediately applied during a continuous scan.

-

Remove

Removes the currently selected position from the list.

-

Remove All

Removes all positions from the list.

-

Load../Save..

Loads or saves the stored position parameters to/from a *.ABC file.

-

Spline Interpolation

If activated, a spline interpolation instead of a linear interpolation is
used. Note that spline interpolation with only few positions in between the neighboring images can show an overshoot of the applied
acquisition settings and hence lead to very bright or dim images.

-

Extrapolate

If activated, the interpolation between the Positions in the list can be
extrapolated to the actual first and last slice of a z-stack in case if
those are not part of the defined range of Positions.

-

Enable Test

If activated, the parameters are updated while changing the current zposition either with the SW focus or with the handwheel of the stand.
This allows to quickly check the parameters during a continuos scan.
The changes of the parameters are not indicated during the actual experiment.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

731

13 Software Functions & Reference | 13.3 Tools

ZEISS

13.3.2.9 Time Series Tool

Info
This tool is only visible if you have licensed and activated the module in the Modules Manager. Additionally you must activate the corresponding checkbox on the Acquisition tab in
the Experiment Manager. This tool is part of the basic license for LSM.

Info
If you define times as timer series acquisition conditions, these apply once for the entire experiment. This also applies to experiments that use the Experiment Designer
Use Time Series to acquire an image series consisting of a number of time points. Define, for example, the acquisition interval, the length of the experiment and other specifications to control
the experiment.

Parameter

Description

Duration

Defines the minimum duration of your experiment with the slider or
the up and down arrows.
The drop-down list defines the number of time points in cycles or the
duration:
§ Cycles
§ ms: milliseconds
§ s: seconds
§ m: minutes
§ h: hours
§ d: days

As Long as Possible

Activated: The acquisition of the time series continues as long as
possible depending on the free disk space of the hard disk. That
means the following:
§ For hard disks with more than 20 GB free disk space the acquisition always runs until 2 GB disk space is left.
Example: An experiment using a hard disk with 250 GB of free
disk space will run until 2 GB are left. The calculated/required disk
space for the experiment is 248 GB.
§ For hard disks with less than 20 GB free disk space, at least 10
% disk space will be always left free.
Example: An experiment using a hard disk with 15 GB of free disk
space will run until 1,5 GB are left. The calculated/required disk
space for the experiment is 13,5 GB.

Interval

Defines the interval from individual image to individual image in an
image series. You can specify the interval to set the gap between individual time points in milliseconds, minutes, hours or days. For LSM it is
possible to change the Interval during timer series acquisition with the
Parameter Interval Time.
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Parameter

Description

Use Camera
Streaming if Possible

Only visible in Camera/Widefield Mode.

Use Burst Mode if
Possible

Only visible in Camera/Widefield Mode.

Measure Speed

Not available for LSM acquisition.

Activated: The software tries to use the free running/streaming mode
of the active camera.

Activated: The system buffers acquisition data in the main memory.
For more information, see Burst Mode.

Checks whether the experiment can be performed using the interval
which is set. If the interval is too small, the shortest possible value is
defined automatically for the interval.
Start / Start Next
Time Slice / Stop /
Pause Begin /
Pause End

Defines the Start, Stop and Pause conditions of your experiment. Select the parameters for the corresponding condition from the Mode
dropdown list.

–

Manual

The experiment is started immediately when clicking on the Start Experiment button in the Experiment Manager.

–

At Time of
Day

The experiment is started, stopped or paused at the entered time. Enter the desired time in the spin box / input field below the dropdown
list.

–

After Delay

The experiment is only started, stopped or paused once the length of
time entered has passed.

–

On Trigger

The experiment is started, stopped or paused once a TTL signal has
been received.

Interval Time

–

Interval

This function is only available for LSM 980. Use this function to interactively change the interval during a running time series acquisition.
Adds a new interval value which is taken over from the current set interval. To add a new interval, simply click on the Add

–

Trigger In

Assigns a TriggerIN signal to change the interval.

–

Trigger Out

Assigns a TriggerOUT signal for each interval change

Set Marker

button.

This function is only available for LSM 980. Use this function to mark
events during the time series acquisition.
To define a new marker, simply click on the Add button
.
The marker is applied within the acquired time series when clicking
the Set button or via trigger signal.

–

Description

Predefine the marker by typing in the marker name into the editing
box.

–

Set

Click Set or use TriggerIN to set a marker during time series acquisition.

Trigger In
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Trigger Out

Interactive
Switches

ZEISS

Description
If necessary, assign a TriggerOUT signal for every set marker.
Note that the TriggerOut signal for the marker function consists of a
high spike followed by a 3 second long TTL pulse. Within the duration
of the pulse a further low spike is delivered.
Adds and configures switches that can be used to execute certain actions during your experiment. To add a new switch, simply click on
the Add

button.

The Switch button opens a dialog to configure an interactive switch.
For more information, see Interactive Switches section [} 735].

Info
The shortest possible interval is calculated by performing a blind experiment. The camera exposure time, number of steps of a Z-stack and the number of acquisition channels are taken into
consideration in the calculation. Depending on the number of Z-stacks and channels and
whether long exposure times have been set, it may take some time to calculate the shortest
time interval.

13.3.2.9.1 Experiment Conditions section
The following functions are only visible if the Show All mode is activated:
You can define the Start, Stop, Pause Begin and Pause End conditions for your experiment.
Start Next Time slice can only be used with trigger functionality of the LSM 980. Select the parameters for the corresponding condition from the dropdown list:

Parameter

Description

Manual

The experiment is started immediately when clicking on the Start Experiment button in the Experiment Manager.

At Time of Day

The experiment is started, stopped or paused at the entered time. Enter the desired time in the spin box/input field to the right of the
dropdown list.

After Delay

The experiment is only started, stopped or paused once the length of
time entered has passed.

On Trigger

The experiment is started, stopped or paused once a TTL signal has
been received.

Interval Time

This function is only available for LSM 980. Use this function to interactively change the interval during a running time series acquisition.
Use the + button to add a new interval value which is taken over from
the current set interval.
Add another interval first before changing the current interval.
Highlight the desired interval during the experiment to change the interval before the next image frame is scanned or assign a TriggerIN
signal to change the interval. You can always assign a TriggerOUT
signal for each interval change.
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Description
The change of the interval is also marked in the time series acquisition. The marker is visible next to image (2D view, Gallery view, MeanROI) when the change occurred.

Set Marker

This function is only available with LSM 980. Use this function to mark
events during the time series acquisition.
Predefine the marker by typing in the marker name into the editing
box. Either click Set or use TriggerIN to set a marker during time series acquisition.
You can also assign a TriggerOUT signal for every set marker.
The Set button becomes active when the acquisition is running.
The marker is visible next to image (2D view, Gallery view, MeanROI)
when the marker was set.

Info
If you define times as timer series acquisition conditions, these apply once for the entire experiment. This also applies to experiments that use the Experiment Designer

13.3.2.9.2 Interactive Switches section
The following functions are only visible if the Show All mode is activated:
Here you can add and configure switches that can be used to execute certain actions during your
experiment.
Left-click on a new or existing switch to open the dialog in which you can configure the button
parameters:

Parameter

Description

Name

Here you can enter a name for the button.

Description

Here you can enter a description for the button.

Color

Activated: Shows a colored line at the left edge of the switch.

Color Selection

Opens the Color Selection dialog. Here you can select a color for the
line at the left edge of the switch.

Action

Here you can select one of the following actions. This action will be
executed when you click on the button:
§ None
§ Set Interval
§ As Fast as Possible
§ Trigger
§ Hardware Setting
§ Jump to previous block
§ Jump to next block
§ Jump to block #

Delete Switch

Deletes the selected switch.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

735

13 Software Functions & Reference | 13.3 Tools

ZEISS

13.3.2.10 Experiment Information Tool
Here you can find an overview of your experiment parameters, e.g. the memory requirement of
the experiment or its duration.

Parameter

Description

Required Disk Space

Indicates the calculated memory space that the experiment
will take up on your hard drive. All the activated blocks of
an experiment created using the Experiment Designer are
taken into account.

Duration (Theoretical)

The system adds together all the exposure times arising
during acquisition in the experiment and indicates this
value. In the case of time series the intervals set are also
taken into account. The actual acquisition duration will always turn out longer, however, as switching times for components (diaphragms, reflectors) and positioning times (Zplane, stage position) also come into play.

Maximum Acquisition Rate

If the Time Series acquisition dimension is activated in the
Experiment Manager, you can measure the maximum
possible frame rate of the system in the Time Series tool.
In that case the frame rate is shown here. Otherwise "not
available" is displayed. After any change is made to the experiment the frame rate must be determined again in the
Time Series tool.

Elapsed Time (Last Experiment)

If you have already run the current experiment before on
the system, the duration actually required for it is displayed
here. This information disappears again if you change the
experiment.

Next Time Point in

Shows duration to next time point.

Tile Size

Shows the X/Y dimensions of your experiment. In the case
of a single position this value is identical to the size of the
camera field.

13.3.2.11 Experiment Feedback Tool

Info
This tool is only visible if you have licensed and activated the module Advanced Processing in
the Modules Manager and additionally activated the Experiment Feedback checkbox in the
Experiment Manager on the Acquisition tab.

Parameter

Description

Edit Feedback
Script...

Opens the Script Editor [} 737] dialog. There you can create scripts for
an Experiment Feedback.
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Description

Select script runtime conditions

-

Free Run

Upon the experiment start the acquisition and the feedback script are
started but run from here in an completely unsynchronized manner.
The online image analysis or the script run itself will not slow down
the actual image acquisition.

-

Synchronized

This mode will lead to strictly determined order of events depending
on the chosen level of synchronization. The online image analysis and/
or the feedback script will be started after current acquisition is finished.
In contrast to the Free Run mode, a synchronized run can slow the
whole acquisition down. The big advantage of the mode is, that the
synchronized run ensures a predictable workflow.

Define Script Slot

Here you define the experiment feedback sequence by arranging the
slots (represented by blue buttons). The blue slots run one after another the non blue slots are run separately.
§ The Acquisition slot represents the actual image acquisition.
§ The Analysis slot represents the online image analysis.
§ The Script Run* slot represents the execution of the experiment
feedback loop script. Note that the loop script will be only executed when triggered by a used observable inside the loop script.
§ The HD Writing slot represents the slot for writing the image data
to your hard drive.

Allow additional
loop script runs

Triggers the main loop if observables that are not part of the multidimensional experiment (e.g. frame index, time index, block index, etc.)
change. Those observables could be time or temperature of the incubation. If the checkbox is not activated only experiment observables
trigger the main loop script. This only applies when the acquisition is
idle. This only applies when acquisition is idle.

13.3.2.11.1 Script Editor for Experiment Feedback Dialog

See also
2 Editing the Feedback Script [} 241]
13.3.2.11.1.1 Input Windows
The three windows on the left allow you to input scripts based on the programming language
Python:

Window

Description

Pre Loop - Single Execution on Experiment
Start

Import modules and define functions or variables. This part is executed only once at the beginning of the feedback experiment.
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Window

Description

Loop Script - Repetitive
Execution During Experiment Runtime

Executed every time an observable used within the loop script
changes. Allows to modify the experiment on-the-fly and react
on results from the online image analysis, e.g. stop the acquisition when a defined number of cells have been counted, or to
take action upon external signals.

Post Loop Script - Single Execution on Experiment Stop

Define actions that are executed only once when the acquisition
is finished, e.g. write the data in a logfile or play a sound when
the experiment is finished.

Clear output

Clears the output messages field.

Accept

Adopts the script within the experiment without closing the window.

OK

Adopts the script and closes the window.

Cancel

Leaves the dialog without adopting the script.

For more information, see Editing the Feedback Script [} 241].
13.3.2.11.1.2 Commands tab
The Commands tab on the right contains all commands for observables, actions and editor tools.

Parameter

Description

Available Observables

Observables are conditions or parameters that can be determined and observed during the course of the experiment. Select
observables, actions and tools by clicking on the black triangle at
the right-hand edge and dragging the desired action from the list
to the desired input area.
The following observables are available:

-

Analysis

Analysis observables contain measurement parameters from image analyses that have been previously defined, e.g in the Image
Analysis Wizard. Only those variables that are specified through
the selection of the measurement program appear in the list.

-

Experiment

Experiment observables relate to the experiment currently running and display the current time point or the current Z-stack
plane, for example.

-

Hardware

Hardware observables include, for example, the status of connected devices, such as trigger devices, or incubators.

-

Environment

Environment observables describe the system environment, such
as the time or available memory space on the computer.

Available Actions

Actions are possible actions and reactions that can be performed
during the experiment. These can vary greatly and include, for
example, changing microscope hardware, changing camera parameters, generating notifications or audible alerts, calling up
other programs or canceling the experiment.
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Parameter

Description

-

Experiment Actions

Commands that can be used to modify a running experiment onthe-fly. It also includes modifying hardware parameters which
are typically part of an acquisition experiment, like exposure
times or light source intensities.

-

Hardware Actions

Hardware Actions are modifications of a running experiment
concerning the incubation, XYZ positions and the Digital IO
ports.

-

Extra Actions

Commands that can be used to log any kind of data into a text
file or to start an external application outside ZEN at any time
during a running experiment.

Editor Tools

-

The Editor tools include sample scripts, allow to play sounds or
write debugging outputs.

Examples and Templates

Contains a small collection of script samples to illustrate some
basic ideas of the feedback script. You can adopt the sample
scripts by double-clicking. After receiving a prompt, the current
content in the script window is overwritten entirely .

Validate Script

Checks your script for errors. An information is displayed if your
script is valid or not.

Information

-

IO Card Port Labels

Contains the exact naming of the available IO ports for the current system.

13.3.2.11.1.2.1 Script Commands - Observables

Info
It is crucial to understand that observables are more than just values "that can be observed".
They are required to trigger a script-run of the Loop Script.
If there are no observables used or they remain unchanged, the script will not be executed.

13.3.2.11.1.2.1. Observables - Analysis
1
The available commands inside the analysis sections depend on the definition of the image analysis pipeline and the defined ROIs from the Physiology module. Therefore this is a dynamically created list that will always look different. The list will only contain those parameters, that are
defined inside the CZIAS measurement file. Such a file can be created using the image
analysis wizard or an OAD macro.
13.3.2.11.1.2.1. Observables - Experiment
2

CurrentBlockIndex
Complete Command

ZenService.Experiment.CurrentBlockIndex

Input
Output

integer
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CurrentBlockIndex
Description

Returns the current experiment block index in heterogeneous experiments.

CurrentSceneIndex
Complete Command

ZenService.Experiment.CurrentSceneIndex

Input
Output

integer

Description

Returns the index of the current position for multi-position experiments.

CurrentTileIndex
Complete Command

ZenService.Experiment.CurrentTileIndex

Input
Output

integer

Description

Returns the current tile index.

CurrentTimePointIndex
Complete Command

ZenService.Experiment.CurrentTimePointIndex

Input
Output

integer

Description

Returns the current time point index, e.g. the frame number from a
time-lapse experiment.

CurrentTrackIndex
Complete Command

ZenService.Environment.CurrentTrackIndex

Input
Output

integer

Description

Returns the current track number.

CurrentZSliceIndex
Complete Command

ZenService.Experiment.CurrentZSliceIndex

Input
Output

integer

Description

Returns the current Z-Plane form the Z-stack.

ElapsedTimeInMinutes
Complete Command

ZenService.Experiment.ElapsedTimeInMinutes
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ElapsedTimeInMinutes
Input
Output

double

Description

Returns the elapsed time in minutes for the current experiment.

ElapsedTimeInSeconds
Complete Command

ZenService.Experiment.ElapsedTimeInSeconds

Input
Output

double

Description

Returns the elapsed time in seconds for the current experiment.

ImageFileName
Complete Command

ZenService.Experiment.ImageFileName

Input
Output

string

Description

Returns the name of the current experiment as a string. The String
ending will be *.czi and *.czmbi for multi-block experiments, respectively.

IsExperimentPaused
Complete Command

ZenService.Experiment.IsExperimentPaused

Input
Output

boolean

Description

Returns the paused state of the current experiment, i.e. it will be True
if the experiment is paused.

IsExperimentRunning
Complete Command

ZenService.Experiment.IsExperimentRunning

Input
Output

boolean

Description

Returns the running state of the current experiment, i.e. it will be True
if the experiment is running.

HasChanged
Complete Command

ZenService.Environment.HasChanged(String observableId)

Input
Output

boolean
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HasChanged
Description

Returns true/false if a certain observable has/ has not changed. On
simple occurrences it is possible to use the HasChanged("observableId") method. Where available the HasChanged("observableId")
method takes an observable name as parameter. HasChanged("observableId") returns true whenever the specified observable has
changed since last script run; otherwise false. So it might not be suitable for situations when an observable changes very often and/or
when really a singular execution is desired.

13.3.2.11.1.2.1. Observables - Environment
3

CurrentDateDay
Complete Command

ZenService.Environment.CurrentDateDay

Input
Output

integer

Description

Returns the current day.

CurrentDateMonth
Complete Command

ZenService.Environment.CurrentDateMonth

Input
Output

integer

Description

Returns the current month.

CurrentDateYear
Complete Command

ZenService.Environment.CurrentDateYear

Input
Output

integer

Description

Returns the current year.

CurrentTimeHour
Complete Command

ZenService.Environment.CurrentTimeHour

Input
Output

integer

Description

Returns the current hour.

CurrentDateTimeMinute
Complete Command

ZenService.Environment.CurrentTimeMinute

Input
Output

integer
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CurrentDateTimeMinute
Description

Returns the current minute.

CurrentDateTimeSeconds
Complete Command

ZenService.Environment.CurrentTimeSeconds

Input
Output

integer

Description

Returns the current second.

CurrentDateTimeMilliseconds
Complete Command

ZenService.Environment.CurrentTimeMilliseconds

Input
Output

integer

Description

Returns the current millisecond.

FreeDiskSpaceInMBytes
Complete Command

ZenService.Environment.FreeDiskSpaceInMBytes

Input
Output

double

Description

Returns the free disk space on the hard disk where the experiment
data will be saved.

HasChanged
Complete Command

ZenService.Environment.HasChanged(String observableId)

Input
Output

boolean

Description

Returns whether a certain observable has changed. On simple occurrences it is possible to use the HasChanged("observableId") method.
Where available the HasChanged("observableId") method takes an
observable name as parameter. HasChanged("observableId") returns
true whenever the specified observable has changed since last script
run; otherwise false. So it might not be suitable for situations when
an observable changes very often and/or when really a singular execution is desired.

13.3.2.11.1.2.1. Observables - Hardware
4

IncubationAirHeaterIsEnabled
Complete Command

ZenService.Hardware.IncubationAirHeaterIsEnabled

Input
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IncubationAirHeaterIsEnabled
Output

boolean

Description

Returns the state of the incubator.

IncubationAirHeaterTemperature
Complete Command

ZenService.Hardware.IncubationAirHeaterTemperature

Input
Output

double

Description

Returns the current temperature setpoint.

IncubationChannelXIsEnabled (X=1-4)
Complete Command

ZenService.Hardware.IncubationChannelXIsEnabled

Input
Output

boolean

Description

Returns the state for a specific incubation channel.

IncubationChannelXTemperature (X=1-4)
Complete Command

ZenService.Hardware.IncubationChannelXTemperature

Input
Output

double

Description

Returns the temperature for a specific channel.

IncubationCO2Concentration
Complete Command

ZenService.Hardware.IncubationCO2Concentration

Input
Output

Double

Description

Returns the current CO2 concentration setpoint.

IncubationCO2IsEnabled
Complete Command

ZenService.Hardware.IncubationCO2IsEnabled

Input
Output

Boolean

Description

Returns the state of the CO2 incubation system.

IncubationO2Concentration
Complete Command

ZenService.Hardware.IncubationO2Concentration

Input
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IncubationO2Concentration
Output

Double

Description

Returns the current O2 concentration setpoint.

IncubationO2IsEnabled
Complete Command

ZenService.Hardware.IncubationO2IsEnabled

Input
Output

Boolean

Description

Returns the state of the O2 incubation system.

IncubationCoolingChannelIsEnabled
Complete Command

ZenService.Hardware.IncubationCoolingChannelIsEnabled

Input
Output

Boolean

Description

Returns the state of the cooling system.

IncubationCoolingChannelTemperature
Complete Command

ZenService.Hardware.IncubationCoolingChannelTemperature

Input
Output

Double

Description

Returns the current cooling temperature.

IncubationHumidityIsEnabled
Complete Command

ZenService.Hardware.IncubationHumidityIsEnabled

Input
Output

Boolean

Description

Returns the state of the humidifier.

IncubationHumidityValue
Complete Command

ZenService.Hardware.IncubationHumidityValue

Input
Output

Double

Description

Returns the current humidity.

TriggerDigitalInX (X = ...)
The range of values for X depends on the IOcard configuration.
Complete Command

ZenService.Hardware.TriggerDigitalInX
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TriggerDigitalInX (X = ...)
Input
Output

Boolean

Description

Returns the state of a specific TriggerDigitalIn port.

TriggerDigitalOutX (X = ...)
The range of values for X depends on the IOcard configuration.
Complete Command

ZenService.Hardware.TriggerDigitalOutX

Input
Output

Boolean

Description

Returns the state of a specific TriggerDigitalOut port.

TriggerDigitalOutRLShutter
Complete Command

ZenService.Hardware.TriggerDigitalRLShutter

Input
Output

Boolean

Description

Returns the state of the reflected light shutter, where True = Open
and False = Closed.

TriggerDigitalOutTLShutter
Complete Command

ZenService.Hardware.TriggerDigitalOutTLShutter

Input
Output

Boolean

Description

Returns the state of the transmitted light shutter, where True = Open
and False = Closed.

13.3.2.11.1.2.2 Script Commands - Available Actions
13.3.2.11.1.2.2. Actions - Experiment
1
Depending on the present hardware the shown options might vary, e.g. it is only possible to set
the laser intensity, if there is a laser engine configured.

ContinueExperiment
Complete Command

ZenService.Actions.ContinueExperiment()

Input
Output
Description

This will continue the current experiment in case it was paused.
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JumpToBlock
Complete Command

ZenService.Actions.JumpToBlock(int newBlockIndex)

Input

integer newBlockIndex

Output
Description

This will jump to the specified experiment block inside a heterogeneous experiment.

JumpToContainer
Complete Command

ZenService.Actions.JumpToContainer(string containerId)

Input

string containerId

Output
Description

This will jump to the specified container of the sample carrier.

JumpToNextBlock
Complete Command

ZenService.Actions.JumpToNextBlock()

Input
Output
Description

This will jump to next acquisition block defined inside the Experiment
Designer tool

JumpToNextContainer
Complete Command

ZenService.Actions.JumpToNextContainer()

Input
Output
Description

This will jump to next container inside the currently used sample carrier.

JumpToNextRegion
Complete Command

ZenService.Actions.JumpToNextRegion()

Input
Output
Description

This will jump to next defined region.

JumpToPreviousBlock
Complete Command

ZenService.Actions.JumpToPreviousBlock()

Input
Output
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JumpToPreviousBlock
Description

This will jump to the previous acquisition block inside the experiment
designer tool.

MoveTileRegion (1)
Complete Command

ZenService.Actions.MoveTileRegion(int regionIndex, double x,
double y)

Input

integer regionIndex, double x [nm], double y [nm]

Output
Description

Updates the specified tile region inside the tile region list with the
given X and Y coordinates.

MoveTileRegion (2)
Complete Command

ZenService.Actions.MoveTileRegion(int regionIndex, double x,
double y, double z)

Input

integer regionIndex, double x [nm], double y [nm], double z [nm]

Output
Description

Updates the specified tile region inside the tile region list with the
given X, Y and Z stage coordinates.

MoveTileRegionByOffset
Complete Command

ZenService.Actions.MoveTileRegionByOffset(int regionIndex,
double offsetX, double offsetY, double offsetZ)

Input

integer regionIndex, double offsetX [nm], double offsetY [nm], double
offsetZ [nm]

Output
Description

Updates the specified tile region inside the tile region list with the
given offset in X, Y and Z.

PauseExperiment
Complete Command

ZenService.Actions.PauseExperiment()

Input
Output
Description

This will pause the current running experiment.

ReadLEDIntensity
Complete Command

ZenService.Actions.ReadLEDIntensity(int trackindex, double
wavelength)

Input

integer trackindex, double wavelength [nm]

Output

double intensity
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ReadLEDIntensity
Description

This will read the intensity for the specified track and LED.

ReadTLHalogenLampIntensity
Complete Command

ZenService.Actions.ReadTLHalogenLampIntensity(int
trackindex)

Input

integer trackindex

Output

double intensity

Description

This will read the intensity for the specified track and LED.

SetExposureTime (1)
Complete Command

ZenService.Actions.SetExposureTime(int channelindex, double
exposure)

Input

integer channelindex, double exposure [ms]

Output
Description

This will set the exposure time of the camera for the specified channel.

SetExposureTime (2)
Complete Command

ZenService.Actions.SetExposureTime(int trackindex, int channelindex, double exposure)

Input

integer trackindex, integer channelindex, double exposure [ms]

Output
Description

This will set the exposure time of the camera for the specified track
and channel.

SetLEDIntensity
Complete Command

ZenService.Actions.SetLEDIntensity(int trackindex, double
wavelength, double intensity)

Input

integer trackindex, double wavelength [nm]

Output
Description

This will set the intensity for the specified track and channel.

SetLEDIsEnabled
Complete Command

ZenService.Actions.SetLEDIsEnabled(int trackindex, double
wavelength, bool isEnabled)

Input

integer trackindex, double wavelength [nm], boolean is Enabled

Output
Description

This will enable the specified LED for the specified track. The predefined intensity value will be used.
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SetMarkerString
Complete Command

ZenService.Actions.SetMarkerString(string markerText)

Input

string markerText

Output
Description

This will insert a marker at the current time point.

SetTimeSeriesInterval (1)
Complete Command

ZenService.Actions.SetTimeSeriesInterval(double interval, TimeUnit unit)

Input

double interval, TimeUnit unit (e.g. TimeUnit.ms)

Output
Description

This will set the interval of a time series to the specified value.

SetTimeSeriesInterval (2)
Complete Command

ZenService.Actions.SetTimeSeriesInterval(double interval)

Input

double interval [ms]

Output
Description

This will set the interval of a time series to the specified value in [ms].

SetTLHalogenLampIntensity
Complete Command

ZenService.Actions.SetTLHalogenLampIntensity(int trackindex,
double intensity)

Input

integer trackindex, double intensity

Output
Description

This will set the intensity of the TL Halogen lamp for the specified
track.

StopExperiment
Complete Command

ZenService.Actions.StopExperiment()

Input
Output
Description

This will stop the current running experiment (similar to pressing the
Stop button).

UpdateZStackCenterPosition
Complete Command

ZenService.Actions.UpdateZStackCenterPosition(double centerPosition)

Input

double center position [nm]
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UpdateZStackCenterPosition
Output
Description

Updates the center position of the defined Z-stack with the specified
center position.

UpdateZStackCenterPositionByOffset
Complete Command

ZenService.Actions.UpdateZStackCenterPositionByOffset(double centerPositionOffset)

Input

double center position offset [nm]

Output
Description

Moves the center position of the defined Z-stack by the specified offset.

13.3.2.11.1.2.2. Actions - Experiment - LSM
2

LSM - ReadAnalogInTriggerState
Complete Command

ZenServiceLSM.Actions.ReadAnalogInTriggerState(int port)

Input

integer trigger port

Output
Description

Returns the state of specified AnalogInTriggerIn port.

LSM - ReadAnalogOutTriggerState
Complete Command

ZenServiceLSM.Actions.ReadAnalogOutTriggerState(int port)

Input

integer trigger port

Output
Description

Returns the state of specified AnalogInTriggerIn port.

LSM - ReadDigitalGain
Complete Command

ZenServiceLSM.Actions.ReadDigitalGain(int trackIndex, int
channelIndex)

Input

integer trackindex, integer channelIndex

Output

double digitalGain

Description

Returns the value for the DigitalGain for the specified track/channel.

LSM - ReadLaserIntensity
Complete Command

ZenServiceLSM.Actions.ReadLaserIntensity(int trackIndex, int
lineWavelength)

Input

integer trackIndex, integer lineWavelength [nm]

Output

double intensity
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LSM - ReadLaserIntensity
Description

Returns the laser intensity [%] for the specified laser wavelength.

LSM - ReadMasterGain
Complete Command

ZenServiceLSM.Actions.ReadMasterGain(int trackIndex, int detectorIndex)

Input

integer trackIndex, integer detectorIndex

Output

double masterGain

Description

Returns the value for the masterGain for the specified track/dectector
combination.

LSM - ReadPinholeDiameter
Complete Command

ZenServiceLSM.Actions.ReadPinholeDiameter(int trackIndex)

Input

integer trackIndex

Output

double pinholeDiameter [micron]

Description

Returns the value for the pinhole in [micron] for the specified track.

LSM - ReadScanDirection
Complete Command

ZenServiceLSM.Actions.ReadScanDirection()

Input
Output

ScanDirections direction

Description

Returns the current scan direction.

LSM - ReadScanSpeed
Complete Command

ZenServiceLSM.Actions.ReadScanSpeed()

Input
Output

int speed

Description

Returns the current scan speed.

LSM - ReadTLLEDIntensity
Complete Command

ZenServiceLSM.Actions.ReadTLLEDIntensity(int trackIndex)

Input

integer trackIndex

Output

double intensity [%]

Description

Returns the intensity value [%] for the TL-LED.

LSM - SetAnalogOutTriggerState
Complete Command

ZenServiceLSM.Actions.SetAnalogOutTriggerState(int port,
double state)
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LSM - SetAnalogOutTriggerState
Input

integer port, double state

Output
Description

Sets the voltage value for the AnalogOutTrigger port.

LSM - SetDigitalGain
Complete Command

ZenServiceLSM.Actions.SetDigitalGain(int trackIndex, int channelIndex, double digitalGain)

Input

integer trackIndex, integer channelIndex, double digitalGain

Output
Description

Sets the value for the DigitalGain for the specified track/channel.

LSM - SetLaserEnabled
Complete Command

ZenServiceLSM.Actions.SetLaserEnabled(int trackIndex, int
lineWavelength, bool isEnabled)

Input

integer trackIndex, integer lineWavelength, bool isEnabled

Output
Description

Sets the state for the specified laser inside the specified track.

LSM - SetLaserIntensity
Complete Command

ZenServiceLSM.Actions.SetLaserIntensity(int trackIndex, int
lineWavelength, double intensity)

Input

integer trackIndex, integer lineWavelength [nm], double intensity [%]

Output
Description

Sets the laser intensity for the specified laser inside the specified track.

LSM - SetMasterGain
Complete Command

ZenServiceLSM.Actions.SetMasterGain(int trackIndex, int detectorIndex, double masterGain)

Input

integer trackIndex, integer detectorIndex, double masterGain

Output
Description

Sets the value for the MasterGain for the specified track/detector.

LSM - SetPinholeDiameter
Complete Command

ZenServiceLSM.Actions.SetPinholeDiameter(int trackIndex,
double pinholeDiameter)

Input

integer trackIndex, double pinholeDiameter [nm]

Output
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LSM - SetPinholeDiameter
Description

Adjusts the pinhole for the specified track.

LSM - SetScanDirection
Complete Command

ZenServiceLSM.Actions.SetScanDirection(ScanDirections direction)

Input

ScanDirections direction

Output
Description

Adjust the ScanDirection to the specified value.

LSM - SetScanSpeed
Complete Command

ZenServiceLSM.Actions.SetScanSpeed(int speed)

Input

integer speed

Output
Description

Adjusts the ScanSpeed to the specified value.

LSM - SetTLLEDIntensity
Complete Command

ZenServiceLSM.Actions.SetTLLEDIntensity(int trackIndex, double intensity)

Input

integer trackIndex, double intensity [%]

Output
Description

Adjusts the intensity of the TL-LED to the specified value.

13.3.2.11.1.2.2. Actions - Hardware
3

ExecuteHardwareSetting
Complete Command

ZenService.HardwareActions.ExecuteHardwareSetting(string
settingNameInExperimentSettingsPool)

Input

string settingNameInExperimentSettingsPool

Output
Description

Loads a specific experiment setting from the list of experiment settings. The settings will be overwritten within the next experiment loop, if the settings are included in the regular experiment settings.

ExecuteHardwareSettingFromFile
Complete Command

ZenService.HardwareActions.ExecuteHardwareSettingFromFile(string hardwareSettingFilePath)

Input

integer string hardwareSettingFilePath

Output
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ExecuteHardwareSettingFromFile
Description

Loads a specific experiment setting from a file directly. The settings
will be overwritten within the next experiment loop, if the settings are included in the regular experiment settings.

PulseTriggerDigitalOut
Complete Command

ZenService.HardwareActions.PulseTriggerDigitalOut(string
port-Label, double duration)

Input

string portLabel, double duration

Output
Description

Produces a TLL pulse with a specified duration at the selected trigger
port.

PulseTriggerDigitalOutX (X=7-8)
Complete Command

ZenService.HardwareActions.PulseTriggerDigitalOutX(double
duration)

Input

double duration

Output
Description

Produces a TLL pulse with a specified duration at trigger port X.

ReadFocusPosition
Complete Command

ZenService.HardwareActions.ReadFocusPosition(double Position- InMicrometer)

Input

double PositionInMicrometer

Output
Description

Get the current value of the Z-drive. This function was placed under
the category HardwareActions, and not under Observables, since
they trigger the execution of the main loop of the script automatically
when changing.

ReadStagePositionX
Complete Command

ZenService.HardwareActions.ReadFocusPosition(double Position- InMicrometer)

Input

double PositionInMicrometer

Output
Description

Get the current value of the stage X-axis. This function was placed under the category HardwareActions, and not under Observables,
since they trigger the execution of the main loop of the script automatically when changing.
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ReadStagePositionY
Complete Command

ZenService.HardwareActions.ReadFocusPosition(double Position- InMicrometer)

Input

double PositionInMicrometer

Output
Description

Get the current value of the stage Y-axis. This function was placed under the category HardwareActions, and not under Observables,
since they trigger the execution of the main loop of the script automatically when changing.

SetFocusPosition
Complete Command

ZenService.HardwareActions.SetFocusPosition(double PositionInMicrometer)

Input

double PositionInMicrometer

Output
Description

Sets the focus drive to the specified position. Currently the piezo drive
is not accessible from the Experiment Feedback script.

SetIncubationAirHeaterIsEnabled
Complete Command

ZenService.HardwareActions.SetIncubationAirHeaterIsEnabled(bool IsEnabled)

Input

bool IsEnabled

Output
Description

Enables the AirHeater of the incubation system.

SetIncubationAirHeaterTemperature
Complete Command

ZenService.HardwareActions.SetIncubationAirHeaterTemperature(double temperature)

Input

double temperature

Output
Description

This will set the temperature of the AirHeater to the specified temperature.

SetIncubationChannelIsEnabled
Complete Command

ZenService.HardwareActions.SetIncubationChannelIsEnabled(int channel, bool isEnabled)

Input

integer channel, boolean isEnabled

Output

double intensity

Description

This will enable the specified channel.
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SetIncubationChannelTemperature
Complete Command

ZenService.HardwareActions.SetIncubationChannelTemperature(int channel, double temperature)

Input

integer channel, double temperature

Output
Description

Sets the temperature of the selected channel to the specified value.

SetIncubationCO2Concentration
Complete Command

ZenService.HardwareActions.SetIncubationCO2Concentration(double concentration)

Input

double concentration

Output
Description

Sets the CO2 concentration to the specified value.

SetIncubationCO2IsEnabled
Complete Command

ZenService.HardwareActions.SetIncubationCO2IsEnabled(bool
isEnabled)

Input

boolean isEnabled

Output
Description

Enables the CO2 incubation.

SetIncubationO2Concentration
Complete Command

ZenService.HardwareActions.SetIncubationO2Concentration(double concentration)

Input

double concentration

Output
Description

Sets the O2 concentration to the specified value.

SetIncubationO2IsEnabled
Complete Command

ZenService.HardwareActions.SetIncubationO2IsEnabled(bool
isEnabled)

Input

boolean isEnabled

Output
Description

Enables the O2 incubation.

SetStagePosition
Complete Command

ZenService.HardwareActions.SetStagePosition(double positionXInMicrometer, double positionYInMicrometer)

Input

double positionXInMicrometer, positionYInMicrometer
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SetStagePosition
Output
Description

Sets the stage XY position to the specified value.

SetStagePositionX
Complete Command

ZenService.HardwareActions.SetStagePosition(double positionXInMicrometer)

Input

double positionXInMicrometer

Output
Description

Sets the stage X position to the specified value.

SetStagePositionY
Complete Command

ZenService.HardwareActions.SetStagePosition(double positionYInMicrometer)

Input

double positionYInMicrometer

Output
Description

Sets the stage Y position to the specified value.

SetTriggerDigitalOut
Complete Command

ZenService.HardwareActions.SetTriggerDigitalOut(string portLabel, bool isSet)

Input

string portLabel, boolean isSet

Output
Description

Sets the selected TriggerDigitalOut port to the specified value.

SetTriggerDigitalOut7
Complete Command

ZenService.HardwareActions.SetTriggerDigitalOut7(bool isSet)

Input

boolean isSet

Output
Description

This will set TriggerDigitalOut7 port to the specified value.

SetTriggerDigitalOut8
Complete Command

ZenService.HardwareActions.SetTriggerDigitalOut8(bool isSet)

Input

boolean isSet

Output
Description

Sets the selected TriggerDigitalOut8 port to the specified value.
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SetTriggerDigitalOutRLShutter
Complete Command

ZenService.HardwareActions.SetTriggerDigitalOutRLShutter(bool isSet)

Input

boolean isSet

Output
Description

Sets the TriggerDigitalOutRLShutter port to the specified value.

SetTriggerDigitalOutTLShutter
Complete Command

ZenService.HardwareActions.SetTriggerDigitalOutTLShutter8(bool isSet)

Input

boolean isSet

Output
Description

Sets the selected TriggerDigitalOutTKShutter port to the specified
value.

13.3.2.11.1.2.2. Actions - Extra
4

AppendLogLineString (1)
Complete Command

ZenService.Xtra.System.AppendLogLineString(string logMessage)

Input

string logMessage

Output

string (contains the file path of the data log file)

Description

Creates a text file (ExperimentName_Log.txt) inside the folder save
folder/temp and the file path to the log file is returned. Numbers have
to be converted to strings in order two write them into the log file.
Column separators have to be specified as strings as well.

AppendLogLineString (2)
Complete Command

ZenService.Xtra.System.AppendLogLineString(string logMessage, string logFileName)

Input

string logMessage, string logFileName

Output

string (contains the file path of the data log file)

Description

This is similar to the function AppendLogLineString (1) but allows to
specify the file path where the text file will be saved.

ExecuteExternalProgram (1)
Complete Command

ZenService.Xtra.System.ExecuteExternalProgram(string exeFilePath)

Input

string exeFilePath

Output
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ExecuteExternalProgram (1)
Description

Starts an external application (*.exe, *.py, *.mp3, ...). It may be required to add the location of the application the environmental variables, usually PATH, in order for windows to find the application. It is
also possible to use the absolute file path.

ExecuteExternalProgram (2)
Complete Command

ZenService.Xtra.System.ExecuteExternalProgram(string exeFilePath, string arguments)

Input

string exeFilePath, string arguments

Output
Description

This is similar to the function above but it allows to specify arguments
which can be passed to the application. An example could look like
this: ZenService.Xtra.ExecuteExternalProgram("fiji-win64.exe", "macro Open_CZI_OME_complete.ijm Experiment-123.czi")

ExecuteExternalProgramBlocking (1)
Complete Command

ZenService.Xtra.System.ExecuteExternalProgram(string exeFilePath, string arguments, int timeoutInMs)

Input

string exeFilePath, string arguments, int timeoutInMs

Output

integer exitCode

Description

This advanced method will run an external program and blocks the
subsequent script. When the Experiment Feedback runs in synchronous script execution it also blocks the experiment until the external
application is closed. It requires a paramater called timeoutinMs,
which specifies after which time period the script will continue independent from the external applications. As an output it returns a socalled ExitCode (integer), which is produced by the external application when exiting. This ExitCode has to be supported by the external
application. Standard Windows programs (like Notepad, etc.) just return '0'. When using a special application or self-written applications
it is possible to set a special own ExitCode.

ExecuteExternalProgramBlocking (2)
Complete Command

ZenService.Xtra.System.ExecuteExternalProgram(string exeFilePath, int timeoutInMs)

Input

string exeFilePath, int timeoutInMs

Output

integer exitCode

Description

This is the same method as above but with additional arguments for
the external application. The timeout parameter is still required.

PlaySound (1)
Complete Command

ZenService.Xtra.System.PlaySound()

Input
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PlaySound (1)
Output
Description

This will play the system sound.

PlaySound (2)
Complete Command

ZenService.Xtra.System.PlaySound(string waveFilePath)

Input

string waveFilePath

Output
Description

Plays the specified wave sound file.

RunLoopScript
Complete Command

ZenService.Xtra.System.RunLoopScript()

Input
Output
Description

This command will trigger a run of the LoopScript. It is only meant to
be used when running the Experiment Feedback script in synchronous
script execution.

WriteDebugOutput
Complete Command

ZenService.Xtra.System.WriteDebugOutput(string message)

Input

string

Output
Description

Writes string messages in the Output for debugging.

13.3.2.11.1.3 Debugging tab

Parameter

Description

General

-

Show Warning
Popup

Allows to open warning popups.

-

Show Output
Messages

Opens the output messages field. Here the messages defined below
are displayed during script run for debugging purposes.

Output Messages

-

Show

Displays the corresponding message in white.

-

Highlight

Displays the corresponding messages with different colors.

User Defined Messages
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Write to Output
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Description
Writes user defined messages (ZenService. Xtra.System. WriteDebugOutput (string message)).

Auto Messages

-

Observable
Change

Writes a notification each time an observable changes.

-

Action Called

Writes a notification each time an action is called.

-

Action Executed

Writes a notification each time an action is executed.

-

Action Warning

Writes action warning messages.

-

Exception

Writes exception messages.

-

Script Run

Writes which part of the sript (preloop, loop script, post loop script) is
run.

Additional Information

-

Show Message
Type

Allows to additionally display the message type.

-

Show Time
Stamp

Allows to additionally display the time stamp for each message.

-

Follow Debug
Message

Follows the output if activated.

Clear output

Clears the messages in the output field.

13.3.2.12 Timed Bleaching Tool
This tool permits setting the bleach parameters for a bleaching experiment in combination with a
time series. Bleaching or photo manipulation is done in between acquisition.

Parameter

Description

Start after # of images

Activated: Enables you to set the number of frames that are imaged
before the bleaching process.

Repeat after # of
images

Activated: Enables you to set the number of images that will separate a repetitive bleaching procedure.

-

Iterations

Defines the bleach repetitions for bleach areas.
This defines the total amount of scans which are performed for
bleaching the selected region during each bleaching process.

-

Spot Bleach Duration

This function is only available with LSM 980. When spots are defined
for bleaching enter the time for each spot to be bleached in this editing field.
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Description

Excitation of
Bleach

-

Use different
settings for different regions

All Regions

Activated: For each previously drawn ROI a tab is present, in which
laser line and laser power can be chosen.
Only visible if the checkbox above is not activated.
Note that for high laser power the High Intensity Laser Range must
be set in the Imaging Setup or Channels tool (only for LSM 900).
Activates the according checkbox for a laser line. Use the slider to adjust the power for bleaching/photo-manipulation.

The following parameters are only visible if the Show All mode is activated:

Parameter

Description

Bleaching Settings

Here you can manage bleaching settings, e.g. save, load or delete settings on the hard disk.

Stop on intensity
below

Activated: Enables you to bleach the sample to an intensity value calculated as % of the initial intensity within the region to bleach, during
an experiment with repetitive bleaching. The intensity value is determined with every taken image.
Note: This function can only be applied if one ROI for bleaching is defined. It does not work for multiple regions.

Set Different scan
speed

Activated: Enables you to set the scan speed for bleaching can differently than the imaging scan speed. A lower speed results in a longer
pixel dwell time, which increases the efficiency of bleaching.

Set different Z-Position

Activated: Enables you to perform the bleaching at a different z-level
than currently set. Enter the difference in µm into the input field.

Spot/Full area sequential bleach

Activated: For Spot Bleach mode this is set as default. When activated all regions (and spots) are bleached sequentially performing all
bleach iterations for each region first before moving to the next region. The scan field is limited to each bleach region.

Protect detectors
during bleach

Activated: PMT gain is set to 0 V during the bleaching step.
Note that, selecting this option the PMT gain will slow down the acquisition. Typically, small bleach ROIs will not be causing a critically
high signal for the detectors.
However, even when this option is not activated, the detectors will either downregulate the voltage or shut down completely in case of
significant over exposure.
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13.3.2.13 Interactive Bleaching Tool
This tool allows to bleach interactively during a Continuous scan or during a Time Series experiment while image acquisition is performed. The bleach region is determined by pointing the
mouse onto the position in the image.

Fig. 69: Interactive Bleaching Tool

Parameter

Description

Mouse Behavior

Change the display of the selected clipping plane using the dropdown
list to the right of the Activate checkbox. The following settings are
available:

-

Bleach while
mouse button
pressed

The bleaching process is continued while the mouse button is
pressed.

-

Bleach fixed
number of iterations

The bleaching process is continued for a fixed number of times after
the mouse is pressed. The number of iterations can be entered below.

-

Fixed iteration
count

Determines the number of iterations.

-

Allow cancel by
click

If activated, the bleaching process can be stopped before the fixed
number iterations is accomplished. Simply click on the left mouse button again to stop the bleaching process.
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Parameter

Description

Bleaching Stencils
list

The available bleaching stencils (equivalent to ROIs for bleaching) are
listed here.
A stencil is displayed in its graphical form, the color displays the laser
line that is assigned for bleaching to this stencil.
You can add a stencil by clicking the + Create from graphic button.
This will import an activated graphical element from the Graphics
tool tab.
A stencil can be saved, loaded or deleted.
A stencil is active, when clicked on and highlighted.
To use an activated stencil for bleaching, move the mouse cursor onto
the image and click on the left mouse button.

Laser Settings for
section

Here you can set the laser line and laser power for the activated stencil.

13.3.2.14 Dynamics Tool
The checkbox to activate the tool is only visible if Time Series acquisition is active and Tiles is not
activated.
Using the tool you can open the Mean ROI Setup where you can configure physiology functions
for a Time Series experiment. Deactivate the Dynamics checkbox to deactivate physiology functions.
If you click on the Mean ROI Setup button the setup view will be visible in the Center Screen
Area. There you will see a snapshot containing all channels of the currently active image.
13.3.2.14.1 Mean ROI Setup
The Mean ROI Setup is in essence a modified version of the MeanROI view with several minor
additions. It allows experiment pre-settings to be made on Snap-shots of the cells/ specimen on
which the measurements will be made. These settings include:
§

image and chart layouts;

§

chart axis settings;

§

generation, placement and management of measurement and Background ROIs

§

measurement settings

A ratio preview image is also displayed that allows an assessment of the current ratio settings on
the Online Ratio tab. To update the images in the Mean ROI Setup a new Snap can be made at
any time.

See also
2 Mean ROI Tab [} 861]
2 Layout Tab [} 862]
2 Charts Tab [} 863]
2 Online Ratio Tab [} 864]
2 Mean ROI View [} 859]
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13.3.2.15 Auto Save Tool

Info
The Auto Save tool is not visible, if you have activated the Panorama checkbox in the Experiment Manager. When you execute an experiment or click on the Snap button, the Auto Save
tool is disabled until the experiment is cancelled or finished. The tool also stays disabled when
the experiment is paused. This behavior should prevent operation errors during experiments.
If the Auto Save checkbox in the Experiment Manager is activated, all images which are acquired from the Acquisition tab, are automatically stored as *.CZI format during acquisition.
Generally, all images are automatically written to the hard disk during acquisition. This is to prevent data loss in case of technical problems. The folder path for these files is displayed in the status bar under Storage Folder. The location can easily be opened by double-clicking on this field.
The path can be changed in the Tools menu | Options | Saving. Even though these files are
stored physically on the disk, they are indicated with an asterisk and you will be prompted to either rename and store them in a different place, or to delete them. They are maintained only if
the software crashes. In case you want to store the files directly in a location of your choice, activate the Auto Save checkbox. In this case the files are not written to the temporary folder anymore.
The automatically saved images are contained in the subfolder temp within the currently chosen
image storage path (default path is: C:\Users\<username>\Pictures\temp). When saving such temporarily saved images via the File menu | Save you will be asked to specify a document name and
a storage location. If you close such an image document without saving it, it will be permanently
deleted from the Temp folder in order to prevent the accumulation of unnecessary images.

Parameter

Description

Folder

Shows the directory for the images. The text box is read-only. No
values can be entered or pasted by the user. This ensures that
the text box contains always a valid directory
To change the directory click on the
folder for the auto saved images.

button to select a new

Automatic Sub-Folder

Activated: Creates automatically a top level sub folder in the
given directory. The sub folder name is based on the actual date,
e. g. 2014-07-04.

Name

Here you can specify the image name. An index number is automatically appended to the image name.

Close CZI after acquisition

Activated: Closes the CZI image in the center screen area when
the experiment is finished.

File Name Preview

Shows the currently chosen storage path as well as a preview of
file name being used next.
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13.3.2.16 Automated Image Export Tool

Info
It is not possible to automatically export images created by the Snap function. If you require to
use the Auto Export feature for individual images, you must create a Time Series experiment
with a single cycle.
If the Automated Export checkbox in the Experiment Manager is activated before an experiment is executed, the generated images will be stored in the defined directory with the given parameters and options, provided by the options under the checkbox. This option was developed for
automatically exporting images with a user defined format (TIFF or JPEG).

Info
When you execute an experiment, the tool is disabled until the experiment is cancelled or finished. The tool also stays disabled when the experiment is paused. This behavior should prevent operation errors during experiments.
For technical reasons images acquired from the Acquisition tab are always auto-saved temporarily
as CZI files. If the application requires images to be stored in external common file formats, it is
necessary to run the export function. The Automatic Image Export facilitates this in a convenient
und automatic way giving the choice of single page TIFF or JPEG file formats. It is also possible to
automatically close and discard the auto-saved CZI file to streamline the acquisition workflow.

Parameter

Description

Folder

Shows the directory for the images. The text box is read-only. No
values can be entered or pasted by the user. This ensures that
the text box contains always a valid directory
To change the directory click on the
button. Select a new
folder for the auto saved images in the dialog.

Automatic Sub-Folder

Activated: Creates automatically a top level sub folder in the
given directory. The sub folder name is based on the actual date,
e. g. 2014-07-04.

Prefix

Here you can define a prefix for the image file name and a name
for the sub folder. If the text box is empty an image gets a localized default prefix (“Untitled”) and a folder gets a localized default name (“New folder”). If an image or folder with a name still
exists, the new image or folder gets the same name with an increasing index in accordance to the standard Windows Explorer
behavior, e. g. New Folder (1), New Folder (2).

Format

Here you select the format for the export images. Two formats
are supported:
§ TIFF: For the TIFF format (lossless, bigger file size) you can additionally select the Compression method.
– None
– LZW
– ZIP
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Description
§ JPEG: For the JPEG format (lossy, smaller file size) you can set
the Quality level by adjusting the slider between Low (lower
quality, smaller images) to High (higher quality, bigger file
size).

Original data

For TIFF format only:
Activated: Generates an additional raw data TIFF image. Its bit
depth depends on the original camera image (Gray 8/16 bit or
RGB 24/48 bit)

Gray Scale Linear

For JPEG format only:
Activated: Generates an additional raw data JPEG image. The
bit depth depends on the original camera image. In case of 8
bits, the JPEG image has 8 bit gray scale or 24 RGB. In case of 16
bits, the JPEG image is reduced to the “Valid Bits” of the camera.
If the camera image is a 16 bit gray scale image, the resulting
JPEG image is a 8 bit gray scale image. In case of a 48 bit RGB
image the JPEG image has 8 bit RGB.
Both additional image types are marked with an ORG suffix in
their file names.

Apply display curve
and channel color

Activated: Applies the display curve and channel color to the
JPEG or TIFF image

Use channel names

Activated: The name of the resulting image contains the name
of the defined channel.

Add XML Metadata

Activated: Saves an additional xml file with image meta data. Its
name has the following nomenclature:
Prefix_Metadata(image format).xml → Test_Metadata(tif).xml If
more than one xml file with the same name exists the file gets an
index, e.g. Test-02_Metadata(tif).xml.

Close CZI image after
acquisition

Activated: Closes the CZI image in the center screen area when
the experiment is finished.
NOTICE! If Auto Save is not activated, this will lead to the
loss of the original .czi file for the experiment.

Dimension/Sub-directory

If you check one of the Channels, Time Series, Z-Stack or Scenes
checkboxes, an additional sub-directory will be created if the corresponding dimension exists in the experiment block.
The sub-directory will be created in the same image dimension
order as the CZI image created, e.g. T-C-Z. The top level folder
within the “Dimension” folders is always the B (“Block”) folder
[new].
Each sub-directory gets a letter that represents its image dimension (T for time series, C for channel, etc.) and an index, if more
than one dimension of the same type exists (T=0, T=1).

13.3.2.17 Automation Tool
With this tool you can select OAD macros which will be executed before or/and after an experiment. The default folder for macros is User/Documents/Carl Zeiss/ZEN/Documents/Macros.
Any other folder is selectable.
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Parameter

Description

Run OAD macro
before experiment
execution

If activated, the selected macro is executed before the experiment
starts.

Run OAD macro
after experiment
execution

If activated, the selected macro is executed after the experiment.

If you click on the ... button you can select a macro from the file system.

If you click on the ... button you can select a macro from the file system.

13.3.3 Tools on Processing Tab
13.3.3.1 Image Parameters - Input Tool

Parameter

Description

Input image

Input image with file name and path to the target folder.

Set Input Automatically

Activated: The currently active image is automatically loaded as input
image. This can be used to load the output image of the first image
processing step as input for the next image processing step.

Apply to preview,
only

After image processing, the output image document is active.

Switch to Output

Activated: Applies the selected Image Processing Function only to
the area that is selected in the Output Tool via Preview.

Remain at current
view

Activated: The currently active image document will remain active after the image processing step.

13.3.3.2 Image Parameters - Output Tool

Parameter

Description

Output image

Output image with file name and path to the target folder.

Custom Output
Name

Enter a valid output name.

Overwrite

Activated: Overwrites an existing file.

Create New Output

Activated: Saves the image file with a new name.

Save outputs

Activated:Saves the image automatically.

Naming

Opens a dialog to define conventions for the image file name.

Preview

Displays a preview window in your image. In this window you can see
a calculated preview of what the result will look like with the current
parameter settings.

See also
2 Image Processing Workflow [} 90]
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13.3.4 Tools on Analysis Tab
13.3.4.1 Interactive Measurement Tool

Feature Set section

Parameter

Description

Feature Set

Here you select and load previously saved feature definitions/feature
sets. If you have made changes to a feature definition, the name of
the feature selection is marked with an asterisk (*). If you close the application without saving a changed ("asterisked") feature selection,
you will be asked whether you want to save the changes.
Opens the Options shortcut menu.

Options
Define

Opens the Feature Selection Dialog.

Feature Subset section
Only visible if the Show All mode is activated.

Parameter

Description

Feature Subset

Here you can select and load previously saved definitions of subsets. If
you have made changes to a subset definition, the name of the feature subset is marked with an asterisk (*). If you close the application
without saving a changed ("asterisked") feature subset, you will be
asked whether you want to save the changes.
Opens the Options shortcut menu.

Options
Define

Opens the Feature Subset Definition Dialog [} 772].

Measurement Sequence section
Only visible if the Show All mode is activated.

Parameter

Description

Measurement Sequence

Here you can select and load previously saved measurement procedures. If you have made changes to a measurement procedure, the
name of the measurement procedure is marked with an asterisk (*). If
you close the application without saving a changed ("asterisked")
measurement procedure, you will be asked whether you want to save
the changes.
Opens the Options shortcut menu.

Options
Define

Opens the Interactive Measurement Sequence Definition Dialog.
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Parameter

Description

Run

Starts the selected Measurement Sequence in the Interactive Measurement Sequence Execution Dialog.

Parameter

Description

Create Measurement Table

Creates a measurement data table. This contains the measurement
data from the Measure view of the current image.

13.3.4.1.1 Feature Selection Dialog
Here you can specify which features are measured with the available graphic elements. This selection is adopted into the current feature definition. The feature definition is then marked ("asterisked") as having been changed.
Available Elements section
In this section you can specify for each available graphic element which features you want to be
measured. The graphic elements are ordered by type. The following types are available for selection:

Element Type

Description

Regions (2D)

Here you will find all the graphic elements that define a closed region.

Single Distances

Here you will find all the graphic elements with which you can measure a single distance.

Multiple Distances

Here you will find all the graphic elements with which you can measure several distances at once.

Angle

Here you will find the graphic elements with which you can measure
an angle.

Point

Here you will find the graphic elements with which you can perform
measurements at a pixel.

Events

Here you will find the graphic elements with which you can count various events in an image.

Selected Features section
The features that you have selected for each individual graphic element are listed in this section.
Activate the Display checkbox for each feature to display the value of the measured feature in
the graphics plane of the image.

Parameter

Description
Deletes the selected feature.

Delete
Moves the selected feature one position higher.
Upwards
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Description
Moves the selected feature one position lower.

Downwards
Features section
All the features that you can measure with the graphic element activated in the Available Elements section are listed in this section.

Parameter

Description

Search Features

Here you can enter parts of the name of the feature that you are
looking for. The features in which the entered character string occurs
are listed.
Select a type of feature according to which you want the features to
be filtered from the dropdown list.

-

All

All features are listed.

-

Geometric Features

All geometric features are listed.

-

Intensity Features

All features that analyze intensity values are listed.

-

Image Features

All features that contain meta information about the measured image
are listed.

-

Position Features

All features that describe the position are listed.

-

Geometric Features Unscaled

All features that describe unscaled geometric features.

-

Position Features Unscaled

All features that describe unscaled positions are listed.

-

Polygon-based
Features

All features polygon-based features are listed.

-

Statistical Features

All features that can be used for plotting in a heatmap (i.e. that provide statistical values suitable for heatmap plotting) are listed.

Parameter

Description
Click on the button to select a feature for the measurement.

Add
13.3.4.1.2 Feature Subset Definition Dialog
Here you can specify which features are available in the Feature Selection Dialog. These features
are adopted into the current subset definition. The subset definition is then marked ("asterisked")
as having been changed.
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Features section
All the features that you can measure with the graphic element activated in the Available Elements section are listed in this section.

Parameter

Description

Search Features

Here you can enter parts of the name of the feature that you are
looking for. The features in which the entered character string occurs
are listed.
Select a type of feature according to which you want the features to
be filtered from the dropdown list.

-

All

All features are listed.

-

Geometric Features

All geometric features are listed.

-

Intensity Features

All features that analyze intensity values are listed.

-

Image Features

All features that contain meta information about the measured image
are listed.

-

Position Features

All features that describe the position are listed.

-

Geometric Features Unscaled

All features that describe unscaled geometric features.

-

Position Features Unscaled

All features that describe unscaled positions are listed.

-

Polygon-based
Features

All features polygon-based features are listed.

-

Statistical Features

All features that can be used for plotting in a heatmap (i.e. that provide statistical values suitable for heatmap plotting) are listed.

Parameter

Description

Feature

There is a checkbox in front of the name of each of the listed features. Activate the checkbox in front of the features that you want to
be offered in the Feature Selection dialog.

Shortcut menu

Right-click in the Features section to open the shortcut menu.

-

Select All Features

Activates all checkboxes.

-

Deselect All
Features

Deactivates all checkboxes.

13.3.4.1.3 Interactive Measurement Sequence Definition Dialog
Here you can define an interactive measurement procedure. You can specify the order in which
you want the individual graphic elements to be drawn in and which measurement parameters you
want to have calculated for them. The definition is adopted into the measurement procedure currently selected. The measurement procedure is then marked ("asterisked") as having been
changed.
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Available Elements section
In this section you can specify for each available graphic element which features you want to be
measured. The graphic elements are ordered by type. The following types are available for selection:

Element Type

Description

Regions (2D)

Here you will find all the graphic elements that define a closed region.

Single Distances

Here you will find all the graphic elements with which you can measure a single distance.

Multiple Distances

Here you will find all the graphic elements with which you can measure several distances at once.

Angle

Here you will find the graphic elements with which you can measure
an angle.

Point

Here you will find the graphic elements with which you can perform
measurements at a pixel.

Events

Here you will find the graphic elements with which you can count various events in an image.

Double-click on a available element to select it and adopt it into the Selected Elements Sequence list.
Selected Elements Sequence section
This list displays the selected graphic elements in the order in which they will be drawn in during
the measurement, from top to bottom. To display the value of the measured feature in the image's graphics plane, activate the corresponding checkbox of the graphic elements.

Parameter

Description
Deletes the selected feature.

Delete
Moves the selected feature one position higher.
Upwards
Moves the selected feature one position lower.
Downwards
Features section
All the features that you can measure with the graphic element activated in the Available Elements section are listed in this section.

Parameter

Description

Search Features

Here you can enter parts of the name of the feature that you are
looking for. The features in which the entered character string occurs
are listed.
Select a type of feature according to which you want the features to
be filtered from the dropdown list.

-

All

All features are listed.
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Description

-

Geometric Features

All geometric features are listed.

-

Intensity Features

All features that analyze intensity values are listed.

-

Image Features

All features that contain meta information about the measured image
are listed.

-

Position Features

All features that describe the position are listed.

-

Geometric Features Unscaled

All features that describe unscaled geometric features.

-

Position Features Unscaled

All features that describe unscaled positions are listed.

-

Polygon-based
Features

All features polygon-based features are listed.

-

Statistical Features

All features that can be used for plotting in a heatmap (i.e. that provide statistical values suitable for heatmap plotting) are listed.

Parameter

Description
Click on the button to select a feature for the measurement.

Add
13.3.4.2 Image Analysis Tool
Note that this tool is available only when you have licensed the Image Analysis module.

Parameter

Description

Setting

Select and load previously saved analysis programs here.
Opens the options menu.

Options

–

New

Creates a new analysis setting. Enter a name for the setting.

–

New from Template

Creates a new setting based on an existing setting. The template setting will not be modified.

–

Create new
from analyzed
image

Reads out czias settings from a previously analyzed image and creates
a new setting from that.

–

Rename

Enables you to enter a new name for the setting.

–

Save

Saves a modified setting under the current name. An asterisk indicates
the modified state.

–

Save As

Saves the current setting under a new name. Enter a name for the
setting.

–

Import

Imports an existing setting.
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Description
Deletes the current setting.
Opens the Segmentation Method Selection dialog.

Edit

For more information, see Creating a new image analysis setting
[} 369].

Parameter

Description

Setup Image Analysis

Opens the Image Analysis Wizard [} 777] to define a new analysis
program or to change an existing program.

Analyze Interactively

Runs the selected analysis program with all the interactive steps.

Analyze

Runs the selected analysis program without interruption.

Info
Steps that you have not marked as interactive in the Image Analysis Wizard are run with the
values set in the analysis program. The program does not stop to allow you to change these
interactively.

13.3.4.2.1 Segmentation Method

Parameter

Description

Method

-

Segment region
classes independently

For each defined region class the specified image channel will be
segmented using the class segmenter which can be defined in
step Automatic Segmentation of the image analysis wizard.

-

ZOI (Zones of Influence)

Constructs a zone of influence (ZOIs) and a ring around each primary object.

-

Segment binary images

For each region class, the selected image channel will be segmented by the binary class segmenter.

-

Whole image

Uses the whole image as a region.

-

Interactive segmentation

Uses only the interactive segmentation step. For each region
class, the regions must be drawn manually.

Wizard Steps

-

Classes

In this step you can define the classes into which the measured
objects in the image are divided.

-

Frame

In this step you can define one or more measurement frames.

-

Automatic Segmentation

In this step you can choose the segmentation method to be applied and set parameters for the segmentation of the objects
that you want to measure.

-

Region Filter

In this step you can define the conditions under which you want
an object to be measured.
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Parameter

Description

-

Interactive Segmentation

In this step you can post-process the segmented objects interactively.

-

Features

In this step you select the measurement features.

-

Results Preview

In this step you will see the preview of the measurement result.

13.3.4.2.2 Image Analysis Wizard
Note that this wizard is available only when you have licensed the Image Analysis module.
13.3.4.2.2.1 Classes
In this step you can define the classes into which the measured objects in the image are divided.

Parameter

Description

Interactive

Activated: The class definition can be changed interactively while the
measurement program is running in Analyze Interactively mode.

Classes

The defined classes are listed here. If you create a new measurement
program, a predefined set of classes is created automatically. Each
class consists of two entries. The first entry concerns all the objects
belonging to the class. The second entry represents an individual object.

Add Class

Adds a new individual class to the list on the Base-level.

Add Subclass

Adds a new subclass to the selected class.

Remove Class

Deletes the selected class from the list.

Name

Here you can enter a name for the selected class in the Classes list.

Channel

If you create a measurement program for a multichannel image, in
this selection field you need to select the channel for the selected
class in the Classes list. This channel is used for image segmentation.

Color

Here you can select a color to mark the objects of a class.

Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

For more information, see Image Analysis [} 369] to Image Analysis.
13.3.4.2.2.2 Frame
In this step you can define one or more measurement frames. Only the area within the measurement frames will be analyzed. Furthermore you can define how the analysis treats objects that are
cut by the border of the image or the frame.
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Parameter

Description

Interactive

Activated: The measurement frame definition can be changed interactively while the measurement program is running in Analyze Interactively Mode.

Tool bar

Select Frame

Draw Rectangle

Draw Circle

Draw Contour
(Polygon)

Use this to select measurement frames that you have already created.
To select a measurement frame, click inside it. To select several measurement frames, hold down the Ctrl key and click inside the desired
measurement frames. Once you have selected a measurement frame,
you can change its size. Delete frames with the Del key.
Enables you to create a rectangle as a measurement frame in the current image.
Enables you to create a circle as a measurement frame in the current
image.
Enables you to create a contour as a measurement frame in the current image.

Removes all drawn-in measurement frames in the current image.

Remove All
Frames
Maximize circle

Only active if you have defined precisely one circle.
Activated: Maximizes the drawn-in circle to the full image size. In the
case of rectangular images the circle is adjusted to the shorter side.

Center circle

Only active if you have defined precisely one circle.
Activated: Centers the drawn-in circle to the full images size.

Mode

Here you can select how you want the measurement frame to be applied. The following modes are available:

-

Inside Only

Measures only those objects, that are lying completely within the
measurement frame. Objects that are touching the frame or are intersected by the frame are not analyzed.

-

Cut at Frame

Measures all objects that are lying within the measurement frame.
Objects that are intersected by the measurement frame are measured
precisely up to the measurement frame.

The following fields are only active if you have selected a drawn-in graphic element:
Left

Here you can enter the start point for the frame on the X axis in pixels.

Top

Here you can enter the start point for the frame on the Y axis in pixels.

Width

Here you can enter the width of the measurement frame in pixels.

Height

Here you can enter the height of the measurement frame in pixels.
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Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

For more information, see Image Analysis [} 369] to Image Analysis.
13.3.4.2.2.3 Automatic Segmentation
In this step you can choose the segmentation method to be applied and set parameters for the
segmentation of the objects that you want to measure.

Parameter

Description

Execute

Activated: Sets the defined threshold values when the measurement
program is run.

Interactive

Activated: The defined threshold values can be changed while the
measurement program is running in Analyze Interactively mode.

Classes

Here you can select the class for which you want to define the segmentation.

Ring Element Class

This additional parameter is only available if you have selected the
Zone of Influence (ZOI) method.

-

Ring Distance

Distance from surface of the primary object. Negative values mean
that the ring starts at the defined distance within the primary object.

-

Ring Thickness

Defines the thickness of the ring.

ZOI Class

-

ZOI Width

Apply

This additional parameter is only available if you have selected the
Zone of Influence (ZOI) method.
Allows you to set the distance of border of the ZOI from the border of
the ring, or the main object, respectively.
Executes the selected segmentation method after a parameter
change.
Time consuming segmentation methods like Intellesis Trainable Class
Segmenter are not run again automatically when a parameter is
changed.

Select

Opens the selection of segmenters. For more information, see Segmentation Method Selection [} 784].

The following parameter are visible depending on the selected segmentation method.
Model Section

Parameter

Description

Select Model

Opens the dialog to choose a segmentation model, see also Select
Model dialog [} 785].

Reset

Resets/ Deletes the selected model.
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Smoothing section

Parameter

Description

Smoothing

Here you can select how you want to smooth the image before the
threshold values are set. The following methods are available:

-

None

The image is not smoothed.

-

Low Pass

Applies the Low Pass Method.

-

Gauss

Applies the Gauss Method.

-

Median

Applies the Median Method.

Size

Only visible, if you have selected Low Pass or Median.
Enter the size of the filter matrix in the X and Y direction using the
slider or input field.

Sigma

Only visible, if you have selected Gauss.
Enter the sigma value using the slider or input field.

Variance section

Parameter

Description

Variance

Set the kernel size which is used to calculate the variance value of one
pixel with its neighboring pixels using the slider or input field.

Thresholds section

Parameter

Description

Thresholds

Define the lower and upper threshold for the variance using the slider
or input field.

Invert

Parameter

Description

Invert

Activated: Uses the inverted areas of the histogram as were previously defined.

Dilate

Parameter

Description

Dilate

Dilate the segmented area using the slider or input field. (Value given
in pixels).

Subtract BG section

Parameter

Description

Subtract BG

Here you can select what kind of background subtraction is performed. Only visible if Segmentation with Background Subtraction is selected.
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Description

-

None

No background subtraction is performed.

-

Rolling ball

The rolling ball background subtraction is performed.

Sharpen section

Parameter

Description

Sharpen

Here you can select how you want to improve the sharpness of the
image before the threshold values are set. The following methods are
available:

-

None

The sharpness of the image is not changed.

-

Delineate

Applies the Delineate Method.

-

Unsharp Masking

Applies the Unsharp Masking Method.

Threshold

Only visible, if you have selected Delineate.
Enter the threshold value for edge detection using the slider or input
field. The threshold value should correspond roughly to the gray value
difference between objects and the background.

Size

Only visible, if you have selected Delineate.
Enter the size of the edge detection filter using the slider or spin box/
input field. The value should correspond to the size of the transition
area between objects and the background.

Strength

Only visible, if you have selected Unsharp Masking.
Enter the strength of the Unsharp Masking using the slider or input
field. The higher the value selected, the greater the extent to which
small structures are enhanced.

Threshold section
Here you can define the threshold values for the selected class in the Classes list.

Parameter

Description

Reset

Resets all threshold value settings.

Undo

Undoes the last change made to the threshold values.

Redo

Restores the last undone change to the threshold values.

Color Model

Only visible if the image is a color image.
Color Model [} 786]

-

RGB

In RGB Mode you can define the threshold values for the red, green
and blue color channels.

-

HLS

In HLS Mode you can define the threshold values for hue, saturation
and lightness.

Histogram

In the histogram you can change the lower and upper threshold value
for the activated value. Drag the lower or upper adjustment handle or
shift the entire highlighted area between the lower and upper threshold value.
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Description

Threshold Definition

-

Click

Click in the image on the regions that you want to define as objects.

-

Automatic

The threshold values are determined automatically from the histogram. During setup only the part of the image displayed in the
viewport is taken for the calculation of the threshold (only for method
RGB).

Pick Behavior

Only visible, if you have selected Click for Threshold Definition.

-

+

Enables you to expand the currently segmented regions by the gray
values/colors of the objects subsequently clicked on.

-

-

Enables you to reduce the currently segmented regions by the gray
values/colors of the objects subsequently clicked on.

Tolerance

Only visible, if you have selected Click for Threshold Definition.
Enter the tolerance range by which the gray/color value read out
when you click is expanded to define the threshold value, using the
slider or input field.

Neighborhood

Only visible, if you have selected Click for Threshold Definition.
Enter a neighborhood range around the pixel clicked on, using the
slider or input field. The threshold value is calculated from the average
of the gray/color values in this neighborhood range.

Method

Only visible, if you have selected Automatic for Threshold Definition.
Select the method from the dropdown list that you want to use for
the automatic calculation of the threshold values.
The following methods are available:

-

Otsu

For all possible threshold values, the Otsu method calculates the variance of intensities on each side of the respective threshold. It minimizes the sum of the variances for the background and the foreground.

-

Maximum Peak

Separates background and foreground pixels at the maximum value
of the histogram.

-

Iso Data

The threshold value lies in the middle between two maximums in the
histogram.

-

Triangle Threshold

The threshold value is calculated from the sum of the average and
three times the sigma value of the histogram distribution.

-

Three Sigma
Threshold

Info
After the automatic calculation of the threshold values you can further modify the threshold
values found interactively by selecting Click for threshold value definition.
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Min. Confidence Section

Parameter

Description

Min. Confidence
(%)

Sets the minimum value for the confidence that a certain pixel belongs to the segmented class. The default value is 51.

Minimum Area section

Parameter

Description

Minimum Area

Enter the minimum area in pixels that an object must have in order to
be segmented, using the slider or input field.

Hole section

Parameter

Description

Min. Hole Area

Enter the minimum area in pixels of the holes of the detected region
using the slider or input field. This input is synchronized with the input
for Minimum Area which must not be smaller than Min. Hole Area.

Fill all Holes

Activated: Fills holes in segmented objects.

Binary section

Parameter

Description

Binary

Performs morphological operations on the segmented (binary) image.

-

None

No operation is performed.

-

Open

Opening performs first erosion and then dilation. The effect is
smoothing and removing of isolated pixels.

-

Close

Performs first dilation and then erosion. The effect is smoothing of
the objects and filling of small holes.

-

Dilate

Enlarges the boundaries of segmented regions. Areas grow in size and
holes within the regions become smaller.

-

Erode

Erodes boundaries of the segmented regions. The areas shrink in size
and holes within the areas become larger.

Count

Enter how often the selected binary operation is performed, using the
slider or input the field.

Separate section

Parameter

Description

Separate

Here you can select whether you want to process the image further
after segmentation. Objects that are touching one another can be
separated using different methods.

-

None

Objects are not separated.
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Description

-

Morphology

This method separates objects by first reducing and then enlarging
them, making sure that once objects have been separated they do not
merge together again.

-

Watersheds

Using this method you can separate objects that are roughly the same
shape. This method may however result in the splitting of elongated
objects.

Count

Enter how often the method is applied successively to the result at the
location of the separation, using the slider or input field.

Suppress Invalid section

Parameter

Description

Suppress Invalid

Activated: Discards invalid pixels at the border of the image.

Suppress Border

Parameter

Description

Suppress Border

Activated: Suppresses the border pixels which might be incorrect, as
areas outside of the image are filled with zeros. Excluded area depends on the kernel size used.

Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

For more information, see Image Analysis [} 369] to Image Analysis.
13.3.4.2.2.3.1 Segmentation Method Selection

Parameter

Description

Segmentation Source

Here you can select the segmentation source. Depending on the
selected segmentation source, the functionalities in the Image
Analysis Wizard change accordingly, see Automatic Segmentation [} 779].
Note: This does not work for intensity features as region filter.

-

From Image Channel

Uses the channel of the multi-channel image defined in step
Classes for segmentation of the selected region class.

-

From Measurement
Frame (s)

Takes the regions from the measurement frame. You can modify
the region in the interactive segmentation step.

-

Remaining to Frame

Takes the regions from the measurement frame when the regions of the other classes are subtracted from the measurement
frame.
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Parameter
-

Description

Take from parent regions

Image Segmenter

Takes the regions that fulfill a certain condition, defined in step
Region Filter, from the parent regions.
Here you can choose which segmentation method will be applied.

-

Segment by global
thresholding

A global threshold is applied to the image channel for image segmentation.

-

Segmentation with
Background subtraction

A background subtraction is performed prior to a thresholdbased image segmentation.

-

Segment binary images

Segments binary images.

-

Variance-based
thresholding

Image segmentation via variance-based thresholding. Detects objects where there is a strong change in pixel intensities independent of the absolute intensity.

-

Dynamic thresholding

Dynamic thresholding or adaptive thresholding calculates a local
threshold for small regions of the image. This is especially helpful
for inhomogeneous illumination or background structures.

-

Intellesis Trainable
Class Segmenter

Uses machine-learning algorithms to segment the selected class
by applying a trained Intellesis model.

13.3.4.2.2.3.2 Select Model dialog

Parameter

Description

Model Name

Here you can select a model.
Only models trained on one channel images are shown here because
only those can be used to segment a specific class assigned to a specific channel.

Model Class

Here you can select the model class.

OK

Sets the model name and class.

Cancel

Cancels the model selection and closes the dialog.

See also
2 Automatic Segmentation [} 779]
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13.3.4.2.2.3.3 Color Model
RGB
Here you can set the RGB channel threshold values.

Parameter

Description
Activates the red channel in the Expander Histogram.

Red
Activates the green channel in the Expander Histogram.
Green
Activates the blue channel in the Expander Histogram.
Blue
Low

Here you can enter the lower threshold value for the corresponding
channel.

High

Here you can enter the upper threshold value for the corresponding
channel.

Invert

Swaps the Lower and Upper values for the corresponding channel.

Full Range

Sets the Low value to 0 and the High value to the maximum possible
gray value for the corresponding channel.

HLS
Here you can set the hue, lightness and saturation threshold values.

Parameter

Description
Activates the hue in the Expander Histogram.

Hue
Activates the lightness in the Expander Histogram.
Lightness
Activates the saturation in the Expander Histogram.
Saturation
Low

Here you can enter the lower threshold value for hue, lightness and
saturation.

High

Here you can enter the upper threshold value for hue, lightness and
saturation.

Invert

Swaps the corresponding Lower and Upper values.

Full Range

Sets the corresponding Lower value to 0 and the Upper value to the
maximum possible value.
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13.3.4.2.2.4 Region filter
In this step you can define the conditions under which you want an object to be measured.

Parameter

Description

Execute

Activated: Uses the measurement conditions when the measurement
program is run.

Interactive

Activated: The measurement conditions can be changed while the
measurement program is running in Analyze Interactively mode.

Classes

Here you can select the class for which you want to define the conditions.

Edit

Opens the Region Filter Editor [} 787].

Copy to All

Copies the defined region filters to all classes.

Conditions

If you have defined one or more blocks with conditions in the Region
Condition Editor, you can select the block for which you want to set
the condition.
Select the relevant block and set the maximum/minimum values either
by clicking on the objects in the image you want to include in the
measurement, or by entering the maximum/minimum values separately.

Undo

Undoes the last change made to the condition.

Redo

Restores the last undone change to the condition.

Reset

Resets all settings for the conditions.

Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

For more information, see Image Analysis [} 369] to Image Analysis.
13.3.4.2.2.4.1 Region Filter Editor
All features in the list of selected features will be calculated during image analysis. The results are
displayed in the results table for all detected objects of the same class. The columns of the features are sorted according to the order they appear in the Selected Features list.
The results of the settings you set here will be displayed in the Image Analysis Wizard in the last
step in the table with results on the right side. For more information, see Results Preview [} 795].
For a detailed description of the individual features, see Measurement Features [} 397].

Parameter

Description

Selected Features
for Condition

In this list, the features that you have selected for the condition are
displayed block by block. All features in a block are "And"-linked for
the condition, i.e. an object is only measured if the values of each individual feature fall within the defined range.
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Parameter

Description

Add Block

Adds an "Or" block. If several "Or" blocks have been defined, an object is measured if it meets the condition in at least one block.

Clear Block

Deletes all features in an "Or" block.

Remove Block

Deletes the selected "Or" block.

Remove All

Deletes all "Or" blocks.

Parameter

Description

Search Features

Searches for features by name.

Drop down menu

Double-click on the feature or click the + symbol to add the feature to
the list of selected features on the left.

-

All

Lists all available features.

-

Geometric Features

Lists only the subset of geometric features.

-

Intensity Features

Lists only the subset of intensity features.

-

Image Features

Lists only the subset of image features.

-

Position Features

Lists only the subset of position features.

-

Geometric Features Unscaled

Lists only the subset of unscaled geometric features.

Parameter

Description
Click on the button to select a feature for the measurement.

Add
13.3.4.2.2.5 Interactive Segmentation
In this step you can post-process the segmented objects interactively. You can modify the results
of the automated segmentation when you use Run Interactive to analyze your image data.

Parameter

Description

Interactive

Activated: The segmented objects can be post-processed interactively while the measurement program is running.

Classes

Here you can select the class whose objects you want to process.

Edit Region section
With the tools below you can modify the objects of the currently selected class.

Parameter

Description

Draw

Draw new objects of the selected class.
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Parameter

Description

Erase

Using this button you can erase parts of an object. Holding down the
left mouse button, outline the parts of the object that you want to
erase. Right-click to erase these parts of the object.

Cut

Use this button to separate connected objects. Holding down the left
mouse button, draw in the separation line between the objects.
Right-click to cut the objects.

Merge

Use this button to connect objects. Holding down the left mouse button, outline the parts of the object that you want to merge. Rightclick to merge the objects.

Fill

Fills a hole. To fill a hole, left-click on the hole.

Remove

Removes a drawn in object by clicking on it.
Deletes all drawn in objects.

Remove All
Tool bar

Rectangle

Circle

Enables you to add a rectangular object or cut a rectangular region
from an object.
Enables you to add a circular object or cut a circular region from an
object.
Enables you to add an object or cut a region from an object.

Contour

Enables you to add an object or cut a region from an object.

Contour (Spline)

Enables you to add an object or cut a region from an object.

Active Contour

Enables you to add a line-object.

Polyline Region

Enables you to add a point object.

Point

Region Growing section
Only visible for images with a size smaller than 10000 x 10000 pixel.

Parameter

Description

Mode

-

Click on areas in the image you want to add to the selected object
class.

-

Click on areas in the image you want to remove from the selected object class.
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Parameter

Description

Intensity

Here you can enter a tolerance value for the intensity using the slider
or input field. The tolerance value specifies how much the intensity of
a pixel may deviate from the average intensity of the object in order
to still "grow" to become part of the object.

Color

Only active if your input image is a color image.
Here you can enter a tolerance value for the color using the slider or
input field. The tolerance value specifies how much the color value of
a pixel may deviate from the average color value of the object in order to still "grow" to become part of the object.

Fill

Fills holes that are created during region growing.

Post Processing section
Only visible for images with a size smaller than 10000 x 10000 pixel.

Parameter

Description

Region Filter

Reapplies the region filter you defined in the previous step to the
post-processed image.

Parameter

Description

Undo

Undoes the last action.

Redo

Restores the last undone action.

Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

For more information, see Image Analysis [} 369].
13.3.4.2.2.6 Features
In this step you select the measurement features.
Features you have defined are available from within the Feedback Experiment. Any time you
change the image analysis settings, you need to reload the *.czias file in the feedback script editor to activate the changes. For more information, see Workflow Experiment Feedback [} 240].

Parameter

Description

Interactive

Activated: The features can be changed interactively while the measurement program is running in Analyze Interactively mode.
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Parameter

Description

Classes

Here, you can select the class for which you want to define measurement features. For each class there are two entries for which you can
define features. The first entry concerns all the objects belonging to
the class. The second entry represents an individual object. The results
is a statistical value of the measurement feature over all single objects
of that class. For example, Mean Intensity channel 1 will give you
the mean intensity of all single objects. Area will give you the sum of
all areas of the individual objects.

Region Features

-

Edit

Opens the Feature Selection view.

-

Copy to All

Copies the defined features to all other class or classes, respectively.

Display

If you activate Display in the Feature Selection window for a feature, the result of the measurement is displayed next to the corresponding object in the analyzed image.

Annotations

-

Edit

Opens the Feature Selection window.

-

Copy to All

Copies the annotations to all other classes.

Annotations

Only visible if a "child" class is active.
The list shows all annotations that are drawn in for the current class.

Annotation Options

-

Color

Allows you to select the color for the region annotations.

Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

For more information, see Image Analysis [} 369] to Image Analysis.
13.3.4.2.2.6.1 Features of individual regions
For a description of individual measurement features, see Measurement Features [} 397].

Parameter

Description

Search Features

Here you can enter parts of the name of the feature that you are
looking for. The features in which the entered character string occurs
are listed.
Select a type of feature according to which you want the features to
be filtered from the dropdown list.

-

All

All features are listed.
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Description

-

Geometric Features

All geometric features are listed.

-

Intensity Features

All features that analyze intensity values are listed.

-

Image Features

All features that contain meta information about the measured image
are listed.

-

Position Features

All features that describe the position are listed.

-

Geometric Features Unscaled

All features that describe unscaled geometric features.

-

Position Features Unscaled

All features that describe unscaled positions are listed.

-

Polygon-based
Features

All features polygon-based features are listed.

-

Statistical Features

All features that can be used for plotting in a heatmap (i.e. that provide statistical values suitable for heatmap plotting) are listed.

Parameter

Description

Selected Features

Displays all available features that can be calculated for each object
during image analysis.

-

Name

Name of the selected feature(s)

-

Display

Activated: The value of the feature for each object is displayed in the
analyzed image.

-

Copy

Only visible for Classes (collection of objects) and if more than one
class exists.
If the Copy column is empty, the selected feature is not copied to any
result table.
Copies the selected feature also in the result table of
CLASSES in the next higher hierarchy level.
Copies the selected feature also in the data table of CLASS in
the next higher hierarchy level.
Copies the selected feature also to the data table of the first
CLASSES element of the same hierarchy level.
Copies the selected feature also to the data table of the first
CLASS element of the same hierarchy level.
Copies the selected feature also in the data table of the first
CLASSES element on the next higher hierarchy level.
Copies the selected feature also in the data table of the first
CLASS element on the next higher hierarchy level.
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Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

13.3.4.2.2.6.2 Annotations

Parameter

Description

Search Features

Here you can enter parts of the name of the feature that you are
looking for. The features in which the entered character string occurs
are listed.
Select a type of feature according to which you want the features to
be filtered from the dropdown list.

-

All

All features are listed.

-

Geometric Features

All geometric features are listed.

Parameter

Description
Click on the button to select a feature for the measurement.

Add

Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

13.3.4.2.2.6.3 Features of all regions
For a description of individual measurement features, see Measurement Features [} 397].

Parameter

Description

Search Features

Here you can enter parts of the name of the feature that you are
looking for. The features in which the entered character string occurs
are listed.
Select a type of feature according to which you want the features to
be filtered from the dropdown list.

-

All

All features are listed.

-

Geometric Features

All geometric features are listed.

-

Intensity Features

All features that analyze intensity values are listed.
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Description

-

Image Features

All features that contain meta information about the measured image
are listed.

-

Position Features

All features that describe the position are listed.

-

Geometric Features Unscaled

All features that describe unscaled geometric features.

-

Statistical Features

All features that can be used for plotting in a heatmap (i.e. that provide statistical values suitable for heatmap plotting) are listed.

Parameter

Description

Selected Features

Displays all available features that can be calculated for each object
during image analysis.

-

Name

Name of the selected feature(s)

-

Display

Activated: The value of the feature for each object is displayed in the
analyzed image.

-

Copy

Only visible for Classes (collection of objects) and if more than one
class exists.
If the Copy column is empty, the selected feature is not copied to any
result table.
Copies the selected feature also in the result table of
CLASSES in the next higher hierarchy level.
Copies the selected feature also in the data table of CLASS in
the next higher hierarchy level.
Copies the selected feature also to the data table of the first
CLASSES element of the same hierarchy level.
Copies the selected feature also to the data table of the first
CLASS element of the same hierarchy level.
Copies the selected feature also in the data table of the first
CLASSES element on the next higher hierarchy level.
Copies the selected feature also in the data table of the first
CLASS element on the next higher hierarchy level.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

794

13 Software Functions & Reference | 13.3 Tools

ZEISS

Parameter

Description

Parameter

Description
Click on the button to select a feature for the measurement.

Add

Parameter

Description

Next

Moves on to the next step of the wizard.

Back

Moves back to the previous step of the wizard.

Cancel

Cancels the wizard.

13.3.4.2.2.7 Results Preview
In this step you will see the preview of the measurement result. The results table contains only the
measurements performed in the current view port. The measured image is displayed in the Analysis View [} 855].

Parameter

Description

Classes

Here you can select the class for which you want to see the measured
features. For each class there are two entries: The "parent" class,
which shows the features for all objects together, and the "child"
class, which shows the features for each individual object.

Highlight Box

-

Color

Allows you to set the color of the highlight box surrounding the selected object in the image.

-

Line Width

Allows you to set the line width of the highlight box around the selected object in the image.
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Parameter

Description

Enable chart

Activated: Displays a chart with measurement results in the Analysis
View by default.
Deactivated: Displays no chart in the Analysis View by default.

Chart Type

Sets the default chart type that will be displayed in the Analysis
View. With the two buttons, you can either select the Scatter Chart
or the Histogram Chart as default.

X-Axis

Selects the default feature that is displayed on the x-axis of the chart
in the Analysis View.
The elements displayed in the drop down menu depend on the previously defined measurement features.

Y-Axis

Only available for the scatter chart.
Selects the default feature that is displayed on the y-axis of the chart
in the Analysis View.
The elements displayed in the drop down menu depend on the previously defined measurement features.

Multiple Scenes

Only available for multi-scene images.
Activated: Sets as the default chart a histogram/ scatter chart that
contains the data points of all scenes.

Time Series

Only available for time series images.
Activated: Sets as the default a chart that displays the analysis results
of the selected class in a time series chart.

Heatmap

Only available for experiments with multi well/ multi chamber plates
(multiple scenes).
Activated: Sets as the default chart a heatmap of the well plate.

Back

Moves back to the previous step of the wizard.

Finish

Saves the created analysis setting and ends the wizard.

Cancel

Cancels the analysis setting and closes the wizard.

Table with results on the right side
The results in this table depend on the settings you made in the Feature Selection dialog. The
table contains all selected features for the highlighted class/classes.

Parameter

Description

ID of the parent

Allows to identify for this object, which subset of objects belong to
the same "parent" object.

ID

Default feature of each object. It serves as an identifier for each individual object, but also for the group of objects in the statistics-level
(Classes).

Area [µm2]

If a "child"-class is selected, Area gives the Area of each individual object. If a "parent"-class is selected, Area gives the sum of the areas of
all individual objects in the "child"-class.

For more information, see Image Analysis [} 369].
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13.3.5 Tools on Applications Tab
13.3.5.1 arivis Vision4D Tool
This tool enables you to send an image to the arivis Vision4D software and open it there with an
analysis pipeline selected in ZEN. The input image for the tool is always the currently opened image.

Parameter

Description

Options

–

Show Sample
Pipelines

Activated: Displays sample pipelines in the directory below.

–

Add Pipeline Directory

Opens a browser to select and add a folder with pipelines you created
in Vision 4D to the list of directories below.

–

Remove Pipeline Directory

Removes the selected pipeline directory in the list below.

Update Pipeline
List

Updates the pipeline directories.

–

Note: You can only remove whole directories / top level folders which
you have imported. Removing subfolders or individual pipelines from
the list is not possible!

Recently used

Displays a list of the most recently used pipelines.

Search

Searches for a pipeline using the input field.
Cancels the current pipeline search.

Cancel Search
Open and Apply

Opens Vision4D with the current image and the selected pipeline.

13.3.6 Tools in Right Tool Area
13.3.6.1 Images and Documents Tool

Parameter

Description

List of opened images and documents

Here you find a list of all images and documents which are currently
opened in the Center Screen Area. The disk symbol with a small
warning sign
means that you changed and/or have not saved the
chosen image or document.

Save

Saves the chosen file. Save as dialog will open if you have not saved
the file yet.
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Parameter

Description

Quick Export

Automatically exports the active image with the default settings of
Single File Export method to…/user/pictures (Windows default
folder for images).
Images of time series or z-stacks will be automatically exported with
the default settings of Movie Export method to…/user/movies
(Windows default folder for movies).
Closes the active image or document.

Close
Shows only the text of the file .
Text View
Shows a small preview image (thumbnail) of the file.
Thumbnail View
Shows a preview image of the file.
Big Preview
13.3.6.2 Microscope Tool

Parameter

Description

Objective List

Here you can easily switch between the objectives and pre-magnification. The color bar on the objective buttons indicates the color for the
respective stage limit indicator inside the Navigation tab.
If you select autocorr objectives (motorized correction collar) you can
additionally adjust the relevant settings like Correction Mode, Bottom Thickness or Imaging Depth.

13.3.6.3 Stage Tool

CAUTION
Risk of Crushing Fingers
The drive of a microscope stage with a motorized horizontal stage axis (stage drive) is strong
enough to crush fingers or objects between the stage and nearby objects (e.g. a wall).
4 Remove your fingers or any objects from the danger area before moving the stage drive.
4 Release the joystick immediately to stop the movement.
This tool enables you to navigate the sample in a microscope equipped with a motorized stage.
You can use the Navigation Circle (software joystick) to move the stage or enter the coordinates
directly.

Parameter

Description

Navigation Circle

Enables you to move the stage freely in the X and Y direction and in
both diagonal directions.
To move the stage, drag the Navigation Circle icon in the desired direction. If released, the icon snaps back to the Navigation Circle
center and the stage stops.
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Description
The Navigation Circle allows four speeds:
§ Normal modes:
– Inner segments: Slow
– Outer segments: Medium

§ High-speed modes:
– Inner segments: Fast
– Outer segments: Very Fast

To enter the high-speed mode, right-click the Navigation Circle icon.
The Navigation Circle turns red. To return to normal speed, rightclick the Navigation Circle icon again.
Stop

Stops any stage movement immediately.
Use this button if you entered X-Position and/or Y-Position and
wish to interrupt the stage movement immediately (e.g. to prevent a
collision).

X-Position, Y-Position

Specifies the target coordinates for the stage movement.
The stage starts moving immediately after the coordinates have been
entered and confirmed; either by pressing the Return key or by clicking anywhere outside the current input field.

Info
You can also control the Navigation Circle and thus the motorized stage with the keyboard.
To activate keyboard control left-click anywhere inside the segmented Navigation Circle. To
change between the two speed modes, right-click the centralNavigation Circle icon.
§

To move the stage at the lower speed, use the arrow keys (diagonal movements are also
possible).

§

To move the stage at the higher speed, use Shift + Arrow keys.

The following parameters are only visible if the Show All mode is activated:
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Parameter

Description

Speed

Sets the moving speed of the stage in percent (100%=maximum possible speed).
Note that the speed setting does not change the speed graduation of
the SW joystick.

Acceleration

Sets the acceleration of the stage in percent (100% = maximum acceleration value).

X/Y-Position

-

Set Zero

Sets the current position as the new zero point for the x/y coordinates.

-

Calibrate

CAUTION! Risk of Crushing Fingers. Performs an automatic stage
calibration. For this the stage moves to the limit switches to determine the zero points in the x and y direction and then returns to its
starting position, which is now defined with its absolute coordinates.

Marks section
This section shows a list where you can define X / Y positions (optional z value), so called marks.
It is also possible to import a list of positions from the list into an experiment including the 'Tiles'
tool.
13.3.6.4 Focus Tool

CAUTION
Risk of Crushing Fingers
The drive of a microscope stage with a motorized vertical axis (focus drive) is strong enough to
crush fingers or objects between the stage and the microscope stand.
4 Remove your fingers or any objects from the danger area before moving the focus drive.
4 Release the joystick immediately to stop the movement.
This tool changes the vertical distance (i.e. Z direction) between stage and objective. This enables
you to focus the sample, or, for a sample with an uneven surface, to focus the area of interest.
1

2

1

Higher objective position, higher sample features in focus

2

Lower objective position, lower sample features in focus
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Parameter

Description

Current

Displays the stage position in µm
Initially, when you use the Focus tool for the first time after switching
on the microscope, the exact position of the stage is not known.
Therefore, the position indicated by Current is initially set to zero. If
you enter a value, the stage moves by the entered amount relative to
the current position. If you want to move the focus to an absolute position, you must first click Home to move the focus to one of the end
positions. The value of Current is set to this known position. You can
then enter an absolute position.

Position control

–

Navigation Bar

Enables you to set the stage position. You can either use the Navigation Bar to move the stage up or down or you can enter the target
position in the Current input field.
Enables you to move the stage freely in Z direction
To move the stage, drag the Navigation Bar button in the desired direction. If released, the Navigation Bar button snaps back to the
center and the stage stops.
The Navigation Bar allows four speeds.
Normal modes:
§ Inner segments: Slow
§ Outer segments: Medium

High-speed modes:
§ Inner segments: Fast
§ Outer segments: Very Fast

To enter the high-speed mode, right-click the Navigation Bar button. The Navigation Bar turns red. To return to normal speed, rightclick the Navigation Bar again.

–

Current

Defines the target position of the stage in µm. The stage starts moving immediately after the coordinates have been entered and confirmed by pressing the Enter key or by clicking anywhere outside the
Current input field.

–

Stop

Stops any stage movement immediately.

Backlash Correction

Activated: Enhances the positional accuracy by performing an extra
movement. When activated the focusing takes slightly longer

Handwheel on

§ Activated: Turning the handwheel also adjusts the focus
§ Deactivated: The handwheel is deactivated: turning it does not affect the focus

Step Size

Defines the difference in µm by which the stage moves at each step.
Indirectly this defines the speed of the stage movement.
The Step Size also determines the accuracy of the focus position.
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Parameter

Description

Home

Moves the focus to one of the end positions. The value of Current is
set to this known position.
This ensures that the position shown as Current corresponds to the
actual stage position.

Work

Moves the stage back to the position it was in before using the Load
button (i.e. the work position)
If you have moved the stage (e.g. using the Navigation Bar) after
moving it into the load position, the work position is lost and the
Work button will not work.

Load

Increases the distance between objective and stage by 8,000 µm
This aids you in exchanging the sample. After exchanging the sample,
you can move the stage back into its work position by using the
Work button.
Make sure not to move the stage (e.g. using the Navigation Bar) after moving it into the load position. Otherwise, the previous position
is lost and the Work button will not work.

Measure

This function allows to measure distance in Z direction.

Z-Position

Specifies which position of the motorized z drive is used as the origin
(zero value)

–

Set Zero

Sets the current focus position as the origin (zero value)

–

Calibrate

Performs an automatic calibration

13.3.6.5 Definite Focus Tool

Parameter

Description

Status

Displays the actual status of the device, e.g. Standby or Monitoring.

Find Surface

Tries to find the surface of the cover glass and adjusts the focus position accordingly.
If the signal is not strong enough, the actual focus position remains.

Store Focus

Sets (and saves) the current focus position as the stabilizing position.
Note that if you change an objective, the saved position will be
deleted.

Recall Focus

Restores the saved focus position.

Lock Focus

If activated, Definite Focus holds the current focus distance by starting
a continuous focus stabilization.
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13.3.6.6 Incubation Tool
In the Incubation Tool you can define and control parameters for temperature, atmosphere and
the Y-Module. The available parameters depend on which components you have configured on
your system.

Info
The symbols behind measured values indicate if the measured and the set values are
§

the same = green check mark,

§

different = red or blue triangle with exclamation point, or

§

not activated = blue circle with question mark.

Parameter

Description

Temperature

Here you can control up to 4 independent heating channels that are
linked to certain devices (e.g. incubator XL, heating insert P, objective
heater etc.). The devices are assigned to different channels in the Micro Tool Box (MTB).

-

-

Heating/ Cooling

Activated: The channel will be used for the experiment.

Channel (1-4)

Activated: The channel will be used for the experiment.

Under Setpoint you can set the temperature of the channel in °C.
Under Measured you see the currently measured value.

Under Setpoint you can set the temperature of the channel in °C.
Under Measured you see the currently measured value.

-

Sensor

Atmosphere

-

O2 Channel

Shows the current temperature inside the incubation chamber.
Here you can define the O2 and CO2 concentration, as well as the
temperature for an Air Heater module. Note that the meaning of the
symbols behind the measurement values is the same like described
above.
Activated: The O2 channel will be used for the experiment.
Under Setpoint you can set the O2 concentration of the chamber in
percent (1-100%).
Under Measured you see the currently measured value.

-

CO2 Channel

Activated: The CO2 channel will be used for the experiment.
Under Setpoint you can set the CO2 concentration of the chamber in
percent (1-100%).
Under Measured you see the currently measured value.
§ Fan Speed:
Sets the rotation speed of the fan.
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-

Air Heater

ZEISS

Description
Activated: The air heater will be used for the experiment.
Under Setpoint you can set the temperature of the air heater in °C.
Under Measured you see the currently measured value.
§ Fan Speed:
Sets the rotation speed of the fan.

-

Pump Level

Y-Module

Sets the pump level.
Note: If O2 Channel or CO2 Channel is activated and the Pump
Level is set to 0, a warning is displayed to remind you to set the
pump level >0 so that the gas is actually pumped to the probe.
The Y-Module panel allows setting the temperature for two independent modules (thermostats).

-

Selected

Here you can select which module you want to control (Module 1 or
Module 2).

-

Circulator 1-2

Activated: The channel will be used for the experiment.
Under Setpoint you can set the temperature of the channel in °C.
Under Measured you see the currently measured value.
For each module two circulator channels can be activated.

13.3.6.7 Macro Tool

Parameter

Description

Record

Records a new macro. The Record button will change to a Stop button. Press this Stop button to stop the macro recording.

Run

Executes the selected macro.

Stop

Stops the running macro at the active command.

Selection

Displays a list of all existing macros.

–

Creates a new macro.
Add
Deletes the selected macro.

–
Delete

–
Options
Preview

With the options dropdown you can create, duplicate, rename, and
safe new macro files, or delete existing macros.
Here you see a preview to the macro program code of the selected
macro. Editing the macro here is not possible.

Properties

–

Name

Displays the name of the macro.

–

Keywords

Displays keywords for the selected macro. Keywords can also be entered in this text field.
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Description

–

Description

Displays the description for the selected macro. A description can also
be entered in this text field.

–

Toolbar Configuration

When you click on the button you will enter the Customize Toolbar
dialog. There you can add macro buttons or functions to the toolbar
for a quick access. How you can configure the toolbar is described under Customizing Toolbar [} 237].

Macro Editor…

Opens the Macro Editor Dialog [} 622].

See also
2 Right Tool Area [} 22]
13.3.6.8 Lasers Tool
The is equipped with a variety of diode and solid state lasers. The lasers can be controlled
(switched from Standby mode to On) vie ZEN. The tool displays only lasers which are available
with the system. (For LSM 980 only.)

2

1

3

4

Fig. 70: Lasers tool

1

Laser Lines [nm] column
Lists the available laser wavelengths. For Multiphoton Lasers the tunable range and fixed
line (if available) of the laser is displayed.

2

Power column
Contains the On/Off power control buttons one for each laser line. For Multiphoton
lasers the ON/OFF effects both, the tunable and the fixed line.

3

All Lasers Off button
With one click all still active lasers can be switched off.
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Laser Properties panel
Shows the laser properties of the selected (highlighted) laser line. The listed properties always contain the current wavelength, the status of the laser and the power.
§ The status of diode or solid state lasers changes between Connected, Warming up
and Ready.
§ The status of Multiphoton lasers changes between Connected, Warming up and
Mode locked. The laser is ready for use only when in Mode locked status.
§ The status of Multiphoton lasers also changes when the laser is tuned (Tuning), the
GDD unit is adapted (GDD Positioning) or when the laser is in CW mode (CW lasing). In any such status the laser cannot be used for imaging.
§ For Multiphoton lasers the panel contains the control for the GDD (group dispersion
delay) unit (if available).
§ In case two Multiphoton lines are available for imaging the second (typically non tunable) line with its status is displayed at the bottom of the panel.

Prerequisite ü The system components are switched on
ü ZEN is running
1. In order to use a laser for imaging, click On in the drop down list in the Power column of
the desired laser.
à A warning triangle next to the activated laser line indicates the laser is now on and emits
laser light.
Some lasers need up to 1 minute to warm up to their full power level. In this status the laser line
is marked in red in the Channels Tool and in the Timed/Interactive Bleaching Tool. Multiphoton lasers take several minutes to warm up to full power.
All lasers which are needed for an experiment (load experiment), a track configured using Smart
Setup or when an image is re-used to reproduce the imaging acquisition parameters, are
switched on automatically. A laser is also switched on when it is selected in the Channels Tool,
the Imaging Setup Tool, the Timed Bleaching Tool or the Interactive Bleaching Tool.
Option
Lasers can be set to automatically switch off after 30 minutes of inactivity. This function can be
activated/deactivated in Options | Acquisition | LSM. Changing this function requires to restart
ZEN.
GDD Control
The settings for the GDD unit are predefined when the system is set up. The unit will move to a
specific value when the laser wavelength is changed. The wavelength of the multiphoton laser
might be changed either in the Channels Tool, when loading an experiment or when re-using an
image.
The value for GDD can be adapted to the experiments needs. In order to achieve the shortest possible pulses for a given setting (wavelength and objective), move the slider to a different position
while scanning in Live or Continuous mode. When the image intensity is at its maximum, the
shortest possible pulses reach the sample for multiphoton excitation. Store the value to use it for
the next image acquisition using Snap or Start Experiment. The value for the current wavelength is displayed next to GDD.
GDD values may vary also with the objective. The pre-set values assume that a large high NA objective is used. The variations between similar types of objectives can be neglected. Hence the settings might only need small adaptions if at all for a given wavelength. The GDD value does not
change if a wavelength is chosen for which no value is stored. Restore sets all GDD values back to
the factory settings.
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13.3.6.9 Cryo Temperature Tool
In this tool you can see the temperature status of the Linkam Cryo stage. When the stage is selected in the MTB configuration and properly connected to the computer, the temperature is
logged beginning with the ZEN startup. This logging of data is asynchronous and runs as long as
ZEN is active.
Note that if the stage is physically disconnected from the computer, only the last received temperature is logged. Only after a restart of ZEN the current temperature is again logged in a new log
file.

Parameter

Description

Temperature Status

Displays the current temperatures.

–

Bridge Temperature

Displays the current bridge temperature.

–

Chamber Temperature

Displays the current chamber temperature.

–

Dewar Temperature

Displays the current dewar temperature.

Temperature Logging

–

Interval

Only visible if Show All is activated.
Sets the interval for reading the temperature data between 5 to 60
seconds.

–

Open record

Opens the record for the logged temperatures. Current opens the
current log file in ZEN as a .czt file.
Folder opens the folder where the log file is saved on your computer
(C:\Users\user\Documents\Carl Zeiss\ZEN\Documents\TemperatureLogging).

–

Logging/ Start
Logging

Shows that the temperature is logged. Click on Logging to stop logging the temperature. The button changes to Start Logging.
Click on Start Logging to continue the logging of thee temperature.

Image Temperature Data

–

Export Temperature Data

Opens the temperature data as a table in ZEN.
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13.4 Dialogs
13.4.1 Stage/Focus not calibrated Dialog
If you see this dialog, after you have started the software and the hardware was initialized, you
should consider to calibrate the stage and focus drive immediately.
The calibration is necessary, if
§

a motorized stage and/or focus drive are used, and

§

the stage and focus drive are not calibrated.

To start the calibration procedure, simply click on the Calibrate Now button.

CAUTION
Risk of Crushing Fingers !
The drive of a microscope stage with a motorized vertical axis (focus drive) is strong enough to
crush fingers or objects between the stage and the microscope stand.
4 Before starting the calibration procedure, ensure that people stand clear of the instrument
and that the full travel range is not obstructed by any objects.
If you skip the calibration, you can calibrate the stage and focus drive afterwards within the
Stage Control and Focus Control dialogs accessible via the Lightpath tool, see Stage Control
and Focus Control. Make sure that the Show All mode is activated, to see the Calibrate button
within the dialogs.
Note that for fully automated system like Axio Scan the axes are calibrated automatically. The calibration is not necessary in that case.

13.4.2 ApoTome Dialog
Parameter

Description

Recommended
Grid

In this section you can set the grid with which you want the ApoTome
to be operated.

Automatic Grid
Control

Activated by default.
Activated: The appropriate grid for the selected objective is selected
automatically (in the case of ApoTome.2).
Deactivated: It is possible to select another grid from the dropdown
list that is now active, e.g. to create a thicker optical section thickness. A list of recommended objectives and suitable wavelengths can
be found here.

Calibration Status

Here you can see whether your ApoTome has been calibrated successfully or whether calibration needs to be performed.

Theoretical Thickness

The theoretical section thickness for the selected filter set and the objective used is displayed here.
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13.4.3 ApoTome Settings Dialog
Parameter

Description

Camera

Here you can select the camera you wish to use to acquire your ApoTome images. As soon as you have selected a camera, ApoTome images are generated automatically during acquisition (Snap). The selected camera also applies to the Acquisition tab.

Live Mode

Here you can choose between the No Combination, Optical Section and Conventional Fluorescence modes for the live image.

Acquisition Mode

Here you can choose between the No Combination, Optical Section and Conventional Fluorescence modes for acquired images.

Phase Images

Here you can choose between no fewer than 3 and no more than 15
phases. Each phase corresponds to a grid position. By default, 5
phases are acquired.

Filter

Here you can set a filter which can be used to filter out residual
streaks from the image. You have a choice between no filtering (Off)
and three strength levels.

Image Normalization

Activated: The gray values are extended to the maximum available
dynamic range following the calculation, see Normalization .

13.4.4 Add Dye or Contrasting Method Dialog
Here you add dyes and contrast techniques to your experiment. The dyes in the database contain
important information that is saved in the image document (e.g. spectral characteristics). This information can be used later during image processing (e.g. deconvolution).

Info
You can add additional dyes to the database with the Dye Editor under Tools > Dye Editor....

Parameter

Description

Recently used

Displays the six recently used dyes or contrasting methods in a list.
This ensures that you have quick access to the dyes or contrasting
methods that you use frequently.

Search

Here you can enter the name or initial letters of the dye or contrasting
method that you want to search for. The search results are displayed
immediately in the Dye Database list or the Contrasting Methods
list.
If no search filter is active, the lists of dyes or contrast techniques are
arranged in alphabetical order. If you cannot find a certain dye, try using a related dye name or a general name.
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Parameter

Description

Dye Database

Choose fluorescent dyes here. Double click on the dye or click on the
Add button to add it to the experiment. The left column shows the
name of the dye.
The right column contains its color and main emission wavelength.
The "Custom" entry adds a channel to your experiment without any
additional information. This means that the resulting image cannot be
used for certain processing operations.

Contrasting Methods

Only available for WF tracks.

Add

Adds the selected dye to the experiment. You can add several dyes/
contrasting methods in a row.

Close

Closes the dialog.

Here you can choose a contrasting method. Double click on the contrasting method or click on the Add button to add it to the experiment.

13.5 Image views
The software offers a lot of different image views. The general image views are visible for each
image. The specific image views are available only if the image has the appropriate characteristics (eg multiple channels, Z-stack, etc.) or you have licensed a specific module (e.g. for 3D View).
Each image view has general and specific controls which you can use to work with the view.

13.5.1 General image views
These image views are available with any image. Depending on the type of image in question, the
general control elements may have additional or more limited functions.
13.5.1.1 2D View
This view is the default view for images in the software. For this view the General View Controls
[} 887] are available to you. To open the view's context menu [} 810], right-click in the Center
Screen Area [} 21].
13.5.1.1.1 2D View Context Menu

Menu item

Description

Short cut

Full Screen

Switches to full screen mode. To exit full-screen mode, press
F11 or ESC.

F11

Zoom Group

Here you have access to the main zoom functions (Dimensions tab > Zoom section [} 888]).

Rulers

Shows rulers at the top and left edge of the image.

Show Floating
Scale Bar

Shows a scale bar, which you can position freely in your image.

Navigator

Shows the 2D view Navigator window.
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Menu item

Description

Spot Measurement / Focus
ROI

This function is only active in the live image or during Continuous mode.

Graphics

This function is activated by default.

ZEISS

Short cut

Shows a region in which the exposure time is measured and
the software autofocus is focused.

Shows graphic elements that have been drawn into the image, e.g. annotations or scale bars.
Show Bleach
ROI

This function is only visible with FRAP images.

Grid

Adds a grid to the image.

Copy Display
Settings

Copies the display settings from an image (Display tab).

Paste Display
Settings

Inserts copied display settings into an image (Display tab).

Shows graphic elements that were used during acquisition
for bleaching (FRAP).

Paste Display
Settings and
Channel Colors
ROI (Region of
Interest) |
Draw Region
of Interest

Draw a certain rectangular region that is of particular interest
to you into the image. The ROI is displayed with red boundaries. You can draw several regions into an image.

Ctrl+ U

ROI (Region of
Interest) |
Draw Rotatable Region of
Interest

Draw a certain rectangular region that is of particular interest
to you into the image. This region can be rotated and is displayed with yellow boundaries. You can draw several regions
into an image.

Ctrl+Shift
+R

ROI (Region of
Interest) | Create Subset Images From ROI

Creates new image documents from the selection regions
you have drawn in. All dimensions of the image are taken
into account here. This function works for both the non rotatable and rotatable ROIs (the red and the yellow regions).

Ctrl+ Shift
+C

Create Image
from View

Creates an image from the current view.

Paste

Inserts a graphic element into the current image from the
clipboard.
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13.5.1.2 Gallery View
In this view you see an overview of your multidimensional images. The individual images of the
images concerned are presented in a gallery. It is possible to show any combination of dimensions, e.g. channels against time. When you view images for the first time in the Gallery view,
they are displayed as follows:

Image type

Display

Multichannel image

All the channels present in an image are shown,
including the mixed color image.

Time lapse image

All the time points present in an image are
shown.

Z-stack image

All Z-planes are shown.

Multichannel & time lapse image

All the time points present in an image are
shown. All channels are shown as a mixed color
image.

Multichannel & Z-stack image

All Z-planes are shown. All channels are shown
as a mixed color image.

Time lapse & Z-stack image

All Z-planes are shown.

Time lapse, Z-stack & multichannel image

All Z-planes are shown. All channels are shown
as a mixed color image.

See also
2 General View Options [} 887]
13.5.1.2.1 Gallery Tools Tab
Here you can specify which dimension you want to be displayed on which axis of the Gallery
view. To do this, click on the corresponding dimension´s button.
Displayed Dimensions section
Each of the buttons is only visible if the current image contains the corresponding dimension.

Button

Function

Channels

Shows the channels present as individual images.

Z-Stack

Shows the Z-Planes present as individual images.

Time Series

Shows the time points present as individual images.

Chann.& Z (Channels
and Z-Stack)

Shows the channels present in relation to the Z-stack images
present.

Chann.& Time (Channels and Time Series)

Shows the channels present in relation to the time lapse images
present.

Z&Time (Z-Stack and
Time Series)

Shows the Z-Stack images present in relation to the time lapse
images present.
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Options section

Checkbox

Function

Show Dimension Labels

Inserts annotations into each individual image that provide information on the time point or Z-plane.

Invert X/Y axis

This checkbox is only available if the Show All mode is deactivated. It is active only if two dimensions are shown in relation to
each other (Chann.&Z, Chann.&Time, Z&Time). If activated, this
function inverts the X and Y axis of the view.

Show Graphics

Shows graphics / annotations within the images (in case if graphics / annotations are drawn in).

Show Merged

Only visible for multichannel images. Only active if the channels
present are shown. Shows the pseudo colored (mixed) images of
all channels in addition to the individual images.

Advanced Functions
The following functions are only visible if the Show All mode is activated:
X Axis / Y Axis settings
From the first 2 dropdown list you can select which dimension (depending on which dimensions
are available in the active image, e.g. channels, z-stack, etc.) will be shown on the X or Y axis (X
axis = horizontal direction, Y axis = vertical direction).
In the second dropdown lists you can select wether you want to display all images of each dimension or if you want to display a certain range of images on the X or Y axis. Therefore you find the
following options :

Option

Description

All

Displays all images of the active image in the Gallery view.

Subset by Step

If selected, you can enter a step size in the Step input field. If 2
steps are entered, only every second image will be shown. In the
Max. input field you can enter the desired number of images
which will be shown. The step size will be calculated automatically.

Subset by Range

If selected, you can adjust a range of images (e.g. from image
4-10) which is displayed in the view. Use the slider or the input
fields to enter the desired range.

Image Creation
Here you can directly create images out of the Gallery view. Select the type of image that you
want to create from the Create image from dropdown list. If you click on the Create button the
image will be generated and opened in a new image document. The resulting image contains all
the information of the input image; the pixel data are not changed. Following options are available:
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Option

Function

Gallery View

Creates an image of the current Gallery view. If this option is selected, the option Gallery Image from is available. Here you can
additionally select a dimension that is not currently displayed
(e.g. Single Image will export each single image additionally). The
resulting image is always a 24 bit RGB color image. The pixel
data of the original image are changed. If the Burn in graphics
checkbox is activated, all graphics or annotations will be burned
into the output images.

Selection Subset

Creates an image from the images that have been selected in the
current view. To select an image simply click on the image in the
Gallery view. Hold Crtl-Key while clicking to select more images
at once.

Range Subset

Creates an image from the defined selection range. If this entry is
selected, sliders for the selected dimensions appear (Start, End
and Interval). Use the sliders to set the selection range you
want.

13.5.1.2.2 Gallery Appearance Tab
Only visible if the Show All mode is activated.

Parameter

Description

Dimension Labels

Here you can define the font and the style, color, position and size of
the text for the dimension details that are shown.

Layout

Here you can set the background color of the Gallery view and the
distance between the individual images (from 1-10 pixels).

13.5.1.3 2.5D View
In the 2.5D view intensity values in a two-dimensional image are converted into a height map.
Here the highest intensity values are represented by the greatest extension in the Z-direction.
Overall this results in a so-called 2.5D or pseudo-3D image.

Info
If you are viewing a multichannel image, you can have the intensity values of the individual
channels displayed. To do this, activate or deactivate the desired channels on the Dimensions
tab.

13.5.1.3.1 2.5D View Tool bars
The tool bars are arranged to the left of and underneath the image area. You can use the tools to
control the display of the 2.5D volumes in the image area.
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Left Tool Bar

Icon

Parameter

Description

Top thumb
wheel

Enlarges or reduces the image area.

Rotate

Use this to rotate the 2.5D volume in any way you wish
within the space. This is the default mode when you switch
to 2.5D view for the first time.

Zoom

Use this to increase the zoom factor of the image area.

Bottom thumb
wheel

Rotates the 2.5D volume around the horizontal (X) axis.

Bottom Tool Bar

Icon

Parameter

Description

Left thumb
wheel

Use this to rotate the 2.5D volume around the vertical (Y)
axis.

Bounding Box

Use this to show or hide a bounding box around the 2.5D
volume.

Show X/Y Axis

Use this to show or hide the X/Y axis.

Show Z Axis

Use this to show or hide the Z axis.

Start View

Use this to switch back to the start view. A top view of the
2.5D volume is displayed. Lateral movements and the zoom
factor are adjusted so that the 2.5D volume can be seen at
the center of the image area.

Right thumb
wheel

Use this to compress the 2.5D volume on the (Z) axis perpendicular to the screen plane.

-
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13.5.1.3.2 2.5D Display Tab
On the 2.5D Display tab you have 4 Render mode options for displaying your 2.5D image.

Parameter

Description

Render mode

-

Profiles

Displays the relief divided into a number of profiles with an equal distance.
Set the number of profiles using the Grid distance slider.

-

Grid

Displays the relief overlaid with a grid. This view supports gray levels
only.
Make the grid more closely or more coarsely meshed using the Grid
distance slider.

-

Filled

Displays the height relief by upwardly discrete, layered pillars.

-

Surface

Displays the relief as a continuous, flowing landscape.
Make the surface coarser or finer using the Grid distance slider.

Invert Z axis

Use this function for images that contain many large, bright regions.
Activated: Displays the lowest intensity values by means of the greatest extension in the Z direction.

Use palette

Activated: Overlays the relief with the pseudo colors that have been
set on the Dimensions tab.

Show Faces at
Side

Only available in the Surface render mode.

Show plane

Activated: Shows two blue, transparent planes in the 2.5D volume.

Activated: Closes the sides of the relief.

Set the position of the planes using the X/Y sliders.
Extract image

To save an individual image in the current view, click on the Save As
button.

13.5.1.3.3 Series Tab
On the Series tab in the 2.5D view you can create a series of images in the 2.5D view. These series can be played back later as a video clip, for example.

Parameter

Description

Render Series

Here you can select the desired series mode:

-

Turn Around X

Here you can define the start/stop angle and the rotation direction
around the X axis.

-

Turn Around Y

Only visible in the 3D view.
Here you can define the start/stop angle and the rotation direction
around the Y axis.

-

Turn Around Z

Here you can define the start/stop angle and the rotation direction
around the Z axis.
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Description

-

Start/Stop

Here you can define the angle and zoom settings for the start and
end position of your series. The intermediate positions are interpolated evenly.

-

Position List

Here you can define any number of positions. The positions can each
have completely different rotation, zoom and illumination settings.

-

Over Time

Only visible in the 2.5D view.
Here you can define the start time point and end time point for a series. All other settings (rotation, zoom, etc.) remain unchanged.

Stored
Opens the Options shortcut menu.
Options
Apply
Preview

Creates a series image with the current settings.
To obtain a preview of the series, click on
preview, click on

No. of Frames

Play. To end the

Stop.

Here you can enter or select the number of individual images in the
series.

13.5.1.3.4 2.5D Display Options Tab
Only visible if the Show All mode is activated.

Parameter

Description

Angle X

Enter the rotation angle in the X direction with a precision of 1 degree using the slider or input field.

Angle Y

Enter the rotation angle in the Y direction with a precision of 1 degree
using the slider or input field.

Z Scaling

Enter the Z scaling using the slider or input field.

Ambient

Reduces or increases the intensity of the ambient lighting in the 2.5D
view.

Reflection

Reduces or increases the proportion of the ambient light reflected on
the relief.

Shine

Reduces or increases the effect of the ambient light shining on the relief.

Light height

Reduces or increases the intensity of the lighting in the 2.5D view. A
small distance means a circular light source at the center, while a
large distance illuminates the scene evenly.

Reset lights

Resets all settings to the default values.
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13.5.1.4 Profile View
In the Profile view you can create intensity profiles in your image. The view is divided into 4
quadrants: Profile window (top left), Image window (top right), Profile table (bottom left),
and Interactive Measurements table (bottom right).

Info
To create an intensity profile of a certain region, select a tool on the Profile Definition tab.
Use this to draw a line across a structure of interest in the image. An intensity profile of the
drawn line is generated automatically and displayed in the Profile window. To zoom into an
aspect of the Profile window, drag out a rectangular frame using the left mouse button in the
Profile window. The selected region is displayed in enlarged form. Right-click to return to the
original view.

See also
2 General View Options [} 887]
13.5.1.4.1 Profile Definition Tab
Tool bar
Using the tools you can add one of four different profile tools(Arrow, Polygon, Freehand, or
Rectangle) to your image. The intensity profile of each tool is shown in the Profile window.

Parameter

Description

Select

Changes the mouse pointer to Selection mode. You can use this to select graphic elements in the image.

Clone

Use this to copy the last selected element and insert it at another position in the image.

Arrow

Use this to insert an arrow into the image. The gray levels for each
pixel along the line are shown in the Profile window in the direction
of the arrow.

Polygon

Use this to insert a polygonal measurement line in the original image.

Freehand

Use this to insert a measurement line with a shape of your choice.

Rectangle

Use this to insert a rectangular measurement region. For this tool, the
average gray values across the width of the rectangle are shown in
the Profile window and the Profile table.

Keep Tool

Activated: Keeps the last selected tool active.

Auto Color

Only visible if the Show All mode is activated.
Activated: Highlights each drawn-in measurement line with a random color.

Stroke Thickness

Here you can enter the line width of the measurement line. For line
widths larger than one pixel, the average gray values across the line
width are shown in the Profile window and Profile table.
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Parameter

Description

Show profile in
graphics

Activated:Adds the profile curves to the profile tool drawn into the
image.
This function is only available for the Arrow tool.

Profile Measurements section

Parameter

Description

Normal

Switches the mouse behavior for interacting with the Profile window to the standard behavior.

Measurement

Use this to perform a point measurement in the Profile window. To
copy the measured value into the interactive measurement table, click
on the Add to table button.

Caliper X

Use this to perform a number of measurements along a certain distance along the X axis of the profile. To adopt the value into the measurement data table, click on the Add to table button.

Caliper Y

Use this to perform a number of measurements along a certain distance along the Y axis of the profile. To copy the value into the interactive measurement table, click on the Add to table button.

Reset Table

Deletes all values from the interactive measurement data table.

Add to table

Adds the current measurement values of tools used in the Profile window to the interactive measurements table.

Grid Distance section

Parameter

Description

Grid Distance

Adjusts the value with the slider or input field. It defines how the
measurement is done:
For a grid size of 1, each pixel covered by the profile tool is measured.
For a grid size of 2, the average of 2 pixels is measured. For a grid
sized of 3, the average of 3 pixels is measured etc. This is useful when
measuring line profiles in very large tile images e.g. from Axioscan.

13.5.1.4.2 Profile View Tab
Here you can configure the display for the Profile view.
Show section

Parameter

Description

Profile Table

Activated: Shows the profile table.

Int. Measurement

Shows the interactive measurement table.

Values

Currently without function.

Image

Only visible if the Show All mode is activated.
Activated: Shows the Image window.
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Channel section
Here you can activate or deactivate the profiles for each color channel for an RGB image. Gray:
shows the average intensity value for all three color channels. This function is only available for
RGB color images.
X/Y Axis section
Only visible if the Show All mode is activated.
Here you can determine the limits for the X axis and Y axis.

Parameter

Description

Auto

Sets the limits for the axes automatically based on the available pixel
values in the image..

Norm

Normalizes the profile display to the maximum values of the distribution.

Fixed

Enter the min/max values for the profile display in the Min/Max input
fields manually.

Log X Scale

Switches the X-axis to logarithmic value distribution.

Log Y Scale

Switches the Y-axis to logarithmic value distribution.

Data Table section
Click on the Create button to create a data table of the Profile measurement table. If an interactive measurement value table contains any values, it is also created as separate data table. To save
the table as comma separated values file (csv), click on the Save As button.
New Image from section
Here you can create an image document of the profile view. Select the desired image configuration from the dropdown list. To save the image, click on the Save As button.
13.5.1.5 Histo View
The Histo (Histogram) view shows you the gray value histogram of your image. In the right image
area you can see your current image and in the left image area you can see the Histogram window. At the side you will also find four data tables:
§

In the first table from the left you will find all the raw data for each channel.

§

In the second table from the left you will find all the limits for each channel of the image next
to the image name.

§

In the third table from the left you will find the statistical values for the gray value distribution, e.g. average, standard deviation, minimum and maximum value.

§

The fourth table shows the values of measurements in the histogram. The results (Integral)
show the percentaged fractions of the occurences.

See also
2 General View Options [} 887]
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13.5.1.5.1 Histo Definition Tab
Tools
With these tools you can add specific ranges to your image. The histogram window displays the
gray value histogram for each area.

Parameter

Select
Clone

Description
Changes the mouse pointer to Selection mode. You can use this to select graphic elements in the image.
Use this to copy the last selected element and insert it at another position in the image.
Use this to insert a rectangular measurement region.

Draw Rectangle
Use this to insert a circular measurement region.
Draw Circle

Draw Spline Contour

Draw Polygon

Use this to insert a measurement region with a shape of your choice.
The line is closed automatically.

Use this to insert a polygonal measurement region in the original image.

Keep Tool

Activated: Keeps the last selected tool active.

Auto color

Only visible if the Show All mode is activated.
Activated: Highlights each drawn-in measurement region with a random color.

Normal

Switches the Profile window back to the view display.

CaliperX

Use this to perform a measurement of a region in X direction in the
histogram display. To adopt the value into the measurement data table, click on the Add to Table button.

Add to Table

Only active if a measurement (using CaliperX mode) was drawn into
the histogram.
Adds the current measurement into a measurement data table below
the original image.

Reset Table

Deletes the measurement data table below the original image.

Histo Table section
The following parameters are only visible if the Show All mode is activated:

Parameter

Description

Histo Table

Select the type of gray value distribution from the dropdown list. The
following types are available:

-

Frequency

If selected, the histogram is displayed according to the relative frequency of the gray values in percent.
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Parameter
-

SumUp

-

SumDown
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Description

Relative Frequency

Parameter

Description

Bin count

Enter the Bin count using the slider.

Bin size

Only visible if the Show All mode is activated.
Enter the Bin size using the slider.

Logarithmic binning

Only visible if the Show All mode is activated.

Lower Threshold

Enter the lower threshold value for the gray value distribution using
the slider or spin box/input field. All regions in the image with gray
values below the lower threshold value are overlaid in blue and all
those with gray values above the upper threshold value are overlaid in
red.

Skip Black

Activated: Automatically subtracts the lowest value of the gray distribution. If activated, the settings for the lower threshold value are deactivated.

Upper Threshold

Enter the upper threshold value for the gray value distribution using
the slider or spin box/input field. All regions in the image with gray
values below the lower threshold value are overlaid in blue and all
those with gray values above the upper threshold value are overlaid in
red.

Skip White

Activated: Automatically subtracts the highest value of the gray distribution. The settings for the upper threshold value are deactivated.

Show thresholds

Only visible if the Show All mode is activated.

Activated: Switches from the linear to a logarithmic class width. The
class size is calculated automatically.

Activated: Shows the threshold values as colored overlays in the
original image.
13.5.1.5.2 Histo View Tab
Here you can configure the display for the Histo view.
Show section

Parameter

Description

Statistic table

Activated: Shows the table containing the statistical values in the image area.

Int. Measurement

Activated: Shows the measurement data table below the original image.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

822

13 Software Functions & Reference | 13.5 Image views

Parameter

Description

Frequency Table

Only visible if the Show All mode is activated.
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Activated: Shows the table containing the raw data for each channel.
Image

Only visible if the Show All mode is activated.
Activated: Shows the original image in the image area.

Channel section
Here you can activate or deactivate the histograms for each channel.
X/Y Axis section
Only visible if the Show All mode is activated.
Here you can determine the limits for the X axis and Y axis.

Parameter

Description

Auto

Sets the limits for the axes automatically.

Norm

Normalizes the histogram display to the maximum values of the distribution.

Fixed

Enter the min/max values for the histogram display in the Min/Max
input fields.

Logarithmic
Channel Transparency section

Parameter

Description

Channel Transparency
Data Table section
Click on the Create button to create a data table from all the measured values displayed. To save
the table, click on the Save As button.
New Image From section
Here you can create a new image document. Select the type of image from the dropdown list. To
save the image, click on the Save As button.
13.5.1.6 Measure View
In this view measured values from images are displayed in a table. The table is only visible if there
are annotations/measured values in the image. To highlight the row of the table containing the
measured values of a graphic element, click on a graphic element in the image. To highlight a
graphic element in the image, click on the measured value in the row of the table.
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13.5.1.6.1 Measurement Tab
Here you can specify how to draw the graphic elements for measurements into an image and
how the measurement data are displayed. You can also add user-specific features to individual
graphic elements.
Graphic Elements Section
Only visible if the current image is a multidimensional image.
Here you can decide, whether to draw a graphic element "globally" into all channels, Z-positions,
time points, etc., or whether to draw in separate elements for the view currently displayed.

Parameter

Description

Channel

Activated: Activates the Single Channel mode. Only draws graphic elements into the channel currently displayed.

Time

Activated: Only draws graphic elements into the time point currently
displayed.

Z-Position

Activated: Only draws graphic elements into the Z-position currently
displayed.

Copy in All Following

Activated: Draws a new graphic element into the view currently displayed and into all subsequent time points or Z-positions.

New Feature section
Here you can add a defined feature to the selected graphic element.

Parameter

Description

Name

Here you can enter a name for the feature.

Value

Here you can enter the desired value for the current graphic element.

Unit

Here you can enter the desired unit for the feature.

Add

Adds the feature. The measurement data table is expanded to include
this feature.

Remove

Removes the selected feature.

Data Display section
Here you can specify how you want the measured values for the drawn-in graphic elements to be
displayed.

Parameter

Description

Format

-

Table

Displays the measured values in a row of a table. As you can specify
the features individually for each graphic element, the number of columns containing measured values may differ from graphic element to
graphic element (i.e. from row to row).
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Parameter
-

List

ZEISS

Description
Displays each measured value in a separate row. The measurement
data table then has the following defined columns:
§ Name: Name of the graphic element (e.g. line).
§ Feature: Name of the feature (e.g. distance).
§ Value: Value of the feature.
§ Unit: Unit of the feature (e.g. µm).

Current View

Only displays the measured values of the current view.

All Views

Displays all measured values contained in the image.

Create Document

Creates a measurement data table from the measured values displayed. The table is saved as a separate document.

Export Temperature Data

Only visible for cryo images with temperature data.
Opens the temperature data as a table in ZEN.

13.5.1.7 Info View
The Info View allows you to display extensive information about your image. Using the
buttons in each of the sections you can show additional fields in the sections or hide fields that
are currently showing. To show or hide individual sections, click on the
the headings for each of the sections.

button to the left of

Info
The Info View only shows the fields that actually contain data. Using the
buttons in
each of the sections you can show additional fields. To do this, activate the corresponding
checkboxes in the shortcut menu.

13.5.1.7.1 General section

Parameter

Description

Title

Here you can enter a title for your image.

Description

Here you can enter a description for your image.

Comment

Here you can enter a comment.

Keywords

Here you can enter keywords for your image.

Rating

Here you can enter a rating for your image. To enter a rating, click on
the star icons.

13.5.1.7.2 File information section

Parameter

Description

Name

Displays the file name of the image without file extension.
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Parameter

Description

File Type

Displays the file type of the image.

File Path

Displays the location where the image is saved in your file system.

File Size

Displays the file size of the image.

Created

Displays when the image was created.

Last Modified

Displays when the image was last changed.

User

Displays the name of the user. You can enter the user name in the Extras menu | Options | User [} 640].

Compression
Method

Displays the compression method.

Compression Quality

Displays the compression quality.

13.5.1.7.3 Image Dimensions section

Parameter

Description

Time Series

Displays how many time points the image contains. The value in
brackets shows the full duration of acquisition.

Z-Stack

Displays how many Z-planes the image contains. The value in brackets
shows the full size of the Z-stack.

Channels

Displays how many channels the image contains.

Tiles

Displays how many individual images (tiles) the image is composed of.

Scaling (per Pixel)

Displays the scaling per pixel.
Edit button:
Opens the Edit Scaling dialog [} 827].

Image Size (Pixels)

Displays the image size in pixels. The first number indicates the horizontal dimension and the second the vertical dimension.

Image Size (Scaled)

Displays the scaled image size. The first number indicates the horizontal dimension and the second the vertical dimension.

Bit Depth

Displays the bit depth of the active image, e.g. 24 Bit. The bit depth
depends on the camera settings when acquiring the image.

Stage Position

Displays the stage position. Within the image this is the center point.
In the case of tile images this is the center point of the first tile.

Scanning Mode

Displays the scanning mode. This can either be the image field, an image line or a pixel.

Scanner Zoom

Displays the zoom factor. The value 1 corresponds to the standardized
image field of all confocal systems.

Rotation

Displays the rotation of the image field around the optical axis.

Crop Offset

Displays the shift of the scanned region from the center of the image.
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Parameter

Description

Pixel Time

Displays for how long the emission signal is collected per pixel. This is
the so-called integration time.

Line Time

Displays how long the system needs to scan an image line.

Frame Time

Displays how long the system needs to scan the image field displayed
in X and Y in full.

Averaging

Displays the number of individual measurements per image or line.
The average of the individual measurements produces the pixel intensity values for the image.

13.5.1.7.3.1 Edit Scaling Dialog
The Edit Scaling dialog is divided up into table form. The columns contain the Scaling Factor
and Scaling Unit and the rows the dimensions.

Parameter

Description

Scale Factor column

Enter the desired scaling factor in the input fields.

Scale Unit column

Select the desired scaling unit from the dropdown list. The metric
units Meter, Centimeter, Millimeter, Micrometer, Nanometer and Picometers are available as options, as well as the imperial units Inch and Mil.

Row X

Shows the scaling in the horizontal direction.

Row Y

Shows the scaling in the vertical direction.

Row Z

Shows the scaling in the 3rd dimension. This is usually the focus
direction.

Info
Row Z for the third dimension is only displayed if the image has a third dimension.

13.5.1.7.4 Acquisition Information section

Parameter

Description

Acquisition Start

Displays the date and time when the acquisition of the image
took place.

Microscope

Displays which microscope was used to acquire the image.

Objective

Displays which objective was used to acquire the image.

Optovar

Displays which Optovar was used to acquire the image.

Zoom
Total Magnification (Eyepiece)
Filters
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Parameter

Description

Beam Splitter

Displays which beam splitter was used to acquire the channel.

Lasers
Calibration Marker Positions
Aperture size
Magnification
Accelerating Voltage
Working Distance
Scan Speed
Probe Current
Specimen Current
Brightness
Contrast
Noise reduction
Tracks
Reflector

Displays which reflector cube was used to acquire the image.

Beam Splitter
Filter Ex. Wavelength
Filter Em. Wavelength
Contrast Method

Displays the contrast technique. In transmitted light this is the
condenser setting, while in reflected light it corresponds to the
selected reflector cube.

Ligth Source
Ligth Source Intensity

Displays the lamp intensity with which the image was acquired.

Illumination Wavelength
Pinhole

Displays the diameter of the pinhole.

Laser Wavelength
Laser Blanking

Blanking of the laser during scanner movement without acquisition.

Stokes Vector
Laser Attenuator State
Scan Mode
Rotation
Crop offset
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Description

Pixel Time
Line Time
Frame Time
LSM Scan Speed
Scan Direction
Line Step
Averaging
Averaging Mode
Averaging Method
VivaTome Grid
VivaTome Reflector
VivaTome Beam Splitter
VivaTome Filter Ex. Wavelength
VivaTome Filter Em.
Wavelength
Channels
Channel Name

Displays the name of the channel.

Channel Description

Here you can enter a description of the channel. Describe the exact use of the channel or what can be seen in this channel.

Dye Name

Displays the name of the dye.

Channel Color

Displays the pseudo color allocated to the channel.

Emission Wavelength

Displays the main emission wavelength of the channel or dye
used.

Excitation Wavelength

Displays the main excitation wavelength of the channel or dye
used.

Effective NA
Detection Wavelength
Imaging Device
Camera Adapter

Displays which camera adapter was used to acquire the image.

EM Gain

Displays the factor by which the camera signal was increased.

Exposure Time

Displays the exposure time with which the image was acquired.

Depth of Focus

Displays the depth of focus. This is calculated according to the
following formula: Depth of field = (2 * n * λ) / (NA)² = (2 * refractive index * emission wavelength) / (numerical aperture)²
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Parameter

Description

Section Thickness

Displays the thickness of the optical section.

Binning Mode

Displays whether binning was applied during acquisition and
how much.

Detector Type

Displays which detector was used for acquisition.

Detector Gain

Displays the gain setting of the detector for acquisition.

Detector Digital Gain

Displays the digital gain of the detector during acquisition.

Detector Offset

Displays the offset settings of the detector during acquisition.

HDR Processing
Airyscan Mode

Info
In the case of multichannel images the channel-dependent information is saved in a table. Here
the sorting of the individual information fields may differ.

13.5.1.7.5 Direct Processing section
This section is only visible if your image was processed with Direct Processing.

Parameter

Description

Processing Function

Displays the name of the function which was used for Direct Processing.

Completed

Displays the date and time when the processing was finished.

Duration

Displays the duration of the processing.

13.5.1.7.6 Deconvolution Information section
This section is only visible if the image was processed with Deconvolution. The displayed parameters depend on which algorithm was used.

Parameter

Description

Algorithm

Displays which algorithm was used for processing.

Elapsed Time

Displays how long the processing took.

Aberration Correction

Displays what/if aberration correction was used for processing.

GPU Acceleration

Displays what/if GPU acceleration was used for processing.

Optimization

Displays the optimization which was used for processing.

Quality Threshold

Displays the quality threshold which was used for processing.

Normalization

Displays the normalization method which was used for processing.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

830

13 Software Functions & Reference | 13.5 Image views

ZEISS

Parameter

Description

Strength

Displays the normalization strength which was used for processing.

Stack Correction

Displays what/if stack correction was used for processing.

Regularization

Displays the regularization which was used for processing.

Likelihood

Displays the likelihood calculation which was used for processing.

PSF

Displays the PSF which was used for processing.

-> Clipboard

Saves the parameters to the clipboard. For reuse of parameters for
new processing, see also Step 4: Info View and re-using Deconvolution parameters from a processed image [} 98].

Convergence History

Displays the convergence history graph.

13.5.1.8 Tree View
The Tree View is visible only if you have activated the Enable Tree view checkbox under Tools |
Options | Documents. The checkbox is deactivated by default.
The tree view shows a detailed list containing all meta data of the selected image.

13.5.2 Specific image views
These image views are only visible if the image has corresponding features. The 3D view, for example, is only visible for Z-stack images.
13.5.2.1 Split View
Only visible for multichannel images and not during the acquisition of LSM images.
In this view you see all channels of a multichannel image. The channels are displayed side by side,
in the channel colors that have been assigned to them. You also see the mixed image view in
which all the channels are overlaid.

Info
By double-clicking on an acquired multi-channel image, you can switch quickly to the 2D view.
Double-clicking on the image in the 2D view switches you back to the Split view. If you double-click on one of the displayed channels, only this channel will be shown in 2D View.

See also
2 2D View [} 810]
2 General View Options [} 887]
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13.5.2.2 Ortho View
Only visible for Z-stack images.
In this view (orthogonal section) you can analyze your Z-stack images. Here, in addition to the top
view (X/Y axis), you will also see the section views of the X/Z axes (top) and Y/Z axes (right).

See also
2 General View Options [} 887]
13.5.2.2.1 Ortho view for Airyscan images
Airyscan multiplex images can be directly viewed during acquisition in 3D ortho view.
Select the Ortho view tab to switch to this display mode.

In Ortho Display, you can adjust the areas which are sectioned for the 3D view.

Ortho Display can be combined with Airyscan SR preview processing.
To activate the preview, click on the SR button in the Airyscan tab.
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Ortho Display also allows to display a Maximum Intensity Projection (MIP) in all 3 directions.
Activate the Maximum Intensity Projection (MIP) checkbox to activate this view. It is recommended that only fully acquired stacks are viewed with this function.

The result is a brighter XY image, and a very bright XZ and YZ view. This is because very many
slices are projected here. It might also occur that the XZ and YZ view show stripes. This is due to
the preview processing and often disappears once the full datastack was processed and saved.
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13.5.2.2.2 Ortho Display Tab

Parameter

Description

Cut Lines

Sets the positions (pixel values) for the section lines using the X/Y/Z
sliders or input fields.
Alternatively you can also adjust the positions directly in the image
area. To adjust the positions, move the mouse over a section line in
the image. Hold down the left mouse button and move the mouse.

-

Mid

Positions the relevant slider at the center of the view.

Line Width

Only visible if the Show All mode is activated.
Enter the thickness of the section lines in pixels using the sliders or input fields. This results in a maximum intensity projection being displayed over the selected pixel width.

Cut Line Opacity

Only visible if the Show All mode is activated.
Here you can enter the degree of opacity of the section lines from 0%
(invisible) to 100% (completely opaque).

Maximum Intensity Projection
(MIP)

Activated: Displays a maximum intensity projection (MIP) across all
planes for all 3 views. The section lines are hidden and the control elements that are not relevant in this view are deactivated.

Measure 3D Distance

Only visible if the Show All mode is activated.
Activated: Activates the 3D distance measurement. The Set Start
and Set End buttons and the Distance display field are visible.
To set a starting point for the measurement, navigate the cutlines to
the desired starting point and click on the Set Start button. The Set
End button will become active. To set an end point for the measurement, navigate the cutlines to the desired end point and click on the
Set End button. The pixel coordinates of the measurement points are
displayed next to the buttons. The measured distance is displayed in
the Distance display field.

New Image

Creates a new image document. Select the desired view from the
dropdown list (only in Show All mode). To save the image, click on
the Create button.
The resulting image contains the image data in the same dynamics
(bit depth) as the original image and consists of the same number of
channels (in the case of multichannel images) or time points (in the
case of time lapse images) as the original image, but only contains the
Z-plane currently displayed.

13.5.2.3 3D View
This view is only available if:
§

you have licensed the 3Dxl module.

§

you have loaded or acquired a z-stack image.

§

a suitable NVIDIA or ATI graphics card with full OpenGL 3.3 or higher functionality is present.

3D View employs 3D rendering technology which requires access to advanced Open GL functionality. For full functionality this means, that a modern dedicated graphic card (NVIDIA or AMD-ATI
technology) has to be present. The lower grade graphics functionality provided with some Intel
GPUs frequently found on laptops, does not support all of the required Open GL calls. This means,
that with Intel GPUs, only reduced functionality is available:
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§

only maximum projection rendering (MIP).

§

Series tab is missing.

§

only reduced functionality of the Appearance tab.

§

No fonts can be displayed in the render window.

§

the Measure button opens the measurements table but does not show any measurements.

The 3D view displays z-stack images three-dimensionally as a 3D volume. Using the toolbars on
the left, right and bottom of the image area you can directly control and move the 3D volume.
With the view specific tabs below the image area you find a lot of parameters to adjust the appearance and further settings of the 3D volume.

1

2

Fig. 71: 3D View
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Tool bars
see Tool bars [} 836]

2

View Specific Tabs
see 3D Tab [} 840],
Appearance Tab [} 841],
Clipping Tab [} 843],
Series Tab [} 845],
Measurements Tab [} 848],
3D Graphics Tab [} 849]

ZEISS

13.5.2.3.1 Tool bars
The tool bars are arranged to the left and right of the image area and underneath it. You can use
the tools to control and adjust the display of the 3D volumes in the image area. The tool bars are
visible in ZEN's standard 3D view as well as the ZEN Connect 3D view. For the view in ZEN Connect not all of the options are available.
13.5.2.3.1.1 Tool Bar (Left)
This tool bar is visible in the ZEN standard 3D view and the ZEN Connect 3D view. Not all the options are available for each view.

Parameter

Description
Zooms in or out of the 3D image.

Top thumb wheel

Arrow

Use this to select end points of measurement tools that have been
drawn into the 3d image (Measure tab). You can then edit the position of the end points.
In the ZEN Connect 3D view, this control allows you to transform the
adjustable volume.
Use this to rotate the 3D image in any way you wish within the space.
This is the default mode when you switch to 3D view for the first
time.

Rotate
Use this to increase or reduce the zoom factor of the image area.
Zoom

Move

Use this to move the 3D image.
In the ZEN Connect 3D view, this control allows you to shift the zstack in the z-plane.
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Description
Clicking on this button enables the flight mode. This mode allows to
virtually fly through the 3D image. Use the keys from the list below to
control your flight.

Fly
Rotates the 3d image around the horizontal (X) axis.

Bottom thumb
wheel
Flight Mode Key Layout / Controls

Key

Function

W

Forward

S

Backward

A

Left

D

Right

Space

Up

C

Down

E

Rotate (clockwise)

Q

Rotate (counter-clockwise)

X

Precision Mode, enables slower movement

13.5.2.3.1.2 Tool Bar (Right)
This tool bar is visible in ZEN's standard 3D view as well as the ZEN Connect 3D view. For the view
in ZEN Connect not all of the options are available.

Parameter

Description
Hides the X/Y clipping plane.

Toggle X/Y clipping plane (blue)
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Description
Hides the X/Z clipping plane.

Toggle X/Z clipping plane (green)
Hides the Y/Z clipping plane.
Toggle Y/Z clipping plane (red)
Creates a 2D image of the current view. The image is a 24 bit color
image. All annotations are burnt in automatically.
Snap
Adds the current view to a position list as a new position.
Add

With the help of position lists you can have your view calculated as a
series of individual images. This series can then be exported as a
movie, for example.
Only active if a position list containing at least two saved positions exists.

Play

Plays back a preview of the series that is calculated. To stop the preview, click on the button again.

13.5.2.3.1.3 Tool Bar (Bottom)
This tool bar is visible in the ZEN standard 3D view and the ZEN Connect 3D view. Not all the options are available for each view.

Control element

Description
Rotates the 3D volume around the vertical (Y) axis.

Left thumb wheel
Switches back to the start view from any view.
Home view button

A top view of the 3D volume is displayed. Lateral movements and the
zoom factor are adjusted so that the 3D volume can be seen at the
center of the image area.
Shows or hides drawn-in measurements.

Show measurements button

If measurements are drawn-in, a table of the measurements appears
at the right side of the image area.
Shows or hides a bounding box around the 3D volume.

Show bounding
box button
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Description
Shows or hides the coordinate axes.

Show coordinate
axes in color button

§ X axis = red
§ Y axis = green
§ Z axis = blue
Shows or hides the scaling on each axis.

Show scaling button

Spin Mode button

Enables the spin mode. This allows to set the 3D volume in continuous motion. You will find a short description on how to use the spin
mode below.
Only active, if arivis Vision 4D is installed and licensed on the system.

Send to Vision 4D

Apply

Starts Vision 4D and imports the image. The image will be displayed
with almost identical rendering settings as in ZEN's 3D View.
Note: Not all render methods will produce absolutely identical settings between the two applications. This is due to additional functionalities available for Vision 4D.
Only available in Zen Connect 3D view.
Applies the changes made in the 3D view to the ZEN Connect project.

Reset

Only available in Zen Connect 3D view.
Restores the settings defined in the ZEN Connect project.
Rotates the 3D volume around the (Z) axis perpendicular to the screen
plane.

Right thumb wheel
13.5.2.3.1.4 Animating the 3D Volume
Prerequisite ü The Rotation mode in the left tool bar is selected.

1. Click on the Spin mode icon.

2. Move the mouse inside the image area.
3. Hold down the left mouse button and move the mouse slightly to the left or right.
4. Release the left mouse button again.
The 3D volume rotates continuously in the direction in which you moved the mouse. If you move
the mouse quickly, the 3D volume rotates quickly. If you move the mouse slowly, the 3D volume
rotates slowly.
To stop the animation, left-click again in the image area.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

839

13 Software Functions & Reference | 13.5 Image views

ZEISS

13.5.2.3.2 3D Tab
Here you can specify which projection/rendering mode you want to use to display the 3D volume.
There are 5 view modes available. To activate the desired view mode, click on the corresponding
button. An activated button (respectively the mode) appears in blue color.
Note: This tab is visible in the ZEN standard 3D view and the ZEN Connect 3D view. Not all the
options are available for each view.

Fig. 72: Mode Buttons

Parameter

Description

Transparency

Activates the Transparency rendering mode.

Volume

Activates the Volume mode.

Maximum

Activates the Maximum intensity projection mode.

Surface

Activates the Surface reconstruction mode

Mixed

Activates a combination of transparency rendering and surface reconstruction mode

Precise/Fast

Adjust the level of detail of the 3d volume here.
§ If you select the Precise setting, all the information present in the
image is used to achieve the best possible display. The calculation
time can increase accordingly.
§ If you select the Fast setting, the image data are significantly reduced before the calculation. The calculation is fast, but only a very
coarse 3D display of the volume is achieved.

Update on completed frame

Only available, if Follow Acquisition on the Dimensions tab is activated.
Activated: During acquisition, the 3D View is only updated after the
acquisition of a stack has been completed.
Deactivated: While the acquisition of a stack is still ongoing, the 3D
View is continuously updated. However, with very fast acquisition this
update can not be guaranteed.

Depth coding

Only active if Transparency, Maximum or Mixed mode is activated.
Activated: Replaces the channel colors of the volume with a rainbow
color table where the color represents the depth of the stack. A palette is shown which matches the colors to a given depth (in scaled
units).

Toggle Clipping
Planes

By activating or deactivating the buttons you can show or hide the
corresponding clipping planes in the 3D volume.
If you right-click on an activated button, a shortcut menu opens. Here
you can select whether you want the back (Clip Back), front (Clip
Front) or both sides of the 3D volume to be clipped. You can also
specify the Style of the clipping plane. Under each button is a slider.
You can use this to move the relevant clipping plane within the volume.
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Parameter

Description

Wedge

Activated: Activates two texture planes. Only the sector between the
planes is cut out. You can select which planes you want to be used
for the wedge function from the dropdown list. The selection is also
visible in the relevant buttons.

Stored

Here you can select saved 3D settings.
Opens the options menu.

Options

–

New

Creates a new settings file that is given a name automatically and has
the file extension *.cz3dr. The settings file can be found in the user
path under \My Documents\Carl Zeiss\ZEN\Documents\3Dxl render
settings.

–

Delete

Deletes the selected settings file from the hard drive.

–

Rename

Renames the selected settings file. Enter a new name in the input field
and confirm with OK.

–

Save As

Saves the selected settings file under a different name.

–

Import

Imports a *.cz3dr file and applies it to the current image.

–

Export

Exports a *.cz3dr file to a different location.

Create Image

Creates a new image from the current view. This image is a 24 bit
RGB color image. All graphic elements, such as annotations, are burnt
in. In the dropdown left of the button you can select the resolution
for the image that is created.

13.5.2.3.3 Appearance Tab
Here you can define the appearance of the 3D volume. On the tabs available on this tab, select
the setting that you want to change (e.g. Transparency). Depending on which mode you have activated on 3D tab, different tabs and parameters are available.
Note: This tab is visible in the ZEN standard 3D view and the ZEN Connect 3D view. Not all the
options are available for each view.
13.5.2.3.3.1 Transparency Tab

Parameter

Description
Here you can select the channel of a multichannel image for which
you want to set the transparency.

Channel selection
Threshold

Sets the lower threshold value in percent of the gray levels displayed.
With this setting you specify the gray value range for the relevant
channel that you want to be included in the rendered image.

Ramp

Sets the extent of the transition from completely transparent to completely opaque (0-100 percent).

Maximum

Sets the level of opacity (0-100 percent).
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Parameter

Description

Histogram

Displays the settings that you enter using the sliders schematically.
The X axis represents the gray level values and the Y axis the opacity.
You can also change the position of the curve using the mouse.

Reset

Resets all parameters to the original values.

13.5.2.3.3.2 Surface Tab
Only visible if Surface or Mixed view mode is activated on the 3D tab.

Parameter

Description
Here you can select the channel of a multichannel image for which
you want to adjust the surface settings.

Channel selection
Threshold

Sets the lower threshold value in percent of the gray levels displayed.
With this setting you specify the gray value range for the relevant
channel that you want to be included in the rendered image.

Ambient Light

Sets the ambient light on a scale from 0 to 100%.

Spectacular Light

Sets the spectacular light from 0 to 100%. This value influences the
differences between bright and dark structures.

Shininess

Sets the surface shininess.

Reset

Resets all parameters to the original values.

13.5.2.3.3.3 Channels Tab
Only visible if Mixed view mode is activated on the 3D tab.
Here you can specify how Transparency and Surface settings are mixed. In the case of multichannel images you can also configure these settings differently for each channel.
Activate the corresponding checkboxes for Transparency and Surface in the list.
13.5.2.3.3.4 Background Tab

Parameter

Description

Background Color

Sets the background color for the 3D view. To do this, click on the
color field and select the desired color.

Reset

Resets the background color.

13.5.2.3.3.5 Light Tab

Parameter

Description

Brightness

Sets the brightness of the light source (from 0 - 100 %).
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Parameter

Description

Azimuth

Here you can enter the angle of the light source above the virtual
horizon.

Elongation

Here you can enter the light source's horizontal angle of incidence.

Light source

As an alternative to the slider or input field, you can set the Azimuth
and Elongation together by using the mouse to move the point
within the light source display.

Reset

Resets all parameters to the original values.

13.5.2.3.3.6 Projection Tab

Parameter

Description

View angle

Sets the projection angle at which you want to view the scene freely
between 0° and 80°. The effect of this on the perspective display is as
if you are viewing the 3D image through a telephoto or wide-angle
lens.

Scale Z

Here you can set the scaling of the volume in the Z direction (value
range 10% - 600%).

Stereo anaglyph

Activated: Displays the 3D volume as anaglyphs. You can choose between a
§ Red/Green display, or a
§ Red/Cyan display.

Camera separation

Sets the distance between the two virtual cameras (0-20%).

Parallax shift

Sets the degree of movement that is necessary to bring the two camera images back into line (-100 to +100%).

Reset

Resets all parameters to the original values.

13.5.2.3.4 Clipping Tab
Only visible if the Show All mode is activated.
Here you can edit clipping planes. To select a clipping plane, click on the corresponding button.
The editing functions which you can use to modify the selected clipping plane become visible
when you activate the specific clipping plane.

Info
On the Clipping tab you can edit the clipping planes. On the 3D tab you can activate or deactivate the relevant clipping planes in the 3D volume.

Parameter

Description

Show All Clipping
Planes

Activated: Automatically inserts all 3 clipping planes into the 3D
volume. Additionally the editing functions for each clipping plane
were activated automatically.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

843

13 Software Functions & Reference | 13.5 Image views

Parameter

ZEISS

Description
Activates the editing functions for the X/Y clipping plane.

X/Y
Activates the editing functions for the X/Z clipping plane.

X/Z
Activates the editing functions for the Y/Z clipping plane.

Y/Z
Activate

Activated: Activates the selected clipping plane in the 3D volume. The corresponding settings become visible. You will find a
detailed description of the settings in the list below.
Note: Each plane is positioned at the center of the 3D volume
and aligned orthogonally (in the X/Y, X/Z, Y/Z direction).

Reset All

Resets all parameters to the original values.

The following parameters are only visible if the Activate checkbox is activated and a clipping
plane has been selected.

Parameter

Description

Clipping Plane Style

Change the display of the selected clipping plane using the dropdown list to the right of the Activate checkbox. The following
settings are available:

-

Invisible

The plane is invisible.

-

Colored

The plane is displayed in color. The frame color is used with 50%
transparency here.

-

Binary

The data above the threshold value that are touched by the clipping plane are displayed in binary form as a white area. Black
pixels are non-transparent.

-

Transparent

The data that are touched by the clipping plane are displayed as
they are in Transparent view mode, but in 2 dimensions. The
ramp for the transparency is linear here. Black pixels are transparent.

-

Textured opaque

The display appears as it does with the Textured setting. Black
pixels do not let any light through, however, meaning that the
render data behind them are not displayed.

Outline

Activated: Displays the frame of the selected clipping plane. Enter the frame color via the color field.

Clip Front

Activated: Clips the front of the 3D volume.

Clip Back

Activated: Clips the back of the 3D volume.
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Parameter

Description

Clip Transparency

Only active if Mixed view mode is activated.
Activated: In addition to the surface data, also clips the transparency data.

Clip Surface Channels

Only visible if Surface or Mixed view mode is activated.
Here you can enter which channel you want to be clipped using
the channel buttons.

Position

Here you can enter the position of the selected clipping plane.

<X
(X Angle)

Here you can enter the X angle for the selected clipping plane.

<Y
(Y Angle)

Here you can enter the Y angle for the selected clipping plane.

Reset Orientation

Resets the selected clipping plane to the original position.

13.5.2.3.5 Series Tab
Here you can create render series of individual views, which you can later view and export as a
movie. The tab contains different control elements depending on the Render Series type. The following parameters are the same for all render series types: Render Series section, Stored section, Apply button and Fixed Resolution checkbox.
Note: This tab is available in the ZEN 3D view as well as in the ZEN Connect 3D view. Not all the
options and settings are available in the ZEN Connect 3D view!

Parameter

Description

Render Series

Here you can select the desired series mode. Depending on the chosen render series type, different parameters are displayed.

-

Turn Around X

Define the start/stop angle and the rotation direction around the X
axis.

-

Turn Around Y

Only visible in the 3D view.
Define the start/stop angle and the rotation direction around the Y
axis.

-

Turn Around Z

Define the start/stop angle and the rotation direction around the Z
axis.

-

Start/Stop

Define the angle and zoom settings for the start and end position of
your series. The intermediate positions are interpolated evenly.

-

Position list

Define any number of positions. The positions can each have completely different rotation, zoom and illumination settings.

-

Over Time

Only visible in the 2.5D view.
Define the start time point and end time point for a series. All other
settings (rotation, zoom, etc.) remain unchanged.

Apply

If clicking on this button the series will be calculated. A new image
document will be opened in the Center Screen Area. You can view
the series by clicking on the Play button in the Dimensions tab.
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Parameter

Description

Stored

Only visible if Show All is activated.
Here you manage your series settings. Via the dropdown list you can
select a saved settings file.

Options

-

New

Clicking on the button opens a shortcut menu with the following options:
Creates a new settings file (*.czsht).
This file can be found in the user's local document path (e.g. \My Documents\Carl Zeiss\ZEN\Documents, in a corresponding subfolder).

-

Delete

Deletes the selected settings file.

-

Rename

Opens a dialog to rename the selected settings file.

-

Save As

Saves a copy of the currently selected settings file under a different
name.

-

Save

Saves changes to a currently selected settings file.

-

Import

Imports a settings files from the hard disk.

-

Export

Exports a settings files to the hard disk.

Preview

Shows a preview of the series to be created. Use the

Play /

Stop button to start or stop the preview.
Frames

Sets the number of individual frames that the series consist of after
the calculation. The more individual images that you specify here, the
more fluidly the scene transitions will be displayed later. Select predefined values from the dropdown list (e.g. 20 or 100 frames).

Fixed Resolution

Only visible if Show All is activated.
As a rule, the image series is calculated using the current screen resolution. If you want to set a different format for the series, activate the
checkbox.
In the input fields that are now visible you can enter the width and
height in pixels with which you want the series to be created.

The following parameters are only available if you have selected Turn Around X / Y / Z under
Render Series:

Info
§

The X rotation, Y rotation and Z render series types all have the same control elements and
differ only in the axis around which the rotation is calculated.

§

The preview function is not available for these types of series.
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Parameter

Description

360° Panorama

Select 360° panorama, if you want to generate a complete rotation
series.

Partial Panorama

If you select partial panorama, you can specify the starting angle and
stopping angle that you want to use for the series. To do this, enter
the desired values in the input fields or adjust it in the graphical representation of the rotation circle at the right of the input fields.

-

Start Angle

Determines the starting angle.

-

Stop Angle

Determines the stop angle.

-

Direction

Determines the direction of rotation.
When you are configuring a partial panorama, the desired angles can
also be determined easily using the circular control element:

-

Grab the white start/stop points with the mouse and position these
accordingly on the circle. The number of individual images is also displayed here.
Angle Definition
The following parameters are only available if you have selected Start/Stop under Render Series:

Parameter

Description

Start Position

You can position the volume in the image area as required using the
mouse. The geometric parameters are displayed in the input fields.
You can also determine the Camera Position and the Look At parameters for X, Y or Z and the angle directly using the input fields or
the slider. All changes are displayed immediately in the image area.

Stop Position

You can position the volume in the image area as required using the
mouse. The geometric parameters are displayed in the input fields.
You can also determine the Camera Position and the Look At parameters for X, Y or Z and the angle directly using the input fields or
the slider. All changes are displayed immediately in the image area.

The following parameters are only available if you have selected Position list under Render Series:

Parameter

Description

Add

Adds the current position to the position list.

Insert

Inserts a new position between two existing positions.
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Parameter

Description

Position list

Each position is displayed in the list with its X, Y, Z angle and zoom
level.

Using the control elements at the bottom of the list you can change
the order of the positions (Arrow buttons), cut positions (Scissors
icon) or copy and paste them again at another position (Copy / Paste
icons).
If you want to delete all positions, click on the Clear List button.
Further Parameters

You can determine which of the following parameters you want to be
taken into consideration when the series is calculated.
To do this, activate the corresponding checkbox:

-

Light

Includes illumination parameters.

-

Transparency

Includes transparency settings (not active in Surface mode).

-

Background

Includes color and distance of the background.

-

Time

Includes time series parameters (only active for time series images).

-

Camera

Includes camera settings, e.g. viewing angle (from the 3D / virtual
camera).

-

Planes

Includes planes settings (not active in Shadow mode).

-

Surface

Includes surface settings (only active in Surface and Mixed mode).

13.5.2.3.6 Measurements Tab
Only visible if the Show All mode is activated.
Here you can perform interactive measurements in the 3D volume. Note that measurements are
not possible in Shadow projection mode. The measurements can be drawn in directly in the 3D
volume using different tools. The measurement results are displayed in a list at the right of the image area.

Parameter

Description

Tool bar
Using the tools you can perform interactive measurements in the 3D
volume. The following tools are available:

-

Select

Changes the mouse pointer to Selection mode. Use this to select measurements in the 3D volume in order to change them.
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-

Line

Use this to measure the length of a line in µm. Click once on the starting point and hold down the mouse button. Then drag the mouse to
the end point and release the mouse button again. The measurement
is complete. The result of the measurement is displayed in the list to
the right of the image area.

-

Angle

Use this to measure the angle between two connected legs. First define the starting point. Then use the mouse to drag the first leg to the
desired first end point. Define the second leg by clicking on the second end point. The angle measurement ends with a display of the angle measured (in degrees). The result of the measurement is displayed
in the list to the right of the image area.

-

Polygon Curve

Use this to measure along a line with any number of segments. Click
from corner point to corner point. Complete the measurement by
right-clicking. The result of the measurement is displayed in the list to
the right of the image area.

-

Color selection

Here you can select a color for the tool you want to draw in. Simply
click on the colored rectangle and choose a color from the list.

-

Keep Tool

Activated: Keeps the selected tool active.

-

Auto Color

Activated: Automatically changes the color of the drawn-in tool.

Parameter

Description

Show Measurements

Activated: Shows the measurements in the 3D volume or in the list
of measured values at the right of the image area.

-

On top

Activated: All drawn-in measurement tools appear in the foreground,
even if these are in fact obscured by image structures.

Display Values

-

on the objects

Activated: Displays the measured values in the 3D volume.

-

as list

Activated: Displays the measured values in the measurement data table.

Delete Selected

Only active if a measurement tool has been selected in the 3D volume.
Deletes selected measurement tools from the 3D volume.

Delete All

Deletes all measurement tools from the 3D volume.

13.5.2.3.7 3D Graphics Tab
Only visible if the Show All mode is activated.

Parameter

Description

Tool bar
Using the tools you can perform interactive measurements in the 3D
volume. The following tools are available:
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Description

-

Select

Changes the mouse pointer to Selection mode. Use this to select measurements in the 3D volume in order to change them.

-

Line

Use this to measure the length of a line in µm. Click once on the starting point and hold down the mouse button. Then drag the mouse to
the end point and release the mouse button again. The measurement
is complete. The result of the measurement is displayed in the list to
the right of the image area.

-

Angle

Use this to measure the angle between two connected legs. First define the starting point. Then use the mouse to drag the first leg to the
desired first end point. Define the second leg by clicking on the second end point. The angle measurement ends with a display of the angle measured (in degrees). The result of the measurement is displayed
in the list to the right of the image area.

-

Polygon Curve

Use this to measure along a line with any number of segments. Click
from corner point to corner point. Complete the measurement by
right-clicking. The result of the measurement is displayed in the list to
the right of the image area.

-

Color selection

Here you can select a color for the tool you want to draw in. Simply
click on the colored rectangle and choose a color from the list.

-

Keep Tool

Activated: Keeps the selected tool active.

-

Auto Color

Activated: Automatically changes the color of the drawn-in tool.

Parameter

Description

3D Measurements

All measurement contained in the 3D volume are displayed here. The
list contains the following columns:

-

Eye icon

Here you can select whether or not a measurement tool is displayed
in the image. If you click in the title field of the column, the setting is
made simultaneously for all entries.

-

Lock icon

Not activated for the 3d view.

-

Type

Displays the type of a tool. If you click on the icon, you can change
the color of the tool.

-

ID

Displays the unique identification number of the measurement tool.

-

A

No function

-

M

Activated: Displays the measurement data in the image. If you click
in the title field of the column, the setting is made simultaneously for
all entries.

-

Name

Displays the name of the tool. To change the name, double-click on
the entry. Then enter a new name. Confirm the entry with the Enter
key.
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13.5.2.4 Tomo3D View
The Tomo3D view combines a 3D viewer with up to three orthogonal 2D views.
The Tomo3D is only available if:
§

you have the 3Dxl Plus license.

§

you have loaded or acquired a z-stack.

1

2

3

4

5

1

Left Toolbar
Toolbar to manipulate the image display. For more information, see Left Toolbar (Tomo3D) [} 852].

2

Image View
Area where you interact with the image views and set the cut lines with the mouse. You
can display up to four different views, including a 3D and different 2D views. The number of image views can be set in the Ortho Display tab, the type can be set by the dropdown in the top left corner of each view.

3

Snap button
Creates a 2D image of the current view. All annotations are burned in automatically.

4

Bottom Toolbar
Toolbar to manipulate the image display. For more information, see Bottom Toolbar (Tomo3D) [} 852].

5

View Options
Area for general view options, like the Dimensions Tab [} 887], and the specific view options.
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13.5.2.4.1 Left Toolbar (Tomo3D)

Parameter

Description
Zooms in or out of the image.

Top thumb wheel
Use this to rotate the 3D image in any way you wish within the space.

Rotate
Use this to increase or reduce the zoom factor of the image area.
Zoom
Use this to move the 3D image.
Move
Rotates the 3D image around the horizontal (X) axis.

Bottom thumb
wheel
13.5.2.4.2 Bottom Toolbar (Tomo3D)

Control element

Description
Rotates the 3D volume around the vertical (Y) axis.

Left thumb wheel
Switches back to the start view from any view.
Home view button

A top view of the 3D volume is displayed. Lateral movements and the
zoom factor are adjusted so that the 3D volume can be seen at the
center of the image area.
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Description
Shows or hides a bounding box around the 3D volume.

Show bounding
box button

Draw cutlines

Activated: Displays the cutlines in the 3D viewer.
Deactivated: The cutlines are not displayed in the 3D viewer.
Rotates the 3D volume around the (Z) axis perpendicular to the screen
plane.

Right thumb wheel
13.5.2.4.3 Ortho Display Tab (Tomo3D)

Parameter

Description

Cut Lines

Sets the positions (pixel values) for the section lines using the X/Y/Z
sliders or input fields.
Alternatively you can also adjust the positions directly in the image
area. To adjust the positions, move the mouse over a section line in
the image. Hold down the left mouse button and move the mouse.

-

Mid

Positions the relevant slider at the center of the view.

Line Width

Only visible if the Show All mode is activated.
Enter the thickness of the section lines in pixels using the sliders or input fields. This results in a maximum intensity projection being displayed over the selected pixel width.
You can also adjust the width directly in the image area. To adjust the
width, move the mouse over a section line in the image until a small
arrow is displayed. Hold down the left mouse button and move the
mouse.

Cut Line Opacity

Only visible if the Show All mode is activated.
Here you can enter the degree of opacity of the section lines from 0%
(invisible) to 100% (completely opaque).

Views

Only visible if the Show All mode is activated.
Sets the number and allocation of views in the Image View.

-

Displays four views.

-

Displays one view.

-

Displays two vertically separated views.

-

Displays two horizontally separated views.

-

Displays three vertically separated views.

-

Displays three horizontally separated views.
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13.5.2.4.4 Appearance Tab (Tomo3D)
Here you can define the appearance of the 3D volume. On the tabs available on this tab, select
the setting that you want to change (e.g. Transparency).
13.5.2.4.4.1 Transparency Tab

Parameter

Description
Here you can select the channel of a multichannel image for which
you want to set the transparency.

Channel selection
Threshold

Sets the lower threshold value in percent of the gray levels displayed.
With this setting you specify the gray value range for the relevant
channel that you want to be included in the rendered image.

Ramp

Sets the extent of the transition from completely transparent to completely opaque (0-100 percent).

Maximum

Sets the level of opacity (0-100 percent).

Histogram

Displays the settings that you enter using the sliders schematically.
The X axis represents the gray level values and the Y axis the opacity.
You can also change the position of the curve using the mouse.

Reset

Resets all parameters to the original values.

13.5.2.4.4.2 Background Tab

Parameter

Description

Background Color

Sets the background color for the 3D view. To do this, click on the
color field and select the desired color.

Reset

Resets the background color.

13.5.2.4.4.3 Light Tab

Parameter

Description

Brightness

Sets the brightness of the light source.

Reset

Resets the brightness.

13.5.2.4.5 3D Tab (Tomo3D)
Here you can specify which projection/rendering mode you want to use to display the 3D volume.
There are three view modes available. To activate the desired view mode, click on the corresponding button.

Parameter

Description

Transparency

Activates the Transparency rendering mode.
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Parameter

Description

Volume

Activates the Volume mode.

Maximum

Activates the Maximum intensity projection mode.

ZEISS

13.5.2.5 Analysis View
Only visible if an image analysis has been performed.
The Analysis view displays the following:
§

the image from the analysis

§

the table containing the analysis results

§

a scatter chart or histogram

Info
§

To highlight the row of the table containing the measured values of an object, click on a
segmented object in the image or in the chart. To highlight multiple rows, press Ctrl and
click on multiple object/ data points.

§

To highlight the corresponding segmented object in the image, click on a row in the table
or on the data point in the chart. To highlight multiple objects, press Ctrl and click on multiple rows/ data points.

§

To highlight the measured value of an object in the scatter chart or in the histogram, click
on one or more rows in the table. The corresponding data point in the chart turns red. To
change the chart type, on the Custom Chart tab, click on the corresponding Chart Type
button. To highlight multiple objects, press Ctrl and click on multiple rows/ objects.

You can also move your stage in the Analysis view if you click on the Stage button in the Dimensions tab and then on a position in the image. The stage is displayed as a red crosshair. This
allows you to move your stage to particular points of interest which your analysis detected but
would have been very hard to identify in the original image in the 2D view.

CAUTION
Risk of Crushing Fingers
The drive of a microscope stage with a motorized horizontal stage axis (stage drive) is strong
enough to crush fingers or objects between the stage and nearby objects (e.g. a wall).
4 Remove your fingers or any objects from the danger area before moving the stage drive.
4 Release the joystick immediately to stop the movement.

See also
2 Charts and Tables of the Analysis View [} 393]
2 Custom Chart tab [} 857]
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13.5.2.5.1 Analysis Tab
On the Analysis tab you can define how the measured objects are displayed in an image.

Parameter

Description

Show Objects

Activated: Displays the measured objects in the graphics plane.

Fill

Activated: Displays the objects in filled form.
Deactivated: Displays only the contours of the objects.

Opacity

Here you can set the opacity with which the measured objects are displayed in the graphics plane.

Delete Measurement Data

Deletes all objects and measurement data from the image.

Show All Classes

Activated: Displays the objects of all classes.
Deactivated: Displays the objects of the selected class.

Create Table(s)

Creates data tables

-

<Classname>

Create data table for selected class.

-

All classes (separately)

Create individual data tables for all classes.

-

All class/classes
(concatenated)

Create concatenated data tables for all class/classes.

Classes

In the Classes section you can select the class whose measurement
features you want to be displayed in the measurement data table. For
each class there are two entries: the first entry concerns all the objects
belonging to the class (field features) and the second represents an
individual object (object features).

13.5.2.5.2 Chart Export Tab
Here you can export the currently displayed custom chart as an image (with the file format PNG,
TIF, BMP, or JPG).

Parameter

Description

Screen Resolution
(96ppi)

Exports the chart with a resolution suitable for screens.

Printing Resolution
(300ppi)

Exports the chart with a resolution suitable for printing.

–

Width (inch)

Adjusts and displays the width.

–

Height (inch)

Adjusts and displays the height.

–

Maintain aspect
ratio

Activated: If height or width is changed, the other parameter is
changed automatically to maintain the aspect ratio.
Deactivated: Height and/or width can be changed without an automatic adjustment of the other parameter. The aspect ratio is not
maintained.
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Parameter

Description

Transparent Background

Activated: The chart is exported with a transparent background. Possible file formats for this kind of export are PNG and TIF.

Export

Opens a dialog to select the folder and path for export.

Export Data

Available for histogram charts and the heatmap.
Exports the data of the histogram or the heatmap as a *.csv file.

13.5.2.5.3 Sample Carrier Tab
On this tab you select the data which is shown in the multiple scenes chart of the Analysis view.
Filled wells which contain objects (images) are displayed in yellow color, unfilled/ empty wells are
transparent.

See also
2 Selecting data for the multiple scenes chart [} 396]
13.5.2.5.4 Table Export Tab
This tab allows you to export the currently opened table. The table is exported in csv format.

Parameter

Description

Export Table

Opens a explorer to select the location for export.

13.5.2.5.5 Custom Chart tab
You can display a histogram or visualize the relationship between two quantitative variables by
scatter chart and adapt the zoom factor to optimize the display. Draw a rectangle into the histogram / scatter chart to zoom in. Double click into the histogram / scatter chart to zoom out.

Parameter

Description

Enable chart

Activated: Displays the chart in the Analysis View.
Deactivated: Displays no chart in the Analysis View. Deactivates all
controls described below to edit the chart.

Chart Type

–

Scatter Chart

Displays a 2D scatter chart in the Analysis View.

–

Histogram
Chart

Displays a histogram in the Analysis View.

X-Axis

Selects the feature that is displayed on the x-axis of the chart.
The elements displayed in the drop down menu depend on the previously defined measurement features in the image analysis setting.

Y-Axis

Only available for the scatter chart.
Selects the feature that is displayed on the y-axis of the chart. The elements displayed in the drop down menu depend on the previously defined measurement features in the image analysis setting.
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Parameter

Description

Histogram Bin
Count

Only available for the histogram chart.

Adapt Zoom Factor

Activated: Automatically zooms the chart when selecting items from
the data table or the image.

Multiple Scenes

Only available for multi-scene images.

Creates the amount of bins to be displayed.

Activated: Displays a histogram/ scatter chart that contains the data
points from all scenes.
Deselect to go back to single-scene results.
Time Series

Only available for time series images.
Activated: Displays the analysis results of the selected class in a time
series chart.

Heatmap

Only available for experiments with multi well/ multi chamber plates.
Activated: Displays a heatmap of the well plate.

See also
2 Analysis View [} 855]
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13.5.2.6 Mean ROI View
In the Mean ROI view you can draw ROIs and measure their intensity profile after acquiring time
series experiments. The intensity profiles are displayed as charts and can be exported to data tables.

Info
§

The Physiology (Dynamics) module activates additional features to those of Mean ROI
for the offline analysis of physiology experiments, e.g. the Time Line View panel, Ratio
functions and ROI tracing.

§

In this view the Image area is always to the left, charting area always to the right. Depending on which Region layout you have selected in Layout tab, the Mean ROI view can have
a different appearance.

1

2

3

4

5

1

Image area
Here you see the images for each channel of the time series and the ratio image (if the
ratio calculation is enabled). The display of images can be adapted in the Layout tab.
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Charting Area
Here you see the charts for the values of all channels selected in the Layout tab as well
as for the ratio calculation (if it is enabled on the Ratio tab). If a ROI is selected in the image area on the left, the corresponding plot line is highlighted (the plot line is thicker) in
the charts.
Playhead (blue line)
Indicates the current frame of the time series visible in the image panel(s). The position of
the playhead is synchronized with the displayed image frame number and vice versa.
Press and hold the left mouse and drag the playhead in the desired direction. The current
time point of the visible frame is displayed to right of the playhead line in the same time
unit as the x-axis of the chart.

3

Table
This table displays the values for all channels and regions at the different time points, as
well as the temperature, focus (if present in the image metadata) and information about
markers. If you deactivate a channel in the Visible Charts section of the Layout tab, the
corresponding columns are hidden in the table.
This table is synchronized with the image view and the charts. If you select a field in the
table, the corresponding ROI is selected in the image view and the charts (playheads) are
updated accordingly.

4

Time Line View
This view is only available with the Physiology (Dynamics) module and if it is activated
in the Layout tab. The chart supports similar functions as the other charts in MeanROI.
Here you can limit the time range with the zoom functionality. The actions in this chart
are synchronized with the others in the MeanROI view. For more information, see Time
Line View panel [} 861].

5

View Options
Here you have your standard view options as well as specific options for MeanROI, for
example for the Layout or the calculation of the Ratio.

Info
Hover over the plot with the mouse (crosshair). A tool tip appears with details of the intensity
value at this position, ROI ID #, Channel, and time point (in currently set time unit of x-axis).
Note these values (intensity and time) are interpolated. You can visualize the time points alone
a plot by activation of the Show Tick marks function on the Chart tab.

See also
2 General View Options [} 887]
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13.5.2.6.1 Time Line View panel
Only visible if you have licensed the Physiology (Dynamics) module.
This chart supports similar functions as detailed for charts in Mean ROI.
1

2

3

4

5

Fig. 73: Time Line View Panel

1

Intensity data traces from measurement ROIs.

2

Zoom control
The transparent area (blue) is the user definable zoom range. The zoom range translates
into the display range of the x-axis of the other charts displayed above the time line view.
To edit the zoom range hover use the controls at either end. Click and hold the left
mouse to drag and resize the zoom area.

3

The center line (blue line) displays the playhead.

4

Markers with corresponding color code.

5

Chart data/intensity parameter selection check boxes
Depending on the available metadata different check boxes are available on the left side.
Only two parameters can be displayed at a given time. The combination can be chosen
as required.
When intensity parameters are displayed on the right side, it is possible to further select
which of the available channels and/ or ratio should be displayed. Channel intensity and
ratio intensity can be displayed in a mutually exclusive manner.

13.5.2.6.2 Mean ROI Tab

Parameter

Description

Background Correction

If you have activated the Live Ratio Generation in the Online Ratio
tab, or the Ratio Calculation in the Ratio tab, the background correction is disabled here and only visible in the Online Ratio/ Ratio
tab. Also note that the correction for ROI is only available if there are
at least two ROI defined in the image!
The following modes are available:

-

None

No background correction is performed.

-

Constant

Allows a user defined numeric value to be entered for both channels
in the spin box.

-

ROI

Allows to select the background ROI, the determined value will be
channel specific.
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Description

Layout and Charts
Default Settings

-

Define Default

Defines the current layout and chart setup as the default. The layout
and charts can be changed in the Layout tab.

-

Apply Default

Displays the default setup for layout and charts.

Restart Measurements

Only visible if the measurements calculation was canceled.
Restarts the measurements calculation.

13.5.2.6.3 Layout Tab

Parameter

Description

MeanROI View
Layouts

Adjusts how the images, charts, and the table will be displayed.

-

Image and
Chart

Selects one of three different layouts of how an image together with
a chart will be displayed. If you click on one of the buttons the layout
will be changed.

-

Image and
Chart with Table

Selects one of three different layouts of how an image and a chart together with a table will be displayed. If you click on one of the buttons the layout will be changed.

Visible Views

-

Single Channel
View

Visible Charts

-

Single Channel
View

Selects the channels for which the image should be displayed in the
image area.
Activated: Only one channel can be selected whose image is displayed.
Deactivated: You can manually switch on/off channels whose images
should (not) be displayed.
Selects the channels for which the charts and table columns should be
displayed in the chart area and the table.
Activated: Only one channel can be selected whose chart and information is displayed.
Deactivated: You can manually switch on/off channels whose charts
and information should (not) be displayed.

Synchronize Charts
and Channels

Activated: Synchronizes the chart and channel settings.

Show Markers/
Switches

Activated: The temporal position of any switches and markers are always displayed on the charts both during acquisition or post-acquisition.

Show Time Line
View

Only visible if you have licensed the Physiology (Dynamics) module.
Activated: The Time Line View panel is displayed below the other image chart panels of the Center Screen Area. The Time Line View
panel is designed to provide an overview of the experiment whilst allowing the user to examine the detail displayed in the other chart
panels by means of an integrated zoom tool. The Time Line View can
be hidden by unselecting the check box as required both during or after an experiment.
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Parameter

Description

Show View Captions

Activated: Displays the channel name clearly with the image of each
channel in the multichannel view layout.
Deactivated: Hides the channel name of each image in the image
view.

13.5.2.6.4 Charts Tab

Parameter

Description

All Chart Settings
(X- / Y-Axis)

Note that a function is active when the button is highlighted in blue.
The settings for X- and Y-Axis (only if Show All is activated) are the
same, see description below. The Y- axis settings are always applied
to the selected chart. The currently selected chart name (channel) is
displayed above the Y-axis settings.

-

Auto

The scaling of the respective axis is automatic, allowing for an optimal, and appropriate adjusting display of the all values.

-

Fixed

The upper and lower limit of the axis can be defined using the min
and max spin boxes.

X-Units

-

Auto

The units are selected automatically.

-

Fixed

You can select the desired unit for the x-axis from the dropdown list.

Show Tick Marks

Shows tick marks in the chart. If activated, you can set the Form and
Size of the tick marks. Currently, the tick marks have to be set per
chart.

Show Legend

Shows the chart legend.

Show Axis Captions

Shows captions of the axis.

13.5.2.6.5 Export Tab

Parameter

Description

Data Table

-

As New Document

Opens the measurement data table in a new document tab. The table
displays all measurement values and area for all ROIs in each channel.
If event markers are present these are also listed here at the appropriate time points. For a description of the measured parameters, see
Basics of Calculation of Intensity and Ratio Values [} 463].

-

Save as *.csv

Opens the Save As dialog and allows the measurement data to be
exported as a comma separated value (*.csv) file. The following values are exported for each ROI and channel: Intensity, area and if
present event markers. The exported values are the raw data without
the subtraction of any background correction.
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Description

Ratio image

-

As New Document

Opens the ratio image in a separate new document as a *.czi file (current Z only).

-

Save as

Opens the Save As dialogue to save the ratio image directly to a *.czi
file.

13.5.2.6.6 Ratio Tab
This view option is almost identical to the Online Ratio tab in the MeanROI Setup, see Online
Ratio Tab [} 864]. In fact when an experiment is finished the exact same values used for the display of the online ratio are transferred to the offline ratio tool of the MeanROI view and are
stored with your image for later reference.
For offline ratio assessment the settings can be changed and are applied to the ratio image and
the measured values. For large data sets (high resolution or many time points), a smooth playback
of the ratio image can be achieved by clicking on the Cache ratio image button. This stores the
ratio images temporarily to the computers memory for very fast playback or adjustments of the
time slider. The following descriptions describe the differences on the Ratio tab:

Parameter

Description

Ft0= Average intensity of frame

Only available if the Single wavelength method is selected.

Update

Applies the changes of the frame made with the input fields.

–

Cache ratio image

Defines the frames of the time series image from which the reference
value Ft 0 should be calculated.
The numbers in the input fields refer to the frame number of the current experiment in the MeanROI view. The desired frame numbers
can be entered with the buttons or directly by typing a number into
the field. Typically, your experiment should include a baseline of 5-10
images before and/ or in between a simulation/ activation.

Caches all the ratio images of the current time series with the given
ratio calculation parameters. This is done to avoid image flickering
when moving through the time series with the slider quickly.

13.5.2.6.7 Online Ratio Tab

Parameter

Description

Calculation dropdown list

Selects the ratiometric method you want to use. Single and Dual
wavelength dyes are supported with an additional three formulas for
further adapted (online or offline) image ratio calculations. The ratio
set-up will change in accordance with your selection.

-

Single Wavelength Method

Select the channel in the dropdown menu. The Ft0 value is the averaged fluorescence from the specified number of image frames. The
number of frames to average is defined in the spin box of the reference image set-up (see 10). The spin box at the far left is a multiplication factor.
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Description

-

Dual Wavelength Method

Select the channels in the dropdown list required to calculate the ratio
values/image e.g. for Fura-2, a dual excitation dye, the numerator is
the 340 nm image the denominator the 380 nm image. For dual emission dyes the function is identical. The spin box at the far right is a
multiplication factor.

-

Image Ratio
Type 2

The formula calculates the normalized ratio of the difference between
two weighted channel intensities.

-

Image Ratio
Type 3

The formula calculates the ratio between the weighted difference and
weighted sum of two channel intensities

-

Image Ratio
Type 4

The formula calculates the ratio between the intensity difference of
two channels in relation to the intensity of one channel.

Background Correction

A background correction can be performed on a channel by channel
basis. The selection of a background correction method modifies the
ratio set-up formula accordingly. Note that the correction by ROI is
only available if there are at least two ROI defined in the image! The
following modes are available:

-

None

No background correction is performed.

-

Constant

Allows a user defined numeric value to be entered for each channel in
the appropriate spin box.

-

ROI

Allows to select the background ROI defined in the Mean ROI view/
setup.
Note that for dual wavelength protocols the same ROI is used in each
case, but its channel specific values are applied for the correction.
For single wavelength ratio, no ROI background correction is available.

Ratio Clipping

Activated: Sets the factor for ratio clipping.

Color

Select the color (LUT) used to display the ratio image. Per default the
Rainbow LUT is used as it allows intensity changes to be followed easily.

Enable Threshold

Activated: Allows the threshold values to be set for the ratio calculation.

Channel /
Threshold

A threshold value can be applied in the form of a constant integer
value for each channel individually. Thresholds help to reduce noise
anomalies that are cause by pixel to pixel variations in areas between
cells or near cell boarders during the ratio calculation. Enter the desired threshold value for each channel into the spin boxes provided.
For more detailed information on how ZEN handles thresholds, see
Basics of Calculation of Intensity and Ratio Values [} 463].

-
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13.5.2.6.8 ROI Tracing Tab
This tab is only available if you have licensed the Physiology (Dynamics) module.
ROI tracing allows you to adjust the position of your ROI as necessary to accommodate the lateral
movement of an object in a image of which the mean intensity is to be measured. This is done by
defining a series of one or more so called key frames for individual ROIs. In this manner, complex
object movements can be corrected.

Parameter

Description

Enable ROI Tracing

Enables the functionality for ROI tracing.

Selected ROI

Displays the number and shape of the currently selected ROI.

Key Frame Edit
Mode

Only available if you have selected a ROI.

–

Manipulates the ROI for all time points/key frames.
All Key
Frames

–
Single Key
Frame
Interpolation

Manipulates the ROI for the currently selected time point and creates
a key frame. Note that a single key frame adjustment can only be performed when the frame number (time point) is set to 2 or higher.
Only available if you have selected a ROI.
Selects an interpolation method for the ROI changes between the
time points.

–

Constant

Does not interpolate the ROI position between the key frames, i.e. the
ROI is pnly present at the set key frames.

–

Linear

Determines the ROI position at the time points between key frames
based on linear interpolation.

–

Spline

Determines the ROI position at the time points between key frames
based on spline interpolation.

Key frame list

Displays the key frames of the ROI and the changes compared to the
previous key frame.

–

Adds the current position as key frame.
Add
Deletes the currently selected key frame.

–
Delete
Show

–

Trajectories

Activated: Displays the trajectories between the key frames in the
image.

–

Ticks

Activated: Displays ticks for the (center) position the ROI for each
time point in the image. These ticks are only visible if Linear or Spline
is selected as interpolation method.

–

Ghosted key
frames

Activated: Displays the shape of the ROI at each key frame.
Deactivated: Displays the shape of the ROI only at the currently selected time point.
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–

All ghosted

ZEISS

Description
Only available if Ghosted key frames is activated.
Activated: Displays the shape of the ROI for all time points. This effect is only visible if Linear or Spline is selected as interpolation
method.

See also
2 Adjusting ROIs for Time Points [} 459]
13.5.2.7 Unmix View
This view is only visible for multi-channel or lambda stack images. It is used for:
§

display the spectra corresponding to defined ROIs (mean ROI intensity over Lambda),

§

show the intensity values in table form, copy the table to clipboard or save the table as a text
file and

§

generate linear unmixed multi-channel images.

In this view you will see 2 areas as default. The intensity-over-lambda diagram (1) to the left and
the image display (2) to the right. The specific view options (3) below the image area are described in the following topics.

Fig. 74: Unmix View
13.5.2.7.1 Unmix Tools Tab
Here you can select various tools and use these to draw graphic elements into your images, similar to the tool bar on the Graphics tab. You can also obtain an overview of the graphic elements
that you are using in your image.
The following list will describe the specific parameters for this tab:
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Parameter

Description

Toolbar

Using the tools you can draw in certain regions of interest which are
then displayed in the intensity-over-lambda diagram and will be used
for linear unmixing.

-

Use this to select the graphic elements in the image area. If you are
currently in another mode, you can switch back to the selection mode
using this button.

Select

Clone

Use this to create an identical copy of the last graphic element drawn
in by simply clicking anywhere into the image area. To exit this mode,
either switch back to the selection mode or press the ESC key.
Draws a rectangular Region of Interest (ROI) into the image.

Draw Rectangle

Draw Circle

Use this to draw in a circle. This element by default also shows the
mean gray level of the image region.
With this tool you can draw a elliptical region.

Draw Ellipse

Draw Spline
Contour

Use this to draw in a freely selectable contour. You can either define
the corner points by a series of clicks or you can trace a contour by
keeping the left mouse key pressed. Close this contour by right-clicking. Corners are always rounded with this tool. This element by default also shows the mean gray level of the image region.
With this tool you can draw a polygonal region.

Draw Polygon

Draw Cross

List of Spectral Data

With this tool you can draw a cross marker into the image, where the
pixel at the center of the cross is taken for the unmixing measurement.
Note: The 10x10 pixel rectangle around the cross is only a visual aid
to locate the marker, the unmixing is only taking the one pixel at the
center into account and not this rectangular bounding box.
The list gives you an overview of the spectral data in the image, which
will be used for linear unmixing. The names indicates the origin, e.g. if
manually or automatically picked by ACE (see below) or loaded from
the spectra database.
To load a spectrum from the spectral database, press the Add + button for a new row. Click into the Name column and select the according name for the needed spectrum.

Save to spectra
database

If you click on this button you can save the selected entry to the spectra database.

Auto find /ACE...

ACE stands for Automatic Component Extraction.
If you click on this button the software automatically searches for regions with distinct spectral signatures and tries to find the defined
number of spectra.
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Parameter

Description

Linear Unmixing

Performs the linear unmixing processing of the image with the selected spectra.

ZEISS

Note: The channels of the Lambda stack which are de-selected in the
Dimensions tab are not included in the calculation.
Show Table

Activated: Displays a table of intensity values over Lambda below the
default image area.

Normalize for display

Activated: Normalizes the graphs of the spectra to 1.

Subtract background

Here you can select the list entry of a marked spectrum that should be
subtracted before linear unmixing.

Auto scale

Activated: Automatically balances the intensity of unmixed channels
to equal levels.

Create residuals
channel

Activated: Generates an additional channel in which the intensity
value represent the difference between the acquired spectral data and
the fitted linear combination of the reference spectra for each pixel.
In essence, the residual value is the biggest remaining "residual" from
the least square fit routine. The residuals are a general measure for
how good the fit of the algorithm has performed.

Channel

-

Raw

The raw data acquired during a lambda stack is used as channels and
for spectral display.

-

Spectral

The intensity data of the lambda stack is calculated into channels for
each detector (Channel 1 and Channel 2).

13.5.2.7.2 Chart Options Tab
This tab provides several parameters to change the appearance and contents of the spectral
graph. For the beginning we recommend to use the default settings here.
13.5.2.8 Lambda View
In this view you can display images that are acquired in Lambda mode, see Lambda Mode. the resulting images are called Lambda stacks. For that type of image the 2D View is not available.
Instead the Lambda View displays a Lambda Stack in a wavelength-coded color view as default. A
color palette, mimicking the emission wavelength of the channel, is automatically assigned to the
individual lambda images which are then displayed in a merge-type display.
On Display tab, the channel-specific settings of brightness, contrast and gamma can be handled
as described for channels in the 2D View.
In order to use other views (e.g. Split or Gallery view) or to view lambda stack data sets in ZEN
black, convert the data set using the Convert to Lambda image processing function.
The general view options on Dimension tab are adapted to the Lambda View with the following
changes:
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Fig. 75: Dimensions tab changes for Lambda view

Parameter

Description

Channels

Displays the single channels of a Lambda stack image as a colored
button. You can handle the channels like in the 2D View. E.g. if you
click on a channel button you can show or hide the channel in the image area.

Lambda Coded

Activated: All channels are displayed as a merged image. Each channel is assigned to a channel color that represents the recorded emission wavelength in the lambda stack.
Deactivated: Only one channel of the Lambda Stack is displayed
without pseudo coloring. Additionally the Single Channel checkbox
is activated and cannot be changed. To display a different channel of
the Lambda Stack, click on the according channel. This will display the
chosen channel and deactivate the previously displayed channel.

13.5.2.9 Colocalization View
Only visible for multichannel fluorescence images.
In the Colocal. (Colocalization) view, you can analyze the extent of colocalization quantitatively
in two fluorescence channels. The view consists of two main areas: the X/Y scatter plot on the
left and the actual image (2 channels are displayed) in the right image area. Using the Coloc.
Tools specific view control, you can also display the Colocalization table in the lower image
area. To do this activate the Table checkbox in the Extract section.

Info
The channels that you are comparing with one another are displayed in the image area in the
form of a color overlay. The channel color of the image is used here. If the images have more
than 2 channels, you can add additional channels on the Dimensions tab. This temporary selection is deactivated, however, when you select the channels to be compared on the Coloc.
Tools tab.

See also
2 General View Options [} 887]

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

870

13 Software Functions & Reference | 13.5 Image views

ZEISS

13.5.2.9.1 X/Y Scatter Plot
The pixel intensities of two channels are plotted against one another in the diagram and each
pixel pair with the same X/Y image coordinates is displayed as a point. The frequency with which
pixels of a certain brightness occur is visualized by means of a color palette that is displayed at the
bottom of the diagram. The relative value range lies between 0-255.
The vertical and horizontal axes show the gray value range that applies for the relevant channel.
The diagram is overlaid with two lines that subdivide it into 4 quadrants, numbered from 1-4. Using the mouse you can position the lines freely and therefore adjust the threshold values to the
data.
The quadrants have the following meanings:
§

1: Non-colocalizing pixels from channel 1

§

2: Non-colocalizing pixels from channel 2

§

3: Colocalizing pixels

§

4: Background

13.5.2.9.2 Coloc. Tools Tab
Here you find all control elements you need to perform a colocalization analysis.
13.5.2.9.2.1 Tool Bar section
Only visible if the Show All mode is activated.
Use the tools to draw regions into the image in which you want the analysis to be performed. A
description of the tools can be found on the Graphics [} 894] tab.
Once a region has been drawn in, it is automatically treated as an active region. The scatter plot
shows the pixel value frequencies for this region.
The Colocalization table displays the data for the entire image and for the selected region. To
select several regions, hold down the Ctrl key and click on the desired regions.
Apart from drawing regions into the image, you can also draw them into the X/Y scatter plot. If
you have used the function in the Regions section [} 873], only those pixels that are framed by a
region in the scatter plot are taken into consideration. This means that you can correlate interesting point clouds quickly with the corresponding pixels in the image.
If you have drawn regions into the scatter plot, the ROI (region of interest) button will also appear
in the tool bar. As long as this button is activated (highlighted in blue), you can select, move and
change the regions in the scatter plot using the Selection tool. If you want to change the quadrant lines again, you will need to deselect the ROI button beforehand.
13.5.2.9.2.2 Channels and scatter plot control section
Channels dropdown lists
Here you can select which channels of a multichannel image are compared with one another. Select a channel for both the horizontal and vertical diagram axis from the Channels dropdown list.
The first and second channel are always selected by default. As soon as you have made a selection, all other channels are automatically removed from the image display. You can, however, add
other channels temporarily on the Dimensions tab.
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Threshold sliders
Using the two Threshold sliders and the two spin boxes/input fields, you can set the threshold
value (in gray levels) for both channels.

Range dropdown lists
Only visible if the Show All mode is activated.
Here you can define the gray value range that the scatter plot axes will display. Auto is selected
here by default, which means that the range is automatically set to the brightest pixel in the image. You can, however, enter a fixed gray value range between 256 (8 bits) and 65535 (16 bits). If
the image is a time lapse or Z-stack image, Auto has been selected, you can select the dimension
for which you want the gray value range to be automatically determined from another dropdown
list. In this way you can easily determine a valid diagram setting for an entire time series, for example, without having to analyze each individual time point.
Dimension selection dropdown list
This dropdown list is only visible if at least one of the Range dropdown lists is set to Auto and if
the image is a z-stack or a time series. Defines whether the axis of the scatter plot are based on
the values of the current image plane (2D), or on the entire z-stack (All Z)/time series (All T).
Costes button
Calculates the optimal threshold value according to Costes et al.
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13.5.2.9.2.3 Regions section
Channels buttons
Here you can mask pixels in the image according to which one of the four quadrants they belong
to. The numbers on the buttons correspond to the numbering of the quadrants in the X/Y scatter plot. The color selection window is accessed by clicking on the color field. Using the Opacity
slider you can determine the degree of transparency of the masking.
Cut Mask button
Only active if a quadrant has been masked.
Creates a new image exclusively containing the masked pixels.
13.5.2.9.2.4 Extract section
Scatter Plot button
Creates a new image document from the X/Y scatter plot. In the case of time series or Z-stacks
the dimensions are also created automatically.
The following functions are only visible if the Show All mode is activated:
Table button
Creates a new table document. The document contains all measurement data from the colocalization analysis. All dimensions, such as T and Z, are also taken into account. This table can be saved
as a *.csv document for further processing in other programs.
Table checkbox
Activated: Displays the colocalization table in the image area.
13.5.2.9.3 Colocalization table
Only visible if the Table checkbox is activated on the Coloc. Tools tab.
For each quadrant of the scatter plot there is a correspondingly labeled row in the table. The
Global row contains the values for the entire image. The table contains columns for the following
measured values:
13.5.2.9.3.1 Region
Once a region has been selected it has a number assigned to it. This number appears in the image
and in the table.
13.5.2.9.3.2 Quadrant
Indicates the measured values for the four quadrants of the scatter plot.
13.5.2.9.3.3 Pixel Number
Shows the total number of pixels of each quadrant. The sum of all pixels in this column for all 4
quadrants corresponds to the product of the height x width of the original image.
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13.5.2.9.3.4 Area (µm²)
Area = number of pixels x scaling factor for X/Y
If there is no scaling for the original image, the following applies: 1 pixel = 1 µm.
13.5.2.9.3.5 Relative Area (%)
Relative area = area of quadrant/total area
13.5.2.9.3.6 Pearson's Correlation Coefficient
Provides information on the intensity distribution within the colocalization region.
Value range: -1 to 1.
1: All pixels are on a straight line in the scatter plot from bottom left to top right (if, for example,
you have used the same channel twice for the colocalization, you will find the value 1 in this column).
0: The pixels in the scatter plot are distributed in a cloud without a preferred direction.
-1: The pixels do not overlap. The scatter plot stretches from top left to bottom right. This situation can be described as negative colocalization and means "exclusion".
The calculation formula is as follows:

GV: Gray Value; AV: Average Gray Value; C: Channel
13.5.2.9.3.7 Manders' Correlation Coefficient
Insensitive to differences in the signal intensity between the two channels and bleaching.
Value range: 0 to 1
The calculation formula is as follows:

Fig. 76: C: Channel
13.5.2.9.3.8 Coloc. Coefficient 1
This coefficient indicates the relative number of colocalized pixels in channel 1 in relation to the
total number of pixels above the threshold value:

The values range between 0 and 1, with 0 indicating no colocalization and 1 indicating full colocalization.
Numerator = Number of pixels in quadrant 3
Denominator = Number of pixels in quadrant 3 + number of pixels in quadrant 1
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13.5.2.9.3.9 Coloc. Coefficient 2
This coefficient indicates the relative number of colocalized pixels in channel 2 in relation to the
total number of pixels above the threshold value:

The values range between 0 and 1, with 0 indicating no colocalization and 1 indicating full colocalization.
Numerator = Number of pixels in quadrant 3
Denominator = Number of pixels in quadrant 3 + number of pixels in quadrant 2
13.5.2.9.3.10 CC (weighted) 1
Weighted correlation coefficient channel 1. Calculated like the simple colocalization coefficient,
but using the sum of the gray value intensity rather than the number of pixels.

The values range between 0 and 1, with 0 indicating no colocalization and 1 indicating full colocalization.
Numerator = Sum of intensity of all pixels in quadrant 3
Denominator = Sum of intensity of all pixels above the threshold value
13.5.2.9.3.11 CC (weighted) 2
Weighted correlation coefficient channel 2. Calculated like the simple colocalization coefficient,
but using the sum of the gray value intensity rather than the number of pixels.

The values range between 0 and 1, with 0 indicating no colocalization and 1 indicating full colocalization.
Numerator = Sum of intensity of all pixels in quadrant 3
Denominator = Sum of intensity of all pixels above the threshold value
13.5.2.9.3.12 Average Intensity 1
The sum of all gray values from channel 1, divided by the total number of pixels in this channel:
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13.5.2.9.3.13 Average Intensity 2
The sum of all gray values from channel 2, divided by the total number of pixels in this channel:

13.5.2.9.3.14 Standard Deviation 1
Displays the standard deviation of the gray values in channel 1:

13.5.2.9.3.15 Standard Deviation 2
Displays the standard deviation of the gray values in channel 2:

13.5.2.9.3.16 Z Index
Displays the Z index for Z-stack images.
13.5.2.9.3.17 T Index
Displays the time index for time lapse images.
13.5.2.9.3.18 Relative Time
Displays the time of acquisition for all dimensions of a multidimensional image, beginning at
0h:00min:00sec:00msec.
13.5.2.9.3.19 Relative Focus
Displays the relative focus position at which an image has been acquired.
13.5.2.10 FRAP View
The FRAP view (FRAP = Fluorescence Recovery after Photobleaching) is only visible for a time series data set which includes a minimum of one bleach event. It permits interactive analysis of
bleaching experiments, including:
§

Fit Formula
Fitting of FRAP data to a mono exponential or double exponential model for intensity

§

Fit Range
Selection of data points for the fitting

§

Photofading Factor
Determining the fading factor from a reference region (Ref.) from the present experiment or a
control experiment and reusing it for subsequent experiments

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

876

13 Software Functions & Reference | 13.5 Image views

§

ZEISS

Defining Background and Reference Regions for the analysis (fitting) of FRAP data

Note: When acquiring Airyscan SR or Airyscan MPLX data, FRAP View only works as expected
with the complete time series date processed
The Image Display in the FRAP View shows 4 panels:
§

the intensity-over-time diagram with the fitted curve per channel (1)

§

the image display with the ROI graphics (2)

§

the table with the fit parameters for each channel and analysis ROI Group (one or more ROIs
can be grouped for analysis, up to three groups can be analyzed) (3)

§

an optionally viewed table of the average intensity values of each ROI Group (corrected for
Background and Reference) for each time point and channel

1

2

3
Fig. 77: Image display of a time series with bleach event in the FRAP View Tab
13.5.2.10.1 FRAP View Options
The additional view-specific FRAP View Options are available in the FRAP View Options Tab.

Fig. 78: FRAP View Options Tab
Any changes performed with this view options tab are effective immediately.
The settings of the Dimensions, Display, Player and Graphics View Options tabs apply for FRAP
View, too.
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Available tools in the FRAP View Options Tab are:

Parameter

Description

Regions of Interest
(ROIs)

The FRAP View Options Tab includes drawing tools that work identically to the Graphics View Options Tab. ROIs from both control blocks
can be combined.

Fit Formula

Drop down menu to select the mathematical model (mono or double
exponential model) for data fitting

Diagram Line

Drop down menu to format the line thickness of the fit curve(S) in the
diagram

Diagram Marker

Drop down menu to format the time point markers of the fit curve(s)
in the fit diagram

Normalize

Checkbox to choose between absolute or normalized fit data. This updates the table of the intensity values and the fit diagram

Table

Checkbox to activate/deactivate the display of the intensity value (for
each channel) per time point corrected for background and reference
region if applied

Time Unit

Drop down menu to format the time units of the fit diagram, the fit
data table and the intensity table

Fit Range

Edit boxes and slider to define the data range for the fit algorithm

Photofading Factor

Checkbox to Use or not use the photofading factor for the data fitting
algorithm; Edit box to type in a photofading factor; Load and Save
function buttons to save and retrieve a factor (.xml file).
The photofading factor is either calculated from the current reference
region(s) or it is loaded from a previous experiment. The edit box
shows the currently (applied) value.
The photofading factor = reference(t)/reference(t=0) and then fitted
by: intensity(t) = exp(-kappa * t). The fitted value of kappa is displayed
in the edit box.

Background Region

Check box in the list of ROIs: Mark the region of interest which represents the mean background intensity to be used for data correction.
The mean intensity value of the background region is subtracted from
the data prior to fitting.

Reference Region

Check box in the list of ROIs: Define and select a ROI which represents
the fluorescence intensity of a reference area that has not been
bleached and has not been affected by the leach event. The mean intensity within that region is used to correct the data at each time
point for any bleaching artifact that occurred during the imaging
process. For this the data are divided by [reference(t)/reference(t=0)]

Combine Regions
Group 1, 2, 3

Check boxes in the list of ROIs which allow to choose more than one
ROI for analysis and to group them according to the experimental set
up. Mean Intensity values for the regions combined are used as data
input.
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13.5.2.10.2 Fit Model
The Fit Model applied provides the following data/parameter:
§

The final signal intensity in the analyzed ROIs following recovery IE (of the fitted curve)

§

The amplitude of the fitted curve (which equals the mobile fraction) I1 mobile fraction

§

The proportion of the mobile fraction: F1 mobile fraction (%)

§

The fitted parameter T1(s)

§

The half time of recovery T1 half (s)

§

The rate constant for the exchange of molecules between the bleached region and the surrounding area K1 (1/s)

§

The part of the immobile fraction of the protein I delta immobile fraction

§

The proportion of the immobile fraction: F1 immobile fraction (%)

A double exponential displays the mean of the fitted values for the two different mobile fractions
as the fit curve. The following (additional) parameters are provided
§

The amplitude of the two curves, displayed as one (which corresponds to each part of the
mobile fractions) I1 and I2.

§

The fitted parameters T1 (s) and T2 (s) for each mobile fraction.

§

The rate constant for the exchange of molecules between the bleached region and the surrounding area K1 (1/S) and K2 (1/s) for each mobile fraction.

§

The half time of recovery for each fraction T1 half (s) and T2 half (s)

The table displays the result of the data fit. The result can be copied to the clipboard (right mouse
click) and directly pasted into excel or saved as text.
The calculation of the parameters is based on the bleached ROI(s) unless other ROIs or selected or
the ROIs are moved.
The analysis is then part of the image and the type of analysis is displayed again when opening
the FRAP view for the image.
13.5.2.11 FRET View
13.5.2.11.1 Introduction
Förster Resonance Energy Transfer (FRET) is a mechanism which describes an energy transfer
between two chromophores, typically fluorescent proteins. Upon excitation with light of suitable
wavelength a donor chromophore, then in its electronic excited state, can transfer energy to an
acceptor chromophore. The efficiency of this energy transfer is dependent on the distance between the two molecules. This makes FRET an indicator for even very small changes in the distance between two molecules.
When using confocal or super resolution techniques FRET is typically used to determine whether
two fluorophores are within a certain distance of each other and whether this distance changes
due to external or internal influences.

See also
2 Acquisiton Prerequisites [} 880]
2 Sensitized Emission [} 880]
2 Acceptor Photobleaching [} 884]
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13.5.2.11.2 Acquisiton Prerequisites
There are two ways to access FRET measurements:
§

Sensitized Emission

§

Acceptor Photobleaching

Different acquisition set ups are necessary for each approach to enable the FRET View.
Analysis along Sensitized Emission requires a multichannel (multidimensional) data set (minimum 3 channels). The acquisition settings are determined by used fluorophores. Refer to scientific
papers for more information on sample preparation and necessary controls for sensitized emission
experiments.
Analysis along Acceptor Photobleaching requires a time series with a bleach event. The acquisition settings are determined by used fluorophores. Refer to scientific papers for more information
on sample preparation for acceptor photobleaching.
Depending on the data set FRET view provides different parameter sets for image analysis.
To access FRET View, the data set needs to be loaded or be completely acquired. Online calculation of FRET data is not supported.

See also
2 Sensitized Emission [} 880]
2 Acceptor Photobleaching [} 884]
13.5.2.11.3 Sensitized Emission
13.5.2.11.3.1 FRET tab

Parameter

Description

Graphics tools

Use graphics tools to define the region(s) to be analyzed including the
(optional) region which defines background signal.

Method

Select the analysis method. ZEN provides three different methods for
data analysis. Depending on the method selected the display of the
FRET image changes. The data table displays the results of all three
methods. For more information, see Analysis methods for Sensitized
Emission.

Create Image

The displayed FRET image is displayed as new image document.

ROI table

Checkboxes assign the defined regions as region to be analyzed or
background region.

13.5.2.11.3.2 Parameter tab
Determine the Donor coefficient values by using a sample with signal of the donor fluorophore
only using the same imaging settings which are later used for imaging the FRET sample. Define
one or more regions in the image which are enabled as objects to be analyzed in the FRET tab.
The Donor coefficient values are taken from this region by clicking the Analyze Donor button.
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Determine the Acceptor coefficient values by using a sample with signal of the acceptor fluorophore only using the same imaging settings which are later used for imaging the FRET sample.
Define one or more regions in the image which are enabled as objects to be analyzed in the FRET
tab. The Acceptor coefficient values are taken from this region by clicking the Analyze Acceptor
button.

Parameter

Description

Donor Ch

Define the channel which contains the Donor signal.

Acceptor Ch

Define the channel which contains the Acceptor signal.

FRET Ch

Define the channel which contains the FRET signal.

Analyze

Select which signal has to be analyzed from the present image.

Donor coef. Fd/Dd

Shows the value of Donor signal detected in the FRET channel/Donor
signal detected in the Donor channel from the analyzed present image.

Donor coef. Ad/Fd

Shows the value of Donor Signal detected in the Acceptor channel/
Donor signal detected in the FRET channel.

Acceptor coef. Fa/
Aa

Shows the value of Acceptor signal detected in the FRET channel /
Acceptor signal detected in the Acceptor channel.

Acceptor coef. Da/
Aa

Shows the value of Acceptor signal detected in the Donor channel /
Acceptor signal detected in the Acceptor channel.

Acceptor coef. Da/
Fa

Shows the value of Acceptor signal detected in the Donor channel/
Acceptor signal detected in the FRET channel.

G

Allows to set Gordon Factor which depends on the fluorophores used
and which can be part of the Gordon and Xia analysis. Please refer to
the original publications for further details (Gordon et al., Biophys J
74, 2702 (1998), Xia and Liu, Biophys J 81, 2395 (2001).

Global coefficient

When checked the current coefficient values are applied to all open
image documents in FRET View.

Drop down selection

Choose which parameter set should be saved or loaded. Choose between Acceptor or Donor.

Save

Save the coefficients of Donor or Acceptor as .xml file.

Load

Load the coefficients of Donor or Acceptor for the current analysis.

13.5.2.11.3.3 Threshold tab
The threshold for image analysis can be set manually using the slider or editing text box next to
Donor, Acceptor, FRET or All, where All moves all three sliders to the same value.
Alternatively, the threshold can be set by defining and enabling a background region in the FRET
tab. The values for the thresholds are either displayed as grey value levels (Raw data) or Normalized to the value 1.
Activate the general setting: Subtract Background using thresholds when background values
should be subtracted before image analysis is performed.
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Parameter

Description

Donor

Define threshold for analysis of donor signal.

Acceptor

Define threshold for analysis of acceptor signal.

All / FRET

Define threshold for analysis of all signals.

Clear

Set all threshold values to zero, deactivate background region.

Normalized

Grey values normalized to zero.

Raw data

Absolute grey values.

ZEISS

13.5.2.11.3.4 Settings tab
The tab allows to select parameters used for image analysis.
The General tab applies to both methods, Acceptor Photobleaching and Sensitized Emission.
Pixels of grey value zero are not included in any analysis.
13.5.2.11.3.4.1 General tab

Parameter

Description

Subtract background using
thresholds

The previously defined grey values of the thresholds (FRET tab,
Thresholds tab) are subtracted from each pixel prior to analysis. If
unchecked, pixels below the defined thresholds will not be displayed
in the FRET Image and are not part of the analysis (value and area).

Exclude saturated
pixels

Pixels which are saturated in at least one channel will not be considered for analysis.

Include thresholded pixels

Pixels with the same grey value as the defined thresholds will be part
of analysis.

Apply palette

The FRET image is displayed color coded.

Show palette

Displays a palette of the FRET values within the FRET image and a
palette of the channel colors in the raw data image.

13.5.2.11.3.4.2 Acceptor Photobleach tab

Parameter

Description

Do not show negative values in Fc
image

Does not display any negative values in the FRET image

13.5.2.11.3.4.3 Sensitized Emission tab

Parameter

Description

FRETN Truncation

Only includes the range of the selected values in result table and the
displayed image
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Parameter

Description

N-FRET Truncation

Only includes the range of the selected values in result table and the
displayed image

Do not show negative values in Fc
image

Does not display any negative values in the FRET image showing the
analysis according to the method of Youvan.

FRETN normalization

Does not display any negative values in the FRET image showing the
analysis according to the method of Youvan.

13.5.2.11.3.5 Analysis Methods for Sensitized Emission
13.5.2.11.3.5.1 FC or Youvan Method
Youvan et al., Biotechnology et alia 3, 1 (1997)
Fc = Ff-Df(Fd/Dd)-Af(Fa/Aa)
Displays the Fc image with intensities converted from the FRET index calculated for each pixel using the Youvan method. This method assumes that the signal recorded in the FRET channel is the
sum of real FRET signal overlaid by donor crosstalk and acceptor signal induced by direct (donor)
excitation. There is no correction for donor and acceptor concentration levels and as a result the
FRET values tend to be higher for areas with higher intensities.
13.5.2.11.3.5.2 FRETN or Gordon Method
Gordon et al., Biophys J 74, 2702 (1998)
FRETN = FRET1/ Dfd * Afa
Displays the FRET image with intensities converted from the FRET index calculated for each pixel
using the Gordon method. This method calculates a corrected FRET value and divides by concentration values for donor and acceptor. This method attempts to compensate for variances in fluorochrome concentrations but overdoes it. As a result, cells with higher molecular concentrations
report lower FRET values.
13.5.2.11.3.5.3 N-FRET or Xia Method
Xia and Liu, Biophys J 81, 2395 (2001)
NFRET = FRET 1/ (Dfd*Afa)
Displays an N-FRET image with intensities converted from the FRET index calculated for each
pixel using the Xia method. This method is like the Gordon method with the difference that the
square root of donor and acceptor concentration is used for concentration compensation. The resulting image is properly corrected for variances in the fluorochrome concentration.
The Sensitized Emission analysis (all three methods are analyzed) shows the following parameters in the data table beneath the FRET image and the original image:

Parameter

Description

Region

The identification numbers of regions assigned for analysis. Region
zero refers to the whole image.
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Parameter

Description

Time

When a time series is analyzed, the time point is shown.

D avg.

Average intensity of the region in the Donor channel. These values
are influenced by the chosen settings in the Settings Tab. They may
therefore vary from values of the same regions in the Histo tab.

A avg.

Average intensity of the region in the acceptor channel. These values
are influenced by the chosen settings in the Settings Tab. They may
therefore vary from values of the same regions in the Histo tab.

F avg.

Average intensity of the region in the FRET channel. These values are
influenced by the chosen settings in the Settings Tab. They may
therefore vary from values of the same regions in the Histo tab.

FRETN (p)

Result of analysis using Gordon method. The FRETN value is calculated for each pixel, afterwards the average for the chosen region is
determined.

Fc (p)

Result of analysis using Youvan method. The Fc value is calculated for
each pixel, afterwards the average for the chosen region is determined.

N-FRET (p)

Result of analysis using Xia method. The N-FRET value is calculated
for each pixel, afterwards the average for the chosen region is determined.

13.5.2.11.4 Acceptor Photobleaching
13.5.2.11.4.1 FRET tab

Parameter

Description

Graphics tools

Use graphics tools to define the region(s) to be analyzed including the
(optional) region which defines background signal.

Method

Select the analysis method. With an input of a dual channel time series with bleach event only Acceptor Bleaching analysis is possible.

Create Image

The displayed FRET image is displayed as new image document.

ROI table

Checkboxes assign the defined regions as region to be analyzed or
background region.

The Acceptor Photobleaching analysis shows the following parameters in the data table beneath the FRET image and the original image:

Parameter

Description

Region

The identification number of regions assigned for analysis. Region
zero refers to the whole image.

FRET(p) Eff. %

FRET efficiency for each pixel is calculated and averaged for all pixels
of the region.

D Pre

The averaged intensities of the region are used to calculate an averaged FRET efficiency for this region. Delta D / D Post * 100.

D Post

Average donor intensity of the region in the pre-bleach image.
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Parameter

Description

A Pre

Average acceptor intensity of the region in the pre-bleach image.

A Post

Average acceptor intensity of the region in the post-bleach image.

Delta D

Change in donor intensity of the region before and after the bleach
event. Delta D = D Post-D Pre.

Delta A

Change in acceptor intensity of the region before and after the bleach
event. Delta A = A Post- A Pre.

13.5.2.11.4.2 Parameter tab

Parameter

Description

Donor Ch

Define the channel which contains the Donor signal

Acceptor Ch

Define the channel which contains the Acceptor signal

Pre-bleach image:
<nr>

Indicates the image before bleach event used for analysis

Pre-bleach image:
<nr>

Indicates the image after bleach event used for analysis

Image after bleach
event

In case of repetitive bleaching select the bleach event which should
be analyzed. The post-bleach image number is updated accordingly.

13.5.2.11.4.3 Settings tab
The tab allows to select parameters used for image analysis.
The General tab applies to both methods, Acceptor Photobleaching and Sensitized Emission.
Pixels of grey value zero are not included in any analysis.
13.5.2.11.4.3.1 General tab

Parameter

Description

Subtract background using
thresholds

The previously defined grey values of the thresholds (FRET tab,
Thresholds tab) are subtracted from each pixel prior to analysis. If
unchecked, pixels below the defined thresholds will not be displayed
in the FRET Image and are not part of the analysis (value and area).

Exclude saturated
pixels

Pixels which are saturated in at least one channel will not be considered for analysis.

Include thresholded pixels

Pixels with the same grey value as the defined thresholds will be part
of analysis.

Apply palette

The FRET image is displayed color coded.

Show palette

Displays a palette of the FRET values within the FRET image and a
palette of the channel colors in the raw data image.
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13.5.2.11.4.3.2 Acceptor Photobleach tab

Parameter

Description

Do not show negative values in Fc
image

Does not display any negative values in the FRET image

13.5.2.11.4.3.3 Sensitized Emission tab

Parameter

Description

FRETN Truncation

Only includes the range of the selected values in result table and the
displayed image

N-FRET Truncation

Only includes the range of the selected values in result table and the
displayed image

Do not show negative values in Fc
image

Does not display any negative values in the FRET image showing the
analysis according to the method of Youvan.

FRETN normalization

Does not display any negative values in the FRET image showing the
analysis according to the method of Youvan.

13.5.2.11.4.4 Threshold tab
The threshold for image analysis can be set manually using the slider or editing text box next to
Donor, Acceptor, FRET or All, where All moves all three sliders to the same value.
Alternatively, the threshold can be set by defining and enabling a background region in the FRET
tab. The values for the thresholds are either displayed as grey value levels (Raw data) or Normalized to the value 1.
Activate the general setting: Subtract Background using thresholds when background values
should be subtracted before image analysis is performed.

Parameter

Description

Donor

Define threshold for analysis of donor signal.

Acceptor

Define threshold for analysis of acceptor signal.

All / FRET

Define threshold for analysis of all signals.

Clear

Set all threshold values to zero, deactivate background region.

Normalized

Grey values normalized to zero.

Raw data

Absolute grey values.
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13.5.3 General View Options
The general view options are visible in any view. Some of the view options are only visible when
you open a particular file type. E.G. see the ApoTome view option only if you have opened a
ApoTome image.
13.5.3.1 Dimensions Tab
Here you configure the settings for how the image will be displayed on the screen. You can select
the size of the display and call up information about the content of the image. In the case of multidimensional images you can select here which dimension is displayed. The dimension sliders (e.g.
time, channels) help you to navigate through the single images of an experiment.
Note: The displayed settings in the tab depend on the image and experiment. Also the settings of
this tab in the 2D and 3D Correlative Workspace viewer are limited and/ or different compared to
the normal ZEN image view.

Fig. 79: Dimensions Tab (Show All)
13.5.3.1.1 Slider section
Depending on how many dimensions your image contains, several sliders can be available in this
section. Using the sliders you can adjust the position that you want for each dimension available
in the image. You will see the current position number in the input field to the right of the relevant slider. You can also enter the position number directly here.

Fig. 80: Slider Section (example)
The
Play buttons to the right of the input fields enable you to play back the dimension automatically. This takes place at a rate of 5 images per second by default. You can change the
speed on the Player Tab [} 893].

Info
For images with more than 3 dimensions a scrollbar is displayed which you can use to access
the other sliders.
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Depending on the available dimensions, the following sliders can be visible:

Parameter

Description

Follow Acquisition

By activating the Follow Acquisition checkbox during acquisition of
multi dimensional experiments (time series, tiles and z-stacks) the actual image is displayed (default value).
By moving the Time slider in the Dimensions tab, this feature is disabled and a button for performing a manual update of the slider
range is shown.

Update

Only visible if Follow Acquisition is deactivated.
Triggers a manual update of the acquired image during the running
acquisition.

Z-Position

Only visible in the case of z-stack images.
Here you can adjust the desired z-position.

X-Position

Only visible for images acquired in Line scan mode.
Here you can adjust the desired x-position.

Time

Only visible in the case of time series images.
Here you can adjust the desired time point.

Scene

Only visible if the image contains different scenes.
Adjusts the desired scene. If you deactivate the Scene checkbox, all
scenes are displayed in an overview.

Global-Z

Only visible for ZEN Connect projects with at least one z-stack.
Sets the global value for the displayed z-slices. The range of the slider
is defined by the z values of all stacks in the project.
Note: When you use the Global Z slider and are beyond the range of
a certain image, only a frame for this image is displayed to show
where the image is positioned.

Block

Only visible if you have used the Experiment Designer and created
several experiment blocks.
Adjusts the desired experiment block.

Total Time

Only visible if you have used the Experiment Designer.
Adjusts the duration across all blocks.

Phase

Only visible for ApoTome images and if on the ApoTome tab [} 905]
the Display Mode is set to Raw Data.
Selects the various phases of the raw images.

13.5.3.1.2 Zoom section
This section contains tools that you can use to adjust the size of the image region displayed.

Fig. 81: Zoom section

Info
If you hold down the Ctrl-key, you can zoom in and out of the image using the mouse wheel.
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Parameter

Fit to View

Normal View
(100%)

Description

Short
cut

Automatically sets a zoom factor at which the entire image
can be displayed visibly on the screen.

Ctrl +
0

Shows the image without increasing or decreasing the
zoom factor. One pixel of the image corresponds to one
pixel on your screen.

Ctrl +
1

Decreases the zoom factor.

F8,
Ctrl +
F8

Increases the zoom factor.

F7,
Ctrl +
F7

Decrease Zoom

Increase Zoom

Zoom factor

Auto-Fit

ZEISS

Here you can set the display size steplessly. The desired
zoom factor can be entered in the input field in percent.
Activated: Adjusts the display size automatically and continuously to the size of the window.

13.5.3.1.3 Tools section

Fig. 82: Tools section

Parameter

Description
Activates the selection mode.

Selection

Zoom Rectangle

Activates the zoom mode. Hold down the left mouse button and drag
out a selection rectangle. When you release the left mouse button,
the region within the rectangle is displayed in enlarged form.
If you have a mouse with a mouse wheel, you can also use this to
move enlarged/reduce image regions.

Move

Activates the move mode. Left-click inside an enlarged image to move
the zoomed region.
If you have a mouse with a mouse wheel, position the mouse pointer
inside the image region and hold down the mouse wheel. The mouse
pointer will then appear automatically as a hand icon. You can now
move the image region.
Only visible in Gallery view.

Inner Zoom

This function allows you to set a new zoom level for all images simultaneously using the mouse wheel.
The size of the Gallery view does not change here. This allows you to
limit the view to one interesting image region. Use the Move tool to
move the view.
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Parameter

Show Pixel Values
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Description
Activates the show values mode. If you move the mouse pointer into
the image region, a vertical arrow and a display field will appear. The
pixel values of the position to which the arrow is pointing are displayed in the display field.
In the first line of the display field the X/Y coordinates are shown. The
second line shows the X/Y coordinates in scaled units. In the other
lines the gray values for each channel are shown.

Navigator

Opens the in the image area. There you will see an overview of your
image and you can navigate to different positions using a rectangular
window.

Interpolation

Activated: The pixel elements of the image are shown in an interpolated display. This makes it possible to avoid the pixelated display of
small or greatly enlarged images.
Deactivated: The pixel elements of the image are displayed as they
are. This function is activated by default. You can deactivate this function via Tools menu | Options | Documents Tab [} 633].

13.5.3.1.4 Channels section
This section contains all channels that you are using in your image. You can switch the display of
channels in images on or off and change the channel colors (pseudo color assignment).

Fig. 83: Channels section
A button is displayed for each channel. Each button has two functions:
1. The channel name is displayed in the top section. To switch a channel off/on again, left-click
on this section of the button.
2. The bottom section of the button shows the channel color. The display changes depending
on the status of the button:
§

When switched off, you will see a colored line below the button.

§

When switched on, you will see a color field with a dropdown list below the button. Clicking
on the dropdown list opens the color selection, see Color Selection Dialog [} 892].

Info
For images with 8 or more channels, the Channel buttons are reduced in size. In this case it is
no longer possible to change the color channel by channel.

Parameter

Description

Single-Channel

Activated: Only a single channel is displayed.

Show Channel Colors

Only visible in Split view.
Activated: Displays the individual channels of multichannel images
with the assignment of pseudo colors.
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Parameter

Description

Range Indicator

Activated: Changes the display to single channel mode.

ZEISS

The channel is displayed in monochrome. At the same time you will
see pixels that are saturated (displayed in red) and pixels that have no
signal (values = 0; displayed in blue). Note that with camera systems it
is normally not possible to achieve pixel values of 0. The blue indicator
is therefore normally not displayed.
This function helps you to set your acquisition settings, camera exposure or detector gain, so that saturation of the detector is avoided.
The range indicator function is not available for the sum channel of
the Airyscan.
Quick Color Setup

Opens a dialog that allows you to select a color quickly for all channels of a multichannel image. The following options can be set:

-

None

All channels are displayed without a pseudo color.

-

Grayscale

All channels are displayed in monochrome (this applies in particular to
multichannel images that have been acquired using color cameras).

-

BGR

Channel 1: blue, channel 2: green, channel 3: red, no color assigned
to any other channels.

-

GRB

Channel 1: green, channel 2: red, channel 3: blue, no color assigned
to any other channels.

-

RGB

Channel 1: red, channel 2: green, channel 3: blue, no color assigned
to any other channels.

-

Via LUT

Colors for all channels are selected using a reference look-up table.
The LUT is divided up into as many sections as there are channels,
with the channel color being used at the separation point. You can
select the reference LUT using the Reference LUT... button.

-

Custom

The colors defined by the user are restored.

-

Dye

The color of the dye used during the experiment is restored

On the bottom of the tab further controls are available:

Parameter

Description

Stage

Activated: You can move the stage with the mouse during a continuous acquisition by clicking and dragging the displayed red cross in the
image container.

Marks

Activated: Stage coordinates (Marks) can be defined by clicking into
the image. The coordinates are written into the Marks table in the
Stage tool . The Marks button stays available during image acquisition

Selected Image

Only available in the ZEN Connect 3D Viewer.
Selects the active image to which the settings or transformations
should apply.
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13.5.3.1.4.1 Color Selection Dialog
Here you can select a pseudo color for the selected channel. In the lower area of the dialog you
will see four buttons that offer various methods of color selection. The selected button is highlighted in blue. To change the method, simply click on the appropriate button.

Fig. 84: Color Selection dialog

Parameter

Description

Weight

Sets the weighting of one channel to another channel. This is only
possible with multi-channel recordings.

Color

Here you can choose the desired color from a default color chart. The
selected color is displayed on the color button.

LUT

LUT = Look-Up Table
Here you can choose the desired color from a more complex color
look-up table.

Cust...

Cust = Custom
Here you can define an own color and assign it to a color field.

None

Assigns no color to the channel. Images of monochrome cameras are
black/white display. images of color cameras are displayed in real colors.
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13.5.3.2 Player Tab
Only visible if the Show All mode is activated.
Using the functions on this tab you can play back multidimensional images. The functions largely
correspond to the functions for playing back films.
Player Options
The following control elements are available:

Parameter

Play

Description
Plays back the image series forwards from first to last image. The dimensions are played back one after the other in the sequence specified.
Stops the play-back of the image series.

Stop

Play

Plays back the image series backwards from last to first image. The dimensions are played back one after the other in the sequence specified.
Plays back the image series forwards and backwards alternately.

Play alternately
Jumps to the start of the image series.
Jump to first
Jumps to the end of the image series.
Jump to last

Parameter

Description

Speed (FPS)

Here you can adjust the speed at which an image series is played
back.
The speed is displayed in frames per second (FPS) in the input field.
You can also enter the desired speed directly in the input field. The
maximum play-back speed is 25 FPS.

Follow Acquisition

Activated: Always displays the last acquired image during an ongoing acquisition procedure, as well as the slider for the corresponding
dimension.

Dimensions

Depending on the available dimensionsin the active image a slider is
displayed here for each dimension. Possible sliders:
§ Z-Stack
§ Time
§ Scene
§ Block
The sliders have each two adjustment handles, which you can use to
define the start and end point of the playback.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

893

13 Software Functions & Reference | 13.5 Image views

Parameter
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Description
If there are several dimensions, you can determine, by activating the
corresponding checkbox, if you want the dimension to be taken into
account during the play-back.
Each slider offers as many steps as there are individual positions in the
specified dimension.
A third adjustment handle indicates the current position and cannot
be controlled directly.

13.5.3.3 Graphics Tab
Here you can select various tools and use these to draw graphic elements into your images. In the
list you see the graphic elements that you have drawn in to the image.
Global Graphics In general there are two classes of graphic elements: global and custom. Each global graphic element has a set of properties such as style or type of measurement values displayed, which can be
changed system wide for each element. Each global element can only have one formatting style
which is used every time, this element is being used. All graphic elements can be accessed
through the Graphics menu, a selection of the most important tools is also available in the
Graphics view options tab for quick access (see image below). The content of the Graphics tab
cannot be modified however.
Custom Graphics Custom graphic elements are available in the Custom Graphics tab. Here it is possible to configure a collection of graphical elements according to personal preference. It is also possible to create multiple copies of the same tool type with different formatting styles and measurement values
which is not possible for global graphic elements. For more information, see Custom Graphics Tab
[} 901].

Info
Graphic elements are characterized by their formatting style, can be annotated with a free text
and can contain measurement values such as geometric or gray value measurements. Add free
text by double clicking any graphic element and typing in the desired text.
Note: You can select the graphical elements and modify them. For more information, see Editing
graphical elements and measurements [} 899].
A selection of global graphic elements to work with are available to you here. For more tools,
open the Graphics [} 620] menu.

Parameter

Select

Clone

Description
Use this to select the graphic elements in the image area. If you are
currently in another mode, you can switch back to the Selection mode
using this button.
Use this to create an identical copy of the last graphic element drawn
in by simply clicking anywhere into the image area. To exit this mode,
either switch back to the Selection mode or press the ESC key.
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Description
Use this to draw in a Region of Interest (ROI) into the image.

Draw Region of Interest

Draw Text

Insert Scale Bar

ROI’s are only used to create subsets of images, not for annotation of
images. To create a subset, hold the Ctrl key pressed and move the
mouse cursor within the ROI. Then press the left mouse key and wile
keeping it pressed down drag the mouse outside the ROI. A new subset image document only containing the pixels within the ROI but
with all other dimensions is being created.
Use this to insert a text field into the image. With the field drawn in
start typing to add text.
Automatically inserts a scale bar into the bottom right corner of the
image.
The size is set automatically to approximately 5% of the width of the
image size. The length can be modified by selecting the scale bar in
the image and changing the length.
Use this to draw in an arrow.

Draw Arrow

Draw Rectangle

Draw Circle

Draw Spline Contour

Format

Use this to draw in a rectangle that is always parallel to the edges of
the image. This element by default also shows the mean gray level of
the image region.
Use this to draw in a circle. This element by default also shows the
mean gray level of the image region.
Use this to draw in a freely selectable contour. You can either define
the corner points by a series of clicks or you can trace a contour by
keeping the left mouse key pressed. Close this contour by right-clicking. Corners are always rounded with this tool. This element by default also shows the mean gray level of the image region.
Only active, if you have selected a graphical element in the image or
the Annotations/Measurements list.
Opens the Format Graphic Elements dialog [} 898]. There you can
format the selected graphic element according to your preference.
Alternatively you can double-click on the list entry or right click on the
graphical element in the image and select the Format entry.

Relative Time

Acquisition Time

Relative Focus

Focus Position

Adds a text box to the top left of the image with information on the
relative acquisition time per channel. Relative means, that the time
value is set to 0 at the time point, where the element is drawn in. This
makes it easier to analyze time series images.
Adds a text box to the top left of the image with information on the
absolute acquisition time per channel.
Adds a text box with information about the relative focus position.
Relative means, that the focus value is set to 0 at the z-plane the element is drawn into. This makes it easier to interpret focus changes
when playing through the image dimensions.
Adds a text box with information about the absolute focus position as
recorded from the focus drive of the microscope.
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Parameter

Exposure Time
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Description
Adds a text box with information about the exposure time used by
the camera given in the format „00.000“ [ss.msec].
Adds a text box with the names of all the active channels.

Multi Channel
Name

Carrier Container
Name

Adds a text box with information on the carrier container name. This
is only useful for images acquired from multiple scenes using the Tiles
module. Examples are multiwell plates. With this annotation an image
can be related to the well it came from.

Keep Tool

Activated: Keeps the selected tool active. This allows you to draw in
a number of the same elements one after the other.

Auto Color

This parameter is only visible if Show All is activated.
Activated: Uses a new color for each element drawn in.

Snap to Pixel

This parameter is only visible if Show All is activated.
Activated: Draws in the graphic elements in a way that connects
them to the image pixels. If image-pixel precise measurements shall
be done, this option must be used.
If this option is not active, the graphic elements are drawn into the
graphics layer independently of the actual image pixels.

Layers
Only visible if the Show All mode is activated.
Here you can specify which graphic element layers are active and visible in the image. To open the
shortcut menu, click on the Layers dropdown menu.

Parameter

Description

Active Layer

Here you can specify which graphics layer is active in the image. The
other layers are visible but blocked. To activate a layer click on the
menu entry.

-

automatic

Sets the active layer automatically. This is the default setting.

-

Selection

Sets the Selection layer as the active layer. This layer contains graphic
elements such as ROI selection, Grid, etc.

-

Annotations/
Measurements

Sets the Annotation/Measurement layer as the active layer. This layer
contains most of the graphic elements which can be drawn in such as
all annotation elements or interactive measurement tools.

-

Acquisition

Acquisition elements are elements which have been used in experiments to specify acquisition ROI’s or photomanipulation ROI’s such as
used for FRAP experiments.

Layers

-

Selection

Here you can specify which layer is visible in the image. The other layers are not visible.
Displays the Selection layer in the image.
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Parameter
-

Annotations/
Measurements

ZEISS

Description
Displays the Annotation/Measurement layer in the image.

Table
Here you can see almost all the graphic elements that exist in your image. You can also control
the behavior of the graphic elements here, e.g. lock or hide them. You can format each graphic
element as you wish.

Info
In the list you will only see the graphic elements relating to the active graphics plane. To
change the active graphics plane, click on the Layers button. This button is only visible in
Show All mode. Select the layer that you want to display under Active Layer.
The columns of the list contain the following entries:

Parameter

Description
Shows or hides a graphic element.

Visibility
Locks a graphic element to prevent changes being made.
Fix Position
Type

Displays the icon for the tool type. To format a graphic element, double-click on the icon. The Format Graphic Elements dialog then opens.

ID

The parameter is only visible if Show All is activated.
Displays the ID for the graphic element. To do this, activate the
checkbox at the corresponding list entry. Note that each graphic element has its unique ID.

A

The parameter is only visible if Show All is activated.
Displays Annotations for a graphic element. To do this, activate the
checkbox at the corresponding list entry. „Annotations“ refers to all
user defined text as well as text from frequent annotations.

M

The parameter is only visible if Show All is activated.
Displays Measurement data for a graphic element. To do this, activate the checkbox at the corresponding list entry.

Name

Displays the name of the graphic element. To change the name, double-click in the Name field. Then enter the text of your choice. This
can be used to label elements in your image.
Saves the selected graphic element for reusing it with other images.

Save
Loads an existing graphic element into the current image.
Load
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Description
Deletes the selected graphic element.

Delete
Dimension
The coordinates and dimensions of the selected graphic element are displayed in the corresponding input fields (standard unit = image pixels):

Parameter

Description

Scaled µm

Activated: The dimensions are shown in scaled unit.

X

Displays the X coordinate of the center point of a graphic element.
Edit the X coordinate here.

Y

Displays the Y coordinate of the center point of a graphic element.
Edit the Y coordinate here.

W

Displays the width of graphic elements.
Change the width here.

H

Displays the height of graphic elements.
Change the height here.

Angle

Displays the angle of rotation of graphic elements. Here the measured
angle is displayed for the graphic element Angle.
Change the angle here.

See also
2 Adding Annotations to Images or Movies [} 61]
13.5.3.3.1 Format Graphical Elements Dialog
This dialog can be called up via the menu Graphics |Format or via the Graphics view option tab.
Note that for the Draw Region of Interest function, a reduced amount of functionalities is available.

Parameter

Description

Zoom with image

If activated, the size of the graphic element (e.g. line width, given in
nr. of pixels) is related to the pixel size in the image. Therefore, when
zooming into the image, the line width increases in the same way as
the image pixels.
If deactivated, the size relates to the monitor pixel size. That means
when zooming into the image, the line width e.g. does not change.

Line

Here you change the line color, width and the line style (none, solid,
dashed and dotted).
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Parameter

Description

Text

Here you select the text font, color, size and style by selecting the appropriate options. Also select the desired horizontal and vertical alignment from the dropdown list.
Reading direction is only active for measurement annotations of the
Line element. One direction aligns the text annotation to the edge
of the image. Two directions aligns it parallel to the line itself.

Fill

Here you can adjust, if the background of the annotation should be
filled or not. Several filling options are available.

Opacity

Here you can adjust the degree of opacity of the graphic element in
percent. 100% makes the graphical element completely opaque (covering the underlying image pixels), while 0% makes it completely
transparent.

Annotation

Here you can change the selected annotation and add the unit.

Set as new global
default

If you click on this button the formatting style of the graphic elements
currently selected in the image is set to the new default.

Reset

If you click on this button the formatting style of the currently selected graphic element is reset to factory default.

See also
2 Graphics Tab [} 894]
2 Adding Annotations to Images or Movies [} 61]
13.5.3.3.2 Editing graphical elements and measurements
You can change the following properties of a graphical element or an interactive measurement:
§

Size and position of entire element.

§

Position of measurement result.

You can also copy, paste, and delete elements and for some tools you can change the orientation.
Moving an entire element / measurement
Prerequisite ü At least one element is visible in the Center Screen Area.
1. Select the element with the left mouse button and drag and drop it to the desired position.
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Resizing an entire element / measurement
Prerequisite ü At least one element is visible in the Center Screen Area.
1. Click on the respective element.
2. Drag the sides of the bounding box.

Copying / pasting an element:
Prerequisite ü At least one element is visible in the Center Screen Area.
1. Click on the respective element.
2. Press Ctrl+C to copy or Ctrl+V to paste the selected element. Alternatively, right-click the element and select Copy or Paste.
Rotating an entire element / measurement
Prerequisite ü At least one element is visible in the Center Screen Area.
1. Click on the respective element.
2. Select the node above the element wit the left mouse button and rotate it to the desired
position.
Deleting an entire element / measurement
Prerequisite ü At least one measurement is visible in the Center Screen Area.
1. Click on the respective element.
2. Press the Del key. Alternatively, right-click the element and select Delete
Moving the measurement result
To change the properties of the measurement result:
Prerequisite ü At least one measurement is visible in the Center Screen Area.
1. Select the node by the measurement result with the left mouse button and drag it to the
desired position. Note that the node can be hard to differentiate from the bounding box of
the element.
Abc

Abc
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13.5.3.4 Custom Graphics Tab
Only visible if the Show All mode is activated.
Here you can create your own preferred collection of graphic elements. You can add multiple instances of the same element but assign different formats or measurement values to them. Custom
graphics should not be confused with the standard graphic elements the formatting style of
which can only be changed globally (meaning one default style per element is used system wide).
When opened for the first time, no elements exist. Click Customize to add your own graphic elements.

Parameter

Select

Clone

Description
Use this to select the graphic elements in the image area. If you are
currently in another mode, you can switch back to the Selection mode
using this button.
Use this to create an identical copy of the last graphic element drawn
in by simply clicking anywhere into the image area. To exit this mode,
either switch back to the Selection mode or press the ESC key.

Customize

Opens the Customize Tools dialog. In this dialog you can add up to
35 graphic elements which are organized in up to 5 tool bars. You
can make changes to their formatting style and also define which
measurement values they should show.

Keep Tool

Activated: Keeps the selected tool active. This allows you to draw in
a number of the same elements one after the other.

Auto Color

This parameter is only visible if Show All is activated.
Activated: Uses a new color for each element drawn in.

13.5.3.4.1 Customize Tools Dialog
This dialog is called up via the Custom Graphics view option tab.

Parameter

Description

User Toolbar

This list shows all custom graphic elements added to the Custom
Graphics tab. Select a tool and double click on it’s icon to open the
Format New Custom Graphic Tool dialog, see here [} 898].
You can rearrange the order of elements by using the Up or Down
arrows at the bottom edge of the list. To delete a selected element
use the Delete icon at the bottom edge of the list.

Search

Type in text to search for specific graphical elements.

Tools

This list contains all graphical elements available. If you select an element and double click on it, it will be added as a new entry to the top
row of the User Toolbar list. Alternatively the Button with the Plus
symbol at the bottom edge of the list can be used.
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Parameter

Description

Frequent Annotations

This list contains all frequent annotations available. Frequent annotations are aligned rectangle elements preconfigured to show image
metadata such as acquisition time or focus position used during acquisition.
If you select an element and double click on it, it will be added as a
new entry to the top row of the User Toolbar list. When finished,
click the Close button. The newly added elements are now shown in
the Custom Graphics tab.

13.5.3.5 Display Tab
Here you can adjust the image display. This function is particularly important if you want to display images with a very high dynamic range on the screen.
The histogram shows the brightness distribution of the pixels that are present from all channels simultaneously. The y-axis represents the relative frequency and the x-axis indicates the brightness.
A curve showing the corresponding distribution, the so-called display characteristic curve, is displayed for each channel.

Fig. 85: Display tab (Show All)
If you want to adjust the histogram for an individual channel, activate this via the relevant color
field in the Channel Selection. Alternatively you can also click on the corresponding distribution
curve directly in the histogram.
Display characteristic curve
Each channel has a display characteristic curve. Using the display characteristic curve you can set
the limit for the black value (left) and the limit for the white value (right). This allows you to influence the contrast in the image. Move the mouse pointer over the corresponding adjustment handles at the bottom edge of the display histogram or to the small rectangles on the display characteristic curve. Hold down the left mouse button and move the adjustment handles or rectangles
as required.
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The curvature of the display characteristic curve influences the gamma value. To change the curvature, move the mouse pointer to the second or fourth small rectangle on the display characteristic curve. Hold down the left mouse button and move the rectangles up or down. The setting is
used immediately for the display. Using the middle rectangle you can move the whole display
curve. This changes the brightness of the image.
Note that some of the functionality is only visible if the Show All mode is activated!

Parameter

Description
Only visible for multichannel images.

Channel Selection

Here you can select for which channel you want to adjust the display
on the screen. To select all channels, click on the All button. To select
a certain channel, click on the corresponding channel field. Hovering
the mouse pointer over a color field displays the relevant channel
name.
If the image consists of more than 29 channels, a scrollbar will be displayed which you can use to switch to the desired channel.

Spline Mode

Clicking on this button allows you to add up to 8 points to the display characteristic curve.
You can then bend the curve around these points. To do this, click on
the desired section of the display curve and move it as required. Clicking on the display curve again adds another point.
You can delete points by moving them along the display curve until
they lie on top of another point. In this way, even in difficult situations you can adjust the display curve so that all important image regions can be displayed well.

Auto

The automatic adjustment is not available during the acquisition of
LSM experiments.
Adjusts the image display automatically.
This is particularly useful in the case of a live image, in Continuous
mode or if you play back a time series image that contains changing
brightness.

Min/Max

Adjusts the display characteristic curve so that the darkest pixel is
black and the brightest pixel is white in the display. Note that this
function makes an approximation to get a quick result! For detailed
information about minimum and maximum values refer to measurements conducted in the Histo view.

Best Fit

Adjusts the display characteristic curve so that 0.1% of the darkest
pixels contained in the image are black and 0.1% of the brightest pixels are white in the display.

Input fields

With the two input fields to the right of the BestFit button you can
adjust the black/white values from 0.1% to values from 0 to 90% according to your requirements.

Dimension Selection

If your images contain time series, z-stacks or both, you can here select the aspect of an image for which the display settings should be
applied.
Note that with all settings other than Current there may be several
seconds of calculation time until the setting is applied, depending on
the number of time points/ z-planes.
The following options are available:
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Description

-

Current

Adjusts the display for the current image and keeps this setting for all
other time points or Z-planes.

-

All T

Collects the intensity values from all time points and adjusts the display according to the brightest and darkest pixels within the entire
time series.

-

All Z

Collects the intensity values from all Z-planes and adjusts the display
according to the brightest and darkest pixels within the entire Z-stack.

-

All T+Z

Collects the intensity values from all Z-planes and time points and adjusts the display according to the brightest and darkest pixels within
the entire Z+T series.

Options

Here you can copy display settings to the clipboard, insert them into
other images from there or save and reload settings. This allows you
to apply identical display settings to several images in order to produce comparable display conditions.

Reset

Resets all parameters to the default values.

Black

Displays the gray value currently set up to which all pixels are shown
as black. You can also enter a certain value here.

Gamma

Displays the gamma value currently set. You can also enter a certain
value here.

0.45

Sets a gamma value of 0.45. This is the recommended setting for
most color images.

1.0

Sets a linear display characteristic curve with a gamma value of 1.0.

White

Displays the gray value currently set from which all pixels are shown
as white. You can also enter a certain value here.

13.5.3.6 PSF tab
In most image views you will see the PSF Display tab as soon as a PSF image has been loaded.
PSF images differ from the data types of normal images. They are saved, for example, in the highprecision floating point format. A series of important values that allow conclusions to be drawn
about the microscope system and sample conditions can also be read from PSF images.
Export PSF button
Generates a new PSF document in 16 bit gray level format, which can be processed as required to
allow it to be used in other programs.
Display Mode settings
Choose between three display options from the dropdown list:
§

Intensity PSF: The PSF is displayed in the position space, gray values are displayed in floating
point format.

§

Intensity OTF: The optical transfer function (OTF) displays the 3D PSF in the frequency space
following a 3D Fourier transformation. Gray values are displayed in floating point format.

§

Intensity Slice OTF: Displays the 2D Fourier transformation of each individual Z-plane.
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Axial cut view checkbox
Activated: Displays the PSF in axial section view.
Deactivated: A slider for Z appears on the Dimensions tab. This allows you to move through the
various Z-planes.
List of PSF values
A series of important values relating to the PSF are displayed here in a table:
§

Storage type: Format in which the PSF is saved

§

Source: Shows whether the PSF has been generated by measuring a bead stack (External) or
from the theoretical calculation (Internal).

§

Used Dimensions: shows whether the PSF is 3D or 2D.

§

Instrument: shows the type of microscope used.

§

Illumination: shows the illumination conditions that applied.

§

NA Objective: Numerical aperture of the objective

§

Lateral Magnification: shows the objective magnification.

§

Working Distance: shows the working distance of the objective.

§

Illumination Wavelength: shows the wavelength of the excitation light; in the case of multichannel PSFs the values for all channels are shown here.

§

Detection Wavelength: shows the wavelength of the detected emission light; in the case of
multichannel PSFs the values for all channels are shown here.

§

Transverse Resolution (Rayleigh): shows the actual lateral resolution achieved according to
Rayleigh; in the case of multichannel PSFs the values for all channels are shown here.

§

Axial Resolution: shows the actual axial resolution achieved, determined according to Full
Width Half Maximum (FWHM); in the case of multichannel PSFs the values for all channels are
shown here.

Info
Please note that the resolution values for measured PSFs show the performance of the entire
system, consisting of all optical and electronic components. The sample, with its optical properties and possible aberrations, therefore has a significant impact on the resolution. This means
that these values are not suitable for making statements about the quality of the objective.

13.5.3.7 ApoTome tab
Here you have various settings for displaying an ApoTome image.

Parameter

Description

Display Mode

ApoTome images are acquired as raw data. The Display Mode sets
how the image is calculated and displayed.

–

Optical sectioning

The displayed image is calculated/rendered by eliminating the excitation and emission light that originates in regions outside of the focal
plane.

–

Conventional
fluorescence

The displayed image is calculated/rendered like a conventional fluorescence image.
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Parameter

Description

–

Displays the raw data as output image and disables all other parameters of the function.
Displays the Phases slider on the Dimensions tab. This enables you
to select the various phases of the raw images.

Raw Data

Normalization

Activated: The resulting images always fill the entire 16 bit dynamic
range of the image histogram, see normalization .

Enable Correction

Activated: Displays the Correction dropdown list for stripe artifact
correction.

Correction

Only visible if Enable Correction is activated.
Applies stripe artifact correction to the resulting image. It attempts to
remove stripe artifacts which may be caused by bleaching of the
sample during acquisition or by slight deviations in the grid phase position.

–

Phase Errors

Corrects phase errors in the image without additional bleaching correction.

–

Local Bleaching

Corrects the bleaching for each pixel individually (default setting). This
is usually the best method.

–

Global Bleaching

Corrects bleaching by means of global bleaching correction, which is
applied equally to the entire image.

Phase Correction

Only visible if Enable Correction is activated and if you have selected
one of the two bleaching corrections for Correction.
Activated: Performs a correction of any phase deviations present in
addition to the selected bleaching correction.

Fourier Filter

The Fourier filter attempts to remove residual stripes.

–

Off

Uses no Fourier filter to remove stripes.

–

Weak

Uses a weak Fourier filter to remove stripes.

–

Medium

Uses a medium Fourier filter to remove stripes.

–

Strong

Uses a strong Fourier filter to remove stripes.

Grid

Displays the grid frequency used for the image in lines/mm.

Deconvolution

Activated: Displays key parameters for ApoTome deconvolution. Deconvolution benefits from the presence of a CUDA enabled NVIDIA
graphic card by speeding up the processing.

Aberration Correction

Only visible if Deconvolution is activated.
Activated: Displays parameters for aberration correction.

–

Refractive Index
Embedding

Sets the refractive index of the used embedding medium .

–

Distance to
Coverslip

Sets the distance of the acquired structure from the side of the cover
slip facing the embedding medium.
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Parameter

Description

Set Strength Manually

Only visible if Deconvolution is activated.
Activated: Sets the degree of restoration with the slider. To achieve
strong image restoration, move the slider towards Strong. To achieve
less image restoration, move the slider towards Weak.
Note: If the setting is too strong, image noise may be intensified and
other artifacts, such as "ringing", may appear.
Deactivated: The restoration strength for optimum image quality is
determined automatically.
The restoration strength is inversely proportional to the strength of
so-called regularization. This is determined automatically with the
help of Generalized Cross Validation (GCV).

Apply Deconvolution

Only visible if Deconvolution is activated.
Applies the deconvolution to the ApoTome image. The result is displayed directly without a new document being created. To create a
separate document, click on the Create Image button.

Create Image

Creates a new image document. The available settings are taken into
consideration here.

13.5.3.8 Airyscan tab
During acquisition of Airyscan 2 Multiplex mode images, the result can be displayed and controlled for correct acquisition quality with the Airyscan tab. Note: If you use multi-immersion objectives, the immersion medium needs to be indicated with the MTB software to allow for correct
processing of Airyscan images.

Parameter

Description

Display Mode

–

Preview

You can see a more instantaneous refresh especially during continuous scan. This allows best control of focus and stage positions.

–

SR

Shows a processing preview which displays a true super resolution
processing of the current image content.

Super Resolution

Modifies the processing strength.

Auto Filter

Sets the processing strength automatically.
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Parameter

Description

Process

In the drop down list you can select the image(s) and dimension you
want to save. Available options:
§ Current Image (2D)
§ Current Image (3D)
§ All Images (2D)

Create Processed
Image(s)

Processes the active images and saves them.

13.6 View Modes
13.6.1 Full Screen mode
In this mode the image will be displayed in the full monitor size.
To start the full screen mode, position the cursor on the image area and open the context menu
via right mouse click. Click on Full Screen. You can also press F11 or click on menu Window |
Full screen as an alternative.
Toolbar
In the toolbar at the bottom you find several buttons for general and image specific functions, like
zoom function (Zoom button) or image informations (Info button). When you open a multidimensional image, you find buttons for specific functions, etc. Z-Stack, Channels. To open the
functions, click on the button.
Previous button
Displays the previous document in full screen mode. You can page step by step backwards
through all open documents.
Next button
Displays the next document in full screen mode. You can page step by step forwards through all
open documents.
Exit Fullscr. button
Closes the full screen mode.
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13.6.2 Exposé mode

Fig. 86: Exposé mode
To open the Exposé mode click on the expose mode icon in the document bar [} 22].
In this mode all open documents will be displayed in an overview. When you click on an image in
the overview the Exposé mode will be closed and the image will be displayed in standard view.
Click on Back to go back to the standard image view.

13.6.3 Splitter mode
To open the Splitter mode click on the splitter mode icon in the document bar [} 22].
In this mode you can generate a multi image of one or several images in order to compare them.
Drag an image of the Images and Documents gallery in Right Tool Area and drop it in a splitter position. The standard setting for the splitter are 2 columns and 1 row. You can modify these
setting in the Split-View.
Proceed similarly with further images to be displayed in the multi image. The same image can be
dropped several times in the splitter view, i.e. to compare different image scenes.
The multi image can be saved as CZSPL (Zeiss Multi Image Files) image type in the menu File >
Save As. The stored multi image is no image document, but rather a reference of the images displayed in the splitter mode.
Use the Split Display tab for further adjustments (i.e. arrangement) of the splitter mode. Here
you can create a single image of the multi image to be saved as CZI image file.
13.6.3.1 Split Display Tab
Arrangement section
Here you can set how much columns and rows the splitter image should have. Therefore simply
enter the desired number in the Columns / Rows input fields.

Parameter

Description

Arrangement
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Description

–

Columns

Sets the number of columns displayed in the splitter view mode.

–

Rows

Sets the number of rows displayed in the splitter view mode.

Synchronize Dimensions

Activated: The settings of the Dimensions tab (i.e. Zoom) will be applied synchronously to all images in splitter mode.

Synchronize Display

Activated: The settings of the Display tab (i.e. Gamma) will be applied synchronously to all images in splitter mode.

Show Position
Data

Activated: The cursor changes to an arrow symbol and a cross
marker in the image. The X/Ycoordinates with scaling unit and gray
value of the current cursor position are displayed below the image.
Furthermore additional information is displayed for multidimensional
images: i.e. the gray value for each channel of a multichannel image, the time of each time point of a time lapse image, the focus
position of each Z position of a Z-Stack.

Reset

By clicking on this button you can reset all adjustments applied to the
images in splitter view.

New Image From

Here you can select the type of image to be generated. The available
options are depending on the dimensions of the displayed image.

-

Current View

Creates a 2-dimensional image of all opened images visible in the
splitter mode.

-

Time Series

Creates a multi-dimensional image containing each time point of a
time series image.

-

Z-Stack

Creates a multi-dimensional image containing each Z-plane of a Zstack image.

-

Rotation

Creates a multi-dimensional image containing each rotation plane of a
rotation series image.

Create

Generates an single image of the multi image displayed in splitter
mode with the corresponding settings. The image can be saved in the
*.CZI format in File > Save as menu.

Interpolation for
zoomed images

Only visible if the Show All mode is activated.
Here you can select how you want interpolation to be performed if a
pixel is calculated from several individual pixels.

-

Nearest Neighbor

The output pixel is given the gray value of the input pixel that is closest to it.

-

Linear

The output pixel is given the gray value resulting from the linear combination of the input pixels closest to it.

-

Cubic

The output pixel is given the gray value resulting from a polynomial
function of the input pixels closest to it.

Spacing

Only visible if the Show All mode is activated.
Here you can adapt the size of the distance between the single images to values 0 up to 20. The background (distance) will be displayed
in black color and appears, if the splitter image is generated by the
Create button.
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Parameter

Description

Spacing color

Only visible if the Show All mode is activated.

ZEISS

Here you can change the background color of the splitter image.
Burn-in annotations

Only visible if the Show All mode is activated.
Activated: All existing annotations and graphical elements within the
images will be burned into the resulting splitter image.

13.7 File Browser
Here you see an overview of all image or data files stored on your computer. In the left column
you see a file structure which is associated with the common image or data containing folders in
your file system (Images and documents). In the right area you see the preview to the selected
folder.

Info
The ZEN folders contain automatically the Auto Save folder. Here you see all auto-saved images from ZEN. Set Auto Save path in Tools | Options | Saving.
Gallery View
Here you see all files of a folder as small preview images (thumbnails). Use Tool tab to adjust preview images size, sorting, etc..
Info View
Here you see a detailed list with all data the selected image contains. Find a detailed description
of all possible data under Info View [} 825].
Table View
Here you see all files of a folder well-arranged in a table. This view is perfect for folders which
contain many files.

13.7.1 Tools Tab
Parameter

Description

Icon size

Set size of thumbnail images here.

Text Rows

Select entries which you want to have displayed as additional text row
under the thumbnail image.

Record

Switch from file to file in the selected folder by using the slider.

Sorting

Arrange your files to certain properties (i.e. file name, type, etc.)

Folders

Manage selected file folders here (i.e. new folder, rename folder,
etc.).

Selection

Manage selected files here (i.e. copy file, or delete file).
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14 Systems, Applications & Components
14.1 LSM 980
14.1.1 Polarization Imaging
Linear (plane) polarized light, which is light whose wave goes only one direction, exciting a fluorescent molecule with a preferred dipole orientation results in polarized emitted light. It provides a
contrast-enhancing method that is especially useful in the study of molecules that are fixed in
their orientation or are greatly restricted in their rotational diffusion. Anisotropy is directly related
to polarization and is defined as the ratio of the polarized light component intensity to the total
light intensity.
In polarization microscopy using LSM systems the sample is irradiated with vertical polarized light
(in respect to the optical table) from a laser source. The emitted fluorescence is passed sequentially through emission polarizers (analyzers) that are positioned before the Quasar detector. They
transmit either the vertical (IVV) or horizontal (IVH) polarized emitted light onto the Quasar detector
(L format fluorescence polarization). Since the vertical component of the emission light is parallel
polarized to the vertical polarized excitation light, it is often also referred to as the parallel component (P Pol, Ip, I||). Likewise, the horizontal polarized emission light is also designated as the perpendicular ("senkrecht" in German) component (S Pol, IS, I|). In the software the "p" and "s" designations are used.
Polarization P and anisotropy Polarisation P and anisotropy r are defined as: are defined as:

and

with 0 ≤ r ≤ 1.

They can be interconverted to each other in the following way:

and
In a completely polarized sample (IS = 0) the anisotropy r = 1. In a completely non-polarized sample (Is = Ip) anisotropy r = 0.
The formulas for polarization P and anisotropy r as given above are strictly true only, if the optical
transmission for both emission polarizers are identical. Any differences must be corrected by introducing a correction factor G that is multiplied with Ip. Hence the anisotropy r in such a case is calculated according to:

G can be measured using horizontally polarized excitation light and is defined as

However, since in LSM systems the polarization of the excitation light can not be changed from
vertical to horizontal, G has to be determined with an isotropic fluorescent dye solution as the ratio between the mean intensities Ip and Is, e.g. obtained from the histogram view.
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Info
Please note that the G factor is not the mean intensity of the ratio calculation (R), where every
pixel is computed separately. It has to be calculated from the ratio of the mean intensities of
the Ip and Is images.
As the formulas implies:
Anisotropy r is the preferred display as anisotropy of single species is additive. The calculation of r
can be done using ratio formulas located in the MeanRoi View.
14.1.1.1 Setting up Polarization Imaging
Prerequisite ü S and P Pol filters are part of the system configuration.
1. Set up a multitrack configuration using exactly the same settings with the exception of the
Pol Anisotropy filters.
2. Click the Pol Anisotropy filter wheel located under the channel selection list.
à This opens up the Pol Anisotropy selection panel.
3. Check the anisotropy filter you want to use for Track 1.
4. Switch to Track 2. Select the anisotropy filter you want to use for Track 2.
5. The options are Pol Anisotropy P Filter (for the parallel polarized light transmission) and
Pol Anisotropy S Filter (for vertical polarized light transmission) (see picture).

Info
If you want to calculate Anisotropy using the ratio imaging formulas provided by ZEN, then
choose P for Track 1 and S for Track 2.
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14.1.1.2 Determining the G Factor
Prerequisite ü Isotropic sample like a fluorescent dye at a 1 mM concentration, for example fluorescein.
ü Multitrack image acquisition set as described above (Imaging Set up for Polarization Imaging)
with excitation laser and detection beam path set for imaging the isotropic dye sample.
ü Excitation laser intensity and detector gain set to get a well balanced image without overexposed pixels.
ü Pol Anisotropy P Filter selected for Track 1 and Pol Anisotropy P Filter selected for
Track 2.
1. Acquire a time series multitrack image with the image in Track 1 showing the emission signal filtered by the P Anisotropy filter and the image in Track 2 showing the emission signal
filtered by the S Anisotropy filter.
2. Open MeanRoi View .
3. Open Ratio action tab.

4.
5.
6.
7.
8.

Activate Enable Ratio Calculation.
Chose Dual Wavelength as method for ratio calculation.
Set factor to 1,00.
Draw a (large) region into the image for analysis.
Activate Image and Chart with Table in the Layout action tab.

à The G factor is shown as mean intensity value of the Ratio_R1 channel in the intensity
chart.
The G-factor is therefore defined as:
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14.1.1.3 Obtaining an Anisotropy Image
1. Set up a multitrack configuration with alternating analyzers: P in Track 1, S in Track 2, leaving all other imaging settings as when obtaining the image series for determining the G factor.
2. Acquire a time series.
3. In MeanROI View choose the Ratio Type 3 formula in the Ratio tab.

4. Set Background Correction to Constant.
5. Type in the value of the G Factor (as “Background Correction) as a multiplier into the nominator and 2x G Factor as (as a “Background” Correction) into the denominator. With Ch1T1 and Ch1-T2 corresponding to IP and Is this formula corresponds to the formula for anisotropy r.
6. Adjust multiplier and add value as fit to get a good image representation.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

915

14 Systems, Applications & Components | 14.1 LSM 980

ZEISS

7. Alternatively, open Processing | Method | Image calculator.
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8. Use source 1 (S1) being the P track image (Ch1 T1) and source 2 (S2) the S track image
(Ch1 T2) with consideration of the G factor in Parameters.

14.1.2 FCS (Fluorescence Correlation Spectroscopy)
FCS (FCS) records temporal changes in the fluorescence emission intensity caused by single fluorophores passing the detection volume. It provides quantitative localized measurements of physical parameters including mechanisms of transport, molecular mobility, and densities of fluorescently labeled molecules based on temporal fluctuations which are detected via their emission signal intensity. In the most basic configuration, FCS examines the inherent correlations exhibited by
the fluctuating fluorescent signal from labeled molecules as they transit into and out of a specified
excitation volume. The most easily observed change in intensity is the fluctuation of the concentration of fluorescent molecules. The temporal auto-correlation of the recorded signal intensity
provides a quantitative measurement of the strength and duration of the intensity changes. These
parameters are used to calculate the average number of molecules and their average diffusion
time through the excitation volume. From this, further parameters can be deduced like concentration and size (shape) of the molecule. The dual-color variation, termed Fluorescence Cross-Correlation Spectroscopy (FCCS), is utilized to probe two species labeled with different fluorophores.
FCCS can extend investigations to the examination of biochemical reactions between two partners, such as reaction rates, kinetics, fractions of binding or reacting molecules, and mobilities of
a complex formed between the partners.
For successful FCS measurements both, the used hardware and the sample must meet certain
standards. FCS-based-techniques measure fluctuations caused by single molecules within a small
volume of typically less than a femtoliter which needs to be precisely defined. Hence a high-end
objective paired with highly sensitive detectors and a low noise highly stable laser source is a prerequisite. Especially for FCCS measurements color shift effects of optical elements have a negative
impact onto the results. Hence one must keep the measurement spot on the optical axis/center of
the scan field when FCCS data are acquired. The stage rather than the scanner need to be used to
position the measurement spot in the very center of the scan field.
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FCS measurements need a single photon counting detector and a laser wavelength suitable for
fluorophore excitation. FCCS measurements are typically performed observing two fluorophores
excited with different wavelengths and using two counting detectors.
LSM 980 provides several detectors which can be operated in counting mode and hence can be
used for FCS and FCCS measurements.
The most basic configuration includes two counting capable channels, more advanced systems
provide 5 or even 7 counting capable channels. In addition, BiG.2, an external detection unit
which can be mounted onto the scan head of each of these configurations, can be used for FCS
and FCCS.
FCS and FCCS measurements are either performed using dissolved molecules/dyes or using cultured cells observing low to medium abundant proteins (few pM up to µM) at endogenous expression levels.
For successful measurements the preparation of the sample must meet some prerequisites.
When analyzing labeled molecules in solution the labeled molecule/dye should be dissolved in a
water/buffer solution and diluted such that the concentration is between 1-50 nM. After dilution,
the solution must be put into a chamber with a # 1.5 cover-glass bottom. The glass bottom thickness/quality is influencing the measurement which relies on a precisely defined focal spot. Make
sure to put enough media to cover the entire bottom of the chamber. Common dyes used for this
kind of experiment are for example any kind of Alexa Fluor® dye.
For cultured cells the endogenous expression of fluorescently labeled proteins is best achieved using modern genome editing techniques. This keeps the expression level low enough for successful
FCS and FCCS measurements.
14.1.2.1 Overview Acquisition Tools
Imaging Setup

Fig. 87: Imaging Setup tool, FCS track selection
Within the Imaging Setup tool select +LSM FCS from the track selection drop down list to set up
and activate a FCS track. Only with an active FCS track, the FCS specific acquisition tools will be
displayed.
Main Action Buttons

Parameter

Description

Continuous

Opens a new FCS document and starts a continuos FCS measurement
according to the settings defined in the Channels Tool.
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Parameter

Description

Snap

Starts the FCS measurement according to the settings defined in
Channels Tool and Experiment Regions. Snap performs a FCS data
acquisition at the center of the scan field or at all FCS spots defined
and activated in Experiment Regions.

Channels Tool
For description of the parameters in the Channels tool, see Channels Tool - Measurement Settings [} 920].
Right Tool Area

Parameter

Description

Detector Counting
Tool

Shows counts per second (Count), correlation amplitudes (Correlate)
or counts per molecule (CPM). The values are updated whenever a
FCS acquisition is running. The values displayed can be averaged over
1, 3 or 10 seconds.

Experiment Region Tool

Parameter

Description

Draw FCS spot

Defines positions in xy (FCS spots) for FCS measurement using the
scanner for positioning.

Update Z

Allows to assign different Z positions to different FCS spots. Z-Focus
positions are only indicated and relevant for FCS spots, not for any
other experiment regions..

File Menu

Parameter

Description

New FCS Document

Opens a new FCS document in the Center Screen Area. Existing data
can be added to the new document by copy and paste or drag and
drop from stored documents to rearrange and combine data sets.

FCS Document View

Parameter

Description

Correlation view

Opens when data acquisition starts. It shows count rate and correlation graphs for all active acquisition channels.

Info

Shows selected information on the experiment.

Fit

Provides various tools for data fitting and display.
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14.1.2.1.1 Channels Tool - Measurement Settings

Parameter

Description

Measurement
Time

Here you can enter the period of one measurement.

Repetitions

Here you can enter the number of repetitions for one measurement.

Adjust

Opens the Adjust Pinhole wizard to perform an automatic count rate
versus pinhole position scan.

Z-scan

Opens the Z-Scan [} 921] wizard to perform a Z-scan ant plot the
count rate averaged value dependent on the Z position to find the optimal focus position.

Fit Model

Here you can select a fit model for fitting the data of the selected
channel after finishing the measurement.
A different fit model can be selected for each FCS/FCCS channel.

14.1.2.1.1.1 Adjust Pinhole Wizard

Info
In case two lasers and two detectors (for the visible light path) are defined, the plot shows
more curves, one for each laser/detector pair. Potential cross-talk effects can be excluded
when defining only one laser and detector for the adjustment procedure. The curves match
the color of the detector defined in the Imaging Setup or Channels tool.

Parameter

Description

Invisible light path

Only displayed if the laser with invisible light (405 nm or IR laser) is
defined for the acquisition.

–

Adjust X axis

Adjust the position of the pinhole on the X axis.

–

Adjust Y axis

Adjust the position of the pinhole on the Y axis .

–

Coarse
Moves the pinhole position in X or Y over the whole range while acquiring FCS data for each position. The count rate data are averaged,
fitted to match a gaussian curve and plotted against the pinhole position. The plot is displayed in the center area in the Calibration View
tab. It is possible to change between the view tabs during acquisition.

–

Fine
Moves the pinhole position in X or Y about 10 micrometer around the
currently stored value while acquiring FCS data for each position. The
count rate data are averaged, fitted to match a gaussian curve and
plotted against the pinhole position. The plot is displayed in the center area in the Calibration View tab. It is possible to change between the view tabs during acquisition.
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Description
Before the adjustment scan is started, the slider and the input box beneath the show the currently stored pinhole position in X and Y. The
sliders can be moved and the position edited once the scan has finished. This allows to move the positions to a different value than suggested by the system. The then indicated value will be stored when
clicking Finish to leave the wizard. The Pinhole position in the plot is
shown in micrometer. One micrometer corresponds to approximately
one motor step.

Visible light path

Only displayed if the laser with visible light ((lasers from 445 nm to
639 nm) is defined for the acquisition.

Cancel

Cancels the procedure and keeps the existing pinhole position.

Finish

Takes over the new pinhole position as general position also for all
other LSM acquisition functions.

14.1.2.1.1.2 Z-Scan Wizard
Z-Scan provides an automated procedure to optimize focus position for auto- or cross correlation
measurements. The Z-Scan provides the following parameters:

Parameter

Description

Current Position

Displays the current position. This position is changing during the actual scan procedure.

Center Position

Displays the Center Z Position of the defined range.

Range

Define the range of the Z-Scan by either typing in a value or using the
scroll arrows of the Range edit box.

Step Width

Define the step width by either typing a value or using the scroll arrows of the Step Width edit box.

Start

Perform the scan by pressing Start.
During the scan the count rate is plotted for the selected channels using the channel assigned colors.
Once the scan is complete a red bar is positioned at the Z position
with the maximum count rate. This position can be changed by moving the red bar, moving the slider beneath the Start button, typing in
a value into the edit box next to the slider, or using the scroll arrows.

Finish

Click Finish to take over this Z position for the FCS measurement.

Cancel

Click Cancel to discard the values and keep the original Z position

14.1.2.2 FCS Document View
This view contains three layers, which can be selected by clicking the corresponding tab:

Tab

Description

Correlation

Displays the count rate trace, the correlation function, the photon
counting histogram, the pulse density histogram, and the result table,
see Correlation Tab [} 922].
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Tab

Description

Fit

Displays the fit graph, the residuals, and the used model, see Fit Tab
[} 927].

Info

Displays the defined name, any typed in comment, and some of the
meta data, see Info Tab [} 932].

If you close an FCS document without saving, you will be asked in the Close image dialog, if you
want to save the data.
14.1.2.2.1 Correlation Tab

1

2

3

4

5

6

Fig. 88: Correlation tab

1

Count rate diagram [} 923]

2

Pulse distance histogram [} 923]

3

Correlation diagram [} 924]

4

Photon counting histogram (Pulse density histogram) [} 925]

5

Result table [} 926]

5

FCS view options [} 933]
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14.1.2.2.1.1 Count Rate Diagram
In the Count Rate diagram the count rate(s) (CR) in kHz is plotted vs. running time. If a cross
correlation set-up is used, the count rate trace for each channel is displayed.
Zoom into the diagram by pressing the left mouse button and drawing a rectangle of the area
you want to zoom in. After disengaging the button, the zoom image is displayed.
Clicking the right mouse button within the diagram opens the Count rate context menu.

Parameter

Description

Reset diagram
zoom

Resets to the original image size when zoomed in.

New cut region

When raw data files are available, define cut regions by choosing the
New cut region option. The cut region size can be adapted by two
sliders. The cut out region is thereby displayed as a matted box. Select
independent cut regions for different channels of a cross correlation
experiments. In cross-correlation calculations, a cut region in one
channel will automatically define the same cut region in the other
channel. You can select more cut regions by repeatedly choosing this
option. These regions may overlap.

Remove cut region

Removes the last cut region. By repeatedly choosing this option, the
cut regions in the reverse order of their creation will be removed.

Remove all cut regions

Removes all cut regions simultaneously.

Copy text to clip
board

Copies the diagram coordinates into the clipboard, from which they
can be pasted into other programs like Excel.

Write text to file

Stores the diagram coordinates in a .txt file. You are prompted to
choose a name and a folder before saving.

Copy graphics to
clip board

Generates an image of the graph with the legend text and color
coded graphs which can copied to standard windows documents.

Abscissa logarithmic

Displays the abscissa in a logarithmic scaling.

Ordinate logarithmic

Displays ordinate in a logarithmic scaling.

Line width

Allows to select the thickness of the graph. Six settings are possible.

The remaining parts of the count rate disrupted by cut out regions will
be separately correlated and the average will be calculated and displayed.

Tab. 1: Correlation view - Count Rate context menu
14.1.2.2.1.2 Pulse Distance Histogram
This diagram shows the frequency plotted against the times elapsed between two subsequent
pulses (or: photons recorded from the detector). To obtain this histogram, the time distance between two photons is evaluated using the raw data.
Zoom into the diagram by pressing the left mouse button and drawing a rectangle of the area
you want to zoom in. After disengaging the button, the zoomed area of the graph is displayed.
Clicking the right mouse button opens the Pulse Distance Histogram context menu:
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Parameter

Description

Reset diagram
zoom

Resets to the original image size when zoomed in.

Copy text to clip
board

Copies the diagram coordinates into the clipboard, from which they
can be pasted into other programs like Excel.

Write text to file

Stores the diagram coordinates in a .txt file. You are prompted to
choose a name and a folder before saving.

Copy graphics to
clip board

Generates an image of the graph with the legend text and color
coded graphs which can copied to standard windows documents.

Abscissa logarithmic

Displays the abscissa in a logarithmic scaling.

Ordinate logarithmic

Displays ordinate in a logarithmic scaling.

Line width

Allows to select the thickness of the graph. Six settings are possible.

Tab. 2: Correlation view - Pulse Distance Histogram context menu
14.1.2.2.1.3 Correlation G(τ) Diagram
The diagram shows the correlation functions for each activated channel.
Zoom into the diagram by pressing the left mouse button and drawing a rectangle of the area
you want to zoom in. After disengaging the button, the zoomed area of the graph is displayed.
Clicking the right mouse button within the diagram opens theCorrelation context menu:

Parameter

Description

Reset diagram
zoom

Resets to the original image size when zoomed in.

Copy text to clip
board

Copies the diagram coordinates into the clipboard, from which they
can be pasted into other programs like Excel.

Write text to file

Stores the diagram coordinates in a .txt file. You are prompted to
choose a name and a folder before saving.

Copy graphics to
clip board

Generates an image of the graph with the legend text and color
coded graphs which can copied to standard windows documents.

Abscissa logarithmic

Displays the abscissa in a logarithmic scaling.

Ordinate logarithmic

Displays ordinate in a logarithmic scaling.

Line width

Allows to select the thickness of the graph. Six settings are possible.
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Parameter

Description

Normalize

Is used to normalize the selected G(0) value corresponding to the
number of diffusing particles to 2, not the total correlation to which
also other processes like triplet state can contribute.
All other values (subtracted by 1) will than be multiplied by the correction factor defined by the ratio of 1 to [G(0)-1] and increased by 1,
hence G (τ)normalized=[1/ (G(0)-1) * (G(τ)-1)]+1. Deactivating Normalize
will display the normal correlation curve.
Normalization only works for fitted data as only then a G(0) value is
available.

Tab. 3: Correlation view - Correlation context menu
14.1.2.2.1.4 Photon Counting Histogram
This diagram (also called Photon Counting Histogram) shows the frequency plotted against the
photon number in a certain time bin. To obtain this histogram, the number of pulses (or: photons
recorded from the detector) in a moving time window are recorded and included in a histogram.
Determine the binning when loading a *.fcs file with raw data saved along with it using the
Reload button.
Zoom into the diagram by clicking+holding the left mouse button and drawing a rectangle of the
area you want to zoom in. If the button is disengaged, the zoomed area of the graph is displayed.
Clicking the right mouse button opens the Photon Counting Histogram context menu:

Parameter

Description

Reset diagram
zoom

Resets to the original image size when zoomed in.

Copy text to clip
board

Copies the diagram coordinates into the clipboard, from which they
can be pasted into other programs like Excel.

Write text to file

Stores the diagram coordinates in a .txt file. You are prompted to
choose a name and a folder before saving.

Copy graphics to
clip board

Generates an image of the graph with the legend text and color
coded graphs which can copied to standard windows documents.

Abscissa logarithmic

Displays the abscissa in a logarithmic scaling.

Ordinate logarithmic

Displays ordinate in a logarithmic scaling.

Line width

Allows to select the thickness of the graph. Six settings are possible.

Tab. 4: Correlation view - Photon Counting histogram context menu
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14.1.2.2.1.5 Result Table
The Result Table below the diagrams displays the measuring results. The width of the columns
can be changed by moving the border lines. The order of the columns can be changed. For this
purpose, click on the head line of the relevant column, hold down the mouse button and move
the column to the required position. When the mouse button is released, the column is inserted in
the new position. A scrollbar at the bottom of the table allows one to view all parameters that
might not fit within the width of the table. A scrollbar on the right allows access to all repetitions.
1. Select a line in the table by clicking on it with the mouse (multiple choice is possible by
pressing the Shift or Ctrl key additionally).
à Selected lines are highlighted in color and displayed in the legends of the diagrams.
à Corresponding graphs are shown color coded in the graphic displays.
2. Select lines and define properties of the table by pressing the right mouse button, when the
cursor is within the table.
à The Result Table context menu opens offering different options.

Parameter

Description

Select all

Selects all measurements (rows) in the table regardless which line is
highlighted.

Select all channels

Selects all rows belonging to the same channel of a repetitive measurement as the highlighted row.

Select all repetitions

Selects all rows belonging to the same repetitive measurement as the
highlighted row.

Select all positions

Selects all rows belonging to the same measurement position as the
highlighted row.

Select all kinetic
indices

Selects all rows belonging to the same kinetic time point as the highlighted row.

Delete

Deletes the highlighted rows.

Cut

Stores in the clipboard the highlighted rows. Only if the data are
pasted in a new window, the data are deleted from the old one.

Paste

Pastes rows currently stored in the clipboard into the table.

Color

Allows to select a color for the selected data sets.

Copy text to clipboard

Copies the table contents into the clipboard, from which they can be
pasted into other text programs.

Write text to file

Stores the diagram coordinates in a .txt file. You are prompted to
choose a name and a folder before saving.

Properties

Opens the Table Properties window.

Tab. 5: Result Table context menu
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14.1.2.2.2 Fit Tab
The Fit tab provides access to the tools which allow to work with newly generated or already existing data for data analysis.

1

2

3

Fig. 89: FCS Document, Fit tab

1

Diagram area [} 927]

2

Channel area [} 929]

3

Result table [} 932]

14.1.2.2.2.1 Diagrams
Depending on the chosen Fit model, the diagrams differ.
When fitting to a correlation model the upper graph shows the Correlation G(τ) Fit diagram
(correlation plotted versus the correlation time) with the overlaid fit graph. It also displays the fit
range defined by the red (start value) and the blue (end value) bars. The lower Fit deviation curve
depicts the fit residuals. If an experiment is loaded or data have just been acquired for which no
fit has been conducted yet, only the measured Correlation G(τ) curve is shown and no overlaid
fit curve. The Correlation-Fit deviation diagram is still empty.
For fitting to a PCH model the upper graph shows the Frequency diagram (frequency against
count rate per bin) with the overlaid fit graph. If an experiment is loaded for which no fit has been
conducted yet or data have just been acquired , only the measured curve is shown and no fit
curve. The Frequency-Fit diagram will be empty.
Zoom into the diagrams by pressing the left mouse button and drawing a rectangle of the area
you want to zoom in. If the button is disengaged, the zoomed area is displayed.
Clicking the right mouse button within the diagrams opens a context menu each for the Correlation, the PCH fit diagram, and the Fit deviation diagram.
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Parameter

Description

Reset diagram
zoom

Resets any zoomed image

Copy text to clip
board

Copies the diagram coordinates into the clipboard, from which they
can be pasted into other programs like Excel

Write text to file

Stores the diagram coordinates in a .txt file. You will be prompted to
choose a name and a folder before saving.

Copy graphics to
clip board

Generates an image of the graph with the legend text and color
coded graphs which can be copied to standard windows documents

Abscissa logarithmic

Displays the abscissa in a logarithmic scaling

Ordinate logarithmic

Displays the ordinate in a logarithmic scaling

Line width

Allows to select the thickness of the graph. Six settings are possible.

View measured
data

Displays the measured Correlation or PCH curve in addition to the Fit
curve. If this option is not selected, only the Fit curve is displayed.

Normalize

Is used to normalize the selected G(0) value corresponding to the
number of diffusing particles to 2, not the total correlation to which
also other processes like triplet state can contribute. All other values
(subtracted by 1) will than be multiplied by the correction factor defined by the ratio of 1 to [G(τ)-1] and increased by 1, hence G (τ)normalized=[1/ (G(τ)-1) * (G(τ)-1)]+1. Normalization only works for fitted data
as only then a G(0) value is available.

When ordinate is set to a logarithmic scale all zero frequencies will be
displayed as vertical tabs, since the log0 goes to infinity low values.

This option is only available for the Fit Correlation diagram.
Show fit range
text

Displays the start and end values of the fitted data of the correlation
curve defined by the red and blue bars. The positions of the bars can
be adjusted by drag and drop. Start Channel and End Channel determine which part of the correlation curve should be fitted to the
model. The start and end position of the channels are displayed as
correlation times (in µs).
This option and the bars are only available for the Fit Correlation diagram.

Scaling

Opens the Diagram scaling window . Enter the required percentage
value (from 1 to 100) for the scaling and click on OK to rescale, Cancel to keep the old value. The scaling of the G(t) axis is adjusted.
This option is only available for the Fit deviation diagrams.

Tab. 6: Diagram context menu
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14.1.2.2.2.2 Channel Area
The Channel area within the Fit View tab shows the active channel (name and color), for which
the Fit and Fit All buttons apply. If more than one row is selected (shown in blue color in the result table) the active channel is the channel in the last selected row of one or multiple selected
channels.
§

Fit applies to all selected rows of all channels.

§

Fit All applies only to the rows belonging to the active channel.

The Channel area provides the interface to define and save a Fit model. This interface can only be
accessed when either:
§

a continuous FCS acquisition has been started

§

an FCS experiment has been performed

§

a new FCS document has been opened and data have been dragged into this document.

1

2

3

4
5
6
7
8
9
Fig. 90: Fit tab, Channel area

1

Model drop down list

2

Define... button

3

Link edit box with drop down list

4

Upper Limit display box

5

Lower Limit display box

5

Type edit box with drop down list

6

Value edit box

7

Parameters list
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Fit action buttons [} 931]

Parameter

Description

Model

Drop down list contains all previously defined and stored fit models.
Selecting a model by clicking onto the name in the list loads the
model and displays a set of parameters which can be individually
adapted when applying the fit model to the data set(s). The parameters are updated once the fit model is applied to the data.

Define

Click to define a new Fit model. For a detailed description of the available parameters, see Define Model Dialog [} 939].

Link

Links the parameter globally. Type the required letters, separated by
comma.
§ M: links the parameter over different measurements
§ K: links the parameter over kinetic indices with the same time
points
§ P: links the parameter over positions obtained from measurements
at the same site
§ R: links all repetitions of one measurement
§ C: links the parameter for the same channel
Alternatively, select the link(s) from the drop down list opened when
clicking onto the drop down arrow.
If a linkage is activated that does not apply for a measurement, it is
disregarded. Otherwise the same rules are in place as for Fit and Fit
all in terms of to which data rows the links apply.

Upper Limit

Defines the upper limit value tolerated from a fit; if this value is exceeded, the fit is rejected and another (global) maximum is searched
for. The default value depends on the parameter.
The Upper Limit parameter value is only accessable if the Show Limits... option is selected within the interactive selection list opened
with a right mouse click into the parameter panel.

Lower Limit

Defines the lower limit value as a fit parameter; if this value falls short,
the fit is rejected and another (global) minimum is searched for.
Change the value by editing the default value in the edit box. The default value depends on the parameter, but is in most cases 0.
The Lower Limit parameter value is only accessable if the Show
Limits... option is selected within the interactive selection list opened
with a right mouse click into the parameter panel.

Type

Displays whether a parameter is free floating, if its value is fixed or
whether it should be used as a start value. Choose between the options in the drop down menu by selecting Free, Start or Fixed, respectively.
§ When Free is selected, the parameter will be defined as free. After
the fit, the field will contain the fit result for the parameter. The
start values of the parameter (initial guesses) will be calculated by
an algorithm.
For user defined models the option free is not available as a setting
for the parameter Type.
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Description
§ Fix sets a fixed parameter which is useful if the value is known
from other measurements.
§ Start assigns a start value to the parameter and leaves the parameter free to fit. In this case, no initial guesses will be made.

Value

Displays the currently assigned value of the parameter. Change the
value by editing the default value in the edit box..

Parameter

Displays the parameter's name. Activate or deactivate the parameter
by ticking / de-ticking the check box. Only if a parameter is active it
will be taken into account for fitting the data.

§

The parameter settings are not stored with the experiment or the fit model. They need to be
defined anew for each fit procedure.

§

A text in the state display panel warns in yellow writing on any constraints or errors of the defined fit model and suggests suitable changes. For example, whenever some inconsistencies
are present, e.g having two parameters free that depend on each other, like the geometric
factor and the number of molecules, the system gives a warning about the mistake.

Info
Generally it is accepted that non-linear fitting procedures yield more reliable results when the
number of free floating parameters is low. It is recommended to fix parameters which are
known from independent measurements. Good candidates for fixing are diffusion times of the
free dye and the free (i.e. not bound) partner, which can be determined in previous measurements. Another good candidate is the structural parameter that is an instrumental parameter.
The quality of the fit is displayed in the chi2 display box of the Fit table. The χ2 (chi2) value should
approach zero for highest quality. The range of the data to be used for fitting can be defined by
re-positioning the red and blue bar originally set at the beginning and end of the correlation diagram to the required start and end range positions. For the then next Fit procedure then new
range is applied.
Lower and upper limits are only displayed if selected. To select, click with the right mouse button
into the result table to open the context menu.
14.1.2.2.2.2.1 Fit Action Buttons

Parameter

Description

Fit

Performs a fit for all highlighted measurements (rows) according to
the loaded model. When the fit is completed, the free parameters are
replaced with the new fitting results and the fit graph and result table
are updated.

Fit all

Performs a fit for all measurements (rows) that have the same channel
as the one displayed in the Channel display field (active channel). All
other channels are ignored. Changing to a row with a different channel loads the last assigned model for that row.

Undo

Cancels a previous command. Repeatedly pressing will cancel commands in the reverse of their execution.
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Parameter

Description

Redo

Re-executes a previously undone command and hence will become
only active, if an action was performed. Repeatedly pressing will reexecute previous undone commands in the order of their previous execution.

To Method

This function is not supported.

14.1.2.2.2.3 Result Table
The data result table in the Fit view displays the values of the fitted parameters. It is updated
when clicking the Fit button in the Model panel. Measuring rows in the Result table can be activated / deactivated by checking / unchecking the corresponding check boxes. Deactivation of
these check boxes will not exclude the relevant rows from all subsequent evaluation procedures,
but only from the average. Average curves are updated in respect to the rows taken into consideration.
14.1.2.2.3 Info Tab

Info
The complete experiment settings, including all multidimensional acquisition settings, are
stored with the experiment when it is saved.

1
2

3

Fig. 91: Info tab

1

Name display box
The name of the experiment is updated whenever the experiment is saved under a defined name. It cannot be edited otherwise.

2

Comment edit box
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Write down any relevant information about the experiment you would like to keep with
the data.

3

Acquisition display box
The panel shows apart from the acquisition date and the pinhole size only information
about the single measurement parameters.

See also
2 Fit Action Buttons [} 931]
14.1.2.2.4 FCS Document View Options
14.1.2.2.4.1 Correlation Tab
The Correlation action tab lists all correlation channels with their assigned channel color including cross correlation channels.

1
2
3

Fig. 92: FCS Document, Correlation action tab

1

Channels dropdown menu
Displays the list of active channels and allows to change the color when clicking on the
arrow. Changes are immediately effective.

2

Diagrams
Choose the diagrams to be displayed by activating the corresponding buttons. Selected
diagrams will be highlighted in blue. By clicking on the appropriate button, the diagram
can be toggled between ON and OFF.

3

Reload ... button
Opens the Reload tool (see Reload Tool [} 935]).
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14.1.2.2.4.2 Table Tab
The Table action tab provides several options to sort and display the data.

1
2

3

4

Fig. 93: FCS document, Table action tab

1

Order drop down list
Determine, how different measurements are grouped together. The hierarchy of grouping of categories is determined by their listed sequence.

2

Show standard deviation checkbox
If activated, all parameters are displayed with their values and their calculated standard
deviation from the different measurements. Only then the displayed average correlation
function can be meaningfully fitted.

3

Average drop down list with correlation measurements
In the drop down selection choose how to average the data.
§ When Fit results is selected, the single values of the parameters are averaged.
§ Selecting Correlation averages single data points of each correlation function and an
average correlation function is calculated.
Check, which measurements (Repetition, Kinetics, Positions, Correlation) should be
used to built the average by activating the corresponding checkboxes.

4

Parameters list
Only parameters set active are visible in the table. The order of the displayed parameters
can be adjusted using drag and drop in the table itself. Deactivation of these check boxes
excludes the relevant rows from all subsequent evaluation procedures like averaging.
These settings will be stored when saving the data. Immediate reactivation is possible
when activating the check box. The scroll bar allows viewing all content of the display
box.
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14.1.2.2.4.3 Reload Tool
Whenever a *.FCS file is opened and raw FCS data (*.RAW files) have been saved during acquisition along with the *.FCS file, the Reload ... button is available in the Correlation tab in the FCS
document view.
The tool allows to redefine several parameters for
§

Correlation [} 935]

§

Count rate [} 936]

§

PCH (Photon Counting Histogram) [} 937]

§

Electronic dust filter [} 938]

The panel opens with the default settings which are applied for the original data acquisition.
14.1.2.2.4.3.1 Correlation
The Correlation tab allows to specify how the raw data will be processed for correlation analysis.

1
2

3
4

Fig. 94: Reload tool, Correlation tab

1

Binning time edit box
Determines the minimal binning time used in the correlation analysis and also the start
correlation time, which will be identical to minimal binning time. Chose whether to directly enter values or use the scroll arrows. Can be reset to the default value by clicking
the 0.2 button.

2

Maximum correlation time edit box
Defines the end correlation time. It cannot exceed the measurement time. Hence, the
value will only be used if equal to or smaller than 2/3 of the measurement time, else the
measurement time will be used automatically. Chose whether to directly enter values or
use the scroll arrows. Can be reset to the default value by clicking the 1000 button.

3

Tau Channels edit box
Defines the number of linear increased Tau channels per multiple Tau step. Chose
whether to directly enter values or use the scroll arrows. Can be reset to the default
value by clicking the 8 button.

4

Default button
Resets all parameters to the default values. Please note that with the default settings, the
algorithm works the fastest.
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The algorithm for auto-correlation functions is as follows:
In the first correlation step all events within a certain correlation interval T are counted.
The default T in the first correlation step (n=0) equals 200 ns, which is 4x the maximum sampling
rate of 50 ns, as limited by the dead time of the detectors and the electronics. T will be changed
by the entry in the Binning display window. This corresponds to a clock speed of 20 MHz.
Thus, for this correlation interval a maximum of 4 events can be counted. These events / correlation intervals are shifted against themselves for a time interval t. The first t equals the first T value,
as a default 200 ns = 0.2 ms. t will be changed by the entry in the Binning display window.
T is linearly increased by step sizes of 200 ns (or the entered value) for 8 times (direct tau) and
than for another 8 times (multiple Tau), i.e. the maximum correlation time in the first step is
16 x 0.2 ms = 3.2 ms using the default settings. The direct and shifted events / correlation intervals are multiplied interval for interval and the products are added together and normalized.
The normalization result is defined as: (result x received clocks)/(pulse2) for auto-correlation or (result x received clocks)/(pulseA x pulseB) for cross-correlation. The received clocks counted equal 4x
the number of correlation intervals, which are defined by the measurement time. At the end the
relevant data for the next correlation step are processed. Here, the correlation interval is increased
by a factor of 2. Hence, the correlation interval (T) in the n-th correlation step is T = 0.2 ms x 2n
for the default settings. The initial lag time for a certain correlation step corresponds to the last
lag time of the previous correlation step added to the respective correlation interval. This value is
then linearly increased 8 times.
Therefore after step n, the correlation or lag time (t) ultimately corresponds to
t = 6 x 0.20 + 8 x 0.2 x 2n ms. The doubling of the correlation interval is performed on default 25
times. Thus the maximum is: t = 16 x 0.2 + 8 x 0.2 x 225 ms.
14.1.2.2.4.3.2 Count rate
The Count rate tab allows to specify the binning time used for the count rate trace.

1
2

3

Fig. 95: Reload tool, Count rate tab

1

Automatic checkbox
Activates dynamic binning.

2

Binning time edit box
Determines the constant binning time used in the count rate analysis. Chose whether to
directly enter values or use the scroll arrows. Can be reset to the default value by clicking
the 1 button.

3

Default button
Resets all parameters to the default values. Please note that with the default settings, the
algorithm works the fastest.
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When Automatic is active, the system averages three data points and rebinds the data in dependence of the measurement time. The diagram will have a mean with fluctuations above and below the mean.
In constant binning, data points are not averaged. This will result in a baseline with fluctuations
above.
In (automatic) dynamic binning the count rate trace will be adjusted to the measurement length.
The count rate trace represents the averaged binned count rate versus measurement time, in
other words photons/second therefore intensity.
The bin window in dynamic binning now depends on the measurement time, whereby the bin
window doubles, if 500 values are exceeded.
In the first step, the binning time is 3.2 ms. For the next steps, the binning time (tr) becomes
tr = 3.2 ms x 2n. The measurement time (td), at which the binning time doubles is calculated according to td = 3.2 ms x 500 x 2n.
14.1.2.2.4.3.3 PCH
The PCH allows to specify the binning time used for the photon counting histogram.

1
2

3

Fig. 96: Reload tool, PCH tab

1

Automatic checkbox
Activates dynamic binning.
When Automatic is active, 32 different binning times will be used.

2

Binning time edit box
Determines the constant binning time used for the PCH. Chose whether to directly enter
values or use the scroll arrows. Can be reset to the default value by clicking the 10 button.

3

Default button
Resets all parameters to the default values. Please note that with the default settings, the
algorithm works the fastest.

Info
In automatic binning mode, binning starts with a value of 50ns, which is doubled 32 times. So
binning times are 50 x 2n, with n=1 to 32. The histogram with the best dynamic range (three
standard deviations) will be selected and displayed.
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14.1.2.2.4.3.4 Dust filter
The Dust filter tab allows to activate an electronic dust filter. Define a threshold in the Count
rate intensity that, if exceeded, will lead to a removal of the corresponding count rate region
from the correlation analysis.

1
2

3

Fig. 97: Reload tool, Dust filter tab

1

Dust filter checkbox
Activates the dust filter function.

2

Deviation to erase peak in count rate edit box.
Determines the Threshold in %. Chose whether to directly enter values or use the scroll
arrows. Can be reset to the default value by clicking the 10 button.
All measurement points within a binned count rate time window having a deviation of
more than the specified value from the average count rate will be cut out and not used
for the correlation analysis.

3

Default button
Deactivates Dust filter and resets the values to default.

Note that the cut off count rate is defined as a value exceeding the average count rate during a
certain measurement period (bin window) by a certain percentage. Thus, the consecutive fast succession of low peaks might accumulate the same count rate as one high peak within a certain period of time and hence, the cut off is not defined by the peak height but rather by the counts per
binning time.
If the integrated count rate over a certain count interval exceeds the average count rate by that
threshold, this special interval is discarded for correlation analysis. For example, if the system detects a count rate in a certain time interval that exceeds the average count rate by over 30% and
the threshold was set to 30, this interval will be discarded for correlation analysis. The time intervals before and after the discarded region are separately correlated and the results averaged. This
holds also true, if more than one region is discarded. In this case all the single regions that are
separated by cut out regions are separately correlated and the resulting average is displayed.
Note, that calculation of an average will be performed at the beginning of the measurement. If
peak count rates will come at the beginning, this kind of dust filter does not work. Also, due to
the necessity to average signals over a certain integration time, more than only the peak area will
be discarded. Another outcome of the necessity to average the count rate signal is that several
small peaks following close to each other will be treated as a huge peak and might be cut out.
This means, in the Automatic cut mode accumulated count rates rather than peaks are removed.
For cross-correlation experiments, any of the regions discarded in either autocorrelation function
will not be used. Cut off regions are framed by stippled boxes and appear matted in the Count
Rate window.
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14.1.2.2.5 Define Model Dialog

Parameter

Description

Correlation

Create a correlation model from predefined equations, which will be
fitted analytically, see Generating a Correlation Model.

PCH

Create a photon counting histogram model, which will be fitted numerically, see PCH tab [} 940].

Formula

Create a user defined model equation, which can be fitted analytically, see Formula tab [} 941].

14.1.2.2.5.1 Correlation tab
This tab show the options for assembling a correlation model. Correlation allows assembling a
model with predefined terms.

1

2

Fig. 98: Define Model dialog, Correlation tab

1

Settings ... button
Opens a submenu for the respective term, see Terms and Term Settings [} 952].

2

Terms list
Shows selected terms of the currently active model. The assembled equation is displayed
in the G(τ)=1 display area.
A new model can be defined by activating the requested equation terms and defining
the corresponding settings for each term.
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14.1.2.2.5.2 PCH tab
The PCH tab within the Define Model tool is used to determine concentrations and the molecular brightness of molecules.
PCH can be fitted only one-dimensional. If a cross-correlation measurement is activated, the PCH
model is automatically replaced by a correlation model.

1
2
3
4

Fig. 99: Define Model dialog, PCH tab

1

Background
§ Type in a value if known.
§ Keep the value to zero, if no background is expected.
§ The background is no fit parameter.

2

Components
Select numbers of components (1, 2 and 3) by clicking the Components 1, 2 or 3 buttons. The number of active components will be highlighted in blue.

3

Specific brightness
Type in a brightness value (Hz) specific for the chosen number of components beneath
the Components button activated. If you don’t know the brightness, keep the value at 1.

4

Instrumental parameters
Type in values in the respective first order, second order and third order edit boxes.
These values have to be determined in independent calibration experiments using a defined dye solution with a known brightness. The parameters correct for the deviation of
the confocal volume from a true Gaussian distribution. Normally, only a correction for
the first order parameter is necessary and recommended. Hence, in the calibration fit
keep the first order parameter free and the second and third parameters fixed to zero.
Enter the determined first order number and save it with the model for later measurements.
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14.1.2.2.5.3 Formula tab
The Formula tab allows to define own fit equations.

1
2
3
4

5

Fig. 100: Define Model dialog, Formula tab

1

Formula edit box
Displays the entered formula.

2

Keyboard
Used to type the required formula.

3

Clear Formula button
Finishes the variable definition process.

4

Return button
Deletes the entered formula.

5

Description panel
Displays any expected operation and syntax errors.

Note that:
§

All variables defined at the beginning are considered fixed variables, all other variables are
considered fit parameters.

§

Each defined variable must have an assigned number. This number will substitute for the variable in the equation.

§

Always start a formula with G as the dependent variable in the form of G(x)=, x being any arabic letter.

§

The independent variable x is considered to have the SI unit [s] and the same holds true for
any dependent parameter to it.

§

If there are no syntax errors, parameters and operations will be indicated.
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14.1.2.2.5.4 Model Equations
The acquired correlation functions must be fitted to models in order to retrieve meaningful results. It depends on the biochemical process, which model is the most appropriate. If the underlying process is known, the model can be selected prior to the start of the experiment. For example,
if diffusion in a membrane is the subject, a 2-D diffusion model should be applied. In other cases,
the process is not known, for example for free or anomalous diffusion. In this case, one can
screen different potential models and look for the best fit taken into account the χ2 value. Often
two models work nearly equally well, for example, a two component free diffusion model can
give you as satisfactorily a fit as a one component anomalous diffusion model, and without prior
knowledge about the system it will be impossible to decide, which is the better one. In principle,
models can be excluded if the fit does not work. However, a working model is only a potential
candidate but does not signify it to be the correct one. Care should be taken to minimize the free
parameters as much a possible to improve on the fit quality. It is not advisable to fit to three components without fixing the parameters of at least one of them. For example, if the diffusion time
of a free ligand can be determined in a pre-experiment, that value should be fixed to reduce the
number of floating parameters for the evaluation of the binding experiment to its receptor.
The FCS software is designed to be flexible. That means that the user can define or assemble
equations which are useless. Care should be taken and formulas should be compared to the ones
known from literature to obtain meaningful results. Also, the presence of a model does not necessarily mean, that the quality of the recorded data allows its usage. For example, anti-bunching requires a lot of care in data acquisition like long measurement times and cross-correlation to reduce dead times of the detectors and elimination of after-pulsing artefacts. It is in the responsibility of the user to set up his or her experiments accordingly.
The correlation function
Definition of the auto-correlation function

or

where
denotes the time average and
the mean intensity.

describes the fluctuations around

For long time average of 1 (no bleaching) the following relation exists:
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Definition of the cross-correlation function
The formalism for the cross-correlation function is identical to the auto-correlation function, with
the exception that the signal in one channel is not compared to itself, but to a signal in a second
channel. Lets assign the indices "r" and "b" for the red and blue channel, respectively, than the
cross-correlation function would read as follows:

Note that the software for FCS calculated GI functions, which do therefore converge to 1 and not
0. The acquired correlation functions are than compared to model equations.
Available model equations
In the following available equations used for the fits are given that define the accessible parameters. For some equations useful conversions to other parameters are listed as well. The total correlation is given by equation 2:

where d is the offset, B the background correction, A the amplitude and Gk,l(τ) the correlation for
a single process. The suffixes k and l signify correlation terms for dependent and independent processes, respectively, that are multiplied with or added to each other.
The total correlation is therefore the amplitude multiplied to the product of the single correlation
terms that are dependent and hence convolute each other. This amplitude has to be corrected for
background and any offset. In cases, when the processes are independent from each other, the
single correlations terms add up, for example in cases where there is more than one component
all bearing the same label or of bunching terms that are independent from each other. If independent and dependent processes are present, all independent terms will add up and are multiplied
with the dependent terms.
One can distinguish between different classes of fluctuation processes: anti-bunching, bunching
and diffusion.
14.1.2.2.5.4.1 Amplitudes
The amplitude of the correlation function is influenced by the offset, background and the number
of particles in dependence of the geometric factor. The amplitude is also influenced by the
process of correlation.
The "1"
In a normal correlation, the curve converges to 1, in case intensities I are correlated as is the case
with the FCS software. Note that in other cases, if fluctuations Iδ are correlated, the correlation
function converges to 0, if no bleaching occurs.

You can therefore easily convert GI(τ) to GδI(t) values by adding a fixed offset of –1.
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Offset d

c is any rational number that can be negative or positive.
In the FCS software the offset can be a fit parameter or a fixed value. In some cases, especially if
very slow or immobile components are present, there can be a positive offset from 1. This offset
can be taken into account by fitting to d. On the other hand, if the offset is known, it can be
fixed. The offset will be added to each correlation value.
Background B

where Ib is the background intensity and It is the total intensity.
The FCS software treats the background always as a fixed value and never as a fit parameter. Thus
the user has to define the background.
Note that the background in this case refers to a non-correlating background. If there is no background intensity, B = 1, otherwise B < 1. The background can be determined by measuring an unlabeled solution or cell at the same settings than the real experiment and recording the count rate
Ib. The real experiment with the labeled species will give It. A non-correlating background will result in a lower amplitude and hence overestimation of molecule numbers, if not corrected for.
Note the squared correction term.
Amplitude A

where γ is the geometric factor accounting for the point spread function (PSF) and N the mean
number of particles.
In the FCS software γ can be a fit or a predefined fixed value. In case γ is a fit value N must be
fixed in the fit procedure. N is normally a fit parameter.
Please note that γ takes different values for different fitting models depending on the assumed intensity distribution of the point spread function (PSF):
γC=1.000 (cylindrical)
γ2DG=0.500 (2-D Gaussian)
γ3DG=0.350 (3-D Gaussian)
γGL=0.076 (Gaussian-Lorentzian).
γ can also be calibrated, if a known concentration c of a dye is measured. In this case N can be
fixed and γ fitted. The obtained number can be entered as the calibrated fixed number. N can be
calculated from equation

with V being the confocal volume and LA = 6.023 x 1023 mol-1 the Avogadro number.
The volume V is calculated from equation
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with ωz axial focus radius and ωr the lateral focus radius. The radii themselves have to be determined by a calibration measurement using a dye with a high quantum yield and a known diffusion coefficient D from the fitted diffusion time τd and the structural parameter S employing a free
diffusion model with triplet state.
The following relations exist:
for 1 photon excitation
for 2 photon excitation

Equations 5e or 5f, dependent on the excitation source, can be used to retrieve ωr; with its knowledge ωz can be calculated from equation 5g.
"N" can have different meanings in different fit models. For biology, normally the number of diffusing particles is of interest. In this case, if photo-physical processes (triplet, blinking, stretched
exponentials) are involved, it is recommended to use their normalized forms, since then the number of molecules correspond directly to the number of diffusing particles. If photo-physical terms
are not normalized, the number measured is the total number of diffusing particles and those undergoing photo-physical processes.
14.1.2.2.5.4.2 Anti-bunching terms
Anti-bunching is the phenomenon that a molecule cannot produce emitted photons as long as it
stays in the excited state. Hence during the transition time required to drop back to the ground
state, which corresponds in most of the cases to the lifetime if no other photo-physical processes
are involved, no photon can be expected, which results in anti-correlation and hence a drop of
the correlation function below 1.
Independent to other terms

where C is the amplitude and τa the transition time, also referred to as the lifetime.
Dependent in combination with other terms

where C is either a fit parameter or a fixed value and often takes the value 9/5.
There are two cases to be distinguished: First, if the anti-bunching is independent with other processes, than equations 6a and 6b in the non-normalized or normalized form must be used and the
terms are multiplied with other correlation terms. In case the anti-bunching is treated dependent
to other processes, than equation 6c is the correct one to use and the term is added to other correlation terms.
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Stretched exponential – anti-bunching
This is a more general term adding frequency and stretched factors to the exponent.
not normalized

normalized
where K1 is the fraction of molecule, and τk1 the exponential decay time, k1 the frequency factor
and κ1 the stretch factor.
K1 and τk1 are fit parameters; k1 is a fixed parameter and must be user defined; κ1 is either a fit parameter or can be fixed.
Note, fixing k1 and κ1 to "1" results in a simple anti-bunching term.
Double stretched exponential – anti-bunching
This is a double exponential function, where the exponentials are subtracted.
not normalized

normalized
where K1 and K2 are the fractions of molecules, and τk1 and τk2 the exponential decay times, k1
and k2 the frequency factors and κ1 and κ2 the stretch factors.
K1, K2, τk1 and τk2are fit parameters, k1 and k2are fixed parameters and must be user defined, κ1
and κ2are fit parameters or can be fixed.
14.1.2.2.5.4.3 Bunching terms
Bunching is the phenomenon of a burst of photons during a certain time interval, the duration of
which is determined by photo-physical processes including triplet, blinking, flickering and protonation. These terms are exponential decay functions. Formally, they look the same, only the exponential decay might be different.
Triplet
not normalized

normalized
where Tt is the triplet fraction, that is the number of molecules undergoing triplet states and τt the
triplet decay time.
Tt and τt are fitted parameters.
Triplet is based on an un-allowed intersystem crossing from the excited to the so-called triplet
state. This state lasts for 1 – 5 µs. If the electron drops back to the ground state, no photon is
emitted and hence during the triplet state the molecule is in a dark state. Triplet is indicated as a
rise in the correlation amplitude, which is indicated as a deviation from the flattening curve at
shorter correlation times. If not normalized, the triplet fraction contributes to the total number of
molecules.
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Blinking
not normalized

normalized
where Tb is the blinking fraction, that is the number of molecules in the dimmer state and τb the
blinking decay time of the dimmer state. Note, if the blinking term is not normalized, the number
of blinking molecules will influence the total number of molecules.
Tb and τb are fitted parameters.
Blinking is based on the phenomenon that the electron distribution over conjugated systems can
change in dependence on the local environment, for example changes in the pH, which will lead
to molecules in a bright and dim or dark state. It is therefore a kinetic process that can be described in the following way with the following relations:

with the constraint
with B and D representing the brighter and darker states, kF and kR the forward and backward reaction rates and ηB and ηD the emission yields or molecular brightness of molecule species (D or B)
in Hz or the relative dimensionless brightness. In case, where darker state is completely dark
(ηD=0), equation 7h simplifies to

Note that Blinking is referred to a process that does not lead to a covalent modification in the
chemical bonds. If covalent changes occur the process is referred to as Flickering, which is formally treated in the same way.
Dependent triplet and blinking
In this case the terms are just representatives for two dependent bunching terms that are linked
by addition (double exponential term). Note that the triplet fraction, if present, could be potentially fitted to either of the terms.
not normalized

normalized
where T1 and T2 are the fractions of molecules in the triplet state, and τt1 and τt2 the triplet exponential decay times.
T1, T2, τt1 and τt2are all fitted parameters.
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Independent triplet and blinking
In this case the terms are just representatives for two dependent bunching terms that are linked
by multiplication. Note that the triplet fraction, if present, could be fitted to either of the terms.
not normalized

normalized
where T1 and T2 are the fractions of molecules in the triplet state, and τt1 and τt2 the triplet exponential decay times.
T1, T2, τt1 and τt2are all fitted parameters.
Stretched exponential - bunching
In some reactions the kinetics cannot be fitted to simple exponential functions but require
stretched exponentials.
not normalized

normalized
where K1 is the fraction of molecule, and τk1 the exponential decay time, k1 the frequency factor
and κ1 the stretch factor.
K1 and τk1 are fit parameters, k1 is a fixed parameter and must be user defined, κ1 is either a fit parameter or can be fixed.
Note, fixing k1 and κ1 to "1" result s in a simple bunching term.
Double stretched exponential - bunching
This is a double exponential function, where the exponentials are added.
not normalized

normalized
where K1 and K2 are the fractions of molecules, and τk1 and τk2 the exponential decay times, k1
and k2 the frequency factors and κ1 and κ2 the stretch factors.
K1, K2, τk1 and τk2 are fit parameters, k1 and k2 are fixed parameters, κ1 and κ2 are fit parameters or
can be fixed.
This term is often required to fit protonation, with the second stretch factor and the frequency
factors are set to "1".
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14.1.2.2.5.4.4 Diffusion terms
Diffusion is driven by Brownian motion. We can distinguish translational, rotational and flow diffusion.
Rotational diffusion
In the most general form, rotation can be described as the sum of 5 exponential terms

where Ra is the amplitude, cm the relative amplitude, rm the frequency factor and τr,m the rotational
diffusion time.
However, there are special cases that are of more use. In symmetric rotation, the general formula
reduces to:
not normalized

normalized
where Ra is the rotational amplitude and τr the rotational diffusion time.
Ra and τrare fit parameters.
If rotation occurs dependent from other processes, the formula used as an additive term is defined as:

Ra is either a fit parameter or a fixed value and often takes the value 4/5.
In case of asymmetric rotation, the term is as follows:

not normalized

normalized
where Ra is the amplitude, c1 and c2 are relative amplitudes, r1 and r2 frequency factors, τr,1 and
τr,1 rotational diffusion times.
Ra, τr,1 and τr,1 are fitted parameters, c1, c2, r1 and r2 are fixed values and must be user defined.
Rotational frequencies often take the following values:
r1
r2

1
10/3
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The relative amplitudes dependent on the polarization of the excitation light and the analyzer in
the emission beam path and are as follows:
Ex

lin. pol.

lin. pol.

lin. pol.

unpol.

unpol.

unpol.

Em

parallel

perpendicular

all

parallel

perpendicular

all

c1

80

20/9

860/9

5/9

215/9

20

c2

64/9

4

4

16/9

1

1

Translational diffusion
In its general form, translational diffusion is defined as:

with
the constraint
where τd,i is the diffusional correlation time of molecule species i, S the structural parameter that is
the ratio of axial to lateral focus radii, αi the anomaly parameter or temporal component of molecule species I, ed1and ed2 are fixed values and have to be user defined. The following values define
1-, 2-and 3-D diffusion:

ed1

ed2

dimensionality

1/2

0

1-D

1

0

2-D

1

1

3-D

Note that in the FCS software these values are automatically selected with the choice of dimensionality.
S is either a fit parameter or a fixed value. It is an instrumental parameter and can be determined
by a calibration experiment using a dye solution with a known diffusion as a fit result.
αi is either a fitted value for anomalous diffusion or a fixed value (set to "1") for free diffusion. The
following relation exists:

α

Diffusion process

=1

Free diffusion

<1

Anomalous sub-diffusion

>1

Anomalous super-diffusion
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Note that αi is set automatically to "1", if free diffusion is selected. If anomalous diffusion is selected, the parameter will float.
τd,i are fitted parameters. They can be converted to diffusion coefficients Di using formulas 5e or
5f. The FCS software allows you to directly fit to Di values, but in this case the lateral radius ωr has
to be specified as a fixed value.
Please note that in the case of anomalous diffusion the following relations exist:

where Γ is the transport coefficient of the fractional time dimension.
Please note the following relation between D and G:

If activating the fitting to the diffusion coefficient the Γ values have to be calculated from the D
values by the following conversion:

The Φi values are fit parameters. They account for different brightness of different components. In
principle, if molecules of different brightness are present, the apparent molecular brightness is defined as

where ηiis the brightness of the molecules in kHz or the dimensionless relative brightness values.
The brightness of the species has to be determined beforehand in control experiments.
Note that the brightness contributes as the square to the correlation function, in other words a
double as bright molecule will contribute 4 fold more. Therefore, the fitted number of molecules
must be corrected to obtain the real number Ndiff of diffusing particles; please note that to obtain
the diffusing particle number directly, other terms should be used in their normalized form:

If one wants to know the true fraction fi of each species, values those can be retrieved with the
known brightness from the relation

with the constraints

and

If there is no brightness difference between the components, Φi will become fi.
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You can fit directly to the fractions even in case of different brightness values. In this case, the
brightness values have to be fixed parameters and defined by the user. The fit formula converts
from equation 5a in combination with 8g taking into account the corrected amplitude to equation
8o:

with fixed brightness values ηi.
Flow
Flow signifies active transport either via cytoplasmic movement or directed transport.
If flow occurs in the absence of translational diffusion, the term is defined as follows:

In the presence of translational diffusion, the term alters to:

with τf representing the average residence time for flow and τd the diffusion correlation time.
Note, in the FCS software, the correct term is automatically loaded in dependence on the absence
or presence of a translational term.
With the knowledge of the lateral radius ωr given as a fixed value, the software allows to fit directly to the velocity v instead of the average residence time. The following relation exists:

14.1.2.2.5.5 Terms and Term Settings
Terms
Start the definition of a model by activating the checkbox of the term you want to include into
the final correlation equation. Deactivate the checkbox to remove the term from the final equation. All activated terms are assembled into the final equation that is displayed in G(τ)= display
area.
Choose from:

Term

Description

Offset d

Deviation from 1

Background B

Unspecific non-correlating background

Amplitude A

Number of molecules and geometric factor

Antibunching G a(τ)

Antibunching correlation term
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Term

Description

Triplet G t(τ)

Exponential correlation terms for triplet state, blinking, flickering or
other bunching correlation terms

Rotation G r(τ)

Rotational diffusion correlation term

Translation Gd(τ)

Translational diffusion correlation term

Flow Gf(τ)

Flow correlation term

Stretched exponential Ge(τ)

Stretched exponential correlation term for kinetics

Settings
For a selected term the Settings button becomes available. The Settings panel allows you to
choose specific equations and assign values to parameters, if applicable. The Settings Description box provides information on the parameter or displays the formula of the equation. In addition it provides useful conversions of the fitted parameter to other interesting parameters. For
more information the used formula see Model Equations [} 942].
The following settings are available:

Term

Settings

Offset d

§ Set the offset to 0 by clicking the Normalized button.
§ Define the offset by clicking the Calibrated button
Type in a value into the edit box or set a value using the scroll arrows.
§ The offset can have positive or negative numbers and the value
specified will be added to all correlation values.
§ The description panel provides information on the offset.

Background B

§ Set an offset by typing in value in the Background selection box.
or use the scroll arrows.
§ If there is no background selected, the background correction factor is set to 1.

Amplitude A

§ Set a value for the geometric factor γ, which describes the pointspread function.
§ By clicking the cylindrical, 2DG, 3DG and GL buttons a cylindrical,
2 dimensional Gaussian, 3 dimensional Gaussian (3DG) and Gaussian-Lorentzian (GL) PSF can be set, respectively.
§ click the Calibrated button to type in a user defined number into
the edit box or use the scroll arrows to set a value.
§ The description panel provides information on the amplitude.
§ At least one the γ factor or the number of molecules N have to be
fixed in the fit procedure.

Antibunching G a(τ)

§ Choose between normalized and non-normalized anti-bunching
term by activating / deactivating Normalized.
§ Select the Dependent antibunching, rotation and translation
form by checking the respective box. This equation is used as an
additive term to rotational and translational diffusion terms.
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Settings
§ Leave the amplitude value free to float or to set the value to 9/5 by
clicking the Free or 9/5 buttons, respectively. The active selection
will be highlighted in blue.
§ The description panel provides information on the anti-bunching.

Triplet G t(τ)

The triplet represents bunching terms that are exponential decay
functions.
§ Choose between normalized and non-normalized triplet term by
activating / deactivating Normalized.
§ Choose, whether the bunching terms should be weighted or not by
activating or deactivating Weighted. If no weights are applied, the
fit follows the measured curve to minimize χ2. If no boundary values are set for the relaxation times, noise might also be followed
and triplet fractions might show up to be too high. If weights are
applied, noise is followed less. The following weight equation is
used:
Several options are available for the bunching terms. Select the relevant term from the Components drop down menu:
§ Triplet: 1 exponential function
§ Blinking: 1 exponential function
§ Independent Triplet and Blinking: Sum of 2 exponential functions
§ Dependent Triplet and Blinking: Product of 2 exponential functions
§ The name of the selected term is shown in the Components selection box.
§ The description panel provides information on the bunching terms.

Rotation G r(τ)

§ Choose between normalized and non-normalized rotation functions by activating / deactivating Normalized.
§ Select the Dependent antibunching, rotation and translation
by activating the respective checkbox. This equation will be used as
an additive term to anti-bunching and translational diffusion terms.
Optionally leave the amplitude value free floating or setting it to
4/5 by clicking the Free or to 4/5 buttons, respectively. The active
option is highlighted in blue.
§ Choose between symmetric rotation (1 exponential term) and
asymmetric rotation (double exponential term) by activating / deactivating Asymmetric.
When Asymmetric is active, it is possible to define relative amplitudes and rotational frequencies (note, these parameters are no fit
values and have to be defined by the user).
Relative amplitudes are defined by selecting the excitation polarization (linear polarized or unpolarized) and the emission detection
(parallel, perpendicular or all), by clicking the corresponding
tabs, which will result in the corresponding values displayed in the
c1 and c2 display boxes. Alternatively, if others is activated, you
can type in user defined values.
Rotational frequencies can be selected by clicking the Default tab
to load the default values. The corresponding values are shown in
the r1 and r2 display boxes. By clicking the other tab, user defined
values can be entered.
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Settings
§ The description panel provides information on the rotational diffusion terms.

Translation Gd(τ)

The following possibilities for parameter settings are available:
§ Fit to fractions (normally used when no brightness differences are
observed between different components) or to fractional intensities, by activating Fractional Intensities. Type in the absolute or
relative brightness values of the components into the Molecular
brightness edit box.
§ Fit to the diffusion time, or directly fit to the diffusion coefficient by
activatingDiffusion coefficients. Type in the radial dimension of
the confocal volume into the ωr edit box or use the scroll arrows.
§ In case two photon excitation is used activate 2 Photon since this
will influence the fit formula in the case the Diffusion coefficients
option was chosen.
§ Select the number of components (1, 2 and 3) by clicking the Components 1, 2 or 3 buttons. The number of active components will
be highlighted in blue.
§ Select free / anomalous diffusion in the dropdown down menus
beneath each component button.
§ Set the diffusion Dimension in the dropdown menus beneath each
component button. Select between 1-D, 2-D and 3-D.
§ Enter brightness values in the Brightness edit boxes for each component. These values are only displayed, if the Fractional Intensities option is selected. Type in absolute values (that must have the
same units for all components) or relative values.
§ The description panel provides information on the translational diffusion terms.

Flow Gf(τ)

§ Determine, whether you want to fit to the diffusion time or directly
to the velocity by activating Velocity. Type in the radial dimension
of the confocal volume into the ωr edit box or use the scroll arrows.
§ The description panel provides information on the flow terms.
§ Note, that the system automatically toggles between the pure flow
and flow in combination with translational diffusion in cases where
the Translation term is deactivated or activated, respectively.

Stretched exponential Ge(τ)

§ Choose between bunching and anti-bunching terms by clicking the
Bunching or Antibunching buttons, respectively.
§ Choose between 1 (mono exponential) or 2 (double exponential)
stretched exponential terms by clicking the Components 1 or 2
buttons. The active option will be displayed in blue.
§ Choose between normalized and non-normalized stretched exponential term by activating / deactivating Normalized.
§ Choose between dependent and independent stretched exponentials by choosing from the Components dropdown menu. This becomes only available, if two components are active.
§ The description panel provides information on the strethed exponential terms.
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Settings
§ Note, the frequencies and stretch factors are no fit parameters and
must be defined in the Frequencies k1 and k2 as well as the
Stretch factors κ1 and κ2 display boxes. Either enter a value or
click the 1 button for the default setting.
§ For two components, only the formula for dependent processes is
presently available.

14.1.2.3 Setting up FCS/FCCS Measurement
14.1.2.3.1 FCS Measurement Setup for Labeled Molecules in Solution
Prerequisite ü Dye/Molecule dissolved in suitable solvent and at suitable concentration.
ü High NA Objective selected for imaging.
ü Focus point set into the solvent maybe using imaging techniques to check on emission signal.
1. Chose FCS track in Imaging Setup tool.
2. Select detection channel for FCS in Imaging Setup tool.
3. Select laser and laser power for dye excitation in Channels tool (see Choosing the Optimal
Laser Power [} 958]).
4. Select 1 Airy Unit for the pinhole.
5. Set up measurement parameters in Channels tool (see Setting the Parameters for the FCS/
FCCS Measurement [} 958]).
6. Click Continuous for continuous measurement to see count rates and correlation data and
to optimize laser power.
7. Adjust Pinhole if necessary (i.e. if low count rate is registered during continuous data acquisition with otherwise sufficient laser power) (see Adjusting the Pinhole [} 959]).
8. Click Snap for a complete single dimensional measurement.
14.1.2.3.2 FCS Measurement Setup for Labeled Molecules within Cultured Cells
Prerequisite ü Dye/Molecule available/expressed in suitable concentration within cultured cell
ü High NA Objective selected for imaging
ü Pinhole adjusted with test sample previous to the measurement (if needed) (see Adjusting the
Pinhole [} 959]
1. Focus onto the selected structure.
2. Acquire a confocal image using suitable imaging parameters (laser, laser power, detector
gain, detection range) to identify the region/point of interest for FCS measurement.
3. Open Experiment Regions tool.
4. Select FCS marker tool and position it within the acquired image onto the point of interest.
5. Chose FCS track in Imaging Setup tool.
6. Select the required detection channel/s in Imaging Setup tool.
7. Select laser and laser power for dye excitation (see Choosing the Optimal Laser Power
[} 958]).
8. Set up measurement parameters in Channels tool (see Setting the Parameters for the FCS/
FCCS Measurement [} 958]).
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9. Click Continuous for continuous measurement to see count rates and correlation data and
to optimize laser power and focus position.
10. If necessary run Z-Scan (count rate over Z stack measurement) to find optimal Z position or
correct Z position using the Z Focus of the stand (see Performing a Z-Scan [} 960]).
11. Confirm the selected position within the Experiment Regions tool for the corresponding
measurement spot.
12. Click Snap for a single complete measurement including all selected measurement spots.
14.1.2.3.3 FCS Measurement Setup for Labeled Molecules in Solution Using a Sample Carrier
Prerequisite ü Dye/Molecule dissolved in suitable solvent and at suitable concentration distributed into a
sample carriers wells.
ü High NA Objective selected for imaging.
ü ZEN Module Tiles & Positions is available on the system.
ü Focus point set into the solvent (about 100 to 200 microns above the coverslip into the solvent) maybe using imaging techniques to check on emission signal.
ü FCS track is defined with suitable channel selection, laser line and power, and measurement
parameters for the actual FCS measurement.
ü Pinhole is adjusted for optimal FCS results.
1.
2.
3.
4.

Activate an LSM confocal track (or other imaging track).
Open Tiles tool.
Select the sample carrier matching the one used for the experiment.
Move the actual sample carrier to the reference point marked as yellow cross in the sample
carrier graphic and confirm with ok to close the panel.
5. Calibrate the sample carrier with the following steps:
- 1/4 -> no changes, click Next.
- 2/4 -> Click Set zero, click Next.
- 3/4 -> Chose Search Reference Point (1 Point) from the drop down list, click Next.
- 4/4 -> Set Current XY, click Finish.
6. Activate FCS track .
7. Open Tiles Viewer and zoom out to see the carrier in total.
8. Select the following tool from the Positions icons on the left:
(Setup new positions
from an underlying sample carrier).
9. Mark the wells by clicking them indivually (Click-Strg) or select by drawing a contour around
the relevant ones holding the left mouse button while moving the curser.
10. Keep the default settings: Distribute Positions by Number, Number = 1, and Bias =
None.
11. Click Plus to add one position per marked well.
12. Click Start Experiment to acquire an FCS measurement per selected well.
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Info
Only one position per carrier well is supported.
Repeated measurements per well can be achieved combining this type of acquisition with a
Time series multidimensional acquisition.
Multiple Positions per well or tiles or combinations of tiles and positions are not supported and
will be deleted when the FCS track is activated
If the sequence of the positions is changed after their initial definition the timely sequence of
the position measurement data can only be deduced from the time stamp in the result table
within the FCS document. IDs of positions and measurement data match.

14.1.2.3.4 Setting the Parameters for the FCS/FCCS Measurement
1. Set the Measurement Time.
If you do not have any idea about the behavior of your sample, start with a measurement
time of about 10 seconds. Depending on the signal-to-noise ratio of your correlation curve,
decrease or increase the measurement time. As a rule of thumb the measurement time
should be about 1000 x the diffusion time of a molecule under study. However, due to
“photon noise” (photon shot noise) a 10 s measurement time is a good start value to obtain good statistical results.
2. Set the Repetitions.
Start with Repetitions set to 1. If you want to obtain information about the variation of
your fitted values later on, increase the Repetitions to produce a measurement series. 10
times is a good value to start with. Repetitions can be averaged into an average correlation
function if required. This will improve statistics. An average of 10 x 10 seconds Measurement Time is not as good as one 100 sec measurement. If bleaching becomes a problem, it
might help to reduce Measurement Time and increase Repetitions to obtain fairly good statistical results while reducing bleaching.
14.1.2.3.5 Choosing the Optimal Laser Power
1. Use the initially set laser power indicated in the Laser control panel in Imaging Setup or
Channels Tool.
2. Start a Continuos scan with an active FCS track and bring the Detector Counting tool
from the right tool area into view. A good starting point is a laser power which leads to a
count rate between 50 kHz and 200 kHz.
3. Change the laser power using the slider next to the active laser used for acquisition to increase or decrease the values to achieve such a count rate.
4. When finished, stop Continuous scan.

Info
For most dyes, the Counts / Molecule setting should be optimized in a second step to a value
just under its maximum by adapting the laser power. If carriers of different slide thickness are
employed, the Counts / Molecule setting should be optimized by using the correction ring of
the objective. The correction ring is turned counterclockwise or clockwise until a maximum
value is obtained. The correction ring should also be used for adjusting the Counts / Molecule
setting whenever the immersion media is changed. This is especially important in cases where
the refractive index of the immersion media is different from that of the sample.
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14.1.2.3.6 Adjusting the Pinhole
The pinhole is adjusted using a dye solution. For each excitation wavelength and MBS combination a suitable dye must be used.
We recommend:
§

Rhodamine 6 Green (Rh6G) or Alexa 488 for excitation lines 445, 488 and 514 nm

§

Tetra-Methyl-Rhodamine (TMR) or Alexa 546 for excitation line 543 nm or Alexa 568 for excitation line 561 nm

§

Cy 5 or Alexa 633 for excitation line 639 nm

We recommend to work with a relatively concentrated solution (10-6 mol/l) and low laser power
to achieve intensity curves with low noise.
Prerequisite ü All steps from FCS Measurement Setup for Labeled Molecules in Solution [} 956] up to the
step Pinhole Adjust have been performed.
1. Set the laser power to achieve above 100 kHz count rate, if possible.
2. Click Adjust in the pinhole panel of the Channels tool.
3. Click the Coarse button of X first and then Y to perform a coarse adjustment scan in x and
then in y.
à The pinhole will travel over the maximum range for each axis.
à The adjustment scan in y will use the optimum setting found for the x axis.
4. Perform a fine adjustment in x and y by subsequently clicking the Fine buttons.
à For the fine adjustment the pinhole will travel only a limited distance (about 10 microns)
around the peak determined in the coarse adjustment or around the current stored position of the pinhole if the coarse adjustment was skipped.
5. If the pinholes are adjusted for the first time, the coarse adjustment must be performed first
followed by the fine adjustment, each time for x and y. For subsequent readjustments, the
fine adjustment is typically sufficient.
6. In case more lasers and detectors are selected, the adjustment scan will be done for all
lasers / detectors simultaneously.
7. When using the 405 nm laser it might be necessary to adjust the collimator for optimal
overlay in Z. This should be done in advance to the pinhole adjust procedure if necessary
(see Collimators Adjustment [} 976]). The collimating lens is pre-set at delivery and is a
function of the wavelength and objective used. In case a new objective is used with the system this value needs to be determined anew.
8. The values determined by the adjustment scan for the X and Y position of the pinhole(s) are
indicated by the position of the line in the graph as well as the slider and the number in the
edit box. In case this value is not accepted it can be changed by moving the slider or typing
in a different value.
9. Click finish to store the indicated X and Y values as general pinhole settings for the main
dichroic used. This value will now be used for the current and future FCS / FCCS measurements.
It is recommended to adjust the pinhole for FCS measurements on a regular basis.
10. The adjustment scan can be performed separately for X and Y. The values can be stored independently as well. However it is recommended to adjust both values and store them
both.
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14.1.2.3.7 Performing a Z-Scan
The Z-Scan is especially suitable to position the confocal volume on a cell membrane. Due to the
shape of the confocal volume, the membrane should not be approached from the side but instead
rather from the top of the cell. Please note that it is better to use the upper membrane for measurement, since the lower membrane might be too close to the glass bottom surface resulting in
disturbing reflections. Besides using the Z-Scan you can also position the membrane manually, albeit with less precision.
Prerequisite ü Dye/Molecule available/expressed in suitable concentration within cultured cell.
ü High NA objective selected for imaging.
ü Pinhole adjusted with test sample previous to the measurement (if needed) (see Adjusting the
Pinhole [} 959]).
ü FCS track defined and active.
ü Cell of interest positioned in the center of the scan field and manually focused as best as possible acquiring a confocal image.
1. In Channels tool, click Z-Scan button.
2. Set the range and step width for the scan suitable for the sample.
3. Start the Z-Scan.
à The resulting graph should typically show two peaks (from the lower and upper membranes). High signal intensity may correlate to the labeled membranes.
à If the glass surface happens to be in the Z-Scan range it will also give a peak. To determine its position, perform a Z-Scan at a position where there is no cell. If the glass reflection contributes so much that the peaks of the membranes are hidden due to scaling,
shorten the scan range to avoid picking up the signal.
4. Place the red line at the peak that corresponds to the membrane and select this Z-position.
5. If no clear signal can be detected, or the peak of interest lies too close to the range extremes, take over the Z position most likely to represent the wanted one by moving the bar
to this position and clicking Finish.
6. Restart the Z-Scan at this Z position with an adjusted range and step width and take over
the then defined Z position for the FCS measurement.
14.1.2.3.8 Saving and Loading FCS Data
Whenever Save FCS raw data file is activated in the Acquisition Selection/LSM of the Options
tool, the raw data file is saved along with the *.FCS file in the folder selected for saving the *.FCS
file.
*.RAW files contain the same name than the *FCS.fcs file with name extensions, which identify
the repetition and the channels.
The measurements can be saved individually using the standard save tools or by activating Auto
Save in the left tool area. The *.FCS file includes the whole data set (curves, fitting results, fit parameters).
Whenever a *.FCS file is opened the data show up in the Correlation view tab of the FCS document (see Correlation Tab [} 922]).
The Reload function (see Reload Tool [} 935]) is only available if raw data have been saved along
with the *.FCS file.
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14.1.2.3.8.1 Format of *.RAW Files
*.RAW files are saved optionally when activating the storage of raw data in the options menu (see
Saving and Loading FCS Data [} 960]). The *.RAW data files can be opened directly in ZEN. They
are also opened automatically if linked to a *.FCS file. In this case all raw data files associated with
the *.FCS file will be opened in the same FCS document.

Info
Raw data formats can also be opened in ZEN Black (all versions).

Info
The sampling rate is set to 15 MHz. Depending on the detector used for FCS measurements, a
maximum data rate of up to 16 Mbyte/sec is achieved.
The recorded test has the following structure:

Bit
0 (LSB) ... 7

Meaning
§ clock countervalue (starting at 1) during the triggering event
§ trigger events are pulse recordings or counter overruns
§ zero is reserved and only transmitted at the end of the measurement

8

1, if pulse recorded in channel 1 during cycle bt1; else 0

9

1, if pulse recorded in channel 2 during cycle bt1; else 0

10

1, if pulse recorded in channel 1 during cycle bt2; else 0

11

1, if pulse recorded in channel 2 during cycle bt2; else 0

12

1, if pulse recorded in channel 1 during cycle bt3; else 0

13

1, if pulse recorded in channel 2 during cycle bt3; else 0

14

1, if pulse recorded in channel 1 during cycle bt4; else 0

15 (MSB)

1, if pulse recorded in channel 2 during cycle bt4; else 0

Tab. 7: Structure of the recorded text
The following examples illustrate the format. The tables show part of the running pulse train
(from left to right) divided into clock cycles. "1" in the corresponding box indicates that a pulse arrived in this cycle. The "counter" row shows the counter readings. The lowest row indicates when
the text has been recorded.
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Fig. 101: Examples of the recorded text
The following text is recorded:
Example 1:
§

at W1: high byte: 00011001(bin) = 19 (hex); low byte: 123 (dec) = 7B (hex); resulting word =
7B19 (hex)

§

at W2: high byte: 00000000(bin) = 00 (hex); low byte: 255 (dec) = FF (hex); resulting word =
FF00 (hex)

Example 2:
§

at W1: high byte: 00010001(bin) = 11 (hex); low byte: 123 (dec) = 7B (hex); resulting word =
7B11 (hex)

§

at W2: high byte: 00100100(bin) = 24 (hex); low byte: 255 (dec) = FF (hex); resulting word =
FF24 (hex)

Info
The first 30 bytes of the raw data file contain the comment "ConfoCor_x__Raw_data_file_1.0" and must be ignored.
The format is processed into one that describes the time distance between photons.
The format is explained in the following figure. The figure displays the raw data with an editor
program that shows the raw data in file offset, hexadecimal, and as ASCII.

Fig. 102: ZEN raw data format
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Explanation

0-63

§ represent the file identifier with the channel number

ZEISS

64-79

§ measurement identifier
The identifier is a randomly created number that will be assigned to
all channels, repetitions, positions and kinetic indices of the same
measurement. Hence, in a cross-correlation experiment, the two
auto-correlation pairs that belong together can be identified.

80-83

§ encode the position of the measurement
§ zero based

84-87

§ encode the kinetic index
§ zero based

88-91

§ encode the repetition number
§ zero based

92-95
96-127

§ encode the detector frequency in Hz
§ reserved for comments
§ set to 0

128-corresponding to a file offset of 7F
(hex)=127 (dec)to 131
starting from
132

§ code for the first pulse distance in detector clocks

§ code for follow up pulse distances

Tab. 8: Explanation of raw data code
14.1.3 Imaging Setup
14.1.3.1 LSM Confocal
Chose LSM confocal as acquisition track for standard confocal acquisition. The following channels
are available for confocal acquisition:
§

Ch1 = Multialkaline PMT (available for all configurations)

§

ChS1 to ChS4 = GaAsP PMT (part of a 6 or 32 channel configuration)

§

ChS5 to ChS8 = GaAsP PMT (part of a 32 channel configuration)

§

Ch2 = Multialkaline PMT (part of a 6 or 32 channel configuration)

§

Ch2 = GaAsP PMT (part of a 3 channel configuration)

§

Ch3 = Multialkaline PMT (part of a 3 channel configuration)

§

ChA = GaAsP PMT (optional, part of a configuration with )

§

T-PMT = Mulitalkaline PMT (optional multialkaline PMT in transmission)

§

GaAsP 1 and GaAsP 2 = GaAsP PMT (optional, detection module attached to DCout port)
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Info
LSM confocal tracks can be used in a multitrack acquisition with either NDD (Non Descanned
Detector) tracks or Airyscan SR tracks.

1

2
3
7
4

5

8

6

9

10

11
Fig. 103: Imaging Setup, LSM Confocal
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Switch track every
Select the switch mechanism by which the hardware is changed between the tracks in
case a multitrack acquisition is set up.
§ Line
Switches tracks in between every line of an image.
This mode switches between the used laser line for each track and the detection channel(s) used for acquisition with their predefined gain and offset. Other hardware settings like filters, pinhole or the spectral width of a channel cannot be changed in between tracks.
This mode is especially useful for applications with high temporal correlation between
the different emission signals.
§ Frame
Switches tracks in between every full image frame.
This mode allows to change all kinds of hardware in between tracks including main
dichroic beam splitters, secondary beam splitters, emission filters for , filters in the reflector turret, the pinhole and the spectral width of the channel. This provides a highly
specialized acquisition mode but with a slower overall acquisition.
§ Frame Fast
Switches tracks in between every full image frame (fast).
This mode works similar to line wise switching with the difference that tracks are
switched after each full image frame. The same restrictions as with line wise switching
apply to parameter changes in between tracks. This mode reduces the frequency of
sample illumination for each dye
§ Z-Stack
Switches tracks in between every full image stack.
This mode is only available for image acquisition using Z stacks. The mode switches
tracks in between every full Z stack acquisition. This reduces imaging time as switching
between tracks is performed less often when for each image a frame wise multitrack is
the best choice.

2

Spectral display
Shows the emission spectrum of the selected dye(s) assigned to active or non active
channels of the displayed track and the laser lines used for excitation.

3

Detection range
A bar slider shows up for each activated channel. The slider color matches the color chosen for the corresponding channel. Channel 1 to Channel 3 are aligned from left to right.
The width of the sliders represent the detection range covered by the respective channel.
Change position of a slider with the left mouse button using the cross which appears
when the cursor is moved over the slider. Accordingly, use the arrows at the edges of a
slider to expand or shrink the width of the slider. Moving and adaption is only possible
for internal channels. Channels with emission filters like or cannot be adapted in their
spectral range unless a different filter is selected.
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Emission filter for Airyscan
When Airyscan (ChA) is selected as detection channel the selection for Airyscan emission
filters shows up in this line area. Chose a matching emission filter from the drop down
list which opens up when clicking the arrow on the left hand side of the bar. As with the
internal channels, the setting of the SBS filter affects the detection range of the Airyscan
detector. This again is shown as a (partially) empty bar.

5

Channel selection area
This panel lists all available detection channels for LSM Confocal mode. Select / unselect
checkbox Use for activation / deactivation of individual channels. Assign a dye to a channel by clicking the Dye drop down arrow and selecting a dye from the Add Dye or Contrasting Method Tool Window. Assig a color to the channel by clicking the arrow in the
Color column and selecting a color from the LUT. The color can also be changed in the
Channels tool. The name changes to the name of the dye if a dye is selected for this
channel. The name can be changed in the Channels tool and then shows up also in the
Imaging Setup. The Range column displays the detection range of each channel. For internal channels the detection range can be adapted as described above. In addition it is
possible to edit the upper and lower border of the detection range by clicking into the
range column. Use the arrows or the editing field to precisely adapt the detection range
as needed.

6

Reflection
Check the box for imaging in reflection mode. This mode provides an easy tool to get a
better understanding of surface structures.
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Secondary beam splitters
The line with the drop down arrow represents the secondary beam splitter (SBS) filter
wheel. It allows to direct light to the DCout port where or might be attached. The SBS filter wheel is automatically set to mirror for LSM confocal tracks as typically only internal
channels are used in this mode. Mirror directs all emission light to the internal channels.
If light should be detected by or as another confocal channel, click the arrow and select a
filter from the drop down list. Long pass filters will direct light of longer wavelength to
or . Short pass filters will direct light of shorter wavelength to or . The filters can also be
selected by moving the line from left to right. The detection range of the internal channels might be affected by using a SBS filter. This is marked by a (partially) empty bar
slider for an internal channel.

8

Icon to select polarization filters
The emission light can be filtered using polarization filters. The filters are set in track wise
acquisition mode for detecting S and P polarized light. With this approach polarizsation
anisotropy can be measured. Click onto the icon to select one of the two polarization filters. See Obtaining an Anisotropy Image [} 915]for further instructions.

9

Main dichroic and laser line icon for visible lasers (445, 488, 514, 543, 561, 594,
639 nm)
The two icons are one for the main beam splitter and one for the laser line which is coupled to the port facing the corresponding main dichroic filter wheel. When selecting a
laser line either in this tool window or otherwise (see Lasers Tool or Channels Tool
[} 702]) the matching main dichroic filter is set automatically. The filter changes again
upon selection of an additional laser line or a different laser line if necessary. Deactivation of a line does not change the main dichroic filter. In case no matching dichroic is
available the 80/20 dichroic is selected. You can change the dichroic to a self-chosen setting if needed. Note that only after chosing an additional line or unselecting and reselecting a different (combination of) line(s) the filter will be changed again automatically.
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Main dichroic and laser line icon for in-visible lasers (405 nm, Multiphoton Laser)
The two icons are one for the main beam splitter and one for the laser line which is coupled to the port facing the corresponding main dichroic filter wheel. When selecting a
laser line either in this tool window or otherwise (see Lasers Tool or Channels Tool
[} 702]) then the matching main dichroic filter is automatically set. The filter changes
again upon selection of an additional laser line or a different laser line. Deactivation of a
line does not change the main dichroic filter. In case no matching dichroic is available the
80/20 dichroic is selected. You can change the dichroic to a self-chosen setting if
needed. Note that only after chosing an additional line or reselecting a different (combination of) line(s) the filter will be changed again automatically. Make sure to deselect all
lines first before selecting a new (combination of) laser (lines).

11

Reflector Turret icon
When LSM 980 is attached to the rear port of Axio Observer it can be necessary to control the position of the reflector turret of the stand when acquiring a LSM image. For
multiphoton systems two positions of the reflector turret are equipped with specific
dichroics to reflect the emission signal to NDD channels in reflection. When using NDD
tracks (see NDD (Non Descanned Detector) [} 973]), select the matching dichroic for
NDD detection.
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14.1.3.2 Airyscan SR
Chose Airyscan SR as acquisition track for superresolution imaging with highest image quality. The
following channel is available for Airyscan SR acquisition:
§

ChA = GaAsP PMT (optional, part of a configuration with )

1

2
3

4
Fig. 104: Imaging Setup, Airyscan SR
For Airyscan SR tracks the SBS filter wheel is automatically set to plate to direct all emission light
to .
All other controls are identical to LSM confocal tracks.
Airyscan SR tracks can be combined in a multitrack acquisition with LSM confocal tracks.

1

Spectral display
Shows the emission spectrum of the selected dye assigned to and the laser lines used for
excitation.

2

Secondary beam splitters
The line with the drop down arrow represents the secondary beam splitter (SBS) filter
wheel. It allows to direct light to the DCout port to or . The SBS filter wheel is automatically set to plate for Airyscan SR tracks. If Airyscan SR tracks should be combined with
LSM confocal tracks, the SBS filteres can be used to split the light between the internal
channels and Airyscan.
Click the arrow and select a filter from the drop down list. Long pass filters will direct
light of longer wavelength to . Short pass filters will direct light of shorter wavelength to
Airyscan. The filters can also be selected by moving the line from left to right. The detection range of might be affected by using a SBS filter. This is marked by a (partially) empty
bar representing the detection range.

3

Emission filter for Airyscan
Chose a matching emission filter from the drop down list which opens up when clicking
the arrow on the left hand side of the bar.
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Channel selection area
This panel displays the per default activated Airyscan channel. Assign a dye to the channel by clicking the Dye drop down arrow and selecting a dye from the Add Dye or Contrasting Method Tool Window. Assign a color to the channel by clicking the arrow in the
Color column and selecting a color from the LUT. The color can also be changed in the
Channels tool. The name changes to the name of the dye if a dye is selected for this
channel. The name can be changed in the Channels tool and then shows up also in the
Imaging Setup. The Range column displays the detection range of the Airyscan channel.
It is dependent on the selected emission filter.

14.1.3.3 Airyscan MPLX
Multiplex modes allow a faster image acquisition with Airyscan 2 detectors. The acquisition is parallelized in the Y-direction, which allows to process full SR or confocal resolution though not every
line in Y was scanned during acquisition. The Airyscan 2 detector has nonetheless acquired data
for all lines in the image.
Airyscan MPLX can be selected in the drop down list of the Imaging Setup.

For information on how to acquire LSM images with Airyscan multiplex modes, see Acquiring LSM
900 images with Airyscan 2 multiplex modes [} 76] or Acquiring LSM 980 images with Airyscan 2
multiplex modes [} 79].
14.1.3.4 LSM Lambda
Chose LSM Lambda as acquisition track for spectral imaging with subsequent dye unmixing (emission fingerprinting). The mode allows to separate strongly overlapping emission signals.
The following channels are available for LSM Lambda acquisition:
§

Ch1 = Multialkaline PMT (part of a 6 or 32 channel configuration)

§

ChS = GaAsP PMT (part of a 6 or 32 channel configuration)

§

Ch2 = Multialkaline PMT (part of a 6 or 32 channel configuration)

§

Ch2 = GaAsP PMT (part of a 3 channel configuration)
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4

Fig. 105: Imaging Setup, LSM Lambda

Info
Lambda tracks cannot be used in a multitrack acquisition.

1

Dye selection panel
Add the emissions spectra of the dyes to be unmixed to the spectral display panel. When
clicking + the Add Dye or Contrasting Method selection panel appears. Chose the
corresponding dye and repeat the step for any further dye within your sample. The emission spectra are displayed in the spectral display panel.

2

Spectral display panel
The emission spectra of all selected dyes are displayed in this region to get a better overview over the needed detection range and possibly the necessary spectral resolution.

3

Resolution
Chose the spectral resolution in the drop down list. The Number of Scans which will be
performed for the selected resolution is displayed on the right side. Depending on the
scan head configuration the acquisition of the emission fingerprint image is either done
in parallel with one illumination of the sample (32 channel configuration with 8,9 nm or
lower spectral resolution) or in several illumination steps (32 channel configuration with
4,3 nm or higher spectral resolution; 6 and 3 channel configuration).

4

Detector selection panel
Activate the necessary detectors for the spectral acquisition. If the spectra do not reach
out into the far red or the lower blue range, ChS (or Ch2) suffice for image acquisition.
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14.1.3.5 LSM Online Fingerprinting
Chose LSM Online Fingerprinting as acquisition track for spectral imaging with automatic subsequent dye unmixing (Emission Fingerprinting). The mode allows to separate strongly overlapping
emission signals with final reduced data volume as no raw data are stored. The mode speeds up
data generation in case the parameters for unmixing are known.
The channel for Online Fingerprinting is selected automatically.

1

2
3
4
Fig. 106: Imaging Setup, LSM Online Fingerprinting

Info
Online Fingerprinting tracks cannot be used in a multitrack acquisition.

1

Spectral display panel
This area displays the emission spectra of the selected dyes.

2

Spectral range slider
Define the spectral width for the collection of the fluorescent signals by moving, expanding or shrinking the bar slider using the left mouse button.

3

Resolution
Chose the spectral resolution in the drop down list. The Number of scans which will be
performed for the selected resolution is displayed on the right side. Depending on the
scan head configuration the acquisition of the emission fingerprint image is either done
in parallel with one illumination of the sample (32 channel configuration with 8,9 nm or
lower spectral resolution) or in several illumination steps (32 channel configuration with
4,3 nm or higher spectral resolution; 6 and 3 channel configuration).

4

Dye selection
Select one or more dyes from the unmixing spectra database. Online Fingerprinting requires pre-defined spectra which will be used for the automatic subsequent unmixing
process. The settings for Online Fingerprinting (resolution, spectral width) should ideally
match the acquisition parameters for the unmixing spectra.
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14.1.3.6 NDD (Non Descanned Detector)
Chose NDD as acquisition track for multiphoton imaging. Using non descanned detectors for
imaging when exciting with a multiphoton laser provides a significantly better image quality for
deep tissue imaging.

Info
Filters in front of NDDs have to be inserted/changed manually. The indication of changed filters to ZEN software needs to be done with the MTB software. It is possible to do this when
ZEN is running by clicking on Apply after changing the filters as needed.
The following channels are available for NDD acquisition (all channels are optional; if non-descanned detectors are not available, NDD tracks cannot be set up; the maximum number of channels in reflection/transmission mode is limited to 5 and dependent on the type of stand used):
§

NDD.2 (2 channels) in reflection mode (for all stands)

§

NDD.2 (2 channels) in transmission mode (for Axio Observer and Axio Examiner)

§

NDD.2 single channel as channel 3 or 4 in reflection mode (only in combination with NDD.2;
all stands; for Axio Examiner also in transmission mode))

§

BiG.2 (2 channels) in reflection mode (for all stands)

§

BiG.2 (2 channels) in transmission mode (for Axio Examiner)

§

GaAsP NDD 2 channels in reflection mode (for Axio Examiner only, in addition to other channels in reflection mode)

1
2

3

4

Fig. 107: Imaging Setup, NDD

Info
NDD tracks can be used in multitrack acquisition with other NDD or LSM confocal tracks.NDD
tracks can be used in multitrack acquisition with other NDD or LSM confocal tracks. When the
tracks are switched between NDD and other modes during an experiment, the system shows a
safety warning which, however, does not impair data acquisition but is only commenting on
the intermediate state where the correct safety measures kick in.
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Display of detection range as colored bar for NDDs positioned in reflection mode
This area displays the detection range of all selected channels. Only detectors which collect the fluorescent signal reflected from the sample are represented in this line.

2

Spectral display area
The emission spectra of dyes allocated to active channels are displayed.

3

Display of detection range as colored bar for NDDs positioned in transmission
mode
This area displays the detection range of all selected channels. Only detectors which collect the fluorescent signal transmitted through the sample are represented in this line.

4

Channel selection area
This panel lists all available detection channels for NDD mode. Select / unselect checkbox
Use for activation / deactivation of individual channels. Assign a dye to a channel by
clicking the Dye drop down arrow and selecting a dye from the Add Dye or Contrasting
Method Tool Window. Assig a color to the channel by clicking the arrow in the Color column and selecting a color from the LUT. The color can also be changed in the Channels
tool. The name column lists the names of the detection channels. The name changes to
the name of the dye if a dye is selected for this channel. The name can be changed in the
Channels tool and then shows up also in the Imaging Setup. The Range column displays
the detection range of each channel which depends on the emission filter placed in front
of the channel.
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14.1.3.7 LSM FCS

Fig. 108: Imaging setup. LSM FCS
The Imaging Setup tool allows to chose LSM FCS as acquisition mode for FCS/FCCS measurements. This track lists all available detectors which can be used for FCS/FCCS measurements. The
number of detectors changes with the configuration of the system. A maximum of seven (32+2 ch
configuration), 5 (6+2 ch configuration) or 2 channels (2+1 ch configuration) can be selected for
FCS/FCCS. An additional 2 detectors are listed independent of the configuration in case BiG.2 is
mounted onto the DCout port of the scan head.
The following channels are available:
§

ChS1 to ChS4 = GaAsP PMT (part of a 6 or 32 channel configuration)

§

Ch2 = Multialkaline PMT (part of a 6 or 32 channel configuration)

§

Ch2 = GaAsP PMT (part of a 3 channel configuration)

§

GaAsP 1 and GaAsP 2 = GaAsP PMT (optional, detection module attached to DCout port)

Activate one or more detectors as needed for the experiment. In the lower panel these detectors
can then also be activated for cross-correlation (FCCS) data analysis.

14.1.4 System Maintenance
Use the System Maintenance and Calibration dialog within the Tools menu to check on essential parameters of the LSM.
1. Open Tools | System Maintenance and Calibration…
2. Use the Default mode for a user's routine.
3. Perform the following maintenance procedures as described in the safety and operating
manual:
- Scanner calibration
- Pinhole to MBS calibration
4. Follow the instructions of the wizard.
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à In case the test does not pass you might want to repeat the procedure. If the problem
persists you need to check with your local ZEISS service engineer.
The following additional tests provide information on the quality of the system:
§

The scanfield test provides information on the quality of the scanner calibration. If this quality
repeatedly fails although the scanners have been calibrated, it might be necessary to exchange the scanners. Contact your local ZEISS service engineer.

§

The sharpess test provides information on the resolution contrast. This parameter is dependent on the overall alignment of the system and the quality of the detectors. If detectors deteriorate then this test failing might be an indication for a necessary exchange of a detector.

14.1.4.1 Collimators Adjustment
The position of the collimator(s) for lasers coupled to the invis port can be adjusted if needed. The
position is dependent on the wavelength and the objective used. The collimator position is a function of the system and the position is not part of an experiment and hence cannot be reloaded
with an experiment or re-used with an image.
For tunable Multiphoton lasers it might be necessary to adjust the collimator for a given wavelength and objective as the laser is set up together with the LSM first time at the customers.
Use the following parameters to adjust the collimator.

Parameter

Description

Collimator

Chose the collimator you want to adjust. In case no Multiphoton laser
lines are available only the collimator for 405 nm laser is accessible.

Position

Use the slider or the editing box to change the position of the collimator. Check the image of a continuously scanned sample (i.e. LSM calibration objective) for highest intensity. In case you want to align the
collimator for optimal overlap with vis lasers, perform for example a
reflection line scan with vis laser and focus for highest signal. Then
adjust the collimator of the invis laser for highest image intensity. If
both reflection images show highest intensity the excitation level
matches.

Store Current Pos

Stores the current position as the default position for the selected collimator.

Move to Stored
Pos

Moves the position of the selected collimator to a stored value for the
given wavelength and objective. Stored positions are automatically set
when an objective is changed or the laser is tuned (Multiphoton
laser). The current non stored settings are kept for an experiment if
the laser is not tuned or the objective is not changed.

14.1.4.2 Pinhole Adjustment
The position of the pinhole (or rather the laser beam in X-Y-coordinates) in relation to the detector makes a major contribution to image optimization.
The pinholes have already been adjusted at the factory. These settings are taken over for active
operation when a standard configuration is loaded.
If you want to create a setting that differs from the standard configurations, use the following parameters.
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Parameter

Description

Diameter [µm]
slider

Changes the diameter of the pinhole

X Position [Vis]

Changes the X position of the excitation beam of all vis lasers in relation to the pinhole

Y Position [Vis]

Changes the Y position of the excitation beam of all vis lasers in relation to the pinhole

X Position [Invis]

Changes the X position of the excitation beam of all invis lasers in relation to the pinhole

Y Position [Invis]

Changes the Y position of the excitation beam of all invis lasers in relation to the pinhole

Store Current Pos

Stores the current position as the default position for the given lasers
and main dichroic filter

Moved to Stored
Pos

Resets the pinhole position to the stored value

14.1.4.3 Periscope Adjustment
Multiphoton lasers are steered into the scan head of the LSM via a free beam coupling. The components of the coupling kit ensure that the laser beam is enclosed within metal pipes. The coupling components include a periscope which lifts the free beam up to the height it needs to have
to hit the coupling port of the scan head. The positioning of a freely coupled laser beam is subject
to temperature changes, potentially mechanical influences and the laser itself. When tuning the
laser, it very slightly changes its position. When working with two laser beams the precise overlay
of the two beams can be critical for the experiment. Hence the “Adjust Periscopes” tool provides
access to the motorized steering mirrors within the periscope to adjust for possible mismatches
between the two laser beams.
The periscope contains two sets of mirrors for each beam. One set has more influence onto the
homogeneity of the illumination, the other set is rather adjusted for a precise overlay between the
two beams. For a good coupling both the lateral position as well es the angle of the beam needs
to be adjusted to have the laser travel along the center of the optical axis.
The best reference to achieve this is an image of a structured and fluorescent sample taken with
the 488 nm laser. Such a sample can also be purchased at ZEISS.
The following controls are available:

Parameter

Description

Reference Image

A drop-down list opens listing all open images with the last one acquired on top of the list. The selected image appears as overlay image
in the continuous image tab.

Opacity

Opacity relates to the reference image display in the continuous image tab. 100% does only show the reference image, 0% does only
show the continuously acquired image.

On

Switches the overlay image on/off (set opacity/0% opacity) for quick
cross check on overlaid structures.
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Parameter

Description

NLO 690-1300 nm

Click to select the periscope mirrors for the tuneable line of the Multiphoton laser.

NLO 1045 nm

Click to select the periscope mirrors for the fixed line of the Multiphoton laser.

Arrow button for
various directions

Depending on the selection of the laser line, the arrows move the
beam and hence the continuously acquired image taken with the NLO
laser in the indicated direction. The arrows allow fine and course
movement steps. The number of steps is displayed next to the arrow
buttons.

Move to zero

A current absolute position of each mirror pair can be defined as position zero. This resets the number of moved steps to zero.

Set position zero

Moves the mirrors back to the zero position. The position of the mirrors present at each start of the system is taken as initial zero.

14.1.4.3.1 Correcting inhomogeneous illumination
Prerequisite ü Sample with homogeneous fluorescence is placed in the sample holder (the samples fluorescence must be excitable by any NLO line).
ü The preferred objective for the alignment for Axio Observer: 10x; for Axio Examiner: 20 x 1.0 .
ü The sample is in the field of view and focused.
ü The tuneable Multiphoton laser line is tuned to the desired wavelength.
ü The acquisition parameters are set to have the maximum field of view and imaging speed of 9
or 10 to quickly see the changes in the image when clicking the alignment arrows.
ü Imaging Setup is configured using one internal detection channel at relevant spectral range
with open pinhole.
ü Multiphoton laser is activated for the single channel acquisition track.
1. Open Tools > System Maintenance and Calibration.
2. Select the tool Adjust Periscopes.
3. Select laser line of which the periscope mirrors should be controlled to check/align for homogeneous illumination.
4. Start a Continuous scan.
5. Set laser power and detector gain for optimal imaging with just the first pixels in saturation
(check with range indicator LUT).
6. In case the brightest area is not centered use arrow keys to center the brightest area.
7. Use also a profile line for better visualization of the intensity distribution.
à The motor steps of each mirror are counted to easily move back to the original value.
8. Stop continuous scan when illumination is optimized.
9. The final mirror positions can be set as new zero.
à This position will be constant unless the mirrors are moved again.
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14.1.4.3.2 Correcting overlay of both NLO laser lines
Prerequisite ü Sample with homogeneous fluorescence and structures with high contrast is placed in the
sample holder (the samples fluorescence must be excitable by any NLO line).
ü Chose the objective relevant for the application.
ü Higher NA allows for higher precision when checking and correcting the overlay.
ü The sample with its structured part is in the field of view and focused.
ü A single snap image using preferably the 488 nm laser is acquired as reference image with
good visibility of the structures.
ü The tuneable NLO laser line is tuned to the desired wavelength.
ü Imaging Setup is configured using one internal detection channel at relevant spectral range
with open pinhole.
ü The acquisition zoom and the stage position are kept constant and are identical to the acquisition of the reference image.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.

Open Tools > System Maintenance and Calibration.
Select the tool Adjust Periscopes.
Select the just acquired single image as reference image.
Select laser line of which the periscope mirrors should be controlled to check/align for image overlay.
Activate this laser for acquisition in the Channels tool.
Start a Continuous scan.
Set laser power and detector gain for optimal imaging.
Set opacity of the reference image such that the structures of the reference image and the
continuously scanned NLO image are visible.
Use the arrow keys for overlay to overlay the structures of the continuously scanned image
with the reference image.
It might be necessary to use the overlay and illumination mirrors alternately to achieve the
optimum result.
The motor steps of each mirror are counted to easily move back to the original value.
The reference image can be quickly switched on/off for quick alternating display of the
structures.
The final mirror positions can be set as new zero. These positions will be constant unless
the mirrors are moved again.
Repeat step 4 to 12 for the other NLO laser line.

Info
If the alignment of the Multiphoton laser is off and only part of the beam or no beam is visible
in the objective plane do not attempt to align using this tool. The tool is designed to correct
for minor mismatches occurring when the laser is tuned or small influences on minor temperature fluctuations. It is assumed that the system is set up in a temperature-controlled room
without major air flow as is described in the system setup requirements.
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14.1.4.4 Airyscan Detector Adjustment
14.1.4.4.1 Introduction
The tool provides controls for the automatic alignment of the Airyscan detector during system operation. The status of the current adjustment is indicated in the status bar of ZEN whenever the
Airyscan detector is in use in Airysan SR or Airyscan Multiplex tracks.
The tool can be opened via the System Maintenance and Calibration dialog located in the
Tools menu or by clicking the arrow next to the icon of the detector in the status bar.

1

2

3

4
5

6

Fig. 109: Airyscan Detector Adjustment tool

No.
1

Parameter

Description

Quality and
Status

Shows the adjustment status.

-

No signal available

-

Not enough light or too much
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No.

Parameter

Description

-

Alignment ongoing

-

Alignment done and ok

- Manual
Mode:

- Automatic

ZEISS

The adjustment can be done using the sliders under Fiber position.
The adjustment is performed as defined in Activation.

Mode:

2

Activation

Activate the alignment during Live and Continuous mode.
Activate the alignment during Time Series Acquisitions with
Interval.

3

Fiber position

Use slider to change the adjustment of the fiber in x and y for
manual positioning. The slider can only be operated in Manual
Mode.

4

Store Current
Pos

Stores the current positions of x and y for further reference.

5

Move to
Stored Pos

Moves both sliders to the stored position. Going to the stored
position is a good start when manually realigning the detector.

6

Detector View

Shows the current intensity distribution of the emission signal
over the detector elements.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

981

14 Systems, Applications & Components | 14.1 LSM 980

ZEISS

14.1.4.4.2 Adjusting the Airyscan Detector automatically via the status bar
1. To access the detector adjustment, click on the detector symbol at the Status bar. Depending on the selected Airyscan mode, the illumination pattern varies in geometry. A correct
adjustment is always symmetrical and centered.

2. Start a live or continuous scan to automatically adjust the Airyscan 2 detector.
3. Activate the checkbox Adjust in live and continuous scans. Alternatively, start a time series with intervals and activate Adjust in time series with interval.

The pattern of the active Airyscan detection elements might vary depending on the chosen
Airyscan detection mode.
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14.1.4.4.3 Adjusting the Airyscan Detector automatically via System Maintenance and Calibration

Info
When using 405nm laser in one track and any other laser in the second track, use continuous
mode with both tracks active for Airyscan detector adjustment. The alignment for 405nm laser
depends on the alignment of the other lasers first. If the tracks are adjusted individually the
alignment is mutually overwritten and cannot work properly.

Info
In case the experiment requires image acquisition in multi-track mode with frame wise switching between the tracks and one track using the 405 nm laser for excitation, the following setting needs to be defined to achieve an automatic adjustment of the Airyscan detector during
Continuous mode: Keep the main dichroic for the 405 laser identical between all tracks
whether the tracks work with the 405 laser or not. Otherwise the switching of the MBS between the tracks does not allow to finalize the adjustment and the system stops with an error
message. Do also check the suggestions for track setups which are made by Smart Setup..

Info
When Airyscan is used as detector for LSM confocal track, alignment is not needed. The alignment is set to the stored position.
Use manual mode if the alignment takes to long or does not work. Move slider to the stored position first for a good start.
Prerequisite ü Airyscan SR or Airyscan MPLX track is set up
ü Icon for Airyscan Adjustment status visible in the status bar
1.
2.
3.
4.
5.
6.

7.
8.

Open Tools > System Maintenance and Calibration ...
Select Default as the desired user group .
Click on Continue.
Click on Airyscan Detector Adjustment.
à The Airyscan Detector Adjustment dialog appears.
Activate Adjust in live and continuous scans.
Start a Live or a Continuous scan.
à When light is reaching the detector, the distribution of the intensity over the detector elements is displayed (detector view icon).
Keep scanning and adjust detector gain/laser power in case the light level is to high/low.
Increase scanning speed (for Continuous mode only) to speed up the alignment procedure.
à When the light level is ok, the icon shows in red with a yellow warning triangle and the
alignment is still ongoing.
à When the alignment is done and ok the icon turns green and quality and status ore OK;
the detector element with the brightest signal is the one in the center/middle line (depending on the imaging mode SR versus MPLX).
à With stable room conditions according to the specifications (see Safety and Operation
instructions) there is no need to readjust the detector for every new experiment.
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14.1.4.4.4 Adjusting the Airyscan Detector manually
1. Click on the detector symbol at the Status bar. Depending on the selected Airyscan mode,
the illumination pattern varies in geometry. A correct adjustment is always symmetrical and
centered.

2.
3.
4.
5.

Deactivate all check boxes.
Move the sliders for the Fiber position of X and Y until the detector symbol turns green.
Click on Store Current Pos to save the adjustment setting.
Click on Move To Stored Pos to override the position found by the check boxes and will
keep this position if live or continuous scan is off.

The pattern of the active Airyscan detection elements might vary depending on the chosen
Airyscan detection mode.
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14.1.4.5 Adjusting Readback Signals
The following function adjusts the readback signals of the scanner when a spline scan is performed (see Parameters for LSM Imaging Modes [} 688])
To adjust the readback signals proceed as follows:
1.
2.
3.
4.
5.

Set image acquisition to mimimal zoom and a slow speed like 5 or 6.
Chose Acquisition tab | Acquisition Mode tool |Line scan mode.
Click Line select >> to start a continuous scan.
Select LineSelect tab | Spline Mode.
Draw a scan line ideally covering a large area of the image.
à The readback signal curve will show up as a second line.
6. If this readback signal does not match with the drawn line, use the various sliders (Factor
and Position for X and Y) to achieve maximum overlay between the two lines.
7. For the spline scan itself it might then be necessary to reduce the scan speed and / or reduce the bend of the spline curve to achieve optimal spline scan positioning.
The adjustment of the readback signal should be checked now and again if the overlay of the signal with the spline graphics does no longer sufficiently match.

14.2 ApoTome.2
14.2.1 Introduction
In the following chapters you will learn how to calibrate the ApoTome for a two-channel experiment and acquire a two-channel image. This image will be used as a basis for demonstrating the
processing options. After this, a Z-Stack image will be acquired and processed with the help of
ApoTome deconvolution.
Phase calibration, if it has not yet been performed, is carried out from the Locate tab, while the
other steps are all performed from the Acquisition tab.
Grid Focus Calibration is an important step. It is best to perform this using the sample that you
will want to acquire later, to guarantee identical optical conditions. If your sample is prone to significant bleaching, you can also use the calibration slide provided.
Background information on the ApoTome can be found here:
§

Principle of imaging using fringe projection [} 985]

§

Optimum acquisition conditions [} 991]

§

List of recommended objectives

14.2.2 Principle of imaging using fringe projection
The optics of a microscope are optimized for analyzing very thin samples. For a cover-slip-corrected objective, all optical calculations are performed for very thin objects that lie directly beneath the cover slip. All cover-slip-corrected objectives from ZEISS are optimized for this particular
usage, and exhibit an optimum point spread function (PSF) for the wavelengths for which the corresponding objective has been specified.
In biological applications, however, the vast majority of specimens used do not satisfy these optimum requirements. Sometimes thicker biological tissue slices are used, e.g. to analyze cells in the
tissue using specific fluorescent markers.
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In such cases, during microscopic analysis, and particularly during documentation, the set focal
plane is hidden by parts of the image that originate from above and below the actual focal plane.
As a result the image appears "faded", the contrast is reduced, and the background becomes
bright. In extreme cases important structures and image details may be completely hidden.

Fig. 110: Input image (schematically)
The above representation of a microscopic image of cell nuclei in tissue shows this effect. A number of methods can be used to prevent or reverse this effect, such as confocal laser scanning microscopy or 3D deconvolution.
Principle of fringe projection
With the ApoTome 2 the principle of fringe projection has been employed. This technology involves inserting a grid structure with grid lines of a defined width into the plane of the luminous
field diaphragm of the reflected light beam path. As the plane of the luminous field diaphragm is
conjugated to the focal plane, when you look into the eyepiece you can therefore see the grid,
overlaid with the actual sample.

Fig. 111: Grid image
The image of the grid is shown schematically in the figure above. In reality the grid lines are much
thinner.
Moving the grid structure
A scanning mechanism in the ApoTome 2 slider is used to move the grid structure in at least three
defined steps within the specimen plane. The grid is moved very quickly (in less than 20 ms). A
digital image is acquired at each grid position. The next figure shows the movement of the grid
schematically:

Position 1
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Optical section
The three raw images are combined online on the PC and displayed as an optical section. This
combined resulting image is an optical section through the sample with the following properties:
§

The grid structure has been removed from the raw images.

§

The parts of the image that are out of focus are no longer visible.

§

The sharpness and contrast of the image have been increased.

§

The image’s resolution in the axial direction has been increased.

Fig. 112: Output image (schematically)
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Fig. 113: Sample image: cell nuclei
The figure above shows an application image of cell nuclei (tadpole brain section) in black and
white. Above left: conventional fluorescence Below right: optical section
Why is the resulting image an optical section?
Schematic image of the grid
One possible way to explain this is to use the image of the grid in the sample:

Fig. 114: Grid image (schematically)
The image of the grid provides the necessary information on the distance of the various specimen
structures from the set focal plane (see figure above). Some specimen structures are in focus,
while others lie above or below the focal plane, and enter the set focal plane.
The technique of grid projection makes use of the fact that the image of the grid above and below the actual focal plane is blurred, and enters the blurred areas of the specimen. When the grid
line is moved, significant brightness differences (= contrast) appear in the focal plane.
Outside the focal plane only minor differences are produced, as the sample and the image of the
grid are practically "blurred" together. The brightness differences are detected by the algorithm
used to combine the raw images, and are used to remove the parts of the image that are out of
focus.

Software Manual ZEISS ZEN 3.3 (blue edition) | en-US | Rev.1

989

14 Systems, Applications & Components | 14.2 ApoTome.2

ZEISS

The Raw Data mode
To view the raw data directly switch to the Raw Data display mode on the ApoTome tab.

You will now see the Phase slider on the Dimensions tab. Here you can locate the individual grid
positions. This view can be useful when looking for errors, e.g. to find out where residual streaks
in the processed resulting image originate from.
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14.2.3 Optimum acquisition conditions
The following requirements should be met in order to produce optimum ApoTome images:
§

Exposure time of the camera: this should be set so that approx. 80% of the camera's dynamic range is used. The smaller the dynamic range of the images of the lines, the more noise
the combined resulting images will contain.

§

Correct calibration: Good results can only be achieved if calibration has been performed
correctly. Ideally you should use your own sample for calibration. If this does not lead to good
results, use the calibration slide provided.

§

Sufficient grid contrast in the sample: Good section image results can only be achieved if
the grid lines in the live image can be clearly identified in all object areas. Under certain circumstances samples with very homogeneous staining throughout may not be suitable for
ApoTome images.

§

Avoid vibrations during acquisition, as any movement of the grid position during acquisition
can lead to streak artifacts.

§

Number of phases: Although 3 grid positions (also called phases) can completely cover the
object structures that are in focus and are therefore sufficient for creating optical sections, the
results are significantly better when 5 or more phases are acquired. For this reason 5 phases
are acquired as standard.

§

Selection of the correct grid frequency: Under normal circumstances, the automatic grid
selection yields the best results. In the case of difficult samples, e.g. if the staining is weak, selecting a different grid manually can lead to better results.

§

Avoid electronic interference: The ApoTome's scanner unit is equipped with highly precise
control. Avoid electrical interference, e.g. leaving cell phones close to the ApoTome, to prevent incorrect positioning of the grid.

14.2.4 List of recommended objectives
The following list gives an overview about the recommended objectives and the compatibility with
several microscopes. The links give detailed information about the features of each listed objective.
Overview
§

EC Plan-Neofluar (Axio Observer / Axio Zoom.V16) EC Plan-Neofluar [} 992]

§

LCI Plan-Neofluar (Axio Observer / Axio Zoom.V16) LCI Plan-Neofluar [} 992]

§

Plan-Apochromat (Axio Observer / Axio Zoom.V16) Plan-Apochromat [} 992]

§

LD LCIPlan-Apochromat (Axio Observer) LD LCIPlan-Apochromat [} 993]

§

C-Apochromat (Axio Observer) CApochromat [} 993]

§

LD C-Apochromat (Axio Observer) LD CApochromat [} 994]

§

A Plan-Apochromat (Axio Observer) a Plan-Apochromat [} 994]

§

A Plan-Fluar (Axio Observer) a Plan-Fluar [} 994]

Microscopes
§

Objectives for Axio Observer

§

Objectives for Axio Zoom.V16
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14.2.4.1 EC Plan-Neofluar

V

NA

Immersion

Grid / Section Thickness
@ 490nm [RE/μm]
Highgrid

Middlegrid

Lowgrid

DAPI
with FS
34

DAPI
with FS
49

10x

0.3

Air

2.9 /
31.9

1.7 /
18.2

0.9 /
9.9

OK

OK

20x

0.5

Air

2.4 /
9.2

1.4 /
5.3

0.7 /
2.9

OK

OK

40x

0.75

Air

1.6 /
2.8

0.9 /
1.6

0.5 /
0.9

OK

OK

40x

1.3

Oil

2.5 /
2.2

1.4 /
1.2

0.8 /
0.7

OK

OK

63x

0.95

Air

1.0 /
1.1

0.6 /
0.7

0.4 /
0.4

OK

No

63x

1.25

Oil

1.6 /
1.5

0.9 /
0.9

0.5 /
0.5

OK

OK

100x

1.3

Oil

1.0 /
0.9

0.6 /
0.5

0.4 /
0.3

OK

OK

DAPI
with FS
34

DAPI
with FS
49

14.2.4.2 LCI Plan-Neofluar

V

NA

Immersion

Grid / Section Thickness
@ 490nm [RE/μm]
Highgrid

Middlegrid

Lowgrid

25x

0.8

Oil, water or
glycerin

2.9 /
6.6

1.7 /
3.7

0.9 /
2.0

OK

OK

63x

1.3

Water or glycerin

1.5 /
1.3

0.9 /
0.7

0.5 /
0.4

OK

OK

DAPI
with FS
34

DAPI
with FS
49

14.2.4.3 Plan-Apochromat

V

NA

Immersion

Grid / Section Thickness
@ 490nm [RE/μm]
Highgrid

Middlegrid

Lowgrid

10x

0.45

Air

4.2 /
20.4

2.4 /
11.5

1.3 /
6.2

OK

OK

20x

0.8

Air

3.2 /
4.9

1.8 /
2.8

1.0 /
1.5

OK

OK
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V

NA

Immersion

ZEISS

Grid / Section Thickness
@ 490nm [RE/μm]

DAPI
with FS
34

DAPI
with FS
49

40x

0.95

Air

1.6 /
1.7

0.9 /
1.0

0.5 /
0.5

OK

OK

40x

1.3

Oil

2.5 /
2.2

1.4 /
1.2

0.8 /
0.7

OK

OK

40x

1.4

Oil

2.4 /
1.8

1.4 /
1.0

0.7 /
0.6

OK

OK

63x

1.4

Oil

1.6 /
1.2

0.9 /
0.7

0.5 /
0.4

OK

OK

100x

1.4

Oil

1.0 /
0.8

0.6 /
0.5

0.4 /
0.3

OK

OK

DAPI
with FS
34

DAPI
with FS
49

OK

OK

DAPI
with FS
34

DAPI
with FS
49

14.2.4.4 LD LCIPlan-Apochromat

V

NA

Immersion

Grid / Section Thickness
@ 490nm [RE/μm]

25x

0.8

Oil, water or
glycerin

Highgrid

Middlegrid

Lowgrid

2.9 /
6.5

1.7 /
3.8

0.9 /
2.0

14.2.4.5 CApochromat

V

NA

Immersion

Grid / Section Thickness
@ 490nm [RE/μm]
Highgrid

Middlegrid

Lowgrid

10x

0.45

Water

4.2 /
20.2

2.4 /
11.7

1.3 /
6.1

OK

OK

40x

1.2

Water

2.1 /
1.9

1.3 /
1.1

0.7 /
0.6

OK

OK

63x

1.2

Water

1.4 /
1.3

0.8 /
0.7

0.5 /
0.4

OK

OK
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14.2.4.6 LD CApochromat

V

NA

Immersion

Grid / Section Thickness
@ 490nm [RE/μm]

40x

1.1

Water

Highgrid

Middlegrid

Lowgrid

2.1 /
2.3

1.3 /
1.4

0.7 /
0.7

DAPI
with FS
34

DAPI
with FS
49

OK

OK

DAPI
with FS
34

DAPI
with FS
49

14.2.4.7 a Plan-Apochromat

V

NA

Immersion

Grid / Section Thickness
@ 490nm [RE/μm]
Highgrid

Middlegrid

Lowgrid

63x

1.46

Oil

1.5 /
1.0

0.9 /
0..6

0.5 /
0.3

OK

OK

100x

1.46

Oil

1.0 /
0.7

0.6 /
0.4

0.3 /
0.2

OK

No

DAPI
with FS
34

DAPI
with FS
49

No

No

14.2.4.8 a Plan-Fluar

V

NA

Immersion

Grid / Section Thickness
@ 490nm [RE/μm]

100x

1.45

Oil

Highgrid

Middlegrid

Lowgrid

1.0 /
0.7

0.6 /
0.4

0.3 /
0.2
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14.2.5 Preparation: Phase calibration
Before you can use the ApoTome for your experiments, the optimum angle of deflection of the
scanner unit must be set on the ApoTome 2. This fine adjustment of the scanner unit only has to
be performed once after the system has been set up. The mirror slide and special reflected light
reflector cube, both of which are supplied with the ApoTome 2, are used for this purpose.
Calibration only needs to be performed for one grid and one objective. It is advisable to calibrate
the grid for the low magnification range (grid marked with an "L" for "Low magnification") using
a 20x objective.
The positioning of the camera is also optimized in the dialog for phase calibration. To achieve optimum performance, the camera horizontal should be aligned parallel to the ApoTome 2 grid lines
with as much precision as possible.
The calibration process is supported by a wizard. Start the function by selecting the ApoTome
Phase Wizard function from the Acquisition menu.
The wizard guides you through the calibration process in 5 steps. Follow the instructions in the
text field of the wizard.
For phase calibration you will need the mirror slide provided and the calibration filter
(424930-9902-000). The filter is designed for use with white light sources such as the HXP120C
and cannot be used with the LED light source Colibri. If your ApoTome system was ordered and
supplied exclusively with Colibri, a suitable calibration filter (424930-9000-000) has already been
provided. If Colibri has been retrofitted and the calibration filter is not available, it is not possible
to perform phase calibration. In this case please contact your ZEISS sales representative.

14.2.6 Step 1: Define channels using Smart Setup
Aim
In this step we will set up a two-channel experiment. To do this, we will use the Smart Setup
function. The ApoTome is in the first click-stop position, i.e. in the empty position without a grid.
1. Place your sample onto the microscope stage, localize it with the help of the functions on
the Locate tab and bring it into focus.
2. Now go to the Acquisition tab and create a new experiment in the Experiment Manager:
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.

4. Select the appropriate dyes (in our case Alexa 488 and Alexa 568):

5. Close the dialog by clicking on OK.
à You will now see two channels in the Channels tool.
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6.

You have successfully set up the channels. In the live mode you can now check the focus and exposure time for the two channels.

14.2.7 Step 2: Grid focus calibration
Aim
In this step you will calibrate the focus position of the ApoTome grid for the selected channels.
This step is essential, as without a valid calibration it is not possible to perform an ApoTome experiment. Provided that no changes are made to the device settings that are important for calibration (objective, filter and illumination source, camera) the calibration remains valid for future experiments. We nevertheless recommend that you repeat the calibration from time to time, especially if the sample type you are analyzing changes. Calibration takes place in a wizard, which
guides you through 3 simple steps.
1. Move the ApoTome to the second click-stop position so the grid is positioned in the beam
path.
2. From the Acquisition menu item open the ApoTome Focus Calibration Wizard … entry.
3. In the first step select the channel for which you want to perform calibration.

4. Click on Next to proceed.
à You will now see the Live Image. Bring the sample into focus. The ApoTome grid has
been moved to an end position to make it easier for you to focus on the sample. If you
can nevertheless see the grid lines, something that can never be avoided entirely if you
are using a 100x objective for example, click on one of the two buttons Grid To Start or
Grid To End and use the position at which the fewest grid lines can be seen.
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5. On the left you have the option of adjusting the exposure time and, if necessary, the illumination intensity (with corresponding light sources only).

6. To adjust the exposure time correctly, select the saturation display on the Dimensions tab.
Regions overlaid in red indicate that pixels are saturated.

7. Reduce the exposure time accordingly. The ideal situation is where approx. 70% of the histogram is filled for the brightest region of the sample.
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8. Position the rectangle in the live image and adjust its size in such a way that it covers fairly
homogeneous fluorescent structures and does not lie over the background. The grid focus
is only determined within this rectangle.

9. Click on Next to proceed to the final step.
10. Now click on the Start Full Scan button to start the grid focus search.
à The grid contrast is displayed in the histogram.

11.
à More precise grid focusing can be achieved if you click on the Start Local Scan button.

However, this is only recommended for samples that are not particularly prone to bleaching. For samples prone to significant bleaching, the results of the Local Scan would
measure considerably lower intensities and distort the result.
12. Click on the Finish button.
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13. To perform calibration for another channel, answer Yes to the question "Do you want to
calibrate another channel?" in the dialog that is now displayed.
à The wizard then begins again from Step 1.
14. As soon as you have calibrated all channels, exit the wizard by clicking on No.

You have successfully performed grid focus calibration. Now continue with the next step.

14.2.8 Step 3: Perform ApoTome experiment
Aim
In this step you will perform acquisition for a two-channel experiment. You will use the same
channels that were set up in Step 1. The objective must also be the same one used to calibrate
the grid focus.
1. Insert the desired sample into the slide holder.
2. Open the Live Image and focus on the specimen.
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3. Adjust the exposure time for the two channels in such a way that approx. 70% of the Histogram is used.

4. Close the Live Image to protect the sample.
5. Open the ApoTome Mode tool on the Acquisition tab and enable the ApoTome.

6. Start acquisition by clicking on the Snap button.
à The result is a two-channel image of your specimen.
7.

You have successfully performed an ApoTome experiment.
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14.2.9 Step 4: Process the resulting image
Aim
ApoTome images that are acquired from the Acquisition tab always take the form of raw data.
In this step, with the help of the image you acquired in Step 3, we will look at the various display
options available for ApoTome raw images. We will also create a processed resulting image,
which you can process further as required.
Prerequisite ü For this step you need to be in the 2D view [} 810].

1. In the Center Screen Area go to the ApoTome tab. This view option is only displayed for
ApoTome raw images.
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à If the Show all mode is deactivated you will see two view options: the Display Mode
settings & the Create Image button.

The default selection for Display Mode is the Optical Section view.
2. Select the Conventional Fluorescence option from the Display Mode dropdown list.

à The image is now no longer displayed as an optical section, but as a conventional fluorescence image ("widefield"):
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3. Activate the Show All mode to see additional settings for the calculation of the optical section image.

4. To see the difference between a corrected and uncorrected image, deactivate the Enable
Correction option. Detailed information on the individual options can be found in the online help.
5. If you have not yet done so, enable the correction using the Local Bleaching option.
6. Create a new, processed resulting image by clicking on the Create Image button.
You have successfully processed the ApoTome image and created a resulting image for further
processing.

14.2.10 Step 5: Perform Z-stack acquisition
Aim
In this step you will acquire a Z-stack image with the same channel settings as in Step 3.
1. On the Acquisition tab activate the Z-Stack acquisition dimension in the Experiment Manager.
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2. Open the Z-Stack tool.

3. Start the Live Mode and define the dimensions of the Z-stack for your specimen. To capture the entire object three-dimensionally, you should set the upper and lower limit in such
a way that object structures can no longer be seen in focus. Set the interval between the
individual Z-planes using the Optimal button:

4. Start acquisition by clicking on the Start Experiment button.
à You can follow the progress of the experiment in the progress bar on the status bar:

You have successfully acquired a Z-stack image. Save the resulting image under a meaningful
name via the File menu | Save (Ctrl+S).
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14.2.11 Step 6: Perform ApoTome deconvolution
Aim
In this step ApoTome deconvolution will be performed for the Z-stack acquired in Step 5. This
enables you to significantly enhance the image, beyond what is possible using the normal ApoTome processing functions.
Prerequisite ü The Z-stack image must be in the foreground and in the 2D view. Go to the ApoTome tab
(view option). Make sure that the Show All mode has been activated.
1. Activate the Deconvolution checkbox.

à Make sure that the Set Strength Manually option is also activated. The Strength slider
is set to Medium by default. Retain this setting for the time being.
2. Click on the Apply deconvolution button.
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à Depending on the image size and the specifications of the computer, the processing can
take anything between a few seconds and a few minutes. Make sure that you also adjust
the brightness and contrast using the settings on the Display tab (tip: try out the Min/
Max button).

3. Examine the result by navigating through the Z-stack using the Z-Position slider on the Dimensions tab.
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4. Change the Strength setting on the ApoTome tab until there is an obvious improvement
and there is no disruptive background noise.

5. To obtain the result as a separate image document, click on the Create image button.
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6. Using the Splitter mode [} 909] you can now compare the resulting image with the widefield and the ApoTome processed version.

You have successfully performed ApoTome deconvolution, created a resulting image and compared different resulting images.

See also
2 ApoTome tab [} 905]
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14.3 Celldiscoverer 7
14.3.1 Introduction

Celldiscoverer 7 - Your Automated Platform for Live Cell Imaging
The Celldiscoverer 7 is an automated inverted imaging platform for research applications. The
system calibrates itself, detects and focuses your samples and has adaptive optics to provide the
optimal optical settings in an automated fashion. Thanks to its next generation opto-mechanical
concept, a brand new line of dedicated objectives and a multitude of innovative built-in automation features Celldiscoverer 7 delivers benchmark data quality and easy operation. It allows to
work with a huge variety of sample carriers like wellplates, petri dishes and slides.
The system can automatically detect and calibrate the sample carrier category, measure the bottom material thickness and adapt the optics automatically to deliver maximum image quality. A
built-in incubation chamber, auto immersion allow for long-term live cell imaging experiments.
The new hardware based focus system can not only hold the focus over time but find the sample
carrier surface.
The system is controlled by the ZEN Blue software package which offers all tools and functions
you need to operate the Celldiscoverer 7 efficiently and automate your imaging workflow. The
software contains some additional functions allowing the user to navigate in a safe, easy and efficient way without unnecessary bleaching.
The following modules are part of the ZEN Celldiscoverer software:
§

Tiles & Positions - in combination with focus strategies this allows for easy and flexible image acquisition especially for multi-position and multi wellplate experiments.

§

Advanced Processing & Image Analysis - Use the built-in image analysis functions, create
pipelines to run online image analysis and modify experiments based on those results on the
fly.

§

Automation GUI - Automate routine experiments and using scan profiles that can be started
with just one button.

§

APEER (on-site) Basic - On-site execution of APEER demo modules.

§

Experiment Designer - Configuration of inhomogeneous acquisition experiments.

§

Extended Focus - Calculation of a completely sharp 2D image out of a Z-stack.

§

Measurement - Advanced interactive measurement tools.

§

Multi Channel - Acquisition of fluorescence and transmitted light images in independent
channels.

§

Software Autofocus - Determination of the optimal focus position of the specimen.
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§

Time Series - Acquisition of time series.

§

Z-Stack - Acquisition of Z-Stacks with the help of a motorized focus drive.

ZEISS

Additional ZEN modules are available as option:
§

Macro Environment - Powerful Python scripts allowing to automate all kind of workflows,
export data and connect to 3rd party application required for the workflow.

§

3Dxl - Visualization of 3D or 4D image data.

§

Airyscan - Processing of data acquired with Airyscan 2 (LSM only).

§

Airyscan 2 Basic - Multiplex acquisition with 2x parallelisation (LSM 900 only).

§

APEER (on-site) Advanced - On-site execution of individual APEER modules.

§

Automated Photomanipulation - Acquisition of multiposition experiments with photomanipulation.

§

Colocalization - Quantitative colocalization analysis between two fluorescence channels.

§

Connect - Advanced functionality of ZEN Connect.

§

Connect 3D Add-on - Extension for ZEN Connect for 3D workflows.

§

Data Storage Client - Connection to ZEN Data Storage database.

§

Deconvolution - Improvement of 3D image stacks via 3D-deconvolution algorithms.

§

Direct Processing - Processing of images directly during acquisition.

§

FRAP - Fluorescence Recovery after Photobleaching (FRAP) analysis.

§

Guided Acquisition - Automatic and targeted acquisition of objects of interest.

§

HDR Confocal Basic - High Dynamic Range (HDR) acquisition mode.

§

Intellesis - Image segmentation based on machine-learning algorithm, using pixel classification.

§

Physiology (Dynamics) - Analysis of physiological time series data.

§

Third Party Import - Import of 3rd-party microscopy images into ZEN.
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14.3.2 Sample Tab (Interactive mode)
The Sample tab is the central point of operating the Celldiscoverer 7 system. On top of the tab
you can activate two different modes, the Interactive or the Automation mode. Usually the Interactive mode is used for the default workflow when no plate loader is present or required. The
Automation mode is especially suited for running routine experiments in an automated fashion.
To learn more about the Automation mode, read Sample Tab (Automation mode) [} 1017].

Fig. 115: Sample tab - Interactive mode
If you have selected Interactive mode, the following controls and functions are available:

Parameter

Description

Load Sample

Loads the inserted sample and performs various actions depending on
the selected options under Sample Carrier and under Prescan Options.
The detection of the bottom surface to measure the skirt of the sample carrier is always executed for every individual insert separately.
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Parameter

Description

Eject Tray

Ejects the loaded tray with the sample carrier.

State

Shows the current system status.

Position

Shows the current position of the sample carrier. When the tray is
ejected the position is Load, e.g. the system is ready to be loaded
with a sample carrier. When the carrier is in scan position (above the
objectives) the stated position depends on the current carrier type. As
an example it could state WellPlate or Petri Dish 6x, A1.

Sample Carrier

-

Select...

Here you can select the sample carrier template you want to work
with from list. Inside the selection dialog it is also possible to define
and specify your own custom sample carriers, for example your favorite brand for a 384-well plate carrier. Be aware of the fact, that
one must use the provided insert plates at any time in order to avoid
collisions .Click on the Delete button to remove the selected sample
carrier template.
It is not possible to leave the selection empty, since the Celldiscoverer
relies on having a valid sample carrier template all the time.

-

Measure Bottom Thickness

Activated: The bottom thickness of the sample carrier is measured
using special optics. Make sure the used sample carrier has the correct
bottom material selected. When glass or COC is selected as a material
the thickness measurement will have much smaller search range. In
case of Polysterol as the selected material the search range will be
large in any case.
Note that the measurement may not be correct for embedded samples.

-

Re-Measure

Performs the bottom thickness measurement again at the current XY
position.

-

Determine Bottom Material

Activated: Attempts to determine the use bottom material on demand. The method can differentiate Glass/Cycle Olefin Copolymer
(COC) / "glass-like" materials and Polysterol (PS).

-

Get Material

Performs the material determination again at the current XY position.

Carrier Data

After the sample carrier detection during the prescan (see Prescan
Options below), a graphical sketch of the sample carrier data will be
displayed here. Additionally detailed information about the carrier are
shown.
If the sample carrier detection option is not activated, you can enter
the sample carrier data here manually e.g. Material, Refractive Index, Thickness etc..

-

Material

Here you can select the correct bottom material, e.g. Glass/COC or
Polystyrene (PS).

-

Refractive Index

Here you can modify the pre-selected values if required.

-

Thickness

Shows the measured bottom material thickness. You can adjust the
value if required.
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Parameter
-

Skirt

ZEISS

Description
Per default this parameter can not be edited. You can switch it on under Options | Celldiscoverer | General | Allow manual adaptation
of skirt.
This value is measured automatically for every sample as soon as the
tray is loaded. It defines the distance from the surface of the tray to
the bottom surface of the actual carrier, e.g. the well plate.

-

Default Container

Specifies the container which is approached initially, e.g. to detect
cover glass thickness and measure the skirt height.

-

Imaging Depth

Specifies the desired penetration depth for autocor objectives.

-

Max. Focus Position

Shows the current upper z-limit of the focus drive.

-

DF Search
Range

This field shows whether the Definite Focus (DF) search range is restricted by the z-limit.
If a warning is displayed you can do the following:
§ Increase the z-limit (Under Options | Celldiscoverer)
§ Reduce the imaging depth
§ Check the refractive index

Prescan Options

-

Sample Carrier
Detection

Activated: The system automatically detects which type sample carrier category is used. The result is displayed in the Carrier Data section. The Configure button allows to assign a special carrier template
to carrier category. For example the Pre-Scan recognizes a 96 well
plate (category). This "recognition event" can be assigned to sample
carrier template "MyFavorite96Plate".

-

Create Carrier
Overview

Activated: An overview image of the sample carrier is acquired with
the Pre-Scan camera. The overview image is displayed in the image
document area after the Pre-Scan.

-

Read Barcodes

Activated: The system automatically detects barcodes on the sample
carrier. Currently the system can read codes placed on the short sidewalls of well plates or on top of the carrier, e.g. on a slide.

-

Automatic Sample Carrier Calibration

Activated: An automatic sample carrier calibration is performed during pre-scan. This functionality is available for multiwell plates containing 48, 96, 384, or 1536 wells.
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14.3.3 Using customized sample carriers
The Celldiscoverer 7 allows to create customized sample carrier templates, e.g. for IBIDI multichamber slides.
14.3.3.1 Designing a customized sample carrier template
This chapter describes an example of how to design a customized sample carrier template for
multichamber slides.
1. Click on Tools > Sample Carrier/Holder Templates.
à The Templates dialog opens.
2. Right click on Slide 76 x 26 mm and select Copy and Edit. It is important to select a slide.
Otherwise the sample carrier detection will not work!
à The dialog to edit the template opens.
3. Rename the template.
4. For Category, select Multichamber.
5. Add the correct dimensions of the sample carrier. It is possible to select the Default Container that is initially approached to automatically detect the sample carrier bottom material and thickness.
6. Click on OK.
7. Click on x to close the Templates dialog.
You have now created a customized sample carrier template.

See also
2 Combining the slide holder template with the custom template [} 1015]
14.3.3.2 Combining the slide holder template with the custom template
1. On the Sample tab, under Sample Carrier, click on Select.
2. In the Select Template dialog, right click on Insert 2x Slide - Long and select Copy and
Edit.
3. Rename your sample carrier according to your designed template.
4. In the Part of Insert Carrier dropdown list, select your previously created template.
5. Click on OK.
6. In the Select Template dialog, select your template in the list and click on OK.
You have now combined a sample holder template with your custom template.

See also
2 Activating the Automatic Sample Carrier Detection for the customized sample carrier
template [} 1016]
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14.3.3.3 Activating the Automatic Sample Carrier Detection for the customized sample carrier
template
1. On the Sample tab, under Prescan Options, activate Sample Carrier Detection and click
on Configure.
2. In the Configure Sample Carrier Detection dialog, select Insert 2x Slide –Long and
click on Select.
à The Select Template dialog opens.
3. Under Workgroup Templates, select your customized sample carrier and click on OK.
4. Click on OK to exit the Configure Sample Carrier Detection dialog.
The Sample Carrier Detection will now associate the customized sample carrier template with
the long slide holder. Until changed, every time the slide holder is detected, the customized sample carrier template will appear.
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14.3.4 Sample Tab (Automation mode)
With the Automation mode it is possible to create scan profiles that combine all the pre-scan options with an actual ZEN experiment. The Automation mode can be used for special sample carrier
inserts, e.g. for 2x Slide (long or short), 3x Slide or 6x dish.

Fig. 116: Sample tab - Automation mode
If you have selected Automation mode, the following controls and functions are available:
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Parameter

Description

Default Scan Profile

Here you can set a default scan profile. This profile will be used if new
sample holders are inserted.
If no profiles exists, you first have to create a new profile via the Options menu

-

Options

, see below:

§ New Scan Profile…
Creates a new scan profile.
§ Open Profile Configuration
Opens the Profile Configuration [} 1020] dialog. There you can edit
an existing scan profile.
§ Rename
Renames the selected profile.
§ Save as
Saves the user profile under another file name.
§ Delete
Deletes the selected profile.

Start Prescan

Starts a prescan of all selected slots or the inserted sample (if no plate
loader is used).
To select a slot for a prescan, go to Magazine view and activate the
corresponding checkbox in the Process column.

Start Scan

Starts the scan of all selected slots or the inserted sample.

Eject Tray

Ejects the tray which contains the sample holder.

Import File

If you click on this button you can import a file (*.csv format) which
contains configuration data for the system.
Typically the following data can be imported:
§ Magazine, Slot, Barcode, Scan Profile, ImageFileName, SubPath
Under Separator you can select the separator used in the *.csv file
(e.g. Semicolon, Tab)
If you click on 'Show' a preview of the imported data will be displayed.

Storage Location

Here you can specify the storage location (file path) for all created images.
All image sub paths, which might be read from the configuration file
will be inserted below the defined file path.

Naming Definition

Here you can define naming definitions for the acquired images. You
can select several definitions for the file names from the dropdown
list. The name automatically contains the detected barcode content if
the barcode detection is active for the active profile.
Click on the Options button
tion.
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Parameter

Description

Plate Loader Status

The display of this section depends on your system configuration.
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If you do not use a plate loader only the sample carrier which you
have configured is displayed in the Magazine view.
If you work with a plate loader, its magazine with the different slots is
displayed. Common plate loaders can have up to 4 magazines. One
magazine can contain up to 12 slots. In the slots you put your sample
carriers containing the sample.
The functions mentioned below only apply for the plate loader.

-

Currently
Loaded:

Shows the location (in the hotel of the loading robot) of the sample
holder which is loaded currently.

-

Detect All

Checks all magazines for slots which contain sample carriers automatically.

-

Unload

Unloads the currently selected sample carrier from the Celldiscoverer
back to its slot in the magazine.

-

Reset

This button is only shown in case of an error with the plate loader
(e.g. Plate loader is blocked). The respective message is shown in red.
In this case all controls will be disabled and the plate loader will stop
working. NOTICE! In case of an physical obstruction, e.g. by a
misplaced sample carrier, you first have to remove the sample
carrier before you click on 'Reset'.
By clicking on Reset you can try to restore the system status of the
plate loader. The system then tries to solve the problem using some
internal error checking routines and additional actions.

Magazine 1 - ...

Here you see the graphical display of the magazine(s) and its lots. The
magazines are numbered from 1 - 4 (depending on the available magazines). Under a magazine each slot is displayed as blue button. The
slots are numbered as well (e.g. from 1- 12). The icon in front of a
button shows the loading status. Following status are possible:
§ gray = empty slot
§ blue = occupied slot
§ blue blinking = carrier is currently on the stage
§ yellow = problem detected
§ red = Error occurred during processing
§ green blinking = Slot has status 'prescanned'
§ green = Scanning the slot is finished.
If you double-click on a slot button, the slot will be loaded or unload
from the tray (depending of the loading status). If the tray is loaded
with a carrier from a certain slot and you load a carrier from a different slot, the currently loaded slot will be unloaded first.
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14.3.4.1 Profile Configuration

Parameter

Description

Selected Profile

Shows the name of the selected profile. Under Profile Description
you can enter a short description, if desired.

Carrier Data

Contains information about the sample carrier

-

Automatic
Carrier Detection

In case of the option Automatic Carrier Detection the scan profile can
contain data for different carrier types. They are visible inside the
Sample Carrier list view.

-

Fix Carrier Assignment

Only one specific carrier type is assigned to the scan profile. This is
useful when working with the same carrier type all the time.

Options

-

Create Carrier
Overview

Created and save an sample carrier overview image during the prescan which is store inside the actual image data file as an attachment.

-

Detect Occupied Positions

In case of a sample carrier with multiple inserts, the systems automatically checks for empty positions.

-

Read Barcodes

Read the barcodes from the respective position on the sample carrier
itself (position depends on the carrier).

-

Use configuration file

Three different options available:
§ No configuration file: no configuration will be used.
§ Imported Data : use a configuration that must be imported before.
§ Control Barcode: Defines rules how a barcode will be interpreted.

Sample Carriers

This list view allows managing the sample carrier types supported by
the current scan profile. The + button allows to add more carrier
types. The Delete button deletes the carrier type including all assigned scan experiments.

Carrier Configuration

This area shows the respective carrier configurations and allows to
modify them. For normal wellplates there will be only one data set
visible, but for carriers with multiple inserts it is possible to define different configuration for every available insert

-

Use same sample carrier configuration for all
positions

When activated the same configuration will be used for all sample
carriers during the processing.

Assigned Scan Experiments

Here you can assign the actual ZEN experiments. For carriers with
multiple inserts it is possible to assign an individual experiment to every insert, e.g. it is possible to run a different experiment for every
petri dish when using the 6x petri dish.

Use same scan
experiment for
all positions

Allows assigning the same experiment to every individual position of
the carrier, e.g. use the same experiment for all petri dishes of a 6x
petri dish holder.

-
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14.3.5 Magazine View
In general the Magazine view is used to get an overview of the status of the sample carrier(s) /
scan items in the tray of the system or in the magazine(s) of the plate loader.
The display of this view depends strongly on the system configuration. If you use the system without a plate loader the configured sample carrier is displayed.

Fig. 117: Magazine View without Plate Loader
If you work with a plate loader you will see a list of the available magazines and slots. Note that
only slots which are occupied are displayed. Empty slots are not displayed in the list. We recommend to perform a check for occupied slots by clicking on Detect all in Sample tab under Plate
Loader Status.
The currently loaded slot / scan item is marked by an orange rectangle.
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Fig. 118: Magazine View with Plate Loader
The following controls are available for Magazine view:

Parameter

Description

Expand All

Expands all scan items so that all of them are visible including there
configurations. (This button is only visible when a plate loader is
present.)

Collapse All

Collapses all scan items so that only the short information overview
and the processing status is visible. (This button is only visible when a
plate loader is present.)

Mark All

Activates the processing markers for all scan items. When clicking
'Start Prescan' or 'Start Scan' those items will be processed, if their
status allows for those actions (new, prescanned, stopped).

Unmark All

Deactivates all processing markers.

Default Order

Restores the default order of slots. Their order can be changes via
Drag & Drop. Newly detected carriers will be added at the end.

Select All

Selects all items and allows the execution of a context menu entry for
all shown elements at once.

Unselect All

Unselects all items.

Tray type information
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Description

-

Show Information

Shows the results of the processing, if existing.

-

Show Profile

Open a XML viewer to inspect the complete scan profile configuration.

14.3.5.1 Magazine View Options
The options below are opened via right click on the corresponding slot (e.g. Magazine:1 Slot:1).

Parameter

Description

Assign Scan Profile

Open a list with all available scan profiles. A click on the desired profile assigns it to the currently selected items.

Mark all scan
items of highlighted trays for
processing

Activates the processing checkbox for all selected slots and their scan
items.

Unmark all scan
items of highlighted trays for
processing

Deactivates the processing checkbox for all selected slots and their
scan items.

Show Overview
Image

Opens the sample carrier overview image.

Expand all highlighted holders

Opens the sample carrier overview image.

Collapse all highlighted holders

Opens all selected sample carriers.

Reset carrier status to 'New'

Closes all selected sample carriers.

The options below are opened via right click on an individual sample carrier inside the list (scan
item).

Parameter

Description

Move to Scan Position

Moves the stage to the respective scan position. Depends from the
sample carrier and a possible insert and therefor from the scan item
type.

Mark all highlighted scan items
for processing

Opens the resulting scan image as an individual document inside the
normal document area.

Unmark all highlighted scan items
for processing

Resets all precessing checkboxes for all selected scan items.

Reset Scan status
to New

Resets the status of the scan items to "new".
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14.3.6 Navigation View
In the Navigation view you see the graphical display of the loaded sample carrier. In general the
view is used for navigation purposes. Depending on the carrier, on Selection tab you can navigate to the single containers of the carrier (e.g. of a petri dish) simply by double clicking on the
desired container. The stage will move automatically to the center of the selected container. In
case of carriers with multiple inserts (e.g. 6x petri dish insert) the selection tab allows you the
switch between the different inserts.

Fig. 119: Navigation view
The system is equipped with an automatic collision prevention system. Based on the geometry of
the objective front, the working distance of the objective, the actual carrier or insert geometry
and the skirt height the safe XYZ traveling ranges will be calculated and adapted automatically. In
Navigation view the currently possible XY travelling ranges are always displayed. The current active limit for the selected objective is displayed by a thick, dashed line using the respective color.
The limits for the other objectives are also shown using a thin line using the respective color.
In case that the travel range should be increased (especially for the high magnification objectives),
the Z-Limit above Surface (Tools > Options > Celldiscoverer) can be decreased. See also the
chapter Celldiscoverer Options [} 1029].
The blue cross hair shows the current stage position and the blue rectangle (only visible at higher
zoom levels) shows the field of view of the objective.
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14.3.7 Navigation tab

Parameter

Description

New Tab

Live/continuous image will be displayed in a new tab.

Separate Container

Live/continuous image will be displayed in a separate container.

Navigation View

Live/continuous image will be displayed in the Navigation window
(very small).

Bring Navigator
into View

Enlarges the live/continuous image to full view inside the Navigation
window (works for all three options New Tab, Separate Container,
Navigation View).
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14.3.8 Celldiscoverer Tool
The Celldiscoverer tool is located in the Right Tool Area. Note that the tool is not visible in Automation mode.

Fig. 120: Celldiscoverer tool
The tool is used for controlling the systems hardware components, like objectives, beam splitter,
filter wheels, light path etc..

Parameter

Description

Active Camera

Here you can select the active camera or detector. The respective port
switcher moves automatically.

Objective List

Here you can easily switch between the objectives and pre-magnification. The color bar on the objective buttons indicates the color for the
respective stage limit indicator inside the Navigation tab.
If you select AutoCorr objectives (motorized correction collar) you can
additionally adjust the relevant settings like Correction Mode, Bottom Thickness or Imaging Depth.

Beam Splitter List

Here you can select the desired beam splitter from the list. If you
change the beam splitter the corresponding emission filter from the
list below is changed as well.

Filter List

Here you can select the desired emission filter from the list. A change
here will not affect the selected beam splitter.

Pipette Position

If you click on the ON button the system moves in the pipette position, where it is possible to add reagents to the sample. The tip of the
pipette will be located at the center of the optical axis indicated by
the blue crosshair inside the Navigation tab. Make sure the height
adjustment for the pipette tool is correctly adjusted to the current carrier geometry.

Microscope Control

Opens the Microscope Control dialog. There you can see and adjust
the full light path of the system. We recommend to only adjust settings in the light path, if you know what you are doing.
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14.3.9 Dispensing Tool

This tool is used to set up dispensing events for certain container(s) on a sample carrier. To perform dispensing, the system moves the sample carrier to the dispensing position where you can
easily add dispensing fluid to the selected container(s). The Dispensing checkbox is displayed by
activating Time Series.

Parameter

Description

Sample Carrier

Shows the selected sample carrier which will be used for dispensing.

Options

-

Repeat every

Here you can adjust the interval between dispensing events during an
experiment.
E.g. if you adjust the value to 5 min, the software will pause the running experiment after 5 minutes and allows you to add a substance to
your sample.

-

Dispensing
events

Here you can adjust the total number of dispensing events for an experiment.

-

Select containers

If you click on the Select button, the Container selection dialog
opens. There you can select the containers in which you want to add
the fluid.
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Fig. 121: Container Selection Dialog

14.3.10 Perfusion
To enable perfusion experiments, insert the POC-R dispensing chamber into the Insert plate for
perfusion.

Do not connect the perfusion tubes when loading the sample to avoid any damage.
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If the sample has reached the imaging position, the perfusion tubes can be connected. By clicking
Measure Bottom Thickness the skirt height and bottom thickness are determined.

14.3.11 Celldiscoverer Options
The Celldiscoverer Options menu can be found under Tools | Options | Celldiscoverer.

Parameter

Description

General

-

Use Automated
Camera Frame
Correction

When using the 0.5X after-magnification the chip window on the
camera is adjusted automatically in order to remove the dark areas inside the corners due to the limited FOV for (only!) this after-magnification.

-

Enable Automation Mode
(restart required)

If activated and you work with a plate loader, on Sample tab the Automation mode is automatically activated.

-

Disable empty
check for automation

Activated In Automation Mode the sample is loaded without Automatic Sample Carrier Detection.
We recommend this option if there are problems with the Automatic
Sample Carrier Detection in Automation Mode. The sample carrier type has to be defined in advance.

-

Allow manual
skirt adaption

Activated (not recommended): the skirt height of the carrier can be
adapted manually.
Caution: This is not recommended! Please modify the skirt height only
if it is known exactly. Otherwise, there is the risk of crushing the objective into the sample carrier.

-

Ask User to
Adapt Experiment with Inserted Sample
Carrier

Activated: Shows a warning during loading of the sample carrier
when the sample carrier does not fit to the actual experiment. Allows
either to adapt the sample carrier or to leave the experiment unchanged.
Caution: The adaptation of the experiment to the actual sample carrier will delete all tile regions/positions.

-

Don't show a
'Warning' at experiment execution, if the validation result
can be ignored

Activated: Shows no warning during experiment execution.
Activating this is recommended for automation/execution of macros
etc. to avoid stopping the experiment/workflow. ZEN sometimes asks
for manual confirmation and this would cause the experiment or the
macro to stop.
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Description

Cover Glass Thickness Detection Options

-

Use Default
Thickness Detection (recommended)

If deactivated (not recommended), you can adjust the cover glass
thickness detection options manually for trouble shooting.

-

Use Aberration
Correction

Activated: Attempts to improve the result of the thickness measurement by considering aberration effects. Per default this setting is deactivated.

Prescan Options

-

Show Images
Used for Recognition

Activated: Displays the images used for recognition inside the Document area after the Pre-Scan. This option should be only activated for
trouble-shooting the Pre-Scan sample carrier recognition. Normally
this option can be deactivated.

-

Show live container during
sample carrier
calibration

Activated: Displays the live images used for the automatic sample
carrier calibration inside the Document area after the Pre-Scan. This
option should be only activated for trouble-shooting the Pre-Scan
sample carriers recognition. Normally this option can be deactivated.

Z-Limit above Surface

Allows adjusting the default Z-Limits for different objectives to increase the available XY traveling range.
The icons inside the DF (Definite Focus) Search Range column indicate
if the available Z-range is sufficient for performing a Find Surface operation.

Auto Immersion
Refill Options

-

Remove Water

If you want to use Auto Immersion for an experiment, here you adjust
the duration for the removal of the applied water. The set time defines the duration for which the suction pump is switched on (default:
5000 ms). For use of Auto Immersion, in the Right Tool Area >
Auto Immersion, activate Enable Immersion.

-

Apply Water

If you want to use Auto Immersion for an experiment, here you adjust
the duration for the application of water (default: 2500 ms).

-

Waiting Time
after Refill

Sets the waiting time after a refill (default: 2000 ms).

-

Refill every

Regardless of an experiment, here you adjust the interval time of the
global periodic timer for renewing the immersion (default: 45 minutes). This prevents the system from drying out if it is switched on and
in a rest period for a long time, e.g. over night.

-

Reset

Resets the parameters to the default values.
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Description

Phase Gradient
Contrast Settings

-

Automatic Half
Pupil Angle
Adaptation

A phase gradient contrast image is calculated from two single images
acquired with two different angles of the half pupil.
If activated, the optimal choice of the angles is calculated depending
on the current X/Y Position insides the well.

14.3.12 Performing a Celldiscoverer calibration
The Celldiscoverer calibration wizard is used for hardware calibration of the system. The individual
components can be selected for re-calibration. Calibration data are stored for comparison.
If you want to perform a calibration using the wizard, the following steps are necessary.
1. In the menu bar | Tools select System Maintenance and Calibration...

à The System Maintenance and Calibration dialog opens.
2. Click on Continue >>.
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à In the System Maintenance and Calibration dialog, the available Calibration procedures will be shown.

3. Click on Celldiscoverer Calibration Wizard >>.
à The Celldiscoverer Calibration Wizard (1/2 Welcome) opens.

à Three option are available to continue:
- start a new calibration session by clicking on Create New Session
- continue with a previous calibration session by clicking on Open Session File
- read, write and compare calibration data by clicking on Manage Calibration Data
4. To perform a new Celldiscoverer calibration, click on Create New Session.
à Additionally, an edit field with a proposed session name and the Exclude Immersions
Objectives checkbox are hidden.
5. If required, edit the name of the calibration session and activate the Exclude Immersions
Objectives checkbox.
6. To start the calibration procedure, click on Create.
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à The next screen of the wizard will be shown.

7. Select the steps for the calibration procedure by activating the appropriate checkboxes.
8. Click on Next > to run the calibration.
9. After the calibration is done, click Finish.
à The calibration results will be stored in a file and the System Maintenance and Calibration dialog appears again. The Celldiscoverer Calibration Wizard >> item is
marked by a green checkmark.
10. Close the System Maintenance and Calibration dialog with Close.
If the window closes, you have successfully performed the Celldiscoverer calibration.

14.3.13 Mixed Mode Settings
The Celldiscoverer 7 allows the combined acquisition of camera and LSM tracks. This unique
Mixed Mode Acquisition ensures the precise overlay of the widefield and confocal/Airyscan images. The resulting file contains image(s) of all aligned channels, e.g. for seamless analysis workflows.
In the Mixed Mode Settings of the Acquisition Mode window, a pixelwise overlay of the widefield and confocal frames is set. Optimal image alignment is achieved by registering the LSM image to the camera image. Therefore, a so-called disparity map is automatically created for each
Celldiscoverer 7 system using the Mixed Mode Disparity Map wizard [} 1037]. As a result, four different image processing functions are automatically carried out when the mixed mode acquisition
is activated to correct for variations in scaling (related to total magnification and pixel size), distortion, position/offset, and pixel numbers (cropping of the image).

See also
2 Parameters for LSM Imaging Modes [} 688]
2 Acquisition Mode Tool [} 687]
14.3.13.1 Camera + LSM Combined
By clicking on Combined, the direct overlay of WF and confocal frames is automatically adapted
to the tracks for all zooms and magnifications. For the combined acquisition of WF and confocal
tracks in the mixed mode, no scan field offset and rotation is possible and the bit depth is fixed to
16 bit per pixel. The mixed mode is available for Widefield, LSM confocal, Airyscan HS, and
Airyscan MPLX tracks. The following tracks can be combined:
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§

Widefield + LSM confocal

§

Widefield + LSM confocal + Airyscan HS

§

Widefield + Airyscan HS

§

Widefield + Airyscan MPLX HS

ZEISS

The WF track is automatically set as the first track.
Aquiring z-stack images:
Z-stack acquisition in mixed mode will automatically activate Full z-stack per Channel. In the experiment, channel 1 is acquired for all z levels before channel 2 is acquired.

Mixed Mode Settings with Widefield and LSM confocal track:

Zoom: Zoom is automatically adapted to both camera and LSM track. The widefield image is interpolated to correspond to the LSM image. Zoom is affecting image size and sampling. The number of pixels (frame size) is constant when changing the zoom.
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Frame size: is adapted according to the active sampling. Changes of the frame sizes (e.g. via Presets) influence the sampling.
Sampling: The channel with highest demand for sampling is master and defines the default.
§

Confocal: xy sampling set for 1.0 x Nyquist (2 times sampling) to achieve optimal settings for
confocal resolution. The camera frame is cropped to the LSM frame.

§

Camera: Adjusts the LSM parameters to match the physical pixel size of the camera.

LSM specific settings (for more information, see Parameters for LSM Imaging Modes [} 688]):
§

Scan Speed

§

Direction Monodirectional or Bidirectional

§

Line Step

§

Averaging

Mixed Mode Setting with Widefield and Airyscan HS/ Airyscan MPLX HS track:

Sampling: The channel with highest demand for sampling is master and defines the default.
§

Confocal: xy sampling set for 1.0 x Nyquist (2 times sampling) to achieve optimal settings for
confocal resolution. The camera frame is cropped and resampled to match the LSM frame.

§

HS/ MPLX HS: xy sampling set for 1.5 x Nyquist (3 times sampling) to achieve better SNR.
The camera frame is cropped and resampled to match the LSM frame.

§

Camera: Adjusts the LSM parameters to match the physical pixel size of the camera.

14.3.13.2 Camera + LSM Separate
For separate acquisition of WF and confocal tracks, press the Separate button in the Mixed
Mode Settings. The frame size of the camera is reset to maximum. The frame size of the LSM
track is not changed.
Depending on the selected track in the channels window, the Acquisition Mode tool is adapted,
when the Separate tab in the Mixed Mode Settings is active.
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For an active WF track, all camera relevant parameters are shown (for details see the chapter for
Acquisition Mode [} 687]). The frame size of the camera is reset to Maximize. Other parameters
are unaffected.

For an active LSM track, all relevant scanning parameters are shown.
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14.3.14 Calculating the disparity map for mixed mode acquisition
The wizard calculates the disparity map for alignment of camera and LSM frames in mixed mode
acquisition. Based on a reference image which is acquired in the wizard, the disparity map (an image processing function) is generated that is applied for all LSM frames to ensure a pixelwise overlay with the WF frames in the mixed mode acquisition.
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1. In Tools select System Maintenance and Calibration...
à The System Maintenance and Calibration dialog opens.
2. Click on Continue.
à The System Maintenance and Calibration dialog shows the available calibration procedures.

3. Click on Mixed Mode Disparity Map Wizard.
à The Mixed Mode Disparity Map Wizard Step 1/6 opens.

4. Click on Next.
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à Step 2/6 of the wizard opens.

5. Load the calibration slide in the center slide position (3-slide holder) and click Load Sample
Calibration Info Tab: Display of acquisition parameters automatically set in the wizard.
• Optics: Magnification used to acquire the reference image.
• Lighting: WF track is acquired using transmitted light. Confocal track is acquired with the
640 nm laser.
• Exposure: Exposure time of camera.
• Focus: Focus position (z). The stage position and focus is set automatically. The correct
focus position can also be defined via Auto-Focus. The software autofocus settings can be
set in the Software Autofocus tab.
Acquire the WF and LSM (confocal) image:
• Activate Auto-Focus to find the correct focus position. Otherwise, select Already in focus.
6. Click on Image acquisition.
7. Click on Next.
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à The disparity map is calculated and Step 3/6 of the wizard opens.

Parameters used by the RegionDisparityMap function:
• Registration Method: Affine.
• Registration Quality: High (default). If the result is not accepted and the channels do
not overlay correctly, activate the drop down menu to select between low, medium, high
and highest and press recalculate.
Image View:
• Original: Displays the overlay of WF and confocal frame without applying the disparity
map.
• Corrected: Displays the corrected overlay of WF and confocal frame.
Status:
• Successful calculation of disparity information is indicated by a green check mark.
• Successful application of the disparity map is indicated by a green check mark.
8. After successful calculation, click on Next.
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à The radial distortion is calculated and Step 4/6 of the wizard opens.

Elastic Registration Statistics: A good result is achieved when the average is in the
range of 1 pixel.
Image View:
• Original: Displays the overlay of WF and confocal frame without applying the radial distortion correction.
• Affine/Distort/Elastic: Display of the individual correction steps.
Status:
• Successful calculation of radial distortion information is indicated by a green check
mark.
• Successful application of the radial distortion map is indicated by a green check mark.
9. After successful calculation, click on Next.
à The final disparity map image is saved and Step 5/6 of the wizard opens.

Storage Location: Define the folder (C:\Users\Public\Documents\Carl Zeiss\ZEN\Documents\MixedModeDisparityMapWizard).
File Name: Define the file name (default: DisparityMap_Date_Time).
Image View:
• Original: Displays the overlay of WF and confocal frame without applying the radial distortion correction.
• Affine/Distort/Elastic: Display of the individual correction steps.
• Final: Displays the final image based on the corrections.
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10. Click on Next.
à Step 6/6 of the wizard opens.

• Finish: Ends the wizard and writes the calibration.
• Cancel: Discards the calibration.
11. Click on Finish.
The wizard is closed and the successful calculation of the disparity map is indicated by a green
check mark.

14.3.15 Airyscan HS
The Celldiscoverer 7 contains the specific Airyscan HS (high sensitivity) mode.

On the Acquisition Mode tool, the Airyscan HS specific parameter options are the following:
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Description

Sampling

–

HS

XY sampling set for 1.5x Nyquist to achieve better SNR.

–

Confocal

XY sampling set for 1.0x Nyquist to achieve confocal resolution with
increased signal-to-noise with Airyscan detector.

For information about the general parameter options of the Acquisition Mode, see Acquisition
Mode Tool [} 687].

14.3.16 Airyscan MPLX HS
The Celldiscoverer 7 contains the specific Airyscan MPLX HS (high sensitivity) mode. This track
type cannot be combined with Confocal, HS or WF tracks. Mixed Mode Acquisition is not possible.
The Airyscan MPLX HS track is a selection option in the Imaging Setup.

On the Acquisition Mode tool, the Airyscan MPLX HS specific parameter options are the following:

Parameter

Description

Sampling

–

HS-2Y

XY sampling set for 1.5x Nyquist to achieve better SNR.

–

CO-2Y

XY sampling set for 1.0x Nyquist to achieve confocal resolution with
increased signal-to-noise with Airyscan detector.
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For information about the general parameter options of the Acquisition Mode, see Acquisition
Mode Tool [} 687].

See also
2 Acquiring LSM 900 images with Airyscan 2 multiplex modes [} 76]
2 Acquiring LSM 980 images with Airyscan 2 multiplex modes [} 79]

14.3.17 Smart Setup
Airyscan HS and Airyscan MPLX HS tracks are selected as a detection mode in the drop down
menu of the LSM tab.
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14.3.18 Auto Immersion for Celldiscoverer
14.3.18.1 Introduction
The Auto Immersion functionality in ZEN (blue edition) is used for adding immersion fluid (water)
to water immersion objectives and automatically renewing the immersion fluid during experiments.
Working with Auto Immersion in ZEN is easy. Firstly, create the immersion or renew it, when the
immersion fluid starts to dry out. This is performed using the Auto Immersion tool in the Right
Tool Area. For Celldiscoverer 7 containing the 50x/1.2 water immersion objective, the Auto Immersion is activated automatically.

You can also configure Auto Immersion functionality for experiments. This can be done in the
Auto Immersion tool in the Left Tool Area on Acquisition tab. E.g. for time series experiments
you can set a time interval after which the created immersion will be renewed automatically during the experiment. Please ensure to enable immersion in the Auto Immersion tool in the Right
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Tool Area. Otherwise, the following warning message is shown: “Auto Immersion is not enabled
in the right tool area”.

In the following chapters we describe step-by step how you prepare working with Auto Immersion objectives and how you can use Auto Immersion for experiments.

See also
2 Preparing Auto Immersion [} 1046]
2 Using Auto Immersion for an experiment [} 1047]
14.3.18.2 Preparing Auto Immersion
For Celldiscoverer 7 containing the 50x/1.2 water immersion objective, the Auto Immersion is activated automatically.
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When using the water immersion objective for imaging, the creation of the water immersion must
be enabled.
The following steps have to be performed:
1. In Right Tool Area, open the Auto Immersion tool and activate Show All.

2. Activate the Enable Immersion checkbox to ensure auto immersion functionality.
à The Create Immersion and Remove Immersion buttons will be available.
3. Select the water immersion objective.
The immersion process can be controlled manually using the tool in the Right Tool Area:
§

Click on Create Immersion. This initiates the creation of one immersion procedure.

§

Click on Remove Immersion. This initiates the removing of the immersion fluid.

The immersion creation or removing procedures are independent from the configured settings in
the Auto Immersion Refill Options, see chapter Celldiscoverer Options [} 1029].
14.3.18.3 Using Auto Immersion for an experiment
If you want to use Auto Immersion during an experiment, the following steps are necessary.
Prerequisite ü You have set up an experiment (e.g. a time series experiment).
ü You have read the chapter Preparing Auto Immersion [} 1046]. Basically you have to perform
the steps described in this chapter before each experiment.
ü You can modify the Auto Immersion Refill Options (not recommended) , read chapter Celldiscoverer Options [} 1029].
1. Switch to the water immersion objective you want to use in the experiment. The initial immersion will be created automatically.
2. Select Acquisition tab.
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3. In the Auto Immersion tool in the Left Tool Area, you can configure the parameters for
Time Interval and/or Travel Distance for the experiment. That event which will take place
first will activate the renewing of the immersion during the experiment. For time series experiments we can recommend time intervals for up to 120 minutes, if necessary. For tiles/
multi-position experiments we recommend the re-immersion after 200 mm travel distance.

You have successfully configured auto immersion for an experiment.
14.3.18.4 Auto Immersion Tool
The Auto Immersion tool in the Right Tool Area in general is used to check the immersion status
and to operate the immersion functions.

Parameter

Description

Tank Level

Shows the current filling level of the immersion fluid tank.

Enable Immersion

Must be activated. Displays the controls for immersion.

Create Immersion

If you click on this button, the system will automatically add the immersion fluid to the selected immersion objective.
If the fluid was added once, the button is grayed out.

Remove Immersion

If you click on this button, the system will automatically remove the
immersion fluid from the selected immersion objective.

14.3.18.5 Auto Immersion Tool
The Auto Immersion tool in the Left Tool Area | Acquisition tab is used for experiments only.
You can configure the time interval and travel distance for automatic immersion events in here.

Parameter

Description

Time Interval

Here you can adjust the time interval for auto immersion.
E.g if you set the value to 30 min, the immersion is automatically renewed every 30 minutes during a running experiment.

Travel Distance

Here you can adjust the travel distance for auto immersion.
E.g. if you set the value to 80 mm, the immersion is automatically renewed after the stage has moved a distance of 80 mm.
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15 Service / Maintenance
15.1 Creating a Service Report
The service report contains log files from MTB and ZEN.
If you want to create a Service Report, the following steps are necessary.
1. In the menu bar click on Help > Create Service Report...
à The Enter Information for the Service Report dialog opens.

2. Enter date, time, and an useful description of the issue occurred and the reason for creating
this service report.
3. To include additional files to the report, click Add.
à The Windows Explorer opens.
4. Open the folder with the file to be added.
5. Select the file.
6. Click on Open.
à The Windows Explorer closes. Location and file name of the added file are shown in the
display field.
7. To remove a file from the display field again, select it and click Remove.
8. If required, activate Open file location in Windows Explorer after report is created.
9. Click Create report.
The System information window appears, showing the storage progress.
If the window closes, you have successfully created the Service Report.
This process might take several minutes depending on the system, size of the logs and if the Windows system information is collected too. The storage location of the Service Report is C:/ProgramData/Carl Zeiss/Remote Service.
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16 FAQ
16.1 What can I do If my image is too dark?
Try to increase the exposure time by performing the following settings:
§

in the Locate tab click on the Set Exposure button. This will calculated the correct exposure
time automatically.

§

in the Camera tool manually adjust the Time slider until you achieve the desired result.

§

in the General View Options > Display tab adjust the display curve, see chapter Adjusting
Live Image Settings [} 30].

16.2 How can I balance my images color?
To perform an automatic or manual white balance you must use a color camera. In the Left Tool
Area > Locate tab > Camera tool the White Balance section appears. There you can perform
a white balance with one of these methods:
Auto Method:
1. Move the sample out of the Live window’s field of view, so that you only see the background (essentially the light source).
2. Click on the Auto button.
3. The white balance will be calculated automatically. Afterwards move your specimen back
into the field of view.
Interactive/Pick… Method:
1. Click on the Pick… button.
2. Click on a white area of the Live window which should be represented as white.
This area will be used as a reference for the white balance.
3200K Method:
Use this method if working with a halogen bulb.
1. If available set the light source to 3200K by pressing the 3200K button located on the
body of the microscope.
2. Click on the 3200K button.
This method is also largely depending on the quality/age of your bulb. If the color rendition is not
as desired, try the Auto or the Interactive/Pick… methods above.
5500K Method:
Use this method if working with a LED.
1. Click on the 5500K button.
2. If the color rendition is not as desired, try the Auto or the Interactive/Pick… methods
above.
If none of the above methods produce a satisfactory result, one can additionally manually adjust
the Color Temperature slider.
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16.3 How can it be that my image has dust or a shadow, although my specimen is
clean?
If the dust is not on your specimen, then the best method is to clean the optical elements that lay
in the imaging pathway of your microscope. However if that poses a problem, alternatively, you
can perform a Shading Correction as shown below. This solution has some limitations, especially
if the dust is very dark or thick.
1. Move your sample out of the Field of View until you see nothing but the light source/dust.
2. In the Camera tool, in the Post Processing section, click on the Channel Specific button.
3. Move your sample back into the Field of View.

16.4 Why my image seems to look that something have burned in? (i.e. a shadow of a
previous specimen?)
Check that The Shading Correction of the previous experiment is not already adjusted.
1. In the Camera tool open the Post Processing section
2. Deactivate the Shading Correction checkbox.

16.5 How can I fix a color gradient cast?
To fix a color gradient cast, you can try the following:
1.
2.
3.
4.

Move your sample out of the Field of View until you see nothing but the light source.
In the Camera tool, in the Post Processing section, click on the Channel Specific button.
Move your sample back into the Field of View.
Perform a White Balance, see chapter How can I balance my images color? [} 1050]

See also
2 Why my live image shows extreme colors in comparison to what I see in the eyepieces?
[} 1052]

16.6 What can I do if my live image is of a low quality and looks pixelated?
1. In the Camera tool > Mode section in the Live Speed dropdown list select the entry
Slow.
2. Right-click on the live image and select the Fit to View entry.
3. Optionally, you can also , in the Dimensions tab, activate the Interpolation checkbox.
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16.7 What can I do if my live image is slow?
Solution A
The live speed of your image is possibly set too slow. Increase the Live Speed.
1. In the Camera tool in the Mode section, select a faster speed from the Live Speed dropdown menu. There are at most three choices, depending on the camera: Slow, Medium,
Fast.
Solution B
The exposure time is possibly set to high, respectively improper. Optimize your settings in the
Camera tool, in the Exposure time section.
1. On the Locate tab click on the Set Exposure button.
2. Alternatively in the Camera tool click on the Set Exposure button.
3. Manually adjust the Time slider until you achieve the desired result.

16.8 What can I do if my live image is mostly red/blue?
Check whether the checkbox Range Indicator is activated. If this is the case, the display switches
to the Single Channel mode. The channel will be displayed monochrome. Simultaneously you
see areas where the camera sensor is saturated, shown in red. Areas in which the pixel values = 0,
are shown in blue. If this is not needed anymore deactivate the checkbox.

16.9 What can I do if my live image is still black or white after setting the exposure?
Check to see that your display curve is not set all the way to the left/right. Try to reset the display
curve by clicking in the Display tab on the Reset button to achieve the default setting.

16.10 Why my live image shows extreme colors in comparison to what I see in the
eyepieces?
The reason could be, that your display curve is not adjusted.
1.
2.
3.
4.

Open the Display tab.
Click on the Reset button.
Click on the 0.45 button or set Gamma 0.45.
You can additionally click on Min/Max or Best Fit button.

See also
2 Why is my image color not the same that I see through the eye pieces? [} 1053]

16.11 Why is my image resolution lower than the given camera specification?
Because you chose a wrong or improper setting.
Prerequisite ü You are on the Locate tab.
1. In the Camera tool, in the AcquisitionROI section, click on the Maximize button.
2. In the Mode section check that Binning is set to 1x1.
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16.12 What can I do if I do not see a focused live image?
Refocus the specimen on the microscope. You may activate the Focus Bar as an additional aid.
1. Open the context menu via right-click in the Live image.
2. Select the entry Focus Bar.
The Focus Bar will be shown within the Live image now.

16.13 Why is my image color not the same that I see through the eye pieces?
This is largely dependent on the color of your light source. The following instruction assumes that
your light source is set to white.
1. In the Camera tool, in the Settings section click on the Default button, to set the camera
back to factory default.
2. Click on the Set Exposure button.
3. In the Display tab, click the 0.45 button. If you do not see this button, activate the Show
All mode.

See also
2 How can I balance my images color? [} 1050]
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Airyscan Principle
A classic confocal microscope illuminates one spot on your sample to
detect the emitted fluorescence signal. Out-of-focus emission light is
rejected at a pinhole, the size of
which determines how much of the
airy pattern reaches the detector.
You can increase the resolution by
making the pinhole smaller, but signal-to-noise drops significantly
since less valuable emission light is
passing through. With Airyscan
ZEISS introduces a new concept.
Instead of throwing light away at
the pinhole, a 32 channel area detector collects all light of an Airy
pattern simultaneously. Each detector element functions as a single, very small pinhole. Knowing
the beampath and the spatial distribution of each Airy pattern enables
a very light efficient imaging: you
can now use all of the photons that
your objective collected.
ApoTome - Global bleaching
correction
For each raw image the total (sum)
intensity is measured and a global
decay curve determined. This decay factor is used to correct the
brightness of all pixels in the raw
image. This method is suitable for
samples with only one fluorescent
dye present.
ApoTome - Local bleaching
correction
If more than one fluorescent dye is
present in the sample, a single decay curve cannot be used to correct
bleaching. This is the case for most
biological samples especially when
considering the contribution of autofluorescent substances to the total
signal detected. The solution is to
use a local bleaching correction determining a decay factor for each
individual pixel position in each raw
image which effectivel removes artifacts also for complex dye combinations.
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ApoTome Bleaching correction
The main reason for residual stripe
artifacts in ApoTome images is the
fact, that acquiring at least 3 grid
images for one resulting processed
image leads to bleaching of the fluorescent dyes. This bleaching
leads to brightness differences in
the raw images and to artifacts
when processing the data uncorrected. The principle for correcting
bleaching in widefield data is the
fact, that no matter, how far away
from the focal plane the detector is
placed, the sum intensity emitted
from the sample remains the same.
This is also true for the grid images.
This fact is being used for the ApoTome. Two methods exist, both of
which are patented.
Binning
Binning is understood to mean the
combination of neighboring image
elements (pixels) on the image sensor itself, e.g., the CCD sensor in a
digital camera. Source: Wikipedia
Bleaching Correction
The characteristics of a widefield
fluorescence microscope are based
on the assumption that all Z-planes
have the same total brightness, irrespective of the focus position.
Use is made of bleaching correction by applying a correction factor
to each Z-plane. However, this assumption does not apply to techniques that result in the generation
of optical sections, such as confocal images.
Burst Mode
Burst Mode is some kind of optimization to enable the recording of
the fastest framerates, which can
be achieved by the used camera
hardware. This mode requires
some compromises for the sake of
speed: it supports only single channel time lapse acquisition, an update of the image display is suppressed while recording and the
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maximum time lapse duration is depending from the size of available
main memory (minus some space
to breathe for the operating system). If a multi channel image
needs to be acquired, Burst Mode
will be disabled and maximum
frame rate can be slower then
specified in the camera hardware
performance documentation.
Clipping planes
The purpose of clipping planes is to
cut open the calculated 3D image
so that elements on the inside can
be visualized. Clipping planes can
cut the volume in such a way that
either the front, back or both sides
of the volume data are no longer
visible. In addition, the clipping
plane itself can be given various
textures. This is a very important
modeling option for analyzing 3D
data.
Colocalization
Acquiring fluorescence images in
several channels makes it possible
to visualize the relationship between biological structures. A combined display of two channels in
color overlay mode makes it easier
to assert whether the components
are "colocalized", i.e. whether they
are located at the same position.
Conventionally, two fluorescence
channels are displayed in the form
of a color-coded overlay. The most
common form is the red/green
overlay. Regions in which both fluorescent dyes are present at the
same place are displayed in yellow.
It is not possible, however, to make
quantitative statements concerning
the extent of colocalization on the
basis of this display. At best, a
qualitative statement is possible
with regard to whether or not two
dyes are colocalizing. The Colocalization module is able to fill this gap
and presents the user with a tool
that enables colocalization to be
determined quantitatively. Principle:
It is always the colocalization of two
channels that is analyzed. Colocal-
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ization results from the pixel-bypixel comparison of intensities for
each channel.
Constrained Iterative
The best image quality is achieved
using the iterative maximum likelihood algorithm (see Schaefer et al.:
"Generalized approach for accelerated maximum likelihood based image restoration applied to three-dimensional fluorescence microscopy", J. of Microscopy, Vol.
204, Pt 2, November 2001, pp.
99ff.). This algorithm is able to calculate light from various focal
planes back to its place of origin.
Consequently, with this method it is
possible to derive the 3D structure
from fluorescence images with the
correct brightness distribution and
to visualize optical sections. It is
also possible for missing information to be partially restored from
neighboring voxels. The spatial resolution can be increased without artifacts up to a theoretical limit (one
voxel). It is essential for Z-stacks to
have been acquired in accordance
with Nyquist. Acquiring sufficient
planes above and below the structure of interest is also imperative for
achieving good results. As this is a
complex mathematical method, the
calculation can take longer, depending on the image size and the
PC being used.
Costes
Costes et al. (Biophysical Journal,
2004, vol. 86, pp 3993-4003) have
published a statistical method with
the help of which an attempt is
made to determine an optimal colocalization threshold automatically.
This takes place by initially maximizing the threshold for both channels and then gradually reducing it.
With each step Pearson's Correlation Coefficient is determined for all
pixels below the set value. These
steps are repeated until the Pearson value is minimized (ideally a
value of 0 for perfectly colocalizing
channels). See the publication for
further details. This method has
1055

Glossary

ZEISS
been implemented in Colocalization. Clicking on Auto initiates the
above iterative process, which, depending on the sample, can take
several seconds. The threshold
now set corresponds to the confidence criterion calculated. This
method works very well with large,
diffusely stained structures such as
nucleoplasm or diffuse cytoplasmic
structures. Under certain circumstances it does not function so well
for small structures (e.g. nuclear
speckles or vesicular structures),
particularly in the case of widefield
images, where the signal to background ratio is not as good as it is
with methods that involve the generation of optical sections (e.g.
LSM, TIRF or ApoTome). The Regions button becomes active as
soon as a region is inserted into the
scatter plot. It remains active as
long as regions are selected or
moved there. Activating and deactivating the button makes it possible
to switch between threshold selection using the mouse and the selection/moving of selected regions in
the scatter plot image. If regions
are defined in the scatter plot, the
corresponding data appear in the
table in addition to the overall image.
Deconvolution
Deconvolution is a method that is
used to improve fluorescence images in particular. Image information acquired using a microscope
system can never fully reproduce
the structures of the actual object.
This is because unavoidable distortions occur during acquisition due
to the optics and electronics. In addition, particularly in the case of fluorescence microscopes that do not
offer any methods for generating
optical sections, light from areas of
the object outside the objective's
focal plane is also always acquired.
This covers the structures that the
user actually wants to see to a
varying degree and therefore leads
to a reduction in the contrast and
consequently in the visible resolu-
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tion. These optoelectronic effects
can be described mathematically in
the form of the point spread function (PSF). If the PSF is known, it is
possible to correct the negative effects to a large extent using deconvolution. This produces a completely sharp image of the object
that is richer in contrast. Deconvolution is usually performed on Zstacks, i.e. it is used as a 3D
method. However, it can also be
used to a limited extent to improve
2D images. A good review of deconvolution can be found in Wallace et al., 2001: A Workingperson's guide to deconvolution in light
microscopy; Biotechniques 31:
1076-1097.
Discrete Fourier Transform
The Discrete Fourier Transform
functionality is based on the publication: "Multiple imaging axis microscopy improves resolution for
thick-sample applications", Jim
Swoger, Jan Huisken, and Ernst H.
K. Stelzer, OPTICS LETTERS /
Vol. 28, No. 18 / September 15,
2003
Display characteristic curve
The display characteristic curve allows you to define the range of the
gray value histogram of an image
that you want to display on the
screen. The limit on the left defines
the gray value up to which all pixels
are displayed as pure black (black
value), while the limit on the right
defines the gray value from which
all pixels are displayed as pure
white (white value). The curvature
of the curve defines the so-called
gamma value.
Drag&Drop
Literally translates to "drag and
drop". Does the moving of objects
(eg, files, icons, etc.) on the screen
as from one folder to another.
Clicking the object with the left
mouse button, holding down these,
the object moves with the mouse to
the desired location.
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Dynamic range
The dynamic range describes the
number of brightness gradations
that a camera or another detector is
able to distinguish. Modern, scientific digital CCD cameras, for example, have a dynamic range of up to
2^16 gray levels. In this case we
talk of 16 bit cameras.
Experiment Feedback
Experiment feedback allows the
definition of specific rules and actions to be performed during an experiment. This allows changing the
course of the course of an experiment depending on the current system status or the nature of the acquired data on runtime. Moreover, it
is possible to integrate certain tasks
like data logging or starting an external application, directly into the
imaging experiment. Typically, but
not exclusively, such an experiment
connects the image pickup with an
automatic image analysis.
Fast Iterative
The "Fast Iterative" method is an iterative restoration method that
uses only one iteration per convolution step (see Meinel, E. S.: Origins
of linear and nonlinear recursive
restoration algorithms.
J.Opt.Soc.Am, 3 (6), 1986,
787-799). No regularization is used
in this case. Due to the fast processing and convergence after just
a few iterations, this method is suitable in particular for the processing
of larger time lapse images. The results of the method can quickly lead
to good results and remove most of
the out-of-focus light. They do not,
however, create quantitative brightness conditions in the image. If undersampled images are present, artifact formation may also result.
FCCS
Fluorescence Cross-Correlation
Spectroscopy
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FCS
Fluorescence Correlation Spectroscopy
Field Feature
A field feature is calculated for all
segmented objects of a class. The
geometric or intensity parameters
of all objects of the class, e.g. the
area or the average intensity, are
added together. In addition, all objects can be counted, for example,
or the area of the objects in relation
to the total image area can be calculated as a percentage.
Fluorescent beads
Fluorescent beads are often used
to measure the point spread function (PSF). The diameter of these
beads is usually significantly below
the resolution limit of the objective
used. Based on the known shape
and size, various optical parameters of the microscope system can
be determined with the help of such
objects. To measure the PSF when
using an objective with a numerical
aperture of 1.4, beads with a diameter of 50-170 nm should be used.
Fourier Filter
The processed result ApoTome image can sometimes still show fine
residual line artifacts. This is due to
sample, staining, dynamic range
during acquisition or exposure time
used. These artifacts can be removed using the Fourier Filter option. This function makes use of the
fact, that stripe artifacts appear as
a group of dots in frequency space.
The filter masks those dots and can
in this way remove stripe artifacts
from the image. It only works however, if the camera had been
aligned parallel to the grid lines during phase calibration. Also, it is
quite a crude method and should
not be needed if all other preconditions for using the ApoTome have
been met.
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Gamma value
The gamma value makes it possible to correct the display of images
on computer screens which do not
allow the linear display of gray
value curves. By changing the
gamma value you can emphasize
certain intensity ranges within your
image when it is displayed on the
screen. A value <1 emphasizes the
ranges of medium pixel intensity
(medium gray values), while a
value >1 emphasizes the dark and
bright pixel intensities and therefore
increases the contrast. The recommended settings are 0.8 for fluorescence images, 1.2 for phase contrast or DIC images and 0.45 for
true color images. Please bear in
mind that a "correct" gamma value
setting depends on numerous parameters, such as screen settings,
ambient brightness, etc., and a universal setting cannot therefore be
given.
Gaussian Distribution
The emission of fluorescent light in
fact follows a Poisson distribution.
If, however, detector noise predominates during imaging, or the image
data are only just above the camera noise and therefore very dark, a
normal distribution according to
Gauss tends to apply to such images.
Generalized Cross Validation (GCV)
Regularization, which lessens the
influence of noise during restoration, is normally controlled by a parameter that in most cases is determined heuristically via trial and error. The "generalized cross validation" (GCV) method makes it possible to estimate this parameter even
under the complex conditions of
Poisson maximum likelihood minimization.
Image Analysis Wizard
Using the Image Analysis Wizard
you can create automatic measurement routines very easily. The wizard delivers precise results without
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any need to spend time on programming. This allows you to complete even complex measurement
tasks in just a few minutes.
Image display
A maximum range of 256 gray levels (black and white image) or 16
million colors can normally be displayed on a screen. Modern digital
cameras capture a much larger
range: black and white cameras up
to 65536 values and color cameras
theoretically up to (65536)3 colors
(281 billion). The display of these
gray values/colors therefore needs
to be adjusted for the monitor by
the user. For this adjustment an upper and a lower gray/color value
are defined. All gray/color values
between these limits are displayed
on the monitor within the 256 gray
values/16 million colors that can be
represented.
Image Normalization
The processing algorithm for ApoTome raw images acts in a subtractive manner effectively reducing the
gray value range of the output image. Since all calculations are done
internally in the high precision 32
bit floating point image format the
normalize option can help to generate better output data. The floating
point numbers are back-converted
into 16 bit integer numbers using
the full 16 bit dynamic range normalized to the brightest pixel. This
option makes it impossible however
to make quantitative comparisons
between images.
Kymograph
A Kymograph is a twodimensional
representation of a moving object
over time. The movement of the object is traced using a line or curve
of a given thickness and an intensity plot is then generated over
time. The kymograph image displays the intensities along the line
in X direction and the time points
are plotted in the Y direction. With
this method one can visualize and
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analyze speed and acceleration of
moving objects with a simple 2D
representation.
Lamp Flicker
This phenomenon mainly occurs if
fluorescent arc lamps are operated
for a long period of time. Under certain circumstances alternating
darker and brighter layers can then
appear in the Z direction in Zstacks. This effect may prevent 3D
deconvolution from being usefully
applied, for example.
Maximum mode
In the case of a maximum intensity
projection, only the pixels with the
highest intensity are displayed
along the observation axis. This
view is well suited to the two-dimensional display of three-dimensional images, e.g. in publications,
one reason being that a maximum
transparency effect is only visible in
this mode.
Microscanning
Microscanning is a technological
process for the production of highresolution images using a CCD or
CMOS sensor. For a sequence of
images, the sensor is moved in two
dimensions by micro-mechanics in
very small intervals between acquisitions.The distances are smaller
than a pixel dimension and allow
the inclusion of detailed information
that would otherwise not be seen
by the sensor.
Mixed mode
In Mixed mode, a volume can be
displayed in both Surface mode
and Transparency mode. In the
case of multichannel images, for
example, structures inside a cell,
such as FISH signals or nucleoli,
can be displayed in Surface mode
and the cytoplasm around these
structures can be displayed transparently in another channel. This
means that even highly complex
spatial relationships can be shown
convincingly.
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Motif buttons
With the Motif buttons you can optimize image acquisition regarding
particular requirements like speed
or quality. All parameters e.g. camera resolution or dynamic range in
Acquisition Mode or Channels tool
were set automatically. They will influence basically camera, detector
and lightning settings.
MTB
The software MicroToolBox (MTB)
is used to generate and manage
microscope configurations. Information about microscope components (e.g. nosepieces, reflector
turrets, shutters etc.) and, if necessary, additional external units (e.g.
motorized xy stages, external light
sources etc.) is stored in these configurations. Furthermore, the software can also be used to enter information about microscope components, such as objectives, fluorescence filter cubes etc., in a simple way and to save this information in the microscope (depending
on the type of microscope in question). In this case, the information is
saved directly in the microscope,
allowing it to be displayed on the
microscope’s TFT screen, for example. Various configurations can
be created, of which only one is activated at any time. The active configuration is used by imaging software such as ZEN to provide
graphic control dialogs for the configured microscope units (e.g. lightpath or microscope components
control).
NDD
Non-descanned detector. The nondescanned detection modules can
be used in the reflective or transmissive light path (transmission
NDDs not available for Axio Imager) or simultaneously in both
beam paths. That means that up to
12 NDD channels (depending on
the stand used) can be configured.
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Nearest Neighbor
The Nearest Neighbor method uses
the simplest and fastest algorithm
(Castleman, K.R., Digital Image
Processing, Prentice-Hall, 1979).
Its function is based on subtraction
of the out-of-focus information in
each plane of a stack, taking the
neighboring sections above and below the corrected Z-plane into account. This method is applied sequentially to each plane of the entire 3D stack. It allows you to enhance contrast quickly, even if image stacks have not been put together optimally.
Nyquist Criterion
The Nyquist criterion states that a
signal must be detected with at
least double precision in order to
reliably acquire all the frequencies
in the signal. In the case of images
acquired with coarser resolution,
undesired effects such as aliasing
may otherwise result. For the deconvolution of microscope images,
this means, in practical terms, that
images should be acquired with a
pixel resolution that is at least double the optical resolution, both in
the lateral and axial direction.
Object Feature
An object feature is calculated for
an individual segmented object. It
describes a geometric or intensity
property of the object, e.g. its area
or its average intensity.
PCH
Photon Counting Histogramm
Phase Correction
The ApoTome grid is moved in precise steps during acquisition in order to cover the sample fully for
one section. The used steps are
stored in the image metadata and
used for all subsequent processing
steps. In most cases this will work
very well. However, there can be
cases e.g. caused by vibrations,
when the actual grid position deviates from the reported position
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causing artifacts during processing.
Phase correction analyses the actual grid positions in the raw images and uses the determined values instead for processing. This option will add a bit of processing time
however.
Point Spread Function (PSF)
All optoelectronic effects that influence the creation of a microscope
image can be described mathematically in the form of the point spread
function (PSF). If the PSF is known,
deconvolution can be used to
largely remove the negative effects
from microscope images. There are
three possible ways to determine
the PSF: theoretically through
knowledge of the key optical parameters, experimentally through
measurement using fluorescent
beads of a known diameter, or
blindly using a method that works
with less prior knowledge. In ZEN
the theoretical model according to
Lanni and Gibson has been implemented, which also models asymmetries like those that can arise
due to spherical aberrations (see S.
F. Gibson, F. Lanni, "Experimental
test of an analytical model of aberration in an oil-immersion objective
lens used in three-dimensional light
microscopy", J. Opt. Soc. Am. A,
vol. 8, no. 10, pp. 1601-1613, October 1991).
Poisson Distribution
The emission of photons by fluorochromes follows a statistical distribution, known as a Poisson distribution. This is the preferred model
taken as the basis for the deconvolution calculation. It applies if the
predominant proportion of image
noise is caused by shot noise ("salt
and pepper noise"). This assumption applies to images that have
been acquired using good, lownoise detectors, the dynamic range
of which has been utilized to a certain extent.
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Position
In a tile experiment positions refer
to independent individual image
fields (tiles) that are localized at
various places on the sample. A
position corresponds to a tile region
consisting of just one tile. Each position is based on an X and Y coordinate of the stage and a Z coordinate of the focus drive. Individual
positions or position arrays
(grouped individual positions) are
defined using the Tiles tool. After
acquisition the individual positions
are displayed as scenes.
Pseudo color assignment
In fluorescence microscopy,
pseudo color assignment describes
the assignment of any artificially selected color to the channel of a multichannel fluorescence image. As it
is mostly monochrome cameras
(which produce black and white images rather than "true colors") that
are used in this area of application,
we talk of pseudo coloring.
Raw Data Mode
The ApoTome combines the advantages of widefield imaging systems with the advantages of optical
sectioning. Images acquired from
the Acquisition tab always contain
all images acquired from the grid.
These grid images are also called
phase- or raw-images. This principle offers several advantages: 1) all
informations acquired are kept and
not discarded; 2) the acquisition itself is not slowed down by processing overhead; 3) you get access to
various correction methods giving
you flexibility in treating your sample in the right way after acquisition; 4) Phase (=grid-position) errors occuring during acquisition
such as caused by vibrations of the
microscope can be likely corrected
using the phase correction option
without having to redo the acquisition; 5) you can achieve a marked
improvement in resolution and contrast by using the specially adapted
ApoTome deconvolution option
bundled with all systems; 6) the raw
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mode facilitates easy analysis of
images which show errors or artifacts in the sectioned image which
would otherwise remain obscure.
Reference Z-Position
By default the current Z-position at
the time the experiment is started is
set as the Reference Z-Position for
acquisition. Z-stack experiments,
for which the center of the defined
Z-stack is set by default as the
fixed Reference Z-Position, form an
exception to this. Offsets for channels and Z-stacks shift acquisition
in relation to the Reference Z-Position. If a focus strategy is used, this
determines and updates the Reference Z-Position during the experiment.
Regularization
Working with real microscope images that are affected by noise
leads to considerable difficulties
with the practical application of deconvolution methods, which is why
regularization (e.g. according to
Tikhonov-Miller-Phillips) is essential. Regularization is a method that
lessens the influence of noise by
means of various penalty terms.
Stronger regularization leads to
weaker restoration and weaker regularization to stronger restoration,
although in this case noise is also
intensified.
Regularized Inverse Filter
The inverse filter is a genuine 3D
method and generally achieves better results than the Nearest Neighbor algorithm. It essentially involves
dividing the Fourier transformation
("FT") of the volume by the FT of
the PSF, which can be performed
very quickly. In the real space this
corresponds to deconvolution. In
addition, a statistical method ("General Cross Validation – GCV") is
applied, which determines the
noise component of the image and
automatically sets the restoration
strength to the optimum level in line
with this. This process is also
known as regularization. The
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method is very well suited to the
processing of several image stacks
in order to preselect images for the
application of the iterative "highend" method. Z-stacks must, however, have been acquired at the
correct (Nyquist) distance. The additional acquisition of Z-planes
above and below the structure of
interest is recommended.
Render Series
To display a 3D volume on the
screen, each image must be recalculated. This takes time and, in the
case of large images, cannot be
done interactively. You can, however, have a series of individual images calculated which represent
the animation that you want. Such
an image series can be displayed
considerably faster and more fluidly
than is possible interactively on the
screen as, in this case, the views
no longer have to be rerendered.
Furthermore, an image series like
this lends itself extremely well to
being exported as a film.
Shading Correction
The Brightness of microscopic images often declines to the edges.
This is caused for example, by misaligned, or inhomogeneous lighting,
inconstant light conditions or dirty
optics. ZEN is able to correct this
interference with the so called
Shading Correction. First you need
a white image. This functions as a
reference for the background of
your image, which shall be corrected.
Smart Setup
Smart Setup is the intelligent and
convenient control center for your
fluorescence images. Simply select
a fluorochrome from the more than
500 dyes stored and ZEN will automatically provide the optimal filter
combinations and acquisition settings for your experiment.
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Spherical Aberration
Every objective requires the use of
a defined immersion medium to deliver the best optical resolution. In
microscopy practice, particularly in
the area of biosciences, it is not always possible, however, to embed
the sample in a medium with the
correct refractive index. When light
enters the embedding medium with
the wrong refractive index this results in "spherical aberration". The
PSF becomes more asymmetrical
the further away from the cover slip
it is measured. In practical terms
this becomes noticeable in the form
of an increasing loss of brightness
as the distance from the cover slip
increases. It is possible to compensate for spherical aberration either
by using objectives with correction
rings or objectives that have been
calculated for certain embedding
media (e.g. aqueous solutions).
Within certain limits, however,
spherical aberration can also be
compensated for during deconvolution, by taking the parameters responsible for this effect into consideration when calculating the theoretical PSF. For further details see
S. F. Gibson, F. Lanni, "Experimental test of an analytical model of
aberration in an oil-immersion objective lens used in three-dimensional light microscopy", J. Opt.
Soc. Am. A, vol. 8, no. 10, pp.
1601-1613, October 1991.
Surface mode
The two modes previously described display the data with soft
transitions or with a transparent
character, depending on the setting. In Surface mode, the program
calculates solid surfaces ("isosurfaces") from the gray values, which
emphasizes particularly flat structures (e.g. cell walls of plant cells).
This display can be used if you
want to draw attention to certain
structures, while other, internal
structures are hidden.
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Threshold
Which threshold is the correct one
is a question that is frequently
asked. Unfortunately it is not possible to give a definitive answer to
this question, particularly because
this often depends on the problem
and the properties of the sample.
Generally speaking it can only be
said that the best approach is to
determine the thresholds using appropriate control samples, e.g.
samples without colocalization as a
negative control and samples with
biologically relevant colocalization
as a positive control. Thresholds
determined in this way can, under
certain circumstances, be transferred to the sample of interest.
Tile region
In a tile experiment a tile region
refers to a group of individual image fields (tiles) that belong together and are arranged in the form
of a grid. With the help of tile regions it is possible to acquire areas
with dimensions that exceed the
size of an individual image field.
Within an experiment a number of
tile regions can be acquired at various positions on the sample. Each
tile region is based on an X and Y
coordinate of the stage and a Z coordinate of the focus drive. Tile regions are defined using the Tiles
tool. After acquisition the individual
tile regions are displayed as
scenes.

by means of a virtual light source.
Additionally, the transparency of
the structures can be adjusted to
allow deeper insights into the image. This allows a realistic representation of the structures in the
image imitating real-life observations. It also allows a realistic and,
in contrast to the maximum projection mode, a quantitative display of
the volume.
Widefield
Classical microscopes frequently
are called "widefield" microscopes
in order to distinguish them from
microscope systems with optical
sectioning capability such as laser
scanning microscopes. In contrast
to such systems widefield microscopes do not possess the ability to
discriminate betwee image information in the axial (=Z) direction leading to blurred images and therefore
are only poor 3D imaging systems
per se. There are methods to add
this missing axial sectioning ability
to widefield microscoped such as
3D deconvolution or structured illumination (ApoTome, Elyra-S)

Transparency mode
In the Transparency mode, the
structures in the image are rendered in a similar fashion as in the
Volume mode. The key difference
is an applied edge enhancement filter to allow more focus on relevant
structures within the data while simultaneously fading out homogenous and less important areas.
Volume mode
In the Volume mode, the structures
in the image are rendered as threedimensional objects and illuminated
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Index
Numerics
2.5D View
2D View
3D images
Align
3D View
Animating the 3D Volume
Key Layout / Controls for Flight
Mode
Left tool bar
Right tool bar
Tool bar (bottom)

814
810
584
834
839
837
836
837
838

A
ACP X Unscaled
397
ACP X Unscaled WCS
397
ACP Y Unscaled
398
ACP Y Unscaled WCS
398
Acquire
Live panorama image automatically
49
Acquire a first camera image
28
Acquire ApoTome images
985
Acquire Multi-channel Images
43
Acquire Tile Image
449
Acquire Tiles Images
Adjusting Z Positions
520
Assigning Categories to Tile Regions and Positions
526
Calibrating Stage
512
Copying a Tile Region or Position
520
Introduction
511
Re-Positioning of your sample carrier after incubation
527
Tiles & Positions with Advanced
Setup
515
Using Sample Carriers
529
Acquiring Panorama Images with ZEN
lite
445
Acquiring the Panorama Image
449
Acquiring Time Series images
49
Acquisition Mode
687
Acquisition Sequence
662
Acquisition tab
652
Acquisition Tools
Experiment Designer
723
Focus
800
Stage
798
Activate
Alignment process
576
Adapt
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Focus values
719
Focus values with Definite Focus
720
Focus values with Software Autofocus
720
Add
Dataset to ZEN Connect project 569
Images to ZEN Connect project 567
Add Annotations
29
Add Dye or Contrasting Method
809
Adjust
Opacity
603
Adjust Camera Orientation
513
Adjust live image settings
Brightness
30
Contrast
30
Gamma
30
Adjust Z positions
520
Adjustment
Airyscan detector
980
Collimator
976
Pinhole
976
Readback signals
985
Advanced Tile Setup
Left toolbar
547
Advanced Tiles Setup
544
Create Preview Scan
515
Airyscan 2 LSM 980 detector adjustment
Automatically
982
Manually
984
Airyscan Detector Adjustment
980
Airyscan multiplex modes
970
Airyscan SR
969
Airyscan tab
907
Align
Data in Connect project
595
Data in CWS project
595
Images in 3D
584
Images in z direction
582
Rotate
578
Scale
579
Shear
580
Translate
577
ZEN Connect project data
576
Z-Stack automatically
358
Z-Stack manually
357
Alignment
Cancel
581
Clear
582
Finish
582
Reset
581
ZEN Connect project
576
Alignment mode
576
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Alignment process
576
Activate
576
Alignment tab
595
Analysis setting
Create
431
Analysis tab
665
Analysis View
855
Charts and tables
393
Analyze Interactive Batch
217
Analyze to Label Image
214
Batch
215
Use
108
Annotation
Add to image or movie
61
Edit
62
Rearrange
62
Remove
62
APEER
244
Create path mapping
246
Remote execution
245
Apeer API key
Create
245
APEER module
Download
246
Use locally
247
Apeer on-site
244
ApoTome
808
ApoTome Mode
702
ApoTome Settings
809
Apply Mask tool
174
Area
398
Area Convex
398
Area Filled
398
Area Filled Unscaled
398
Area Unscaled
399
arivis Vision 4D
797
arivis Vision4D
Pipeline
797
Assign
Category
526
Name
526
Atlas 5 project
Load
567
Auto Save
766
Automated Export Tool
767
Automated Photomanipulation
253
Perform experiment
254
Automated Photomanipulation tool 255
Automated Photomanipultion
Settings
253
Automatic segmentation
779
Automation Mode - Celldiscoverer
1017
Celldiscoverer
1017
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B
Basic Features
Intellesis
438
Batch Processing - Image Export 102
Binary
783
Binning
670, 693
BioFormats
Import
572
Bit Depth Adjustment (Camera)
678, 698
Black Reference
673, 695
Bound Bottom
399
Bound Bottom Unscaled
399
Bound Bottom Unscaled WCS
399
Bound Bottom WCS
399
Bound Height
399
Bound Height Unscaled
400
Bound Left
400
Bound Left Unscaled
400
Bound Left Unscaled WCS
400
Bound Left WCS
400
Bound Right
401
Bound Right Unscaled
401
Bound Right Unscaled WCS
401
Bound Right WCS
401
Bound Top
401
Bound Top Unscaled
402
Bound Top Unscaled WCS
402
Bound Top WCS
402
Bound Width
402
Bound Width Unscaled
402
Burst Mode
733

C
Calculating a ratio for one wavelength
462
Calculating a ratio for two wavelengths
462
Calibrate
Sample Carrier Template
529
Stage
512
Camera
669
Adjust Orientation
513
Bit Depth Adjustment
678, 698
Camera Settings
Reload Camera Settings
676
Save Camera Settings
676
Set Camera Settings to factory default
676
Camera tool
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Acquisition ROI section
672, 694
Binning
670, 693
Black Reference
673, 695
Exposure Time section
669
Gain
672
Mode section
677, 697
Post Processing section
673, 695
Shading Correction
674
White Balance section
671
Cancel
Alignment
581
Carrier
Select
594
Carrier / Holder in ZEN Connect
project
Clear
589
Select
589
Carrier tab
554
Category
Assign
526
Create New
526
Positions
536
Sort
527
Tile Region
536
Celldiscoverer
Magazine View
1021
Navigation View
1024
Center Screen Area
21
Center X
403
Center X Unscaled
403
Center X Unscaled WCS
403
Center X WCS
403
Center Y
403
Center Y Unscaled
404
Center Y Unscaled WCS
404
Center Y WCS
404
Change
Image order
570
Opacity
603
Scaling
229
Channel Alignment
143
Channel Alignment Extended
144
Channels
702
Chart export
856
Charts and tables
Analysis View
393
Circularity
404
Classes
Edit
432
Clear
Alignment
582
Carrier / Holder in ZEN Connect
project
589
Clone
Trained model
431
Close
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ZEN Connect project
572
Coarse Z-Stack Alignment
Image Processing
110
Setup
111
Collimator adjustment
976
Colocalization View
870
Compactness
404
Configure
Single image export
597
Stored documents table
593
Configure Microscope Components 26
Confocal Topography
257
Module
257
Connect
Licensing
562
Connect acquisition and processing
computer
Direct processing
344
Connect computer
With discovery proxy
345
Connect computers
Without discovery proxy
344
Connect project
Align data
595
Save to data storage
592
Stored documents
606
Connected Processing PCs
355
Contour
Toolbar
548
Contrast
30
Convert
TXM to czi
206
Convexity
404
Copy
Graphical element/measurement
900
Position
520
Tile Region
520
Correct
Stage jitter
183
Count number of fluorescence signals
per nuclei
375
Count number of objects in a ring
around nucleus
389
Create
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Analysis setting
431
Apeer API key
245
Category
526
Deconvolution settings
342
Global Focus Surface
524
Image analysis setting
369
Image analysis setting from analyzed image
370
Local Focus Surface
522
New trained model
425
Path mapping
246
Point spread function
135, 334
Positions
518, 519
Preview Scan
515
PSF
135, 334
Sample Carrier Template
529
Tile Regions
517, 518
ZEN Connect project
565
Create Image Subset
103
Image Processing
112, 184
Create manual scaling
30
Create Sub Image
101
Crop ROI
103
Cryo
Image processing functions
109
Z-Stack alignment
122
Cryo images
Workflow
356
Custom chart
857
Custom Dye
Copy & Paste Data
58
Data
58
Data from Preset Dye
58
New
59
Custom Graphics Tab
901
Customize Tools Dialog
901
Cut out
Volume from z-stack
359
Cut Out Regions
Image Processing
113
CWS project
Export single image
597

D
Data storage
592, 593
Delete Connect project from
593
Delete image
592
Delete image from
592
Open Connect project
593
Save Connect project
592
Stored documents
606, 607
Stored images
593
Deconvolution
123, 323
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Create Settings
342
Image types
335
Perform with default values
91
Process on processing computer
349
Deconvolve
Z-stack image
93
Deep features
Intellesis
441
Default Parameter for Deconvolution
341
Definite Focus
Adapt focus values
720
Delete
Connect project from data storage
593
Graphical element/measurement
900
Image from data storage
592
Images from disk
569
Model
431
Denoise
Image Processing
116, 160
Dialog
Edit Sample Carrier Template 558
Select Sample Carrier Template
557
Diameter
404
Diameter Unscaled
404
Dilate
780
Direct Processing
351, 354, 644
Connect acquisition and processing
computer
344
Deconvolution
349
Introduction
343
Use
346
Using Direct Processing with
Airyscan
347
with advanced deconvolution settings
350
Discovery proxy
Set up
346
Disparity map
Calculation
1037
Display
Relative laser power
709
Distribute
Global Support Points
524
Local Support Points
523
Documents tab
633
Download
APEER module
246
Dye
New
59
Dye Database
809
New
59
Dye Editor
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Copy & Paste Data
Creating a Custom Dye
Custom Dye
Custom Dye Data
Data Set
Introduction
New Dye
Preset Dye

58
57
58, 59
58
59
55
59
58

E
Acquire EDF-Images
Compare images
53
F12 Key
52
Timer
51
Edit
Classes
432
Graphical elements and measurements
899
Position Arrays
537
Positions
537
Properties (Support Points)
560
Sample Carrier Template
558
Single Positions
537
Support Points
560
Ellipse Angle
405
Ellipse Angle Unscaled
405
Ellipse Major
405
Ellipse Major Unscaled
405
Ellipse Minor
405
Ellipse Minor Unscaled
406
EM Processing
License
356
Enhance Local Contrast
Image Processing
116
Example
Image analysis 371, 375, 382, 389
Z alignment
583
Experiment Feedback
736
Adaptive acquisition engine
241
Concept
239
Script Editor
737
Workflow
240
Experiment Information
736
Experiment Manager
653
Experiment Regions Tool
720
Export
Data for SerialEM
575
Multi-channel image
598
Multiscene image
234
Naming convention
235
Single image
574, 597
Trained model
430
Video
574
ZEN Connect project
575
Export with images
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Trained model
430
Export/Import
Workflow Export/Import
233
Exporting
User database
42
Extended Depth of Focus (EDF)
51
Extensions
666
Extract
PSF from image
135, 334

F
Feret Maximum
Feret Maximum Angle
Feret Maximum Unscaled
Feret Minimum
Feret Minimum Angle
Feret Minimum Unscaled
Feret Ratio
Feret Vertical to Maximum
Fiber Length
Fiber Length Unscaled
FIB-SEM stacks
Workflow
Field of view
Width dialog
File Browser
Fill holes
Filter
Images in search results
Finish
Alignment
Flip
Image horizontally
Image vertically
Focus Strategy Tool
Focus Surface
Create Global
Create Local
Global
Local
Focus tool
Focus values
Adapt
Adapt with Definite Focus
Adapt with Software Autofocus
Form Circle
Format Graphic Elements Dialog
Frame rate
Full Screen mode

406
406
406
406
406
407
407
407
407
407
356
599
911
783
593
582
581
581
711
538
524
522
522
522
800
719
720
720
408
898
23
908

G
Gain
Gallery View
Gardient Max
Gardient Sum

672
812
141
141

1068

Index

ZEISS
Gauss
Image Processing
117, 161
General View Options
Dimensions Tab
887
Player Tab
893
Genreal View Options
Display Tab
902
Geometric Group
143, 144
Global Focus Surface
522
Global-Z
591
Grab
Image in ZEN Connect project 590
Graphical Elements
Customizing
901
Formatting
898
Graphics
Custom
901
Global
894
Graphics Tab
894
Gray Value Compensation
Image Processing
123
Group Management
627
Groups
Manage group privileges
41
Privileges
41
Guided Acquisition
368
License
362
Perform
363
Preliminary work
362
Guided Acquisition settings
365

H
Heatmap
395
Calculation
396
Hide
Region caption in a ZEN Connect
project
589
Region caption in Connect Project
589
Highpass
Image Processing
117, 142
Histo View
820
Holder
Select
594

Add annotation
61
Export single image
574, 597
Filter search results in data storage
593
Flip horizontally
581
Grab in a ZEN Connect project 590
Of ZEN Connect project in explorer
570
Save to data storage
592
Image acquisition LSM 900
Airyscan 2 multiplex modes
76
Image acquisition LSM 980
Airyscan 2 multiplex modes
79
Image Analysis
775
Example
371, 375, 382, 389
Use trained model
435
Image Analysis Program
231
Image analysis setting
Create
369
Create from analyzed image
370
Image channel
Select
424
Image Container Category
408
Image Export
Export folder
200, 203, 212
File Types
208
Method
207
Quick Export
798
Image Import
Supported File Types
204
Image in ZEN
Open
570
Image Index Block
408
Image Index Position
408
Image Index Scene
409
Image Index Time
409
Image Index Z
409
Image order
Change
570
Image Processing

I
ID
ID of the Parent
Image
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408
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Apply Mask
174
Coarse Z-Stack Alignment
110
Create Image Subset
112, 184
Cryo
109
Cut Out Regions
113
Denoise
116, 160
Enhance Local Contrast
116
Gauss
117, 161
Gray Value Compensation
123
Highpass
117, 142
Lightsheet
218
Median
118, 161
Remove Stripes
119
Save Settings for IP functions
90
Shading Correction
120, 138
Slice Replacement
120
Sort SmartFIB tiffs
121
Workflow
90
Image Scene Name
409
Image tyes
Deconvolution
335
Image vertically
Flip
581
Image Views
FRAP View
876
Unmix View
867
ImageJ tab
645
Images and Documents Gallery
797
Imaging Setup
Airyscan SR
969
For Widefield Applications
685
LSM Confocal
963
LSM Lambda
970
NDD
973
Online Fingerprinting
972, 973
Import
Add image
567
BioFormats
572
Images to ZEN Connect project 572
Labels from binary mask
432
Proprietary file formats
572
SmartFIB stack
360, 573
Third-party images
572
Trained model
429
TXM
206
Import experiment blocks
724
Import images
Tiles & Positions
530
Importing
User database
42
Index
409
Info View
825
Intellesis
Neural networks
433
Intensity Maximum of channel 'C1' 409
Intensity Mean Value of channel
'C1'
409
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Intensity Minimum of channel 'C1' 409
Intensity Range of channel 'C1'
409
Intensity Standard Deviation of channel 'C1'
409
Interactive analysis
392
Interactive Measures
770
Interactive Mode - Celldiscoverer 1012
Celldiscoverer
1012
Interactive segmentation
788
Interpolation Degree
Select
526
Introduction
ZEN Connect
562
Working with Focus Strategies
86
Invert
780

L
Labels from binary mask
Import
432
Imgage Views
869
Laplace
142
Lasers tool
805
Layer Thickness Measurement
257
Tools
267
Wizards
267
Left toolbar
Advanced Tile Setup
547
License
EM Processing
356
Guided Acquisition
362
Licensing
ZEN Connect
562
Light Path
666
Lightsheet Processing
218
Registration
221
Lightsheet Processing Registration
221
Likelihood
127, 326
Live panorama
638
Acquire panorama image automatically
49
Load
Atlas 5 project
567
ZEN Connect project
567
Local Focus Surface
522
Local variance
142
Location
Toolbar
551
LSM 980
Maintenance
975
LSM Confocal
963
LSM Lambda
970

M
Macro Editor Dialog

622
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Magazine View
1021
Options
1023
Maintenance
LSM
975
Manage
Group privileges
41
Manual Extended Depth of Focus 51
Mean ROI View
859
Measure
Point spread function using subresolution beads
99
PSF using subresolution beads 99
Measure fluorescence intensity in a
multichannel image
371
Measure View
823
Median
Image Processing
118, 161
Menu bar
19
Method Extended Depth of Focus 105
Microscope Control
666
Min. confidence
783
Min. hole area
783
Minimum area
783
Mirror
147
Model
Delete
431
Export with images
430
Rename
430
Move
Graphical element/measurement
899
Image in ZEN Connect project 570
Measurement result
900
Movie
Add annotation
61
Quick export
233
Movie Export
195
File Types
196
Movie Recorder
682
Multi-channel image
Export
598
Multiple scenes chart
394
Multiplex modes
LSM 900 image acquisition
76
LSM 980 image acquisition
79
Multiscene image
Export
234

N
Navigation tab
Navigation View
NDD
Neural Networks
Intellesis
Number of the region holes
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1025
1024
973
433
409

O
OAD (Open Application Development)
ImageJ Extension
411
OAD Concept
444
Online Fingerprinting
972
Opacity
Adjust
603
Open
Connect project from data storage
593
Image from data storage
592
Image in ZEN
570
Images in ZEN Connect 3D view
565
ZEN Connect
564
ZEN Connect project
567
Optimize live image settings
30
Options
Tiles
555
Ortho View
832
Orthogonal Projection
147

P
Pan & zoom
588
Panorama View
457
Password Rules
41
Paste
Graphical element/measurement
900
Path mapping
APEER
246
Perform
Automated Photomanipulation experiment
254
Deconvolution with default values
91
Guided Acquisition
363
Interactive analysis
392
Performance indicators
23
Performing deconvolution
Configurable
93
Perimeter
410
Perimeter Unscaled
410
Physiology
458
Mean ROI Setup
765
Pinhole adjustment
976
Pipeline
arivis Vision4D
797
Pixel size
599
Pixel Value
23
Point spread function
Create
135, 334
Measure using subresolution beads
99
Polarization imaging
912
Position Array
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Toolbar
551
Position Arrays
Options
537
Positions
535
Adjusting Z values
521
Assign Category
526
Assign Name
526
Category
536
Copy
520
Create
518, 519
Options
537
Predefined
Toolbar
549
Preview scan
548
Toolbar
548
Privileges
Groups
41
Processing
Polarization imaging
912
Processing tab
664
Settings Concept
90
Workflow
90
Processing the Panorama Image 451
Profile View
818
Progress bar
23
Proprietary file formats
Import
572
PSF
Create
135, 334
Extract from image
135, 334
Measure using subresolution beads
99
PSF wizard
135, 334

Q
Quick export
Movie

233

R
Radius
Radius Unscaled
Readback signals adjustment
Region
Select
Region caption
ZEN Connect project
Region Class Color
Region Class ID
Region Class Name
Region filter editor
Region of Interest
ZEN Connect
Regions tool
Registration
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410
410
985
588
589
410
410
410
787
590
606

Lightsheet Processing
221
Regularization
126, 326
Relative laser power
Display
709
Remove
Data from ZEN Connect project 569
Image from ZEN Connect project
569
Remove Stripes
Image Processing
119
Rename
Image in ZEN Connect project 570
Trained model
430
Re-Positioning
Sample Carrier
527
Resample
148
Reset
Alignment
581
Resize
Graphical element/measurement
900
Reuse function
662
Right Tool Area
22
Roberts
142
Rotate
149
Alignment
578
Graphical element/measurement
900
Z-Stack
584
Rotate 2D
150
Roundness
410

S
S&F View
489
Sample Carrier
538
Calibrate Template
529
Create Template
529
Customize Template
529
Distribute Support Points
524
Edit Template dialog
558
Re-Positioning
527
Select Template
529
Select Template dialog
557
Tiles toolbar
550
Toolbar positions
552
Sample Carrier tab
857
Sample Holder Calibration Wizard
304, 493
Sample navigator
LSM 980 and LSM 900
69
Save
Image to data storage
592
Saving tab
632
Scale
Alignment
579
Scaling
629
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Change
229
Scaling options
22
Script Editor for Experiment Feedback
737
Script runtime condition
Select
242
Section
Focus Surface
538
Positions
535
Sample Carrier
538
Segmetation model
Select
785
Select
Carrier / Holder in ZEN Connect
project
589
Carrier and Holder
594
Category
526
Image channel
424
Interpolation Degree
526
Region
588
Sample Carrier Template
529
Sample Carrier Template dialog 557
Script runtime condition
242
Segmentation model
785
Select template dialog
594
Selecting a Light/Dark Screen Layout
237
Separate after segmentation
783
SerialEM
Export
575
Session
Start in ZEN Connect
571
Set up
Discovery Proxy
346
Set up Physiology experiments
465
Set user language
24
Settings
Automated Photomanipulation 253
Setup
by Array
519
by Carrier (Positions)
519
by Carrier (Tiles)
518
by Contour
517
by Location
518
by Predefined
518
Coarse Z-Stack Alignment
111
Shading Correction
674
Image Processing
120, 138
Sharpen
781
Sharpness
700
Shear
Alignment
580
Shift
151
Show
Image of ZEN Connect project in
Explorer
570
Show All Mode
25
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Show/hide areas
238
Shuttle & Find Module
Introduction
472
Shuttle and Find
487
Single Pixel Filter
162
Image Smoothing
162
Processing
162
Single Positions
535
Options
537
Slice Replacement
Image Processing
120
Smart Setup
655
Airyscan LSM 980 and LSM 900 68
SmartFIB stack
Import
360, 573
Smoothing
780
Sobel filter
143
Software autofocus
508
Adapt focus values
720
Sort SmartFIB tiffs
Image Processing
121
Specific View options
554
Split Display
909
Split View
831
Splitter mode
909
Stage alignment
152
Stage jitter
Correct
183
Stage size
Zen Connect
645
Stage tool
798
Stage View
545
Stake
Toolbar
550
Start
Session in Connect project
571
Start software
17
Status bar
22
Stitching
153
Shading correction
153
Storage folder
23
Stored documents
Connect project
606
Data storage
606, 607
Stored documents table
Configure
593
Subtract BG
780
Support Points
Distribute on Sample Carrier
524
Ditribute on Tile Region
523
Global
538, 560
Local
538
Options
560
Verify Z positions
525
Verifying Z-values
523
Suppress Border
784
Suppress invalid
784
1073

Index

ZEISS
System Information

22

T
Tab
Carrier
554
Table Export tab
857
Third-party images
Import
572
Threshold
781
Tile
500
Tile Region
500
Assign Category
526
Assign Name
526
Category
536
Copy
520
Create
517, 518
Distribute Support Points
523
Tile Regions
Adjusting Z-Values
521
Tiles
531
Options
541, 555
Verify Tile Regions / Positions 542
Tiles & Positions
Import images
530
Tiles advanced setup
Live and Stage tab
554
Tiles and Positions
Selecting Interpolation Degree 524
Setting up a simple positions experiment
514
Setting up a simple tiles experiment
513
Tiles Options
555
Time Bleaching Tool
762
Time series chart
395
Time Series images
49
Toggle
Region caption in a ZEN Connect
project
589
ZEN Connect view modes
571
Tomo3D View
851
Tool Bar
19
Toolbar
Contour
548
Location
551
Position Array
551
Predefined
549
Preview scan
548
Sample carrier positions
552
Sample carrier tiles
550
Stake
550
Tools
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Acquisition Mode
687
ApoTome Mode
702
Auto Save Tool
766
Automated Export Tool
767
Camera
669
Channels
702
Experiment Feedback
736
Experiment Information
736
Focus Strategy
711
Image Analysis
775
Imaging Setup
684
Interactive Measures
770
Lasers tool
805
Manual Extended Depth of Focus
683
Microscope Control
666
Movie Recorder
682
Regions
606
Shuttle and Find
487
Software autofocus
508
Tiles
531
Time Series Tool
732
Z-Stack
726
Topography
257
Wizards
265
Tools
265
Trainable Segmentation
421
Trained model
Clone
431
Create
425
Delete
431
Export
430
Export with images
430
Import
429
Rename
430
Use for image analysis
435
Translate
Alignment
577
Tree View
831
TXM
Convert to czi
206
Import
206

U
Undock/Dock tool window
238
Use
Analyze to Label Image
108
APEER module locally
247
Automated Photomanipulation settings
253
Direct Processing
346
Gobal-Z
591
User and Group Management
Options
41
User database
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Index

ZEISS
Importing/exporting
User interface
User management

42
18
36, 627

V
Variance
Verify Z positions
of Support Points
Video
Export
Video export wizard
Vision4D Tool

780
525
574
599
797

W
Workflow
Cryo images
FIB-SEM stacks
Image Processing
Working with MeanROI
Workspace configuration

356
356
90
458
19

Pan & zoom
588
Zoom to extent
588
Zoom in/out workspace
237
Zooming
ZEN Connect project
569
Z-Stack
726
Acquiring Z-Stack Images
46
Auto-Configuration
727
Automatic alignment
358
Configure Z-Stack automatically 47
Configure Z-Stack manually
48
Create EDF-Image
105
Cut out volume
359
Manual alignment
357
Manual Configuration
272, 728
Rotate
584
Z-Stack Alignment
122, 154
Z-stack image
deconvolve
93

Z
Z alignment
Example
Z-Alignment
ZEN Connect
Export project
Introduction
Licensing
Region of Interest
Stage size
Toggle view modes
ZEN Connect 3D view
Open images
ZEN Connect project
Add dataset
Add images
Align
Align data
Close
Create
Export single image
Export video
Import images
Load
Move image
Remove image
Rename image
ZEN Connect tool
Zoom
Zoom to extent
ZEN Connect tool
ZEN Connect project
ZEN Data Storage
Zoom
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583
582
575
562
562
590
645
571
565
569
567
576
576
572
565
574
574
572
567
570
569
570
601
569
588
601
591
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